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What's New in AGi32? 

What’s New? 

Version 2.1 series 

• Updated CAD import engine to Autodesk® RealDWG technology 

• Coplanar Merging technology for simplified and reduced surface count in CAD imports 

• Drag and drop DWG 

• Complete support for absolute photometry in Luminaire Define and Instabase 

• BUG Rating support in Luminaire Define and Instabase 

• LEE and Rosco color filter library support in Luminaire Define (Color/SRE) 

• Roadway standard support for global standards: IES RP-8-2000, CIE-140-2000, BSEN-13201-3-2003, AS1158.2-2005, NZ1158.2-2005 

• New Roadway Optimizer technology 

• New roadway standards builder (for roadway researchers) 

• New and improved textures interface 

• Light loss factor calculator in Luminaire Define 

• Expanded Instabase query for BUG, LER, LED lamp type 

• Photometric Integrity check in Instabase query 

• New web-based Installation License Manager 

• New license sharing technology 

• New navigation and graphics in all Viewers: CAD Import, Surface Edit, Automatic-placement, Object Library 

• Scale RGB renderings 

• Access to complete Photometric Toolbox from Luminaire Define (PTB version 1.7x) 

• Improved performance in Project Manager and column sorting 

• New Schedules fields 

• International language capability in schedules: French, Spanish, Brazilian-Portuguese 

• Points on line – arced (curved) segments can be sloped 

• Import Scattered calculation points from text file 

• Windows 7 (and Vista) compliant, file system simplified 
• File Open, Save, Save_As now use most recent folder 

Version 2.04 

• Updated CAD import engine to Open Design Alliance libraries version 2.7 

Version 2.03 

• Revised photometric Instabase System with subscription capability and new web-based back end functionality for Manufacturers. 

Version 2.00 

• Interface: Tabbed movement between Model, Render and Page Builder modes. 

• Interface: Luminaire, Calculation Point, Room/Object and Drawing tools have been moved to Toolkits with flexible docking choices. 

• Interface:  New Status Bar contains transparent toggle settings for Snap, Snap-To and Ortho (Model Mode) and Textures, Wire Overlay, Model 
Overlay and Anti-Aliasing (Render Mode). 

• Interface: Calculate and Daylight Study progress display occurs  in Statistics Window (Statistics Display replaced with Calculation Status 
Display).  Now integrated into AGi32 form,  minimize AGi32 while calculating by using desktop Minimize button. 

• Interface: Status Bar shortcuts (function keys) have been changed and aligned with AutoCAD . 

• Interface: Drag and Drop A32 and AGI files into Model mode desktop to open files. 

• Interface: Interactive Isometric view in Model Mode - press and hold Shift key wile pressing down mouse wheel button. 

• Interface: Navigate while calculating in Render Mode.  Pause and start calculations. 

• Interface: Calculation Methods available from new Calculate button menu as well as Adaptive Subdivision, Radiosity Stopping Criterion and 
Batch Processing. 

• Interface: Roadway Optimizer and Room Estimator now contained in the Design Tools button on the new Control bar. 
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• Calculate; Pause and resume calculations in Render mode so that interactions may be made in environment prior to reaching Radiosity 
Stopping Criterion. 

• Calculate: Automatic Placement Calculation Points – Added Diffuse Luminance and Daylight Factor to available calculation types. 

• Render:  Display Properties - Hidden wireframe, Radiosity Wireframe. 

• Render:  Display Properties - Render light as Direct Only, Indirect Only or Direct/Indirect. 

• Render: Remove direct Illumination from Image has been deprecated. 

• Render: Overlay your choice of Model Mode entities on top of rendered environment (e.g., calculation points, drawing lines, luminaire templates, 
photometric webs, etc.) 

• Render: Exposure can accommodate composite scenes with both interior and exterior surfaces visible.  

• New capability: Rooms, Objects, Statistical Areas, LPD Areas and Remove Calculation point polygons from existing drawing entities. 

• New capability: Surface Edit - Surface Types revised and enhanced with toggle settings for former surface types "Removed", "Daylight Exterior" 
and "Direct Flux Only". 

• New capability: Project Manager - Password protect projects. 

• New capability: Rotate Object - Window options and 3D Rotate options added. 

• New capability: Schedules can be moved and deleted like all other Drawing commands (Single, Window, All). 

• File-Export: Improved layer and block hierarchy. 

• File-Export: Export DWG and DXF with multiple version support through AutoCAD 2008. 

• File-Export: Layer structure and entity selection is customizable.  Unit conversion is also available. 

• File Import: Import XREF files if available, browse if necessary. 

• Define Luminaire - LCS (Luminaire Classification System) metric now calculated for all Type C photometric files. LCS Graph displayed for all 
photometric files. 

• Define Luminaire - LER (Luminaire Efficacy Rating) metric now calculated for all Type C photometric files. 

• Photometric support - European standard photometric support - Eulumdat, TM14 files can now be used directly. 

• System: Default AGi32 file extension changed to .AGI from A32. 

• System: AGI-Light and AGI-DOS files can no longer be opened in AGi32.  

• System: AGi32 responds to mouse down clicks instead of mouse up clicks. 
• System: The AGi32 Assistant has been deprecated. 

  

Using AGi32 

AGi32 is a software tool used to predict the lighting performance of electric luminaires and/or daylight inside a simulated environment.  The 
environments that may be considered in AGi32 can range from a simple rectangular space to a multilevel interchange or complex auditorium.  

AGi32 is a stand-alone tool, meaning that no other software programs are required to create or output the calculations results.  However, a common 
manner of input and output in AGi32 involves the importing and exporting of DXF (Drawing Exchange Format) or DWG (AutoCAD native format) files 
from CAD software. DXF is an industry standard format that is generated by virtually any CAD software available.  DWG is AutoCAD's native drawing 
format.  Importing DXF and DWG Files provides background information about the underlying architecture and systems that are used in AGi32 as a 
template for creating the environment.  CAD files exported from AGi32 translate the AGi32 data into drawing entities for use with other CAD software. 

AGi32 allows you to select from two calculation techniques, when simulating the lighting application.  Direct Only Method is a simplified calculation 
technique used when reflected light need not be considered in the results.  This mode lends itself particularly well to exterior lighting applications, 
sports and industrial interiors with low reflectance surfaces.  Full Radiosity Method is used where reflected light is a major contributor and you wish to 
render the results. 

When considering how to analyze a lighting scenario, you may find it helpful to use the analogy of ingredients in a recipe.  Luminaires are a 
necessary ingredient and must be defined for every calculation.  If numerical results are required (e.g., illuminance values), then calculation points 
must be placed in the design at appropriate locations.  When surfaces exist in the environment that interact with light (i.e., block, reflect or transmit 
light), these surfaces are modeled using rooms and/or objects.  Although AGi32 is first and foremost a calculation tool, it can be used for visualizing 
the lighting design without any numerical results.  In this case, the ingredients required are electric luminaires or daylight and the surfaces that 
interact in the illuminated environment. 

Luminaire definitions represent the internal catalog of luminaires used throughout the design.  At the heart of the luminaire definition exists the 
photometric file defining the luminaires distribution as provided by the selected lighting manufacturer.  AGi32 comes with photometric data from a 
variety of luminaire manufacturers.  Each occurrence of a luminaire can be positioned and aimed as needed. 

Calculation points are placed in the design when numerical results are required. Each calculation point represents the placement of a "virtual" light 
meter measuring the required results.  AGi32 allows you to consider and measure numerous different metrics; Illuminance, Exitance, Diffuse 
Luminance, Unified Glare Rating, Daylight Factor, Roadway Luminance, Veiling Luminance, STV and Glare Rating. 

When modeling surfaces in AGi32, the program provides two internal modeling types for your use. Rooms contain interior surfaces that are opaque. 
Objects are the most flexible modeling type and may be used in interiors or exteriors.  They may be opaque or transmissive.  Most objects are closed 
on all sides but a few types (such as cones and spheres) may be open. 

AGi32 also is capable of importing three-dimensional solids created in other programs via DXF or DWG file.  The addition of externally created solids 
to an AGi32 model can lend dramatic realism and accuracy.  Imported models are converted into AGi32 Objects and can be manipulated using the 
same commands as object created internally. 
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Drawing Entities are used in AGi32 for presentation purposes (Schedules and Text), to create a background for the design (i.e., a parking lot if one 
wasn't imported) or to point to specific parts of the design (i.e., a circle or axis used to demarcate information).  Drawing entities do not affect the 
lighting calculations. 

Finally, the order in which the environment is created is flexible as well.  You may choose to model the environment, then place the luminaires. Or 
you might choose to position the luminaires, then place calculation points.  As long as the completed "recipe" contains all of the necessary 
ingredients, the order in which they are selected is not important. 

  

Learning AGi32 

A variety of sources are available to you when questions arise. AGi32 has excellent tutorials and on-line help at your finger tips, as well as support 
options from our distributors or Lighting Analysts directly. 

HTML Help 

AGi32 has extensive on-line help available when using the program. Just look for the HELP button when AGi32 presents a dialog box for input, or go 
to the Help menu when at the main screen. Help material is context sensitive at the dialog box level by pressing the F1 key, whereas from the pull-
down menu you have access to the entire Help contents. 

Tutorials 

The Tutorials in the HTML Help are designed to be followed in a hands-on manner with the AGi32 program.  Work through each tutorial for a broad 
understanding of the variety of functions possible with AGi32.  We highly recommend that at least one tutorial be completed by all users prior to 
attempting production work with AGi32. The Instant Gratification Tutorial is designed to cover a variety of functions valuable to all users and is an 
excellent place to begin. 

Website 

Lighting Analysts maintains a variety of valuable information on the Internet in the form of company news, sales literature, product demonstrations, 
technical assistance, Knowledgebase articles, and even downloadable product and photometric library updates. 

Please visit us at www.agi32.com. 

Feedback 

We like to hear from you for any reason, praise or criticism; please communicate your opinions, experiences, and adventures with AGi32.  

   

AGi32 Interface - Concepts 

The AGi32 Interface is composed of the following parts: 

• Menu Bar - Provides access to all Common and Mode Toolkit commands by pull-down menu selection. 

• Common Toolbar - Provides access to File management and View commands. 

• Control Bar - Provides access to Mode Tabs, calculation and design commands and Project Manager. 

• Status Bar - Provides access  to switches and settings across modes. 

• Mode Toolkits - Provides Add/Modify entity commands for all modes.  Toolkits update their command availability based on the current mode 
(Model, Render and Page Builder). 

• Statistics Display - Displays Calculation Summary and LPD/UWLR Summary information. 

• Calculation Status Display - Only display while calculating, provides information on calculation status and progress. 

When you first start AGi32, the initial screen contains the menu bar at the top, the Common Toolbar and Control Bar directly below, the graphics 
window, Mode Toolkits and Statistical Display docked on the right and the Status bar at the bottom. 
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AGi32 Interface-Procedure 

Finding commands 

The menu bar contains pull-down menus that access commands and settings within AGi32.  Icons that represent commands are interspersed 
amongst the interface and provide graphical accessibility to the AGi32 commands. The Mode Toolkits may be docked left or right on the desktop or 
may float above the graphics window.  They can also be disconnected to move to a secondary monitor.  All docking commands are accessible from a 
right click menu on the toolkit titlebar. 

Mouse usage & Command Line 

As the mouse moves over the toolbars, the cursor is in the form of an 11 o'clock arrow to assist in selecting a command.  When the cursor rests on 
an icon for a second, a tool tip describing the icon's command will appear.  As the mouse moves over the graphics window, the cursor changes to 
cross hairs to locate objects in the graphics window.  Some commands prompt you to select an entity to modify.  In this case, the cursor will change 
to a pickbox to aid in selecting the desired object.  

� To select a command, left click on the icon or menu selection. 
� To see the available command options, left click on the pull-down arrow to the right of the command icon.  Select the desired menu option. 
� You may cancel a command by using the Esc key on your keyboard. 
� Conclude a command by pressing the right mouse button.  When no command is active, pressing the right mouse button will reactivate the 

previously used command. 
� The mouse wheel will zoom into (roll forward) and out of (roll backward) the Model Mode graphics area.  Hold down the wheel to Pan, press the 

shift key while holding down the wheel to interactively orbit an isometric view. 
� The command line at the bottom of the screen will prompt you for the required information.  The word "select" on the command line indicates 

you can graphically select the entity or vertex with the mouse.  The word "enter" indicates you can type in the information from the keyboard. 
When entering information from the keyboard, press Enter to submit the information once you have completed typing. 

� Within a command that requires specifying a boundary (like a room or calculation polygon), you can undo an erroneous line segment with Ctrl-Z 
or the Undo key on the AGi32 Common Toolbar. 

Graphical Coordinate Entry 

When graphically specifying vertices or radius information with the mouse in AGi32, you may use absolute or relative coordinates. 
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AGi32 uses a 3-dimensional Cartesian Coordinate system consisting of X, Y and Z axes.  This system is called a WCS (world coordinate system).  In 
a WCS displaying Plan View, X is defined as running left to right on the screen (East-West), Y is up and down (North -South) and the positive (+) Z-
AXIS is perpendicular to the display pointing towards you. 

In Elevation Views, Z points up and down on the screen and X and/or Y may run left to right, depending on the elevation view taken. 

Every entity in AGi32 is specified in terms of 3 coordinates. These coordinates remain constant to the WCS display and do not flip if an alternate view 
is taken. In other words, in an elevation View, one is always working with Z coordinates, not just X and Y. 

Absolute coordinates 

This input method allows you to enter the coordinates in relation to the Cartesian coordinate system with the origin at 0, 0, 0. 

For example, to create a rectangular-flat room with three point input that is 10 x 10 feet in X and Y you would enter the following coordinates: 

� Point 1: 0, 0, 0 (Z is optional unless you wish to use a Z other than 0 which is the 
default) 

� Point 2: 10, 0, 0 (Z is same as 1st point) 
� Point 3: 10, 10, 0 (Z is same as 1st point) 

 

Relative coordinates 

This input method allows you to enter coordinates relative to the current (or last) point entered.  

For example, to create a rectangular-flat room with three point input that is 10 x 10 feet in X and Y you would enter the following relative coordinates: 

� Point 1: 0, 0, 0 (Z is optional unless you wish to use a Z other than 0 which is the 
default) 

� Point 2: @10, 0 (@X,Y method) OR @10 (@X method) OR 10@0 (Length@Angle 
method) 

� Point 3: @0, 10 (@X,Y method) OR 10@90 (Length@Angle method) 

 

Four options are available: 

1. Length@Angle – Actual point in located a specified distance and angle from the current point. Example: Current point = (0, 0, 0), relative 
coordinates =(100@45), actual point = (70.7,  70.7,  0) 

2. @X – Actual point in located a specified distance in the X direction from the current point. Example: Current point = (0, 0, 0), relative coordinates 
= (@100), actual point = (100,  0,  0) 

3. @X,Y - Actual point in located a specified distance in the X and Y directions from the current point. Example: Current point = (0, 0, 0), relative 
coordinates = (@100,50), actual point = (100,  50,  0) 

4. @X,Y,Z – Actual point in located a specified distance in the X, Y and Z directions from the current point. Example: Current point = (0, 0, 0), 
relative coordinates = (@100,50,25), actual point = (100,  50,  25) 
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Notes: 

� In Plan and Isometric View, any of the input methods may be used to specify coordinate locations in the X-Y (horizontal) plane.  
� In Elevation Views, the @X,Y,Z method must be employed to specify the coordinates in a fixed elevation plane. 
� The coordinate display provides the following information: X, Y and Z coordinates, Orient, Tilt and Length (command dependant). 

Menu Bar 

Most of AGi32's commands are available from the pull-down menu bar at the top of the AGi32 Desktop (except those commands found on the 
Control Bar and Status Bar). You can choose menu options in one of the following ways: 

 After you click the menu name to display a list of options, click the option to choose it. 

 Hold down the ALT key and enter the underlined letter in the menu name. For example, to open a new drawing, hold down ALT while pressing F 
(ALT+F) to open the File menu.  Then enter the underlined letter that corresponds to the desired option.  For example, press the S key to save the 
job file you are currently working on. 

 Some menu options also have hot keys that access the command directly instead of going through the pull-down menus or through a toolbar 
button.  These hot key combinations will be shown adjacent to the command name in the pull-down menu.  For example, to open an AGi32 file press 
the [Ctrl] key and the [O] keys at the same time [Ctrl+O] to invoke the Open File dialog.  

Terminology Definitions 

Throughout the online Help, you will find terminology that refers to specific parts of the AGi32 software or processes involved.  These terms are not 
arbitrary or intended to confuse those not current in computer lingo!  We have actually given careful thought to most terms and you will find their 
definitions in the text that follows. 

Controls 

The term Control is of technical origin and refers to a mini program that is used to control access, or interface with, certain types of information.  
Examples of typical controls include the following: Text box, Combo box, Pull-down menu, Pop-up menu, Option button, Check box, Scroll bar, Tab, 
Command button, Tree view, List box, Updown button, Picture box, Drivelist box, Dirlist box, Filelist box, Common dialog, Progress bar and Grid. 

Job File 

The job file is the computer file that you use to save the job(s) you work on. AGi32 Job files carry the extension AGI.  Example: Downtown Pedestrian 
Mall.AGI 

Project 

A Project is a subset of your Job file that may contain computations for any portion of your application.  For example, when running multiple interior 
spaces in a single job file you may want to separate them into multiple Projects.  Projects can be locked such that they are not computed when 
working on other portions of your job file.  Projects can be manipulated using the AGi32 Project Manager.  A single Job file may contain multiple 
Projects. 

AGi32 Desktop 

Desktop refers to AGI32’s main interface screen.  The Desktop contains all of the pull-down menus, toolbars, and graphics Windows related to the 
program operation.  Technically, the AGi32 Desktop is a MDI (Multiple Document Interface) form. 

Toolbars and Toolkits 

Toolbars and Toolkits contain collections of buttons designed to access most of AGi32's most commonly used commands eliminating the need to 
search for a command in the pull-down menu structure. 

Graphics Window 

The graphics window is another description for the active area in which you create your projects.  The Graphics Window can contain a number of 
different Views as created in the AGi32 View Manager. 

Dialog 

A Dialog is an interactive window or form that appears when certain functions are activated (as in carrying on a dialog with AGi32!).  An example of a 
Dialog is the Define Luminaire portion of AGi32.  This command actually has multiple dialogs associated with it.  Essentially, any time you execute a 
command and an interactive window appears requesting input, you are looking at a dialog. 
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MultiUse Dialog 

The MultiUse Dialog is covered by the previous definition as well, but can be accessed from different commands.  An example of this is the Color 
Dialog box.  Many MultiUse dialogs are Windows Common Dialogs meaning they are standardized among applications and available to any 
developer. 

Mouse Pointer 

The mouse pointer is the standard Windows mouse icon. (Set by 
system defaults).  

Cursor 

The cursor can either be crosshairs, or a pick box in the Graphics 
window depending on the status of the command being carried 
out.  

 

Command Line 

The AGi32 Command Line can be found across the bottom left corner of the AGi32 Desktop (screen). The Command Line always displays the status 
of the current command in progress and prompts for action by the user. Data entry can also be accommodated on the Command Line when the 
command in progress is waiting for coordinate entry.  

More information about working in AGi32  is available in the AGi32 Overview 

  

Menu Bar 

All of the Common and Mode Toolkit commands are available from the pull-down menu bar at the top of the AGi32 Desktop.  You can choose menu 
options in one of the following ways: 

 After you click the menu name to display a list of options, click the option to choose it. 

 Hold down the ALT key and enter the underlined letter in the menu name. For example, to open a new drawing, hold down ALT while pressing F 
(ALT+F) to open the File menu.  Then enter the underlined letter that corresponds to the desired option.  For example, press the S key to save the 
job file you are currently working on. 

 Some menu options also have hot keys that access the command directly instead of going through the pull-down menus or through a toolbar 
button.  These hot key combinations will be shown adjacent to the command name in the pull-down menu.  For example, to open an AGi32 file press 
the [Ctrl] key and the [O] keys at the same time [Ctrl+O] to invoke the Open File dialog. 

  

Toolbars 

You can start a command by clicking on an icon in a toolbar and then choosing options in a dialog box or responding to the prompts displayed on the 
command line. 

To see more detailed information about a command, click on the hyperlink. 

 

Menu Bar 

The following Menu Bar commands only appear in the Menu and not on any Toolbar or Toolkit.  Any redundant commands that do appear in Toolkits 
or Toolbars will be included in those tables. 
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Mode Button Menu Location Command 

All   File-New From Template Creates a new AGi32 file from a previously saved AGi32 Template. 

All   File-Save As   

All   File - Save As Template   

All   File-Banner   

All   File-Information   

All   File-Print Text   

Page Builder   Edit - Paste Directly to Imageport Shortcut: Ctrl - V 

Model   View-Redraw All Views   

Model   View-Set Limits   

Model, Page 
Builder  

View- Pan Center Translate a point to the center of the screen. 

Model, Page 
Builder  

View- Zoom Center Zooms in on a selected point and translates it to the center of the 
screen. 

Model, Page 
Builder  

View- Zoom In Enlarge the size of entities in the current view by the current Zoom In 
factor. 

Model, Page 
Builder  

View- Zoom Out Reduce the size of entities in the current view by the current Zoom Out 
factor. 

Model, Page 
Builder 

  View-Zoom Extents   

Model   View-Plan Rotated   

Model   View- Isometric Specify   

Model   Tools - Translate Origin   

All   Tools - Textures Database   

All   Tools - Quick Commands   

All   Tools - Restore Default Toolkits   

All   Tools - Digitizer   

All   Tools - Create Activate Disk   

All   Tools  - Update User Information   

All   Tools - Check For Software 
Updates 

  

All   Tools - Software Update 
Scheduler 

  

All   Tools Network License   

All   Tools - Create Instabase File   

All   Help Menu   

 

Common Toolbar 

The Common toolbar provides file management, view functions and evaluation tools for your use. 

Some commands are not available in all modes, check the Mode column to see when a command is active. 

Mode Button Button Name Command 

All 
 

File- New Create a new job file. 

All 
 

File- Open Open an existing AGi32 file. 

All 
 

File- Import Import a CAD or AGi32 file into the existing file. 
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Model, Render 
 

File- Export Exports a CAD file in Model mode. Export an image or VRML file in Render mode. 

All 
 

File- Save Save your file. 

All 
 

File- Print Print the current view. 

Model, Render 
 

Edit-Copy Copies contents of current View to Windows Clipboard. 

All 
 

Edit-Undo Undo the last command. 

All 
 

Edit- Redo Redo the last command. 

Model, Page 
Builder  

View- Redraw Current 
View 

Redraw the current view. Redrawing clears any 'ghosts' or blips left behind. 

Model, Page 
Builder  

View-Pan-Point Pan with the mouse using two points of reference 

Model, Page 
Builder  

View- Zoom Window Enlarge an area of interest on your screen. 

Model, Page 
Builder  

View- Zoom Extents++ Size the overall drawing to fit within the confines of the current view with a ¼” border 
added. 

Model 
 

View- Zoom Limits Update the view to display the coordinate window defined by the View-Set Limits 
command. 

Model, Page 
Builder  

View- Previous Return to the previous viewpoint. 

Model, Render 
 

View- Plan Display a 2D birds eye view of the environment. 

Render 
 

Bottom View Look through the bottom plane of the rendered environment. 

Render 
 

Left View Look through the left plane of the rendered environment. 

Render 
 

Right View Look through the right plane of the rendered environment. 

Render 
 

Front View Look through the front plane of the rendered environment. 

Render 
 

Back View Look through the back plane of the rendered environment. 

Model 
 

View- Specify Elevation Specify a viewpoint looking at the environment from the side (through the Z 
elevation). 

Model 
 

View- Elevation - 
Looking North 

Specify a viewpoint looking North by specifying the viewpoint location. 

Model 
 

View- Elevation - 
Looking South 

Specify a viewpoint looking South by specifying the viewpoint location. 

Model 
 

View- Elevation - 
Looking East 

Specify a viewpoint looking East by specifying the viewpoint location. 

Model 
 

View- Elevation - 
Looking West 

Specify a viewpoint looking West by specifying the viewpoint location. 

Model 

 

View-Surface Display a Room or Object wall or side surface by selecting that surface. 

Model 
 

View- Isometric Specify a 3D view using the default Isometric View parameters in System Settings. 

Model, Render 
 

View- Isometric - North 
West 

Display a 3D view looking from the North West viewpoint. 

Model, Render 
 

View- Isometric - North 
East 

Display a 3D view looking from the North East viewpoint. 

Model, Render 
 

View- Isometric - South 
East 

Display a 3D view looking from the South East viewpoint. 

Model, Render 
 

View- Isometric - South 
West 

Display a 3D view looking from the South West viewpoint. 
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Render 
 

Interactive Clip Cut away the environment from front to back. 

Render 
 

Interactive Dolly Move through the environment in the view direction. 

Render 
 

Interactive Orbit Move around the environment keeping the same focus point. 

Render 
 

Interactive-Walk Move through the environment with Rotate and Pan capabilities. 

Render 
 

Interactive Pan Move left/right or up/down relative in the environment. 

Render 
 

Interactive Rotate Look left/right and/or up/down while staying in a fixed position. 

Render 
 

Interactive Zoom Enlarge or reduce the graphic size, maintaining the same position. 

Model, Page 
Builder 

  Interactive-Pan Interactively pan the display using the mouse wheel button (this command is always 
active). 

Model, Page 
Builder 

  Interactive-Zoom Interactively zoom in/out using the mouse wheel button (this command is always 
active). 

Model   Interactive-Isometric Interactively set/change the isometric view using the Shift key and the mouse wheel 
button (this command is always active). 

Model, Render 
 

View Manager Create and manage multiple views. 

Render 
 

Render-View Properties Change the properties of the current view (background color, projection, etc.). 

Render 
 

Display Properties Modify the display parameters used in Render mode (display type, color, scaling, 
etc.). 

Model, Page 
Builder  

Measure - Area Measures the area and perimeter for a user defined polygon. 

Model, Page 
Builder  

Measure - Distance Measures the length between two points. 

Model 
 

Identify Entity Identifies an AGi32 entity and describes how to modify it. 

All 
 

System Settings Provides access to customizable settings in AGi32. 

 

Control Bar 

The Control Bar provides access to the interface Modes, design tools and calculation settings. 

Button Button 
Name 

Command 

 

Model Tab Model mode provides the interface 
for simulating the lighted 
environment. Model mode is the 
default interface shown. When 
Model mode is current, the Model 
tab is white and the Render and 
Page Builder tabs are tabbed to the 
background. 

 

Render Tab Render mode allows you to view, 
navigate and customize your 
visualizations. When Render mode 
is current, the Render tab is white 
and the Model and Page Builder 
tabs are tabbed to the background. 

 

Page 
Builder Tab 

Page Builder mode provides custom 
report creation for printing. When 
Page Builder mode is current, the 
Page Builder tab is white and the 
Model and Render tabs are tabbed 
to the background. 
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Design 
Tools: 

Roadway 
Optimizer 

Room 
Estimator 

When AGi32 is first initialized, the 
Room Estimator Design Tool is the 
default option. Click on the pull-
down arrow to see the tool 
selections. The last selected Design 
Tool will be displayed as the default 
option: 
  

Roadway Optimizer provides a 
design tool for optimizing pole 
spacings along a roadway using CIE 
and IES criteria. 

Room Estimator provides a zonal 
cavity design tool for estimating 
illuminance or luminaire quantity in 
empty rectangular rooms. 

 

Daylighting Enable and specify daylight 
conditions for a single date and time. 

Available from pull-down menu: 

 Daylight Study 

Daylight Study Viewer 

 

Start Ray 
Trace 

Generates ray trace image using 
current Ray Trace Parameters. Click 
on the pull-down arrow to see the 
Tool selections 

Available from pull-down menu: 

Set Parameters 

 Image Viewer 

 

Calculate 

AutoCalc 

Calculate the lighting effects in the 
environment and select which 
calculation method to use for 
computations: Full Radiosity (Direct 
+ Indirect Light), Direct Only or 
Direct Only - AutoCalc On.  

Available from pull-down menu: 

Adaptive Subdivision 

Radiosity Stopping Criterion 

Batch Processor 

Calculation Summary 

 

Project 
Manager 

Manage and create projects. 

Available from pull-down menu: 

Transfer Entity - Single, Window or 
All selection methods 

 
Project list Display all defined projects. The 

default project name is Project_1. 

 

Status Bar 

The Status Bar provides access to common System Settings and displays global parameters for the environment. 

Some commands are not available in all modes, check the Mode column to see when a command is active. 
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Mode Button Button 
Name 

Command 

All 

 

Toolkit 
Display 

Toggles the Toolkits On and Off, to the last specified location. 

All 
 

Statistics 
Display 

Toggles the Statistics Display On and Off, to the last specified location. 

All 
 

Units Change the current display and Illuminance units. Icon also displays the current 
units. 

Model, 
Page 
Builder 

 
Snap 
Setting 

Modify the cursor snap precision. The Snap text box is transparent. Snap Button 
Toggles Snap On and off (F9 Shortcut) 

Model, 
Page 
Builder 

 

Ortho Toggling Ortho On restricts the cursor movement to purely horizontal and vertical 
movement. This mode assists in creating linear environments and placement of 
luminaires, objects within. Ortho Button Toggles Ortho On and Off transparently 
(F8 Shortcut) 

Model 
 

Snap To Snap to the endpoints of other entities (drawing entities, objects, rooms) when 
creating the environment. (F3 Shortcut) 

Model, 
Page 
Builder 

 
Update Light Indicates whether the display and statistical entities are current. 

Render 
 

Toggle 
Texture 
Display 

Toggles textures applied to surfaces On and Off. (F10 Shortcut) 

Render 
 

Toggle 
Wireframe 
Overlay 

Toggles the wireframe overlay On or Off. Wireframe overlay indicates the 
Radiosity meshing applied. (F11 Shortcut) 

Render 
 

Model 
Overlay 

Toggles the Model mode entities to display on top of the Rendered environment. 
Click on the pull-down arrow to change the Settings or use the Display 
Properties command. Model Overlay uses a WYSIWYG approach (all entities in 
Model mode are visible by default). (F7 Shortcut) 

Render 
 

Apply Anti-
Aliasing 

Apply anti-aliasing to the current image (Choose Anti-Aliasing Sampling Level 
from pull-down list). 

(F6 Shortcut) 

The Anti-Aliasing Sampling Level indicates the number of image copies applied 
and offset from the original image in order to provide the appearance of 
smoother edges (instead of jaggies). The Default Level is None indicating no 
anti-aliasing is applied by default. The Maximum Sampling Level is 15. Higher 
sampling levels increase the image quality but also take longer to produce (up to 
several seconds). An Anti-Aliasing setting of 8 is recommended for most 
environments. 

Model Mode Toolkit 

Drawing/Schedules Toolbar 

The Drawing/Schedules Entity toolbar allows you to add and modify drawing entities (lines, circles, text) and schedules in your environment. Some 
buttons have multiple commands associated with them, which are available from the arrow to the right of the button. The secondary options are 
displayed below the correlated button. 

Button Button Name Command 

 
Line Width Modify the current drawing entity line width. 1 Pixel line width is the 

default. 

 
Line Type Modify the current drawing entity line type. 

 
Line Color Modify the current drawing entity line color. 

 
Drawing Entity-Arc Creates an arc. 

 
Drawing Entity-Axis Creates an axis in the X, Y or Z direction. 
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Drawing Entity-Block Inserts a previously defined block. 

 
Drawing Entity-Circle Creates a circle. 

 
Drawing Entity-Cube Creates a cube. 

 
Drawing Entity-
Dimension 

Creates a dimension line in the X, Y or Z plane. 

 
Drawing Entity-Line Creates a line. 

 
Drawing Entity-
Rectangle 

Creates a rectangle. 

 
Drawing Entity-Array Copy drawing entities into a rectangular grid. The default option is a single 

selection. Use the secondary menu to select Window or All. 

 
Drawing Entity-Copy Copy drawing entities to other locations. The default option is a single 

selection. Use the secondary menu to select Window or All. 

 
Drawing Entity-Create 
Block 

Creates a global block from the selected entities. The block is accessible 
from any job file. The default option is a single selection. Use the 
secondary menu to select Window or All. 

 
Drawing Entity-Create 
Normal Luminaire 
Symbol 

Creates a luminaire symbol to use in Model mode from the selected 
entities. The default option is a single selection. Use the secondary menu 
to select Window or All. 

 
Drawing Entity-Delete Deletes the selected drawing entities, including schedules. The default 

option is a single selection. Use the secondary menu to select Window or 
All. 

 
Drawing Entity-Explode Explodes a block or text entity into individual components (drawing entities 

or text lines). The default option is a single selection. Use the secondary 
menu to select Window or All. 

 
Drawing Entity-Move Move drawing entities (including schedules) to another location. The 

default option is a single selection. Use the secondary menu to select 
Window or All. 

 
Drawing Entity-Modify 
Properties 

Change the color and/or line type of the selected drawing entities. Does 
not operate on Schedules. The default option is a single selection. Use the 
secondary menu to select Window or All. 

 
Drawing Entity-Rotate Rotate the selected entities. The default option is a single selection. Use 

the secondary menu to select Window or All. 

 
Drawing Entity-Scale Scale the selected entities. The default option is a single selection. Use 

the secondary menu to select Window or All. 

 
Drawing Entity-Text Creates text or inserts text files into your job file. 

 
Drawing Entity-Edit 
Text 

Modify the properties of the selected text. 

 
Drawing Entity-
Schedule 

Creates a dynamic schedule that extracts information about your job file. 

 
Drawing Entity-Edit 
Schedule 

Modify the properties of the selected schedule. This is the default option. 

 

Luminaire Toolbar 

The Luminaire toolbar allows you to add and modify luminaires in your job file. Some buttons have multiple commands associated with them, which 
are available from the arrow to the right of the button. The secondary options are displayed below the correlated button. 

Button Button Name Command 

 

Luminaire- Define Creates an internal catalog of luminaires. 
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Luminaire - Locate Place the luminaires into the job file using the current 
settings and specifies how the luminaire is positioned. 

 

Defined Luminaire 
List 

Choose luminaire type from Defined Luminaire List 

 
Mounting Height Specifies the luminaire's Z elevation above 0. 

 

Aiming Parameters Apply aiming parameters manually before positioning. 

 
AimZ 

  

Specify the aiming point elevation. 

 
Luminaire - 
Rectangular Array 

Dynamically array a luminaire or luminaire group with 
rectilinear options. This is the default option. 

 

Luminaire - Polar 
Array 

Array a luminaire or luminaire group into a circular or 
semicircular pattern. 

 

Luminaire - Change 
Mounting Height 

Change the luminaire mounting height using the same 
aiming angle or point. The default option is Same Aiming 
Angle - Single. Using the secondary menu, you may select 
Same Aiming Point and Window or All for both options. 

 

Luminaire - Copy Copy luminaires to other locations. The default option is a 
single selection. Use the secondary menu to select Window 
or All. 

 

Luminaire - Delete Delete luminaires. The default option is a single selection. 
Use the secondary menu to select Window or All. 

 

Luminaire - Edit Edit luminaires to change their properties in a tabular 
fashion. The default option is a single selection. Use the 
secondary menu to select Window or All. 

 
Luminaire - Move Move luminaires to other locations. The default option is a 

single selection - Same Aiming Angle. Use the secondary 
menu to select Window or All filters and Same Aiming Point 
options. 
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Luminaire-Move-
Same Aiming 
Angles 

Move selection set of luminaires maintaining the existing 
aiming angles. Aiming points will change as luminaires shift 
position. 

 

Luminaire-Move-
Same Aiming Point 

Move selection set of luminaires maintaining the existing 
aiming points. Aiming angles will change as luminaires shift 
positions to maintain aiming points. 

 

Luminaire - Mirror Mirror luminaires about a definable mirror line. The default 
option is a single selection. Use the secondary menu to 
select Window or All. 

 
Luminaire-
Photometric Web-
Visibility-Toggle 
On/Off 

Toggle luminaire photometric webs On/Off for individual 
luminaire locations using current photometric web 
specifications. 

 

Luminaire-
Photometric Web-
Specification 

Modify current photometric web specifications. 

 

Luminaire-
Photometric Web-
Visibility 

Change visibility of luminaire photometric webs On or Off or 
by Label. Toggle On/Off is the default option. 

 
Luminaire - Re-Aim Re-Aim an individual luminaire to another aiming point. 

 
Luminaire - Re-
Orient 

Specify a different orientation angle for an individual 
luminaire. 

 

Luminaire - Switch Remove the luminaires from calculations using multiple 
switching options. The default option toggles individual 
luminaires On or Off. The secondary menu provides the 
ability to switch luminaires On or Off using Single, Window or 
All selections options. 

 
Luminaire - Create 
Template 

Create a template for the selected luminaire type using the 
current mounting height. This is the default option. 

 

Luminaire - Delete 
All Templates 

Delete all templates that have been defined. If templates are 
required at a later time, they will need to be recreated. 

 

Luminaire - Visibility 
Templates 

Switch the visibility of luminaire templates On or Off for all 
luminaires or by label. 
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Luminaire - Symbol 
Magnifier 

Magnify the Model Mode symbol by a specified factor. This 
option is typically used in exterior lighting layouts to assist in 
viewing the luminaire locations. 

 
Luminaire - Create 
Group 

Create a luminaire group from individual luminaire locations. 
Luminaire groups may be oriented and arrayed. This is the 
default option. 

 

Luminaire - Explode 
Group 

Explode a luminaire group into its individual locations. 

 
Luminaire - Label Labels the luminaires and specifies the labeling options. This 

is the default option. Labels may also be toggled On and Off 
from this dialog. 

 

Luminaire - Delete 
Label 

Deletes individual luminaire labels. 

 

Luminaire - Move 
Label 

Move individual luminaire labels. 

 
Sort Luminaires Sort Luminaires by sequence numbers by selecting from 

several sorting schemes. 

 
Aiming Diagram Create an Aiming Diagram (used typically for Sports Lighting 

installations) for an existing luminaire location (or grouping). 

 
Luminaire - 
Parametric Mirror 

Add a parametric mirror. 

 
Luminaire - Delete 
Parametric Mirror 

Delete a parametric mirror location. This is the default option. 

 

Luminaire - Switch 
Parametric Mirror 

Break the parametric relationship between luminaires by 
switching a parametric mirror Off. 

 

Calculations Toolbar 

The Calculation Points toolbar allows you to add and modify calculation points in your environment. Some buttons have multiple commands 
associated with them, which are available from the arrow to the right of the button. The secondary options are displayed below the correlated button. 

Button Button Name Command 

 
Calc Pts - 
Automatic 
Placement 

Creates calculation points on surfaces in rooms or objects. 

 
Calc Pts - Grid Creates a 2 Pt. grid of calculation points. This is the default option. 

 

Calc Pts - 3 Pt. 
Grid 

Creates a 3 Pt. grid of calculation points. 

 
Calc Pts - Line Creates lines of calculation points. 
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Calc Pts - 
Polygon 

Creates a horizontal polygon of calculation points. 

 
Calc Pts - 
Scattered 

Creates scattered calculation points. 

 
Calc-Pts - 
Daylight Factor 

Creates a Daylight Factor calculation grid. 

 
Calc Pts - Glare 
Rating 

Creates a family of Glare Rating calculation grids. Each observer 
position generates a related grid. 

 
Calc Pts - 
Roadway 
Luminance 

Creates a Roadway Luminance grid of calculation points. 

  

 
Calc Pts - 
Unified Glare 
Rating 

Creates a family of Unified Glare Rating calculation grids. Each observer 
position generates a related grid or individual Observer value. 

 
Calc Pts - Delete Deletes calculation points. The default option allows you to delete 

calculation grids individually. The secondary menu allows you to select 
Window. 

 
Calc Pts - Edit Edits calculation grids. 

 
Calc Pts - Move Moves calculation grids. 

 
Calc Pts - Delete 
Labels 

Deletes calculation grid labels. This is the default option. 

 

Calc Pts - Move 
Labels 

Moves calculation grid labels. 

 

Calc Pts - 
Remove Points 

Removes calculation points. The default option allows you to remove 
calculation points within a polygon. The secondary menu allows you to 
select Single, Window or Within Entities. 

 

Calc Pts - 
Replace Points 

Replaces removed calculation points. The default option allows you to 
replace calculation points within a window. The secondary menu allows 
you to select Window or All. 

 
Calc Pts - 
Statistical Area 

Creates a Statistical Area summarizing the calculation points included 
within. 

 

Calc Pts - Delete 
Stat Area 

Deletes the selected statistical area. 

 
Calc Pts - Edit 
Stat Area 

Edits the properties of the selected statistical area. This is the default 
option. 

 

Calc Pts - Move 
Stat Area Label 

Moves the label of the selected statistical area. 
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LPD/UWLR Area 

  

Create an LPD/UWLR Area (Lighting Power Density/Upward Waste 
Light Ratio Metrics). 

 

Delete 
LPD/UWLR Area 

Delete an LPD/UWLR Area. Single selection is the default option 

 

Edit LPD/UWLR 
Area 

Edit the properties of an LPD/UWLR Area. This is the default option. 

 

Move 
LPD/UWLR Area 
Label 

  

Move the label describing an LPD/UWLR Area to another location. 

 
Calc Pts - 
Isolines 

Creates Isolines in calculation grids and calculation point polygons. 

 
Calc Pts - 
Highlight Values 

Highlights maximum, minimum and/or calc point value ranges. 

 

Rooms/Objects Toolbar 

The Room toolbar allows you to add and modify rooms in your environment. Some buttons have multiple commands associated with them, which are 
available from the arrow to the right of the button. The secondary options are displayed below the correlated button. 

Button Button Name Command 

 

Surface Edit Edits surface attributes for any selection of Rooms and/or Objects. The 
default version is Single selection (multiple select of any Object or Room 
type). The secondary menu provides additional selection options 
including Window and Window select by type (Object or Room). 

 
Room-
Rectangular-Flat 

Creates a room with a rectangular footprint and flat ceiling. This is the 
default option. 

 

Room-
Rectangular-Barrel 
Vault 

Creates a room with a rectangular footprint and barrel vault ceiling. 

 

Room-
Rectangular-Gable 

Creates a room with a rectangular footprint and gable ceiling. 
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Room-
Rectangular-Hip 

Creates a room with a rectangular footprint and hip ceiling. 

 

Room-
Rectangular-
Pyramid 

Creates a room with a rectangular footprint and pyramid ceiling. 

 

Room-
Rectangular-
Vertical Extrusion 

Creates a room with a rectangular footprint and user defined ceiling. 

 
Room-Round-Flat Creates a room with a round/elliptical footprint and flat ceiling. This is the 

default option. 

 

Room-Round-
Dome 

Creates a room with a round/elliptical footprint and dome ceiling. 

 

Room-Round-
Vertical Rotation 

Creates a room with a round/elliptical footprint and user defined ceiling. 

 
Room-Polygon-
Flat 

Creates a room with a polygon footprint and flat ceiling. 

 
Room-Copy Copies a room to other locations. 

 
Room-Delete Deletes a room. 

 
Room-Edit Modifies a room's properties (color, reflectance, height, etc.). 

 
Room-Move Moves a room to another location. 

 
Room-Labels-
Delete 

Deletes an individual room label. 
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Room-Labels-
Move 

Moves an individual room label. 

 

Create Room 
Opening - Wall 

Creates openings in Room wall surfaces. This is the default option. 

 

Create Room 
Opening - Flat 
Ceiling 

Creates openings in flat Room ceiling surfaces. 

 

Create Room 
Opening - Floor 

Creates openings in Room floor surfaces 

 

Delete Room 
Opening 

Deletes openings in Room surfaces. 

 
Rectangular - 
Object - Flat 

Creates an object with a rectangular footprint and flat top. This is the 
default option. 

 

Rectangular - 
Object - Barrel 
Vault 

Creates an object with a rectangular footprint and a Barrel Vault top. 

 

Rectangular - 
Object - Gable 

  

Creates an object with a rectangular footprint and a Gable top. 

 

Rectangular - 
Object -Hip 

Creates an object with a rectangular footprint and a Hip top. 
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Rectangular - 
Object - Pyramid 

Creates an object with a rectangular footprint and a Pyramid top. 

 

Rectangular - 
Object - Vertical 
Extrusion 

  

Creates an object with a rectangular footprint and user defined top. 

 
Round - Object - 
Flat 

  

Creates an object with a round/elliptical footprint and flat top. This is the 
default option. 

 

Round - Object - 
Cone 

Creates an object with a round/elliptical footprint and tapered top. The 
cone may taper up or down depending on a given positive or negative 
height. 

 

Round - Object - 
Dome 

  

Creates an object with a round/elliptical footprint and domed top. 

 

Round - Object - 
Sphere 

  

Creates an object with a spherical (or round) shape. 

 

Round - Object - 
Vertical Rotation 

Creates an object with a round/elliptical footprint and user defined top. 
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Polygon - Object - 
Flat 

  

Creates an object with a user defined footprint and flat top. This is the 
default option. 

 

Polygon - Object - 
Vertical Extrusion 

Creates an object with a user defined profile and rectangular extrusion. 

 
Planar - Object Creates a single surface object. 

 
Add Library Object Inserts a previously defined library object into the environment. Library 

objects are composite objects made of the above shapes that are stored 
independently and can be inserted into any file. 

 

Object - 
Rectangular Array 

Array an object into a rectangular grid. 

 

Object - Polar 
Array 

Array an object into a circular or semicircular pattern. 

 

Object - Copy Copy an object to other locations. The default option is a single selection. 
Use the secondary menu to select Window. 

 

Create Luminaire 
Render Symbol 

Create custom luminaire symbols used in AGi32's Render mode. The 
default option is single selection (multiple objects may be individually 
selected at once). The secondary menu provides a Window selection 
option as an alternative. 

 

Object - Delete Delete an object. The default option is a single selection. Use the 
secondary menu to select Window. 

 
Object - Edit Edit an individual object to modify its properties (color, label, wireframe 

color, height, etc.). Properties differ depending on selected object type. 
To edit the surface properties of multiple objects and/or rooms, use the 
Surface Edit command instead. 

 
Object - Explode Explode a library object into its individual components. 

 

Object - Move Move an object to another location. The default option is a single 
selection. Use the secondary menu to select Window. 

 

Object - Rotate Rotate an object about a definable point in Plan, Isometric or Elevation 
view. The default option rotates a single object. The secondary menu 
provides a Window select option as an alternative. 
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Object-Rotate-
Three Angle 

Rotate an object about a definable point in Plan or Isometric view using 
individual specifiable angles of rotation (Orient, Tilt and Roll). The default 
option rotates a single object. The secondary menu provides a Window 
select option as an alternative. 

 
Object - Scale Scale an object to uniformly increase or decrease its size. 

 
Object Label - 
Delete 

Delete an individual object label. This is the default option. 

 

Object Label - 
Move 

Move an individual object label. 

 

Make Library 
Object 

Group individual objects into a reusable library object that is stored 
independently of the job file. Single select is the default option. Window 
selection is available from the secondary menu. 

 

Create Object 
Opening - Vertical 
Side 

Creates openings in vertical side surfaces of Objects. This is the default 
option. 

 

Create Object 
Opening - Flat Top 

Creates openings in flat top surfaces of objects. 

 

Create Object 
Opening - Flat 
Bottom 

Creates openings in flat bottom surfaces of objects. 

 

Delete Object 
Openings 

Deletes openings in objects. 

  

Page Builder Mode Toolkit 

Page Builder Toolbar 

The Page Builder toolbar provides tools that assist in creating custom output in AGi32. 

Button Button Name Command 

 
New Report Create a new Report 

 
Open Existing Report Load an existing Report 

 
Save Report 

  

Save the current report as a template to use with other job files. 

 
Report Properties Change the current reports properties (page sizes, protection, 

page names, etc.) 

 

Current Page Displays the current page number and total page count. 

 
Display Previous Page Displays the previous page in the report. 
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Display Next Page Displays the next page in the report. 

 
Set Current Page As 
Master Page 

Sets the current page as the Master design template for easy 
specification of repeating elements across the report. 

 
Clear All Entities From 
Current Page 

Clears the current page of all entities. 

 
Delete Current Page Deletes the current page and all its elements. 

 
Insert Blank Page Inserts a blank page after the current page. 

 
Insert Copy Of Current 
Page 

Inserts a copy of the current page after the current page. 

 
Insert Saved Page Inserts a previously saved page after the current page. 

 
Lock/Unlock Page Toggles the Lock/Unlock status of the current page. Locking a 

page prevents it from being modified. 

 
Move Current Page Left Moves the current page to the left. 

 
Move Current Page 
Right 

Moves the current page to the right. 

 
Save Current Page Saves the current page for use with other job files. 

 
Create Viewport Create a dynamic Viewport that links to a View specified in Model 

mode. 

 
Create Imageport Create a static Imageport that contains a rendering, Instabase or 

graphic image. 

Render Mode Toolkit 

Render Viewpoints Toolbar 

The Render Viewpoints toolbar provides controls for creating animated viewpoints in you rendered environment that can be exported as movies. 

Button Button Name Command 

 
Render-Viewpoints Create custom viewpoints to use in AGi32 and VRML players. To add the 

current Viewpoint to the list use the F2 keyboard button. 

 
Render-Current 
Viewpoint Scene 

Indicates current scene and allows user to select alternate scene if defined. 
Scenes are definable in Viewpoints dialog. 

 
Render-Viewpoint 
Slideshow 

Scroll through the defined viewpoints. 

 
Animate Viewpoints Animates the Viewpoints in the current scene using the Viewpoint parameters 

specified in the Viewpoints dialog. 

Statistics Window 

Statistics 

The Statistics Window displays the summaries of calculated metrics as well as Calculate options during the Calculation process. 

Button Button Name Command 

   The Statistics Window title bar indicates the current function. When the 
environment is being calculated, the Title Bar text changes accordingly. 

 
  While the environment is calculating, the current process is displayed. 

Processes include: Radiosity, Calc Points 

 
Cancel 
Calculations 

Cancel the calculations without completing. No calculation points results will 
be displayed. 

 
Stop Calculations Stop the calculation process at the current stage. If the radiosity process is 

stopped prematurely, calculation points will be computed from the current 
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Pause 
Calculations / 
Resume 
Calculations 

Pause the calculations to interact with the environment, then resume 
calculations. Note, the calculation process need not be paused to interact 
with the environment in Render mode (you can navigate and change the 
display properties while calculating), however pausing the calculations may 
be desirable to free up some CPU resources if needed at a given time. 

Calculations may be paused in Model mode or Render mode. 

Note: minimizing AGi32 while calculating will allocate the calculation 
processes lower priority amongst other processes if desired. 

 

Radiosity 
Stopping 
Criterion 

The Light Absorbed value indicates how much of the progressive radiosity 
solution has been completed. 

The progress bar indicates how much time is left (graphical indication) and 
the Total Time Completed, Left and the estimated completion time are shown 
as well. 

 

Statistics Displays the summary information for calculation entities such as point x 
point grids, LPD/UWLR Areas and Statistical Areas. 

Restoring Toolkits 

To restore the default factory Toolkit positions, click on the Tools-Restore Default Toolkits command. 

  

Displaying Toolkits - Concepts 

The AGi32 Model Toolkit and Statistical Window can be moved across the desktop to other positions, and docked left or right.  The Common 
Toolbar, Control bar and Status bar cannot be displayed any differently than their default factory positions.  

Toolbar icons cannot be altered in any Toolkit or Toolbar.  

  

Displaying Toolkits-Procedures 

Toolkit location options and display styles are available from the Toolkit menu,  which is accessible by right-clicking on the Toolkit titlebar: 
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• Toolkits can be easily switched on and off from the Toolkit and Statistics switches on the Status Bar.  

• Toolkits may be docked on the left or right side of the desktop, or displayed floating over the desktop.  Their widths and heights may be changed 
as well.  

• Docking options are available by right clicking on the Toolkit title bar.  To undock a Toolkit you may also drag the Toolkit towards the desktop 
and place it where you want it to go.  To graphically redock it, drag it beyond the edge of the desktop until it seats into place. 

Dock Left/Right: Docks the selected Toolkit left or right on the desktop. 

• Initial size is set to the last known floating size (size when undocked). Toolkits can be resized once docked. 

• Docking Priority – First Toolkit docked is on top, second Toolkit docked is on bottom. You can flip the position of Toolkit by undocking BOTH 
Toolkits and re-docking in the desired order (first-top, second-bottom). Simply undocking and re-docking a Toolkit does not change its position 
in the docking window! 

• Docked Toolkits are integrated into the desktop and therefore, take up working space. 

• Auto Undock (transparent command): Docked Toolkits can be undocked by simply moving the Toolkit while docked.  To move a Toolkit, left-
click and hold on the Toolkit titlebar and move the mouse. 

• Auto Dock (transparent command): Undocked Toolkits can be re-docked by simply moving the Toolkit off the left or right edge of the working 
area.  The Toolkit will automatically dock when approximately ¼ of the Toolkit is outside of the working area. 

• Disconnected Toolkits can NOT be re-docked in this manner. Use the Dock Left/Right options instead. 

• Toolkits are docked using a last in, on top hierarchy.  Therefore, if you want the Model Toolkit to be displayed above the Statistics Window, dock 
the Statistics Window first, then dock the Model Toolkit. 

Align Left/Right: Undocks and floats the selected Toolkit left or right on the desktop. 

• Initial size is set to last known floating size (size when undocked).  Toolkit can be resized at any time. 

• Undocked Toolkits are not integrated into the desktop and, therefore, do NOT take up any working space.  However, since they ‘float’ over the 
workspace, they may obstruct the working area and may need to be moved or resized to minimize their impact. 

• Undocked Toolkits CANNOT be moved off of the working area unless they are disconnected (see Disconnect). 

Disconnect: Undocks and floats the selected Toolkit  

• Disconnect undocks and floats the selected Toolkit. 

• Initial size is set to last known floating size (size when undocked).  Toolkit can be resized at any time. 

• Disconnected Toolkits are not integrated into the desktop and, therefore, do NOT take up any working space. However, since they ‘float’, they 
may obstruct the working area and may need to be moved or resized  to minimize their impact. 

• Disconnected Toolkits can be moved off of the working area.  This is a great way to maximize workspace if you have a large monitor or use 
multiple monitors (workspace on one monitor, Toolkits on the other monitor). 

• Once disconnected, the Disconnect menu option is changed to Reconnect.  This allows you to reconnect the toolkit to the desktop (has the 
same affect as Align Right) 

Default Style - Toolbars within the Toolkit are displayed one at a time. 

• The selected toolbar is moved to the bottom of the list and opened for easy access. 

• Depending on the size of the Toolkit, it may be necessary to resize the Toolkit in order to see all tools in the toolbar. 

Shutter Style - This option allows you open multiple toolbars within a Toolkit at a time. 

• The order of the toolbars does not change when you open and close a toolbar. 

• Opening multiple toolbars will most likely require Toolkit resizing in order to display all of the tools in all of the open toolbars. 

• Caution: This display style is only recommended for computers setups that have a lot of screen space (large or multiple monitors and/or high 
screen resolution).  Otherwise, the likelihood that tools within a toolbar are not visible is very high.  The minimum recommended screen 
resolution to use this option is 1280x1024. 
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Restoring Toolkits-Concepts 

The Restore Default Toolkits command restores the Mode Toolkits and Statistical Window to their factory provided settings and positions. 

Technical Details 

Toolkits may be restored in any Mode (Model, Render or Page Builder).  

Toolkits cannot be customized, except for their current position and width. 

  

Restoring Toolkits-Procedures 

The Restore Default Toolkits command restores AGi32 Toolkits to their factory provided positions and settings.  This command may be activated at 
any time to restore your own Toolkits to their default positions. 

 From the Tools menu, choose Restore Default Tookits 

  

Keyboard Shortcuts 

The Keyboard Shortcuts and command modifiers listed below provide access to many AGi32 commands and functions directly from the keyboard. 
You can also assign custom keyboard shortcuts, in addition to these factory defaults, with Quick Commands. 

Function Keys  Model Render Page Builder 

F1 Context sensitive help Context sensitive help Context sensitive help 

F2   Viewpoints - Quick Add - 

F3 Toggles SnapTo On/Off * - - 

F4 Invokes ‘arc’ command during 
the following commands: 

• Calculations - Line 

• Calculations - Polygon 

• Calculations - Stat Area 

• Calculations - LPD/UWLR 
Area 

• Drawing Entity - Line 

• Object - Rect - VE 

• Object - Round - VR 

• Object - Polygon - Flat 

• Object - Polygon - VE 

• Room - Rect - Flat 

• Room - Round - VR 

• Room - Polygon - Flat 

- Invokes ‘arc’ command during 
the following commands: 

• Drawing Entity - Line 

F5 When specifying an ‘arc’, flips 
direction of arc 

Flips grid normal when 
specifying the following 

- When specifying an ‘arc’, flips 
direction of arc 
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calculation types: 

• 2pt-Grid-Normal Meter 

• 3pt Grid–Normal Meter 

F6 - Applies Anti-Aliasing (if level > 
None) 

- 

F7 - Toggles Model Overlay On/Off - 

F8 Toggles Ortho On/Off * - Toggles Ortho On/Off * 

F9 Toggles Snap On/Off * - Toggles Snap On/Off * 

F10 - Toggles Textures On/Off - 

F11 - Toggles Wire Overlay On/Off - 

F12 Calculate Calculate Calculate 

  

Key Pad Model Render Page Builder 

Left Arrow View - Pan - Left Interactive – Drag mouse left View - Pan - Left 

Right Arrow View - Pan - Right Interactive – Drag mouse right View - Pan - Right 

Up Arrow View - Pan - Up Interactive – Drag mouse up View - Pan - Up 

Down Arrow View - Pan - Down Interactive - Drag mouse down View - Pan - Down 

Shift+Left Arrow View-Isometric - Rotates view 
+5 degrees 

Slows interactive action - 

Shift+Right Arrow View-Isometric - Rotates view -
5 degrees 

Slows interactive action - 

Shift+Up Arrow View-Isometric - Tilts view -5 
degrees 

Slows interactive action - 

Shift+Down Arrow View-Isometric - Tilts view +5 
degrees 

Slows interactive action - 

Ctrl+Left Arrow - - Pan contents of active 
Viewport left (click in Viewport 
to activate) 

Ctrl+Right Arrow - - Pan contents of active 
Viewport right (click in Viewport 
to activate) 
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Ctrl+Up Arrow - - Pan contents of active 
Viewport up (click in Viewport 
to activate) 

Ctrl+Down Arrow - - Pan contents of active 
Viewport down (click in 
Viewport to activate) 

Ctrl+Shift+Left Arrow - Speeds up interactive action - 

Ctrl+Shift+Right Arrow - Speeds up interactive action - 

Ctrl+Shift+Up Arrow Dynamically increases the size 
of a schedule when placing 

Speeds up interactive action - 

Ctrl+Shift+Down Arrow Dynamically decreases the 
size of a schedule when 
placing 

Speeds up interactive action - 

PgUp Increments Z-coordinate by 
current snap value 

- Increments Z-coordinate by 
current snap value 

PgDn Decrements Z-coordinate by 
current snap value 

- Decrements Z-coordinate by 
current snap value 

Ctrl+PgUp     Display Next Page 

Ctrl+PgDn     Display Previous Page 

Home View - Zoom-In - View - Zoom-In 

End View - Zoom-Out - View - Zoom-Out 

Ctrl+Home - - Zoom in on contents of active 
Viewport (click in Viewport to 
activate) 

Ctrl+End - - Zoom out from contents of 
active Viewport (click in 
Viewport to activate) 

  

Control Keys Model Render Page Builder 

Ctrl+A Add - Luminaire - Location - - 

Ctrl+C Edit - Copy Edit - Copy - 

Ctrl+D - - Toggles Viewport Visibility 
On/Off 
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Ctrl+F  Modify - Luminaire - 
Parametric Mirror Off 

- - 

Ctrl-N  Modify - Luminaire - 
Parametric Mirror On 

- - 

Ctrl+O   File - Open File - Open File - Open 

Ctrl+P  File-Print File-Print File - Print File - Print File - Print 

Ctrl+S File-Save File-Save File - Save File - Save File - Save 

Ctrl+V - - Edit - Paste Directly To 
Imageport 

Ctrl+W - View - Viewpoints - 

Ctrl+Z Edit - Undo - Edit - Undo 

 

Misc Model Render Page Builder 

Esc  Edit - Cancel Edit - Cancel Edit - Cancel 

Enter numeric value on 
keyboard 

- Sets Eye Position and Focus 
Position to that height 

- 

  

Modifiers Model Render Page Builder 

Shift 
Press and hold 

Filters by current Z-coordinate 
value when selecting 
luminaire(s) 

- - 

Ctrl 
Press and hold 

Disables parametric mirror 
when Re-Aiming or Re-
Oriented a luminaire 

- - 

Shift+Ctrl 
Press and hold 

During Luminaire - Locate & 
Aim command, advances to 
next aiming point while 
maintaining the last luminaire 
location (skips extra click to 
specify luminaire location) 

- - 

* A note regarding Snap, SnapTo, Ortho and keyboard entry prioritization: A data entry hierarchy has been established to prevent Snap, SnapTo, 
Ortho and keyboard entry (typing values) conflicts.  The hierarchy, from highest to lowest, is: Keyboard entry, Ortho, SnapTo, and Snap.  For 
example: As the cursor is moved, Snap is applied to the coordinates.  As the cursor gets close to another entity, SnapTo takes over (if it is enabled).  
If Ortho is enabled, the "snapped" or "snapped to" coordinates are controlled by Ortho, disallowing diagonal movement or selection.  Entering 
coordinates via the keyboard overrides all three of the other settings, even if they are enabled. 

  



AGi32 Help System  What’s New in AGi32? 

31 

 

Network License Check In/Out 

This command allows network licensed users of AGi32 (both LAN and WAN versions) to check out a license as a standalone copy. 

You may checkout a license for up to 30 days, at which time the standalone version will expire.  An expired copy will need to be reregistered as a 
single user license or network license.  

A checked out license can be checked back in at any time to return it to the pool of network licenses.  Checked out licenses should be checked in, 
rather than let expire, once the standalone capabilities are not required, so that other users may have access to the license (e.g. 5 licenses are 
available from the network instead of 4). 

A few important notes about this functionality: 

• When the standalone version expires, so will the checkout copy on the network server.  This will restore the license availability to the pool of 
licenses. 

Note: There may be a lag, of up to several hours, between the times when the checkout out license expires and when the expired license is 
returned to the pool.  It is best to check the license back in instead of letting it expire. 

• The AGi32 server software includes the option to disallow network license checkout. This is the default option.  The server service must allow 
license checkout in order for the client to include this functionality.  If the server does not allow network checkout, an error message will be 
displayed. 

• Each time standalone copy is activated, a message will display indicating the number of days left. 

Checking out a network license 

1. From the Tools menu, select Network License-Network License Check In/Out. 
2. Click Ok to check the network license out. 
3. To check the license back in, repeat steps 1 and 2. 

  

Getting Help 

Using the HTML Help Viewer 

The HTML Help Viewer displays the selected topics alongside an integrated table of contents, index, and a full-text search feature so you can find 
information easily.  Book icons open to reveal topic entries and sub-books.  The HTML Help Viewer has the added benefit of allowing you to see the 
table of contents, index, or search results at the same time you are viewing a Help topic.  This orients you within the Help system and allows you to 
see all of the other applicable Help topics at a glance. 

The Help Viewer also includes the Favorites and Glossary tabs.  The Favorites tab is used to bookmark topics.  This enables you to quickly display 
topics that you refer to often.  The Glossary tab provides descriptive information about software and lighting terminology used in AGi32. 

Resize the HTML Help Viewer 

The HTML Help Viewer can be resized by dragging on the Viewer edges.  A double-sided arrow appears when the cursor is rested over the Viewer 
edge.  Drag the cursor to the desired location to increase or decrease the Viewer size.  You may also drag the entire Viewer to another location to 
see AGi32 underneath.  The HTML Help Viewer will recall its last location and size each time it is viewed. 

Show/Hide the Left Pane 

 

Hide Button 

The Left Pane containing the Navigation tabs (Contents, Index, Search, Favorites and Glossary) is displayed with 
AGi32 by default. This pane may be hidden from view by clicking on the Hide button. 

  

When the Left Pane is hidden, the Hide button is toggled by a Show button. Clicking this button, will restore the Left 
Pane. 

The Left Pane may also be resized by dragging its right edge (dividing it from the Main view) left or right to decrease 
or increase its size. The adjusted size is saved and recalled each time the HTML Help Viewer is displayed. 
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Show Button 

Browse buttons 

The HTML Help Viewer provides Back and Forward navigation buttons just like a browser does. 

 

Back Button 

The Back button takes you back to the previous topic that was displayed in the HTML Help Viewer. You may continue 
navigating back until the first topic is displayed. 

 

Forward Button 

The Forward button displays the topic that was displayed prior to going back. It is not enabled unless you go back through 
your topics. 

Locating Topics in the Contents tab 

The Locate button displays the current topic's location in the Table of Contents. This feature is useful for finding other related topics in AGi32. 

Find a Topic 

The Navigation tabs displayed in the Left Pane of the HTML Help Viewer provide multiple methods for finding information. 

Contents 

The Contents tab displays the Table of Contents for AGi32. The Table of Contents displays books containing sub-books and topics. Double click on a 
book to reveal its contents; double click on a topic to display it the HTML Help Viewer. 

The Table of Contents provides organized content from which you may select any number of topics and technical assistance. 

Index 

The Index provides a list of index entries associated with AGi32. You may type a word or scroll through the list searching for index entries. Topics are 
often indexed under more than one entry. 

Double-click an index entry to display the corresponding topic. 

Search 

The Search tab allows you to search for every instance of a word or phrase in AGi32. In the Search tab, type the word or phrase for which you want 
to search, and then click List Topics. For some search tips, click here. 

Double-click the Topic title in the Select Topic list to display the corresponding topic. 

Favorites 

The Favorites tab allows you to store your most frequently accessed Help topics.  Each time the HTML Help Viewer is displayed you may select any 
topics you have added to this tab.  To place a topic in the Favorites tab, click the Add button once it’s displayed in the right pane of the Viewer. 

The Favorites list may be updated at any time and little viewed topics may be removed from the Favorites list. 

Glossary 

The Glossary tab provides a definition list for terms used in AGi32.  Definitions are shown for the selected Glossary items in the lower portion of the 
Glossary tab. 
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Searching Tips 

• Topic lists may be sorted by Rank, Location or Title. 

• Searches are not case-sensitive; queries may be entered in uppercase or lowercase characters. 

• You may search for any combination of letters (a-z) and numbers (0-9). 

• Punctuation marks (i.e., period, colon, semicolon, comma, and hyphen) are ignored during a search. 

• To search for an exact phrase, use quotation marks or parentheses to group the words together.  You cannot search for quotation marks. 

• Boolean expressions - Advanced searching functionality is added by using the conjunctions AND, OR, NEAR and NOT.  Conjugations may be 
typed or added using the small right facing arrow to the right of the Search text box. 

Search Type Description 

Search Previous Results Allows you to narrow your search by considering only the 
previous results in the search list. 

Match Similar Words Uses words similar to the searching terms in the display. This 
option is enabled by default. 

Search Titles Only Searches only topic tiles (not entire text) for search word or 
phrase. 

• Wildcard expressions - You may search for words using wildcard characters or partial words in the Search tab. 

Wildcard Expression Example Results 

single word or partial word illum All words with "Illum" within are searched: 
illuminate, illumination, illuminance, etc. 

phrase exitance meter If the words exitance meter are encased in 
parentheses ("exitance meter") the exact phrase is 
serched for.  If exitance meter is entered, topics 
are shown that contain both words, although not 
necessarily together. 

asterisk (*) *.AGI All words with a .AGI extension will be displayed. 

  

Browse Sequences 

Browse Sequences combine related topics into a linear sequence that is displayed at the top of the right pane in the HTML Help Viewer. Browse 
sequences allow you to move sequentially through the topics or select any topic individually. 
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Browse sequences may be selected from the Select Browse Sequence menu. 

 

Topics in the browse sequence are shown in order from left to right. To see 
additional topics in a long browse sequence, click the arrows on either side of the 
Browse Sequence display. 

 

The Previous button selects the previous topic in the Browse Sequence. 

 

The Next button selects the next topic in the Browse Sequence. 

   

Obtaining Technical Support 

Support options from real people 

A variety of options are available when looking for assistance on a specific issue that cannot be easily solved using on-line or written documentation.  
Lighting Analysts is dedicated to assisting our users in every way possible and takes great pride in the level of support we provide.  Regardless of 
where you purchased your AGi32 software, you will have the timely attention of highly qualified people when looking for assistance. 

In the United States and Canada 

Most users' in the USA and Canada have purchased the software directly from Lighting Analysts in Colorado. Others will have specific partnerships 
with professionals responsible for placement and maintenance of the software.  See below for a list of representatives around the world. 

SupportPlus 

Lighting Analysts offers an annual support and maintenance agreement to insure access to the latest software in production and priority telephone 
assistance.  This agreement is called SupportPlus, and may be obtained at any time through Lighting Analysts in Colorado or through our 
international affiliates (benefits may vary). 

User's subscribing to SupportPlus receive unlimited priority telephone support by supplying their LAI user number (assigned at the time of product 
registration).  In addition, SupportPlus users will automatically be shipped, or provided access to, all standard product upgrades released during their 
membership completely free of charge.  Unlimited Email, Web and Fax support are provided. 

Without SupportPlus 

Users electing not to subscribe to SupportPlus are provided 30 days free telephone support from the date of product registration.  Your user number 
is required. All users are provided free unlimited Email, Web and Fax Support. 

Telephone number for first 30 days: 303.972.8887 (user # required) 

Email: help@agi32.com, or support@agi32.com  



AGi32 Help System  What’s New in AGi32? 

35 

 

Website: www.agi32.com 

Fax: 303.972.8851 

General contact information in the U.S.A. 

Lighting Analysts, Inc. 
10440 Bradford Road 

Littleton, CO 80127 U.S.A. 

Telephone: 303.972.8852 

www.agi32.com 

Email: info@agi32.com 

Fax: 303.972.8851 

International Representatives - listed on www.agi32.com  

Accessing Lighting Analysts Website 

You may access Lighting Analysts website directly by selecting the Help On the Web option from the Help menu.  

Access is provided to helpful sections of the website.  

• Support Page provides many links for obtaining immediate support responses as well as links to software downloads, training calendar, contact 
information and more. 

• The Knowledgebase provides a valuable reference for AGi32 users with FAQs, bug reports, known issues and possible work arounds. 

• The Submit Support Report link allows you to contact our Customer Care department directly for help with AGi32. Your local user and computer 
information is extracted automatically and sent to Customer Care for speedier resolutions. 

• The Forums link access Lighting Analysts' User Forums for input on presales questions, best practices, wishlist entries and news. 
• The E-Store allows you access your purchase history, buy products and obtain updates (login is required). 
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AGi32 Overview 

AGi32 Overview - An Introduction 
 

Now that you have installed AGi32 and perhaps even experimented with the program, it is helpful to read a brief overview of the software’s capability 
and function as imagined by the authors.  The sections following this introduction present more detail for the topics mentioned here.  Be sure and 
review the Project Checklist if you do nothing else, while everyone has their own method of learning and working, a few tips toward efficient use of 
the software may assist with the learning process. 

AGi32 is a software tool used to predict the photometric performance of selected luminaires or daylight penetration in a simulated environment. The 
environments that can be considered by AGi32 range from a simple interior space to a multilevel interchange or complex auditorium. AGi32 provides 
the appropriate tools to deliver the lighting analysis regardless of project complexity.  

The AGi32 user interface is graphical and CAD-like as the primary function of the software involves the construction and analysis of architectural 
models. A graphical interface is proven to be the most flexible and accepted method for this task. Users of CAD software will find AGi32 to be 
complimentary of other familiar software programs. Within the graphical environment, button toolkits are used to present the frequently used 
commands most efficiently. All buttons are redundant for functions also available from the pull-down menu system. 

When using AGi32 to predict photometric performance, AGi32 allows you to select from two calculation methods when simulating a lighting 
application. The Direct Only Method is a simplified calculation technique used when reflected light need not be considered in the results. This method 
lends itself particularly well to exterior lighting applications and environments with low reflectance surfaces and uses considerably less computation 
time. The Full Radiosity Method is required in all other cases and is capable of predicting the interaction of light with reflective surfaces in any 
environment. The Full Radiosity Method is required for rendered results and for daylighting computations. 

AGi32 is capable of a number of lighting specific computations aside from the basic incident illuminance (fc/lux) on any real or imaginary surface. The 
software can also compute pavement luminance for roadway and tunnel applications per IESNA-RP-8-2000 and RP-22-2004, Glare Rating, Unified 
Glare Rating (CIE metrics for discomfort glare evaluation), and Daylight Factor on any real or imaginary surface for use with LEED specifications of 
usable daylight penetration. To compute the amount of light leaving any real surface, use the Exitance and Diffuse Luminance metrics available from 
the Automatic Placement dialog. 

AGi32 is a stand-alone tool.  This means that no other software is required to create or present the calculated and rendered results, however, a 
common method of project preparation involves the import of CAD created entities. These may be simple line drawings, or 3D objects. AGi32 is able 
to read the CAD created information from DXF (Drawing Exchange Format) or DWG (AutoCAD native format) files created in most CAD software. 
The topic “Importing DXF and DWG Files” provides background information about the underlying architecture and systems that are used in AGi32's 
CAD import function. 

When your work in AGi32 is complete, much of the information can be exported to DXF or DWG format to be re-integrated with outside CAD 
drawings.  This is primarily used to send numeric results back to CAD for presentation with other project documents. 

The AGi32 software maintains a valuable relationship with many of the lighting industries most prominent luminaire manufacturers. Photometric 
databases of IES format information are delivered with the software and are constantly maintained with updates delivered through our webserver.  
Photometric data accessed in this way is guaranteed to function with AGi32 and is most easily searched and browsed for relevant products to suit 
your application. AGi32 will also read any photometric file in the following common formats: IES (.IES), CIBSE (.CIB, .TML, .CC, .C1S) and 
EULUMDAT (.EXL, .LDT). 

You will find AGi32 capable of a variety of presentation techniques to assist you in sharing the results of your work. AGi32 is WYSIWYG in that you 
can print or plot any view you obtain in the Model graphics mode.  Flexible schedules, dimensioning, line and text tools are provided to assist in the 
creation of meaningful drawings.  This information can also be exported to DXF or DWG for integration with CAD.  Renderings can be exported as 
single views to JPG or BMP, animated and saved to AVI, or exported as complete 3D worlds to VRML to share with others.  Collectively, both 
numeric and rendered information can be printed on user-customized reports using AGI32’s sophisticated Page Builder tool.  

   

AGi32 Overview - Interface 

The program’s user Interface is the screen you see, and in essence, how you interact with the programs capabilities. The first thing you may notice is 
the program is very similar to a modern CAD program. It is completely graphical in behavior and each project you create in AGi32 will be much like 
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constructing a working drawing in CAD. If you have never operated a CAD program, don't worry, it is not difficult. If you are on old hand with CAD, 
you will find much of this information familiar. 

Cartesian Coordinates 

Before working in a graphical interface (AGI = advanced graphical interface), you will need to understand the basic 3-dimensional Cartesian 
Coordinate system consisting of X, Y and Z axis. All entities placed in AGi32, whether they be Lines, Rooms, Objects or Luminaires, have locations 
described by coordinates phrased in (X,Y,Z) values. Notation such X=50, Y=20, Z=0 refers to a point in 3D coordinate space that is 50 units from the 
origin in the X-direction, 20 units from the origin in Y-direction and 0 units from the origin in the Z-dimension. 

When looking at the screen as you first open AGi32, you will notice a small X&Y coordinate marker in the lower left corner of the screen. This marks 
the Origin of coordinates (X=0, Y=0). What about Z you say? Well, Z (Zed) sticks straight out of the screen towards you. This is what is commonly 
referred to as PLAN view. Most of the work you will do takes place in Plan View. 

As you might imagine, in a 3-dimensional system, you have the opportunity to explore your work from many different viewing angles including 
Elevation and Isometric. An Elevation view is so titled as it refers to viewing your work from the side such that the Z-coordinate, or elevation above or 
below zero is in the primary viewing plane (flat on the screen). Elevation views can be established from any viewing direction and shortcut buttons 
are provided for the four primary views (N,S,E,W). Isometric views display your work in a 3-dimensional manner such that both the X and Y axis are 
visibly diverging towards opposite corners of the screen. All dimensions are displayed true size. Shortcut buttons are available for the four secondary 
viewing directions (NE,NW,SW,SE) as well as a user definable orientation and tilt of the coordinate system. 

Cursor Movement 

As you move your mouse within the drawing area, notice the Crosshair cursor moves and the X,Y,Z coordinates are displayed in the lower left corner 
of the screen. By default, the cursor moves in increments of one unit. This is referred to as a Cursor Snap of one (Snap=1). The cursor Snap can 
easily be changed such that the cursor movement is constrained to a smaller or larger number. This makes locating or selecting entities much easier. 
Similarly, the cursor can be constrained to move in only the X & Y planes, or left to right and up and down. This is called Ortho mode, an abbreviation 
for Orthographic. As a final alteration to cursor movement, AGi32 provides a Snap-To function. When enabled, this mode allows the cursor to 
automatically locate vertices or corners and snap the cursor to that position. This can greatly assist in the creation of complicated shapes on top of 
CAD created backgrounds. 

Units 

AGi32 can operate in either English or Metric units equally and translate between the two systems. When in English units, the cursor moves in either 
decimal feet or feet and inches and all dimensions are entered in decimal feet. When operating in Metric units, the cursor movement and all 
coordinate entry is given in decimal meters. 

Lighting metrics can be either English or Metric and can be mixed with the opposite units system. Generally, English operation is in Feet and 
Footcandles (Illuminance), Metric operation is in Meters and Lux (Illuminance). Units can be mixed to yield Feet with Lux or visa-versa. 

On first installation the program is set in English units. This can be changed on a per use basis or permanently from the Tools-System Settings 
command. 

Infinite drawing area 

When you first open AGi32 the screen displays a working area roughly 140x100 units (X by Y). While this might be more than enough area for a 
small interior application, it will be quite small relative to an outdoor site lighting project. Because the screen requirements of different types of 
projects you will encounter are so diverse, the program must be truly able to handle an infinite amount of area. Changing the display is performed 
with the mouse wheel (although Zoom commands may be employed instead). The amount of area covered on the screen can increase by Zooming-
out (scroll towards yourself with the wheel), or can decrease by Zooming-in  (scroll away from yourself with the wheel). The amount of Zoom has no 
effect on the actual size of the entities you have created. Just like a zoom function on a camera, it simply makes the entities appear smaller or larger. 
AGi32 supports functions for Zoom-In, Zoom-Out, Zoom-Window, Zoom-Extents, Zoom-Limits and Zoom-Center. 

While the screen representation is at a particular level of zoom, it is helpful to be able to move the image on the screen. This function is called PAN. 
In AGi32 you can the display in three ways, 1) by depressing the mouse wheel like a button and moving the mouse left to right or up and down on the 
desktop, 2) by simply selecting a point in space and dragging it to a new location, this is “Pan-Point”; 3) by selecting any point to be moved to the 
center of the display, this is “Pan-Center”. Keyboard shortcuts are also provided to Pan-Left, Right, Up and Down. Depressing the mouse wheel while 
holding down the Shift key on your keyboard will allow mouse movement to orbit around the last zoomed point (scroll mouse wheel). This can be a 
very handy way to view portions of your model that may be hidden from view. 

   

AGi32 Overview - Command Structure 

Now that you have an idea how a three-dimensional drawing environment functions, let's continue to examine the actual command structure of 
AGi32. When first opening the program you will find the majority of commands organized into a Toolkit on the right side of the desktop. These 
buttons are simply redundant for a number of commands accessible from the pull-down menus across the top of the screen. Additional view and 
control settings are available from toolbars at the top of the desktop as well as the bottom of the desktop. Most AGi32 commands are available from 
the pull-down menus, however, as users become more proficient, it is generally easier to use the buttons to select a particular command. 
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AGi32 commands are organized into groups by the type of entities they operate on, or the functions they perform. Looking first at the structure of the 
pull-down menus, you will notice familiar menus titled FILE, EDIT and HELP. Like most other software programs you may use, you can expect to find 
similar functions present in these menus. For example: File-Open, File-Exit, File-Import and other commands are available from the File menu. The 
more operation specific menus ADD and MODIFY contain commands designed to Add or Modify entities in the drawing. The VIEW menu contains 
commands that operate on what you see on the screen.  

The CONTROL BAR  provides access to all three desktop modes (Model, Render and Page Builder) as well as calculation parameters and 
commands, daylighting capabilities,  post-process ray tracing controls and design tools. The STATUS BAR at the bottom of the desktop contains 
commands that can be considered Tools providing peripheral functions or adjusting some parameters of program operation. 

While the pull-downs are all encompassing, the button toolbars and Toolkits are a much faster and more efficient way of using the major program 
functions. The button toolbars are arranged such that all buttons contained in each toolkit  are specific to a particular type of entity. Toolkits contain 
Add and Modify commands, the other toolbars contain global commands that are accessible in each mode, albeit perhaps uniquely as the 
functionality of each mode differs. For example: commands that operate on Luminaires are found on the Luminaire toolbar in the Model Toolkit. 
Commands specific to calculation points are found on the Calculation Points toolbar and commands relative to Rooms and Objects are found on the 
Room/Object toolbar, both in the Model Toolkit. Specific command titles can be displayed by pausing your mouse cursor over a button momentarily 
(that's called a ToolTip!). 

For the identity of each button please see the Toolbars topic. 

  

AGI32 - Calculation Methods 

Now that we have a basic understanding of the layout and organization of the program, let's discuss modes of operation and some basic premises in 
working with different types of lighting projects. 

The AGi32 software can be operated using two different calculation methods. The selection of the appropriate method is an important topic that 
should be clearly understood from your first calculation as they are intended for entirely different purposes. The two different methods are titled 
“Direct Only Method” and “Full Radiosity Method”. 

Direct Only Method 

This mode computes the Direct component of light arriving at any calculation point in space. Direct Only Method does not consider any 
interreflections. It does, however, consider the shadowing effect of 3-dimensional objects. What does this mean exactly? It means Direct Only 
Method will not calculate light that has hit one surface and bounced off toward another. It is therefore not a proper vehicle for the computation of 
indirect illumination for example. Direct Only Method considers light intercepted by a surface to stop at that point, a sort of black hole effect if you will. 
It does not bounce. 

For what sort of applications is Direct Only Method appropriate?Direct Only Method is designed to compute Illuminance for exterior site lighting, 
sports lighting, flood lighting and road lighting. It will consider objects as obstructions (shadow casting) and offers several time-saving features to 
shorten the already very fast computation time. 

Full Radiosity Method 

The Full Radiosity Method enables all the features found in AGi32 for the accurate computation of interreflected light. Full Radiosity Method is 
required for interior lighting applications, indirect lighting, daylighting, and when rendering is desired. Due to the rigorous nature of interreflected 
lighting calculations, Full Radiosity Method projects will always require additional run time over Direct Only Method projects of the same scale. 

Switching between Direct Only and Full Radiosity Method is as simple as a mouse click and can be performed anytime. When a project contains 
three-dimensional entities (Rooms and/or Objects), switching from Full Radiosity Method to Direct Only Method will change all three-dimensional 
entities into light blocking surfaces. All color and reflectance properties are disabled. 

  

AGi32 Overview - Background Drawings 

Generally speaking, for all lighting problems you will tackle, some type of background reference is required in order to present order to the 
appearance of any calculated information. For the most part (there are a couple small exceptions), AGi32 does not compute and present simple 
tables of numbers. Contrarily, AGi32 is geared toward presenting complete solutions for either interior spaces or complex exterior sites. Calculations 
are generally best displayed on top of a reference drawing. 

Reference drawings can be as simple as a few lines drawn to designate the limits of the project boundaries, or, possibly the lines delineating the 
perimeter of an interior space. Simple lines are easily drawn using drawing tools present in AGi32 and indoor spaces are displayed automatically 
after they have been created using the appropriate Room tool. On the other hand, many complex layouts are most effectively communicated when 
displayed on top of CAD created background drawings. For complex exterior sites, the use of a CAD created background is almost prerequisite. 

Drawings created in CAD must be exported from the CAD program in DXF or DWG format. They can in turn, be imported into AGi32 using the File-
Import command. AGi32 will read DWG and DXF format files from most versions of AutoCAD and many other programs. There are certain entity 
types that may not translate, this information can be found in the help topic “Importing and Exporting Files”. 
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CAD models containing three dimensional surface information can also be imported into AGi32 via DXF or DWG file. AGi32 is able to read most 3D 
surface entities directly providing the ability to import anything from simple objects to complement your models to complete 3D architectural models. 
More on 3D import capability. 

   

AGi32 Overview - Photometric Library 

New users may already have a substantial quantity of photometric files stored on their computer systems. AGi32 can access your existing library of 
photometric files easily using the Select command form within the Luminaire Define dialog. However, photometric files contained with in the AGi32 
photometric library are specifically prepared to take full advantage of AGi32's Instabase capability and should be considered over older files of the 
same manufacturer. 

While AGi32 will read photometric files from any location, the real power of photometric selection is more truly realized when using our Instabase 
(Instant Database) tool with photometry constantly maintained by manufacturers on the Instabase System web server. Each manufacturer 
participating has prepared their data for optimal presentation with AGi32 by breaking down their products into categories,incorporating photographic 
images, relevant web links and even custom luminaire symbols (not all manufacturers have taken all steps yet). This makes product selection faster, 
easier, more accurate, and fun! 

Installing manufacturers Instabase files 

You can install photometrics from the Instabase System at any time and as often as you like. The process is all contained within AGi32 and no 
external file manipulation is required. In a typical scenario, you may install several manufacturers immediately and then return later to install 
additional manufacturers data.  

To install photometry from the Instabase System, begin by starting AGi32. Select the Luminaire Define command from the Luminaire toolkit. Now 
select the Instabase button at the top of the Luminaire Define dialog followed by the Manage button in the Instabase dialog. The Manage Photometric 
Instabasesdialog will be displayed. If you have a persistent Internet connection (broadband or from your corporate network), the Download.Subscribe 
tab will show the list of manufacturers currently available. 

The AGi32 Instabase System provides a convenient subscription service where users can elect to receive automatic notification when a revision has 
been posted by the manufacturer. Subscribing is optional when an Instabase File is downloaded (they are separate checkboxes) but it is highly 
recommended. Furthermore, it is an option to allow manufacturers to contact you if you wish but this is not the default setting.  

 

Select the manufacturers Instabase Files of interest (start with one or two) and click on the "DO IT!" button at the bottom of the dialog. The selected 
Instabases will automatically be downloaded and added to the list of available manufacturers photometry. Close the Manage Photometric Instabases 
dialog (you can return anytime) and all your manufacturers will be available from the pull-down menu adjacent to the Manage button. 

Once you select a manufacturer from the pull-down menu, you can navigate through a product tree by opening successive nodes (marked with a + 
sign). At each node level a graphic image will appear relevant to the node contents. If the node contains photometric files, a listing of all files 
contained in that node is displayed. You can then see descriptive information for each file by clicking on that file with a single mouse click. The 
descriptive information is extracted from the photometric file and is prepared by the manufacturer. If the photometric file does not correspond to the 
node level image, a different image will be displayed. 

In addition, once you are clicking on the individual file level, you can view polar (or Cartesian, for Type B) candela plots of the luminaire distribution. 
This photometric information can be examined more closely by clicking on the More button in the lower right corner of the screen. 

Once you find a photometric file you are interested in using, simply highlight it and click OK to return to the AGi32 Define Luminaire Dialog. 

Querying the Instabase 

The Instabase also has a powerful query function to search for files matching a certain set of criteria, (e.g., lamp type,  wattage, LCS rating or LER). 
You can then scroll through descriptive information for each file retrieved by the query and select the file of interest to bring it back to AGi32. 
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The Instabase concept provides file search and retrieval with the ease of an electronic catalog for manufacturers participating in the Instabase 
System. This presents an attractive avenue for product selection immediately within the bounds of the AGi32 program. If there are other 
manufacturers you would like to see place their photometric data in the AGi32 Instabase System, please do not hesitate to tell them about it or ask 
them to contact Lighting Analysts at info@agi32.com. . 

   

AGi32 Overview – Calculations and Rendering 

AGi32 is a multi-purpose lighting design tool that will serve you best if its capabilities are clearly understood with respect to the requirements of the 
various projects in which you will employ it. For example: The data you are likely to present for a Parks and Recreation level softball field will most 
likely be quite different than that of a commercial interior. Similarly, the approach you use to analyze the two projects in AGi32 will utilize different 
tools. 

The first questions you should answer before starting on any project is what aspects of the environment are important to the lighting analysis and 
what are you expecting for an end result? The following table should help you setup the problem within the AGi32 software in order to get the proper 
results. 

Example project Desired results Relevant commands 

Calculation 
Method 

Surfaces Calculation points  Render 

Softball or area 
lighting 

Numeric point x 
point, statistics, 
schedules, export 
to DXF 

Direct Only 
Method: 
AutoCalc On 
(optional) 

None or Objects for 
shadow only 

Polygon No 

Commercial 
interior  

Numeric point x 
point, statistics, 
schedules, export 
to DXF 

Full Radiosity 
Method 

Yes: Room and 
Objects 

Automatic 
placement 

Automatic in Full 
calc mode with 
surfaces, just go 
to Render mode 

Commercial 
interior with 
visualization 

Same as above 
plus rendering, 
cannot export 
rendering to CAD 

Full Radiosity 
Method 

Yes: Room and 
Objects 

Automatic 
placement 

Export BMP,JPG 
or VRML, Ray-
trace (optional) 

Exterior with 
visualization 

Same as above Full Radiosity 
Method 

Objects for ground Polygon, 2pt, 3pt 
or automatic 
placement 

Export BMP,JPG 
or VRML, Ray-
trace (optional) 

Daylighting Same as above Full Radiosity 
Method 

Exterior or Interior 
model 

Any Export BMP,JPG 
or VRML, Ray-
trace 

Roadway Numeric, IES or 
CIE luminance 
computations 

Direct Only 
Method 

No (automatic for 
luminance calcs) 

Roadway 
Luminance 

No 

Roadway with 
reflective 
geometry (tunnel) 

Numeric, IES or 
CIE luminance 
computations 

Full Radiosity 
Method 

Room and Object, 
tag as Roadway 
contributor and 
Roadway Pavement 
surface in Surface 
Edit 

Roadway 
Luminance 

Yes 

  

AGi32 Overview  - Presentation 

AGi32 provides many different ways to present your work from printing or plotting the drawing and numeric data you have prepared, to exporting 
rendered images as single view bitmaps or complete 3D VRML worlds. There are a variety of methods and your choice will most likely depend on 
your needs at the moment. The different methods are outlined below. 

Page Builder 

Page Builder is AGI32’s custom report layout tool. When accessed initially, Page Builder presents a blank report (you select the page size and page 
count) for you to layout your presentation. You may include your CAD views, renderings, company logo, schedules, text, almost anything you need to 
create a complete and dynamic layout. It is a WYSIWYG tool - what you see is what you get. Once your content is ready for presentation, all you 
have to do is lay it out in your report. 

Unique to Page Builder are two different types of graphics placeholders: Viewports and Imageports. Viewports link to views you have specified in 
Model Mode (numeric information such as point by point). If you'd like to include multiple Viewports with different information in each one, simply 
define and specify multiple views in Model Mode. This is achieved with View Manager. Each Viewport may be assigned a custom print scale. The 
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scale you choose will depend on the content you are displaying and the overall paper size. Imageports contain bitmap images which can be 
automatically retrieved from Render mode views, Ray-trace images, Daylight Study images, Instabase luminaire images and photometric information 
or any bitmap (BMP or JPG) on your computer system.  

All schedules can be added directly to your Page Builder report instead of being added to a view in Model Mode. Text notes, Smart text, title blocks 
and logos may also be added directly to your custom page. Once your presentation is complete, you can save the report format for repeated use. To 
print the report, simply output directly to a printer or plotter. It is also possible to print to PDF with Adobe Acrobat.  

More information about Page Builder 

Specifying multiple views with View Manager 

Render Mode 

Toggle Model mode entities on top of the rendered environment to create highly informative composite images where you can combine numeric and 
graphical results for presentation. 

Render mode provides two still image export options ( BMP / JPG Export) and a 3D export option: VRML Export 

BMP / JPG Export - Export your current Render view as a BMP or JPG format image. We suggest specifying an anti-aliasing sampling level before 
the export operation to smooth out any jagged edges in your image. 

VRML Export - Export the entire rendered environment as a VRML file (Virtual Reality Modeling Language). VRML files are complete 3-dimensional 
reproductions of your AGi32 rendering. They can be walked through, rotated, turned and viewed from any point. This is an ideal communication 
medium for designers and tech-savvy clients. Send a VRML file attached to an email and the party on the receiving end can open and tour with the 
aid of a VRML viewer, many of which are freely available on the Internet. VRML Export does not include texture mapping or Model Overlay entities. 

In addition, you may export animations from AGi32 as movie files. Movie files may contain multiple scenes, up to 30 fps and be comprised of 
customizable image sizes. The calculation techniques contained within each movie file may be radiosity based or ray traced. 

More information about Render mode 

Anti-aliasing settings 

Model Mode - CAD Export 

Export your AGi32 environment as a CAD compatible DXF or DWG file. The CAD file will include all visible AGi32 layer information as 3D line and 
text information. The layer structure in the exported CAD file can be customized to suit your needs or you can use the Layer Structure shown in 
Project Manager. 

Exporting CAD Files 

Model Mode - Print View 

Print the contents of any View in Model Mode using this option. 

Printing in Model mode 

Model Mode - Print Text 

Print detailed reports about the illuminated environment using this feature. The Print Text command allows you to select from a list of possible 
content. You can also include a customized Title page. 

Printing Text in Model Mode 

    

AGi32 Overview - Project Checklist 

The methods you employ to tackle Interior versus Exterior projects may differ slightly depending on your goals for the final result. The following 
checklist will assist you in planning for success in your early endeavors with AGi32. 

Exterior projects 

Many applications performed with AGi32 fall into the realm of exterior site lighting, flood lighting, sports lighting and roadway lighting. Generally, 
these applications share common goals and can be tackled with similar techniques. There are exceptions, of course, and we will discuss these briefly 
at the conclusion of this section. 
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Exterior problem definition 

Exterior lighting application with desired end result to be point-by-point computations displayed on top of a CAD generated background. Output may 
be plotted or exported to CAD via DXF or DWG formats. 

Exterior project - Steps for success 

Step 1 - Open AGi32 

Step 2 - Use the File-Import command to bring in the desired drawing background from CAD generated DXF or DWG file. A simple alternative to this 
may be to draw the site details using the drawing tools provided by AGi32. A digitizer interface is also available for large format tablets able to trace 
paper drawings. 

Step 3 - Define the luminaire photometrics to be used in the application using the Luminaire-Define command. You can easily define Single, or a 
variety of multiple head configurations including Arm length. 

Step 4 - Create any 3-dimensional Objects required in the application. 

Step 5 - Place calculation points on the ground or Workplane using one of the calculation points commands: 2-point grid, 3-point grid, or polygon. To 
put points on surfaces directly, use the Automatic Placement command. 

Step 6 - Remove any excess calculation points using the Modify Calculation Points-Remove Points commands. You can remove points via polygon 
or under entities directly. 

Step 7 - Place luminaires in desired positions from the luminaire toolbar. 

Step 8 - Choose the Direct Only Calculate Method from the pull-down menu on the Calculate button, compute the results by clicking on the Calculate 
button. The Direct Only Calculate Method is most appropriate for exterior calculations, but you can use the Full Radiosity Method if reflected light is 
of importance. 

Step 9 - Refine luminaire layout if necessary. Use tools like Isolines and Highlight Values to evaluate your design. Turn on the AutoCalc feature for 
fine tuning. 

Step 10 - When the numbers are correct, use the Add Drawing Entity- Add Schedules command to add Schedules to summarize numerical results 
and tabulate luminaires employed. 

Step 11 - Enhance the output with borders and title blocks. These items can be created and stored within the Block manager for use on any project. 

Step 12 - Export results to DXF or DWG. 

Optional steps - replace like numbered steps above 

Step 10 - Enter the Page Builder section of AGi32 and place multiple views of your project on the desired paper size. You can setup the main AGi32 
desktop to display multiple views of your project such as Plan, Isometric, and Elevation. 

Step 11 - Place Schedules as above and add bit-mapped graphics such as luminaire photographs and company logos. 

Step 12 - Plot or print results. Because Page Builder output is a composite of vector and raster graphics, it cannot be exported as a CAD file. 

Other possibilities 

For Roadway applications you may elect to compute Pavement Luminance and other associated metrics. This involves simply placing the 
appropriate types of computation points using the Add Calculation Points - Roadway Luminance command. This is a variation on Step 5 above. 

The above scenario assumes the ultimate output is simply numerical results and not a rendering. However, if a rendering is desired it can be as 
simple as adding a few steps to the model. 

Step 13 - Add an Object for the ground using the Add-Object-Planar (polygon) command. 

Step 14 - Switch AGi32 into Full Radiosity Method and compute again. 

From this point you can improve the model to become much more elaborate. You can add additional Objects for medians or pedestrian furniture, add 
Library Objects, and even add textures to object surfaces. The sky is essentially the limit when you start building complicated 3-D models. Keep in 
mind, the more complicated the model (number of discreet surfaces), the longer the computation can take to process. 

Interior projects 

We can try and generically apply the label of Interior lighting application to anything from a commercial office space to a very dramatic restaurant or 
private residence. The truth is, from the designer's perspective they are very different animals. Using the techniques available with AGi32, the 
methods employed to analyze the variety lighting system possibilities are identical. 
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Problem definition 

Interior lighting application with initial results to be a color rendering for experimentation with different lighting design scenarios. Ultimate goal is final 
rendering as well as point-by-point computation. 

Interior project - steps for success 

Step 1 - Open AGi32 

Step 2 - If a CAD background is available, use the File-Import command to bring in the drawing background from CAD generated DXF or DWG file. 
For many interior applications this step is not necessary. 

Step 3 - Define the luminaire photometrics to be used in the application using the LumAdd-Define command. Take special care to define the proper 
Render Mode symbol for the luminaire. If the luminaire comes from a photometric database delivered with AGi32, the manufacturer may have 
already matched a custom symbol with this photometric file. 

Step 4 - Create the 3-dimensional space required in the application. For simple applications this step may involve creating a single room shape using 
the Room command. For more complicated spaces, it may involve multiple Room shapes and a variety of Objects in combination. Three-dimensional 
CAD models can also be imported ranging from objects to complete architectural spaces. 

Step 5 - Locate the luminaires as desired from the Luminaire toolbar. 

Step 6 -  Set the program to Full Radiosity Method from the pull-down menu adjacent to the Calculate button. Then click on the Render tab on the 
Control Bar and AGi32 will advance to Render mode displaying a wireframe mesh of the model. 

Step 7 - Click on the Calculate button to watch the progressive radiosity calculation process. The process can be halted at anytime, however, the 
solution is complete only when the computation has reached a Radiosity Stopping Criterion of 99% (default preset). 

Step 8 - Investigate the model using the standard view and Interactive command buttons from the toolbar. 

Step 9 - Return to AGi32's Model mode for any modifications to luminaire positions, quantities or definitions. 

Step 10 - You can iterate back and forth in Render mode and Model mode as often as you like. Experiment with the Pseudocolor mode using the 
Display Properties command for a nice method of evaluating luminance or illuminance quantities. 

Step 11 - Within the AGi32 Model mode, select the Add-Calculation Points-Automatic Placement command. Then select any surfaces within the 
dialog where calculation points are desired. On exit from the dialog, AGi32 will automatically place the calculation points. 

Step 12 - Compute the project again from Model mode or Render mode. Computations are slightly faster from Model mode as the software does not 
have to intermittently refresh the screen presentation. 

Step 13 - The output options for an interior application are similar to those available in the previously discussed exterior application with a few 
additions to handle renderings. 

13.a For simple printed output of point by point results you can repeat Steps 9-12 as presented in the exterior application. 

13.b For more complete printed output including rendered views, the Optional Steps in the exterior application move the focus to the Page Builder 
section of AGi32. 

13.c Single views can also be exported to JPG or BMP format and complete 3-D virtual worlds can be exported in VRML format.  

Further optional steps that can make your renderings more realistic: 

Add texture maps – AGi32 contains a library of bitmapped textures (materials) that can be applied to any reflective surface. You can also add your 
own bitmap textures to the library easily. Textures can represent anything from carpet, concrete and tile to artwork. Careful application of texture can 
make your renderings very realistic.  

Ray-tracing – If you select a single view or a series of viewpoints in render mode, AGi32 is able to run a post-radiosity process ray-trace to consider 
specular reflections and create very hard shadow lines in your renderings. A degree of specularity can be assigned to any surface using the Surface 
Edit command in Model mode. Ray-trace parameters are set from the Ray-trace menu. Ray-traced images are automatically exported to JPG or 
BMP and can be used in Page-Builder or viewed with the Image Viewer. 

Color Bleeding – The degree of color bleeding can be controlled within AGi32 to make the rendered image appear closer to that interpreted by the 
human visual system. Color bleed from surfaces can be set using the Surface Edit command. 

Toggle Model Mode Overlay - Toggle Model mode entities on top of the rendered environment with the Toggle Model Overlay command on the 
Status Bar. This allows you to create highly informative composite images where you can combine numeric and graphical results for presentation. 
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 Sample Files 

AGi32 has AGi32 Sample Files available to help you explore a finished project and get a "feel" for the software. There are also CAD Sample Files, 
which are used in the Tutorials. (To access the Tutorials, go to the Contents tab in Help, and scroll to the bottom for the Tutorials.) 

The Sample Files may be downloaded from the Lighting Analysts server. Go tohttp://www.agi32.com/index.php?id=2b . Under the Miscellaneous 
Downloads heading, click on the orange "download" button for the Sample Files. The Sample Files are in a zipped folder which you may Save to your 
desktop; once it's there, double click on the icon. Follow the steps to unzip the Sample Files. You may accept the default location or put them 
somewhere else, as long as you know where to find them! (Note the other items that are available for download, including a printable version of all 
the tutorials.)  

There will be two folders of sample files: AGi32 Sample Files and CAD Sample Files. 

Try the AGi32 Sample File titled Burger World2.agi first. Open the file, select the Render tab and then click the Calculate button at the top of the 
screen. Enable the Textures from the toggle button on the bottom of the screen, and experiment with the interactive viewing commands on the top 
menu bar. Exit Render Mode (click the Model Mode button) and try another sample file.  

Several of the sample files are required by the tutorials, as mentioned above, or are completed versions of the tutorial lessons. 
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Working With AGi32 Job Files 

File Management 

Creating New Job Files-Concepts 

The New command opens a new working file at any time while in AGi32. AGi32 can only have one working file open per session at any time. When 
opening a new file while another is currently open, you will be asked to save any work currently in progress. 

A new AGi32 working file is automatically opened each time AGi32 is started. It is not necessary to open a New file to begin working when you open 
AGi32. Your work is not formally named until you assign a job file with the Save or Save As commands. However, the temporary name New-#-
wrk.agi is used as the working file name. The # represents the timer sequence AGi32 uses to save the working files. This system provides a useful 
recovery scheme as your work is always current to the last command as well as to the last save. See the System Crash Job File Procedure for more 
information.  

Creating a New Job File 

The New command opens a new job file in AGi32. The job file remains unnamed until the user saves the file and assigns a job file name. Only one 
job file may be open at a time. 

 From the File menu choose New, or from the Common toolbar select . 

Creating a New Job File from a Template 

The New from Template command opens the File-Open dialog to the Template Tab, allowing the user initiate a copy of a Template file as their new 
job fill in AGi32. The generated job file remains unnamed until the user saves the file and assigns a job file name. Only one job file may be open at a 
time within each session of AGi32. 

 From the File menu choose New from Template 

Opening Files-Concepts 

The Open command opens previously saved AGi32 job files (*.AGI) and older version AGI32 job files (*.A32). The Open command will find AGi32 
files anywhere on your computer network. Three Tabs are available for convenient file selection. 

Note: Files with Roadway Calculation grids created in version 2.1 or later will not open in earlier versions of AGi32. Files created in version 2.04 or 
earlier can be opened in version 2.1 or later, but the calculation grids are converted to a single Illuminance grid that can be edited in the later 
versions. Converted grids are assigned to '_Converted-Illuminance Only' standard. Converted grids must be edited in order to apply an actual 
Roadway Standard and select additional calculation metrics. A message is displayed when opening a .AGI file with older-version roadway grids. 

 

Existing Tab 

• The Existing Tab presents file and folder information allowing the user to simply navigate to the appropriate folder. The default file type is 
AGi32 Job Files (*.AGI). To open older version files (pre-version 2.0), it is necessary to select AGi32 Job Files (Older) (*.A32) from the 'Files of 
type' pull-down. 

• You can also manually type in the path and filename into the File Name selection box. 

• Files may be managed in this tab (copied, renamed, deleted) by right clicking on them and choosing the desired option from the secondary 
menu. Each column may be sorted in ascending or descending order by clicking in the column header. 

• The initial (default) folder location is determined by Job Files location specified in the (System Settings-File System tab. If the folder location is 
changed, the selected folder will become the default location for the current AGi32 session (i.e. the selected folder will be shown the next time 
you enter this dialog). The default folder location will be used once AGi32 is closed and restarted. 

Recent Tab 
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• The Recent Tab displays files opened and saved in AGi32, regardless of saved path. File information such as file size, version and user notes 
are displayed for AGI and A32 files, as well as the last saved Model and Render views. You may also search for files by filename, description 
or file information using the Search For text box in this tab. 

• The Recent tab does not display the first time AGi32 is opened after installation, it only appears after files have been saved the first time. 

• Recent files are stored in a user database defined by the users Windows log-in user name. Each user that logs into the computer will have 
unique list of recent files. 

• Each column may be sorted in ascending or descending order by clicking in the column header. 

• In addition to sorting, you can also search through Recent files list for a specific text string. Enter the desired term in the Search For text box 
and click the Find button (or press the Enter key). The program will search all Recent files and display any files that have the specified text in 
their filename, description, and/or information (e.g. entering ‘Football’ as your search string will search for the word ‘football’ somewhere in the 
filename, description and/or information). All search strings are automatically saved and available from the Search For pull-down menu. You 
can delete a search string by simply selecting the string and clicking the Delete button. 

Templates Tab 

• The Templates Tab allows you to open AGi32 job files that have been previously saved as file templates for consistent initialization of projects 
using predefined data. Job File Templates must be saved in the JobFileTemplates folder specified in the Tools-System Settings-File System 
command to be available in the Templates Tab. 

• Similar to Recent files, all job file templates are tracked and displayed in the Templates tab. However, Templates file information is stored in a 
database in the JobFileTemplates folder and is accessible by multiple users. In other words, when you save a file as a template (see File-Save 
As Template), it is accessible by any user that is using the same JobFileTemplates folder (Tools-System Settings-File System tab). 

• IMPORTANT - If you change the location of your Job File Templates, you need to manually move the contents of the current Job File 
Templates folder to the new location, using My Computer. Otherwise, all template tracking information will be lost (templates will not be 
available in the Open dialog). 

• Selecting the template ‘<Blank AGi32 Job File >’ has the same affect as the command File-New. 

• By default, Template Files are sorted by date with the most recent listed first. You can sort by any column by simply clicking on the column 
heading. Clicking the same column heading will toggle between ascending and descending sort order. 

• In addition to sorting, you can also search through Template Files list for a specific text string. Enter the desired term in the Search For text 
box and click the Find button (or press the Enter key). The program will search all Template Files and display any files that have the specified 
text in their filename, description, and/or information (e.g. entering ‘Football’ as your search string will search for the word ‘football’ somewhere 
in the filename, description and/or information). All search strings are automatically saved and available from the Search String pull-down 
menu. You can delete a search string by simply selecting the string and clicking the Delete button. 

• Once a Template File is selected, a copy of the template file will be loaded and opened with no filename specified. By default, when saving, 
the file will saved as a normal job file (you will be prompt for a filename), unless you save the file as a template (File-Save As Template). 

Opening AGi32 (*.AGI and *.A32) files 

When opening a previously saved AGi32 file, AGi32 creates a working copy of that file. The working file is subsequently named using the job file 
name and a timer setting used by AGi32. AGi32 then accesses and updates the working file rather than your original as you work. The original job 
file is changed when you execute the Save command. 

This system provides a useful recovery scheme as your work is always current to the last command as well as to the last save in addition to a 
backup file. See the System Crash Job File Procedure for more information. 

Before AGi32 opens the selected file, it verifies that all luminaire symbol files, luminaire arrangement files, photometric files and luminaire image files 
(from the Instabase) are available as defined. Luminaire symbol files and luminaire arrangement files that are unique to the selected job file, will be 
copied to your associated AGi32 folders locally. 

If the photometric data in the luminaire definitions do not exist in the specified paths, or are not found in the Instabase, AGi32 will copy the 
photometric files located within the job file database to the PhotometricData_FilesFromJobFiles subfolder specified in the System Settings-File 
System folder location. All photometric files that are not found are automatically placed in the same folder. Existing photometric data found in this 
location will be overwritten with matching photometric data. 

Opening files already in use 

Each time an AGi32 file is opened through the Existing or Recent Tabs, the file is ‘tagged’ to prevent another user from accidentally opening the 
same file at the same time and overwriting one another's modifications. If you attempt to open a file that is already open, you will be presented with a 
dialog showing three options: 

• Create a copy of the file and open – Creates a copy of the file (naming convention is <filename>-Copy-<Time>.agi) and opens the copy. 

• Select a different file – Returns you to the Open File dialog where you can select a different file. 

• Open file – Opens selected file regardless if the file is already opened. Take care to use this option with caution! Changes made to a file that is 
already opened by another user may not be retained when the file is saved (your changes to the file may be overwritten by another user or vice 
versa). There may be times when this option can be used without issue: (1) If you already have the file open and decided to open a fresh copy of 
the file without saving any changes. (2)The file was not properly closed (e.g. AGi32 closed abnormally). This leaves the file ‘tagged’ as being 
already open when in fact it is not. 

Opening AGI-Light (*.AGL) files 
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AGi32 no longer reads AGI-Light files. 

Opening AGI-DOS files 

AGi32 no longer reads AGI-DOS legacy files. The .AGI extension is now used for AGi32 version 2.0. Legacy AGI-DOS files (using the .AGI 
extension) will produce an error on opening.  

Opening Previously Saved Job Files 

The Open command opens a previously saved AGi32 job files. The user can select the desired file from any folder on any drive, or manually type in 
the filename and path. In addition, the user can find an AGi32 file from a selected drive or folder with the Find Files option. 

AGi32 files will display job file information and any associated notes. 

Opening a file: 

1. From the File menu choose Open, or from the Common Toolbar select . 
2. Alternately - you can drag and drop *.AGI and *.A32 files into the Model Mode graphics area to open files. if a file is already open, you will be 

prompted to save the current file before the dragged file is opened. 
3. All AGi32 file types - *.AGI and *.A32 are automatically searched for. 
4. Three Tabs are available for convenient file selection. 

• The Existing Tab presents file and folder information allowing the user to simply navigate to the appropriate folder. AGI32 files may be 
selected through this tab. 

• The Recent Tab displays files opened and saved in AGi32, regardless of saved path. File information such as file size, version and user notes 
are displayed for AGI and A32 files, as well as the last saved Model and Render views. You may also search for files by filename, description 
or file information using the Search For text box in this tab. 

• The Templates Tab allows you to open AGi32 job files that have been previously saved as file templates for consistent initialization of projects 
using predefined data. Job File Templates must be saved in the JobFileTemplates folder specified in the Tools-System Settings-File System 
command to be available in the Templates Tab. 

4. Click Ok. 

AGi32 will copy the photometric data to the local computer if it is not found in the original defined luminaire paths or Instabase. 

Note: Files with Roadway Calculation grids created in version 2.1 or later will not open in earlier versions of AGi32. Files created in version 2.04 or 
earlier can be opened in version 2.1 or later, but the calculation grids are converted to a single Illuminance grid that can be edited in the later 
versions. 

Photometric Data From Job File 

If the photometric data in the luminaire definitions do not exist in the specified paths, or are not found in the Instabase, AGi32 will copy the 
photometric files located within the job file database to the PhotometricData_FilesFromJobFile folder specified in the Tools-System Settings-File 
System command. All photometric files that are not found are automatically placed in this folder. Existing photometric data found in this location will 
be overwritten with matching photometric data.   

Saving Files-Concepts 

The Save and Save As commands allow you to save an AGi32 job file to any drive or directory. The Save As Template command allows you to save 
AGi32 Job Files as templates in lieu of empty job files with predefined data appropriate to any layout condition. Template files are always stored in 
the JobFileTemplatesFiles folder. 

File names can be long and even include spaces per the Windows UNC (Universal Naming Convention) protocol. You can include Information notes 
about the job file that will be seen each time the job file is opened. After an AGi32 file has been saved the first time, AGi32 will continue saving the 
file under the same name from then on. 

When a file is saved, AGi32 automatically organizes and compresses the current working file. The working file is ordered contiguously, the Undo and 
Redo tables are purged and the file is compressed. The newly organized job file is then copied as the job file. If the job file has been previously 
saved, it is saved as a backup copy (with the extension .bak appended to the end) before being overwritten with the new data. 

Compressed files are typically 3 to 6 times smaller than uncompressed job files, which is comparable to compression results from zipping tools. 
Compressed job files are given the same file extension and are automatically recognized by AGi32. 

Save Rendered Environment 

By default, the Rendered Environment is saved when the job file is saved. AGi32 will ask if you wish to save the rendered environment when closing 
the current job file as long as this option is disabled. When a rendered environment is saved, a separate Radiosity Solution File is saved containing 



AGi32 Help System  Working With AGi32 Job Files 

48 

 

the rendered elements within the environment. The Radiosity solution file may be quite large, up to several megabytes. To save the Rendered 
Environment whenever the job file is saved, enable this option in the System Settings command (File System tab). The Radiosity Solution File will 
carry an RSF extension and will be saved in the same folder as the job file. 

Saving the rendered environment for large applications with many surfaces may be time extensive; therefore, AGi32 reports the save status on its 
command line to indicate progress. The AGi32 button on the Windows taskbar will also change its caption to AGI32-Saving as a visual clue if you are 
working on other applications at the same time. Finally, while the rendered environment is being saved, AGi32 is assigned 'below normal" priority so 
that you may open and work in other applications at the same time. 

Save As 

The Save As command allows you to save the current job file as a new AGi32 job file. The original file remains unchanged as of the last Save 
invocation. When saving as an AGi32 file, AGi32 will close the original AGi32 file and present the newly created file for you to continue working with. 

Save As Template 

Job File Templates are AGi32 Job files that contain a certain amount of predefined data that can be used to initialize a project. For example: A job file 
can be created containing a football field drawing background and several floodlight luminaire definitions and the file saved as a ‘Football Template’. 
This saves the user from having to create a new file from scratch every time a football field layout needs to be worked on. 

Job File Templates are automatically stored in the JobFileTemplatesFiles folder (Tools-System Settings-File System Tab). 

As long as the JobFileTemplatesFiles folder is saved on a network location available to all AGi32 users, job file template files may be accessible by 
all AGi32 users across a network. AGi32 Template Files can contain any predefined data that may be desired including, but not limited to: 

• Page Builder Reports 

• Luminaire Definitions 

• Multiple Projects 

• Calculation entities 

• Rooms and Objects 
• Text and other drawing entities 

Saving the Current Job File 

When saving the working file for the very first time, the Save File As dialog appears allowing the user to specify a file name and path for the new job 
file. By default, all job files will be saved in the JobFiles folder location specified in the Tools-System Settings-File System tab. 

Once the working file has been assigned a job file name, AGi32 will update the current job file each time the Save command is invoked. 

 From the File menu choose Save, or from the Common Toolbar select .  

Backup Files 

This feature provides additional file protection in case something happens while saving a job file. When saving, a backup copy of the current file (if 
existing) is automatically made.   

Example: 

1. Create a new file called "file1.agi". 
2. Save file (no backup is made since the file is new). 
3. Work on the file and save again. Since the file already exists (this file has been saved before), a backup copy is automatically made in the same 

folder as the current file-  with the extension .bak. In this case, the backup file would be called "‘file1.agi.bak". 
4. The .bak file contains the previous version of the file (before the save). To use the backup file, simply rename the file and remove the .bak 

extension.  

Saving the Current Job File as Another Name 

The Save File As dialog appears when saving the job file for the very first time or when saving the current job file under a different name. By default, 
job files will be saved in the Job File folder or the last user defined folder, whichever was accessed most recently. 

If you have saved previously, the default filename is assigned the same name as the original saved file. In addition to specifying a filename and 
location, the user may add or modify notes that describe the job file. 

1. From the File menu choose Save  As, or if saving for the first time, from the Common Toolbar select . 
2. Save the file in one of the following manners: 

• Select the appropriate drive and folder location from the Existing Tab. Enter the filename in the File Name text box. 
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3. By default, AGi32 saves the current AGi32 file in the JobFiles folder location specified in the Tools-System Settings-File System tab. You can 
directly access the File System folder locations by clicking on the File System button. 

• Manually type in the file name and path in the File Name text box. 
4. Click Ok. 

Saving the Current Job File as a Template File 

The Save File As Template dialog allows you to specify the information viewed by the user when a template file is selected when the users choose 
the File-Open or File-New from template commands. AGi32 Template files will be saved in the JobFileTemplatesFiles folder (Tools-System Settings-
File System Tab). 

When the JobFileTemplatesFiles folder is specified at a network location available to all AGi32 users, job file template files may be accessible by all 
AGi32 users across the network.  

1. From the File menu choose Save  As Template. 
2. Specify the Template Name in the Name textbox. 
3. Specify an optional one line Template Description in the Description texbox. 
4. Additional information about the file contents or file usage may be entered in the Information section 
5. Click Ok. 

Job File Information-Concepts 

The File Information command provides statistical data about the AGi32 job file as well as the ability to append notes to the job file.  

The information is updated each time the file is saved. 

Available Fields Description 

File Name  Echoes AGi32 job file name 

Location  Echoes AGi32 job file path 

Created By Automatically specified when job file is initially saved. Information is extracted from current user information in 
Tools-Update User Information command. 

Created Date Automatically specified when job file is initially saved 

Created Version  Automatically specified when job file is initially saved 

Date Last Modified  Automatically specified when job file is last saved 

Modified By Automatically specified when job file is saved. User name is based on Current User Name Field (see below). 

Modified Date Automatically specified when job file is last saved 

Modified Version  Automatically specified when job file is last saved 

Total Time (Hrs.) Total time a file has been worked on after initial save. Total Time may be Reset to zero, this options is most useful 
when saving file as another name for alternate design consideration. 

Current User Name Information is extracted from current user information in Tools-Update User Information command. Changing the 
name specified here will update Modified By user name. Updating this name will change the current name stored 
in the Tools-Update User Information command. Note: This name should only be updated when the User 
Information is incorrect (e.g. blank entry or updated user). 

Description One line description specified by user which is displayed in Recent file listing when opening previously saved files. 
It is recommended users utilize concise and consistent descriptions for easy recognition (e.g. Football Field - (6) 
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Pole Layout) 

Information  This multiple line section allows for any additional information the user believes is pertinent. The Add Time Stamp 
button appends the current date, time and user name when it is depressed for chronologic tracking. 

Possible uses for the Information section includes Statistical results, project information, design information and 
revision changes. 

Once you have entered data in the Information field, you can examine the notes in the Information whenever you open the file in the File-Open dialog 
with the Recent tab. 

The File-Information tab is displayed after the first save and whenever the Save As command is used. To prevent the File Information dialog from 
displaying in conjunction with the Save commands, de-select 'Prompt for File Information Before Closing File' in the Tools-System Settings File 
System tab. 

Current Job File Information 

The File Information dialog contains details about the AGi32 job file including file name location, created by, creation date, creation version, modified 
by, modification date, modification version, total time (in hours) file has been opened since it was first saved, description and user information notes. 
The information is updated each time the file is saved. Additionally, the File Information dialog is displayed after the Save As dialog command is 
invoked if not entered here. 

To Print the File Information contents, click the Print button. The Windows Print dialog will appear allowing you to choose which printer and print 
options you wish to apply. 

 From the File menu choose Information.  

Viewing the Last Nine Files 

AGi32 provides easy access to the last nine job files created or opened in AGi32 by appending their names to the File menu. 

 From the File menu choose the file name. 

Exiting AGi32 

When exiting AGi32, you will be prompted to save the most recent version of your work if you have not done so already. When exiting AGi32,you 
may do so from any mode (Model, Render, Page Builder). 

 From the File menu choose Exit. 

 

Importing and Exporting Files 

Importing Files 

The Import command allows you to integrate CAD-created DWG or DXF drawing files or previously saved AGi32 files into your current job file. When 
importing, the original CAD files and AGi32 files remain separate files and are not altered in any way in the Import process. 

Importing CAD-created backgrounds and 3D models can be vital to your ability to perform complex lighting analysis for many lighting applications. 
Without a drawing reference to work from, applications such as outdoor site lighting become impossible to perform in detail. Obtaining and importing 
3D models as surfaces in AGi32 can save you many hours of design time replicating the model from scratch in AGi32. By integrating a previously 
created 3D model into AGi32, you only need to add luminaire and calculation entities to complete your lighting design analysis. 

The ability to import previously saved AGi32 files can be used to merge entire job files or, more often, to import frequently used drawing entities, such 
as title blocks. 

1. From the File menu choose Import and then select either Import CAD File or Import AGI File. Alternatively, you may click on the CAD Import 

button from the Common toolbar   or click on the drop-down arrow next to the button and select either Import CAD File or Import AGI File 
2. Select the file in one of the following manners: 

• By default, AGi32 starts the search in the in the folder accessed most recently. Select the file by left clicking on it. 

• • If necessary, you may browse for the appropriate folder. Once found, select the file by left clicking on it. 

• Manually type in the file name and path in the File Name text box. 
3. Click OK. 
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Related Topics 

Importing CAD Files 

Importing AGi32 Files 

System Settings 

Importing AGi32 Files-Concepts 

AGi32 will allow you to merge multiple job files together while preserving the active content of each file (luminaires, calculation points, rooms, etc.). 
This can be valuable when you find it necessary to combine information from several job files for a single presentation or summary. When an AGi32 
file is imported, the imported file is treated as a separate project. You can import any combination of drawing entities, text, luminaire types and 
locations, LPD/UWLR areas, statistical areas, calculation entities, rooms and objects. When merging an AGi32 that already contains multiple 
projects, AGi32 will combine them into one single project. 

AGi32 applies the default project name specified in System Settings (Project_1 by default). If the specified Project name already exists in the current 
job file, you will be prompted to choose an alternate name. Project names must be unique. 

Textures defined in the imported AGi32 files will be imported into the new job file as long as they are found in the local Textures Database. 

When importing entities, a suffix is appended to the entity label to distinguish it from similar labels already defined in the job file. The suffix used is a 
numeric suffix - _1, _2, etc. 

Examples 

Consider the following example. We wish to import the same AGi32 file twice into one master job file. The projects will be used to compare two 
switching options side by side. 

The Project Map in Project Manager for the original file resulting file is shown below: 

Original Job File: 

 

Merged File: 

Project names chosen: Room1 and Room2 

 

 

Consider another example. File2 is to be merged into File1. File 2 contains two existing projects. The Resulting File is shown. 

File1: 

Single Project: Parking 

File2: 

Two Projects: Roadway and Pedestrian 
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Merge File2 into File1 

Two projects: Parking and Roadway (Pedestrian project is absorbed in Roadway) 

 

When to Merge AGi32 Job Files 

The following list contains some common scenarios where you may wish to consider merging individual job files. While not exclusive, it should give 
you an excellent starting point for expanding your presentation capabilities. 

• Merge a Title block with Smart Text into your current job file. 

• Merge individual rooms or floors into one building presentation. Apply an offset so that the rooms do not overlap each other. 

• Merge multiple design concepts side by side into one presentation file. Use Freeze or Off in Project Manager to remove project from calculation 
consideration. 

• Merge adjacent areas, such as parking areas or ball fields, into one summary file. 

Importing AGi32 Files 

An imported AGi32 file is inserted as a separate project. By default, the imported project is unlocked. Any combination of entities may be imported 
including drawing entities, text, schedules, luminaire types and locations, LPD/UWLR areas, calculation points, statistical areas, rooms and objects. 
When merging a job file with several projects, AGi32 attaches all of the entities to a single project with the imported project name. 
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1. Enter a unique project name in the Project Name text box. 
2. If desired, lock the imported project (locking a project prevents modifications to it). 
3. The Offset coordinates allow you to specify an insertion point, other than the origin, for the project. Offsets relocate the imported entities to a 

new location. Offsets are applied relative to the actual coordinate values. For example, if a luminaire was originally located at 10, 20, 10 and 
offsets of 100, 100, 0 are applied, the luminaire will now be located at 110,120, 10. 

4. Select the entities to import. Click on the Select All button if all entities are to be imported. 
5. Click Ok.  

Note: To Import an AGI file from a previous version of the software, first Open the file in the current (newer) version. Then Save it. It will now be in 
the latest format and can be imported into the latest version. 

  

Note: Textures defined in the imported file are included in the imported file if they are found in the local Textures Database. If they are not found in 
the local Textures Database, a Import Report will be displayed indicating the non-imported texture by name and correlated surface and the surfaces 
will be rendered with solid color. To define textures for these surfaces, choose one of the following: 

� Add the indicated texture to your Textures Database and re-import 
� Import, then manually place the texture on the surface indicated 

Importing CAD Files - Concepts 

AGi32 allows for the input of CAD drawing files in DWG and DXF formats.  

 AGi32 can read RealDWG and DXF files, version 2010 and earlier. 

Layer Selection 

The following layer selection methods are available in both the Import CAD File - Layer Selection tab and the Import Mapping tab: 

� Single clicking or clicking and dragging to select one layer or one selection window of layers at one time. 
� Shift-select: select adjacent layers and all selection in between top and bottom selections 
� Ctrl-select: select non-adjacent layers or non- adjacent selection windows at once. 

AGi32 provides four types of layer selection: 

1. Smart Select Layers - This is the default layer selection method. This method only selects layers that are defined as visible (On and Unfrozen). 
2. Individual Layer Selection - Layers may be selected individually through toggle selection. AGi32 support the Windows Shift and Ctrl methods for 

multiple layer selection. 
3. Select All Layers - This option selects all layers 
4. Clear Selected Layers - This option deselects all layers. 

The Layers selection table only allows for layer selection, it does not provide property control (in other words you cannot switch a layer that is Off to 
On). These changes may only be applied in a CAD program prior to import in AGi32. 

Layers that are selected for import are imported regardless of their properties. If layer selection methods other than Smart Select are employed, the 
AGi32 file may contain "empty" layers (layers that contain no imported data). 

Imported Entity Types 

AGi32 will import the following CAD-created entities: 

Entity Comments 

Supported Drawing Entity Types: 

� Line 

� Arc 

� Polyline (LWPolyline, 
3DPolyline) 

� Spline 

� Circle 

� Ellipse (Elliptical Arc) 

� Text 

� Mtext (unformatted) 

� Mline 

� Trace 

Drawing entity types are never imported as objects. Some drawing entities, such as those with 
thickness assigned, may look like 3D objects in CAD (they may even shade in CAD), but they are 
still 2D and will not be converted to objects in AGi32. 

Lines, Arcs, LWPolylines, Circles, Trace and 2D Solids with thickness assigned will be imported 
with defined thickness into AGi32. These are wireframe drawing entities and will not be converted 
into objects (surfaces) in AGi32.  

Mtext formatting is not supported. 

Curved 2D entities (e.g., arcs, circles, etc.) will be reconstructed in AGi32 using the specified 
curve increment. It is recommended that you change the Curve Increment for Import to 5 degrees 
for exterior background drawings, as these environments typically have shallow curvature lines. 
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� Solid (2D) 

� Dimensions (most types) 

� Leader (most types) 

Supported Object Types: 

� 3D Face 

� Polyface Mesh 

� Polygon Mesh 

� 3D Solids 

� Regions 

� Bodies 

� Surfaces (Extruded, Revolved, 
Lofted, Swept, Planar) 

� Meshes 

Zero-area and degenerate (self-intersecting) surfaces are not imported. 

All 3D Faces, Polyface and Polygon Meshes are imported.  

Non-planar and self-intersecting faces are deconstructed into two planar triangles. 

All 3D surfaces (planar and non-planar) imported into AGi32 are meshed into planar triangles or 
quadrilaterals during the import process. 

Other Supported Entities (Misc) 

� Block References (Inserts) 

� External Reference (XREF) 

XREFs are imported automatically if their references can be found. Otherwise, only the master 
drawing is imported. 

Unsupported Entity Types: 

� Attribute 

� Attribute Definitions 

� Hatch 

� Hyperlink 

� MInsert Block 

� Point 

� Raster Image 

� Ray 

� Shape 

� Tolerance 

� XLine 

� Proxy 

� Paper Space (all entities in 
Paper Space) 

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Units and Scaling 

Units 

AGi32 will read the CAD units setting from the CAD (RealDWG) file and will recognize either the “Engineering” or “Architectural” units settings (both 
are in inches). All other CAD units settings (decimal, scientific etc.) are assumed to be the same as the current AGi32 units (i.e., if the current AGi32 
units are Feet, the imported CAD file is also assumed to be in Feet; if the current AGi32 units are Meters, the imported CAD file is also assumed to 
be in Meters). In this case it is up to the user to select the correct units, if this assumption is incorrect.  

Scaling 

An additional Scaling Factor may be applied upon import in addition to any unit conversion scaling. The scaling factor may entered as a decimal 
value (e.g., 100, 0.75, etc.) or as a fraction (1/2, 7/8, etc.). Math operations are not supported (i.e., +, -, *).  

Drawing Extents 

The Drawing Extents and drawing location are shown in this section (after Units and Scaling are applied). Drawing Extents displays the minimum 
extents (LLHC = Lower Left Hand Corner), maximum extents (URHC = Upper Right Hand Corner) and total extents in the selected AGi32 units. 

Layers and Blocks  

AGi32 imports drawing and object entities on a one-to-one basis. By default, each discreet entity becomes an individual AGi32 entity (either drawing 
entity or object). Entities are not grouped together into a single object unless specified by the user. 
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Grouping Drawing Entities 

Drawing Entities may be grouped into a single layer in the Miscellaneous section of the Import CAD File dialog. The new Layer Name is specified by 
the user at this time. Before combining layers, it is important to consider how the CAD file will be used in the job file. Combining the entire file on one 
layer makes it easy to turn on or off or delete the CAD file; however, it may be desirable to maintain the layers and turn on or off or delete individual 
layers. 

When drawing entities are grouped, all the drawing entities in all selected layers will be combined into one single layer. Drawing entities will retain 
their individual properties (e.g., color, text formatting, etc.). 

Grouping Objects 

3D entities may be grouped into a single object in the 3D Import Options section of the Import CAD File dialog. The new Object Name is specified by 
the user at this time. Each layer is made into an Object Component which may be assigned surface attributes as one definitive grouping. This 
method of grouping the layers together is only appropriate for entity import (where the imported file represents a single complex entity such as a 
plant, person, piece of furniture, etc.). 

When a whole 3D environment is imported in AGi32, grouping 3D Entities into a single object is strongly discouraged. Complex environments 
grouped together can cause coplanar surfaces (such as end panels within exterior walls), which may cause calculation errors and abrupt program 
termination in AGi32. 

When 3D entities are grouped, all the objects in all the selected layers will take on the drawing entity properties of the first layer and the surface 
attributes assigned by default, unless surface mapping is employed. 

 

When not grouped together, 3D entity file 
comes in as 2841 objects. Each object is 

selectable individually. 

 

When grouped together, 3D entity file comes in 
as one object and edited, copied, rotated, etc. 

as one object. 

Blocks 

CAD files support infinitely nested block hierarchies (blocks within blocks within blocks...). However, AGi32 supports only a single level of block 
'hierarchy'. The user may select one of three options to convert the potentially infinite hierarchy to a single level: 

• Explode all blocks on import (default) - Destroys block hierarchy and uses layer hierarchy instead.  

• Keep Low-Level Blocks (only) - Keeps only child blocks (blocks that do not contain any other blocks) intact. All blocks that contain other 
blocks are exploded.  Each exploded entity assumes its properties (color, etc.) based on the layer in which it resides.  
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• Keep High-Level Blocks (only) - Keeps only parent blocks (blocks that are not contained within any other block) intact. All child blocks 
contained within the parent block are imported as part of and assume all properties (color, etc.) of the parent block. 

Layer/Block Mapping in Project Manager 

Project: Each imported CAD file is contained entirely in a new AGi32 project. The import project name consists of the DWG/DXF filename and a 
date/time stamp.  

Drawing Entities: Each layer or block becomes a drawing entity within the Drawing Entity Type classification of the imported project. Color, 
LineWeight, and LineType are determined by their corresponding entity properties.  

Objects: Objects are located within the Object Type classification of the imported project by Object Label. Object Labels are determined by layer or 
block and the number of objects on that layer or block. Format:   LayerName_1, LayerName_2, ... , LayerName_N,    BlockName_1, BlockName_2, 
... , BlockName_N,    etc. 

Layer and block names are also preserved in the Component Label of each object.  

3D Entities 

All 3D surfaces imported into AGi32 are assigned surface properties (such as Color, Reflectance , Texture, etc.). By default, AGi32 imports all 3D 
surfaces as double-sided surfaces with 50% grayscale reflectance. The surface types and properties may be modified during the import process with 
import mapping (see below), or after import by using the Surface Edit command. 

All 3D surfaces (planar and non-planar) imported into AGi32 are meshed into planar triangles or quadrilaterals during the import process. 

The degree to which non-planar (curved) surfaces are meshed can be adjusted in the Advanced Import Options (see below). 

Planar surfaces can be merged together. See Coplanar Merging in the Advanced Import Options (below). 

Object naming convention 

Object Labels are determined by their layer or block name and the number of objects on that layer or block.  

Format:   LayerName_1, LayerName_2, ... , LayerName_N,    BlockName_1, BlockName_2, ... , BlockName_N,etc. (e.g., two objects on Layer Skin 
would  be named Skin_1 and Skin_2). 

Layer and block names are also preserved in the Component Label of each object. For example, in a group labeled ImportCar, Layer Wheels would 
become the name of the Component containing the wheel surfaces,Layer Body would become the name of the Component containing the body 
surfaces, etc.  

Using 3D Entity Models as Library Objects 

Composite objects can be saved, to use and reuse, as library objects. Once you save an imported object as a library object, you can reuse it in any 
job file, complete with its associated material properties. 

Note: It is strongly recommended that you create your library objects at a true scale, so that they do not need to be scaled repeatedly with each 
reuse. We recommend checking the scale of your imported object quickly, in a test file, before you spend a lot of time assigning the desired surface 
materials. 

Import Mapping (3D Entities) 

Entities that are imported as AGi32 objects are assigned surface properties during import. The user can customize these properties by applying an 
import map. Otherwise, a default import map is used.  

Import Maps may be saved and opened. Their location depends on the computer's operating system. In Microsoft Vista, for example, the location is 
C:\ProgramData\AGi32\Import_Maps. Additionally, an import map is automatically saved for each imported file. If the same file is imported again, the 
previously saved import map is automatically loaded. Import maps may be deleted by deleting the import map files directly.  

Import Filters 

• An import map is composed of one or more import filters.  

• An import filter is used to apply AGi32 surface properties (such as surface type, reflectance, etc.) to entities with specified CAD properties 
(color, layer, etc.). Import filters can be thought of as translators that convert CAD properties into AGi32 surface properties. Object properties 
(component label, wireframe color) cannot be specified by import filters.  

• An import filter is applied to each (every) entity and all its sub-entities.  

• Only one filter may be applied to each entity (each filter applies an entire set of surface properties).  

• If an entity meets the criteria for more than one filter, the entity applies first filter it finds (filter order matters).  

• If an entity does not meet the criteria of any filter, the default filter is applied. 

Surface Properties (see Surface Edit command for detailed information) 
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Surface Property Comment 

Surface Label Optional surface labels provide for naming objects with consistent name, allowing for easy identification 
in Project Manager. 

Removed Selecting this option removes selected surfaces from calculation consideration (surfaces become 
invisible). 

Surface Type Available Surface Types: Double Sided, Single Sided, Daylight Transition Glass (Transparent and 
Diffuse), Daylight Transition Opening, Roadway Pavement Single Sided (Direct Flux Only), and Roadway 
Contributor Single Sided). 

Daylight Exterior Selecting this option assigns selected surfaces as Daylight Exterior surfaces (impacts daylighting 
calculations only). 

Color / Reflectance Specify a Color  / Reflectance value for the selected surfaces. Clicking in this cell results in the Color / 
Reflectance Selector dialog being displayed. 

Texture Specify a Texture image to be applied to the selected surfaces. Clicking in the Texture cell opens the 
Select Texture dialog. A preview thumbnail of the texture is displayed once a texture image is selected. 

Transmittance Double Sided surfaces may be assigned a diffuse transmittance value (i.e., they behave like frosted 
glass). 

Color / Transparency When the Glass surface type is specified, you can specify a Color  / Transparency value for the selected 
surfaces. Clicking in either cell results in the Color / Spectral Radiant Emittance (SRE) Selector dialog 
being displayed. 

Specularity Specularity values range between zero and 1, where any value greater than zero results in a high-gloss 
(shiny) surface in Ray Trace imagery. 

Glossiness Glossiness values range between zero and 1, where any value other than zero or 1 results in a low gloss 
finish in Ray Trace imagery. (Must be assigned in conjunction with specularity.)  

Color Bleed Color Bleed values range between zero and 1, where any value less than one results in less color 
reflection (used to mitigate saturated color reflection between surfaces for more-realistic appearing 
renderings). 

Mesh Level Mesh level changes results in finer or coarser surface discretization for calculations and rendering. 
(Change from default settings.) 

Color / Luminance Specify a Luminance value (in Cd/sq.m) for self-emitting surfaces. By default, luminance color equals 
surface color, but they may be different. Clicking in the Color / Luminance cell results in the Color / 
Spectral Radiant Emittance (SRE) Selector dialog being displayed. 

Direct Flux Only Selecting this option assigns selected surfaces as Direct Flux Only surfaces (surfaces receive no 
reflected light); useful for optimization purposes. 

Default Map/Filter 

� Apply to ALL entities ....  
� Surface Type : Double-Sided 
� Reflectance : 0.5 
� Color : RGB - 128 128 128 (middle gray) 
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Filter Types 

� Apply to ALL entities ....  
� If Entity has Color ....  
� If Entity has LineType ....  
� If Entity has LineWeight ....  
� If Entity is on Layer ....  
� If Entity is within Block ....  
� If Entity is on Layer where the Layer Name contains ....  
� If Entity is within Block where the Block Name contains ....  

Import Mapping tabs 

There are two ways to create import maps: by layer and advanced.  

By-layer import mapping allows the user to quickly apply surface properties to entities based on the entities' layer (automatically creating layer filters). 
 The CAD Viewer shows a preview of the currently selected layers. To quickly select and clear layers, use the Select All and Clear Selected buttons. 
Alternatively, you may use the Ctrl-A keystroke combination to toggle the selection between Select All and Clear All. 

Advanced import mapping provides more powerful control by providing access to all available filter types. However, the CAD Preview is not updated 
when creating advanced import maps.  

CAD Viewer 

CAD Viewer Usage 

� The CAD Viewer allows users to preview a drawing before importing. 
� The CAD Viewer responds to layer selection when selecting layers to import as well as selecting layers for import mapping. 
� Changing some import options may cause the viewer display to become invalid. Click on the Refresh button in the CAD Viewer to 

update the display with the new options. The stoplight on the Refresh button will be RED when the viewer needs to be updated and 
GREEN when the viewer is displaying the current information. 

� The CAD Viewer is re-sizable and can overlap the Import CAD File dialog. 

Navigation, Tag and View Control Icons 

Icon Command Keyboard 
Shortcut 

Comments 

 
Front 
View 

  Displays a Front (South) Elevation View of Object or Room in graphic display. 

 
Back   Displays a Back (North) Elevation View of Object or Room in graphic display. 

 
Left   Displays a Left (West) Elevation View of Object or Room in graphic display. 

 
Right   Displays a Right (East) Elevation View of Object or Room in graphic display. 

 
Top   Displays a Top Plan View of Object or Room in graphic display. 

 
Bottom   Displays a Bottom Plan View of Object or Room in graphic display. 

 
Clip   Cuts away the front plane of the image continuously to reveal the objects within and beyond. The size of the 

image does not increase or decrease. This command is very useful when viewing an image with exterior and 
interior components (e.g., interior and site lighting). 

 
Dolly   Moves the observer and the focus point in and out of the model along a straight line. Depending on the view 

direction, from the observer’s point of view, this feature allows you to “walk” into and out of the space. 

 
Orbit   Moves the observer around the model while maintaining the same focus point. Imagine that you are a 

spaceship orbiting the earth, always looking at the center of the earth. 

 

Pan   Moves the observer and focus point relative to a fixed model position. Imagine that you are looking straight 
ahead and moving laterally left/right or up/down. The image will move opposite to the panning direction. 

 

Rotate   Allows the observer to look left or right and up or down from a fixed position. Use this command when you are 
in a space and want to look at different surfaces without changing your position. A panorama view is obtained 
by moving constantly to the left or right. 

 
Walk   Combines the Dolly, Pan and Rotate commands into one movement. Dragging the mouse up/down moves the 

observer forward and backward. Dragging the mouse left/right, rotates the observer view position left and right. 
Using the Shift and Ctrl keys in conjunction with dragging or the arrow keys invokes the Rotate and Pan 
commands as well. 

 
Zoom   

Similar to the Zoom In and Zoom Out commands in AGi32’s Model Mode, with the difference being that the 
image size is continuously increased or decreased as the mouse is held down and dragged. 
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Zoom 
Extents 

  Zooms to the extents of the currently selected layers. 

  

Display Options 

Clicking on the Display Options button below the image opens a list of ways that the image appearance may be modified. For example, you may 
select to keep outlines visible and surfaces filled in, but not show text or drawing entities associated with this file. In a 3D file, you may also change 
the Transparency of the model. These selections apply to the image seen in the CAD Viewer only. By default, all options are selected and 3D files 
are displayed with Transparency = 0% (opaque), with the background color available for modification.  

Color Mapping 

ACI colors are automatically converted to Windows color numbers. Please note, there are only 256 ACIcolors. Windows uses either; 16, 256, 16-bit 
or 24-bit colors. Consequently, there may be slight variation in the color between ACI colors and AGi32 colors. New CAD files may have wireframe 
colors specified using 24-bit colors. AGi32 will be able to match these colors exactly when the file is imported in AGi32. 

Line Type Mapping 

When importing CAD files into AGi32, CAD linetypes must be mapped to one of AGi32's available line types. The table below shows details of 
mapping CAD standard linetypes into AGi32. 

AGi32 Line Type ACAD Line Type 

SOLID CONTINUOUS 

DASH CENTER 

CENTER2 

CENTERX2 

DASHED 

DASHED2 

HIDDEN 

HIDDEN2 

HIDDENX2 

PHANTOM 

PHANTOM2 

PHANTOMX2 

DOT DOT 

DOT2 

DOTX2 

DASHDOT BORDER 

BORDER2 

BORDERX2 

DASHDOT 

DASHDOT2 

DASHDOTX2 

DASHDOTDOT DIVIDE 

DIVIDE2 

DIVIDEX2 

All other linetypes are imported as Solid linetypes in AGi32. 

Font Mapping 

CAD files use their own fonts, and there is no correlation with Windows fonts. Since AGi32 uses Windows fonts, imported text is converted to the 
current AGi32 default system font. This default font setting is located in the Tools - System Settings dialog and can be changed as desired. Imported 
text can be changed using the Modify - Drawing - Edit Text command. 

Note: If the font described in the imported CAD file is found on the end user's computer (in the Windows Font folder), AGi32 will use the CAD font 
instead of the AGi32 default system font. 
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XREF Drawings 

External References (XREFs) found in the imported file will automatically be imported if the XREF file can be found. 

• 'Clipping' is not supported in XREFs in AGi32. Some CAD programs allow you to 'clip' an XREF with a polygonal boundary so only a 
portion of the XREF is visible (think viewport). AGi32 imports all entities in the XREF, regardless of what is visible in CAD (i.e., clipping 
is ignored). 

• Another option for including XREFs in the import process is to bind the XREF in CAD. 

Binding XREFs 

1. In CAD, the command BIND is used to bind an external reference (this can be done in the XREF dialog in CAD). 
2. Binding permanently inserts the XREF as a block into the original drawing. Always do the bind on a copy of the original drawing (so that you do 

not lose your “live” links). 
3. You cannot bind XREFs with proxy objects or names with invalid characters. 

Text Size and Offset Factors 

 

Text Size and Offset Factor are applied to text in DXF files when they are imported into and exported from AGi32. These parameters are applied to 
the text so that in AGi32 it looks similar to its original appearance in CAD. 

The text size in AGi32 determines the size of the character block containing the font glyph and top and bottom leading spaces.  In CAD software, the 
text is created without any top and bottom leading spaces. 

We have to match this: 

 

to this: 

 

Text Size Factor adjusts the CAD Text Size to correspond to the AGi32 Text Size, which includes the top and bottom leading spaces. An example 
illustrates these concepts. 

• The default Text Size Factor is 2 

• AGi32 Text Size = CAD Text Size * Text Size Factor 
• AGi32 Text Size = 0.5 * 2 = 1 (used above) 

Offset Factor offsets the text to account for the bottom leading space in AGi32. 

• The default Offset Factor is 1.5 (1 / 0.66). 

• YNEW = Y – (AGi32 Text Size / Offset Factor) 
• YNEW = 1 – (1 / 1.5) = 0.33 

Advanced Import Options 



AGi32 Help System  Working With AGi32 Job Files 

61 

 

Curve Increment 

AGi32 does not support curved lines or surfaces. Therefore, imported circles, arcs, ellipses, etc. are broken into straight-line segments. A smaller 
Curve Increment will import the curved geometry more accurately, but at the expense of more line segments. 

Curved (Non-Planar) Surfaces 

AGi32 breaks curved 3D surfaces into meshes of planar triangles and quadrilaterals. There are two choices here: 

• Optimize Curved Surfaces - Produces the optimal balance between number of imported surfaces and accuracy of the imported surfaces to the 
original surface. 

• Use Curve Increment - Applies the curve increment when importing surfaces. A smaller curve increment allows you to make the imported 
surfaces more accurately resemble the original surface, but at the expense of more surfaces (takes longer to import and to calculate). 

Planar Tolerance  

Many planar surfaces are not exactly planar. this value determines which surfaces are considered to be planar for importing purposes. Surfaces that 
exceed this value are broken into (planar) triangles or not imported. Larger values will allow more surfaces to be imported, but may adversely affect 
rendering and calculations. 

Minimum Area Tolerance 

Surfaces with an area less than the tolerance are considered "null surfaces" and will not be imported. Small surfaces may not be important for 
calculation purposes (won't affect results), but may significantly slow down the calculation. 

Merge Coplanar Surfaces 

Many 3D CAD model are (unnecessarily) meshed into triangles and quadrilaterals. Merging these surfaces together can result in drastic 
improvements in calculation time, display performance, etc. This feature merges surfaces together if: 

• The surfaces are coplanar 

• The surfaces are adjacent (have a common edge) 

Coplanar merging is enabled by default. Check the import summary after importing is complete to see how many surfaces were merged. 

Merging coplanar surfaces is tricky business since many surfaces are not exactly coplanar. There are two choices here: 

• Angle Tolerance - The maximum angle variance between surface normals for the surfaces to be considered 'coplanar.' 

• Distance Tolerance - The maximum distance between surface planes for them to be considered 'coplanar.' 

Increasing these tolerances increases the number of surfaces that will potentially be merged together. Merging surfaces that are not actually 
coplanar can adversely affect rendering and calculations. 

Surface Checks 

When AGi32 imports 3D entities as objects, they may be inspected for consistent surface orientation and duplicate surfaces. These checks are 
performed within each object by processing the vertices of a specified percentage of surfaces together within each object. By default, AGi32 uses a 
value of 0.25 (25%) as its grouping value. This value, the '3D Entity Check Range' may be changed in the Advanced Import Options section of the 
Import CAD File dialog. 

• This process is based on the assumption that adjacent surfaces in the model should be within a certain percentage of each other in the CAD 
file. This may not always be true, in which case the percentage of surfaces checked should be raised by increasing the '3D Entity Check Range'. 
A 3D Entity Check Range equal to 1.00 will ensure consistent surface orientation and no duplicate surfaces within each imported object. 
However, the larger this number, the longer AGi32 will require to perform these inspections and modifications. 

• Files with imported surfaces that are of inconsistent surface orientation or have duplicate surfaces may not render with Adaptive Subdivision 
enabled.  

Importing CAD Files 

AGi32 is able to import CAD-created backgrounds in either DXF or DWG file formats. Three-dimensional surface information (3D Entities) can also 
be imported into AGi32 for ease in exchange of model information between AGi32 and other modeling programs. 

CAD files are imported in layers that were defined when the original drawing was created. The user can import any or all of the layers. If desired, the 
user can combine all of the drawing entities into one layer and/or all the imported 3D entities into one object. 

If AGi32 does not recognize the units in the file, the user will be prompted to enter the correct (original) drawing units or a user-defined Scale 
Drawing Factor. AGi32 automatically converts the scale to the current display scale, Feet or Meters. 



AGi32 Help System  Working With AGi32 Job Files 

62 

 

1. CAD Viewer - Click the Show/Hide CAD Viewer button to display the CAD Viewer. It is not displayed by default. The CAD Viewer allows users to 
preview a drawing before importing. The CAD Viewer responds to layer selection while selecting layers to import as well as selecting layers for 
import mapping. 

2. Layer Selection - By default, all visible ("on" and "thawed") layers are selected; this option is called Smart Select. Alternatively, you may select 
individual layers or click the Select All Layers button to select all of the layers. 

3. Units and Scaling - If AGi32 cannot absolutely identify the units in the imported CAD file, the current display units will be used, displayed 
between question marks.  

� If a different display unit is desired, click the current display unit button (Example: Ft). 

� Applying an alternate scale - Enter a Scale Drawing Factor or the units the original drawing was created with. The drawing extents will 
update dynamically. 

4. 3D Options - If the file contains 3D-surface information , you have several choices about how to handle these entities. 

• To import all of the entities (drawing entities and 3D entities), select the radio button adjacent to Import All. This option is selected by 
default. 

• To ignore 3D entities in the imported CAD file, select the radio button adjacent to "Import Drawing Entities ONLY". 

• To import only the 3D entities and ignore the remainder of the drawing entities in the file, select the radio button adjacent to "Import 
"3D-Entities Only." 

• To import the 3D-surfaces as AGi32 Objects, select the radio button adjacent to "Import 3D Entities as Objects". This checkbox is 
selected by default whenever 3D Entities are present in an imported CAD file. 

• To convert the 3D entities to drawing entities, select the radio button adjacent to "Import 3D Entities as Drawing Entities". 

• By default, 3D entities are not grouped into a single object. To group objects into a single composite object select "Group ALL 3D 
Entities Into a Single Object" and specify an object name. This option is best suited for single object import (e.g., plants, cars, people, 
etc.) When importing an entire environment, de-select this option for best results. 

5. Blocks - By default AGi32 explodes all drawing and 3D entity blocks into their original entity components. You may opt to maintain high or low 
level blocks instead. 

6. Import Text - Text entities are imported by default. To not import text, clear the checkbox adjacent to Import Text. 

7. Flatten Drawing Entities - This option allows you to change the Z coordinate of all drawing entities to one consistent value (the default value is 
0). This option should only be applied to 2D drawings to avoid stray entities floating above or below the base layer. An alternate Z value for all 
drawing entities may also be specified. 

8. Group ALL Drawing Entities Into a Single Layer - By default,drawing entities are not grouped into a single layer; instead the original layer 
stratification is maintained. To group drawing entities into a single composite layer select "Group ALL Drawing Entities Into a Single Layer" and 
specify a layer name. 

9. Click OK to begin the import process. 

10. AGi32 will present a series of progress bars to keep you informed of the import process and AGi32 database updating. At the end of the import 
process, an import summary is displayed with the tally of successfully (and unsuccessfully) imported drawing and 3D entities.  

Advanced Options 

• Curve Increment for Import - This value, specified in degrees, indicates how curves are discretized into straight lines segments in AGi32. The 
default value is as specified in System Settings-Advanced (factory setting - 15 degrees). 

• Remove Duplicate Surfaces - This option is selected by default. Checking for duplicate surfaces may yield cleaner objects that calculate faster 
and with less possible errors. 

• Consistent Surface Orientation - This option is selected by default. Checking for consistent surface orientation may yield better presentation 
quality objects that calculate with less possible errors. 

• 3D Entity Check Range - This value indicates the percentage of surfaces within each imported object that will be checked for duplicate surfaces 
and consistent surface orientation. 

Related Topics 

Importing CAD Files containing 3D Geometry 

Scaling Imported CAD Files 

Scaling Imported CAD files (DXF and DWG) 

Drawings created in external CAD programs can be used as backgrounds for the AGi32 job file. When drawings contain 3D Entity information, they 
can actually be used as solid models. CAD files composed of line data only contain lines and text and have no solid surface characteristics. In order 
to enclose a space (rooms) or reflect, transmit or obstruct light (objects) the CAD file must contain 3D Entity information. 
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Drawings are created in a CAD environment using drawing units of feet, inches or non-specific units (decimals, scientific, or fractions). It is very 
important that the CAD file be imported in at the correct scale so that the spatial relationship between all of the entities (luminaires, calculation points, 
objects, etc.) is correct. 

All CAD files are converted to Units of Feet or Meters, the drawing units supported in AGi32. 

Known CAD Units - Inches 

If a CAD file is created using drawing units of inches (one unit equals one inch), the units do not match up. When a CAD file is imported, AGi32 
checks the unit type to see whether a conversion needs to be applied. In the case of inches � feet, AGi32 automatically applies a conversion factor 
of 0.0833 (1 inch � 0.0833 feet), and applies the Inches units in the "Units Specified in CAD File" field. 

 

Unknown CAD Units 

If a CAD file is created using non specific drawing units (decimals, scientific units and fractional), the units can represent any real world unit. In this 
case, you specify which units to assume or specify a specific Scale Drawing Factor. By default, AGi32 will assume units of Feet if the current AGi32 
Display Units are Feet, and Meters if the current AGi32 Display Units are Meters. 

 

If you do not know what units were used when the drawing was created, you may use the following procedure to bring the CAD file in at the correct 
scale: 

1. Import the CAD file using the assumed Units and a Scaling Factor = 1. 

2. Zoom in on a known entity (such a dimensioned line or parking stall width) and measure its length using the Tools-Measure-Distance command 

( ). 
3. Compare the measurement distance to the known length of the line (or parking stall width). 
4. The ratio of the two will give you the actual scaling factor. 

Scaling Factor = known length / measured length or distance 

5. To scale the drawing entities correctly, you have two options: 
A. Open a new job file and import the CAD file again using the assumed Units and apply the calculated Scaling Factor. 

B. From the Modify menu, choose Drawing Entities - Scale - All ( ). 
� Enter the reference point: 0,0,0 
� In the Scale text box, enter the calculated scaling factor. 

6. Re-measure the same line or distance to verify that the scale is correct  
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Exporting CAD Files-Concepts 

The Export command creates a CAD-compatible DXF or DWG file from the current AGi32 job file. While other CAD programs can use the CAD files 
created from AGi32, the format is constructed specifically to AutoDesk standards. The exported CAD file consists of layers containing drawing 
entities and text representing all of the lighting specific data in the AGi32 files. These files can be easily merged into existing drawings. 

Please note that the process of creating a CAD file simply produces an additional file formatted to the selected CAD format - DWG or DXF. Your 
original AGi32 file is not altered in any way. Exporting a CAD file is not a replacement to saving your original AGi32 file. You should always save your 
AGi32 file with any current changes. A CAD file has no lighting or surface information inherent inside, and lighting metrics present in a CAD file are 
not modifiable in AGi32. Its purpose is to combine with other existing CAD drawings for presentation only. 

CAD Versions supported 

RealDWG 2010 DWG/DXF 

RealDWG 2007 DWG/DXF  

RealDWG 2004 DWG/DXF 

RealDWG 2000 DWG/DXF 

RealDWG R12 DXF  

WYSIWYG Approach 

All entities are exported with their current 3D coordinates, unless the Reset Origin option is selected . No surface information is included in the 
exported CAD file - only line and text data. 

Units and Scaling Factor 

The current Units applied in the AGi32 are shown (e.g., Feet or Meters). The user can choose which Units to apply to the exported CAD file: Feet, 
Inches, Centimeters or Millimeters. If a CAD file has been imported into the AGi32 file, its original units will be applied as the default conversion units. 
For example, if a CAD file with Inches units is imported into AGi32, Inches will become the default unit selected in the "Units will be Converted to" list.  

• If multiple CAD files have been imported, the units in the most recent import will be applied as the current conversion units. 

• If a CAD file is exported multiple times, the last applied conversion unit is recalled and reapplied. 

AGi32 Unit Conversion Unit CAD Decimal Unit Value CAD Architectural/ 
Engineering Unit (Inches) 
Value 

Feet Feet 1:1 12:1 

Feet Inches 1:12 1:1 

Meters Meters 1:1 N/A 

Meters Centimeters 1:100 N/A 

Meters Millimeters 1:1000 N/A 

Conversion Units = Feet: When inserted into a Decimal Units drawing, one unit in AGi32 equals one Decimal unit. When inserted into an 
Architectural or Engineering Units drawing, one AGi32 unit equals one Inch. For example, a line 36" long in AGi32 would appear 3' long in CAD (36 
Inches). 

Conversion Units =  Inches: When inserted into a Decimal Units drawing, one unit in AGi32 equals twelve Decimal units. For example, a line 3' 
long in AGi32 becomes 36 units long in CAD. When inserted into an Architectural or Engineering Units drawing, one AGi32 unit equals one Foot 
(twelve inches). For example, a line 36' long in AGi32 would appear 36' long in CAD (432 Inches).  

Conversion Units = Meters: When inserted into a Decimal Units drawing, one (Meter) unit in AGi32 equals one Decimal unit. 

Conversion Units = Centimeter: When inserted into a Decimal Units drawing, one (Meter) unit in AGi32 equals one hundred Decimal units. 

Conversion Units = Millimeter: When inserted into a Decimal Units drawing, one (Meter) unit in AGi32 equals one thousand Decimal units. 



AGi32 Help System  Working With AGi32 Job Files 

65 

 

Apply Scaling Factor 

By default, the AGi32 scaling factor is set to 1. If a Scaling Factor was applied on import, the inverse Scaling Factor should be applied to export the 
drawing at the same scale as the original. For example, if a Scaling Factor of 0.5 was applied on import, a scaling factor of 2 would need to be 
applied on export, to output the resultant file at the same size as the original. However, if the applied scaling factor specified on Import is necessary 
to fix any scaling error, an inverse scaling error should not applied (the environment will be exported its actual size). 

Reset Origin 

The Reset Origin command is automatically applied if the Translate Origin command was used to apply a local User Coordinate System (UCS) to the 
model. It is desirable to Reset the Origin in the exported CAD file so that the original drawing locations are maintained. This is critical in the 
architectural construction process, where many consultants' drawings are overlaid and externally referenced on top of each other to create a 
complete construction drawing set. 

The coordinates displayed in the Reset Origin section are the negative values of each of the X, Y and Z parameters specified in the Translate Origin 
command. 

Export Types 

This section allows users to select which entity types to export.  

• Entities must exist (and be visible) in Model Mode to be exported 

• Some entity types are dependant on others to be exported. In other words, if the main export type is deselected, its dependant metric is also 
deselected, as follows: 

1. Luminaires must be selected for their dependant entities to be available: Templates, Photometric Webs and Aiming Vectors. 
2. Calc Points must be selected for Statistical Areas to be available. 

• By default, the Model Mode symbol is exported. However, the Render Mode symbol may be exported instead. 
• The Select All and None buttons allow for quick selection and entity clearing. 

Note: Parametric Mirror lines and labels are not exported; they are a design tool only. 

Export Layers 

By default, the exported CAD file layers are constructed based on entity type. This means that all entities of one type are placed on the same layer 
(e.g., all luminaire symbols are placed on the Luminaire layer). This methodology allows for the cleanest layer construction and entity management. 
Within each layer, entities are further organized by blocks for easy modification (see Blocks section below). 

Layers are named using the following convention: Prefix-ProjectName-EntityType 

For example, AGi32-Project_1-CALCPTS, AGi32-Project_1-ISOLINE are the layer names for the calculation points and Isolines, respectively, 
contained in Project_1, exported from AGi32. 

• Layer names are not restricted to a particular character limit. However, DWG versions prior to 2004 had 31 -character layer name restrictions 
and will truncate longer layer names to 31 characters. Therefore, if you export older file versions (RealDWG 2000 DWG/DXF or RealDWG R12 
DXF), use the Entity Type (Abbreviated) option instead of the default Entity Type. 

• Imported drawing layers are grouped together in one layer when exporting unless the Layer by Entity Name method is used. By default, 
imported CAD layers are grouped together into a layer named "AGi32-CADImportName-DRAWING (e.g., AGi32-BurgerWorld-DRAWING). 

• You may change the Prefix assigned to exported layers. The default is AGi32. 

• You may change the delimiter assigned. The default is a hyphen (-). 

• To export individual layers for each entity (e.g., all F1 Luminaires on the LUMINAIRE-F1 layer, etc.), choose the Entity Name selection box in 
the Export Layers list. This selection will create a layer for each entity definition in AGi32 and may result in a lengthy layer list. 

• A Date/Time stamp may be added to differentiate different revisions from one another. 

• The Export Layers order may be reorganized. Use the Up and Down arrows to the left of the Export Layers list. An example is shown as each 
option is selected and modified. All options may be selected or deselected. To not include a Prefix or Delimiter, clear these selection boxes. 

Entity Type Abbreviated Type (if selected) Default Entity layer organization 

Calculation Points CPT AGi32-Project_1-CALCPTS 

Calculation Points - Mark Points MKP AGi32-Project_1-MARKPOINT 

Isolines ISO AGi32-Project_1-ISOLINE 

LPD / UWLR Areas LPD AGi32-Project_1-LPD_UWLR_AREA 

Statistical Areas STA AGi32-Project_1-STATISTICAL_AREA 

Luminaires LUM AGi32-Project_1-LUMINAIRE 

Luminaire Aiming Vectors AIM AGi32-Project_1-AIMINGVECTOR 

Luminaire Templates TMP AGi32-Project_1-TEMPLATE 
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Luminaire Photometric Webs WEB AGi32-Project_1-PHOTOMETRICWEB 

Luminaire Poles and Pendants POL AGi32-Project_1-POLE_PENDANT 

Rooms ROM AGi32-Project_1-ROOM 

Objects OBJ AGi32-Project_1-OBJECT 

Drawing Entities DWG AGi32-Project_1-DRAWING - Not blocked 

Schedules SCH AGi32-Project_1-SCHEDULE 

Miscellaneous 

Font Override 

Many True Type Fonts are difficult to read in CAD drawings. This option overrides all of the AGi32 text styles with the default CAD font. Note: All of 
the text styles are still created and included in the CAD file, making it easy to change the text styles in CAD. 

Color 

By default, the ACI Color Method (256 color) is used. All AGi32 colors are converted to the nearest ACI color. This will result in the best WYSIWYG 
output. 

24-bit color yields more accurate conversion of colors, but True Color values are not flipped in CAD. That is, with 24-bit color, black text will not 
appear white on a black background, as it does with ACI color in CAD. 

Make Block Names Unique 

When inserting CAD drawings exported from AGi32 into other CAD drawings, naming conflicts can arise causing block definitions to be overwritten. 
These conflicts do not cause errors, but happen silently, making them difficult to notice. When selected, the 'Make Block Names Unique' option will 
prevent these conflicts from occurring by assigning all blocks an unique identifier (ID). The ID is the same for all blocks in the current export, that is; 
the ID is unique for the export not for each individual block. 

Example: Block Names With Unique ID: 

• AGI32-IDabcdef-Project_1-CALCPTS-Room_Floor 
• AGI32-IDabcdef-Project_1-LUMINAIRE-FixtureA_Symbol 

Example: Block Names Without Unique ID: 

• AGI32-Project_1-CALCPTS-Room_Floor 

• AGI32-Project_1-LUMINAIRE-FixtureA_Symbol 

If you want block names to be uniform across more than one export from AGi32, deselect this option. You can avoid naming conflicts in CAD by 
adding drawings to the master drawing with the XREF command rather than the INSERT command. Naming conflicts do not occur when adding 
drawings as external references (XREF) but can occur when adding drawings as block references. 

Blocks 

Each entity in AGI32 is exported as a block. These blocks may contain several levels of block hierarchy, as needed. 

Block 
Reference 

Block Name Block Structure (default Layer Hierarchy) 

Calculation 
Entity 

AGi32-ProjectName-CALCPTS-
EntityName 

Calculation Entity - CALCPTS Layer - Nested Block: 

• Calculation Points, Mark Points, Isolines, Calculation Points Label (Block), 
Boundary Lines 

Mark Points - MARKPOINT Layer - Nested Block (each Markpoint is also a block). 

Isolines - ISOLINE Layer  - Block (each Isoline set is also a block, explodes to line 
segments). 

Block is on CALCPTS Layer. 

Statistical 
Area 

AGi32-ProjectName-
STATISTICAL_AREA-EntityName 

All Block components are on STATISTICAL_AREA Layer - (Boundary Line, Label). 

LPD / UWLR 
Area 

AGi32-ProjectName-
LPD_UWLR_AREA-EntityName 

All Block components are on LPD_UWLR_AREA Layer - (Boundary Line, Label). 

Luminaire AGi32-ProjectName-LUMINAIRE- Luminaire (symbol) - LUMINAIRE Layer - Nested Blocks: 
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EntityName • Luminaire Location (Single, Arrangement, Group) 

• Expanded Luminaire Location (Symbol, Photometric Web, Aiming 
Vectors, Aiming Point Labels (Block))  

• Template 

• Poles and Pendants 

• Luminaire Labels (Block) 

Aiming Vectors and Labels - AIMINGVECTOR Layer. 

Luminaire Templates - TEMPLATE Layer. 

Photometric Webs - PHOTOMETRICWEB Layer - Block. 

Poles and/or Pendants - POLE_PENDANT Layer. 

Block, Luminaire symbols and Labels are on LUMINAIRE Layer. 

Rooms AGi32-ProjectName-ROOM-
EntityName 

All Block components are on ROOM Layer - (3D Polylines, Label). 

Objects AGi32-ProjectName-OBJECT-
EntityName 

All Block components are on OBJECT Layer - (3D Polylines, Label). 

  

Schedules AGi32-ProjectName-SCHEDULE-
EntityName 

All Block components are on SCHEDULE Layer - (Gridlines, text, drawing lines). 

Note: The block hierarchy is not affected by layer hierarchy. The layer hierarchy only affects the layers on which each block (and its internal entities) 
reside. That is, entities within each block (lines, text, etc.) are on the appropriate layers and the block may be on a different layer. Because of this, if 
you want to change the visibility of something in CAD, you should FREEZE/UNFREEZE layers instead of turning them ON/OFF.  

• Freeze/Unfreeze: Turns blocks (and all entities within the blocks) that are on that layer off/on.  

• On/Off: Turns entities (NOT blocks) on specified layer on/off.  

Text 

Calculation Point text is rotated to match orientation and tilt of all vertical surfaces; calculation points are readable in all Elevation views. 

Highlight Values - Regardless of foreground or background selection in AGi32, the text foreground is colored in the CAD file (there is no equivalent to 
text background in CAD).  

All AGi32 text is exported as MText with an attachment point top and left  - Upper Left-hand Corner 

• CAD_Text_Height = AGI_Text_Size / Import_Text_Size_Factor  

• CAD_Y = AGI_Y - (CAD_Text_Height / (2 * Import_Text_Offset_Factor))  
• For more information on this, see Importing CAD Files - Concepts.  

CAD Text Styles are created for each font-bold-italic combination. Other text formatting, such as underline and strike-through, are ignored (only bold 
and italic text formatting is supported at this time). Text Style names use the same prefix and delimiter as layers do.  

Example Text Style Names: 

• AGi32-Courier New  

• AGi32-Courier New-Bold  

• AGi32-Courier New-Italic  
• AGi32-Courier New-Bold-Italic  

AGi32 Export Text Size and Offset Factors 

Text Size and Offset Factor are applied to text in CAD files when they are imported into and exported from AGi32. These parameters are applied to 
exported text so that in CAD it looks similar to its original appearance in AGi32. 

The text size in AGi32 determines the size of the character block containing the font glyph and top and bottom leading spaces. In CAD software, the 
text is created without any top and bottom leading spaces. 

Text Size Factor adjusts the CAD Text Size to correspond to the AGi32 Text Size, which includes the top and bottom leading spaces. 
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AGi32 Line Type Mapping 

AGi32 Line Type CAD Line Type 

SOLID CONTINUOUS 

DASH DASHED 

DOT DOT 

DASHDOT DASHDOT 

DASHDOTDOT DIVIDE 

AGi32 Line Weight Mapping 

Lines are Mapped to nearest-millimeter line weight in CAD. Most lines in AGi32 are pixel thickness. However,Model Mode luminaire symbols can 
have thicker line weights applied, as can imported CAD drawing entities. 

Exporting Files 

The Export command creates a CAD-compatible DXF or DWG format file from the current AGi32 job file. This vector based file format contains layers 
representing drawing entities, luminaires, calculated lighting metrics, rooms, etc. 

1. From the File menu choose Export, or on the Common toolbar select . 
2. The CAD file is assigned the same name as the AGi32 file by default with the .DXF or .DWG extension. If an alternate filename and/or location 

is desired, specify the CAD file name: 

• Select the appropriate drive and/or folder. By default, AGi32 starts the search in the current folder that the AGi32 file is saved in. 
You may change the CADFiles_Export folder location (e.g. to a network location) by clicking on the File System button. 

• Browse for the desired folder by navigating through the available folders.  

• Manually type in the file name and path in the File Name text box. 

3. Choose which file type format to apply. The default is RealDWG 2004. AGi32 supports the following file types and versions: 

• DWG (2000, 2004, 2007, 2010) 

• DXF (R12, 2000, 2004, 2007, 2010) 
4. Click OK. 

Related Topics 

Export CAD Files dialog 

System Settings 

CAD Export Attributes 

The CAD Export dialog allows the user to specify many properties of the exported CAD file: Units, Scaling factor, Reset Origin, Export Types, Export 
Layers, and Color.  

The CAD file is organized to replicate the AGi32 environmental structure. In other words, it is WYSIWYG (what you see is what you get). Most of the 
entities are exported as blocks so that the selection method is as it is in AGi32 (All entities related to each luminaire location are blocked, etc.). 

Once created, the folder in which the file was created is opened, with the newly created file highlighted for easy opening or attachment to e-mail. 

1. By default, AGi32 exports in the same units as the current AGi32 units (e.g., Feet: Feet), unless a CAD file was imported with alternate units. 
You can specify any Conversion unit. If desired, an additional Scaling Factor may be applied (typically not necessary). 

2. The Reset Origin option is automatically checked if the Translate Origin command was applied. 
3. Choose which entities to export. By default, all visible entities are exported. 
4. If desired, you can modify the exported layer structure. By default, all like entities (e.g., objects, rooms, luminaires, etc.) are exported on the 

same layer. 
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5. Choose the color method. ACI Color is the default and will result in the most consistent appearance with AGi32 (especially with dark 
backgrounds). 

6. Click OK. 

 

Printing 

Banner 

Banners apply a graphic image imported into AGi32 for use when printing output from Room Estimator, Roadway Optimizer ,Print-Text and More 
Type C and B dialogs. The image may be created in any graphics program (such as Corel Photo Paint™ or Paint Shop Pro™) as long as it is saved 
in a bitmap (BMP), JPEG (JPG) or Windows™ Metafile (WMF) format. The image will always maintain its original aspect ratio (the ratio of width to 
height) and will be scaled accordingly to fit within the confines of the banner size. 

Banners have a maximum size of 1.25 x 6 (31.75mm x 165.1mm) and are always placed at the very beginning (top) of every page of the printed 
output. 

1. From the File menu choose Banner. 
2. Import the banner in one of two ways: 

• To import a saved graphics file, click on the Import button. You will be presented with the 'Select Image File' dialog in order to 
browse for the graphics file. Select the file and click Ok to bring it into the Banner dialog. 

• You may paste a bitmap image directly into the Banner dialog from the Windows™ clipboard. First, left click in the banner section 
where an existing image is located (or in the blank space if empty). Then, right click to display the pop up menu and select Paste. 
Alternately, instead of selecting Paste from the pop up menu, you may press the CTRL+V keys (at the same time) on your keyboard 
to paste the image in. 

3. You may preview the printed banner exactly as it will appear by clicking on the Print button. The banner will be sent automatically to your default 
Windows system printer. 

4. Click Ok to save the current image as your Banner image. 

Banner-Concepts 

The Banner command allows you to import a custom graphic created in any graphics software to use with output generated from AGi32's Print Text, 
Roadway Optimizer Room Estimator and More-Type C and B dialogs. The graphic images must be in BMP, WMF or JPG formats. 

Banners provide you with the ability to create custom headers for output generated by AGi32's Print Text, Roadway Optimize, Room Estimator and 
More Type C and B dialogs. Banners have a maximum size of 1.25" Height x 6" Width (31.75mm x 165.1mm) and are always placed at the very 
beginning (top) of each page of printed output. 

Print Quality 

Inspect the print quality of your banner by printing it. Click on the Print button to send the Banner image to your default printer. If your selected image 
is larger than the 1.25" x 6" size allowed, then AGi32 will compress the image to fit the maximum size while maintaining the image's aspect ratio (e.g. 
image will not be distorted or skewed). This generally results in acceptable quality.  You may use a graphics program to "resample" the image as 
required if cropping or non-uniform sampling is desired. This may preserve better detail in your image. 

Note: Typical screen resolutions range from 72 dpi to 96 dpi. At 72 dpi, 1.25" x 6" corresponds to 90 x 432 pixels. 

Printing - Concepts 

The Print command is designed to print a single view from your job file. This is in contrast to the printing capabilities of AGi32's Page Builder 
environment, which allows multiple views to be printed or plotted to a single sheet. The Print command, with its single view capability, is most useful 
for check plots, quick output to fax or to be used in conjunction with output from the Print Text command. 

The selected view can be printed using a user defined scale or "fit" a to the selected page size. AGi32 offers options to determine what is plotted and 
how the image fits on the paper. You can control the area of the drawing, its scale, rotation and location on the paper. 

Small printing devices, such as ink jets and laser printers, are designed to use a restricted media size. They are obviously not capable of producing 
large drawings at a legible scale on a single sheet of paper. AGi32 allows drawings to be printed at any scale, even if multiple pages are required. 
The selected output will be paginated appropriately with hatch marks indicated at the corners for easy matching of pages. 

Windows printers 

AGi32 will print or plot to any Windows printer or plotter, as well as to the Adobe Acrobat Distiller. There is generally little preparation needed to print. 
AGi32 references the default settings (including paper size, rotation, quality, etc.) for all Windows printers. The user may change the paper size and 
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orientation, or configure the printer properties to write to a file. When selecting a plotter, you may need to configure additional properties, such as pen 
configuration, print quality, paper source, etc. 

Where 

The Where section indicates specific printer parameters such as device, paper size, orientation and port with regards to printer setup. To change any 
of these parameters, click the Print Setup button. 

If the selected printer supports color, both the Color and Black and White options are active. If the selected printer does not support color printing, 
only the Black and White option will be available. Some monochrome laser printers allow the user to select the Color option so that they may print in 
shades of gray. 

What 

The What section describes exactly what you would like to print. Begin by selecting the desired View name from the View pull-down menu - if more 
than one view exists. Once the view has been selected, choose the portion of the view you are interested in printing: Display, Extents or Window. 
AGi32 will retain the last selection as the default. 

Display - The Display options prints the entire contents of the selected AGi32 View including the white drawing area. This option can be useful when 
establishing a buffer around your drawing, or more likely, after zooming in to t a particular scene of interest, then plotting that exact view. 

Extents - The Extents options prints the coordinate extents (minimum and maximum X, Y and Z coordinates) of the drawing. This is the most 
common method of plotting an entire drawing. 

Limits- The Limits options uses the drawing Limits specified in the View-Set Limits command to determine what coordinate information is included in 
the plot. The default Limits defined in AGi32 are 0,0 100,100 and may not be relevant for the current drawing. 

Window - The Window option allows the user to determine what will be plotted within a specified cropping window. 

Margins 

Margins are measured from the edge of the paper inward. Minimum margins are dictated by the selected printer and media size. AGi32 allows the 
user to increment the margin size individually on each side of the paper (by 5 mm or 0.25 inch depending on the media). When the print scale 
requires multiple sheets of paper, each sheet will apply the specified margins. When selecting the Center Image option, the margins are controlled 
automatically. 

The Reset button will reset all margins to their minimum values. 

Scale 

Job files created in AGi32, or merged from other sources (such as DWG or DXF files) are used at a 1:1 scale in the graphics window. Each drawing 
unit represent 1 foot or 1 meter depending on the display units selected. In other words, when the cursor is moved across the screen, the coordinate 
locations appear in terms of drawing units. 

When the drawing is printed, it is scaled in order to restrict it to a particular media size or to correspond with certain guidelines. To scale the drawing, 
you need to specify the number of drawing units that corresponds to each plotter/printer unit. When the current display unit is feet, AGi32 will present 
a print scale of 1 = <X>'. When the current display unit is meters, AGi32 will present a print scale of 1:<X>. A scale greater than zero must be entered 
when the User Defined Scale is selected. 

Scaling factors operate independently of selected media sizes. For example, a job file created with display units of Feet and plotted to A4 paper (210 
x 297 mm) will still ask for a user defined scale of 1 = <X>'. Similarly, a job file created with display units of Meters will ask for a 1:<X> ratio whether 
the paper is in Metric or English units (A4 or letter). AGi32 handles the units conversion automatically. 

Scaling Examples to fit on C Size Paper (22" x 17", Landscape Orientation) 

Maximum Extents Dimension/Display Units Suggested Standard Scale 

780 Feet 1 (Inch) = 64 Feet (use 1/8 Architectural Scale) 

240 Meters 1 : 600 (use 1:60 Engineering Scale) 

Scale to Fit 

When the Scale to Fit option is selected, AGi32 will fit the selected view option (Display, Extents or Window) within the printable area. Once this 
option has been selected, the scaling factor will gray out, disallowing any modification to the scaling factor. 

Special Formatting 

When printing the drawing selection on one page, AGi32 allows you to center the image within the page. The margins will be recalculated to center 
the image, and then deactivated. To reactivate the margins and change the image formatting, deselect the Center Image box. At this time you may 
change the View options, decrease or reset the margins. 
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It is best to center the image last, due to the way AGi32 calculates the margins. If for some reason you need to change the View options or scale 
when the image is centered, uncenter the image and reset the margins first. This recalibration is necessary because AGi32 centers the image and 
increases the margins based on the previous image size. 

When the number of pages is greater than one, centering the image will not result in any changes to the printed output. 

Print Preview 

Once the View option and scale have been specified, the Print Preview option is available. Based on the current print specifications, Print Preview 
will display the drawing image as it will appear on each page of the printed output. When multiple pages exist, the pages are numbered from left to 
right beginning at the top. Extra blank pages may be displayed if the View option type includes white space (e.g. Display). These pages can be 
excluded from the output list in the Print Details dialog. 

Print Details 

The Print Details dialog appears after the Print button is selected. This dialog allows you to select the umber of copies to print and which pages will 
be printed when AGi32 is breaking the output into multiple pages. You can select a range of pages by entering the page numbers separated by a 
hyphen (e.g. 6-10) or random pages by separating the page numbers by commas (e.g. 5,7,11,12,15). 

Related Topics 

Page Builder 

Print Text 

Exporting Render Views 

VRML Export 

The Printing Process 

The Print command allows the user to translate one view of their work at any scale to the printer/plotter. AGi32 will set options that determine what is 
plotted and how the image fits on the paper including the drawing area, scale, rotation, and location on the paper. 

1. From the File menu select Print, or from the Common Toolbar select . 
2. Verify that the desired printer and media are displayed in the Where section. To change the printer or media, click the Print Setup button. 

Printers that can print color will allow the selection of Color or Black and White for printing. 
3. Select the desired view in the What section. Use the pull-down menu to see all of the available view names. 
4. Specify the Portion of the view that will be printed by selecting the appropriate radio button Display, Extents or Window. If 'Window' is selected, 

click on the Window button to specify the window's extents. 
5. Specify the drawing scale: 

Job files created in AGi32, or merged from other sources (such as DXF), are not scaled in the graphics window. Instead, a drawing unit 
represents 1 foot or meter depending on the display units selected. In other words, when the cursor is moved across the screen, the 
coordinate locations appear in terms of drawing units. When the drawing is printed or plotted, it is scaled in order to restrict it to a particular 
media size or to correspond with certain guidelines. To scale the drawing, you need to specify the number of drawing units that correspond 
to each plotter unit (inches or mm). 

Select the radio button adjacent to User Defined Scale and specify the scale in current display units (ft. or m) below. 

Ex: 1 inch = 20 Ft. 

Or Select the radio button adjacent to Scale To Fit Actual Page Size to fit the view selection on one page. 

6. If printing on one page, you may center the image on that page by clicking in the Center Image selection box. 
7. The number of pages that will be printed according to the current scale will be shown in the Number of Pages That Will Be Printed section. You 

may continue altering the scale (or select a different view portion) to change the number of pages that will be printed. 
8. Preview the selected output by clicking the Print Preview button. If you like the output, click the Print button. Otherwise, click the Cancel button 

to return to the Print dialog. 
9. Click Ok to print the selection according to the current settings. You may also print from the Print Preview dialog box. 

Selecting a Window To Print 

When the Window button is clicked, the Print Window dialog appears allowing the user to enter the window's coordinates or specify the printing 
window on the screen. The window will crop any entities that are partially contained in the window. Once the window coordinates are specified, they 
are saved for future use until they are re-specified. 
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1. Specify the printing window with two opposing corners. This may be done manually by entering the X, Y and Z coordinates for the lower left 
corner and upper right corner in the Window Coordinates boxes. Click Ok. 

2. Alternatively, you may specify the opposing corners of the cropping window on the screen by clicking the Specify button. You will be returned to 
the AGi32 drawing area. Specify the first corner of the printing window by locating the cursor at the desired location and clicking the left mouse 
button. 

Drag the cursor to the opposing corner of the printing window and click the left mouse button again. You will be returned to the Print dialog box.  

Print Preview 

The Print Preview dialog allows the user to view the current selection or Page Builder report as it will appear on each page of the printed output. 
Multiple pages (up to 25) are displayed from left to right and are numbered accordingly. Occasionally, depending on the view option, additional blank 
pages may be displayed. You can exclude these from the output list in the Print Details dialog if desired. 

 To accept the output as it is displayed, click Print. To redefine the output, and return to the Print dialog, click Cancel.  

Print Details 

The Print Details dialog allows you to specify which pages to print (if printing multiple pages) and how many copies of the output to print. 

 When printing a single page, the Pages radio button will gray out and you will only be able to select the number of copies to print. Use the up and 
down scrolling arrows to specify the number of copies. 

 When printing multiple pages you may select to print All Pages or specify the Pages you wish to print. Specific pages may be entered in ranges 
(Ex:1-3) and/or individually (Ex: 11,13,15). You may enter the pages in any combination and in any order, if desired (Ex: 5-7, 3,11). 

 Once the page(s) and number of copies have been specified, click Ok to print. A status bar will appear on the bottom indicating the transfer process 
to the printer or spooler. 

Printing Text - Concepts 

The Print Text command provides a convenient method of printing descriptive and/or statistical information in a preformatted manner. You may select 
specific Summaries to print or select all of them in one easy step. Clearly, if an entity type does not exist in the job file, the associated summary will 
not be generated. Some summary types, such as Luminaire Definitions, can be expanded to include more information if desired. This is achieved by 
clicking on the Detailed radio button instead of the Basic one. 

This feature allows you to print archival information about your job file, so that you could recreate it in the future, and can provide you with additional 
presentation material so that your graphical output is cleaner. 

In addition to producing printer output, you are provided the option of sending the selected output to a text file. When this option is selected, the 
output is formatted as simple ASCII text; all special formatting is removed and the banner, if selected, is not included. The folder containing the file is 
automatically opened after the file is created, for easy viewing or for other file functions (e.g., attaching the text file to an e-mail message). 

Banner 

The banner is composed of a graphic file of your own creation. The image file must be in BMP, JPG or WMF format and can be created in any 
graphics program capable of saving in these formats. File size is up to a maximum of 1.25 x 6 Inches. In pixels, this corresponds to 90 x 432 (in 72 
dpi). Files larger in size will be compressed to fit. 

When selected, the Banner will print at the top of every page. We recommend that banners be composed of a corporate logo and possible company 
information. Keep in mind that a Banner is a graphic (raster) file, and very small text will be difficult to discern when printed. 

Title Page 

The Title Page section provides a test entry area for you to compose descriptive text you may want to include in a separate Title Page. The Title 
Page also prints with the Banner across the top. Some users prefer to add their descriptive information to the Banner and save the Title page for job 
descriptions. Others simplify the banner and include all company and job descriptions in the Title Page. 

You can save your text entry for repeated use by selecting the Save button. Only one Title Page can be saved at a time. The saved Title Page can 
be merged into a new job file by using the Retrieve button. 

Alignment 

Text included in the Title Page can be aligned with the left margin or centered within the page. 

Save and Retrieve buttons 
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Any portion of the text entered in the Title Page section can be saved to use repeatedly with each new job file. Once the text is retrieved, you can 
modify any portion of the text, add to or delete from it, even save it again. All text entered in the Title Page section will print, whether it is saved or 
not. 

Contents 

The Contents section contains selection boxes for the variety of information that can be summarized in the job file. Certain topics allow you to select 
Basic and Detailed Summaries. The table below describes each summary briefly. 

Topic Basic Summary Detailed Summary 

User / Job File Information User Info (User name, Company Name, Address, Telephone, etc) from User Information dialog. 

Job file information (file size, AGi32 version, user information, date last modified, total time (in 
hours) file has been opened since it was first saved, description and user information notes) from 
File Information dialog. 

Luminaire Definitions Brief summary of luminaire definitions 
including Arrangement, Roadway, Indoor 
and Flood classifications, LCS Data (zonal 
lumen values), BUG Ratings, and LER. 

Basic plus Model and Render symbol details 
(including housing and luminous color) and 
Photometric File Summaries. 

Luminaire Locations Luminaire Location information: Sequence Number, Label, X, Y Z, Orient, Tilt, Roll, Spin, Aiming 
Point and Status (On/Off). 

Summary By Label (includes Quantity). 

Expanded Luminaire Locations Expanded Luminaire Location information (arrangements and groups are broken into individual 
locations): Sequence Number, Label, X, Y Z, Orient, Tilt, Roll, Spin, Aiming Point and Status 
(On/Off). 

Summary By Label (includes Quantity). 

Room Summary Brief summary of rooms. Basic Summary plus: Surface Information 
(Label, Type Color, reflectance, 
transmittance of every surface, X, Y Z of 
first point of surface). 

Object Summary Brief summary of objects. Basic Summary plus: Surface Information 
(Label, Type Color, reflectance, 
transmittance of every surface, X, Y Z of 
first point of surface). 

Calculation Summary Brief summary of calculation points and 
numeric summary for each. 

Basic Summary plus: Vertices (for certain 
types) and summary of all calculation points 
(Point Number, X, Y, Z, meter Orient and 
Tilt and Value). 

This summary may require several pages of 
output. 

LPD / UWLR Area Summary Brief summary of LPD/UWLR Areas. Basic Summary plus Vertices. 

  

Select All, Clear All, All Basic, All Detailed Buttons 

The Select All, Clear All, All Basic, and All Detailed buttons act on the summary items globally to make multiple selections easier. To print all relevant 
summaries, click the Select All button. Likewise, clear all selections by selecting the Clear All button. To print basic summaries, use the All Basic 
button, or to print all detailed summaries, use the All Detailed button. 
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Related Topics 

Page Builder 

Printing 

Exporting Render Views 

Creating Movie Files - Viewpoints and Animations 

VRML Export 

The Print Text Process 

1. From the File menu select Print Text. 
2. To output to a file, instead of a printer, select the File option and specify a filename. You may also Browse for a folder location and specify a file 

name in this manner. 
3. If you wish to attach a banner to each page, click the selection box adjacent to Banner. The default banner is shown. To change the banner, 

click on the Banner button or double click on the banner image. 
4. You may include a title page on the printed output by clicking in the selection box adjacent to Title Page. Enter the information you wish to print 

on the title page. This information may be Left or Center justified by clicking on the appropriate button. You may save the title page to use in 
future job files by clicking the Save button after the appropriate information is entered. Then simply reuse the title page by clicking on the 
Retrieve button. This ability allows you to create a generic template for the title page without starting from scratch each time. 

5. Select the desired summaries by clicking in the appropriate selection boxes. For summaries that have a Basic and Detailed option, click the 
radio button adjacent to the appropriate summary type. You may select all summaries to print by clicking on the Select All button. You may 
further select whether all summaries should be Basic or Detailed, where applicable, if desired. 

6. To change the printer, click the Print Setup button. 
7. Click Ok. 

Note: All text summaries are formatted to 8.5 x 11 pages with portrait orientation. You may select other media if desired, but the formatting will not 
change. 
 
Within each AGi32 session, the Print Text dialog automatically apples the last settings chosen. 
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 Adding Entities 

Adding Projects 

Project Manager 

The Project Manager dialog box enables the user to add new projects to the job file and manage project entities. 

What do you want to do? 

Add a project to Project Manager 

1. From the Add menu choose Project, or from the Project toolbar click on the Project Manager button . 
2. Right click in the Project table to display the secondary menu. Select the New option. 
3. Enter a project name in the New Project text box. 

 
4. Click Ok. 
5. The Project can be renamed at any time by clicking in the Project Name column. 

 

 

 

 

 

 

Modify project entities in Project Manager 

1. From the Modify menu choose Project - Project Manager, or from the Project toolbar select . 
2. Load the projects you wish to modify (to load multiple projects, depress the Alt key while clicking in the Load selection box). 
3. Select the entity type you wish to modify - entities are displayed one type at a time (i.e. select either luminaires, objects, calculation points, 

rooms or drawing entities). 
4. Select the Entities you wish to change (to select multiples, highlight the rows including those entities) and make the corresponding changes. 
5. Click Ok. 

Note: Changes are applied instantly. You may visually see the changes by clicking the Apply button or cancel them by clicking the Cancel button. 

Related Topics 

Transferring Entities between projects 

Modifying projects (detailed) 

Project Manager - Concepts 

Project Manager enables you to work with multiple projects in the job file and manage project entities in a layer-like fashion. When AGi32 is opened, 
all entities created are associated with the default project, Project_1. A project contains all information created (e.g., drawing entities, objects, 
luminaires, statistical areas) while that project is current. As entities are added and deleted in the job file, they are also automatically added and 
deleted to the current project.  
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Create multiple projects when there are several tasks in the job file that you do not want to interact. For example, you could have several 
independent rooms in a building that do not affect each other. Create each room, and its associated luminaires, objects and statistical areas, as a 
separate project. Freeze or Switch Off the other projects (rooms) in the job file so you can apply lighting metrics just to the one project (room) you are 
interested in. 

Using Project Manager 

More technical details 

Making A Project Current 

In AGi32, entities (e.g., luminaires, drawing entities, calculation planes, etc.) are always added to the current project in the job file. When working with 
job files that contain multiple projects you can add entities to each project separately. You may change the current project at any time with the Project 
toolbar. 

 Select the desired project name in the Project pull-down menu from the Control Bar. 

 

To transfer entities from one project to another, use the Modify-Project-Transfer Entity command (to select entities graphically) or transfer them by 
Label with Project Manger. To transfer entities graphically, the Transfer Entity command is also found on the Control Bar, click on the pull-down 
arrow adjacent to the Project manager button to select the Transfer Entity option desired: 

 

  

 Adding Drawing Entities 

Adding Arcs - Procedure 

AGi32 allows the user to place arcs of any length and radius at any three dimensional location. Arcs are drawn by specifying three points: beginning, 
end and center. In addition, they can be specified in any view (plan, elevation or isometric). You can add arcs to the endpoint of a line, while in the 
Line command, by pressing F4. The first point of the arc will be the endpoint of the line. The second endpoint of the arc is located next. By default, 
the arc radius will be drawn in the counterclockwise direction. To change the arc's direction, press the F5 key before fitting the arc. 

1. From the Add menu choose Drawing -Arc, or from the Drawing/Schedules toolbar select . 
2. Locate the cursor at the beginning point of the arc and click the left mouse button. 
3. Locate the endpoint of the arc and click the left mouse button again. 
4. Drag the crosshairs until the arc has achieved the right shape and click the left mouse button (this is termed “fitting” the arc). To change the 

arc's direction, press F5 before you click. 
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Drawing Entity Concepts - Arc 

Arcs are drawing entities used to create a background or present information in the job file. As drawing entities, they do not participate in the lighting 
calculations. 

Technical Details 

Small straight line segments make up the arc, and their relationship is maintained during modification. That is to say, arcs can be copied, moved, 
rotated, etc. and the arc will remain intact. To modify an individual segment, explode the arc. 

The segment size, or arc resolution is based on the Initial Curve Increment value in the System Settings-Advanced dialog. Arcs are created using the 
current color and line type on the Properties toolbar. 

Adding an Axis - Procedure 

The Axis command allows you to insert orthogonal coordinate axes in Plan (X and Y axes) and Elevation (Z axis) views in Model Mode and Page 
Builder. The coordinate axes display the coordinate values chosen. In other words, the Axis command is not a ruler, but a coordinate information 
display. 

1. From the Add menu choose Drawing -Axis, or from the Drawing/Schedules toolbar select . 
2. Select the axis type (X, Y, or Z) by clicking on the appropriate radio button. 
3. Enter the distance (ft., or m) between label increments (hatch marks). 
4. By default, the label size is based on label increment. This value may be overridden, by entering a label size (ft., or m). 
5. Click Ok. 
6. Locate the first endpoint of the axis and click the left mouse button. 
7. Drag the cursor in the pertinent orthogonal direction, X, Y, or Z, until the second endpoint is reached and left click again. 

 

 

Axis label location relative to Axis specification direction 
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Drawing Entity Concepts - Axis 

The Axis command is used to create orthogonal axis in Plan or Elevation Views to indicate coordinate information. Coordinate axes are generally 
used to demarcate calculation planes or assist in locating luminaires and can be composed of any length line segment and contain any hatch 
increment. As drawing entities, they do not participate in the lighting calculations. 

Technical Details 

Small straight line segments and text make up the Axis, and their relationship is maintained during modification. That is to say, axes can be copied, 
moved, rotated, etc. and the axis text and lines will remain intact. To modify an individual segment or modify the text, explode the axis. 

Axes are created using the current color and line type on the Properties toolbar. 

Inserting a Block 

The Block command inserts a previously created block into the current AGi32 file in Model Mode or Page Builder. To edit text within a block, the 
block must be exploded first. 

1. From the Add menu choose Drawing -Block, or from the Drawing/Schedules toolkit select . 
2. In Block Manager, select the block to be inserted. 
3. If alternate scaling is desired, enter the known X or Y size. Both coordinates will change to maintain the original aspect ratio. 
4. Click Ok. 
5. Locate the cursor at the desired insertion point and click the left mouse button. 
6. Continue inserting multiple copies of the block, or right click to terminate the command. 

 To permanently delete a block in Block Manager, select the desired block and click the Delete button.  

Drawing Entity Concepts - Inserting Blocks 

Blocks are composed of drawing entities used to create a background or present information in the job file. Blocks can consist of any combination of 
drawing entities and text and may be used to store complex drawing entities such as title blocks, sports fields, arrows and symbols. As drawing 
entities, they do not participate in the lighting calculations. You may use the drawing tools provided with AGi32 to create your blocks, or import a CAD 
file instead.  

When a block is created, it is stored independently of the current job file in the AGI32_GeneralDB database. All of the original block attributes, such 
as line type, color, font and text size, and relative insertion point (specified during creation), are retained in this block and are applied each time the 
block is inserted into the drawing area. This capability allows you to create a block in one job file and reuse it in any other. 

The block may be scaled precisely, before insertion, if desired. This allows you to scale blocks created in feet down to inches for use in Page Builder. 
Once inserted, the block becomes a drawing entity of the current project. The block’s original aspect ratio is maintained; the block cannot be 
stretched or distorted. 

While in the Block command, the user can locate multiple instances of the block. Each Block is inserted at a user-defined location. 

Technical Details 

Line segments and text make up the block, and their relationship is maintained during modification. That is to say, blocks can be copied, moved, 
rotated, etc., and any included  text and lines will remain intact. To modify the drawing entities or modify the text, explode the block. 

If you change the original block after inserting a copy of it, the changes have no effect on the copy. If you want the inserted copy to reflect the 
changes you made to the original block reference, delete the copy and reinsert the block. 

Adding a Circle - Procedure 

1. From the Add menu choose Drawing -Circle, or from the Drawing/Schedules toolbar select . 
2. Locate the center point and click the left mouse button. 
3. Specify the radius by dragging the cursor away from the center point and clicking the left mouse 

button again, or enter the radius from the keyboard.  
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Drawing Entity Concepts - Circle 

Circles are drawing entities used to create a background or present information in the job file. As drawing entities, they do not participate in the 
lighting calculations. Circles may be created in Plan, Elevation or Isometric Views in Model Mode as well as in Page Builder. 

Circles are drawn by specifying the center point and the radius. The radius may be entered by specifying a radius value or selecting a point on the 
circle of the desired radius. 

Technical Details 

Small straight line segments make up the circle, and their relationship is maintained during modification. That is to say, circles can be copied, moved, 
rotated, etc. and the circle will remain intact. To modify an individual segment, explode the circle. 

The segment size, or circle resolution is based on the Initial Curve Increment value in the System Settings-Advanced dialog. Circles are created 
using the current color and line type on the Properties toolbar. 

Adding A Cube - Procedure 

The Cube command enables you to draw 3D cubes of any size. Cubes are defined as (orthogonal rectangles with a user-defined height. They are 
composed of simple drawing entities and do not contain any surfaces.  

1. From the Add menu choose Drawing -Cube, or from the Drawing/Schedules toolbar select  
2. Enter the cube height (ft. or m) in the text box. 
3. Click Ok. 
4. Locate one corner of the cube and click the left mouse button. 
5. Drag the cursor to the opposing corner and left click again. 

 

Drawing Entity Concepts - Cube 

3D Cubes of any size may be created in AGi32. Composed of lines, they do not contain any surface between the lines and have no effect on the 
lighting calculations. They do not reflect, transmit or obstruct light in any way, and thus will not appear in the rendered environment. They are used to 
enhance presentation only. 

Cubes are available for specification in Plan or Rotated Plan view in Model Mode and in Page Builder 

Technical Details 

Small straight line segments make up the cube, and their relationship is maintained during modification. That is to say, cubes can be copied, moved, 
rotated, etc. and the circle will remain intact. To modify an individual segment, explode the cube. 

Cubes are created using the current color and line type on the Properties toolbar. 

Adding a Dimension - Procedure 

The Dimension command insert a dimension of any orientation into Plan or Rotated Plan View in Model Mode or in Page Builder. 

1. From the Add menu, choose Drawing -Dimension, or from the Drawing/Schedules toolbar select . 
2. Enter the text size (in ft. or m) in the Text Size box. 
3. Enter the arrow size (in ft. or m) in the Arrow Size box 
4. Click Ok. 
5. Locate the first dimension endpoint and click the left mouse button. 
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6. Drag the cursor until the second endpoint is located and left click again. 

 

Plan View Example 

 

Drawing Entity Concepts - Dimension 

The Dimension command insert a dimension of any orientation into Plan or Rotated Plan View in Model Mode or in Page Builder. As Drawing 
entities, they do not participate in the lighting calculations. 

Technical Details 

Small straight line segments and text make up the dimension, and their relationship is maintained during modification. That is to say, dimensions can 
be copied, moved, rotated, etc. and the dimension text and lines will remain intact. To modify an individual segment or modify the text, explode the 
dimension. 

Dimensions are created using the current color and line type on the Properties toolbar. 

Adding a Line - Procedure 

The Line command draws a series of connected line segments and arcs for presentations. 

1. From the Add menu choose Drawing -Line, or from the Drawing/Schedules toolbar select . 
2. Locate the starting point (1) and click the left mouse button. 
3. Drag the cursor to the endpoint (2) and left click again. 
4. Continue specifying the endpoints of the next segments (3, 4, 5) 
5. To add an Arc, press the F4 key. Specify the endpoint (6) and center (7) of the arc. Once the Arc is completed, the next line segment will be 

attached to its endpoint (8). 
6. Right click or press ENTER to complete the line. 

 

Drawing Entity Concepts - Line 

A line is a series of connected straight or arc segments created as a single entity. Lines are drawing entities used to create a background or present 
information in the job file. As drawing entities, they do not participate in the lighting calculations.  
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Lines are usually edited all at once, although they can be exploded and modified individually. Arcs may be added to the line by pressing the F4 key. 
The Arc is automatically started at the endpoint of the previous segment. Arcs are completed by specifying the other endpoint and center of the arc. 
Once the arc is completed, another straight segment or arc may be added to the line. 

Technical Details 

Straight line segments make up the line and arc, and their relationship is maintained during modification. That is to say, lines can be copied, moved, 
rotated, etc. and the lines will remain intact. To modify an individual segment, explode the line. 

Lines are created using the current color and line type on the Properties toolbar. 

The arc segment size, or resolution is based on the Initial Curve Increment value in the System Settings-Advanced dialog.  

Adding a Rectangle - Procedure 

The Rectangle command inserts rectangles into the graphics area in Model mode and Page builder. 

1. From the Add menu choose Drawing -Rectangle, or from the Drawing/Schedules toolbar select . 
2. Locate the first corner of the rectangle (1) and click the left mouse button. 
3. Drag the cursor to the opposing corner (2) and left click again. 

 

Drawing Entity Concepts - Rectangle 

Rectangles are drawing entities used to create a background or present information in the graphics area or in Page Builder As drawing entities, they 
do not participate in the lighting calculations. Rectangles do not contain any surfaces. 

Rectangles are drawn by specifying the opposing corners of a four-sided polygon with orthogonal sides. They may be specified in any view (Plan, 
Elevation or Isometric ) in Model Mode or on the media in Page Builder. 

Technical Details 

Straight line segments make up the lines, and their relationship is maintained during modification. That is to say, rectangles can be copied, moved, 
rotated, etc. and the lines will remain intact. To modify an individual segment, explode the rectangle. 

Rectangles are created using the current color and line type on the Properties toolbar. 

Adding Schedules - Procedure 

Schedules are dynamic drawing entities that extract information from the job file and place it in a user-defined table. You may customize the default 
schedules to include as much or as little information as you would like. Schedules update at every redraw and will automatically expand or contract 
as the number of related entities increases or decreases. Schedules may be pasted directly into a view in Model Mode or onto a Page Builder page. 

Each cell has its own intrinsic length associated with the selected field. You may increase or decrease the cell size, as desired. 

1. From the Add menu choose Drawing - Schedule, or from the Drawing/Schedules Toolkit, select . 
2. To use a predefined schedule, choose one from the Schedule Name menu. Saved schedules will be added to this list. 
3. Otherwise, select a schedule type from the Schedule Type pull-down menu. 
4. If desired, you may change the current description. 
5. The schedule may pull data across all projects or one specific project. If desired, select which project (if more than one exists) this schedule will 

reference. The Project Name row is only included in the specified schedule if a specific Project is selected. If All Projects ( the default option) is 
selected, the Project Name row is not included in the schedule. 
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6. The Display Name File enables you to display the schedule's selected fields in a language other than English. Currently, Spanish, French and 

Portuguese are available. Click on the Manage button. In the next dialog, pick the language that you want from the Display Name File menu. 
More information on Display Name Files here. 

7. A default schedule layout is available for each Schedule Type. You may customize the schedule layout by choosing additional or alternate 
selected fields, reordering the schedule and/or changing the cell length and/or color. 

• To choose additional or alternate fields, click the selection boxes so that a checkmark appears next to the fields you wish to include. 

• To change the Field Length or Color, or to Rename a user-defined field, right click on the field you wish to change. 

• You may change a field's Display Name, Width and Text Color. If the field Width is shorter than the associated contents, the text inside 
the field will be truncated. The Field Name is not modifiable; if you wish to use a name that is different than the default, change the 
Display Name cell's contents. 

• There are several user-defined fields (e.g., <UserField1>) available in each schedule type (located at the bottom of the list of available 
fields). Simply place a checkmark in the box to select the field, enter a name in the Display Name field, and enter the appropriate 
information in the User Data field. More information on user-defined fields here. 

8. Style Options: 

• Grid Lines are Visible by default. Unchecking this selection box will make them Invisible. 

• To add a Shadow Effect around the lower right frame of the schedule, select this option. Shadows are only available in Page Builder. 

• To Increase the Row Spacing, enter a value greater than 1. Increasing the Row Spacing adds more white space around your text; it 
also allows symbol size to be increased in the Luminaire Schedule Type. 

• The Grid Line and Color and Width is also customizable. The defaults are Black and 1 Pixel Line Width. 
9. Schedule Orientation: 

• Left to Right: Orients Schedule and included text Left to Right; Insertion Point at Top Left 

• Rotated 90 Degrees Counterclockwise: Orients Schedule Up and Down - Text Flows from Bottom to Top; Insertion Point at Bottom Left 

• Rotated 90 Degrees Clockwise: Orients Schedule Up and Down - Text Flows from Top to Bottom;Insertion Point at Top Left 
10. Range of Entities to Include in Schedule: 

• All: Extracts all relevant information from associated job file/Project into one schedule. Total Count is displayed for your information. 

• Range: Specify a user-defined Range to split any Schedule into multiple parts (e.g., split a Luminaire Location Summary composed of 
100 luminaire locations into 2 pieces: Schedule 1: Range 1- 50; Schedule 2: Range 51-All ). The All parameter is used to automatically 
include any luminaires added to the job file after the schedule is placed. 

11. Font Options: 

• To make the Description and Project cell text bold, click in the selection box adjacent to Description / Project Bold. 
• To make the text in the field header cells bold, click in the selection box adjacent to Field Names Bold. 

• If desired, change the text font or text size . 
12. Schedules extract data from all associated entities in their category. You may filter which Calculation Points, LPD Areas and Stat Areas are 

referenced by using the Project Manager dialog. The Statistical Summary Specification button ( )is located at the top left corner of the 
Schedule Manager dialog. 

13. To Save this schedule so that it may be reused in any other job file,click the Save button ( ) located in the top-left corner of the Schedule 
Manager dialog. Specify the name  (we recommend the following format: Schedule Type-Description), then click the Save button. Click Ok. 
Depending on which mode you were in when the schedule was selected (Model or Page Builder), the saved schedule will be saved in the Model 
Mode Schedules or Page Builder Schedules dialog. 

14. Schedules may be used in other applications by copying them to the Clipboard. The Copy button ( ) is also located in the top-left section of 
the Schedule Manager dialog. 

15. Click Ok. 
16. Locate the schedule on the drawing and click the left mouse button. The cursor is located at the upper-left corner of the schedule. You can 

dynamically resize the schedule before clicking, by using the Ctrl+Shift + Up Arrow and Ctrl+Shift + Down Arrow keys on your keyboard. 

Save Schedule - Procedures 

The Save Schedule command allows you to save your customized schedule with a unique name of your choosing. Schedules are automatically 
saved with the appropriate units for Model Mode or Page Builder Mode, determined by the mode they were saved under. 

1. Click the Save button to access the Save Schedule dialog ( ). 
2. Specify the custom schedule name (we recommend the following format: Schedule Type-Description). Currently saved schedules are displayed 

in the Saved Schedule Files - Mode list. 
3. Click the Save button to add your custom schedule to the Saved Schedule Files list. 
4. Click Ok. 

Schedule Field Properties 

The Field Properties dialog in the Schedule command allows you to change each selected field's Display Name, Width and Text Color. If the field 
Width is shorter than the associated contents, the text inside the field will be truncated. The Field Name is only modifiable with user-defined fields, 
located at the bottom of the list of fields for each schedule. 

Field Name - The Name of the selected Field. This field links the schedule to the associated section of the AGi32 database, and cannot be modified: 
if you wish to use a name that is different than the default, change the Display Name cell's contents . 
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Display Name - The field's heading name that will be displayed in the schedule. By default, this is the same as the Field Name, but it can be 
changed by editing the Display Name field directly or by choosing a Display Name File that contains information on the desired changes. For 
example, you may choose to display the names of the selected fields in a language other than English. Currently, Spanish, French and Portuguese 
are available. This is done by clicking the down arrow next to the Display Name File field and selecting the language desired. You can also create 
your own Display Name File with assigned Display Names that are different from the Field Names. For more information on Display Name Files and 
how to create your own, click here. 

Field Width - The width, in number of characters, of the selected field. Fields default to the maximum character length that can be specified in the 
associated AGi32 dialogs. 

Field Color - The text color of the contents and the heading of the selected field. By default, this color is black. 

User Data - If a user-defined field (e.g., <UserField1>) is selected, you can enter the value to be displayed in the field by clicking in the <User Data> 
field and then clicking on the drop-down arrow to open the User Data dialog. Enter the Display Name, modify the Width and Color if desired, and 
enter the appropriate information in the User Data field. Then click OK to return to the Schedule Manager dialog. For more information, click here. 

Drawing Entity Concepts - Schedules 

Schedules allow you to provide information about your application in a clear and concise way. Schedules are dynamic entities that extract all 
pertinent information automatically from the current job file. Schedules update themselves automatically if the information in the job file changes. 
Each schedule type relates to a particular category (rooms, luminaires, calculations, etc.), and the items available for selection are limited to those 
appropriate for that category.  

By default, AGi32 is shipped with predefined schedules for each category. You may customize the schedules to show more or less  information, 
order and size the columns to your specifications, create and label user -defined columns, and even specify how much data is in each schedule. 
Custom schedules can be saved outside of the current job file so that you can reuse them in any other job file. 

Schedules can be added to the Model Mode display or to Page Builder. The primary difference between these schedules is schedule size, 
specifically text size. AGi32 allows you to save your schedules in either mode (Model Mode - text size in feet or meters; Page Builder Mode - text 
size in inches or mm) depending on the units of the job file. 

The Project Name row is only included in the specified schedule if a specific Project is selected. If All Projects ( the default option) is selected, the 
Project Name row is not included in the schedule. 

Schedule Name 

To select a predefined schedule instead of creating a New one, choose the schedule you are interested in from the Schedule Name menu. AGi32 
ships with 4 predefined (custom) Calculation Summary schedules for your use -- Calculation Summary - Daylight Factor, Calculation Summary - 
Glare Rating, Calculation Summary - Roadway, and Calculation Summary - Unified Glare Rating (UGR). 

Any schedules you save will also be added to this list. You may also modify any of the existing schedules and save them as your own (with a unique 
name). 

Schedule Types 

Select from the available schedule types by scrolling through the Schedule Type menu. The default schedules, except for the Luminaire Location 
Summaries, are all unique and extract information about a particular entity type (rooms, luminaires, calculation points, etc.). The tables below 
illustrates the defaults and available fields within each Schedule type. 

Note: The defaults shown are pre-selected for your convenience. You may select and deselect these options to create custom schedules of your 
own. 

Schedule Type Description Available Fields 

Luminaire 
Schedule 

Summarizes specified luminaire types.  

  

Note: The Symbol-Iso selection provides 
an Isometric Symbol view; the Symbol 
selection provides a Plan view of the 
Symbol. 

To increase the symbol size without 
increasing the text size, increase the 
Row Spacing. This will increase the 
height of each row while maintaining the 
same text size. 

Defaults: Symbol, Qty, Label, Arrangement,Total Lamp Lumens, LLF, 
Description. 

Also Available: Filename, Arm, Offset, any specified LLFs, 
Luminaire Watts, Arrangement Watts, Total Watts, Symbol-Iso, 
No. Lamps, Lumens/Lamp, Lum. Lumens, Lum. Efficacy, Arr. 
Lamp Lumens, IES photometric file Keywords -- [MANUFAC], 
[LUMCAT], [LAMPCAT], [LAMP], [BALLAST], [TEST], 
[TESTLAB], [ISSUEDATE],-- IES Classification, Longitudinal 
Classification, Cutoff Classification, UWLR, CIE Type, NEMA 
Type, BUG Rating, LCS (Lumens, % Lamp, % Luminaire for each 
zone), LER, Housing Color, Luminous Color, and several user-
defined fields. 

Housing and Luminous Color are displayed as a color swatch, not 
RGB values. 

Luminaire 
Location 

Summarizes specified luminaire 
locations. 

Defaults: Sequence No., Label, X, Y, Z, Orient, Tilt. 

Also Available: Status, Roll, Spin, X Aiming Point, Y Aiming 
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Summary Point, Z Aiming Point, Total Quantity, and several user-defined 
fields. 

Expanded 
Luminaire 
Location 
Summary 

Summarizes specified luminaire locations 
in expanded format. Arrangements and 
Groups are dissected into their individual 
locations. 

Defaults: Luminaire No., Label, X, Y, Z, Orient, Tilt, X Aiming 
Point, Y Aiming Point, Z Aiming Point, Tilt Correction Factor 
(TCF), Dimming (%). 

Also Available: Status, Roll, Spin, Group Label, Total Quantity, 
and several user-defined fields. 

Calculation 
Summary 

Summarizes calculation point metrics 
and along with Statistical Areas 
summaries along with their 
corresponding numerical analysis criteria. 

Defaults: Label, CalcType, Units, Avg, Max, Min, Avg/Min, 
Max/Min 

Also Available: Max/Avg, # Points, Description, CV, UG, Point 
Spacing Left-Right (PtSpcLr), Point Spacing Top-Bottom 
(PtSpcTb), Grid Orient, Grid Tilt, Meter Type, Meter Orient, Meter 
Tilt, Meter X, Meter Y, Meter Z, Grid Reflect, Roadway Standard, 
Observer Label, View Angle, Threshold Increment (TI), Veiling 
Luminance Ratio (LVRatio), Small Target Visibility (STV), 
Longitudinal Ratio, Surround Ratio (STV), R Table, Actual Q0 
Value (ActQValue), Daylight Factor % Over (DF % Over), 
Daylight Factor Basis (DF Basis), Range, % Points in Range, % 
Points in Area, and several user-defined fields. 

LPD Area 
Summary 

Summarizes LPD Areas and their 
corresponding numerical analysis criteria. 

Defaults: Label, Area, Total Watts, LPD. 

Also Available: LPD Units, UWLR, Perimeter, Summarize 
Project, Description, and several user-defined fields. 

UWLR Area 
Summary 

Summarizes UWLR Areas and their 
corresponding numerical analysis criteria. 

Defaults: Label, Area, UWLR 

Also Available: Total Watts, LPD, LPD Units, Perimeter, 
Summarize Project, Description, and several user-defined fields. 

Object Summary Summarizes specified Objects in brief. 
Detailed surface information is available 
from the Print-Text command. 

Defaults: Label, Type, Description. 

Also Available: Several user-defined fields. 

Room Summary Summarizes specified Rooms in brief. 
Detailed surface information is available 
from the Print-Text command. 

Defaults: Label, Type, Wall Height, Description. 

Also Available: Several user-defined fields. 

Daylight Summary Summarizes the current Daylighting 
settings. 

Defaults: Site Name, Latitude, Longitude, Compass, Date, Time, 
Sky Conditions. 

Also Available: Electric Lighting, Zenith Factor, and several 
user-defined fields. 

Saving Schedules 

Customized schedules can be saved for reuse with any job file. They can also be shared with other users. We suggest using a consistent naming 
convention for your schedules. We recommend the Schedule Type - Description format. 

Examples: 

• Luminaire Schedule - With Cutoff Classification 

• Luminaire Schedule - No Symbol 

• Calculation Summary - IES Roadway 

• Calculation Summary - CIE Roadway 

Existing schedules in current job files may also be saved without having to recreate them. Simply open the job file containing the customized 
schedule you'd like to reuse.  Click the Edit Schedule button in the Drawings/Schedules Toolkit to invoke the Schedule Manager dialog. Then click 
the Save button and specify the schedule name. 

Schedules are saved as Model Mode Schedules or Page Builder Mode Schedules, depending on which mode they were saved under. The Saved 
Schedule files are stored in AGi32\Schedules\Model Mode Schedules or AGi32\Schedules\Page Builder Schedules. To share these files, copy the 
desired files from the Schedules folder to the same folder on the target computer. You may use Windows Explorer™ and/or My Computer using 
standard Windows commands. 

Once saved, the files appear in the Schedule Name menu within the Schedule Manager dialog. 

Schedules can be removed from the Schedule Name menu by deleting them. The Schedule Files button in the Schedule Manager dialog allows you 
to remove schedules within AGi32, or you may delete them from the folder outside of AGi32 with the Windows commands. 
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Adding User-Defined Data to Schedules 

When selecting the fields to include in a Schedule in AGi32, you have the option of including one or more fields with user-defined data; in other 
words, you may include fields other than those that have been predefined for selection. 

The user-defined fields are found at the bottom of the predefined fields in each schedule type. Let's say you want the LPD Area Summary schedule 
to include the number of luminaires in the project. This isn't one of the predefined fields for this schedule (though it can be found in other schedules). 
You can include the number of luminaires in the project in a user-defined field in this schedule. 

1. In the selected Schedule type, go to the bottom of the predefined fields and put a checkmark in the box for the first user-defined field, called 
<UserField1>.  

2. In the right-most (User Data) column, click where it says <Click to Specify>, and then click on the down arrow to open the User Data dialog box. 
3. Click in the Display Name field and type the name that we wish to use for this field. This is the name that will be displayed in the Schedule in the 

header for this field. In our example, we would type in Number of Luminaires. 
4. If desired, you may change the Width of the field and/or its Color in this dialog. We should change the Width to 21 to accommodate the length of 

our Display Name. 
5. Next, enter the value to be displayed. If we had ten luminaires in our LPD Area, we would enter 10. If we had more than one LPD Area, using 

our example, they would be listed in alphabetical order in the schedule. We would enter the value for the next one in the next field, below the 
"10."  

6. Once you have entered the appropriate values, click OK to return to the Schedule Manager dialog. 
7. Your user-defined field now shows that it has been Specified (right-most column). This field will be displayed last in the schedule, after the other 

selected fields. You can move it or any other field up or down in the list by pressing the Alt key while clicking the up or down arrows on your 
keyboard. 

Schedule Manager - Display Name File 

The Display Name is the field's heading name that will be displayed in the schedule. By default, this is the same as the Field Name, but it can be 
changed by editing the Display Name field directly or by choosing a Display Name File that contains information on the desired changes.  

For example, you may choose to display the names of the selected fields in a language other than English. Currently, Spanish, French and 
Portuguese are available. This is done by clicking the down arrow next to the Display Name File field and selecting the language desired. 

You can also create your own Display Name File with Display Names that are different from the Field Names.  

1. Begin by clicking on the Manage button next to the Display Name File field.  
2.  The Display Name File dialog will open. From the Schedule Type drop-down menu, select the Schedule that you would like to create a 

Display Name File for. 

3. Click on the Create... button. 
4. In the dialog box that opens, type in a name for the file. For example, if you are required to use certain field headings in all of your 

company's schedules, you could call your Display Name File "XYZ Engineering." Click OK to accept the name that you have entered 
and return to the Display Name File dialog. 

5. You can now change the names in the Display Name column. Click once in a field to give it focus. Click again in that field to highlight 
the contents. You can either type additional characters, or you can hold your left mouse button down, drag across the characters, and 
then type to replace them. 

6. Click OK to exit this dialog and return to the Schedule Manager dialog.  
7. Click on the down arrow next to the Display Name File field; your custom Display Name File has been added to the list, in alphabetical 

order with the French, Portuguese and Spanish choices. Note: The custom Display Name File applies only to the schedule type that it 
was created for. Other schedule types would need their own Display Name Files, if applicable. 

To edit a Display Name File that you have created: 

1. Select the schedule type whose Display File Name you wish to edit. 
2. Click the Manage button. 
3. Make your changes, and then click OK. 

Inserting Text 

Adding text to your job file conveys important information and clarifies your presentation output. You may insert text that you enter yourself or extract 
information about the job file. You may also insert a text file that contains general information that may be included in every presentation. Text may 
be located in any view (plan, elevation, isometric) and, for the most part, can be modified just like any other drawing entity. 

AGi32's Text command provides several options including Smart Strings, Replacement Strings, text notes and ASCII text files. You may modify the 
current text style and text size, if desired. 

What do you want to do? 

Add a Smart String 
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Smart Strings are keywords that extract information from an AGi32 job file like date, time, filename, units and total time. Smart Strings are dynamic 
drawing entities that update at each redraw. AGi32 allows the user the option of inserting Smart Strings with or without descriptors. 

1. From the Add menu choose Drawing -Text, or from the Drawing/Schedules toolbar select . 
2. Click on the Smart String radio button. 
3. Select the Smart String you would like to insert. 
4. If desired, change the text font or text size. 
5. Click Ok. 
6. Locate the text on the drawing and click the left mouse button. 

Add a Replacement String 

Replacement Strings are static text entities that extract current information from the job file. The text is not updated when the status or setting 
changes. This is useful when identifying projects. AGi32 allows the user the option of inserting Replacement Strings with or without descriptors. 

1. From the Add menu, choose Drawing -Text, or from the Drawing toolbar select . 
2. Click on the Replacement String radio button. 
3. Select the Replacement String you would like to insert. 
4. If desired, change the text font or text size. 
5. Click Ok. 
6. Locate the text on the drawing and click the left mouse button. 

Add a text note 

This option allows you to enter lines of text at any location. Text Notes with multiple lines maintain their relationship during modifications. To modify 
an individual line, simply explode the text note. 

1. From the Add menu choose Drawing -Text, or from the Drawing toolbar select . 
2. Click on the Note radio button. 
3. Enter the desired information in the text box. 
4. If desired, change the text font or text size. 
5. Click Ok. 
6. Locate the text on the drawing and click the left mouse button. Large pieces of text will appear as a rectangle to facilitate insertion. Locate the 

text rectangle by positioning the cursor located at the upper left corner of the rectangle. 

Add a text file 

You may merge any text file in ASCII format into the current AGi32 job file. This information may be created in an external source, like a word 
processor, as long as it is saved in ASCII format (text only). Documents saved in native formats (such as *.doc) can not be used. 

1. From the Add menu choose Drawing -Text, or from the Drawing toolbar select . 
2. Click on the Text File radio button. 
3. Enter the path and filename or select the Browse button to locate the file name. 
4. If desired, change the text font or text size. 
5. Click Ok. 
6. Locate the text on the drawing and click the left mouse button. Large pieces of text will appear as a rectangle to facilitate insertion. Locate the 

text rectangle by positioning the cursor located at the upper left corner of the rectangle. 

Change the font style 

By default, AGi32 uses the Default System font as specified in the System Settings dialog. To change the font style, click on the Change button. A 
font dialog will appear allowing you to change the font , font style and  color. Once the font has been changed from the Default System font, AGi32 
will use the most recent font and font style. 

Change the text size 

The height of the character block for each letter is given in scaled feet or meters depending on the units setting of AGi32. The Text Size will default to 
either 1 (ft or m) or the last size used. When printing or plotting, text is scaled according to the output scale. For example: Text Size of 5 plotted at a 
scale of 1”=30' will be 1/6” tall (5/30).  
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The text size, in current units (ft. or m) determines the size of the character block 
containing the font glyph and top and bottom leading spaces. Depending on the 
selected font, the glyph size within the character block will vary but the character 
block size will remain the same. This is why different fonts with the same point size 
have different appearances. 

Text size is specified using the current display units and rounded according to the precision setting in the System Settings dialog. However, in the 
graphics display area, the text size is rounded to the nearest pixel. Consequently, at various levels of Zoom, the text may appear to 'stretch' or 
'shrink' relative to other drawing entities. Example: Text cannot be displayed 10.5 pixels high. The text size is rounded to the nearest pixel for display 
purposes. It must be displayed at 10 pixel (text shrinks) or 11 pixels (text stretches). 

Generally, you will want to have an idea of the desired size of the text before entering a value in the cell for Text Size. Calculation values provide a 
good starting point for determining appropriate text sizes for Statistical Areas, Schedules, and LPD/UWLR Areas.  

Related Topics 

Editing Text 

Drawing Entity Concepts - Text 

The Text command allows you to add text to the current AGi32 file in order to explain and enhance your output. You may place text in any location 
and size it in accordance with the drawing's output scale. 

Text is used to create Title Blocks and label parts of the job file. Text may be located in any view (Plan, Elevation or Isometric) in Model mode or in 
Page Builder. For the most part, it can be modified like any other drawing entity. AGi32's Text command provides several factory supplied options 
including Smart Strings and Replacement Strings. In addition, you may add Text Notes and ASCII text files (txt files). 

Text Options 

Smart Strings 

Smart Strings are dynamic text entities that insert descriptive information about the filename, units date and/or time. They are updated at each 
redraw and each time the file is opened. 

Smart String Comments 

[Date] Inserts the current date in accordance with the short date settings in your Windows Regional Settings 
dialog. 

Date: [Date] Inserts the descriptor Date: in front of the current date. 

[Time] Inserts the current time in accordance with the clock settings in your Windows Regional Settings dialog. 

Time: [Time] Inserts the descriptor Time: in front of the current time. 

[Filename] Inserts the current AGi32 job file name (not including path). 

Filename: [Filename] Inserts the descriptor Filename: in front of the current job file name. 

[CompleteFilename] Inserts the current AGi32 job file name including the drive and path 

Filename: [CompleteFilename] Inserts the descriptor Filename: in front of the current job file name. 



AGi32 Help System  Adding Entities 

88 

 

[DisplayUnits] Inserts the current Display Units (feet or meters). 

Coordinates In: [DisplayUnits] Inserts the descriptor Coordinates In: in front of the current Display Units. 

{ProductName} Version {VerNo} 
Rev {RevNo} 

Inserts the current AGi32 version and revision number information 

{ProductName} - {Copyright} Inserts the current AGi32 release name and copyright information 

{ProductName} Version {VerNo} 
Rev {RevNo} - {Copyright} 

Inserts the current AGi32 version, revision number information and copyright information 

Additional Page Builder Smart Strings 

Smart String Comments 

{Page Number} Inserts the current page number into report pages. On Master page, Page Number is displayed as "M". 

Page Number: {Page Number} Inserts the descriptor Page Number in front of the current page number into report pages. On Master 
page, Page Number is displayed as "M". 

Page {X} of {Y} Inserts the current page number as a function of total page numbers into report pages (e.g. 1 of 3, 2 of 3, 
3 of 3). On Master page, Page Number is displayed as "M" of Total. 

{Page Name} Inserts the current page name into report pages. On Master page, Page Name is displayed as "Master". 

Page Name: {Page Name} Inserts the descriptor Page Name: in front of the current page name into report pages. On Master page, 
Page Name is displayed as "Master". 

Replacement Strings 

Replacement Strings are static drawing entities that extract user information and/or project information. Replacement Strings do not update 
themselves if the information changes, which may or may not be desireable. 

Replacement 
String 

Example Comments 

[ProjectName] Project_1 Inserts the current Project name. 

Project Name: 
[ProjectName] 

Project Name: Project_1 Inserts the descriptor Project Name: in front of the current project. 

[UserBlock] Mr. Phil A Mint 

Generic Lighting, Inc. 

1234 Main St. 

Happyville, CO 80000 

303/555-0000 

303/555-0001 

phil@genericltg.com 

Combination of:  

[UserName] 

[UserCompanyName] 

[UserAddress] 

[UserVoiceNumber] 

[UserFaxNumber] 

[UserEmailAddress] 

All user information is entered during the AGi32 Installation procedure. 

[UserName] Mr. Phil A Mint 
  

[UserCompanyNa
me] 

Generic Lighting, Inc. 
  

[UserAddress] 1234 Main St. 

Happyville, CO 80000 
  

[UserVoiceNumber
] 

303/555-0000 
  

Voice Number: 
[UserVoiceNumber
] 

Voice Number: 303/555-0000 Inserts the descriptor Voice Number in front of the voice number. 
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[UserFaxNumber] 303/555-0001   

Fax Number: 
[UserFaxNumber] 

Fax Number: 303/555-0001 Inserts the descriptor Fax Number in front of the fax number. 

[UserEmailAddress
] 

phil@genericltg.com   

Email Address: 
[UserEmailAddress
] 

Email Address: 
phil@genericltg.com 

Inserts the descriptor Email Address in front of the email address. 

[LAIUserNumber] LAI9999   

Text Note 

This option allows you to enter lines of text at any location. Text notes with multiple lines maintain their relationship during modification. To modify an 
individual line, explode the text note. 

The number of characters per line is limited to 256 characters. You may terminate a line before this limit by using the keyboard Enter key. The 
current text font and text size is applied to all text in the Text Note. To apply different style settings, separate the information into separate notes. 

Text File 

You may merge any text file in ASCII format into the AGi32 graphics area or Page Builder page. This information can be created in any external 
source, like Notepad, Wordpad, or Word, as long as it is saved as a text only file (.txt). Documents saved in native formats (such as .doc) cannot be 
imported into AGi32. 

  

 Adding Rooms 

Adding Rooms 

AGi32 provides for three different types of rooms: rectangular, round/elliptical and polygon, each with its own various ceiling configurations for your 
use. Rooms are intended for interior applications and do not provide any reflective or obstructive characteristics on the outside of the room. They 
may be edited to change their reflectances, ceiling and wall heights, and copied or moved as necessary. 

Rectangular Rooms 

Rectangular rooms have a rectangular footprint with factory supplied or user defined ceiling configurations. Some of the more common yet complex 
ceiling types can be created automatically for you including pyramid, barrel vault, dome, gable and hip roofs. In these cases, you will be prompted to 
specify some basic inputs, such as wall and ceiling heights, and the reflectances of the room interior. Then, simply specify the footprint of the room in 
the graphics window and Voila! the roof will be automatically added. In addition, you may also create a vertically extruded section of the room that will 
be applied linearly throughout the user-defined space. 

What kind of room would you like to create? 

Create a rectangular room with a flat ceiling 

Create a rectangular room with a barrel vault ceiling 

Create a rectangular room with a gable ceiling 

Create a rectangular room with a hip ceiling 

Create a rectangular room with a pyramid ceiling 

Create a rectangular room with a vertical extrusion ceiling 

Round/Elliptical Rooms 

AGi32 provides three types of round rooms; dome, flat and vertical rotation. Flat and domed rooms are created by locating the center of the room 
and then specifying its radius. The room will automatically be created according to the wall height and dome height specification in the dialogs. 
Vertical Rotation rooms allow for customization of the room profile and allow you to create a partial circular segment, such as an amphitheater, if 
desired. 

What kind of room would you like to create? 
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Create a round room with a flat ceiling 

Create a round room with a dome ceiling 

Create a round room with a vertical rotation ceiling 

Polygon Rooms 

Polygon rooms are characterized by their non rectangular footprint and may have curved or angular surfaces, if desired. Polygon rooms with flat 
ceilings are provided for your use. Polygon rooms receive a flat ceiling atop the room walls after the room outline is drawn in the graphics window. 

 

 

Create a Polygon Room with a Flat Ceiling 

   

Adding Rooms - Concepts 

 

Room shapes in AGi32 range from very simple geometry - rectangular rooms with flat ceilings - to complex spaces with unusual ceiling 
configurations, including domes, vaults, pyramids and custom ceilings. Rooms are intended to be used for interior lighting applications and may be 
located with base elevation at any level. By default, rooms are created with one sided surfaces that obstruct light from leaving the room. Luminaires 
placed outside a room that are not within another room or blocked by an object may illuminate the interior of the room. Rooms are one-sided so that 
they may be viewed in Render mode without the need to walk inside. Room surfaces may also be assigned a transmittance using the Surface Edit 
command once the room is created. 

Calculation points inside the room may be affected by luminaires located outside of the room, that are not located in other rooms or blocked by 
objects. Applying calculation points with Automatic Placement will place all related grids by default, on the inside of the room shape (the Normal side 
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of this surface type).You may place points on the outside of the Room by placing points on the Abnormal side using Automatic Placement, or by 
flipping the surface normal inside using the Surface Edit command. 

Rooms with ceilings of different heights can actually be handled by using multiple rooms 
and removing the shared surfaces, as shown at right. In fact, combinations of all types of 
room shapes make modeling interior lighting projects more realistic than ever. 

 

Dialog Defaults 

The individual parameters available in all Room dialogs are automatically saved and restored in the Room dialogs. There are two types of defaults 
present in all of the dialogs: Global and Local. Global defaults occur in every Room dialog. Local defaults only occur in specific dialogs. The following 
defaults are global for all Room commands. 

• Label: Default Label is Room. The Label name will automatically increment to produce unique labels. For example, if the first Room is labeled 
Room, the second is labeled Room_1. When the default label is changed, it will also automatically increment. 

• Wireframe color 

• Labeling options 

• Wall Height 
• Ceiling, Wall and Floor  surfaces: Color, Reflectance and Texture (including applied options). 

Reset Defaults - Selecting this button will reset all Global dialog parameters to the factory defined specifications. 

Technical Details 

Room Dimensions 

All room types have certain dimensional variables associated that describe some parameter of the shape that must be defined prior to creating it in 
the graphics area. 

 

 

• Wall Height - The Wall Height refers to the vertical distance from the base of the room 
to the top of the walls or ceiling. 

 

• Vault Height - The Vault height is the height of the vault as measured from the top of the walls to the apex or peak of the vault. 

• Vault Width - The width of the vault can be any dimension less than or equal to the width of the room. If the vault width is less than the room 
width, the vault will be centered in the room. If the vault width is entered as greater than or equal to the room width, the vault will span the entire 
width of the room. 
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• Gable Height - The Gable Height refers to the vertical distance from the top of the 
room walls to the top of the gable ceiling. 

 

• Hip Height - The Hip Height refers to the vertical distance from the top of the room walls to the top of the Hip ceiling. 

• Hip Length - The Hip Length refers to the horizontal distance from the room baseline to the intersection of the hip and ceiling peak as seen in 
Plan view. 

 

 

• Pyramid Height - Pyramid height refers to the vertical distance from the top of the 
walls to the apex of the Pyramid. The total height of the Pyramid room is then the 
height of the walls plus the height of the Pyramid. 

 

• Dome Height - Dome height refers to the vertical distance from the top of the walls 
to the crown of the Dome. The total height of the dome room is then the height of 
the walls plus the height of the dome. 
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Aspect ratio - The Aspect Ratio is used to define the shape of the round room 
footprint. An Aspect Ratio equal to one will create a perfectly round room 
footprint. Aspect Ratios greater than one lengthen the X-axis of the base 
resulting in an elliptical shape left to right. Aspect ratios less than one elongate 
the Y-axis of the base to form an ellipse aligned top to bottom. 

As an example, an Aspect Ratio equal to two will create an ellipsoidal room that 
is twice as long in the X-dimension as it is in the Y-dimension. 

An Aspect Ratio equal to one half (.5) will create an ellipsoidal room that is twice 
as long in the Y-dimension as it is in the X-dimension. 

Surfaces 

Surface properties of Color and Reflectance must be defined for all rooms. When initially defining rooms, reflectance and color are expressed for the 
Ceiling, Walls and Floor. It is possible to edit the wall reflectances on an individual basis by editing the room. 

Color and Reflectance are related to one another in a way that allows only certain colors to be assigned to a specific reflectance value. This is a 
mathematical relationship that is discussed in more depth elsewhere in this manual. To alter the color or reflectance of a room surface, click the 
mouse in either the color or reflectance cell. 

By default, the colors shown are shades of gray based on the reflectance entered in 
the adjacent cell. You can select any reflectance within the gray scale range (Black to 
white)  by entering it in the reflectance cell provided. 

 To select a color, move the Hue slider to the desired color, then move the Saturation 
and Luminance sliders to achieve the desired color. The reflectance will be calculated 
and displayed. You can adjust the reflectance within the Hue by moving the 
reflectance slider. 

  

  

 

 

Textures 

Textures are graphic images that may be applied to the room surfaces to make them appear more realistic. Textures like brick, stone, concrete and 
wood can be tiled in a repeating pattern across the surfaces or stretch across them. The average reflectance and color of the texture is calculated 
and used instead of the surfaces original color in the radiosity calculations. 

AGi32 comes with a selection of assorted textures that may be applied to any surface. You may also obtain textures from lots of other sources, 
including free texture sites online, commercial texture collections, even use your digital camera to obtain them directly. Click here to read about 
texture tips. 

To apply a texture to a surface, click in the Texture cell. Select the texture from the Texture database, then determine the application options. 

Open Ended Rooms 

Certain rectangular room types, Rectangular-Barrel Vault and Rectangular-Vertical Extrusion, may be created with their extruded ends left open. This 
option allows you to use these rooms in an open fashion (i.e., model tunnels) or connect the rooms to other spaces. 

Open Ends Option 

When the Open option is selected, the extruded walls and ceiling end panels are removed. Open rooms may be closed at a later time by editing the 
room and unchecking the Open selection box. 

Inserting curved surfaces into rooms (Polygon-Flat, Rectangular-Vertical Extrusion and Round-Vertical 
Rotation) 
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It is a simple procedure to describe a curved surface using an integrated Arc function. An 
arc can be fit between any two points and can be of most any radius. To insert an arc into 
a room, press the F4 key on your keyboard at the starting point of the arc. The command 
prompt (lower left corner of screen) will then prompt for the second point of the arc as 
shown at right. Click the mouse at the second point of the arc and a dotted line will appear 
showing the current arc shape. If you don't move the mouse the initial arc will be a perfect 
semi-circle (#1). Move the mouse cursor toward the arc apex to raise the arc center point 
and increase the circumference (#2).Or, move the cursor away from the apex of the arc 
and move the arc center downward. This effectively flattens the arc (#3). 

Reversing the Arc 

The direction of the arc can be reversed by simply pressing the F5 key on your keyboard. 

Curved surface resolution 

Curved surfaces are automatically divided into a series of straight segments based on the 
setting of the system variable Initial Curve Increment (degrees). The default is 15 degrees. 
This is adequate for most applications. This variable can be found under System Settings 
command from the Tools menu. Click on the Defaults tab and then on the Advanced 
button. 

  

  

   

   

   

Removing Surfaces 

AGi32 provides the ability to eliminate surfaces from any room shape you might create by removing the surfaces. Removed surfaces are not 
considered in the calculations any longer. A removed surface behaves differently than one whose reflectance is set to zero. Surfaces that have zero 
reflectance absorb all light that touches them and reflect no light outwards. Removed surfaces allow light to transmit directly through them because 
they no longer exist (unless another surface exists in the same location). Once surfaces are removed, you can recreate them by adding in a surface 
with reflectance (either 1 sided or 2 sided). 

By removing selected surfaces in the room, you have the ability to append other shapes to the room. These shapes (rooms, objects) may in turn 
have their surfaces removed. Continuing in this fashion, you can create very elaborate models consisting of numerous rooms and/or objects joined 
together. For example, you may want to create an Polygon-Flat room and remove the flat ceiling that was initially created. Once the ceiling is 
removed, you can use any combination of rooms and objects to create a custom ceiling. 

To remove a surface, either Edit the room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the room. 
In the Surface Edit dialog, navigate to the surface you wish to remove. To remove more than one surface in a room, Tag all of the surfaces you need 
to operate on. Change the Surface property titled Removed to YES. 

The surfaces will be removed from the environment. In Model Mode, they will appear as dashed lines, in Render mode, they will simply not appear. 
Removed surfaces can be replaced at any time through the Surface Edit dialog by changing the surface Removed property to NO. 

 Room Types 

Rectangular Rooms with a Barrel Vault Ceiling 

 

Rectangular barrel vault rooms have a barrel vault ceiling extending from the center of the user 
defined baseline along the entire depth of the room. The barrel vault is created using the specified 
vault width along the baseline and vault height. If the vault width is wider than the specified baseline 
width, it will be truncated so that the vault fills the entire ceiling width. If the vault width is less than the 
baseline width, horizontal ceiling panels will be located on either side of the vault to fill in the ceiling. 
As with rectangular flat rooms, these rooms are located using three user defined inputs - two defining 
the room's baseline and the third indicating the room's depth. Barrel vault rooms are created in Plan 
view and may be located at any angle. 
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1. From the Add menu select Room-Rectangular-Barrel Vault, or from the Rooms/Objects toolbar click the arrow adjacent to the Room-

Rectangular button . The secondary menu will appear. Select Barrel Vault. 
2. Specify a unique label for the room up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's render mode, it is only used to 

represent the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. Enter the height of the room walls in the Wall Height text box. 
7. Enter the barrel vault height above and beyond the room wall height in the Vault Height text box. 
8. Enter the barrel vault width in the Vault Width text box. 
9. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 

reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 

10. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 

• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 

11. To open the ends of the barrel vaulted room, such as a tunnel application, click in the Ends of Room and Barrel Vault Are Open selection box so 
that a check mark appears. Rectangular barrel vault rooms with open ends only have two walls, perpendicular to the open ends. 

12. Click Ok to return to the graphics window and locate the first point of the room. Click the left mouse button. Before clicking the first point, you will 
have the opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. 

13. Drag the cursor to the second point on a room edge and left click again. These two points define the room's baseline. 
14. Drag the cursor to open up the room perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

room may be created on either side of the baseline. The barrel vault will also be created perpendicular to the specified baseline. 

Rectangular Rooms with a Flat Ceiling 

 

Rectangular flat rooms provide the simplest interior spaces in AGi32. These rooms are located using 
three user defined inputs - two defining the room's baseline and the third indicating the room's depth. 
Flat rectangular rooms may be located at any angle in Plan view and can have a ceiling grid located 
within them. 

1. From the Add menu select Room-Rectangular-Flat, or from the Rooms/Objects toolbar select . 
2. Specify a unique label for the room up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
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4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 
represent the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. If a ceiling grid is desired, select it (e.g., 2x2 or 2x4) and its corresponding direction. You may center the grid by clicking in the Center Grid box 
so that a check mark appears. The grid will be drawn using the specified color. To change the default color (black) click in the color cell. The 
Color dialog will appear for your use. 

7. Enter the height of the room walls in the Wall Height text box. 
8. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 

reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 

9. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 

• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 

10. Click Ok to return to the graphics window and locate the first point of the room. Before clicking the first point, you will have the opportunity to 
change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate value. Click the left mouse 
button. 

11. Drag the cursor to the second point on a room edge and left click again. These two points define the room's baseline. 
12. Drag the cursor to open up the room perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

room may be created on either side of the baseline. 

Rectangular Rooms with a Gable Ceiling 

 

These rooms have a gable ceiling extending from the center of the user defined baseline along the 
entire depth of the room. The gable height is specified in the Room-Gable dialog and rises above the 
specified wall height. Gable roofed rooms are located using three user defined inputs - two defining 
the room's baseline and the third indicating the room's depth. They are created in Plan view and may 
be located at any angle. 

1. From the Add menu select Room-Rectangular-Gable, or from the Rooms/Objects toolbar click the arrow adjacent to the Room-Rectangular 

button . The secondary menu will appear. Select Gable. 
2. Specify a unique label for the room up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. Enter the height of the room walls in the Wall Height text box. 
7. Enter the gable height, the vertical distance from the top of the room walls to the highest point of the peak ceiling, in the Vault Height text box. 
8. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 

reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 
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9. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 

• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 

10. Click Ok to return to the graphics window and locate the first point of the room. Click the left mouse button. Before clicking the first point, you will 
have the opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. 

11. Drag the cursor to the second point on a room edge and left click again. These two points define the room's baseline. 
12. Drag the cursor to open up the room perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

room may be created on either side of the baseline. The gable roof line will be created along the entire depth of the room in a direction 
perpendicular to the specified baseline 

Rectangular Rooms with a Hip Ceiling 

 

Hip ceilings are characterized by their four sided inclining slanting planes. Two of the larger planes 
intersect at the center of the room forming its highest point, the ridge. The other two smaller inclined 
planes (the hips) intersect the ridge at some point, determined by the hip length. At the very extreme, 
hip roofs become pyramids. The footprint of this room is located using three user defined inputs - two 
defining the room's baseline and the third indicating the room's depth. They are created in Plan view 
and may be located at any angle. 

1. From the Add menu select Room-Rectangular-Hip, or from the Rooms/Objects toolbar click the arrow adjacent to the Room-Rectangular 

button . The secondary menu will appear. Select Hip. 
2. Specify a unique label for the room, up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's renderer, it is only used to represent 

the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will appear for 
your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. Enter the height of the room walls in the Wall Height text box. 
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7. Enter the hip height (the vertical distance from the top of the room 
walls to the highest point of the peak ceiling) in the Hip Height text 
box. 

 

8. Enter the hip length (the horizontal distance from the roof edge to the inner point on the roof peak) in the Hip Length text box. 
9. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 

reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 

10. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 

• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 

11. Click Ok to return to the graphics window and locate the first point of the room. Click the left mouse button. Before clicking the first point, you will 
have the opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. 

12. Drag the cursor to the second point on a room edge and left click again. These two points define the room's baseline. 
13. Drag the cursor to open up the room perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

room may be created on either side of the baseline. The hip roof's peak will be extruded perpendicular to the specified baseline and the shorter 
hips will be located on the room edges parallel to the specified baseline. 

Rectangular Rooms with a Pyramid Ceiling 

 

Rectangular rooms with pyramid ceilings are distinguished by their inclined sloped surfaces whose 
four sides meet at the highest point in the center of the room. They are created in Plan view and may 
be located at any angle. The footprint of this room is located using three user defined inputs - two 
defining the room's baseline and the third indicating the room's depth. 

1. From the Add menu select Room-Rectangular-Pyramid, or from the Rooms/Objects toolbar click the arrow adjacent to the Room-Rectangular 

button . The secondary menu appears. Select Pyramid. 
2. Specify a unique label for the room up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
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4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's render mode, it is only used to 
represent the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. Enter the height of the room walls in the Wall Height text box. 
7. Enter the pyramid height, the vertical distance from the top of the room walls to the pyramid's peak, in the Pyramid Height text box. 
8. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 

reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 

9. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 

• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 

10. Click Ok to return to the graphics window and locate the first point of the room. Click the left mouse button. Before clicking the first point, you will 
have the opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. 

11. Drag the cursor to the second point on a room edge and left click again. These two points define the room's baseline. 
12. Drag the cursor to open up the room perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

room may be created on either side of the baseline. 

Rectangular Rooms with a Vertically Extruded Ceiling 

 

Vertically extruded rooms allow for an irregular ceiling profile that is extruded from the baseline 
through the entire depth of the room. These rooms may be specified with “open” ends allowing light to 
enter the room, if desired. After the room footprint is created, using the three point input, an Elevation 
view is presented to you with the room walls already in place. Simply create the ceiling profile and 
right click when you are finished. 

Rectangular Rooms with Vertically Extruded Ceilings may also be converted automatically into 
Tunnels - for Tunnel Luminance calculations. The Surfaces within the tunnel are automatically 
converted to appropriate surface types for the necessary calculations. 

1. From the Add menu select Room-Rectangular-Vertical Extrusion, or from the Rooms/Objects toolbar click the arrow adjacent to the Room-

Rectangular button . The secondary menu appears. Select Vertical Extrusion. 
2. Specify a unique label for the room up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. Enter the height of the room walls in the Wall Height text box. 
7. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 

reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 
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8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 

• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 

9. To open the ends of the room as in a tunnel application, click in the Ends of Room and Vertical Extrusion Are Open selection box so that a 
check mark appears. Rectangular barrel vault rooms with open ends only have two walls, perpendicular to the open ends. 

10. Make Room into Roadway Tunnel - selecting this option will assign unique surface types to your "room" surfaces to use in Tunnel Lighting 
calculations per IESNA RP-22-2004 

• Ceiling and Wall reflectances are used, Surfaces change from One-sided surfaces to Roadway Contributors. 

• Floor reflectance is disregarded, reflectance extracted from selected Roadway Luminance Calculation Points (Q0 value associated with 
R Table) is used instead. Surface changed from One-sided surface to Roadway Pavement. 

• By default, when Make Room into Tunnel is selected, the Ends of Room and Vertical Extrusion Are Open selection box is also selected. 
The tunnel will be assigned open ends, unless you uncheck the 'Ends of Room...' selection box. 

11. Click Ok to return to the graphics window and locate the first point of the room. Click the left mouse button. Before clicking the first point, you will 
have the opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. 

12. Drag the cursor to the second point on a room edge and left click again. These two points define the room's baseline. 

13. Drag the cursor to open up the room perpendicular to the specified 
baseline and left click when the appropriate depth has been 
achieved. The room may be created on either side of the baseline. 

 

14. The current view will change automatically from Plan view to an 
Elevation view at the baseline looking into the room. The room floor 
and walls will have already been created. Notice that the cursor is 
attached to the right room wall. Locate the points in the ceiling with 
the left mouse button. Arcs may be added at the current vertex by 
pressing the F4 key on the keyboard then clicking in the other 
endpoint and fit point of the arc. You may undo the last line 
segment or arc in the ceiling by clicking on the Undo button or by 
pressing Ctrl+Z on the keyboard. All of the ceiling panels must be 
located above the topmost portion of the wall. If your ceiling needs 
to dip down into the room, make the first ceiling panel a vertical 
one, so that the walls are actually a little higher. 

 

15. When you have completed creating the ceiling, click on the right mouse button to close the room and create the surfaces. You will be returned 
to Plan view. 

Note: When specifying the profile in Elevation view, the Snap is changed to .01 and is locked at that value. This small snap setting ensures that the 
room surfaces will be created correctly. 
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Round Rooms with Dome Ceilings 

 

Round or elliptical rooms with dome ceilings are easily specified in AGi32. The appropriate dialog is 
presented to you prompting for the room, label, description, wireframe color, labeling options, wall 
height, dome height, surface reflectances and room aspect ratio. The aspect ratio defines the ratio of 
the left-right radius relative to the top-bottom radius of the room. A ratio = 1 produces a circle. A ratio > 
1 produces an ellipsoid in the left-right direction. A ratio < 1 produces an ellipsoid in the top-bottom 
direction. 

Once the specifications in the dialog have been completed, the room is created by locating the center point of the room at floor level and then 
dragging the cursor to specify the room's radius. 

1. From the Add menu select Room-Round/Elliptical-Dome, or from the Rooms/Objects toolbar click the arrow adjacent to the Round/Elliptical 

Room button . The secondary menu will appear. Select Dome. 
2. Specify a unique label for the room up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. Enter the height of the room walls in the Wall Height text box. 

7. Enter the height of the dome, above and beyond the room wall 
height, in the Dome Height text box. 

 

8. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 
reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 

9. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 
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• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 

10. If the room shape is elliptical, enter the appropriate aspect ratio in the X-Y Aspect Ratio text box. The aspect ratio is specified as the ratio of the 
X radius to the Y radius. If the room is longer in the X direction, the aspect ratio will be > 1. If the room is longer in the Y direction than in the X, 
the aspect ratio is < 1. 

• For example: To create an elliptical room 40 feet long (diameter in the X direction) and 20 feet wide (diameter in the Y direction), an aspect 
ratio of 2 would be specified. When the room X radius is prompted for a radius of 20 would be given. The resulting room will be 40 feet long 
(X radius = 20) and 20 feet wide (Y radius = 10). 

11. Click Ok to return to the graphics window and locate the center point of the room. Before clicking in the center point, you will have the 
opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate value. Click 
the left mouse button. 

12. Drag the cursor to specify the X radius of the room and left click again. Alternately, you may specify the X radius from the keyboard. 

Round Rooms with Flat Ceilings 

 

Round or elliptical rooms with flat ceilings may be specified in just a few steps with AGi32. Before the 
room is created, a dialog is presented to you prompting for the room label, wall height, surface 
reflectances and room aspect ratio. The aspect ratio defines the ratio of the left-right radius relative to 
the top-bottom radius of the room. A ratio = 1 produces a circle. A ratio > 1 produces an ellipsoid in the 
left-right direction. A ratio < 1 produces an ellipsoid in the top-bottom direction. 

Once the specifications in the dialog have been completed, the room is created by locating the center point of the room at floor level, and then 
dragging the cursor to specify the room's radius. 

1. From the Add menu select Room-Round/Elliptical-Flat, or from the Rooms/Objects toolbar select . 
2. Specify a unique label for the room up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. Enter the height of the room walls in the Wall Height text box. 
7. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 

reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 

8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 

• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 
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9. If the room shape is elliptical, enter the appropriate aspect ratio in the X-Y Aspect Ratio text box. The aspect ratio is specified as the ratio of the 
X radius to the Y radius. If the room is longer in the X direction, the aspect ratio will be > 1. If the room is longer in the Y direction than in the X, 
the aspect ratio is < 1. 

� For example: To create an elliptical room 40 feet long (diameter in the X direction) and 20 feet wide (diameter in the Y direction), an aspect 
ratio of 2 would be specified. When the room X radius is prompted for a radius of 20 would be given. The resulting room will be 40 feet long ( 
X radius = 20) and 20 feet wide (Y radius = 10). 

10. Click Ok to return to the graphics window and locate the center point of the room. Before clicking the center point, you will have the opportunity 
to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate value. Click the left mouse 
button to locate the center point of the room. 

11. Drag the cursor to specify the X radius of the room and left click again. Alternately, you may specify the X radius from the keyboard. 

Round Rooms with Vertical Rotation Ceilings 

 

 

This command allows you to specify a vertical room profile and spin (or lathe) it around the central axis of the room to create an enclosed or partially 
enclosed round/elliptical room with a custom dome ceiling. These rooms are created in three steps. First, the appropriate dialog is presented to you 
prompting for the room, label, wall height, surface reflectances and room aspect ratio. Then the footprint of the room is specified. You may specify a 
fully enclosed round/elliptical room or a partially enclosed room with a user defined circular segment. Finally, an elevation view is automatically 
presented to you and you specify the ceiling profile. The profile is lathed around the specified footprint to create the room. 

An elliptical room is created by specifying an aspect ratio other than 1. The aspect ratio defines the ratio of the left-right radius relative to the top-
bottom radius of the room. A ratio = 1 produces a circle. A ratio > 1 produces an ellipsoid in the left-right direction. A ratio < 1 produces an ellipsoid in 
the top-bottom direction. 

Once the specifications in the dialog have been completed, the room is created by located the center point of the room (at floor level) and then 
dragging the cursor to specify the room's radius. 

1. From the Add menu select Room-Round/Elliptical-Vert-Rotation, or from the Rooms/Objects toolbar click the arrow adjacent to the 

Round/Elliptical Room button . The secondary menu will appear. Select Vert-Rotation. 
2. Specify a unique label for the room up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. Enter the height of the room walls in the Wall Height text box. 
7. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 

reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 

8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  
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• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 

• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 

9. If the room shape is elliptical, enter the appropriate aspect ratio in the X-Y Aspect Ratio text box. The aspect ratio is specified as the ratio of the 
X radius to the Y radius. If the room is longer in the X direction, the aspect ratio will be > 1. If the room is longer in the Y direction than in the X, 
the aspect ratio is < 1. 

• For example, to create an elliptical room 40 feet long (diameter in the X direction) and 20 feet wide (diameter in the Y direction), an 
aspect ratio of 2 would be specified. When the room X radius is prompted for a radius of 20 would be given. The resulting room will 
be 40 feet long (X radius = 20) and 20 feet wide (Y radius = 10). 

10. Click Ok to return to the graphics window and locate the center point of the room. Before clicking in the center point, you will have the 
opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate value. Click 
the left mouse button. 

11. Drag the cursor to specify the baseline of the room and left click again. This distance dictates the X radius of enclosed rooms and the segment 
depth of partially enclosed rooms. 

12. Specify the ending angle of the room with the left mouse button. 
This angle determines the circular segment to create. Enclosed 
rooms are created by entering an ending angle that corresponds to 
the baseline endpoint. Segmented rooms are created by dragging 
the cursor to indicate the segment that defines the room's footprint. 

 

13. The current view will change automatically from plan view to an 
Elevation view at the baseline looking into the room. The room floor 
and perimeter wall will have already been created. Notice that the 
cursor is attached to the wall. Locate the points in the ceiling with 
the left mouse button heading towards the central room axis, 
indicated by the vertical dotted line. Arcs may be added at the 
current vertex by pressing the F4 key on the keyboard then clicking 
in the other endpoint of the arc. You may undo the last line 
segment or arc in the ceiling by clicking on the Undo button or by 
pressing Ctrl+Z on the keyboard. All of the ceiling panels must be 
located above the topmost portion of the wall. To create a closed 
ceiling, continue the line segments all the way to the dotted line. To 
create an open ceiling, stop the ceiling segments short of the dotted 
line. 

 

14. When you have completed creating the ceiling, click on the right mouse button to close the room and create the surfaces. You will be returned 
to Plan view. 

Note: When specifying the profile in Elevation view, the Snap is changed to .01 and is locked at that value. This small snap setting ensures that the 
room surfaces will be created correctly. 
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Polygon Rooms with Flat Ceilings 

 

Polygon shaped rooms with flat ceilings are created in Plan view and are characterized by their user-
defined perimeter. Their walls may be angled or curved, if desired. 

1. From the Add menu select Room-Polygon-Flat, or from the Rooms/Objects toolbar select . 
2. Specify a unique label for the room up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The room will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's render mode, it is only used to 

represent the room's shape in the graphics window. By default, this color is green. To change it, click in the color cell. The Color  dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the room and/or its 
surfaces. 

6. Enter the height of the room walls in the Wall Height text box. 
7. All of the surfaces within the room are assigned a color. By default, the colors are made up of varying shades of gray corresponding to 

reflectance values of 0.8 (ceiling), 0.5 (walls) and 0.2 (floor).All room surfaces are assigned a color. You may change the surface colors and 
their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing you to select surface colors based 
on user defined reflectances. 

8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the room in the environment. Then, either Edit the 
room and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object.  

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by Editing the room or using the Surface Edit command once it has been placed. 

• By default, rooms are comprised of one sided surfaces, facing inward. This attribute allows you to see into the room without having to 
walk inside in Render mode. You may flip the surface direction or change the surface type to two-sided in the Surface Edit command 
as well. 

9. Creation Method: Choose whether to manually create the boundary lines of the polygon or choose existing drawing entities as the boundary 
line. 

• If a tilted line is selected, the room will be projected down to and created at lowest Z coordinate elevation.  
10. Click Ok to create the room. Follow the steps below depending on the selected creation method: 

Specify a Polygon Manually Create Polygon from Drawing Entities 

i. To change the polygon elevation, move the cursor into the Z-
Coord text box (before clicking the first point) and enter a new 
value or use the up and down arrow keys on the keyboard. 

ii. Locate the first point of the polygon and click the left mouse 
button. 

iii. Move the cursor to the second vertex on the polygon and left 
click again. 

iv. You may specify an arc at the end of the current vertex by 
pressing the F4 key on your keyboard. Locate the second 
endpoint of the arc and left click again. By default, arcs are 
created in the counterclockwise direction, but their direction can 
be changed by pressing the F5 key. Specify the arc's radius by 
dragging the cursor and left clicking the mouse button. The object 

i. Locate the pickbox on the drawing entity line you wish to use and 
left click. 

ii. If a valid polygon is found (see Notes below), it will be displayed 
as a bold line, and the Polygon Search results dialog will appear: 

• Accept Polygon and Repeat - Select another polygon line as a 
template for another room with the same properties. Use pickbox 
to select another closed polygon. 

• Accept Polygon - Create room using selected entity as polygon 
boundary. 

• Reselect Entities - Choose this option if invalid polygon was 
found or if incorrect line was chosen. Use pickbox to select 
another closed polygon. 
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line will be attached to the arc's endpoint. 
v. Continue in this fashion until the polygon is complete. Right click 

to close the polygon shape. The Polygon room will be created. 

• Manually Specify Polygon - Select vertices manually to specify 
polygon boundary, right clicking once all vertices are specified. 
This option is necessary if no valid polygon is found. 

• Cancel - Do not create room. 

Notes: 

• Drawing Entity line segments do not need to be joined, just need 
to be within tolerances (2 decimals of precision - .05) 

• Line segments do not need to make a closed polygon - AGi32 will 
automatically close boundary line 

• AGi32 filters related lines by color. 

Caveats: 

• Disconnected line segments or line segments disconnected by 
gap larger than tolerance level will not form valid polygon. 

• Polygons with intersecting lines will not form valid polygon. 

• Incomplete polygons are not valid and may close in an 
unacceptable manner. 

  

  

Adding Objects 

Adding Objects 

Objects are reflective and/or transmissive elements in AGi32 that may be added to exterior and/or interior spaces to model complex environments. 
The four basic object types, rectangular, round/elliptical, polygon and planar can be used in any combination to achieve any desired result. In 
addition, each object type is available with different configurations, such as spheres, cones, vertical extrusion, etc., to further increase you modeling 
capabilities. Once created, objects may be moved, copied, arrayed and edited as necessary. 

What shape Object would you like to create? 

Rectangular Objects 

Rectangular objects have a rectangular footprint with a flat or user defined top. Many kinds of rectangular objects are provided: flat, barrel vault, 
gable, hip, pyramid and vertical extrusion. Before the object footprint is created, you will be prompted to specify the object height and the object’s 
reflectances and or transmittances. Flat and other predefined topped objects are automatically created after the object footprint is specified in Plan 
View. Vertically extruded objects are created in the same manner with an additional step of creating the vertical extrusion section that will be applied 
linearly across the rectangular footprint. 

What shape Rectangular Object would you like to create? 

Create a Rectangular Object with a Flat top 

Create a Rectangular Object with a Barrel Vault 

Create a Rectangular Object with a Gable 

Create a Rectangular Object with a Hip 

Create a Rectangular Object with a Pyramid 

Create a Rectangular Object with a Vertical Extrusion 

Round/Elliptical Objects 

AGi32 provides you with four types of round/elliptical objects; cone, flat, sphere and vertical rotation. Cone and Flat objects are created by specifying 
the object height in the object’s properties dialog then locating the base’s center point and radius in Plan View. Spherical objects are similar except 
that the center of the sphere (X, Y and Z) is specified in Plan View. Vertical Rotation objects are circular or semicircular entities with a user defined 
profile. The location and circular angle is specified in Plan view then the custom profile is specified in Elevation view. 

What shape Round Object would you like to create? 
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Create a sphere 

Create a cone 

Create a flat cylinder 

Create a domed cylinder 

Create a vertical rotation object 

Polygon Objects 

Objects with non-rectangular footprints (such as workstations or partitions) may be easily created with the Polygon Objects command. Polygonal 
objects have flat tops and bottoms with curved or angular surfaces. 

What shape Polygon Object would you like to create? 

Create a flat object with polygonal sides 

Create a polygonal vertical extrusion object 

Planar Objects 

Library Objects   

Object Concepts 

Combinations of Basic Object Shapes to create complex everyday items 

 

 

Objects are used to model many shapes in AGi32. The choices of object shapes available are varied and range from simple geometries like 
rectangles, cylinders (Round-Flat Object) and spheres to customizable shapes with irregular profiles. Objects can be inserted into any environment, 
both interior and exterior to block, reflect and transmit light as necessary. In addition, single or multiple objects may be stored in a user-defined 
"library" of objects. Library objects can be recalled at anytime, modified for scale and color or reflectance and be placed in any job file. AGi32 is 
delivered with a number of factory provided library objects that may be used at any time to add detail, scale and realism to any lighting layout. 
However, the strength of the system is the ability to create your own object libraries relevant to your work and draw from them whenever necessary. 
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AGi32 is also capable of importing three dimensional solids created in other software via DXF or DWG files. 
Imported solids are converted into AGi32 objects and can be manipulated using the object commands. Generally, 
imported objects are composed of large numbers of small surfaces. These objects can be difficult to edit for color 
and reflectance once imported. Ideally, an externally created object will be stratified into multiple layers and 
blocks. This makes the process of assigning color, reflectance and texture relatively simple on import. 

The internal modelling tools offer substantial flexibility when creating complex elements by using a combination of 
object shapes. The palm tree object, shown at right, was created by using a Round-Flat object to create the 
cylindrical trunk and Planar objects to create the leaves. One leaf was created as a template and multiples were 
added using the Rotate Object and Polar Array Object commands. By visualizing the basic shapes that make up 
real forms in the environment, you can make your layouts more realistic. 

 

Dialog Defaults 

The individual parameters available in all Object dialogs are automatically saved and restored in the Object dialogs. There are two types of defaults 
present in all of the dialogs: Global and Local. Global defaults occur in every Object dialog and carry over to other Object dialogs as well. Local 
defaults only occur in specific dialogs. The following defaults are global for all Object commands. 

• Label: Default Label is Object. The Label name will automatically increment to produce unique labels. For example, if the first Object is labeled 
Object, the second is labeled Object_1. When the default label is changed, it will also automatically increment. 

• Wireframe color 

• Labeling options 

• Height of Sides 
• Top, Sides and Bottom surfaces: Color, Reflectance and Texture (including applied options). 

Reset Defaults - Selecting this button will reset all Global dialog parameters to the factory defined specifications. 

Technical Details: 

Object Shapes 

Rectangular Barrel 
Vault Objects 

 

Rectangular Gable 
Objects 

 



AGi32 Help System  Adding Entities 

109 

 

Rectangular Hip 
Objects 

 

Rectangular 
Pyramid Objects 

 

Rectangular Flat 
Objects 

 

Rectangular Flat 
Object combination 

 

Rectangular 
Vertical Extrusion 
Objects 
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Rectangular 
Vertical Extrusion 
Object 
combinations 

 

Round Cone 
Objects 

 

Round Flat Objects 

 

Round Dome 
Objects 
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Round Sphere 
Objects 

 

Round Vertical 
Rotation Objects 

 

Polygon Flat 
Objects 

 

Polygon Flat Object 
combinations 

 

Polygon Vertical 
Extrusion Objects 
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Polygon Vertical 
Extrusion Object 
combinations 

 

Planar Objects 

1 - Triangular 

2 - Trapezoid 

3 - Quadrilateral 

4 - Polygon 

 

 

Object Dimensions 

All Object types have certain dimensional variables associated that describe some parameter of the shape that must be defined prior to creating it in 
the graphics area. 

 

• Height of Sides- The height of the object sides refers to the distance from the base of the object to 
top of the object, or the distance between the top and bottom surfaces. This is a vertical 
measurement in the Z-plane and is specific to the object only, it is independent of the elevation of the 
object above the floor/ground. 
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• Vault Height - The Vault height is the height of the vault as measured from the top of the walls to the apex or peak of the vault. 

• Vault Width - The width of the vault can be any dimension less than or equal to the width of the object. If the vault width is less than the object 
width, the vault will be centered in the object. If the vault width is entered as greater than or equal to the object width, the vault will span the 
entire width of the object. 

 

• Gable Height - The Gable Height refers to the vertical distance from the top of the 
object sides to the top of the gable top. 

 

• Hip Height - The Hip Height refers to the vertical distance from the top of the object sides to the top of the Hip. 

• Hip Length - The Hip Length refers to the horizontal distance from the object baseline to the intersection of the hip and top peak as seen in Plan 
view. 

 

• Pyramid Height - Pyramid height refers to the vertical distance from the top of the 
sides to the apex of the Pyramid. The total height of the Pyramid object is then the 
height of the sides plus the height of the Pyramid. 
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• Dome Height - Dome height refers to the vertical distance from the top of the sides 
to the crown of the Dome. The total height of the dome object is then the height of 
the walls plus the height of the dome. 

 

• Height of Cone (base to top) - The Height of Cone refers to the overall height of the cone shape from base to top elevation. This figure is 
independent of the elevation of the base of the cone. A positive Height will create a conical shape with point upward (above the base). Whereby, 
a negative Height will place the point of the cone shape downward below the base. Regardless of whether the cone is pointing up or down, the 
current Z-coordinate specifies the base elevation when creating the cone shape in Plan view. 

• If a cone shape is to be trimmed between the base and top elevations the Height of the Cone will dictate the slope of the cone sides and must 
still be entered as the height to the imaginary cone top. 

 

• Height of Trim (base to trim) - The Height of Trim refers to the height of the cone shape from base to the trim line. The Trim Height must be less 
than the Cone Height. Cones can be trimmed anywhere in between the base and tip. This creates a conical shape that does not terminate in a 
single apex point. 

• Note: If the Cone Height is negative (cone points down) and you wish to trim the cone, the Trim Height must be negative as well. 

 

• Height = Radius - The Height of the sphere refers to the vertical distance from sphere center to apex. If the Height = Radius radio button is 
selected, the height will be equal to the radius as specified parallel to the X-axis. If the Aspect ratio is equal to one, this setting will always result 
in a perfect sphere. 

• Height (from center point) - The Height of the sphere refers to the vertical distance from sphere center to apex. This distance can be specified 
independently of the radius dimension allowing shapes to be flattened or elongated in the Z-direction. If the Aspect ratio is equal to one, the 
object will always be circular when viewed from above (Plan). Aspect ratios other than one will elongate the shape in either the X or Y 
dimensions. 
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Aspect ratio - The Aspect Ratio is used to define the shape of the sphere 
equator. An Aspect Ratio equal to one will create a perfectly round spherical 
equator. Aspect Ratios greater than one lengthen the X-axis of the base 
resulting in an elliptical shape left to right. Aspect ratios less than one elongate 
the Y-axis of the base to form an ellipse aligned top to bottom. 

As an example, an Aspect Ratio equal to two will create an ellipsoidal object 
that is twice as long in the X-dimension as it is in the Y-dimension. 

An Aspect Ratio equal to one half (.5) will create an ellipsoidal equator that is 
twice as long in the Y-dimension as it is in the X-dimension. 

Surface Properties 

Surface properties of Color and Reflectance must be defined for all object surfaces. Color and Reflectance are related to one another in a way that 
allows only certain colors to be assigned to a specific reflectance value. This is a mathematical relationship that is discussed in more depth here. To 
alter the color or reflectance of an Object surface, click the mouse in either the color or reflectance cell. 

By default, the colors shown are shades of gray based on the reflectance entered in the 
adjacent cell. You can select any reflectance within the gray scale range (Black to white) by 
entering it in the reflectance cell provided. 

To select a color, move the Hue slider to the desired color, then move the Saturation and 
Luminance sliders to achieve the desired color. The reflectance will be calculated and 
displayed. You can adjust the reflectance within the Hue by moving the reflectance slider. 

  

  

 

 

Textures 

Texture are graphic images that may be applied to the object surfaces to make them appear more realistic. Textures like brick, stone, concrete and 
wood can be tiled in a repeating pattern across the surfaces or stretch across them. The average reflectance and color of the texture is calculated 
and used instead of the surfaces original color in the radiosity calculations. 

AGi32 comes with a selection of assorted textures that may be applied to any surface. You may also obtain textures from lots of other sources, 
including free texture sites online, commercial texture collections, even use your digital camera to obtain them directly. Click here to read about 
texture tips. 

To apply a texture to a surface, click in the Texture cell. Select the texture from the Texture database, then determine the application options. 

Advanced Surface Properties 

Open/Closed Objects 

Certain round object types, such as cones, spheres and vertical rotation shapes can be Open or Closed and can reflect light on the outside or inside. 
In the case of transmittance >0, the object will have reflectance/color on both inside and outside unless "closed." 

Open Shapes 

When the Open option is selected, the object base is removed (for cones and vertical rotation objects) and any partial sides are also left open. Open 
objects may be closed at a later time by editing the object and unchecking the Open selection box. 

Reflective Side 

When working with open shapes, reflectance/color can be specified to be on either the inside or outside of the object. Generally, it is imagined that 
"open" shapes will be reflective on the inside or will be assigned a transmittance. "Closed" partial shapes would most likely be reflective on the 
outside only. 
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Inserting curved surfaces into object (Polygon-Flat, Polygon-Vertical Extrusion, Planar, Rectangular-Vertical 
Extrusion and Round-Vertical Rotation) 

It is a simple procedure to describe a curved surface using an integrated Arc function. An 
arc can be fit between any two points and can be of most any radius. To insert an arc into 
a building, press the F4 key on your keyboard at the starting point of the arc. The 
command prompt (lower left corner of screen) will then prompt for the second point of the 
arc as shown at right. Click the mouse at the second point of the arc and a dotted line will 
appear showing the current arc shape. If you don't move the mouse the initial arc will be a 
perfect semi-circle (#1). Move the mouse cursor toward the arc apex to raise the arc 
center point and increase the circumference (#2).Or, move the cursor away from the apex 
of the arc and move the arc center downward. This effectively flattens the arc (#3). 

Reversing the Arc 

The direction of the arc can be reversed by simply pressing the F5 key on your keyboard. 

Curved surface resolution 

Curved surfaces are automatically divided into a series of straight segments based on the 
setting of the system variable Initial Curve Increment (degrees). The default is 15 degrees. 
This is adequate for most applications. This variable can be found under System Settings 
command from the Tools menu. Click on the Defaults tab and then on the Advanced 
button. 

  

  

 

  

Removing Surfaces 

AGi32 provides the ability to eliminate surfaces from any object shape you might create by removing the surfaces. Removed surfaces are not 
considered in the calculations any longer. A removed surface behaves differently than one whose reflectance is set to zero. Surfaces that have zero 
reflectance absorb all light that touches them and reflect no light outwards. Removed surfaces allow light to transmit directly through them because 
they no longer exist (unless another surface exists in the same location). Once surfaces are removed, you can recreate them by changing their 
reflectance to a real value. 

By removing selected surfaces in the object, you have the ability to append other shapes to the object. These shapes may in turn have their surfaces 
removed. Continuing in this fashion, you can create very elaborate models consisting of numerous objects joined together. For example, you may 
want to create an Rectangular-Flat object and remove one of the sides that was initially created to create the base for a bookcase. Once the side is 
removed, you can use any combination objects to create a custom shelving unit. 

To remove a surface, either Edit the object and select the Surface Edit button in the Edit dialog or use the Surface Edit command to select the object. 
In the Surface Edit dialog, navigate to the surface you wish to remove. To remove more than one surface in an object, Tag all of the surfaces you 
need to operate on. Change the Surface Type to Removed (Invisible) and click Ok. 

The surfaces will be removed from the environment. In Model Mode, they will appear as dashed lines, in Render mode, they will simply not appear. 
Removed surfaces can be replaced at any time through the Surface Edit dialog by changing the surface back to a Single Sided or Double Sided 
surface with appropriate reflectance/color. 

 Object Types 

  Library Objects - Concepts 

Library Objects are single or combinations of multiple objects that have been previously stored in a user defined "library" of objects. Library Objects 
can be recalled at any time, modified for color, scale and/or texture and be placed in any job file. 

AGi32 is delivered with several factory provided Libraries including furniture, computer peripherals, trees and shrubs and other handy objects, 
however, the strength of the system lies in your ability to create library objects of your own for reuse and application in any job file. You may create 
Library Objects out of any combination of Object shapes available in or imported into AGi32 that are relevant to your own work. 

Library Objects are saved into your "custom" Libraries using the Modify-Object-Make Library Object command. 

Associated Dialogs 
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Select Library Object dialog - This dialog allows you to select a library object from your local Libraries. An object preview is shown when an object 
is highlighted in the list. You may use the navigation button above the image to view it from different directions. The Display Options button allows 
you to change object transparency, background color, and other characteristics of the display. 

 

Library Object dialog - This dialog allows you to change the scale of the object by applying Scaling Factors in the X, Y and/or Z directions. You may 
also modify the surface properties of the object by clicking the Surface Edit button. The way that the object is displayed here may be changed as 
well. 

 

Create Object Library  dialog - This dialog allows you to create new Libraries for the purpose of storing library objects. User objects cannot be 
added to the factory provided libraries (Appliances, Computer, Exterior, Fixtures, Furniture, Misc, Office, People, Retail-Industrial, Sports, Structural-
Architectural, Trees and Shrubs, Vehicles); instead they must be added to your own defined Libraries. 
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Library Objects 

The Object – Library Object dialog appears after an object is selected from the Object - Select Library Object dialog. You may change the unique 
label name, description and scaling information. as well as the wireframe color, and labeling options, Surface properties may be edited by using the 
Surface Edit button. 

Library objects may be scaled proportionally or non proportionately, as needed. To scale an object proportionally, apply equal scaling values in the X, 
Y and Z directions. 

You may insert multiple instances of the library object at a time. Each additional library object will be labeled with the original library object name and 
appended with -#. 

1. Specify a unique label for this library object up to 32 characters long. 
2. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
3. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render Mode; it is only used to 

represent the object's shape in Model Mode. By default, this color is black. To change it, click in the color cell. The Color dialog will appear for 
your use. 

4. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces.  

5. To change the surface properties (such as color, texture, specularity, mesh, etc.) click the Surface Edit button. The Surface Edit dialog will 
appear to assist you in making changes.  

6. If appropriate, specify scaling factors in the X, Y and Z directions.  
7. Click Ok to return to the graphics window and locate the object. The object will be attached to the cursor at the user -defined insertion point 

specified when the library object was created.  
8. Click the left mouse button to insert the library object.   

Polygon Objects - Flat 

 

Polygon flat objects are characterized by their uniform height and user defined footprint. They are 
created in Plan View by specifying each vertex on the boundary. Polygon flat objects may have curved 
surfaces attached to the current endpoint by pressing the F4 key on the keyboard. First, you will be 
prompted to specify the endpoint of the arc, then the arc curvature will be specified. If desired, you 
may flip the arc in the opposite direction by pressing the F5 key. Once the arc is complete the cursor 
will be attached to the second point so that you may continue specifying additional vertices. 

The object’s properties are specified in the Object-Polygon-Flat dialog. These properties include a unique object label, description, wireframe color, 
labeling options, side height, and surface reflectances. When the object is initially specified, the top, sides and bottom are assigned color and 
reflectance values. You may edit the object, after creation, to assign a different reflectance (color) to each surface individually, if desired. 

1. From the Add menu select Object-Polygon-Flat, or from the Rooms/Objects toolbar select . 
2. Specify a unique label for the object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's render mode, it is only used to 

represent the object 's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object in the Height of Sides text box. 
7. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 

8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 
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• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

9. Creation Method: Choose whether to manually create the boundary lines of the polygon or choose an existing drawing entities as the boundary 
line. 

• If a tilted line is selected, the polygon will be projected down to and created at lowest Z coordinate elevation.  
10. Click Ok to create the polygon. Follow the steps below depending on the selected creation method: 

Specify a Polygon Manually Create Polygon from Drawing Entities 

i. To change the polygon elevation, move the cursor into the Z-
Coord text box (before clicking the first point) and enter a new 
value or use the up and down arrow keys on the keyboard. 

ii. Locate the first point of the polygon and click the left mouse 
button. 

iii. Move the cursor to the second vertex on the polygon and left 
click again. 

iv. You may specify an arc at the end of the current vertex by 
pressing the F4 key on your keyboard. Locate the second 
endpoint of the arc and left click again. By default, arcs are 
created in the counterclockwise direction, but their direction can 
be changed by pressing the F5 key. Specify the arc's radius by 
dragging the cursor and left clicking the mouse button. The object 
line will be attached to the arc's endpoint. 

v. Continue in this fashion until the polygon is complete. Right click 
to close the polygon shape. The Polygon object will be created. 

i. Locate the pickbox on the drawing entity line you wish to use 
and left click. 

ii. If a valid polygon is found (see Notes below), it will be displayed 
as a bold line, and the Polygon Search results dialog will appear: 

• Accept Polygon and Repeat - Select another polygon line as a 
template for another object with the same properties. Use 
pickbox to select another closed polygon. 

• Accept Polygon - Create object using selected entity as polygon 
boundary. 

• Reselect Entities - Choose this option if invalid polygon was 
found or if incorrect line was chosen. Use pickbox to select 
another closed polygon. 

• Manually Specify Polygon - Select vertices manually to specify 
polygon boundary, right clicking once all vertices are specified. 
This option is necessary if no valid polygon is found. 

• Cancel - Do not create object. 

Notes: 

• Drawing Entity line segments do not need to be joined, just need 
to be within tolerances (2 decimals of precision - .05) 

• Line segments do not need to make a closed polygon - AGi32 
will automatically close boundary line 

• AGi32 filters related lines by color. 

Caveats: 

• Disconnected line segments or line segments disconnected by 
gap larger than tolerance level will not form valid polygon. 

• Polygons with intersecting lines will not form valid polygon. 

• Incomplete polygons are not valid, may close in an unacceptable 
manner. 

Polygon Objects - Vertical Extrusion 
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Polygon vertical extrusion objects are created in Elevation view and allow for any user-defined profile to be uniformly extruded through a specified 
depth. The applications of this object type are numerous including; furniture, ducts, architectural elements, people, trees, cars, etc. Polygon vertical 
extrusion objects may have curved surfaces attached to the current endpoint by pressing the F4 key on the keyboard. First, you will be prompted to 
enter the endpoint of the arc, then the arc curvature will be specified. If desired, you may flip the arc in the opposite direction by pressing the F5 key. 
Once the arc is complete the cursor will be attached to the second point so that you may continue specifying additional vertices. 

The object’s properties are specified in the Object-Polygon-Vertical Extrusion dialog. These properties include a unique object label, description, 
wireframe color, labeling options, object depth, and surface reflectances. When the object is initially specified, all surfaces are assigned the same 
reflectance value. You may edit the object, after creation, to assign a different reflectance (color) to each surface individually, if desired. 

1. Begin by specifying the appropriate Elevation view. Locate the viewing plane, which specifies the view location and direction in Plan view. From 

the View menu choose Elevation, or from the Common toolbar select . Locate the left hand corner of the elevation view and click. Drag the 
cursor along the viewing plane and click on a second alignment point. 

2. From the Add menu select Object-Polygon-Vertical Extrusion, or from the Rooms/Objects toolbar select . Depress the arrow adjacent 
to the Polygon Object button for a second to bring up the secondary menu. Select Vert-Extrusion. 

3. Specify a unique label for the object up to 32 characters long. 
4. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
5. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object 's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

6. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

7. Enter the object depth in the Depth of Object text box. 
8. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 

9. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

10. Click Ok to return to the graphics window and locate the first point of the object. Click the left mouse button. 
11. Drag the cursor to the second point on the object 's profile and left click again. 
12. You may specify an arc at the end of the current vertex by pressing the F4 key on your keyboard. Locate the second endpoint of the arc and left 

click again. By default, arcs are created in the counterclockwise direction, but their direction can be changed on the fly by pressing the F5 key. 
Specify the arc's radius by dragging the cursor and left clicking the mouse button. The object line will be attached to the arc's endpoint. 

13. Continue locating the profile vertices in this manner until you reach the last corner of the object. You may undo individual segments on the 
object profile by pressing Ctrl+Z on your keyboard or clicking on the Undo button on the Common Toolbar. 

14. Click the right mouse button to close the object shape and extrude the object. The side of the object between the last point and the first point will 
be automatically created. 

Note: When specifying the profile in a non-orthogonal Elevation view, the snap is changed to .01 and is locked at that value. This small snap setting 
ensures that the object surfaces will be created correctly. 

Planar Objects 

 

Planar objects are two-dimensional objects that may exist anywhere in three-
dimensional space. For example, each side of a pyramid is a planar object. The 
Planar Object command provides three shapes of planar objects: Triangle (1), 
Quadrilateral/Trapezoid (2 and 3) and Polygon (4). Planar objects are handy for 
creating a reflective ground plane for exterior applications when rendering, 
sealing openings in complex models and modeling the Fresnel properties of 
glass for Daylighting. 
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The object’s properties are specified in the Object-Planar dialog. These properties include a unique object label, description, wireframe color, labeling 
options, and surface reflectances. When the object is initially specified, the surfaces is created as a two sided object with color and reflectance. You 
may edit the object, after creation, to assign a different reflectance (color) to it, if desired. 

What do you want to do? 

Create a triangular planar object 

Triangular planar objects are created in Plan view or Elevation view and can be reflective on one or both sides. They can also be transparent. Each 
vertex on the triangle may have a different Z coordinate, if desired. 

1. From the Add menu select Object-Planar, or from the Rooms/Objects toolbar select . 
2. Specify a unique label for the object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object 's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. The planar surface is assigned a color. You may change the surface color and its corresponding reflectances by clicking in the color cell. The 
Color Selection dialog will appear allowing you to select surface colors based on user defined reflectances. 

7. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

• To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is 
deleted from a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

8. Click on the radio button adjacent to Triangle. 
9. You may specify the Z coordinates of the top and bottom before exiting to the graphics window, if desired. 

10. Click Ok to return to the graphics window and locate the first point of the triangle. Before clicking in the first point, you will have the opportunity 
to change the Z coordinate of the bottom, if desired (Plan View). Move the cursor into the Z-Coordinates Bottom dialog and enter the 
appropriate value. Click the left mouse button. 

11. Drag the cursor to the second point on the triangle. You may change the Z coordinate of the second point if desired by moving the cursor into 
the Z-Coord text box and entering the Z value. Left click the mouse button at the vertex location. 

12. Drag the cursor to the third point on the triangle. You may change the Z coordinate of the top at this time by moving the cursor into the Z-Coord 
text box and entering the appropriate value in Plan view. Notice that you are informed whether the surface is reflecting up or down. You may flip 
the reflective side in the opposite direction by clicking the F5 key. Click the left mouse button again to locate the third point. 

Create a quadrilateral planar object 

Quadrilateral (four sided) planar objects can be created in Plan view or Elevation view and can be reflective on one or both sides, or transparent. In 

Plan View, you may create a non parallel quadrilateral unless the object is tilted (Ztop ≠ Zbottom). In the case of a tilted object, a trapezoid is created 
(bottom and top are parallel). In Elevation view, you may create a quadrilateral because the planar object is inherently restricted to the specified 
plane. 

1. From the Add menu select Object-Planar, or from the Rooms/Objects toolbar select . 
2. Specify a unique label for the object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. The planar object is assigned a color and reflectance. You may change the surface colors and their corresponding reflectances by clicking in the 
color cell. The Color Selection dialog will appear allowing you to select surface colors based on user defined reflectances. 

7. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 
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To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

8. Click on the radio button adjacent to Quadrilateral/Trapezoid. 
9. You may specify the Z coordinates of the top and bottom before exiting to the graphics window, if desired. 

10. Click Ok to return to the graphics window and locate the first point of the object. Before clicking in the first point, you will have the opportunity to 
change the Z coordinate of the bottom, if desired (Plan View). Move the cursor into the Z-Coord text box and enter the appropriate value. Click 
the left mouse button. 

11. Drag the cursor to the second point on the object 's bottom and left click again. 
12. Drag the cursor to the third point on the planar object. You may change the Z coordinate of the top at this time by moving the cursor into the Z-

Coord text box and entering the appropriate value (Plan View). Notice that you are informed whether the surface is reflecting up or down. You 
may flip the reflective side in the opposite direction by clicking the F5 key. Click the left mouse button again to locate the third point. 

13. Drag the cursor to the fourth point on the quadrilateral and left click once more. If the planar object is sloping in Plan view, you will be restricted 
to specifying a line parallel to the bottom. You may not flip or change the Z coordinate at this time. 

Create a polygon planar object 

Planar objects with a user defined polygon boundary can be reflective on one or both sides and can be created in Plan view, Rotated Plan view and 
Elevation view. For polygons created in Plan view, each vertex on the polygon must be located at the same Z-coordinate but the entire planar 
polygon may lie at any elevation. For polygons created in Elevation view, all vertices must lie in the current elevation plane. 

1. From the Add menu select Object-Planar. or from the Rooms/Objects toolbar select . 
2. Specify a unique label for the object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object 's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. The planar object is assigned a color and reflectance. You may change the surface colors and their corresponding reflectances by clicking in the 
color cell. The Color Selection dialog will appear allowing you to select surface colors based on user defined reflectances. 

7. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

8. Click on the radio button adjacent to Polygon. 
9. You may specify the Z coordinates of the polygon bottom before exiting to the graphics window, if desired. This is active only when creating the 

object in Plan view. 
10. Creation Method: Choose whether to manually create boundary lines of planar object or choose existing lines as the boundary line. 

• Planar object will always be flat in Plan View. 

• If a tilted line is selected, polygon will be projected down to and created at lowest Z coordinate elevation.  
11. Click Ok. Follow the steps below depending on the selected creation method: 

Specify a Polygon Manually Create Planar Object Polygon from Drawing Entities 

i. Locate the first point of the polygon and click the left mouse 
button. Before clicking in the first point, you will have a second 
opportunity to change the Z coordinate of the bottom in Plan 
View. Move the cursor into the Z-Coord text box and enter the 
appropriate value. Click the left mouse button to locate the first 
point. 

ii. Drag the cursor to the second point on the polygon. Notice that 
you are informed whether the surface is reflecting up or down. 
You may flip the reflective side in the opposite direction by 

i. Locate the pickbox on the drawing entity line you wish to use and 
left click. 

ii. If a valid polygon is found (see Notes below), it will be displayed 
as a bold line, and the Polygon Search results dialog will appear: 

• Accept Polygon and Repeat - Select another polygon line as a 
template for another object with the same properties. Use 
pickbox to select another closed polygon. 

• Accept Polygon - Create object using selected entity as polygon 
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clicking the F5 key. Left click the mouse button at the vertex 
location. 

iii. Continue locating vertices in this manner. To add an arc to the 
current vertex, press the F4 key. You will be prompted to locate 
the 2nd arc endpoint and the fit point to complete the arc. Once 
all vertices have been specified, right click to complete the 
polygon. 

boundary. 

• Reselect Entities - Choose this option if invalid polygon was 
found or if incorrect line was chosen. Use pickbox to select 
another closed polygon. 

• Manually Specify Polygon - Select vertices manually to specify 
polygon boundary, right clicking once all vertices are specified. 
This option is necessary if no valid polygon is found. 

• Cancel - Do not create object. 

Notes: 

• Drawing Entity line segments do not need to be joined, just need 
to be within tolerances (2 decimals of precision - .05) 

• Line segments do not need to make a closed polygon - AGi32 will 
automatically close boundary line 

• AGi32 filters related lines by color. 

Caveats: 

• Disconnected line segments or line segments disconnected by 
gap larger than tolerance level will not form valid polygon. 

• Polygons with intersecting lines will not form valid polygon. 

• Incomplete polygons are not valid, may close in an unacceptable 
manner. 

Rectangular Objects  - Barrel Vault 

 

Rectangular barrel vault objects have a barrel vault top extending from the center of the user-
defined baseline along the entire depth of the object. The barrel vault is created using the 
specified vault width along the baseline and vault height. If the vault width is wider than the 
specified baseline width, it will be truncated so that the vault fills the entire roof width. If the vault 
width is less than the baseline width, horizontal top panels will be located on either side of the 
vault to fill in the roof. As with rectangular flat objects, these objects are located using three user 
defined inputs - two defining the object's baseline and the third indicating the object's depth. 
Barrel vault objects are created in Plan view and may be located at any angle. 

1. From the Add menu select Object-Rectangular-Barrel Vault, or from the Rooms/Objects toolbar click on the pull-down arrow to the right of the 

Object-Rectangular button . This will invoke the secondary menu. Select Barrel Vault. 
2. Specify a unique label for the object up to 32 characters long. 
3. An optional description may be entered, up to 80 characters long. Meaningful descriptions that include size and color information will be useful 

when generating schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object walls in the Side Height text box. 
7. Enter the barrel vault height, above and beyond the object wall height in the Vault Height text box. 
8. Enter the barrel vault width in the Vault Width text box. 
9. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 

10. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
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stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

11. Click Ok to return to the graphics window and locate the first point of the object. Click the left mouse button. Before clicking the first point, you 
will have the opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. Then, locate the first point by clicking the left mouse button. 

12. Drag the cursor to the second point on a object edge and left click again. These two points define the object's baseline. 
13. Drag the cursor to open up the object perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

object may be created on either side of the baseline. The barrel vault will also be created perpendicular to the specified baseline. 

Rectangular Objects - Flat 

 

Flat rectangular objects are the simplest and most commonly used objects in AGi32. They are 
specified in Plan view and are created by locating the two endpoints on the baseline and a third point 
indicating the object depth. Rectangular objects may be created using any orientation by assigning the 
desired angle when locating the baseline. 

Before the object is created, its properties are specified in the Object-Rectangular-Flat dialog. These properties include a unique object label, 
description, wireframe color labeling options, object height and surface attributes. When the object is initially specified, all sides are assigned the 
same attributes (color, reflectance and texture). You may edit the object, after creation, to assign different attributes to each side individually, if 
desired. 

1. From the Add menu select Object-Rectangular-Flat, or from the Rooms/Objects toolbar select . 
2. Specify a unique label for this object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object sides in the Height of Sides text box. 
7. All object surfaces are assigned a color. You may change the surface colors and their corresponding reflectances by clicking in the color cell. 

The Color Selection dialog will appear allowing you to select surface colors based on user defined reflectances. 
8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 

from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 
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• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

9. Click Ok to return to the graphics window and locate the first point of the object. Before clicking the first point, you will have the opportunity to 
change the Z coordinate of the bottom, if desired. Move the cursor into the Z-Coord text box and enter the appropriate value. Then, click the left 
mouse button to locate the first point. 

10. Drag the cursor to the second point on a object edge and left click again. These two points define the object's baseline. 
11. Drag the cursor to open up the object perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

object depth may be specified on either side of the baseline. 

Rectangular Objects - Gable 

 

These objects have a gable top extending from the center of the user defined baseline along the 
entire depth of the object. The gable height is specified in the Object-Gable dialog and rises 
above the specified side height. Gable topped objects are located using three user defined inputs 
- two defining the object's baseline and the third indicating the object's depth. They are created in 
Plan view and may be located at any angle. 

1. From the Add menu select Object-Rectangular-Gable, or from the Rooms/Objects toolbar click on the pull-down arrow to the right of the 

Object-Rectangular button . This will invoke the secondary menu. Select Gable. 
2. Specify a unique label for the object up to 32 characters long. 
3. An optional description may be entered, up to 80 characters long. Meaningful descriptions that include size and color information will be useful 

when generating schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object walls in the Side Height text box. 
7. Enter the gable height, the vertical distance from the top of the object walls to the highest point of the roof peak, in the Gable Height text box. 
8. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 

9. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 
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10. Click Ok to return to the graphics window and locate the first point of the object. Click the left mouse button. Before clicking the first point, you 
will have the opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. Then locate the first point by clicking the left mouse button. 

11. Drag the cursor to the second point on a object edge and left click again. These two points define the object's baseline. 
12. Drag the cursor to open up the object perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

object may be created on either side of the baseline. The gable top line will be created along the entire depth of the object in a direction 
perpendicular to the specified baseline. 

Rectangular Objects - Hip 

 

These objects have a hip top extending from the center of the user defined baseline following the 
entire depth of the object. Hip tops are characterized by their four sided inclining slanting planes. 
Two of the larger planes intersect at the center of the object forming its highest point, the ridge. 
The other two smaller inclined planes, the hips, intersect the ridge at some point, determined by 
the hip length. At the very extreme, hip tops become pyramids. The footprint of this object is 
located using three user defined inputs - two defining the object's baseline and the third indicating 
the object's depth. They are created in Plan view and may be located at any angle. 

1. From the Add menu select Object-Rectangular-Hip, or from the Rooms/Objects toolbar click on the pull-down arrow to the right of the Object-

Rectangular button . This will invoke the secondary menu. Select Hip. 
2. Specify a unique label for the object up to 32 characters long. 
3. An optional description may be entered, up to 80 characters long. Meaningful descriptions that include size and color information will be useful 

when generating schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object walls in the Side Height text box. 
7. Enter the hip height, the vertical distance from the top of the object walls to the highest point of the peak top, in the Hip Height text box. 
8. Enter the hip length, the horizontal distance from the roof edge to the inner point on the top peak, in the Hip Length text box. 
9. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 

10. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

11. Click Ok to return to the graphics window and locate the first point of the object. Click the left mouse button. Before clicking the first point, you 
will have the opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. Then, locate the first point of the object by clicking the left mouse button. 

12. Drag the cursor to the second point on a object edge and left click again. These two points define the object's baseline. 
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13. Drag the cursor to open up the object perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 
object may be created on either side of the baseline. The hip peak will be extruded perpendicular to the specified baseline and the shorter hips 
will be located on the object edges parallel to the specified baseline.  

Rectangular Objects - Pyramid 

 

Rectangular objects with a pyramid top are distinguished by their inclined sloped surfaces whose 
four sides meet at the highest point in the center of the object. They are created in Plan view and 
may be located at any angle. The footprint of this object is located using three user defined inputs 
- two defining the object's baseline and the third indicating the object's depth. 

1. From the Add menu select Object-Rectangular-Pyramid, or from the Rooms/Objects toolbar click on the pull-down arrow to the right of the 

Object-Rectangular button . This will invoke the secondary menu. Select Pyramid. 
2. Specify a unique label for the object up to 32 characters long. 
3. An optional description may be entered, up to 80 characters long. Meaningful descriptions that include size and color information will be useful 

when generating schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object walls in the Side Height text box. 
7. Enter the pyramid height, the vertical distance from the top of the object walls to the pyramid's peak, in the Pyramid Height text box. 
8. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 

9. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

10. Click Ok to return to the graphics window and locate the first point of the object. Click the left mouse button. Before clicking the first point, you 
will have the opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. Then, locate the first point on the object by clicking the left mouse button at the desired location 

11. Drag the cursor to the second point on a object edge and left click again. These two points define the object's baseline. 
12. Drag the cursor to open up the object perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

object may be created on either side of the baseline. 
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Rectangular Objects - Vertical Extrusion 

 

Rectangular Vertical Extrusion Objects are created by specifying the object footprint in Plan View and 
the Object Profile in Elevation View. In simplest terms, the top of the object is created in Elevation 
View, with the object sides and bottom prespecified. The Object Top cannot dip below the Object 
Sides, so in some cases it may be desirable to specify the height of the sides as less than the actual 
height, to allow for some leeway when specifying the top. 

Before the object is created, its properties are specified in the Object-Rectangular-Vertical Extrusion 
dialog. These properties include a unique object label, description, wireframe color labeling options, 
side height, and surface reflectances. When the object is initially specified, all sides are assigned the 
same reflectance. You may edit the object, after creation, to assign a different reflectance (color) to 
each side individually, if desired. 

1. From the Add menu select Object-Rectangular-Vertical Extrusion, or from the Rooms/Objects toolbar click the arrow adjacent to the Object-

Rectangular button . The secondary menu will appear. Select Vertical Extrusion. 
2. Specify a unique label for the object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object sides in the Height of Sides text box. 
7. All object surfaces are assigned a color. You may change the surface colors and their corresponding reflectances by clicking in the color cell. 

The Color Selection dialog will appear allowing you to select surface colors based on user defined reflectances. To quickly assign the selected 
attributes to all surfaces, click on the Surfaces Same Attributes button. 

8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

9. Click Ok to return to the graphics window and locate the first point of the object. Click the left mouse button. Before clicking the first point, you 
will have the opportunity to change the Z coordinate of the bottom, if desired. Move the cursor into the Z-Coord text box and enter the 
appropriate value. 

10. Drag the cursor to the second point on a object edge and left click again. These two points define the object's baseline. 
11. Drag the cursor to open up the object perpendicular to the specified baseline and left click when the appropriate depth has been achieved. The 

object may be created on either side of the baseline. 

12. The current view will change automatically from Plan view to an 
Elevation view at the baseline looking into the object. The object 
bottom and sides will have already been created. Notice that the 
cursor is attached to the right object side. Locate the points in the 
top with the left mouse button. Arcs may be added at the current 
vertex by pressing the F4 key on the keyboard then clicking in the 
other endpoint and the fit point of the arc. You may undo the last 
line segment or arc in the top by clicking on the Undo button or by 
pressing Ctrl+Z on the keyboard. All of the top panels must be 
located above the sides. If your top needs to dip down, make the 
first top panel a vertical one, so that the sides are actually a little 
higher. 
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13. When you have completed creating the top, click on the right mouse button to close the object and create the surfaces. You will be returned to 
Plan view. 

Note: When specifying the profile in a non-orthogonal  Elevation view, the snap is changed to .01 and is locked at that value. This small snap setting 
ensures that the object surfaces will be created correctly. 

Round/Elliptical Objects - Cone 

 

Cone shaped objects are easily added to the job file using the Add-Object-Round/Elliptical-Cone 
command. Cones may taper up or down depending on how the object height is specified. A positive 
object height (e.g. 5) will result in a cone whose height is above the base elevation. A negative object 
height (e.g., -5) will result in a cone whose height is below the base elevation. 

Once the cone properties have been specified, the cone is created by locating the center point of cone 
base and then dragging the cursor to specify the cone's radius. 

You may truncate a cone so that it is open on both sides, or just the top, if desired. This is achieved by specifying a smaller Trim Height than Cone 
Height. 

Cones may be completely or partially circular and can have an aspect ratio other than 1 applied to them so that they are elliptical, if desired. The 
aspect ratio defines the ratio of the left-right radius relative to the top-bottom radius of the object. A ratio = 1 produces a round sphere. A ratio > 1 
produces an ellipsoidal base in the left-right direction. A ratio < 1 produces an ellipsoidal base in the top-bottom direction. 

Cones may be open or closed as necessary. Open cones may be reflective on the inside or outside as long as the object is opaque (transmission = 
0). Cones that are transmissive are automatically reflective on both sides. 

1. From the Add menu select Object-Round/Elliptical-Cone, or from the Rooms/Objects toolbar click the arrow adjacent to the Round/Elliptical 

Object button . The secondary menu will appear. Select Cone. 
2. Specify a unique label for the object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Specify the height of the cone in the Cone Height text box. Enter a positive cone height to create a cone that tapers up. Enter a negative cone 
height to create a cone that tapers down. 

  

7. To truncate a cone, enter the height from the base to the trim in the Trim Height text box. 
8. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 
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9. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

10. If the object shape is elliptical in the X or Y plane, enter the appropriate aspect ratio in the X-Y Aspect Ratio text box. The aspect ratio is 
specified as the ratio of the X radius to the Y radius. If the object is longer in the X direction, the aspect ratio will be > 1. If the object is longer in 
the Y direction than in the X, the aspect ratio is < 1. 

11. For example, to create an elliptical cone 4 feet long (diameter in the X direction) and 2 feet wide (diameter in the Y direction), an aspect ratio of 
2 would be specified. When the object X radius is prompted for a radius of 2 would be given. The resulting cone will be 4 feet long (X radius = 2) 
and 2 feet wide (Y radius = 1). 

12. To specify an open cone, click in the Open Cone selection box. Circular open cones do not have a 
base. Partially circular open cones do not have a base or vertical sides. Specify whether the cone 
is reflective on the inside or outside for open cones. 

13. Click Ok to return to the graphics window and locate the base center of the cone. Before clicking, 
you will have the opportunity to change the Z coordinate of the base, if desired. Move the cursor 
into the Z-Coord text box and enter the appropriate value. Then, click the left mouse button at the 
center of the base. 

14. Drag the cursor to specify the cone radius and left click again. Alternately, you may specify the 
radius length from the keyboard. 

15. Specify the object’s ending angle with the left mouse button. This angle determines the circular 
segment to create. Enclosed cones are created by entering an ending angle that corresponds to 
the original radius endpoint. Segmented cones are created by dragging the cursor to indicate its 
horizontal cross section. 

  

  

Round/Elliptical Objects  - Dome 

 

Round or elliptical objects with dome tops are easily specified in AGi32. The appropriate dialog is 
presented to you prompting for the object label, description, wall height, dome height, surface 
reflectances and object aspect ratio. The aspect ratio defines the ratio of the left-right radius relative to 
the top-bottom radius of the object. A ratio = 1 produces a circle. A ratio > 1 produces an ellipsoid in 
the left-right direction. A ratio < 1 produces an ellipsoid in the top-bottom direction. 

Once the specifications in the dialog have been completed, the object is created by locating the center point of the object (at floor level) and then 
dragging the cursor to specify the object's radius. 

1. From the Add menu select Object-Round/Elliptical-Dome, or from the Rooms/Objects toolbar select . Left click on the pull-down arrow 
to the right of the button to invoke the secondary menu. Select Dome. 

2. Specify a unique label for the object up to 32 characters long. 
3. An optional description may be entered, up to 80 characters long. Meaningful descriptions that include size and color information will be useful 

when generating schedules. 
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4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 
represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object walls in the Side Height text box. 
7. Enter the height of the dome (above and beyond the object side height) in the Dome Height text box. 
8. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 

9. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

10. If the object shape is elliptical, enter the appropriate aspect ratio in the X-Y Aspect Ratio text box. The aspect ratio is specified as the ratio of the 
X radius to the Y radius. If the object is longer in the X direction, the aspect ratio will be > 1. If the object is longer in the Y direction than in the X, 
the aspect ratio is < 1. 

• For example: To create an elliptical object 40 feet long (diameter in the X direction) and 20 feet wide (diameter in the Y direction), an 
aspect ratio of 2 would be specified. When the object X radius is prompted for a radius of 20 would be given. The resulting object will 
be 40 feet long (X radius = 20) and 20 feet wide (Y radius = 10). 

11. Click Ok to return to the graphics window and locate the center point of the object. Before clicking in the center point, you will have the 
opportunity to change the Z coordinate of the floor if desired. Move the cursor into the Z-Coord text box and enter the appropriate value. Click 
the left mouse button at the object’s first point. 

12. Drag the cursor to specify the X radius of the object and left click again. Alternately, you may specify the X radius from the keyboard. 

Round/Elliptical Objects - Flat 

 

Flat Round/Elliptical objects provide you with the ability to specify cylindrical objects like columns, 
tanks, barrels, tree trunks, etc. They are created with just two clicks in the graphics window; one 
specifying the center point, and the second specifying the cylinder radius. You can create elliptical 
cylinders by specifying an aspect ratio other than 1. The aspect ratio defines the ratio of the left-right 
radius relative to the top-bottom radius of the object. A ratio = 1 produces a round object. A ratio > 1 
produces an ellipsoid in the left-right direction. A ratio < 1 produces an ellipsoid in the top-bottom 
direction. 

1. From the Add menu select Object-Round/Elliptical-Flat, or from the Rooms/Objects toolbar select . 
2. Specify a unique label for the object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
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4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 
represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object sides in the Height of Sides text box. 
7. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 

8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

9. If the object shape is elliptical in the X or Y plane, enter the appropriate aspect ratio in the X-Y Aspect Ratio text box. The aspect ratio is 
specified as the ratio of the X radius to the Y radius. If the object is longer in the X direction, the aspect ratio will be > 1. If the object is longer in 
the Y direction than in the X, the aspect ratio is < 1. 

• For example, to create an elliptical column 2 feet long (diameter in the X direction) and 1 feet wide (diameter in the Y direction), an aspect ratio 
of 2 would be specified. When the object X radius is prompted for a radius of 1 would be given. The resulting column will be 2 feet long (X 
radius = 1) and 1 feet wide (Y radius = 0.5). 

10. Click Ok to return to the graphics window and locate the center point of the object. Before clicking the center point, you will have the opportunity 
to change the Z coordinate of the base, if desired. Move the cursor into the Z-Coord text box and enter the appropriate value. Click the left 
mouse button to locate the center point. 

11. Drag the cursor to specify the X radius of the object and left click again. Alternately, you may specify the X radius from the keyboard. 

Round/Elliptical Objects - Sphere 

 

Spherical objects can be created in AGi32 quickly and easily. This object type may be completely or 
partially circular and can have an aspect ratio other than 1 applied to it so that it is elliptical, if desired. 
The aspect ratio defines the ratio of the left-right radius relative to the top-bottom radius of the object. 
A ratio = 1 produces a sphere. A ratio > 1 produces an ellipsoid in the left-right direction. A ratio < 1 
produces an ellipsoid in the top-bottom direction. 

Partially circular spheres (i.e. hemispheres) may be open or closed as necessary. Open spherical 
objects may be reflective on the inside or outside, as desired. If the open sphere is transmissive, it is 
already reflective on both sides so this option is not applied. 

Once the specifications in the dialog have been completed, the object is created by locating the center 
point of the object (at the sphere’s center) and then dragging the cursor to specify the object's radius. 

1. From the Add menu select Object-Round/Elliptical-Sphere, or from the Rooms/Objects toolbar click the arrow adjacent to the Round/Elliptical 

Object button . The secondary menu will appear. Select Sphere. 
2. Specify a unique label for the object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 

5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 
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6. Specify the height of the object: 

• To create a spherical shape, select the Height (from center point) 
= Radius radio button 

 

• To create an elongated spheroid in the Z direction enter the 
desired height (1/2 the total height) in the Height (from center 
point) = text box. 

 

7. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 
may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. 

8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

9. If the object shape is elliptical in the X or Y plane, enter the appropriate aspect ratio in the X-Y Aspect Ratio text box. The aspect ratio is 
specified as the ratio of the X radius to the Y radius. If the object is longer in the X direction, the aspect ratio will be > 1. If the object is longer in 
the Y direction than in the X, the aspect ratio is < 1. 

• For example, to create an elliptical spheroid 10 feet long (diameter in the X direction) and 5 feet wide (diameter in the Y direction), an aspect 
ratio of 2 would be specified. When the object X radius is prompted for a radius of 5 would be given. The resulting object will be 10 feet long (X 
radius = 5) and 5 feet wide (Y radius = 2.5). Note: if the Radius = Height radio button was selected, the object’s height would be 10 feet. 
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10. Partially circular 
spheroids may be open 
or closed. To specify an 
open sphere, click in the 
Open Sphere selection 
box. 

 

11. If an open sphere was created, specify which side of the open sphere is reflective. 
12. Click Ok to return to the graphics window and locate the center point of the object. Before clicking in the center point, you will have the 

opportunity to change the Z coordinate of the center, if desired. Move the cursor into the Z-Coord text box and enter the appropriate value. 
Then, click the left mouse button at the object’s center location. 

13. Drag the cursor to specify the radius of the object and left click again. Alternately, you may specify the radius length from the keyboard. 
14. Specify the object’s ending angle with the left mouse button. This angle determines the circular segment to create. Whole spheres are created 

by entering an ending angle that corresponds to the original radius endpoint. Segmented spheres are created by dragging the cursor to indicate 
its horizontal cross section. 

Round/Elliptical Objects - Vertical Rotation 

  

Vertical Rotation objects are created by specifying the circular or semi-circular object footprint in Plan View and the Object Profile in Elevation view. 
When creating the profile, the bottom and sides are already created for you; you need only specify the shape of the object top. The Object Top 
cannot dip below the Object Sides, so in some cases it may be desirable to specify the height of the sides as less than the actual height, to allow for 
some leeway when specifying the top. To create a column with protrusions at the top and bottom, specify the height of the object sides as some 
small distance (e.g. 0.05 ft), then create the column profile. 

Before the object is created, its properties are specified in the Object-Round/Elliptical-Vertical Rotation dialog. These properties include a unique 
object label, description, wireframe color, labeling options, side height, and surface reflectances. When the object is initially specified, the top, sides 
and bottom are assigned the same reflectances. You may edit the object, after creation, to assign a different reflectance (color) to each surface 
individually, if desired. 

1. From the Add menu select Object-Round/Elliptical-Vertical Rotation, or from the Rooms/Objects toolbar click the arrow adjacent to the 

Object-Round/Elliptical button . The secondary menu will appear. Select Vertical Rotation. 
2. Specify a unique label for the object up to 32 characters long. 
3. If desired, a description may be entered, up to 80 characters long. Meaningful descriptions including size and color will be useful for schedules. 
4. The object will be created in AGi32 using the selected Wire Frame Color. This color is not used in AGi32's Render mode, it is only used to 

represent the object's shape in the graphics window. By default, this color is blue. To change it, click in the color cell. The Color dialog will 
appear for your use. 
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5. If surface labeling is desired, click on the Labeling button. A separate dialog will appear for specification of text labels for the object and/or its 
surfaces. 

6. Enter the height of the object sides in the Height of Sides text box. 
7. All object surfaces are assigned a color. By default, the surfaces are assigned a shade of gray corresponding to a reflectance value of 0.5. You 

may change the surface colors and their corresponding reflectances by clicking in the color cell. The Color Selection dialog will appear allowing 
you to select surface colors based on user defined reflectances. To quickly assign the selected attributes to all surfaces, click on the Surfaces 
Same Attributes button. 

8. You may assign a texture to the surface by clicking in the Texture cell. The Select Texture dialog will appear so that you may choose a texture 
from the Textures database. Alternately, you may browse for a texture anywhere on your system or assign a texture already in use on another 
surface in the job file. Once the desired texture is selected, you'll determine how the texture should be applied to the surface. Textures may be 
stretched across the entire surface, applied in a grid pattern or assigned a Static size (representing real dimensions) and tiled on the surface 
accordingly. In addition, you may opt to rotate the texture on the surface. 

To delete a texture from the surface, Ctrl-click in the Texture cell and select the Delete key on your keyboard. When a texture is deleted from 
a surface, its correlated color and reflectance are used as the current color and reflectance. 

• To apply additional surface properties (such as Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) to any of the object surfaces, you must first position the object in the environment. Then, either Edit the 
object and select the Surface Edit button in the Edit dialog or use the Edit Surface command to select the object. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may only be removed from an object after it has been initially located in the environment. Surfaces may be removed 
by Editing the object and selecting the Surface Edit button in the Edit dialog or using the Edit Surface command once it has been 
placed. 

9. Click Ok to return to the graphics window and locate the first point of the object. Click the left mouse button. Before clicking the first point, you 
will have the opportunity to change the Z coordinate of the base, if desired. Move the cursor into the Z-Coord text box and enter the appropriate 
value. Then, click the left mouse button to locate the center point of the object base. 

10. Drag the cursor to specify the object’s radius and left click again. These two points define the object baseline. Alternatively, you may enter the 
object radius from the keyboard. 

11. Specify the object’s ending angle with the left 
mouse button. This angle determines the 
circular segment to create. Circular objects are 
created by entering an ending angle that 
corresponds to the original radius endpoint. 
Segmented objects are created by dragging 
the cursor to indicate its horizontal cross 
section. 

 

12. The current view will change automatically 
from Plan view to an Elevation view at the 
baseline looking into the object. The object 
bottom and sides will have already been 
created. Notice that the cursor is attached to 
the right object side. Locate the points in the 
top with the left mouse button. Arcs may be 
added at the current vertex by pressing the F4 
key on the keyboard then clicking in the other 
endpoint of the arc. You may undo the last line 
segment or arc in the top by clicking on the 
Undo button or by pressing Ctrl+Z on the 
keyboard. All of the top panels must be located 
above the sides. If your top needs to dip down, 
make the first top panel a vertical one, so that 
the sides are actually a little higher. 

 



AGi32 Help System  Adding Entities 

136 

 

13. When you have completed creating the top, click on the right mouse button to close the object and create the surfaces. You will be returned to 
Plan view. 

Note: When specifying the profile in a non orthogonal  Elevation view, the snap is changed to .01 and is locked at that value. This small snap setting 
ensures that the object surfaces will be created correctly. 

   

 

 Adding Calculations 

Adding Calculation Points 

Calculation points allow you to quantify your results in GI32 using discreet light meter positions. 

What type of Calculations would you like to add? 

Add Automatic Placement Calculations to Room or Object Surfaces 

Add a 2 Point Calculation Grid 

Add a 3 Point Calculation Grid 

Add Lines of Calculation Points 

Add a Calculation Polygon 

Add Scattered Calculation Points 

Add Glare Rating Calculation Grids 

Add a Daylight Factor Calculation Polygon 

Add UGR Calculation Grids 

Add Roadway Luminance Calculation Grids 

Calculation Points Concepts 

Calculation points are positioned  in the environment, to represent light meters. You may quantify numerous types of metrics depending on the grid 
type and analysis option that you select. Metrics available in AGi32 include: 

Illuminance - incident light 

The Illuminance metric measures the light incident on a surface or workplane -  measured in Footcandles or Lux. Illuminance measurements may be 
made in Full Calculation mode or Direct Calculation mode. Depending on the calculation mode selected and model, Illuminance measurements may 
reflect direct and interreflected contributions. The following Calculation types measure Illuminance (some in conjunction with other metrics): 

• 2 Point and 3 Point Calculation Grids 

• Automatic Placement points 

• Lines of Calculation points 

• Scattered Calculation points 

• Daylight Factor includes Illuminance option 

• Roadway Luminance includes Illuminance option 

Exitance - reflected light 

The Exitance metric measures the light reflected off a surface - measured in lumens per square foot or lumens per square meter. Exitance 
measurements are only available in Full Calculation mode. The Exitance measurements may reflect direct and interreflected contributions depending 
on the model. Exitance may be measured by using the Automatic Placement Calculation type and selecting a real, reflective surface. 

Luminance - reflected light 

The diffuse Luminance metric measures the light reflected off a surface - contained within a volumetric cone with the volume PI. It is measured in 
candelas per square meter. Diffuse Luminance measurements are only available in Full Calculation mode. The Luminance measurements may 
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include both direct and interreflected contributions incident on the measured surface depending on the model. Diffuse Luminance may be measured 
by using the Automatic Placement Calculation type and selecting a real, reflective surface. 

Daylight Factor 

The Daylight Factor metric (DF) measures the ratio of illuminance on a plane in the environment (usually the horizontal working plane) as it 
compares  to the measured illuminance produced by an unobstructed sky. The result is given as a percentage value (e.g. 75%  of the daylight is 
reaching this point)  Daylight Factor measurements are only available in Full Calculation mode. These measurements may reflect direct contribution 
from the sky and interreflected contributions from the model. 

• DF is usually calculated with Overcast skies. Direct Sunlight is excluded from the calculations. 

• Electric Lighting is also excluded from the calculations. 

UGR - Unified Glare Rating - Discomfort Glare measurement for electric lighting 

The Unified Glare Rating metric (UGR) measures discomfort glare from electric lighting in an interior environment. The calculation considers the ratio 
of luminaire luminance and position compared to the background luminance of the environment. The result in given as a UGR value between 10 and 
30, where a high value indicates significant discomfort glare and a low value indicates little discomfort glare. UGR measurements are only available 
in Full Calculation mode. 

Roadway Metrics - Pavement Luminance, Illuminance, Veiling Luminance and STV 

The Roadway Luminance metrics allow you to create a linear stretch of roadway on which to measure a variety of calculation types. The calculations 
are performed in accordance with IESNA or CIE guidelines, whichever the user specifies. Roadway Luminance measurements are available in Full 
Calculation and Direct Calculation mode. The following metrics are available: 

• Pavement Luminance 

• Illuminance 

• Veiling Luminance 

• STV (IES criteria) 

• Relative Threshold Increment (for Veiling Luminance) 

• Maximum Veiling Luminance Ratio (Lv/Lp, average) 

• Longitudinal Uniformity Ratio 

The Roadway Luminance metric also allows you to create a linear stretch of roadway to be used in conjunction with an interior environment or other 
contributing surfaces. 

Glare Rating - Disability Glare measurement for electric lighting (direct component only) 

The Glare Rating metric (GR) measures disability glare from electric lighting in an exterior environment. The calculation considers the effect of veiling 
luminance produced by the luminaires as compared to the background luminance of a specified ground plane for an observer within the illuminated 
plane. The result in given as a GR value between 10 and 90, where a high value indicates significant disability glare and a low value indicates little 
disability glare. GR measurements are available in Full Calculation or Direct Calculation mode. 

Dialog Defaults 

The individual parameters available in all Calculation Point dialogs are automatically saved and restored in the Calculation Point dialogs. There are 
two types of defaults present in all of the dialogs: Global and Local. Global defaults occur in every Calculation Point dialog and carry over to other 
Calculation Point dialogs as well. Local defaults only occur in specific dialogs. The following defaults are global for all Calculation Point commands. 

• Label: Default Label is CalcPts, CalcPtsRoadLum, CalcPtsGR, CalcPtsUGR and CalcPtsDF. The Label name will automatically increment to 
produce unique labels. For example, if the first calculation entity is labeled CalcPts, the second is labeled CalcPts_1. When the default label is 
changed, it will also automatically increment. 

• Point Spacing Left to Right (LR) and Top to Bottom (TB). Note Point spacing for Roadway Luminance is local. 

• Text Size 

• Center points relative to grid boundaries 

• Light meter 

• Numerical Analysis 

• Display options including Labeling options 
• Z coordinates - 1st and 2nd points 

Reset Defaults - Selecting this button will reset all Global dialog parameters to the factory defined specifications. 

Modifying Calculation points 

Once placed in the environment you can modify calculation points in many ways. Here are the available options: 
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• Move calculation points to a different location 

• Delete calculation points 

• Edit calculation points - modify name, point spacing, numerical analysis options, color, precision, font and text size. 

• Remove calculation points - mask out specified points within grid or polygon 

• Replace calculation points - remove erroneously masked points 

• Label calculation points 

• Project Manager - Manage calculation points Visibility, Calculation Status and associated Views 

• Isolines - Display Iso contours for various metrics to illustrate the uniformity present in the calculations. 

• Highlight Values - Shade the point values in specified ways to indicate the maximum, minimum and value ranges for various metrics. 

Other analysis options 

• Statistical Areas - Choose numerical analysis options for a specified area within a calculation grid or encompassing multiple calculation grids. 

• LPD Areas - Calculate Lighting Power Density statistics within a user specified polygon (e.g. a room). Results are given in Watts/square foot 
and Watts/square meter. 

• Psuedocolor Scaling - Display the luminance gradient or Illuminance gradient using a false color scale in Render mode. This option is much 
like a 3D point by point on all surfaces. 

Isoline Concepts 

Isolines are lines of equal value (e.g. Illuminance, Exitance, Luminance, etc.) that are used to provide contouring capabilities for calculated grids and 
polygons. They differ from Luminaire Templates in the following ways: 

• Isolines are generated from calculated points (direct and interreflected light) as opposed to the Direct contribution of Luminaire Templates. 

• Calculated values, and derived Isolines, are responsive to all environmental conditions - multiple luminaires and surfaces, not just one luminaire 
or arrangement as are Templates. 

The Isolines are derived by linearly interpolating the values between adjacent points. If the point density is not fine enough to pick up a low spot or 
spike, the Isolines will not be able to display that value either, however, increasing your point density is not necessarily required unless you have a 
non uniform lighting design. 

When multiple calculation grids or polygons are visible, each grid and/or polygon will have its own Isolines displayed. You may specify the Isoline 
contour values at any time, however, they will not be displayed until the calculation grid or polygon has been calculated. 

Isoline Labels 

Each Isoline contour may be labeled with its associated value. The label increment refers to the distance between text labels. Labels are only 
displayed at the endpoints of Isolines, regardless of the overall length of the Isoline. Consequently, the actual applied increment will vary and will 
generally be longer than the specified increment value. 

Isoline Values 

AGi32 allows up to 12 Isoline values for each calculation type. You may enter the values in any order (ascending, descending, random). Not all cells 
must be used. Blank cells have a zero value assigned to them. This allows you to correlate specific values with a particular color (e.g. low values - 
cool tones, high values, warm tones). 

In addition, if the current colors are not to your liking, additional colors are available. Click in the appropriate color cell and choose an alternate color. 
Your selected colors and values will be maintained for the remainder of the current session and saved with your job file. 

Adding Isolines 

Isolines provide a contour "map" of Illuminance , Exitance, Glare Rating (GR) and Unified Glare Rating (UGR), Luminance  (Diffuse and Roadway), 
Daylight Factor, Veil Ing Luminance,  and Visibility Level (for STV) values. Isolines are global and, once defined, will apply to every calculation entity 
in the job file. Specifying Exitance, Glare, Luminance, Veiling Luminance and Visibility Level Isolines where these values have not been calculated 
will have no effect. 

What type of Isolines would you like to display? 

Add Illuminance Isolines 

1. From the Add menu, choose Calculations - Isolines or, from the Calculations toolbar, select  
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2. To turn the Isoline values on (so they appear in the job file), click in the selection box adjacent to Isolines For Illuminance Values. Isolines may 
be created at any time, and switched off, by clearing this option. Selecting this option will cause Isolines to be displayed for any type of 
Illuminance that has been calculated: horizontal, vertical, surround, semi-cylindrical, and/or hemispherical. 

3. The default line width for Isolines is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). 
4. To label the Isolines with their corresponding values, click in the selection box adjacent to Label Isolines. Specify the distance between label 

occurrences (in ft. or m) in the Increment text box and the label size (in ft. or m) in the Text Size box. To show just one label per Isoline, enter an 
increment value of 1000 (default value). 

5. Enter the illuminance values (FC or Lux) that will define the Isolines. It is not necessary to fill in all of the Isoline Value boxes or indicate the 
values in any particular order. Only positive values are used (empty boxes have a zero value). When specifying Isolines, it is possible to match 
a particular value to a particular color. 

For Example: If only one blue Isoline is desired, indicate the appropriate value to the left of the Blue colored box. 

6. You may also change the color associated with an Isoline value by clicking in the adjacent color box, and selecting an alternate color. 
7. Click Ok. 

Add Exitance Isolines 

1. From the Add menu, choose Calculations -Isolines or, from the Calculations toolbar, select  
2. Click on the Exitance tab. 
3. To turn the Isoline values on (so they appear in the job file) click in the selection box adjacent to Isolines For Exitance Values. Isolines may be 

created at any time, and switched off, by clearing this option. 
4. The default line width for Isolines is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). 
5. To label the Isolines with their corresponding values, click in the selection box adjacent to Label Isolines. Specify the distance between label 

occurrences (in ft. or m) in the Increment text box and the label size (in ft. or m) in the Text Size box. To show just one label per Isoline, enter an 
increment value of 1000 (default value). 

6. Enter the Exitance values (lumens/sq. ft. or lumens/sq. m) that will define the Isolines. It is not necessary to fill in all of the Isoline Value boxes 
or indicate the values in any particular order. Only positive values are used (empty boxes have a zero value). When specifying Isolines, you can 
match a particular value to a particular color. 

For Example: If only one blue Isoline is desired, indicate the appropriate value to the left of the Blue colored box. 

7. You may also change the color associated with an Isoline value by clicking in the adjacent color box, and selecting an alternate color. 
8. Click Ok 

Add Luminance Isolines 

The Luminance tab will create Isolines for the following commands: Roadway Luminance (Pavement Luminance) and Luminance, diffuse - available 
from the CalcPts - Automatic Placement command. 

1. From the Add menu, choose Calculations -Isolines or, from the Calculations toolbar, select  
2. Click on the Luminance tab. 
3. To turn the Isoline values on (so they appear in the job file) click in the selection box adjacent to Isolines For Luminance Values. Isolines may be 

created at any time, and switched off, by clearing this option. Selecting this option will cause Isolines to be displayed for any type of Luminance 
that has been calculated: diffuse, roadway, background, and target luminance, as well as longitudinal uniformity. 

4. The default line width for Isolines is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). 
5. To label the Isolines with their corresponding values, click in the selection box adjacent to Label Isolines. Specify the distance between label 

occurrences (in ft. or m) in the Increment text box and the label size (in ft. or m) in the Text Size box. To show just one label per Isoline, enter an 
increment value of 1000 (default value). 

6. Enter the Luminance values (candelas/sq. m) that will define the Isolines. It is not necessary to fill in all of the Isoline Value boxes or indicate the 
values in any particular order. Only positive values are used (empty boxes have a zero value). When specifying Isolines, you can match a 
particular value to a particular color. 

For Example: If only one blue Isoline is desired, indicate the appropriate value to the left of the Blue colored box. 

7. You may also change the color associated with an Isoline value by clicking in the adjacent color box, and selecting an alternate color. 
8. Click Ok 

Add Daylight Factor Isolines 

1. From the Add menu, choose Calculations -Isolines or, from the Calculations toolbar, select  
2. Click on the Daylight Factor tab. 
3. To turn the Isoline values on (so they appear in the job file) click in the selection box adjacent to Isolines For Daylight Factor Values. Isolines 

may be created at any time, and switched off, by clearing this option. 
4. The default line width for Isolines is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). 
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5. To label the Isolines with their corresponding values, click in the selection box adjacent to Label Isolines. Specify the distance between label 
occurrences (in ft. or m) in the Increment text box and the label size (in ft. or m) in the Text Size box. To show just one label per Isoline, enter an 
increment value of 1000 (default value). 

6. Enter the DF values that will define the Isolines. It is not necessary to fill in all of the Isoline Value boxes or indicate the values in any particular 
order. Only positive values are used (empty boxes have a zero value). When specifying Isolines, you can match a particular value to a particular 
color. 

For Example: If only one blue Isoline is desired, indicate the appropriate value to the left of the Blue colored box. 

7. You may also change the color associated with an Isoline value by clicking in the adjacent color box, and selecting an alternate color. 
8. Click Ok. 

Add GR (Glare Rating) or UGR (Unifed Glare Rating) Isolines 

1. From the Add menu, choose Calculations -Isolines or, from the Calculations toolbar, select  
2. Click on the GR/UGR tab. 
3. To turn the Isoline values on (so they appear in the job file) click in the selection box adjacent to Isolines For GR/UGR Values. Isolines may be 

created at any time, and switched off, by clearing this option. 
4. The default line width for Isolines is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). 
5. To label the Isolines with their corresponding values, click in the selection box adjacent to Label Isolines. Specify the distance between label 

occurrences (in ft. or m) in the Increment text box and the label size (in ft. or m) in the Text Size box. To show just one label per Isoline, enter an 
increment value of 1000 (default value). 

6. Enter the GR/UGR values that will define the Isolines. It is not necessary to fill in all of the Isoline Value boxes or indicate the values in any 
particular order. Only positive values are used (empty boxes have a zero value). When specifying Isolines, you can match a particular value to a 
particular color. 

For Example: If only one blue Isoline is desired, indicate the appropriate value to the left of the Blue colored box. 

7. You may also change the color associated with an Isoline value by clicking in the adjacent color box, and selecting an alternate color. 
8. Click Ok. 

Add Veiling Luminance Isolines 

1. From the Add menu, choose Calculations -Isolines or, from the Calculations toolbar, select  
2. Click on the Veiling Luminance tab. 
3. To turn the Isoline values on (so they appear in the job file) click in the selection box adjacent to Isolines For Veiling Luminance Values. Isolines 

may be created at any time, and switched off, by clearing this option. 
4. The default line width for Isolines is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). 
5. To label the Isolines with their corresponding values, click in the selection box adjacent to Label Isolines. Specify the distance between label 

occurrences (in ft. or m) in the Increment text box and the label size (in ft. or m) in the Text Size box. To show just one label per Isoline, enter an 
increment value of 1000 (default value). 

6. Enter the Veiling Luminance values (cd/square meter) that will define the Isolines. It is not necessary to fill in all of the Isoline Value boxes or 
indicate the values in any particular order. Only positive values are used (empty boxes have a zero value). When specifying Isolines, you can 
match a particular value to a particular color. 

For Example: If only one blue Isoline is desired, indicate the appropriate value to the left of the Blue colored box. 

7. You may also change the color associated with an Isoline value by clicking in the adjacent color box, and selecting an alternate color. 
8. Click Ok. 

Add Visibility Level Isolines 

1. From the Add menu, choose Calculations -Isolines or, from the Calculations toolbar, select  
2. Click on the Visibility Level tab. 
3. To turn the Isoline values on (so they appear in the job file) click in the selection box adjacent to Isolines For Visibility Level Values. Isolines may 

be created at any time, and switched off, by clearing this option. 
4. The default line width for Isolines is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). 
5. To label the Isolines with their corresponding values, click in the selection box adjacent to Label Isolines. Specify the distance between label 

occurrences (in ft. or m) in the Increment text box and the label size (in ft. or m) in the Text Size box. To show just one label per Isoline, enter an 
increment value of 1000 (default value). 

6. Enter the Visibility Level values that will define the Isolines. It is not necessary to fill in all of the Isoline Value boxes or indicate the values in any 
particular order. You may specify positive, negative and zero values (empty boxes are ignored). When specifying Isolines, you can match a 
particular value to a particular color. 

For Example: If only one blue Isoline is desired, indicate the appropriate value to the left of the Blue colored box. 
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7. You may also change the color associated with an Isoline value by clicking in the adjacent color box, and selecting an alternate color. 
8. Click Ok. 

Note: To clear all of the existing values at once, click on the Clear Values button.  

Highlight Values - Concepts 

Ranges of Highlight Values can be assigned to replace the defined text color of all calculation entities provided in AGi32. These ranges are extremely 
useful to designers to evaluate which points fall above or below target values. In addition, the Highlight Values dialog allows for the specification of 
global colors for each of the maximum and minimum values for each metric. 

The last accessed tab is saved and recalled when the dialog is recalled in the current session. 

Value Ranges 

By default, you are provided with up to 5 customizable value ranges, using a grayscale palette. When specifying Highlight Values, you match a 
particular range to a particular shade. Values corresponding to lower ranges, can be linked to the darker grayscale colors, to indicate lower light 
levels. Conversely, values corresponding to higher ranges, can be linked to the lighter colors, to indicate higher light levels. It is not necessary to fill 
in all of the Value Ranges boxes or indicate the values, between ranges, in any particular order. Only positive values are used for all tabs except 
Visibility Level (STV), empty boxes are ignored. In the Visibility Level tab you may specify positive, negative or zero values, empty boxes are ignored. 

You may specify alternate colors for all of the color options in the Highlight Values dialog. 

Foreground vs. Background 

The Highlight Value color may be applied to the text itself (Foreground) or to a box behind the text (Background). At smaller Zoom Levels, the 
Background Color options provides an easier way of seeing the highlighted values. 

Foreground Color 

 

Background Color 

 

Uniformity Gradient 

Uniformity Gradient (UG) is typically used to measure uniformity in sports lighting applications, however it can be used to measure the rate of change 
for any calculated metric. This metric measures how fast the values falls off between measuring points. Specifically, the UG measures the rate of 
change of values between adjacent measuring points, side to side, up, down or diagonal. The rate of change is weighed by the distance between the 
points (the greater the distance, the less rate of change).The UG value is expressed as a ratio of values.  

The reported UG value indicates the highest ratio or greatest rate of change.  

Highlight Values 

The Highlight Values command allows you to highlight calculation values that fall within user defined target ranges, including: Illuminance, 
Exitance,Glare Rating (GR) and Unified Glare Rating (UGR), Luminance, Veiling Luminance, Daylight Factor, and Visibility Level (for STV) values. 
This option allows you to immediately see which calculation points fall above or below your design criteria. Specifying Exitance, Glare, Luminance, 
Veiling Luminance and Visibility Level Isolines where these values have not been calculated will have no effect. 

 In addition, you may specify the global color that will be applied to each of the maximum and minimum calculation values 

You may also change the color associated with any range by clicking in the adjacent color box, and selecting an alternate color. This option allows 
you to specify Highlight Values using a color palette, if desired, instead of a grayscale palette. 

What do you want to do? 

Specify Illuminance Highlight Values 

1. From the Modify menu choose Calculations -Highlight Values, or from the Calculations toolbar select . 
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2. To turn the Highlight Values on, click in the selection box adjacent to Highlight Illuminance Values. Highlight Values may be specified at any 
time, and switched off, by clearing this option. Selecting this option will cause Highlighted Values to be displayed for any type of Illuminance that 
has been calculated: horizontal, vertical, surround, semi-cylindrical, and/or hemispherical. 

3. The Highlight color may be applied to the foreground (text color changes) or background (highlight color is applied to text box encompassing 
text, like a highlight marker). The default option is Foreground. 

4. To apply a Highlight color for the maximum and minimum illuminance values, click in the selection box adjacent to Maximum and/or Minimum. 
You may change their corresponding colors by clicking in the color box and selecting an alternate color. 

5. To apply a Highlight color to the values exhibiting the maximum Uniformity Gradient, click in the selection box adjacent to Uniformity Gradient. 
You may change the corresponding color by clicking in the color box and selecting an alternate color. The default color is Green. 

• Note: Uniformity Gradient will only be highlighted if Uniformity gradient is included in the Calculation Summary (specified when creating 
or editing a calculation area). 

6. To specify value ranges, click in the selection box adjacent to the desired value range section. 

• In the left most text box, enter the target minimum illuminance value for this range. In the right most box, enter the illuminance value 
corresponding to the target maximum value for this range. 

• You may also change the color associated with this range by clicking in the adjacent color box, and selecting an alternate color. 

• You may continue specifying highlight value ranges in this manner up to 5 different ranges, by following steps 5 and 6. 
7. Click Ok to return to AGi32 with the selected highlights. 

Specify Exitance Highlight Values 

1. From the Modify menu choose Calculations -Highlight Values, or from the Calculations toolbar select . 
2. Click on the Exitance tab to bring it to the forefront. 
3. To turn the Highlight Values on, click in the selection box adjacent to Highlight Exitance Values. Highlight Values may be specified at any time, 

and switched off, by clearing this option. 
4. The Highlight color may be applied to the foreground (text color changes) or background (highlight color is applied to text box encompassing 

text, like a highlight marker). The default option is Foreground. 
5. To apply a Highlight color for the maximum and minimum Exitance values, click in the selection box adjacent to Maximum and/or Minimum. You 

may change their corresponding colors by clicking in the color box and selecting an alternate color. 
6. To apply a Highlight color to the values exhibiting the maximum Uniformity Gradient, click in the selection box adjacent to Uniformity Gradient. 

You may change the corresponding color by clicking in the color box and selecting an alternate color. The default color is Green. 

• Note: Uniformity Gradient will only be highlighted if Uniformity gradient is included in the Calculation Summary (specified when creating 
or editing a calculation area). 

7. To specify value ranges, click in the selection box adjacent to the desired value range section. 

• In the left most text box, enter the target minimum Exitance value for this range. In the right most box, enter the Exitance value 
corresponding to the target maximum value for this range. 

• You may also change the color associated with this range by clicking in the adjacent color box, and selecting an alternate color. 

• You may continue specifying Exitance highlight value ranges in this manner up to 5 different ranges, by following steps 6 and 7. 
8. Click Ok to return to AGi32 with the selected highlights. 

Specify Glare Rating (GR) and/or Unified Glare Rating (UGR) Highlight Values 

1. From the Modify menu choose Calculations -Highlight Values, or from the Calculations toolbar select . 
2. Click on the GR/UGR tab to bring it to the forefront. 
3. To turn the Highlight Values on, click in the selection box adjacent to Highlight GR/UGR Values. GR/UGR Highlight Values may be specified at 

any time, and switched off, by clearing this option. 
4. The Highlight color may be applied to the foreground (text color changes) or background (highlight color is applied to text box encompassing 

text, like a highlight marker). The default option is Foreground. 
5. To apply a Highlight color for the maximum and minimum GR/UGR values, click in the selection box adjacent to Maximum and/or Minimum. You 

may change their corresponding colors by clicking in the color box and selecting an alternate color. 
6. To apply a Highlight color to the values exhibiting the maximum Uniformity Gradient, click in the selection box adjacent to Uniformity Gradient. 

You may change the corresponding color by clicking in the color box and selecting an alternate color. The default color is Green. 

• Note: Uniformity Gradient will only be highlighted if Uniformity gradient is included in the Calculation Summary (specified when creating 
or editing a calculation area). 

• Uniformity Gradient is only available for Glare rating calculation areas. 
7. To specify value ranges, click in the selection box adjacent to the desired value range section. 

• In the left most text box, enter the target minimum GR/UGR value for this range. In the right most box, enter the GR/UGR value 
corresponding to the target maximum value for this range. 

• You may also change the color associated with this range by clicking in the adjacent color box, and selecting an alternate color. 

• You may continue specifying GR/UGR highlight value ranges in this manner up to 5 different ranges, by following steps 6 and 7. 
8. Click Ok to return to AGi32 with the selected highlights. 

Specify Luminance Highlight Values 

The Luminance tab will create specify highlighting for the following commands: Roadway Luminance (Pavement Luminance) and Luminance, diffuse 
- available from the CalcPts - Automatic Placement command. 

1. From the Modify menu choose Calculations -Highlight Values, or from the Calculations toolbar select . 
2. Click on the Luminance tab to bring it to the forefront. 
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3. To turn the Highlight Values on, click in the selection box adjacent to Highlight Luminance Values. Luminance Highlight Values may be specified 
at any time, and switched off, by clearing this option. 

4. The Highlight color may be applied to the foreground (text color changes) or background (highlight color is applied to text box encompassing 
text, like a highlight marker). The default option is Foreground. 

5. To apply a Highlight color for the maximum and minimum Luminance values, click in the selection box adjacent to Maximum and/or Minimum. 
You may change their corresponding colors by clicking in the color box and selecting an alternate color. 

6. To apply a Highlight color to the values exhibiting the maximum Uniformity Gradient, click in the selection box adjacent to Uniformity Gradient. 
You may change the corresponding color by clicking in the color box and selecting an alternate color. The default color is Green. 

• Note: Uniformity Gradient will only be highlighted if Uniformity gradient is included in the Calculation Summary (specified when creating 
or editing a calculation area). 

7. To specify value ranges, click in the selection box adjacent to the desired value range section. 

• In the left most text box, enter the target minimum Luminance value for this range. In the right most box, enter the Luminance value 
corresponding to the target maximum value for this range. 

• You may also change the color associated with this range by clicking in the adjacent color box, and selecting an alternate color. 

• You may continue specifying Luminance highlight value ranges in this manner up to 5 different ranges, by following steps 6 and 7. 
8. Click Ok to return to AGi32 with the selected highlights. 

Specify Veiling Luminance Highlight Values 

1. From the Modify menu choose Calculations -Highlight Values, or from the Calculations toolbar select . 
2. Click on the Veiling Luminance tab to bring it to the forefront. 
3. To turn the Highlight Values on, click in the selection box adjacent to Highlight Veiling Luminance Values. Veiling Luminance Highlight Values 

may be specified at any time, and switched off, by clearing this option. Selecting this option will cause Highlighted Values to be displayed for 
any type of Luminance that has been calculated: diffuse, roadway, background, and target luminance, as well as longitudinal uniformity. 

4. The Highlight color may be applied to the foreground (text color changes) or background (highlight color is applied to text box encompassing 
text, like a highlight marker). The default option is Foreground. 

5. To apply a Highlight color for the maximum and minimum Veiling Luminance values, click in the selection box adjacent to Maximum and/or 
Minimum. You may change their corresponding colors by clicking in the color box and selecting an alternate color. 

6. To apply a Highlight color to the values exhibiting the maximum Uniformity Gradient, click in the selection box adjacent to Uniformity Gradient. 
You may change the corresponding color by clicking in the color box and selecting an alternate color. The default color is Green. 

• Note: Uniformity Gradient will only be highlighted if Uniformity gradient is included in the Calculation Summary (specified when creating 
or editing a calculation area). 

7. To specify value ranges, click in the selection box adjacent to the desired value range section. 

• In the left most text box, enter the target minimum Veiling Luminance value for this range. In the right most box, enter the Veiling 
Luminance value corresponding to the target maximum value for this range. 

• You may also change the color associated with this range by clicking in the adjacent color box, and selecting an alternate color. 

• You may continue specifying Veiling Luminance highlight value ranges in this manner up to 5 different ranges, by following steps 6 and 
7. 

8. Click Ok to return to AGi32 with the selected highlights. 

Specify Visibility Level Highlight Values 

1. From the Modify menu choose Calculations -Highlight Values, or from the Calculations toolbar select . 
2. Click on the Visibility Level tab to bring it to the forefront. 
3. To turn the Highlight Values on, click in the selection box adjacent to Highlight Visibility Level Values. Visibility Level Highlight Values may be 

specified at any time, and switched off, by clearing this option. 
4. The Highlight color may be applied to the foreground (text color changes) or background (highlight color is applied to text box encompassing 

text, like a highlight marker). The default option is Foreground. 
5. To apply a Highlight color for the maximum and minimum Visibility Level values, click in the selection box adjacent to Maximum and/or 

Minimum. You may change their corresponding colors by clicking in the color box and selecting an alternate color. 
6. To specify value ranges, click in the selection box adjacent to the desired value range section. 

• In the left most text box, enter the target minimum Visibility Level value for this range. In the right most box, enter the Visibility Level 
value corresponding to the target maximum value for this range. For example, to display negative contrast visibility levels, you may 
want to enter a range from –20 to 0. 

• You may also change the color associated with this range by clicking in the adjacent color box, and selecting an alternate color. 

• You may continue specifying Visibility Level highlight value ranges in this manner up to 5 different ranges, by following steps 6 and 7. 
7. Click Ok to return to AGi32 with the selected highlights. 

Specify Daylight Factor Highlight Values 

1. From the Modify menu choose Calculations -Highlight Values, or from the Calculations toolbar select . 
2. Click on the Daylight Factor tab to bring it to the forefront. 
3. To turn the Highlight Values on, click in the selection box adjacent to Highlight Daylight Factor Values. Daylight Factor Highlight Values may be 

specified at any time, and switched off, by clearing this option. 
4. The Highlight color may be applied to the foreground (text color changes) or background (highlight color is applied to text box encompassing 

text, like a highlight marker). The default option is Foreground. 
5. To apply a Highlight color for the maximum and minimum Daylight Factor values, click in the selection box adjacent to Maximum and/or 

Minimum. You may change their corresponding colors by clicking in the color box and selecting an alternate color. 
6. To specify value ranges, click in the selection box adjacent to the desired value range section. 
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• In the left most text box, enter the target minimum Daylight Factor value for this range. In the right most box, enter the Daylight Factor 
value corresponding to the target maximum value for this range. For example, to display all daylight factor values less than 2%, you 
may want to enter a range from 0 to 1.99. 

• You may also change the color associated with this range by clicking in the adjacent color box, and selecting an alternate color. 

• You may continue specifying Daylight Factor highlight value ranges in this manner up to 5 different ranges, by following steps 6 and 7. 
7. Click Ok to return to AGi32 with the selected highlights. 

How is Highlight Color applied? 

Highlight Values - Foreground Color 

When the Foreground option is selected, the highlight color is applied to the text. Highlight Value colors are included in AGi32's exported CAD output 
- text is highlighted. 

 

Highlight Values - Background Color 

When the Background option is selected, the highlight color is applied to a box encompassing the text, much like marking the text with a highlighter. 
Highlight Value colors are included in AGi32's exported CAD output - only text is highlighted (e.g. foreground). 

 

Statistical Area Concepts 

Statistical Areas are user defined polygons that summarize statistically all the numeric calculations within or on their boundaries. Statistical Areas 
may overlap each other in AGi32 and can be created in Plan or Elevation Views. They are dynamically updated entities that automatically update 
according to any of the calculated changed made within. their borders. 

Statistical Areas are enormously useful in many lighting applications. They allow numerical summaries to be monitored for a variety of different areas 
independently of the grids, lines and polygons used to analyze the analysis area. For example, it is easy to blanket a site with a single grid or polygon 
of calculation points, however, it may be necessary to design different portions of that project to different lighting requirements. The solution is to use 
Statistical Areas to enclose those areas that deserve special attention. 

Adding Statistical Areas 

Statistical Areas allow you to calculate values within any user-defined region. You may break a single calculation plane into numerous statistical 
areas or combine the results of multiple calculation entities into one statistical area. Statistical areas consider the points within and on the polygon 
boundary and the results are shown in the Statistics Window. Statistical areas may overlap without influence. 

Statistical Areas are dynamic entities that update with every redraw. This allows you to place them at any time in the design process. 

1. From the Add menu, choose Calculations - Statistical Area or, from the Calculations toolbar, select . 
2. Specify a unique label for this statistical area, up to 32 characters long. 
3. An optional description, up to 80 characters long, may be entered. 
4. The Summarize Project list indicates the project the Statistical Area will extract information from. The Statistical Area may be attached to one 

project (usually the current project) but summarize another project or all projects. For example, you may wish the Statistical Area to summarize 
a project containing vertical illuminance calculation points although the Statistical Area is in another project. By default, Statistical Areas 
summarize all projects. 

5. Select the type of calculation value to consider; Illuminance, Exitance, Glare Rating, Luminance (Diffuse, as specified in Automatic Placement), 
Roadway Luminance, Veiling Luminance or Unified Glare Rating (UGR). Note: The Illuminance value type include any illuminance types that 
have been calculated, e.g., vertical, semi-cylindrical, etc. The Roadway Luminance value type includes all luminance-related grid types that 
have been calculated, e.g., Longitudinal Uniformity, Background Luminance, etc. If the calculation type does not exist within the statistical 
boundary, zeroes will be displayed. 

6. In the Summary section, select which analysis will be displayed in the Statistics Window. Max/Avg ratio and Number of Points are not selected 
by default.  
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7. Select the label information to be included in the Statistical Area label adjacent to the statistical area in the job file. If no label is desired, simply 
clear all of the selection boxes in this section. 

8. If desired, change the text font or text size. 
9. Creation Method: Choose whether to manually create boundary lines of Statistical Area or choose an existing line, room or object as the 

boundary line. 

• In Plan View, Z coordinate is always 0. 

• If a tilted line, object or room is selected, polygon will be projected down to and created at lowest Z coordinate elevation.  
10. Click Ok. Follow the steps below depending on the selected creation method: 

Specify a Polygon Manually Create Polygon from Drawing Entity, Room or Object  

i. Locate the first point of the polygon and click the left mouse 
button. 

ii. Move the cursor to the second vertex on the polygon and left 
click again. 

iii. Continue in this fashion until the polygon is complete. Right click 
to close the polygon shape. The Statistical Area will be created. 

i. Locate the pick box on the drawing entity line, object or room 
boundary you wish to use and left click. 

ii. If a valid polygon is found (see Notes below), it will be displayed 
as a bold line, and the Polygon Search results dialog will appear: 

• Accept Polygon and Repeat - Select another polygon line as a 
template for another Statistical Area with the same properties. 
Use pickbox to select another closed polygon. 

• Accept Polygon - Create Statistical Area using selected entity as 
polygon boundary. 

• Reselect Entities - Choose this option if invalid polygon was 
found or if incorrect line was chosen. Use pickbox to select 
another closed polygon. 

• Manually Specify Polygon - Select vertices manually to specify 
polygon boundary, right clicking once all vertices are specified. 
This option is necessary if no valid polygon is found. 

• Cancel - Do not create Statistical Area. 

Notes: 

• Drawing Entity line segments do not need to be joined, just need 
to be within tolerances (2 decimals of precision - .05) 

• Line segments do not need to make a closed polygon - AGi32 will 
automatically close boundary line 

• AGi32 filters related lines by color. 

Caveats: 

• Disconnected line segments or line segments disconnected by 
gap larger than tolerance level will not form valid polygon. 

• Polygons with intersecting lines will not form valid polygon. 

• Incomplete polygons are not valid, may close in an unacceptable 
manner. 

Labeling Calculation Points 

Calculation Points may be labeled in a number of ways; labeling the first point in a description of points, labeling every point, labeling each line of 
points and/or labeling observer positions. Specifying labeling for lines of points and observer positions, where these calculations are not defined, will 
have no effect. 

Calculation labels may be applied to calculation grids in three ways: when first specifying the calculation entity, by editing the calculation entity after 
creation, or from Project Manager in the CalcPts Entities matrix. 

Calculation labels are dynamic and will update themselves, upon redraw, if the calculation has been modified. 

What do you want to do? 

Label the first point in this description 

This labeling option is available for all calculation options; grids, scattered points, lines, surfaces, etc. 

1. Click in the selection box adjacent to the labeling options you are interested in. 

2. If desired, change the current font and text size. 

3. Click Ok. 
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The first point may be labeled with the following options: 

Calculation Points Label - This option will extract the label name associated with this calculation and locate it below the first calculation point. 

Description - This option will extract the user-defined description associated with this calculation and locate it below the first point. 

Project Name - This option will extract the project name associated with this calculation and locate it below the first point. 

Summary - This option will list the calculation metric selected in the corresponding dialog (e.g., Average, Maximum, Minimum, Avg/Min, Max/Avg 
and Max/Min ratios). When this option is selected, the Label also includes the metric type and unit of measurements (e.g. Illuminance (Fc), L_Diffuse 
(Cd/sq. meter), etc.) 

Meter Orient and Tilt - This option will extract the meter and tilt information of the first point. This is useful if every point in the calculation exhibits the 
same meter rotation (horizontal meter, normal to grid and fixed orient and tilt angles). If each point exhibits a different orientation and tilt, as in 
variable meter aiming, then this labeling option will not describe the calculation's meter as a whole. In this case, you may want to label the meter of 
each point. 

X-Y Coordinates - This option extracts the X and Y coordinate information of the first point. 

Z coordinate - This option extracts the Z coordinate information of the first point. This comes in handy when creating calculation points with one 
elevation, in that one label describes the Z coordinate of each point. 

Label each point in this description 

This labeling option is available for all calculation options; grids, scattered points, lines, surfaces, etc. 

1. Select the Each Point tab, so that it moves to the forefront of the dialog. 
2. Click in the selection box adjacent to the labeling option(s) you are interested in. 

3. If desired, change the current font and text size. 

4. Click Ok. 

Each point may be labeled with the following options. However, generally labeling each point is not recommended due to the additional overhead 
required and longer refresh times. Consider the circumstances (such as widely scattered points) before selecting these options: 

Calculation Points Label - This option will extract the description name, associated with this calculation. 

Description - This option will extract the user-defined description associated with this calculation and locate it below the first point. 

Point Number - This option will extract the point number associated with each point. 

Meter Orient and Tilt - This option will extract the meter and tilt information of each point. If every point in the calculation exhibits the same meter 
rotation (horizontal meter, normal to grid and fixed orient and tilt angles), you may want to label the first point, instead. 

X-Y Coordinates - This option extracts the X and Y coordinate information of each point. 

Z coordinate - This option extracts the Z coordinate information of each point. If the Z coordinates are the same for each point, you may want to 
label the Z coordinate of the first point instead. 

Label each line of points in this description 

This labeling option is only active when calculation lines are defined or when the lines demarcating a grid or polygon's perimeter are visible. 

1. Select the Each Line tab, so that it moves to the forefront of the dialog. 
2. Click in the selection box adjacent to the labeling option(s) you are interested in. 

3. If desired, change the current font and text size. 

4. Click Ok. 

Each line may be labeled with the following options: 

Calculation Points Label - This option will extract the description name associated with this calculation. 

Description - This option will extract the user-defined description associated with this calculation and locate it below the first point. 

Line Number - This option will list the line number associated with each line at the beginning of the line. 

X-Y Coordinates - This option extracts the X and Y coordinate information of the first point on each line. 

Z coordinate - This option extracts the Z coordinate information of the first point on each line. If the Z coordinates are different for each point (lines of 
variable elevation), you may want to label the Z coordinate of each point instead. 
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Label each observer position in this description 

This labeling option is only active when glare rating is calculated. 

1. Select the Observer Positions tab, so that it moves to the forefront of the dialog. 
2. Click in the selection box adjacent to the labeling option(s) you are interested in. 

3. If desired, change the current font and text size. 

4. Click Ok. 

5. Note for the Roadway Luminance calculation, the IES Observer is not label, as it is a dynamic observer relative to each point in the grid. 

Each observer position may be labeled with the following options: 

Calculation Points Label - This option will extract the description name associated with this calculation. 

Description - This option will extract the user-defined description associated with this calculation and locate it below the first point. 

Observer Position Label - This option indicates each individual observer's label (e.g., Soccer Obs_1) within the calculation. 

X-Y Coordinates - This option extracts the X and Y coordinate information of each observer. 

Z coordinate - This option extracts the Z coordinate information of each observer. 

Calculations Labels - Concepts 

Text labels may be added to calculation grids and polygons to identify certain properties or characteristics. Text labels behave like mini schedules 
providing additional information about the calculation entity. Like schedules, the text labels are dynamic and will automatically update when the 
calculation entity changes. Specifying labeling for lines of points and observer positions, where these calculations are not defined, will have no effect. 

The text label will appear next to the selected point, line or observer position. Text labels may also be moved away from the grid or deleted as 
desired, however, if the calculation entity is edited, the text label will reappear in its original position. 

Modifying Calculation Labels: 

• Edit Label content 

• Move Labels individually to a different location 
• Delete individual labels 

 Calculation Types 

Calculation Point Automatic Placement Concepts 

AGi32 has the ability to automatically place custom shaped grids of calculation points on any Object surface as well as on designated workplanes 
within a Room shape. This command is very powerful and convenient essentially saving the time it would normally take to place a conventional grid 
of points on the surface and eliminate unwanted points. Additionally, the computation points can be automatically centered on the selected surface or 
workplane. Calculation point grids can be individually set for point spacing, text size, decimal places, statistical summary options and your choice of 
Illuminance, Exitance, Diffuse Luminance, or Daylight Factor . 

 

Curved and sloping surfaces are easily accommodated. In fact, using the Automatic Placement command is the method of choice when placing 
calculation points on irregular surfaces. Automatic Placement can be used to add calculation points to any Room or Object surface at any time after 
the surfaces have been created (e.g., Add-Object). 
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By default, Light meter orientation is Normal for grids of points placed by Automatic Placement, however you may apply Fixed or Variable Light Meter 
types to measure Illuminance, as desired. 

Center Points relative to surface boundaries 

 

Computation points can be centered relative to the surface boundaries or the confines of the room (for workplanes). The default setting for this is ON 
or selected. To disable computation point centering, select Off in the CenterPointsOnSurface text box. 

When points are not centered the grid is placed on the surface starting from the lower left corner. As shown in the illustration above, this generally 
results in points along the bottom and left edges of the surface and points stopping short of the top and right edges. 

Automatic Placement Points Normals on surfaces 

Automatic Placement points will be placed on the Normal side of each surface, by default. You may select the Abnormal side (back side) if desired. 

 

Entity Type Normal Side 

Room (Floor, Walls or 
Ceiling) 

Front - Interior (Inside); Top - Workplane 

Objects (Bottom, Sides to 
Top) 

Front - Exterior (Outside) unless Reflective Side is on Inside for certain objects 
(e.g. cone, round-vertical rotation). 

Editing Surface Attributes 

Once the grids are created, they are inherently associated with the room or object to which they were created. If you modify the room or object (i.e. 
delete, move, etc.), the calculation entities will be deleted. The only exception to this rule, is surface editing. Editing the surface properties of the 
associated room, or object using Surface Edit, will retain the associated calculation points. 

Project Manager 

Calculation Points placed with Automatic Placement may be removed from their associated surfaces in Project Manager. Project Manager also 
provides visibility and calculation status control for each individual grid as well. 

Related Topics 

Project Manager 
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Automatic Placement Calculations 

 

The Calculation Points - Automatic Placement command allows you to quickly place calculation points on any room or object surface (and work 
planes inside Rooms). You specify which surfaces will have calculation grids placed on them in the Calculation Points - Automatic Placement dialog. 
As with other calculation types, the calculation grids may have numeric analyses and labeling options associated with them, in addition to appropriate 
point spacing. 

When calculation points are placed on certain roofs, ceilings and object tops (such as dome, vertical extrusion, pyramid, etc.) an individual 
calculation grid or polygon is created for each section in addition to a composite grid for the entire ceiling or object top. The composite grid will 
summarize the values for all associated sections. 

When editing Automatic Placement grids, the surfaces that include points are automatically tagged when the AP dialog is opened. This allows you to 
make changes to all points without having to first navigate to the surfaces containing points. 

1. From the Add menu choose Calculations - Automatic Placement, or in the Calculations Toolkit select . 
2. Select the room or object that you wish to place one or more grids on by locating the pick box cursor on a boundary line and clicking the left 

mouse button. 
3. In the Automatic Placement dialog, you may use the Display Options button below the image to change its appearance, such as showing it as 

outlines only or filled in, and changing the background color. You may use the interactive navigation buttons to view the object from different 
angles. (Additional information below) 

4. Use the navigate at the top-left in the dialog to change the highlight to the surface or group of surfaces to which calculation points will be added. 
Tagging surfaces allows you to quickly select multiple surfaces based on inherent relationships in AGi32 entities. Calculation options will be 
applied in the same way to all tagged surfaces. See table below for a description of the navigation buttons and their functions. 

5. To apply calculation points to all selected surfaces, select the On option in the Calculation Points row in the Calculation Points section. A 
preview of the calculation point spacing and locations will be shown in the graphics display.  

6. You may change the point spacing in either or both directions in the General section. 

7. If desired, specify Highlight Values by clicking on the Highlight Values button . 

8. If desired, specify Isolines by clicking on the Isolines button . 
9. Click Ok. The calculation grids and polygons will automatically be created according to your specifications. 

Navigation, Tag and View Control Icons 

Icon Command Keyboard 
Shortcut 

Comments 

 
Move to 
Previous 
Surface 

F9 Navigates to previous surface in selected room or object; Workplane is assigned as last surface in Rooms. 

 
Move to Next 
Surface 

F10 Navigates to next surface in selected room or object; Workplane is assigned as last surface in Rooms. 

 
Move to 
Workplane 

F6 Navigates to work plane surface in selected room. This icon only appears when a room is selected. 

 
Move to 
Previous 
Component 

F11 Navigates to the first surface in the previous component in the selected object. Objects only contain multiple 
components if they are composed of grouped objects (Library Objects) or multiple layers (imported 3D 
Objects).  To navigate within the surfaces of a component, use the Move to Next/Previous Surface 
commands. 

 
Move to Next 
Component 

F12 Navigates to the first surface in the next component in the selected object. Objects only contain multiple 
components if they are composed of grouped objects (Library Objects) or multiple layers (imported 3D 
Objects). 
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To navigate within the surfaces of a component, use the Move to Next/Previous Surface commands. 

 
Tag Current 
Surface 

F8 Selects the current surface for calculation point placement. Surfaces only need to be tagged if you want to 
apply calculation points or make modifications to more than one surface. 

 
Tag Ceiling, 
Top or Roof 

Ctrl+
E 

Selects all surfaces that were created as ceilings (in Rooms) or tops (in Objects) for calculation point 
placement. Surfaces only need to be tagged if you want to apply calculation points or make modifications to 
more than one surface. 

 
Tag Walls or 
Sides 

Ctrl+
W 

Selects all surfaces that were created as walls (in Rooms), or sides (in Objects) for calculation point 
placement. Surfaces only need to be tagged if you want to apply calculation points or make modifications to 
more than one surface. 

 
Tag Floor or 
Bottom 

Ctrl+
F 

Selects all surfaces that were created as floors (in Rooms), or bottoms (in Objects) for calculation point 
placement. Surfaces only need to be tagged if you want to apply calculation points or make modifications to 
more than one surface. 

 
Tag Object 
Component 

Ctrl+
O 

Selects all surfaces in the current Object component for calculation point placement. Surfaces only need to 
be tagged if you want to apply calculation points or make modifications to more than one surface. 

 
Tag All 
Surfaces 

Ctrl+
A 

Selects all surfaces for calculation point placement. Surfaces only need to be tagged if you want to apply 
calculation points or make modifications to more than one surface. 

 
Remove All 
Tags 

Ctrl+
R 

Deselects all selected surfaces. Necessary when you wish to apply alternate calculation point options to 
different surfaces. Note: Surfaces remain tagged, even when additional surfaces are tagged, until Tags are 
individually or collectively removed. 

 
Front View   Displays a Front (South) Elevation View of Room or Object in graphic display. 

 
Back   Displays a Back (North) Elevation View of Room or Object in graphic display. 

 
Left   Displays a Left (West) Elevation View of Room or Object in graphic display. 

 
Right   Displays a Right (East) Elevation View of Room or Object in graphic display. 

 
Top   Displays a Top Plan View of Room or Object in graphic display. 

 
Bottom   Displays a Bottom Plan View of Room or Object in graphic display. 

 
Clip   Cuts away the front plane of the image continuously to reveal the objects within and beyond. The size of the 

image does not increase or decrease. This command is very useful when viewing an image with exterior and 
interior components (e.g., interior and site lighting). 

 
Dolly   Moves the observer and the focus point in and out of the model along a straight line. Depending on the view 

direction, from the observer’s point of view, this feature allows you to “walk” into and out of the space. 

 
Orbit   Moves the observer around the model while maintaining the same focus point. Imagine that you are a 

spaceship orbiting the earth, always looking at the center of the earth. 

 

Pan   Moves the observer and focus point relative to a fixed model position. Imagine that you are looking straight 
ahead and moving laterally left/right or up/down. The image will move opposite to the panning direction. 

 

Rotate   Allows the observer to look left or right and up or down from a fixed position. Use this command when you are 
in a space and want to look at different surfaces without changing your position. A panorama view is obtained 
by moving constantly to the left or right. 

 
Walk   Combines the Dolly, Pan and Rotate commands into one movement. Dragging the mouse up/down moves the 

observer forward and backward. Dragging the mouse left/right, rotates the observer view position left and right. 
Using the Shift and Ctrl keys in conjunction with dragging or the arrow keys invokes the Rotate and Pan 
commands as well. 

 
Zoom   Similar to the Zoom In and Zoom Out commands in AGi32’s Model Mode, with the difference being that the 

image size is continuously increased or decreased as the mouse is held down and dragged. 

 

Display Options 

Clicking on the Display Options button below the image opens a list of ways that the image appearance may be modified. For example, you may 
select to keep outlines visible and surfaces filled in, but not show text or drawing entities associated with this Object or Room. These selections apply 
to the image seen in the Surface Edit dialog only. By default, all options are selected, with the background color available for modification.  

Additional Dialog Options - in order of appearance in Automatic Placement dialog 

Dialog Settings 

This dialog section controls the display options for surfaces. This section is hidden by default. 

Tag Surface Color - Indicates the line color of tagged surfaces. Default color is yellow; color may be changed by user. 

Current Surface Color - Indicates the line color of current selected surface. Default color is cyan; color may be changed by user. 

Removed Surface Color - Indicates the line color of removed surfaces. Default color is black; color may be changed by user. 
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Meter Vector Color - Indicates the line color of Normal Meter Vector. Default color is black; color may be changed by user. 

Meter Vector Length - Indicates the Normal Vector length in current units - feet or meters. Meter Vector indicates the Normal side of selected 
surface by default (or Abnormal side, if this option is selected in the Calculation Points section). Vector Length is automatically calculated from 15% 
of maximum entity extents in X or Y (whichever is larger); may be changed by user. 

Associated Entity 

Entity Type - Indicates the type of Entity selected - Room or Object. Text box is only displayed for informational purposes; not changeable by user. 

Entity Label - Indicates the Label of the selected Entity - originally assigned by user when entity was created. Text box is only displayed for 
informational purposes; not changeable in this dialog by user. 

Component Label - Indicates the Label of the current component in selected Entity - originally assigned by user when entity was created. 
Component Label only contains information if an Object with Components is selected. Text box is only displayed for informational purposes; not 
changeable in this dialog by user 

General (All Calculation Points) 

This section controls global calculation point settings for this session. The same calculation point parameters are applied to all calculation grids in the 
same Family. If different point spacing is desired for different surfaces within the same entity, apply Automatic Placement multiple times to the same 
entity (with desired point spacing each time). 

Family Label - Indicates label of associated calculation points. By default, Family Label defaults to associated Entity label. However, user can 
specify alternate name, if desired. 

Description - Specify an optional description, up to 80 characters, for family of calculation points, if desired. 

Point Spacing LR - Specify the left-to-right point spacing for all calculation grids. By default, a point spacing of 2 x 2 is used for rooms, 10 x 10 for 
objects. As the point spacing changes, the text size automatically adjusts.  

Point Spacing TB - Specify the top-to-bottom point spacing for all calculation grids. By default, a point spacing of 2 x 2 is used for rooms, 10 x 10 for 
objects. As the point spacing changes, the text size automatically adjusts. 

Text Size - Indicates the Text height, in current units (Feet or Meters) of the calculation point values. Text Size is automatically sized based on point 
spacing; may be changed by user. 

Center Points on Surface - Indicates that calculation  points within all selected grid boundaries are centered. This option is On by default. 

Surfaces 

This section provides information about the currently selected surface. 

Number - Indicates the surface number of the currently selected surface. 

Tag - Indicates if the surface is tagged or not. You may manually tag a surface by changing the Tag text box from Off to On. 

Label - Indicates the Surface Label (Floor, Bottom, Walls, Sides, Ceiling, or Top) of the selected surface. Text box is only displayed for informational 
purposes; not changeable by user. 

Workplane Height - If a room is selected, you will have the option to add a horizontal illuminance calculation polygon on the work plane. When the 
work plane surface is selected, you can specify the work plane height in this text box. Default value is 2.5 feet. You may change the work plane 
Height to 0 if desired. This has the effect of using the Virtual Meter for calculations instead of the Exitance meter. 

Calculation Points 

This section specifies the type of calculation metric used and light meter position. 

Calculation Points - To enable calculation points on all selected and tagged surfaces, select On in the text box. Similarly, to remove calculation 
points from a surface, switch the Calculation Points Off. 

SubLabel - Indicates the Surface SubLabel (i.e. which wall or ceiling surface  is selected). 

Calculation Type - Indicates whether Illuminance, Exitance, Diffuse Luminance, or Daylight Factor is calculated. Default metric is Illuminance. 

Calculation Type Comments 

Illuminance Light incident on the surface; lumens per sq.ft or lumens per sq.m 

Exitance Light reflected off the surface; lumens per sq.ft or lumens per sq.m 
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Diffuse Luminance Density of luminous flux projected in a given direction off of the (assumed diffuse) surface; candelas per sq.m 

Daylight Factor Ratio of interior daylight to exterior daylight on any surface or work plane 

Notes: 

• Exitance values are based on the Numerical Units chosen in System Settings, not on the Display Units. If the numerical units are footcandles, 
Exitance values will be displayed in Lumens/Sq.Ft.  If the numerical units are Lux, Exitance values will be displayed in Lumens/Sq.Meter. 

• Program calculates non-view-dependent diffuse Luminance only (all surfaces are considered lambertian). 

• Diffuse luminance is essentially Exitance/π and is always reported in Cd/Sq.M. Exitance is reported in Lumens/Sq.Units (feet or meters) and 
should be converted to Lumens/Sq.M before comparing with Luminance. 

 Points on Surface - Indicates which side of surface calculation points will be added to - Normal or Abnormal (back side). Default setting is Normal 
Side. 

Entity Type Normal Side 

Room (Floor, Walls or 
Ceiling) 

Front - Interior (Inside); Top - Workplane 

Objects (Bottom, Sides to 
Top) 

Front - Exterior (Outside) unless Reflective Side is on Inside for certain objects 
(e.g., cone or round - vertical rotation). 

  

Light Meter Type - Indicates Position of Light Meter on Selected surfaces. Default position is Normal to Surface: Light meter is placed flush against 
surface, Normal is perpendicular to surface. More on light meter angles 

Light Meter Type Comments 

Normal to Surface Light meter is placed flush on surface, Light meter Normal is perpendicular to surface 
(same as Surface Normal). Illuminance, Exitance, Diffuse Luminance, and Daylight 
Factor may be measured with this Light Meter Type. 

Fixed Orient/Tilt This Light Meter Type is used when user wishes to specify a fixed light meter position 
unrelated to surface direction and normals (e.g., measure horizontal Illuminance on 
sloped plane). User specifies Meter Orient and Tilt in text boxes below. Only Illuminance 
may be measured with this Light Meter Type. 

Variable - Aim 
Towards Point 

Indicates that all light meters will point toward one fixed point, specified with X, Y and Z 
input. User specifies Meter X, Y and Z Aiming Points in text boxes below. Only 
Illuminance may be measured with this Light Meter Type. 

Meter Orient - Indicates Meter Orientation for Fixed Light Meter Type. Orient angle is first angle applied. 

Meter Tilt - Indicates Meter Tilt for Fixed Light Meter Type. Tilt angle is second angle applied. 

Aim Meter Towards X - Indicates X Aiming Point for Variable Light Meter Type. 

Aim Meter Towards Y - Indicates Y Aiming Point for Variable Light Meter Type. 

Aim Meter Towards Z - Indicates Z Aiming Point for Variable Light Meter Type. 

Summary 

Specify the summary options to calculate. By default, average, maximum and minimum Illuminance, Exitance,Diffuse Luminance, and/or Daylight 
Factor are displayed along with uniformity ratios. Click here for more on Summaries. 

Note: Exitance values are based on the Illuminance Units chosen in System Settings, not on the Display Units. If the Illuminance units are 
footcandles, Exitance values will be displayed in Lumens /Sq.Ft. If the Illuminance units are Lux, Exitance values will be displayed in 
Lumens/Sq.Meter.  

Include Composite Summary - Indicates that a composite summary is displayed if calculation points are placed on related surface (Surface label is 
the same). Examples: Wall_Total, Ceiling_Total, etc. The composite grid is only calculated if the correlated grids all calculate the same metric 
(Illuminance, Exitance, Diffuse Luminance, or Daylight Factor). If any of the surfaces are associated with an alternate metric (e.g., 3 walls 
Illuminance, 1 wall Luminance or Daylight Factor), the Composite Surface grid will not be calculated. 

Basic (Avg, Max, Min) - Indicates that the basic summary metrics are calculated. Precision level (Number of Decimal Places) applied is the same as 
for related calculation points. 

Average/Minimum Ratio - Indicates that the Average-to-Minimum ratio (or Minimum-to-Average, if this option is specified in System Settings), is 
calculated. Precision level (number of decimal places) applied is the same as for related calculation points. 

Maximum/Minimum Ratio - Indicates that the Maximum-to-Minimum ratio (or Minimum-to-Maximum, if this option is specified in System Settings), is 
calculated. Precision level (number of decimal places) applied is the same as for related calculation points. 
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Maximum/Average Ratio - Indicates that the Maximum-to-Average ratio is calculated. Precision level (number of decimal places) applied is the 
same as for related calculation points. 

Number of Points - Indicates that the total number of points in each calculation entity is displayed. Removed points are not included in this value. 

Coefficient of Variation - Coefficient of Variation is defined as the ratio of the standard deviation of all values to the mean (average) value. Note: CV 
is not calculated for composite grids (ceiling/top, walls/sides, or floor/bottom). 

Uniformity Gradient - Uniformity Gradient measures the rate of change of values between adjacent measuring points, side to side, up-down, or 
diagonally. The UG value is expressed as a ratio of values. Note: UG is not calculated for composite grids (ceiling/top, walls/sides, or floor/bottom). 

DF Basis (DF Calc Type Only) - The Exterior Illuminance used as the denominator in the Daylight Factor calculation. By default it is Off. 

DF Percent (DF Calc Type Only) - Percentage of Points equal to or above % of Daylight Factor value (User defined, default is 2%). Note: DF is not 
calculated for composite grids (ceiling/top, walls/sides, or floor/bottom). 

% Points in Range - Returns the percentage of the calculated values (any metric) within a designated range, including the minimum and maximum. 
Range Value 1 would be the minimum, and Range Value 2 the maximum. If you do not wish to limit the upper range or don't know the upper limit, 
simply enter a large value, e.g., 10000. Note: % Points in Range is not calculated for composite grids (ceiling/top, walls/sides, or floor/bottom). 

Display (All calculation Points) 

Select the display options, including precision, text color, visible lines, point markers and labeling. 

Number of Decimals - Indicates the number of decimal places displayed in the calculation point value. 

Mark Points - Indicates the measurement position of the associated light meter; position is indicated with a small shaded circle. 

Color - Indicates the color of the calculation value and Mark Point. 

Labeling - Indicates if any Labeling options are applied to the selected grids. Click on the ellipsis (...) button to display the Calculation Points - 
Labeling dialog. 

Session History 

The Session History section indicates surface count as well as a running tabulation of the calculation options applied in this session. 

Total Surfaces - The total surface count for the selected entity. 

Number Selected/Tagged - The total number of surfaces currently selected and tagged. Any modifications applied are applied to all selected 
surfaces. Hint: If you wish to make individual changes to certain surfaces (not global changes, such as point spacing), remove all tags, then only 
select the surfaces you wish to apply these changes to. 

Number of Surfaces Changed - Indicates the type of modification applied to all selected surfaces. 

Calculations Daylight Factor Concepts 

The IESNA defines Daylight Factor  as the "ratio of Illuminance at a point on a plane, generally the horizontal workplane,  produced by the luminous 
flux received directly or indirectly at that point from a sky whose luminance distribution is known,  to the Illuminance on a horizontal plane produced 
by an unobstructed hemisphere of the same sky". The method takes only luminous flux from the sky into consideration (not sunlight) and is generally 
used with uniform or CIE overcast skies (so that sunlight and solar position is not a factor). Daylight Factor is not calculated when electric lighting is 
switched on in AGi32 or when sky types other than CIE General Sky Types 1-5 are selected. 

The Daylight Factor method is calculated in accordance with the IESNA Lighting Handbook, Ninth Edition. 

Daylight Factor ( DF) = Ei / Eo x 100(%) 

Ei = Illuminance produced by daylight (direct and interreflected) on interior workplane 
 Eo = Simultaneous exterior Illuminance on a horizontal workplane from an unobstructed view of sky 

Daylight Factor is used to determine what impact the geometry of the space and location and amount of fenestration have on daylight penetration. 
For Overcast or Uniform skies, the DF ratio will not change over the year, unless the geometry or fenestration in the room changes. Although the 
available luminous flux may change (the Daylight Factor Basis), the percentage of light penetrating the space will remain the same). Some uses of 
Daylight Factor include: 

• Comparing different geometric designs side by side. 

• Meet certain requirements. For example, the United States Green Buildings Council (USGBC) promotes a Leadership in Energy and 
Environmental Design (LEED) certification for buildings. Part of the LEED criteria specifies that a Daylight Factor of 2% is required in 75% of 
the space occupied for critical visual tasks. 
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• Understanding the amount of light entering the interior space. This ratio describes that relationship, regardless of the absolute Illuminance 
values calculated. DF is useful for ascertaining what changes that are made to the geometric design have on improving Illuminance and 
luminance values. 

Implementation of Daylight Factor in AGi32 

• Daylight Factor calculation points  can be specified in two ways using AGi32: the Calculation Point DF command, or, on any surface using 
the Calculations Points Automatic Placement command. 

• AGi32 does not restrict the location of the DF grid to interiors 

• Daylight Factor is only calculated with Overcast Skies or skies with uniform luminance (CIE Sky Types 1-5). 

• Electric lighting is not considered in DF. Electric Lighting should be switched off before Daylighting is applied in order to calculate values for 
DF. 

• Results are given as low precision values (whole percentage points) by default. 

Add Calculations - Daylight Factor 

Daylight Factor is defined as the ratio of illuminance at a point on a plane produced directly or indirectly by skylight to the illuminance on a horizontal 
plane exposed to an unobstructed view of the sky. The method only takes luminous flux from the sky into consideration (not sunlight) and is generally 
used with uniform or CIE overcast skies (so that sunlight and solar position) is not a factor. Daylight Factor is not calculated when electric lighting is 
switched on in AGi32 or when sky types other than CIE General Sky Types 1-5 are selected. 

Daylight Factor ( DF) = Horizontal Illuminance from sky light on horizontal workplane 
Horizontal Illuminance from unobstructed sky 

Daylight Factor is used to determine what impact the geometry of the space and location and amount of fenestration have on daylight penetration. 
Some uses of Daylight Factor include: 

• Comparing different geometric designs side by side. 

• Meet certain requirements. For example, the United States Green Buildings Council (USGBC) promotes a Leadership in Energy and 
Environmental Design (LEED) certification for buildings. Part of the LEED criteria specifies that a Daylight Factor of 2% is required in 75% of 
the space occupied for critical visual tasks. 

From the Add menu choose Calculations -Daylight Factor or from the Calculations toolbar select . 

1. Specify a unique label up to 32 characters. 
2. An optional description may be entered up to 80 characters. Meaningful descriptions that include room information and workplane height will be 

useful when generating schedules. 
3. Specify the point spacing from left to right and top to bottom. By default, a point spacing of 10 by 10 is used. As the point spacing changes, the 

text size adjusts, automatically. You may override the text size, if desired. 
4. You may center the measurement points within the grid boundary, if desired, by clicking in the selection box adjacent to Center Points Relative 

to Grid Boundaries. 
5. To calculate Illuminance values at the same grid locations (for reference purposes), click in the selection box Include Illuminance Grid. This 

selection is enabled by default. 
6. Specify the Summary  options to calculate.  

Daylight Factor Options Illuminance Options 

Default Selections 

• Average Value 

• Max and Min Values 

• Percentage of Points equal to or above % of DF: User 
Defined, default is 2% 

Other available options 

• Number of Points (If Number of Points is selected, the number 
of points that are in the calculation, not including points that 
have been removed, are shown.) 

• Daylight Factor Basis (exterior Illuminance Value) 

Default Selections 

• Average Value 

• Max and Min Values 

• Avg/Min Ratio 

• Max/Min Ratio 

Other available options 

• Max/Avg ratio 

• Number of Points 

• Coefficient of Variance 

• Uniformity Gradient 

7. Select the display options, including precision, text color, perimeter lines, point markers and labeling. 
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8. If desired, specify Isoline contouring and Highlight Values by clicking on the appropriate buttons. 
9. Creation Method: Choose whether to manually create boundary lines of Daylight Factor polygon or choose an existing line, room or object as 

the boundary line. 

• If manually specifying polygon, the Z coordinate is 2.5 feet  (0.7 m) AFF (workplane height) by default. 
• If a tilted line, object or room is selected, polygon will be projected down to and created at lowest Z coordinate elevation.  

10. Click Ok. Follow the steps below depending on the selected creation method: 

Specify a Polygon Manually Create Polygon from Drawing Entity, Room or Object  

i. Locate the first point of the polygon and click the left mouse 
button. 

ii. Move the cursor to the second vertex on the polygon and left 
click again. 

iii. Continue in this fashion until the polygon is complete. Right click 
to close the polygon shape. The Daylight Factor grid will be 
created. 

i. Locate the pickbox on the drawing entity line, object or room 
boundary you wish to use and left click. 

ii. If a valid polygon is found (see Notes below), it will be displayed 
as a bold line, and the Polygon Search results dialog will appear: 

• Accept Polygon and Repeat - Select another polygon line as a 
template for another grid with the same properties. Use pickbox 
to select another closed polygon. 

• Accept Polygon - Create grid using selected entity as polygon 
boundary. 

• Reselect Entities - Choose this option if invalid polygon was 
found or if incorrect line was chosen. Use pickbox to select 
another closed polygon. 

• Manually Specify Polygon - Select vertices manually to specify 
polygon boundary, right clicking once all vertices are specified. 
This option is necessary if no valid polygon is found. 

• Cancel - Do not create calculation entity. 

Notes: 

• Drawing Entity line segments do not need to be joined, just need 
to be within tolerances (2 decimals of precision - .05) 

• Line segments do not need to make a closed polygon - AGi32 will 
automatically close boundary line 

• AGi32 filters related lines by color. 

Caveats: 

• Disconnected line segments or line segments disconnected by 
gap larger than tolerance level will not form valid polygon. 

• Polygons with intersecting lines will not form valid polygon. 

• Incomplete polygons are not valid, may close in an unacceptable 
manner. 

Calculations Glare Rating Concepts 

In 1994, the CIE developed a glare evaluation method for outdoor sports lighting and area lighting applications (CIE document 112-1994). This 
system is available for checking the Glare Rating situation of existing installations and for predicting glare rating at the design stage in new 
installations.  
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The Glare Rating calculation grid provides an indication of glare 
experienced by the observer for each point in the grid based on the 
veiling illuminance produced by the luminaires and the environment 
(ground plane only) on an observer's eye. It is measured as the 
observer looks at each point on a horizontal illuminance grid. Glare 
Rating is restricted to horizontal grids of points below eye level and is 
used in outdoor area and sports lighting applications.  

A lower Glare Rating value (GR) indicates better glare restriction. 

Each glare rating grid is tied to one observer position. Glare rating is calculated for each point on grid based on the veiling luminance produced on 
the eye by the luminaires and the environment. 

When Glare Rating is specified, grids are created for each observer position that duplicate the specified horizontal illuminance grid. Each GR grid is 
identified by its correlated observer position, which are labeled sequentially, Obs_1, Obs_2, etc. In Project Manager, each GR grid is identified by its 
observer position and calculation points label. 

For example, a horizontal grid labeled “football” with one observer position would have a Glare Rating grid associated with it called “football-Obs_1.” 
In Project Manager, there would be two related grids associated with football: the horizontal illuminance grid “football” and “football-Obs_1.” 

The Glare Rating calculation does not take reflective or obstructive entities around or within the GR grid into account. 

Glare Rating Equations 

 

Veiling Luminance Equations considering luminaires and environment 

 

LVL = Veiling luminance on the eye produced by the luminaires for one point. 

i = the current luminaire being considered. 

n = total number of luminaires in the job file. 

E(eye), i = the illuminance produced on the observer's eye in a plane perpendicular 

to the line of sight, produced by the ith source, in lux. 

qi = the angle between the observer's line of sight and the direction of light. 

 

 

 

  

LVE = Veiling luminance on the observer's eye produced by the environment. 

Ehor,av = Average horizontal area illuminance (ground plane). 

ρ = the reflectance of the area assuming diffuse reflection. 

W0 = the unity solid angle in steradians. 
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Nine Point Glare Assessment Scale 

When glare rating was first experimented with by CIE researchers, a glare control mark GF was used that relates to the Glare Assessment scale 
shown below. As the GF marker increases in value, the better glare restriction that is provided by the installation. The glare assessment scale 
provides meaningful visual information regarding the differences in glare rating values. 

Glare rating GR is related to GF by this equation: 

 

Glare Control Mark GF   Glare Rating GR 

1 Unbearable 90 

2   80 

3 Disturbing 70 

4   60 

5 Just Admissible 50 

6   40 

7 Noticeable 30 

8   20 

9 Unnoticeable 10 

A variation of +/- 0.5 in Glare Rating is equivalent to an experimental accuracy ratio of +/- 5% in the Luminance ratio. 

 

Recommended Glare Rating Limits 

To ensure that glare is not excessive in any normal viewing direction at any normally accessible point on the illuminated area, the maximum value of 
GR should always be less than the recommended value of GRmax. 

Area Lighting Applications 

Type of Application GRMax 

Safety & Security Low Risk 55 

  Medium Risk 50 

  High Risk 45 
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Movement & Safety Pedestrians Only 55 

  Slow Moving Traffic 50 

  Normal Traffic 45 

Work* Very Rough 55 

  Rough-Medium 50 

  Fine 45 

(*) In a work area where viewing tasks are of decisive importance, it is advisable to have a maximum glare rating value five units lower than the 
specified GRmax. 

Sports Lighting Applications 

Type of Application GRMax 

Lighting for Training Purposes 55 

Lighting for Competition Purposes 50 

Add Calculations - Glare Rating 

Glare Rating indicates the glare evaluation for outdoor sports and area lighting based on the veiling luminance produced by the luminaires and the 
environment on an observer's eye. It is measured as the observer looks at each point on a horizontal illuminance grid. A lower glare rating value 
(GR) indicates better glare restriction. Glare rating is limited to viewing directions below eye level. 

When glare rating is specified, grids are created for each observer position that duplicate the specified horizontal illuminance grid. Each GR grid is 
identified by its correlated observer position. Observer positions are labeled sequentially, “Obs_1”, “Obs_2”, etc. Each GR grid is identified by its 
correlated observer position. In Project Manager, each GR grid is identified by its observer position and calculation points label. 

For example, a horizontal grid labeled football with one observer position, would have a glare rating grid associated with it called “football_Obs 1.” In 
Project Manager, there would be two related grids associated with “football,” the horizontal illuminance grid “football” and “football Obs_1.” 

The Glare Rating calculation does not take reflective or obstructive entities around or within the GR grid into account. 

1. From the Add menu choose Calculations -Glare Rating, or from the Calculations toolbar select . 
2. Specify a unique label for the family of glare rating grids, up to 32 characters long. 
3. An optional description may be entered (up to 80 characters). Meaningful descriptions that include size and color information will be useful when 

generating schedules. 
4. Specify the point spacing from left to right and top to bottom. By default, a point spacing of 10 by 10 is used. As the point spacing changes, the 

text size adjusts, automatically. You may override this value once the point spacing is established, if desired. 
5. By default, the illuminance grid is not visible. To make it visible, left click in the Illuminance Grid Visible selection box so that a checkmark is 

shown. 
6. Specify the grid reflectance. Enter a decimal value > 0 and < 1. 
7. You may center the measurement points within the grid boundary, if desired, by clicking in the selection box adjacent to Center Points Relative 

to Grid Boundaries. 
8. Specify the observer positions. Each observer position will have a GR grid of its own. Observer positions are specified in one of three ways: 

• Specify the number of observer positions by using the up and down arrow keys next to Number Of Observer Positions. Enter the x, y, 
and z coordinates of each observer position and grid visibility. Initially, a coordinate of 0,0,4.92 ft (or 0,0,1.5 m) is assigned to each 
observer position. 

• Click on the Specify Additional button to specify additional observer positions in the graphics window. When the dialog is first 
accessed, one observer position is already located at 0,0,4.92 ft (or 0,0,1.5 m). You may also use this button to add additional 
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observer positions to ones you have already located. The dialog will temporarily close, and you can locate the observer positions by 
clicking the left mouse button at each location. Right click the mouse when you are done to return to the GR dialog. Each observer 
position will be located at a height of 4.92 ft (1.5 m). You can change this height in the Z-Coord text box if you want. 

• Click on the Specify New button to delete any existing observer positions and specify all new observer positions in the graphics 
(Model mode) window. Locate each observer position with the mouse and left click to specify. Multiple observer positions may be 
specified by repeatedly left clicking at the desired locations. By default, the observer position will be located at typical eye level (4.92 
ft, 1.5 m) unless otherwise specified. Once you have finished locating observers, click the right mouse button to return to the Glare 
Rating dialog. 

9. In the Summary  section, specify the options you would like to calculate. By default, average, maximum and minimum illuminance are displayed, 
along with uniformity ratios (Max/Avg ratio is not selected, by default). If Number of Points is selected, the number of points that are in each grid 
(not including points that have been removed) are shown. 

10. Select the display options, including precision (decimal places), text color, perimeter lines, markers and labeling. 
11. Specify the Z coordinates of the grid. it must be less than the Z coordinate for the observer position(s) as GR is limited to viewing directions 

below eye level. You will have the option to change the grid height, if desired, before specifying the first grid point. 
12. If desired, specify Isoline contouring and Highlight Values by clicking on the appropriate buttons. 
13. Click Ok to return to the graphics window and place the GR plane. 
14. To change the grid elevation, move the cursor into the Z-Coord text box and enter a new value or use the up and down arrow keys on the 

keyboard, before clicking the first point. Locate the first point of the grid and click the left mouse button. 
15. Drag the cursor to the second point on the grid (opposite corner) and left click again. 

Note: Individual Observer Positions may be deleted by selecting the entire row. Click on the row marker to the left of the Observer Label and delete 
it--press Delete on the keyboard when the entire row is highlighted. You may Relabel all of the observer positions, and restore sequential labels by 
clicking on the Relabel All button. 

Calculation Grid Concepts 

Calculation grids are used to quantify Illuminance values within a rectangular boundary using regularly spaced light meter positions. Two versions of 
the Calculation Grid are available - 2 Point and 3 Point specification. The only difference between the two is the alignment of the grid in AGi32's 
environment. 

Calculation grids are used when you have to include point by points in a large rectangular area. If you need to create a calculation grid for an 
irregular boundary, consider using the Calculation Points - Polygon command instead. 

Calculation Grid Examples (Grid Boundary shown for Illustration) 

2 Point Calculation Grid (Parallel to X-Y axis) 

 

3 Point Calculation Grid 

 

Adding A Grid Of Calculation Points 

This command allows you to create a grid of points for which illuminance values will be calculated. Grids may be specified in Plan or Elevation view. 
2-point grids are orthogonal and may be tilted along their baseline. 3-point grids are specified by locating the endpoints of the baseline, then 
specifying the top right corner of the grid. Like 2-point grids, they may be tilted about their baseline as well. 

To measure Exitance or Luminance, use the Automatic Placement command to select the surfaces (object or room) for which Exitance or Luminance 
calculations are desired. 

What do you want to do? 

Specify a 2-pt. Grid 
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Specify a 3-pt. Grid 

Add Calculations - Grid: 2 Point Input 

The 2-point input system can be used when the illuminance grid can be positioned parallel to the Cartesian axis - orthogonal grid (facing N, S, E or 
W). Point grids sloping in the North-South direction (or S-N) and vertical grids created in Elevation view can also utilize the 2-point input. 

In Plan View, the grid must be placed from right to left or left to right. The second input point must have different X and Y coordinates than the first. 

1. From the Add menu choose Calculations -Grid-2 Pt. Input, or from the Calculations toolbar select . 
2. Specify a unique label up to 24 characters. 
3. An optional description may be entered up to 80 characters. Meaningful descriptions that include size and color information will be useful when 

generating schedules. 
4. Specify the point spacing from left to right and top to bottom. By default, a point spacing of 10 by 10 is used. As the point spacing changes, the 

text size adjusts, automatically. A different text size may be specified, if desired. 
5. You may center the measurement points within the grid boundary, if desired, by clicking in the selection box adjacent to Center Points Relative 

to Grid Boundaries. 
6. Select the light meter type by clicking on the appropriate radio button (and entering the desired values, if necessary). By default, the horizontal 

meter and grid is selected. 
7. Specify the Summary  options to calculate. By default, average, maximum and minimum illuminance are calculated and uniformity ratios 

(Max/Avg ratio is not selected by default). If Number of Points is selected, the number of points that are in the calculation (not including points 
that have been removed) are shown. 

8. Select the display options, including precision, text color, perimeter lines, point markers and labeling. 
9. Specify the Z coordinates of the first and second input points. You will have the option to change these values, if desired, when creating the 

grid. By default, both values are set to zero. 
10. If desired, specify Isoline contouring and Highlight Values by clicking on the appropriate buttons. 
11. Click Ok. 
12. To change the grid elevation, move the cursor into the Z-Coord text box and enter a new value or use the up and down arrow keys on the 

keyboard, before clicking the first point. Locate the first point of the grid and click the left mouse button. 
13. Drag the cursor to the second point on the grid and left click again. By default, the Z coordinate will echo the first corners's elevation. To change 

the elevation for the second point, before clicking move the cursor into the Z-Coord text box and enter a new value or use the up and down 
arrow keys on the keyboard. 

Add Calculations - Grid: 3 Point Input 

The 3-point input system can be used when a grid of calculation points is not parallel to the XY axis or when a sloping calculation grid is desired. 3 
point grids can only be specified in Plan view. 

Positioning Technique: 

• 1st Point - Sets the lower left hand corner of the grid of points. 

• 2nd point - Defines the grid's baseline and always has the same elevation coordinate as the first point. 

• 3rd Point - Defines the height of the grid (number of points from top to bottom) and its slope. A Z-coordinate other than zero will slope the 
plane (tilt it up from baseline). 

1. From the Add menu choose Calculations -Grid-3 Pt. Input, or from the Calculations toolbar select  (Left click on the pull-down arrow to 
the right of the button to invoke the secondary menu. Select 3 Pt. Input). 

2. Specify a unique label up to 32 characters. 
3. An optional description may be entered up to 80 characters. Meaningful descriptions that include size and color information will be useful when 

generating schedules. 
4. Specify the point spacing from left to right and top to bottom. By default, a point spacing of 10 by 10 is used. As the point spacing changes, the 

text size adjusts, automatically. 
5. You may center the measurement points within the grid boundary, if desired, by clicking in the selection box adjacent to Center Points Relative 

to Grid Boundaries. 
6. Select the light meter type by clicking on the appropriate radio button (and entering the desired values, if necessary). By default, the horizontal 

meter and grid is selected. 
7. Specify the Summary  options to calculate. By default, average, maximum and minimum illuminance are displayed along with uniformity ratios 

(Max/Avg ratio is not selected by default). If Number of Points is selected, the number of points that are in the calculation (not including points 
that have been removed) are shown. 

8. Select the display options, including precision, text color, perimeter lines, point markers and labeling. 
9. Specify the Z coordinates of the first and third input points. You will have the option to change these values, if desired, when creating the grid. 

By default, both values are set to zero. If you selected Horizontal meter and grid the Z-coordinate for first and third points will always be the 
same. 

10. If desired, specify Isoline contouring and Highlight Values by clicking on the appropriate buttons. 
11. Click Ok. Control is now transferred to the drawing area to locate the grid. 
12. To change the grid elevation, move the cursor into the Z-Coord text box and enter a new value or use the up and down arrow keys on the 

keyboard, before clicking the first point. Locate the first point of the grid and click the left mouse button. 
13. Drag the cursor to the second point on the grid and left click again. This step defines the baseline of the grid. 
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14. Drag the cursor to the right corner of the grid and click the left mouse button one more time. This final step specifies the extents of the grid 
perpendicular to the baseline. By default, the Z coordinate will echo the first point's elevation or the predefined third point elevation (see step 7). 
To change the elevation for the third point, before clicking move the cursor into the Z-Coord text box and enter a new value or use the up and 
down arrow keys on the keyboard. You can not slope a plane if Horizontal meter and Grid are selected. 

Calculations Along Lines Concepts 

The Calculation Points Line command allows you to specify calculation points measuring Illuminance along a user defined line or series of lines. The 
line segments may be drawn in any direction and each one may have a different elevation point if desired. The calculation points are evenly 
distributed along the line segments according to the spacing value specified. Illuminance points along lines are used in many types of lighting 
applications: 

• Perimeter spill lighting - vertical and horizontal Illuminance measurements 

• Illuminance on a curved ramp with changing elevation 

• Pedestrian Lighting for arbitrary paths 

• Anywhere you need Illuminance calculations in a non-grid fashion 

Each vertex on the line may have a different Z value. This attribute allows you to follow the contour of curving ramps where the ramp elevation is 
continuously changing. In addition, non adjacent lines may be "joined" together for numeric analysis purposes, by including multiple lines within the 
same Label. 

Add Calculations - Illuminance along Lines 

This command allows you to create lines of points for which illuminance values will be calculated. Lines are specified in Plan view. Different Z 
coordinates may be entered for each vertex allowing you to create lines of varying elevations (great for interchanges). Multiple lines may be included 
in each definition. 

1. From the Add menu choose Calculations - Line, or from the Calculations toolbar select . 
2. Specify a unique label up to 32 characters. 
3. An optional description may be entered up to 80 characters. Meaningful descriptions that include size and color information will be useful when 

generating schedules. 
4. Specify the point spacing. By default, a point spacing of 10 is used. As the point spacing changes, the text size adjusts, automatically. 
5. Select the light meter  type. 
6. Specify the Summary  options to calculate. By default, average, maximum and minimum illuminance are displayed along with uniformity ratios 

(Max/Avg ratio is not selected by default). If Number of Points is selected, the number of points that are in the calculation (not including points 
that have been removed) are shown. 

7. Select the display options, including precision, text color, visible lines, point markers and labeling. 
8. Specify the Z coordinate of the first point of the line. You will have the option to change the Z coordinate value, if desired, when creating the 

vertices of the line(s). By default, this value is set to zero. 
9. If desired, specify Highlight Values by clicking on the appropriate buttons. 

10. Click Ok. 
11. To change the line elevation, move the cursor into the Z-Coord text box and enter a new value or use the up and down arrow keys on the 

keyboard, before clicking the first point. Locate the first point of the line and click the left mouse button. 
12. Drag the cursor to the second vertex on the line and left click again. By default, the Z coordinate will echo the first vertex's elevation. To change 

the elevation for the vertex, before clicking move the cursor into the Z-Coord text box and enter a new value or use the up and down arrow keys 
on the keyboard. 

13. Continue in this fashion until the line is complete. Right click the mouse to end the line at the last vertex. 
14. At this point, you have two options: 

• You may begin specifying a new line by locating the first point of the line and left clicking. Notice that the last specified Z coordinate is used to 
specify the elevation of the first point. To change the elevation, before clicking move the cursor into the Z-Coord text box and enter a new 
value or use the up and down arrow keys on the keyboard. 

• You may finish specifying the line(s) in this family by right clicking the mouse button again. This will confirm your line location(s) and place the 
points along the line. 

Calculations Polygon Concepts 

Calculation Polygons are used to encompass an irregular boundary (like a parking lot) with a uniformly spaced array of calculation points. This 
command is equivalent to creating a rectangular grid of points and then removing the undesired points to account for an irregular boundary - in one 
step! 

The point placement within the polygon is created parallel to the X-Y axis (points are orthogonally positioned). To position the points aligned along a 
user defined axis, choose a 3 point calculation grid instead (then remove any extraneous points if necessary). 
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Add Calculations - Polygon 

This command allows you to create polygons filled with points for which illuminance values will be calculated. Using the Polygon to place calculation 
points eliminates the need to remove points from a rectangular grid. Polygons must be specified in Plan view. 

Calculation Polygons are used when an irregular calculation grid is desired. Polygons are always horizontal and may be located at any elevation. 

To measure Exitance, Diffuse Luminance or Daylight Factor, use the Automatic Placement command to select the surfaces (object or room) for 
which calculations are desired. 

1. From the Add menu choose Calculations -Polygon. or from the Calculations toolbar select . 
2. Specify a unique label up to 32 characters. 
3. An optional description may be entered up to 80 characters. Meaningful descriptions that include size and color information will be useful when 

generating schedules. 
4. Specify the point spacing from left to right and top to bottom. By default, a point spacing of 10 by 10 is used. As the point spacing changes, the 

text size adjusts, automatically. You may override the text size, if desired. 
5. You may center the measurement points within the grid boundary, if desired, by clicking in the selection box adjacent to Center Points Relative 

to Grid Boundaries. 
6. Select the light meter  type. By default, the horizontal meter and grid is selected. 
7. Specify the Summary  options to calculate. By default, average, maximum and minimum illuminance are displayed along with uniformity ratios 

(Max/Avg ratio is not selected by default). If Number of Points is selected, the number of points that are in the calculation (not including points 
that have been removed) are shown. 

8. Select the display options, including precision, text color, polygon lines, point markers and labeling. 
9. Specify the Z coordinate of the polygon. You will have the option to change this value, if desired, before specifying the first point. By default, this 

value is set to zero. 
10. If desired, specify Isoline contouring and Highlight Values by clicking on the appropriate buttons. 
11. Creation Method: Choose whether to manually create boundary lines of polygon or choose an existing line, room or object as the boundary line. 

• If manually specifying polygon, the Z coordinate can be prespecified in the dialog. 

• If a tilted line, object or room is selected, polygon will be projected down to and created at lowest Z coordinate elevation.  
12. Click Ok to create the polygon. Follow the steps below depending on the selected creation method: 

Specify a Polygon Manually Create Polygon from Drawing Entity, Room or Object  

i. Locate the first point of the polygon and click the left mouse 
button. 

ii. Move the cursor to the second vertex on the polygon and left 
click again. 

iii. Continue in this fashion until the polygon is complete. Right click 
to close the polygon shape. The Polygon grid will be created. 

iv. To change the polygon elevation, move the cursor into the Z-
Coord text box and enter a new value or use the up and down 
arrow keys on the keyboard, before clicking the first point. Locate 
the first point of the grid and click the left mouse button. 

i. Locate the pickbox on the drawing entity line, object or room 
boundary you wish to use and left click. 

ii. If a valid polygon is found (see Notes below), it will be displayed 
as a bold line, and the Polygon Search results dialog will appear: 

• Accept Polygon and Repeat - Select another polygon line as a 
template for another grid with the same properties. Use pickbox 
to select another closed polygon. 

• Accept Polygon - Create grid using selected entity as polygon 
boundary. 

• Reselect Entities - Choose this option if invalid polygon was 
found or if incorrect line was chosen. Use pickbox to select 
another closed polygon. 

• Manually Specify Polygon - Select vertices manually to specify 
polygon boundary, right clicking once all vertices are specified. 
This option is necessary if no valid polygon is found. 

• Cancel - Do not create calculation entity. 

Notes: 

• Drawing Entity line segments do not need to be joined, just need 
to be within tolerances (2 decimals of precision - .05) 

• Line segments do not need to make a closed polygon - AGi32 will 
automatically close boundary line 

• AGi32 filters related lines by color. 

Caveats: 

• Disconnected line segments or line segments disconnected by 
gap larger than tolerance level will not form valid polygon. 

• Polygons with intersecting lines will not form valid polygon. 

• Incomplete polygons are not valid, may close in an unacceptable 
manner. 
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Calculations - Roadway - Concepts 

The Calculation Points - Roadway command allows you to specify several lighting metrics associated with roadway lighting applications in a straight 
segment of roadway. The resulting calculations are calculated based on the user’s selection of the roadway standard that they will be designing to. 
AGi32 includes default input parameters for grid placement and point spacing based on five roadway standards in use around the world:  

• The IES method uses the algorithms in IESNA RP-8-00 (reaffirmed in 2005) 

• The CIE method uses the algorithms in CIE 140-2000 

• The Australia and New Zealand methods use the algorithms in Australia/New Zealand Standard 1158.2-2005  
• The BSEN method uses the algorithms in the 13201-3.2003 document 

This table shows the calculation metrics that are defined in each standard: 

  IESNA RP-8 CIE 

140-

2000 

BSEN 13201-3 .2003 Australia 

1158.2-

2005 

New Zealand 

1158.2-2005 

Pavement 

Luminance 

X X X X X 

Illuminance X X X X X 

Veiling 

Luminance 

X         

Visibility Level 

(STV) 

X         

Longitudinal 

Uniformity 

  X X X X 

Vertical 

Illuminance 

    X     

Semi-cylindrical 

Illuminance 

  X X     

Hemispherical 

Illuminance 

    X     

Surround 

Illuminance 

  X X X X 

Veiling 

Luminance w/TI 

  X X X X 

  

Note: Files with Roadway Calculation grids created in version 2.1 or later will not open in earlier versions of AGi32. Files created in version 2.04 or 
earlier can be opened in version 2.1 or later, but the calculation grids are converted to a single Illuminance grid that can be edited in the later 
versions. Converted grids are assigned to '_Converted-Illuminance Only' standard. Converted grids must be edited in order to apply an actual 
Roadway Standard and select additional calculation metrics. A message is displayed when opening a .AGI file with older-version roadway grids. 

Roadway Luminance Calculations With Reflective Surfaces 

In Full Radiosity Mode, the Roadway Luminance calculation can take reflective or obstructive entities around or within the luminance grid into 
account, per IESNA Recommended Practice for Tunnel Lighting, RP-22, recommendations. This is also true for the associated illuminance and 
veiling luminance calculations. Surfaces that are to be included in the Roadway Luminance calculations must be assigned a special surface type 
(Roadway Contributor). The Roadway Pavement may also be visualized for rendering purposes by assigning it a special surface type as well 
(Roadway Pavement - Direct Flux Only). Surfaces may be composed of 3D Entities imported into AGi32 or made with AGi32's modeling entities. In 
either case, the existing surfaces must be modified in AGi32 by editing the entity and selecting the Surface Edit button in the Edit dialog, or by using 
the Surface Edit command to select the entities. 

More information is available in the Roadway Luminance Calculations With Reflective Surfaces topic. 

Technical Details 

The Roadway Optimizer tool and Roadway Luminance command provide assistance in computing calculations for straight segments of roadways 
using IES, CIE, BSEN, CIE-Australia, or CIE-New Zealand methods. Some of the criteria and recommended values are provided here. 

Terminology, by Standard 

IES, RP-8-00 

AGi32 creates the calculation grids used to calculate Pavement Luminance and Veiling Luminance per the latest revision of RP-8 (RP-8-00).  

Average Pavement Luminance (Lavg) - Luminance on the pavement is based on the quantity and direction of light, observer location, and the 
pavement reflectance characteristics. The overall average luminance of the road surface as observed from a specific point in cd/m

2
. Metric units are 
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used regardless of current settings. Observer position is 1.45 meters above the pavement surface and 83.07 meters back from each computation 
point along a longitudinal line parallel to the direction of travel. Observer line of sight is 1 degree below horizontal. Observer position changes relative 
to the curb line to align with each row of calculation points. A Roadway Luminance grid represents the calculation points for a single directional flow 
of traffic. To consider the entire roadway, a calculation grid should be created for each direction of traffic flow. The directional flow of traffic is 
determined by the specified order of the curb points defining the length of the roadway. Traffic flows in the direction of first point to second point. The 
third point defines the width of the roadway from curb to curb in one direction of traffic flow. 

Illuminance - Illuminance is a measure of the lumens incident on the pavement divided by the area. The units are lumens per square foot 
(footcandles) or lumens per square meter (lux). Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Veiling Luminance (Lv) - A measure of disability glare, veiling luminance is a luminance superimposed over the eye's retinal image that is produced 
by stray light within the eye. In the IES method, Lv is computed at the same points as the pavement luminance with the observer 83.07 meters back 
from each computation point. Observer line of sight is horizontal at 1.45 m above the road surface.  

Veiling Luminance ratio - The IES method uses the maximum value of Veiling Luminance (Lv,max) divided by the Average Pavement Luminance 
(Lavg) as a measure of the disability glare produced by a lighting system. 

Weighted Average VL (STV) – A measure of the visibility of small targets in the roadway considering the target luminance, veiling luminance and 
the background pavement luminance against which they are seen. The weighted average of all Visibility Levels (STV) is given. An Visibility Level grid 
may be included in the calculated results. It is recommended that this grid be examined, as it provides information about contrast bands . When 
considering Visibility Level and STV, designs are created that produce negative and positive contrast, all positive contrast, and all negative contrast. 
The weighted average of the calculated Visibility Levels is displayed as the STV. 

CIE 140-2000 

Average Pavement Luminance - The overall average luminance of the road surface as observed from a specific point in cd/m
2
. Metric units are 

used, regardless of current settings. By default, observer position is 1/4 roadway width inset from the curb, 1.5 m above the pavement surface and 
60m back from the first lateral row of computation points in the grid. Line of sight is 0.5 - 1.5 degrees below horizontal, depending on the distance to 
the points. Observer position is static relative to the curb line. 

Illuminance - Illuminance is a measure of the lumens incident on the pavement divided by the area. The units are lumens per square meter (lux). 
Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Longitudinal Uniformity - The ratio of minimum to maximum pavement luminance, illuminance or veiling luminance is taken along each longitudinal 
line of computation points. The worst-case ratio is displayed as the Longitudinal Uniformity Ratio. For the CIE method, an additional grid of pavement 
luminance points is computed, with observer position centered in the middle of each lane, 60m back from the first lateral row of computation points in 
the grid, and viewing along the line of points in that lane. 

Veiling Luminance (Lv) - A measure of disability glare, Veiling Luminance is a luminance superimposed over the eye's retinal image produced by 
stray light within the eye. In the CIE method, Lv is computed along a single row of calculation points directly in front of the observer position. By 
default, the distance of the observer to the first lateral row of computation points in the grid is 2.75 x (mounting ht - 1.5) meters and 1/4 road width 
from the curb line. 0.5 - 1.5 degrees below horizontal, depending on the distance to the points. The maximum value of Lv is used to compute the 
relative Threshold Increment (TI). NOTE: The CIE 140-2000 method of calculating veiling luminance is per 1000 lamp lumens. This generates rather 
small values. Therefore, it is recommended that if you are calculating veiling luminance with the CIE standard, you first open the Units dialog (bottom 
toolbar in Model Mode or top toolbar in Roadway Optimizer) and set the Number of Decimals value to 2 or 3. This will help to avoid generating all 
zeros. 

Relative Threshold Increment (TI) - A measure of the effect of disability glare produced by the lighting system. Threshold Increment is intended to 
yield the percentage increase in the luminance of the road's surface required to render an object just visible (threshold of visibility) under the 
proposed lighting system (glare present) as compared to the luminance required to render the object just visible in the absence of glare. 

BSEN 13201-3.2003 

Average Pavement Luminance - The overall average luminance of the road surface as observed from a specific point in cd/m
2
. Metric units are 

used, regardless of current settings. By default, observer position is 1/4 roadway width inset from the curb, 1.5 m above the pavement surface and 
60m back from the first lateral row of computation points in the grid. Line of sight is 0.5 - 1.5 degrees below horizontal, depending on the distance to 
the points. Observer position is static relative to the curb line. 

Horizontal Illuminance - Horizontal illuminance at a point is a measure of the lumens incident on the pavement divided by the area. The units are 
lumens per square meter (lux). Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Longitudinal Uniformity - The ratio of minimum to maximum pavement luminance, illuminance or veiling luminance is taken along each longitudinal 
line of computation points. The worst-case ratio is displayed as the Longitudinal Uniformity Ratio. For the CIE method, an additional grid of pavement 
luminance points is computed, with observer position centered in the middle of each lane, 60m back from the first lateral row of computation points in 
the grid, and viewing along the line of points in that lane. 

Vertical Illuminance - Measured in lux, vertical illuminance at a point is calculated on a plane 1.5 m above the surface of the road. The grid is 
located on the same points as the roadway luminance grid. 

Semi-cylindrical Illuminance - Measured in lux, semi-cylindrical illuminance at a point could be considered a type of vertical illuminance, but its 
calculated value varies with the direction of interest. It is calculated at 1.5 meters above the road surface and on a half cylinder whose front is lined 
up parallel to the main directions of pedestrian movement, which for a road are usually longitudinal. The grid is located on the same points as the 
roadway luminance grid. 
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Hemispherical Illuminance - Measured in lux, hemispherical illuminance at a point is calculated at ground level on the road surface. Its formula is 
similar to the formula for horizontal illuminance, but differs from it in the way that the angle of incidence is considered. 

Surround Ratio - This is a ratio of the average horizontal illuminance on the two longitudinal strips each adjacent to the two edges of the 
carriageway (the surround illuminance), divided by the average horizontal illuminance on two longitudinal strips each adjacent to the two edges of the 
carriageway, but lying on the carriageway. The width of all four strips shall be the same, and equal to 5m, or half the width of the carriageway, or the 
width of the unobstructed strip lying off the carriageway, whichever is the least. For dual carriageways, both carriageways together are treated as a 
single carriageway unless they are separated by more than 10m. 

Veiling Luminance (Lv) - A measure of disability glare, Veiling Luminance is a luminance superimposed over the eye's retinal image produced by 
stray light within the eye. In the BSEN method, Lv is computed along a single row of calculation points directly in front of the observer position. By 
default, the distance of the observer to the first lateral row of computation points in the grid is 2.75 x (mounting ht - 1.5) meters and 1/4 road width 
from the curb line. 0.5 - 1.5 degrees below horizontal, depending on the distance to the points. The maximum value of Lv is used to compute the 
relative Threshold Increment (TI). 

Relative Threshold Increment (TI) - A measure of the effect of disability glare produced by the lighting system. Threshold Increment is intended to 
yield the percentage increase in the luminance of the road's surface required to render an object just visible (threshold of visibility) under the 
proposed lighting system (glare present) as compared to the luminance required to render the object just visible in the absence of glare. 

Australia Standard 1158.2- 2005 

Average Pavement Luminance - The overall average luminance of the road surface as observed from a specific point in cd/m
2
. Metric units are 

used, regardless of current settings. By default, observer position is 1/4 roadway width inset from the curb, 1.5 m above the pavement surface and 
60m back from the first lateral row of computation points in the grid. Line of sight is 0.5 - 1.5 degrees below horizontal, depending on the distance to 
the points. Observer position is static relative to the curb line. 

Illuminance - Illuminance is a measure of the lumens incident on the pavement divided by the area. The units are lumens per square meter (lux). 
Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Longitudinal Uniformity - The ratio of minimum to maximum pavement luminance, illuminance or veiling luminance is taken along each longitudinal 
line of computation points. The worst-case ratio is displayed as the Longitudinal Uniformity Ratio. For the CIE method, an additional grid of pavement 
luminance points is computed, with observer position centered in the middle of each lane, 60m back from the first lateral row of computation points in 
the grid, and viewing along the line of points in that lane. 

Surround Ratio - This is a ratio of the average horizontal illuminance on the two longitudinal strips each adjacent to the two edges of the 
carriageway (the surround illuminance), divided by the average horizontal illuminance on two longitudinal strips each adjacent to the two edges of the 
carriageway, but lying on the carriageway. The width of all four strips shall be the same, and equal to 3 meters. The grid shall be placed at the same 
distance as the luminance calculation field. 

Veiling Luminance (Lv) - A measure of disability glare, Veiling Luminance is a luminance superimposed over the eye's retinal image produced by 
stray light within the eye. In the BSEN method, Lv is computed along a single row of calculation points directly in front of the observer position. By 
default, the distance of the observer to the first lateral row of computation points in the grid is 2.75 x (mounting ht - 1.5) meters and 1/4 road width 
from the curb line. 0.5 - 1.5 degrees below horizontal, depending on the distance to the points. The maximum value of Lv is used to compute the 
relative Threshold Increment (TI). 

Relative Threshold Increment (TI) - A measure of the effect of disability glare produced by the lighting system. Threshold Increment is intended to 
yield the percentage increase in the luminance of the road's surface required to render an object just visible (threshold of visibility) under the 
proposed lighting system (glare present) as compared to the luminance required to render the object just visible in the absence of glare. 

Australia Standard 1158.2- 2005 - SAASTAN 

The SAASTAN software calculates some of the Australian metrics differently than Australian Standard 1158.2-2005 defines. Specifically, the 
luminaire cycles that will contribute to the calculation grid points are different in SAASTAN from what is defined in AS 1158.2-2005, and the position 
of the observer for the veiling luminance calculations is also different. These differences can lead to different calculated values for any or all of the 
roadway metrics. 

AGi32 includes AS 1158.2-2005 - SAASTAN as a selectable "standard" for those projects that must be calculated by SAASTAN methods rather than 
by Standard 1158.2-2005. 

New Zeland Standard 1158.2- 2005 

Average Pavement Luminance - The overall average luminance of the road surface as observed from a specific point in cd/m
2
. Metric units are 

used, regardless of current settings. By default, observer position is 1/4 roadway width inset from the curb, 1.5 m above the pavement surface and 
60m back from the first lateral row of computation points in the grid. Line of sight is 0.5 - 1.5 degrees below horizontal, depending on the distance to 
the points. Observer position is static relative to the curb line. 

Illuminance - Illuminance is a measure of the lumens incident on the pavement divided by the area. The units are lumens per square meter (lux). 
Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Longitudinal Uniformity - The ratio of minimum to maximum pavement luminance, illuminance or veiling luminance is taken along each longitudinal 
line of computation points. The worst-case ratio is displayed as the Longitudinal Uniformity Ratio. For the CIE method, an additional grid of pavement 
luminance points is computed, with observer position centered in the middle of each lane, 60m back from the first lateral row of computation points in 
the grid, and viewing along the line of points in that lane. 
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Surround Ratio - This is a ratio of the average horizontal illuminance on the two longitudinal strips each adjacent to the two edges of the 
carriageway (the surround illuminance), divided by the average horizontal illuminance on two longitudinal strips each adjacent to the two edges of the 
carriageway, but lying on the carriageway. The width of all four strips shall be the same, and equal to 3 meters.The grid shall be placed at the same 
distance as the luminance calculation field. 

Veiling Luminance (Lv) - A measure of disability glare, Veiling Luminance is a luminance superimposed over the eye's retinal image produced by 
stray light within the eye. In the BSEN method, Lv is computed along a single row of calculation points directly in front of the observer position. By 
default, the distance of the observer to the first lateral row of computation points in the grid is 2.75 x (mounting ht - 1.5) meters and 1/4 road width 
from the curb line. 0.5 - 1.5 degrees below horizontal, depending on the distance to the points. The maximum value of Lv is used to compute the 
relative Threshold Increment (TI). 

Relative Threshold Increment (TI) - A measure of the effect of disability glare produced by the lighting system. Threshold Increment is intended to 
yield the percentage increase in the luminance of the road's surface required to render an object just visible (threshold of visibility) under the 
proposed lighting system (glare present) as compared to the luminance required to render the object just visible in the absence of glare. 

R-Tables 

A roadway's reflective characteristics are defined by its physical surface properties. Sufficient data has been collected on the reflectance 
characteristics of different pavement types to allow them to be described by reflectance tables or "R" tables.  

Six typical roadway pavements are provided for your use, as defined in the R-Table pull-down menu. 

R-Table Overall Reflectance Coefficient (Q0 ) Description 

R1 0.10 Mostly diffuse reflectance properties 
characteristic of Portland cement or asphalt 
surface with a minimum of 15% of the 
aggregates composed of artificial brightener 
aggregates. 

R2 0.07 A combination of diffuse and specular 
reflectances characteristic of asphalt surfaces 
with aggregate composed of a minimum of 
60% gravel of size greater than 10 mm. Also 
asphalt surfaces composed of 10% - 15% 
artificial brightener in aggregate mix. 

R3 0.07 Slightly specular reflectance typical of asphalt 
surfaces with dark aggregates, rough texture 
and some months of use. This surface is 
common in the United States. 

R4 0.08 Mostly specular surface typical of very smooth 
asphalt texture. 

NZN4 0.09 Diffuse Chip Seal surface 

NZR2 0.09 Glossy polished asphaltic surface 

Additional R-tables can be added to AGi32 easily. Please contact Lighting Analysts for details. 

Illuminance vs Luminance 

The average pavement luminance is influenced by three factors: the quantity and direction of light, the observer location, and the reflective 
characteristics of the pavement. Illuminance, on the other hand, measures the light incident on the pavement surface. Observer direction and 
pavement reflectance are irrelevant. 

Both Illuminance and Luminance design criteria are widely used in the United States and Canada, and there is certainly a strong relationship 
between the two metrics. However, it is possible to meet the Illuminance criteria, yet be substantially far away from the recommended Luminance 
guidelines. 
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IES Recommended Design Criteria 

The Illuminating Engineering Society (IES) of North America provides recommended roadway design criteria in its document called Recommended 
Practice 8, Roadway Lighting (RP-8). RP-8-00, published in 2000 and reaffirmed in 2005 contains the tables shown in the RP-8 Design Criteria topic. 

Calculation Results 

When the calculations are complete, you will be presented with luminance statistics. If other metrics such as illuminance veiling luminance statistics 
are also calculated, these statistics will also be presented in the Statistics window. (Enable with the Statistics toggle button on the bottom toolbar.) 

Discomfort Glare is not calculated for roadway luminance grids. This metric requires us to know the number of luminaires per kilometer. This number 
is not known since the roadway luminance grid can be applied to an arbitrary section of roadway and considers any luminaires that are located in the 
graphics window. 

Add Calculations - Roadway 

The Add Calculations - Roadway command allows you to specify certain lighting metrics associated with roadway lighting applications in a straight 
segment of roadway. The resulting calculations are calculated based on the user’s selection of the roadway standard that they will be designing to. 
AGi32 includes default input parameters for grid placement and point spacing based on five roadway standards in use around the world. These 
standards are: 

•  IESNA RP-8-00 (reaffirmed in 2005) (See separate topic for RP-8 Design Criteria.) 

•  CIE 140-2000  

• Australia/New Zealand Standard 1158.2-2005  
•  BSEN 13201-3.2003 

Click on the Concepts tab above, for a table showing the metrics defined in each of these standards. 

The Roadway Luminance, Veiling Luminance, and Visibility Level (STV) grids represent the calculation points for a single directional flow of traffic. To 
consider the entire roadway, a calculation grid should be created for each direction of traffic flow. The directional flow of traffic is determined by the 
specified order of the curb points defining the length of the roadway. Traffic flows in the direction of first point to second point. The third point defines 
the width of the roadway from curb to curb in one direction of traffic flow. 

The Roadway Luminance calculation can take reflective or obstructive entities around or within the luminance grid into account, per RP-22 
recommendations. This is also true for the associated illuminance and veiling luminance calculations. Surfaces that are to be included in the 
Roadway Luminance calculations must be assigned a special surface type (Roadway Contributor). The Roadway Pavement may also be visualized 
for rendering purposes by assigning it a special surface type as well (Roadway Pavement - Direct Flux Only). Surfaces may be composed of 3D 
Entities imported into AGi32 or made with AGi32's modeling entities. In either case, the existing surfaces must be modified in AGi32 by  Editing the 
entity and selecting the Surface Edit button in the Edit dialog, or by using the Surface Edit command to select the entities. 

1. From the Add menu, choose Calculations - Roadway Luminance, or from the Calculations Toolkit select . 
2. Specify a unique Label for the calculation grid, up to 32 characters long. 
3. An optional Description may be entered (up to 80 characters). Meaningful descriptions will be useful when generating schedules. 
4. Select the roadway standard you wish to use from the pull-down menu just below the Description field. AGi32 will use this to determine the 

observer position (if any) and the point spacing. 
5. On the left side of the dialog, indicate with a checkmark the metrics that you wish to include. A separate grid will be created for each.  
6. Specify the Number of Lanes in the Direction of Travel and (if applicable) in the Opposite Direction. (Some standards considered the lanes in 

both directions; others consider only the lanes in the Observer's direction of traffic flow.) If there is a median, only specify the lanes in the 
Direction of Travel; use 0 for the number of lanes in the Opposite Direction. 

7. Check that the correct Driver's Side of Roadway is indicated. The default is right for RP-8 and CIE standards, and left for Australia, BSEN and 
New Zealand standards. 

8. The Point Spacing Along the Roadway may be a set value, or it may be based on the Number of Luminaire Cycles that the grid will cover, 
depending on the standard selected. 

9. Select the R table from the pull-down menu that best describes the roadway pavement. Six R tables are provided. The Actual Q0 Value is 
extracted from the selected R-Table but may be overridden by entering a different value. 

10. Specify the Summary  options to calculate. The statistics called for by the chosen standard are checked by default. Others may be selected as 
well. 

11. Select the display options, including precision (decimals displayed), text color, grid perimeter lines, lane and direction indicators, Observer 
position,grid points, and labeling. 

12. If desired, you may pre-specify the Z coordinates of the grid before exiting the dialog. You will also have the opportunity to change the Z 
coordinate of the grid while specifying the grid vertices in the graphics window. 

13. If desired, specify Isolines contouring and/or Highlight Values by clicking on the appropriate buttons on the right side of the dialog. 
14. Click OK to return to the graphics window and place the roadway calculation grid(s). 
15. Locate the first point of the grid at the curb edge of the roadway so that it is lined up with a luminaire position and click the left mouse button.(To 

change the grid elevation at the start of the roadway, move the cursor into the Z-Coord text box and enter a new value, or use the up and down 
arrow keys on the keyboard, before clicking the first point.)  

16. Drag the cursor to the second point on the grid, along the curb line, and left click again. Important: The order in which the points are entered 
determines the direction of the flow of traffic. Traffic flows along the roadway from point 1 to point 2. For example, to consider traffic flowing in 
an eastward direction, click the first 2 points on the curb line from left to right. (To change the grid elevation at the end of the roadway, move the 
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cursor into the Z-Coord text box and enter a new value, or use the up and down arrow keys on the keyboard, before clicking the second point. 
This allows you to tilt the roadway in the direction of traffic flow.) 

17. Drag the cursor to the 3
rd
 point on the road. This point defines the roadway width. Note: For RP-8, the roadway width is defined for one direction 

of traffic flow only. For the other standards, the width is the entire roadway (carriageway) unless there is a median. 

Note: Once a Visibility Level (VL) grid has been created (for IES RP-8 standard), the individual grids may not be deleted separately in Project 
Manager. Visibility Level calculations require the roadway luminance, background luminance,and veiling luminance results, thereby tying all the grids 
together. 

Roadway Standards - Configure - Concepts 

AGi32 provides several roadway standards to chose from when specifying a roadway calculation grid. However, the user may also define a "custom" 
standard by clicking the Configure button in the Calculation Points - Roadway Luminance - 3 Pt grid dialog. This opens the Roadway Standards 
dialog. You may start with any of the existing standards, modify point spacing, observer location, and other characteristics, as well as the metrics to 
include in the custom standard. This new standard is then saved for future reference and use. 

The calculation zone may cover one direction of traffic or two-way traffic. For two-way traffic, AGi32 assumes no median width. You may also change 
the side of the road that the driver is on. 

The default settings in the Roadway Standards dialog are determined by the Roadway Standard that is showing in that field (top of dialog). The 
Calculation Metrics defined by the selected standard are listed in the field on the left side of the dialog. The Configure button below this list allows 
you to select the metrics to include in the custom standard. Definitions of the roadway metrics may be found in Calculation Metrics. 

Clicking on one of the metrics listed on the left gives it focus, and the default definitions of the Calculation Grid point spacing and the Observer 
position are displayed.  

The point spacing across and along the road are defined separately. (Calculation tab) 

• For across-road spacing, you may specify:  
o a set spacing, 
o a fixed number of rows of points per lane or per roadway (carriageway), or 
o point spacing based on location of the first point, the number of rows of points desired, and their maximum spacing. 

• For along-road spacing, you may specify: 
o a set spacing, or  
o the number of columns of points within a luminaire cycle. 

On the Observer tab, you may specify one Observer location per row of points, one per lane, or one for the entire roadway. In addition, you may also 
specify the height of the Observer above the roadway surface and the distance of the Observer from the beginning of the grid or from each 
calculation point. In some of the standards,depending on the metric, the Observer's location may be based on a Mounting Height Equation. The 
default values of this equation may be changed. 

It is important to note that the R-Tables are based on empirical data for an observer with a viewing angle of 1 degree below horizontal. If the 
Observer's height or distance from the grid points changes, this will affect the viewing angle. Small changes will have small effects, but larger 
changes could invalidate the calculation.  

For additional information on creating a custom standard, click on the Procedures tab at the top of this topic. 

Roadway Standards - Configure 

AGi32 provides several roadway standards to chose from when specifying a roadway calculation grid. However, the user may also define a "custom" 
standard by clicking the Configure button in the Calculation Points - Roadway Luminance - 3 Pt grid dialog. This opens the Roadway Standards 
dialog. You may start with any of the existing standards, modify point spacing, observer location, and other characteristics, as well as the metrics to 
include in the custom standard. This new standard is then saved for future reference and use. Use the following steps to modify an existing standard 
to become a custom standard. 

1. Begin by selecting the standard that you wish to modify from the drop-down Roadway Standard menu. 
2. In the upper-left corner of the dialog, select to Show Units in Meters or Feet. 
3. Select either One Direction Only or Entire Roadway for the across-road span of the calculation grid(s) in your standard. 
4. Select the side of the road that the driver will be on, left side or right side. 
5. The Luminaire Cycles button will open the Luminaire Cycles dialog. This dialog only applies to Roadway Optimizer, but its attributes may be set 

here. 
6. In the Calculation Metrics, left side of dialog, the metrics included in the standard that you are starting with are listed. Click the Configure button 

below the list to open up the Roadway Standards - Calculation Metrics dialog. You may include as many or as few of these metrics in your 
custom standard as applicable. Place or remove checkmarks as appropriate, and then click OK to return to the Roadway Standards dialog. 

7. Click once on one of the Calculation Metrics to give it focus. The top metric is selected by default. Depending on the standard that you started 
with and the selected metric, you may be able to adjust the height of the calculation grid above the roadway.  

8. On the Calculation Grid tab, the point spacing across and along the roadway (carriageway) are defined separately. For across-road spacing, 
there are three general possibilities: 
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• Set Spacing. Put a dot in the Select Spacing radio button and indicate the spacing between rows. Next,specify the distance of 
the first row of points from the curb. This is the First Row Offset. 

• Dynamic: The number of rows will depend on the minimum number of points and the maximum row spacing. The number of 
rows refers to the number across the width of the roadway (carriageway); this will be the one-way width or both directions, 
depending on your selection above.Select whether the number of rows will be Per Roadway or Per Lane. Next, if you selected 
Per Roadway, specify the distance of the first row from the edge of the roadway as a fraction of the row spacing; this is the 
First Row Offset. For example, if you wanted to have 6 rows of points across the road, no more than 5 feet apart, and you 
wanted to place the first row at 2.5 feet from the curb, you would enter 6 for the Minimum Number of Points, 5 for the Maximum 
Allowable Spacing, and 0.5 for the First Row Offset. If you selected Per Lane, the First Row Offset is fixed at 0.5 x the row 
spacing.  

• Static: A fixed number of rows of points per lane or per roadway (carriageway).Select whether the number of rows will be Per 
Roadway or Per Lane. Next, specify the Offset of each row with respect to the road or lane width, depending on which you 
select. For example, if you wanted to have two rows of points per lane, you would put a dot in the radio button for Per Lane. 
Then you would select Static and enter a 2 for the Number of Rows per lane. The Offset values in the table below the Number 
of Rows tell AGi32 how far from the edge of the lane each row of points is located. The Offset value is a fraction of the lane 
width, as in our example, or of the roadway width, depending on which you selected. If applicable, you may also include an 
Adder value, to shift the points a specific distance. 

8. For along-road spacing, there are two general possibilities: 

• Set Spacing. Put a dot in the Select Spacing radio button and indicate the spacing between rows. Next,specify the distance of 
the first row of points from the curb. This is the First Row Offset. 

• The Number of Columns Per Luminaire Cycle. Put a dot in the radio button for Number of Columns Per Luminaire Cycle and 
enter a value for the Minimum Number of Points that you want included in the grid between luminaires, as well as the Maximum 
Spacing of the points. The First Column Offset indicates the distance from the first luminaire to the first column of points and is 
expressed as a fraction of the column spacing. If you want the first column of points to be lined up with the first luminaire, enter 
0 for this value. 

9. On the Observer tab, select where the Observer(s) will be located:  

• Observer Type. You may have One Per Row of Calculations Points, One Per Lane, or One Per Roadway. In the case of one 
per row of calc points or one per roadway, there will be one calculation grid for that metric. In the case of one observer per 
lane, the number of calc grids for that metric will be equal to the number of lanes. 

• Observer Position, Height Above Roadway *. Enter the height of the Observer's eyes above the roadway. (Feet or meters, 
depending on the units selected in the upper-left corner of the dialog.) 

• Observer Position, Along Roadway *. Two possibilities here: 
o Static. The Observer is a fixed distance from the beginning of the calculation area. It is important to note that this is 

not the distance to the first point, but the distance to the near boundary of the calculation area; the first point may be 
offset a short distance past this boundary. Enter a single value for this distance. For example, in the CIE standard, the 
Observer is 60 meters back from the near edge of the calculation area. The first column of points is slightly past that, 
and the rest of the points are farther away. 

o Dynamic. In this case, the Observer's position moves. If you select Set Distance and enter a value, there will be an 
Observer at that distance from each column of calculation points. (AGi32 only shows the Observer(s) for the first 
column of points.) If you select Based on MH Equation, you will then need to specify the formula that AGi32 should 
use. Click in the field for either meters or feet. In the MH Equation dialog, enter the appropriate values and click OK. 
See Roadway Standard - Mounting Height Equation for more information on this choice. 

• Observer Position, Across Roadway. Two possibilities here: 
o Static. Specify a distance that the Observer should be located from the edge of the roadway or lane, depending on 

what you specified above.  
o Dynamic. Specify that the Observer's distance from the edge is a fraction of the lane or roadway width, depending on 

what you specified above. 

10. Repeat steps 6 - 9 for each of the Calculation Metrics listed on the left side of the dialog. 

11. When you have finished specifying the parameters of your custom standard, click on the Save Changes button. You will be prompted for a 
name. You will not be allowed to overwrite an existing standard, but you can save the changes under a new name.  

The custom standard that you created will be available for future use by selecting it from the Roadway Standard menu in the Calculation Points - 
Roadway Luminance - 3 Pt grid dialog. 

* IMPORTANT: Regarding the Observer position, it is important to note that the R-Tables are based on empirical data for an observer with a 
viewing angle of 1 degree below horizontal. If the Observer's height or distance from the grid points changes, this will affect the viewing angle. 
Small changes will have small effects, but larger changes could invalidate the calculation.  

Roadway Standard - Calculation Metrics 

AGi32 allows you to specify roadway calculation grids according to the definitions in five roadway standards in use around the world. These 
standards are: 



AGi32 Help System  Adding Entities 

170 

 

•  IESNA RP-8-00 (reaffirmed in 2005) 

•  CIE 140-2000  

• Australia/New Zealand Standard 1158.2-2005  

•  BSEN 13201-3.2003 

• Australia 1158.2-2005-SAASTAN 

This table shows the calculation metrics that are defined in each standard: 

  IESNA RP-8 CIE 

140-

2000 

BSEN 13201-3 .2003 Australia 

1158.2-2005 

New Zealand 

1158.2-2005 

Pavement 

Luminance 

X X X X X 

Illuminance X X X X X 

Veiling Luminance X         

Visibility Level 

(STV) 

X         

Longitudinal 

Uniformity 

  X X X X 

Vertical 

Illuminance 

    X     

Semi-cylindrical 

Illuminance 

  X X     

Hemispherical 

Illuminance 

    X     

Surround 

Illuminance 

  X X X X 

Veiling Luminance 

w/TI 

  X X X X 

  

Definitions of these metrics are provided below, listed by standard. 

  

Selecting Calculation Metrics for a Custom Standard 

In creating a custom standard, you may select from the metrics listed in the Roadway Standard - Calculation Metrics dialog. Depending on the 
standard that you start with, certain metrics will be checked by default. You may check or uncheck any of the metrics and then click OK. The selected 
(checked) metrics will be listed in the Calculation Metrics field on the left side of the Roadway Standards dialog.  

See Roadway Standards - Configure - Concepts for more information on creating custom standards. 

  

Calculation Metric Definitions, by Standard 

IES, RP-8-00 

AGi32 creates the calculation grids used to calculate Pavement Luminance and Veiling Luminance per the latest revision of RP-8 (RP-8-00).  

Average Pavement Luminance (Lavg) - Luminance on the pavement is based on the quantity and direction of light, observer location, and the 
pavement reflectance characteristics. The overall average luminance of the road surface as observed from a specific point in cd/m

2
. Metric units are 

used regardless of current settings. Observer position is 1.45 meters above the pavement surface and 83.07 meters back from each computation 
point along a longitudinal line parallel to the direction of travel. Observer line of sight is 1 degree below horizontal. Observer position changes relative 
to the curb line to align with each row of calculation points. A Roadway Luminance grid represents the calculation points for a single directional flow 
of traffic. To consider the entire roadway, a calculation grid should be created for each direction of traffic flow. The directional flow of traffic is 
determined by the specified order of the curb points defining the length of the roadway. Traffic flows in the direction of first point to second point. The 
third point defines the width of the roadway from curb to curb in one direction of traffic flow. 

Illuminance - Illuminance is a measure of the lumens incident on the pavement divided by the area. The units are lumens per square foot 
(footcandles) or lumens per square meter (lux). Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Veiling Luminance (Lv) - A measure of disability glare, veiling luminance is a luminance superimposed over the eye's retinal image that is produced 
by stray light within the eye. In the IES method, Lv is computed at the same points as the pavement luminance with the observer 83.07 meters back 
from each computation point. Observer line of sight is horizontal at 1.45 m above the road surface.  

Veiling Luminance ratio - The IES method uses the maximum value of Veiling Luminance (Lv,max) divided by the Average Pavement Luminance 
(Lavg) as a measure of the disability glare produced by a lighting system. 
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Weighted Average VL (STV) – A measure of the visibility of small targets in the roadway considering the target luminance, veiling luminance and 
the background pavement luminance against which they are seen. The weighted average of all Visibility Levels (STV) is given. An Visibility Level grid 
may be included in the calculated results. It is recommended that this grid be examined, as it provides information about contrast bands . When 
considering Visibility Level and STV, designs are created that produce negative and positive contrast, all positive contrast, and all negative contrast. 
The weighted average of the calculated Visibility Levels is displayed as the STV. 

CIE 140-2000 

Average Pavement Luminance - The overall average luminance of the road surface as observed from a specific point in cd/m
2
. Metric units are 

used, regardless of current settings. By default, observer position is 1/4 roadway width inset from the curb, 1.5 m above the pavement surface and 
60m back from the first lateral row of computation points in the grid. Line of sight is 0.5 - 1.5 degrees below horizontal, depending on the distance to 
the points. Observer position is static relative to the curb line. 

Illuminance - Illuminance is a measure of the lumens incident on the pavement divided by the area. The units are lumens per square meter (lux). 
Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Longitudinal Uniformity - The ratio of minimum to maximum pavement luminance, illuminance or veiling luminance is taken along each longitudinal 
line of computation points. The worst-case ratio is displayed as the Longitudinal Uniformity Ratio. For the CIE method, an additional grid of pavement 
luminance points is computed, with observer position centered in the middle of each lane, 60m back from the first lateral row of computation points in 
the grid, and viewing along the line of points in that lane. 

Veiling Luminance (Lv) - A measure of disability glare, Veiling Luminance is a luminance superimposed over the eye's retinal image produced by 
stray light within the eye. In the CIE method, Lv is computed along a single row of calculation points directly in front of the observer position. By 
default, the distance of the observer to the first lateral row of computation points in the grid is 2.75 x (mounting ht - 1.5) meters and 1/4 road width 
from the curb line. 0.5 - 1.5 degrees below horizontal, depending on the distance to the points. The maximum value of Lv is used to compute the 
relative Threshold Increment (TI). 

Relative Threshold Increment (TI) - A measure of the effect of disability glare produced by the lighting system. Threshold Increment is intended to 
yield the percentage increase in the luminance of the road's surface required to render an object just visible (threshold of visibility) under the 
proposed lighting system (glare present) as compared to the luminance required to render the object just visible in the absence of glare. 

BSEN 13201-3.2003 

Average Pavement Luminance - The overall average luminance of the road surface as observed from a specific point in cd/m
2
. Metric units are 

used, regardless of current settings. By default, observer position is 1/4 roadway width inset from the curb, 1.5 m above the pavement surface and 
60m back from the first lateral row of computation points in the grid. Line of sight is 0.5 - 1.5 degrees below horizontal, depending on the distance to 
the points. Observer position is static relative to the curb line. 

Horizontal Illuminance - Horizontal illuminance at a point is a measure of the lumens incident on the pavement divided by the area. The units are 
lumens per square meter (lux). Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Longitudinal Uniformity - The ratio of minimum to maximum pavement luminance, illuminance or veiling luminance is taken along each longitudinal 
line of computation points. The worst-case ratio is displayed as the Longitudinal Uniformity Ratio. For the CIE method, an additional grid of pavement 
luminance points is computed, with observer position centered in the middle of each lane, 60m back from the first lateral row of computation points in 
the grid, and viewing along the line of points in that lane. 

Vertical Illuminance - Measured in lux, vertical illuminance at a point is calculated on a plane 1.5 m above the surface of the road. The grid is 
located on the same points as the roadway luminance grid. 

Semi-cylindrical Illuminance - Measured in lux, semi-cylindrical illuminance at a point could be considered a type of vertical illuminance, but its 
calculated value varies with the direction of interest. It is calculated at 1.5 meters above the road surface and on a half cylinder whose front is lined 
up parallel to the main directions of pedestrian movement, which for a road are usually longitudinal. The grid is located on the same points as the 
roadway luminance grid. 

Hemispherical Illuminance - Measured in lux, hemispherical illuminance at a point is calculated at ground level on the road surface. Its formula is 
similar to the formula for horizontal illuminance, but differs from it in the way that the angle of incidence is considered. 

Surround Ratio - This is a ratio of the average horizontal illuminance on the two longitudinal strips each adjacent to the two edges of the 
carriageway (the surround illuminance), divided by the average horizontal illuminance on two longitudinal strips each adjacent to the two edges of the 
carriageway, but lying on the carriageway. The width of all four strips shall be the same, and equal to 5m, or half the width of the carriageway, or the 
width of the unobstructed strip lying off the carriageway, whichever is the least. For dual carriageways, both carriageways together are treated as a 
single carriageway unless they are separated by more than 10m. 

Veiling Luminance (Lv) - A measure of disability glare, Veiling Luminance is a luminance superimposed over the eye's retinal image produced by 
stray light within the eye. In the BSEN method, Lv is computed along a single row of calculation points directly in front of the observer position. By 
default, the distance of the observer to the first lateral row of computation points in the grid is 2.75 x (mounting ht - 1.5) meters and 1/4 road width 
from the curb line. 0.5 - 1.5 degrees below horizontal, depending on the distance to the points. The maximum value of Lv is used to compute the 
relative Threshold Increment (TI). 

Relative Threshold Increment (TI) - A measure of the effect of disability glare produced by the lighting system. Threshold Increment is intended to 
yield the percentage increase in the luminance of the road's surface required to render an object just visible (threshold of visibility) under the 
proposed lighting system (glare present) as compared to the luminance required to render the object just visible in the absence of glare. 

Australia Standard 1158.2- 2005 
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Average Pavement Luminance - The overall average luminance of the road surface as observed from a specific point in cd/m
2
. Metric units are 

used, regardless of current settings. By default, observer position is 1/4 roadway width inset from the curb, 1.5 m above the pavement surface and 
60m back from the first lateral row of computation points in the grid. Line of sight is 0.5 - 1.5 degrees below horizontal, depending on the distance to 
the points. Observer position is static relative to the curb line. 

Illuminance - Illuminance is a measure of the lumens incident on the pavement divided by the area. The units are lumens per square meter (lux). 
Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Longitudinal Uniformity - The ratio of minimum to maximum pavement luminance, illuminance or veiling luminance is taken along each longitudinal 
line of computation points. The worst-case ratio is displayed as the Longitudinal Uniformity Ratio. For the CIE method, an additional grid of pavement 
luminance points is computed, with observer position centered in the middle of each lane, 60m back from the first lateral row of computation points in 
the grid, and viewing along the line of points in that lane. 

Surround Ratio - This is a ratio of the average horizontal illuminance on the two longitudinal strips each adjacent to the two edges of the 
carriageway (the surround illuminance), divided by the average horizontal illuminance on two longitudinal strips each adjacent to the two edges of the 
carriageway, but lying on the carriageway. The width of all four strips shall be the same, and equal to 3 meters. The grid shall be placed at the same 
distance as the luminance calculation field. 

Veiling Luminance (Lv) - A measure of disability glare, Veiling Luminance is a luminance superimposed over the eye's retinal image produced by 
stray light within the eye. In the BSEN method, Lv is computed along a single row of calculation points directly in front of the observer position. By 
default, the distance of the observer to the first lateral row of computation points in the grid is 2.75 x (mounting ht - 1.5) meters and 1/4 road width 
from the curb line. 0.5 - 1.5 degrees below horizontal, depending on the distance to the points. The maximum value of Lv is used to compute the 
relative Threshold Increment (TI). 

Relative Threshold Increment (TI) - A measure of the effect of disability glare produced by the lighting system. Threshold Increment is intended to 
yield the percentage increase in the luminance of the road's surface required to render an object just visible (threshold of visibility) under the 
proposed lighting system (glare present) as compared to the luminance required to render the object just visible in the absence of glare. 

Australia Standard 1158.2- 2005 - SAASTAN 

The SAASTAN software calculates some of the Australian metrics differently than Australian Standard 1158.2-2005 defines. Specifically, the 
luminaire cycles that will contribute to the calculation grid points are different in SAASTAN from what is defined in AS 1158.2-2005, and the position 
of the observer for the veiling luminance calculations is also different. These differences can lead to different calculated values for any or all of the 
roadway metrics. 

AGi32 includes AS 1158.2-2005 - SAASTAN as a selectable "standard" for those projects that must be calculated by SAASTAN methods rather than 
by Standard 1158.2-2005. 

New Zealand Standard 1158.2- 2005 

Average Pavement Luminance - The overall average luminance of the road surface as observed from a specific point in cd/m
2
. Metric units are 

used, regardless of current settings. By default, observer position is 1/4 roadway width inset from the curb, 1.5 m above the pavement surface and 
60m back from the first lateral row of computation points in the grid. Line of sight is 0.5 - 1.5 degrees below horizontal, depending on the distance to 
the points. Observer position is static relative to the curb line. 

Illuminance - Illuminance is a measure of the lumens incident on the pavement divided by the area. The units are lumens per square meter (lux). 
Illuminance is not impacted by the pavement's surface type or the angle of observation. 

Longitudinal Uniformity - The ratio of minimum to maximum pavement luminance, illuminance or veiling luminance is taken along each longitudinal 
line of computation points. The worst-case ratio is displayed as the Longitudinal Uniformity Ratio. For the CIE method, an additional grid of pavement 
luminance points is computed, with observer position centered in the middle of each lane, 60m back from the first lateral row of computation points in 
the grid, and viewing along the line of points in that lane. 

Surround Ratio - This is a ratio of the average horizontal illuminance on the two longitudinal strips each adjacent to the two edges of the 
carriageway (the surround illuminance), divided by the average horizontal illuminance on two longitudinal strips each adjacent to the two edges of the 
carriageway, but lying on the carriageway. The width of all four strips shall be the same, and equal to 3 meters.The grid shall be placed at the same 
distance as the luminance calculation field. 

Veiling Luminance (Lv) - A measure of disability glare, Veiling Luminance is a luminance superimposed over the eye's retinal image produced by 
stray light within the eye. In the BSEN method, Lv is computed along a single row of calculation points directly in front of the observer position. By 
default, the distance of the observer to the first lateral row of computation points in the grid is 2.75 x (mounting ht - 1.5) meters and 1/4 road width 
from the curb line. 0.5 - 1.5 degrees below horizontal, depending on the distance to the points. The maximum value of Lv is used to compute the 
relative Threshold Increment (TI). 

Relative Threshold Increment (TI) - A measure of the effect of disability glare produced by the lighting system. Threshold Increment is intended to 
yield the percentage increase in the luminance of the road's surface required to render an object just visible (threshold of visibility) under the 
proposed lighting system (glare present) as compared to the luminance required to render the object just visible in the absence of glare. 

Roadway Standard - Mounting Height Equation 

The BSEN and Australia standards define Observer distance for the Veiling Luminance and Threshold Increment as a function of luminaire mounting 
height. The standard formula is:  
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2.75 x (MH - 1.5) meters 

If you choose to use a formula in a custom standard that will define Observer location based on luminaire mounting height, you may do so for any 
Calculation Metric, not just Veiling Luminance w/ TI, provided the metric calls for an Observer. (Not applicable for illuminance metrics.) 

To define an Observer position this way:  

1. Select the Calculation Metric that it will apply to. 
2. Click on the Observer tab. 
3. For Observer Position, select Dynamic and then Based on MH Equation. 
4. Click in one of the equation cells (Meters or Feet). 
5. The MH Equation Syntax shows the formula that will be used to calculate Observer position based on mounting height. Working in either the 

Meters or Feet column, enter the appropriate values that will place the Observer the desired distance from the beginning of the calculation grid. 
6. The MH Equation that you are creating will be displayed at the bottom of the dialog, in both Meters and Feet versions. 
7. Click OK to return to the Roadway Standards dialog and continue to create your custom standard. 

RP-8 Design Criteria 

The Illuminating Engineering Society (IES) of North America provides recommended roadway design criteria in its document called Recommended 
Practice 8, Roadway Lighting (RP-8). RP-8-00, published in 2000 and reaffirmed in 2005, contains the tables shown below. All design criteria for 
Illuminance and Luminance are given in metric units. For convenience, lux and approximate footcandle levels are quoted in the Illuminance table.  

Illuminance Method - Recommended Values 

Roadway & Pedestrian Conflict 
Area 

Pavement Classification 

(Minimum Maintained Average Values) 

Uniformity 
Ratio 

Eavg /Emin  

Veiling 
Luminance 

Ratio 

Lv,max/Lavg 
Road Pedestrian 

Conflict Area 
R1 

lux/fc 

R2 & R3 

lux/fc 

R4 

lux/fc 

Freeway Class A   6.0 / 0.6 9.0 / 0.9 8.0 / 0.8 3.0 0.3 

Freeway Class B   4.0 / 0.4 6.0 / 0.6 5.0 / 0.5 3.0 0.3 

Expressway High 10.0 / 1.0 14.0 / 1.4 13.0 / 1.3 3.0 0.3 

Medium 8.0 / 0.8 12.0 / 1.2 10.0 / 1.0 3.0 0.3 

Low 6.0 / 0.6 9.0 / 0.9 8.0 / 0.8 3.0 0.3 

Major High 12.0 / 1.2 17.0 / 1.7 15.0 / 1.5 3.0 0.3 

Medium 9.0 / 0.9 13.0 / 1.3 11.0 / 1.1 3.0 0.3 

Low 6.0 / 0.6 9.0 / 0.9 8.0 / 0.8 3.0 0.3 

Collector High 8.0 / 0.8 12.0 / 1.2 10.0 / 1.0 4.0 0.4 

Medium 6.0 / 0.6 9.0 / 0.9 8.0 / 0.8 4.0 0.4 
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Low 4.0 / 0.4 6.0 / 0.6 5.0 / 0.5 4.0 0.4 

Local High 6.0 / 0.6 9.0 / 0.9 8.0 / 0.8 6.0 0.4 

Medium 5.0 / 0.5 7.0 / 0.7 6.0 / 0.6 6.0 0.4 

Low 3.0 / 0.3 4.0 / 0.4 4.0 / 0.4 6.0 0.4 

  

Luminance Method - Recommended Values 

Roadway & Pedestrian Conflict Area Ave. Luminance   

Lavg (cd/m2) 

Uniformity Ratio 

Lavg /Lmin  

Uniformity Ratio 

Lmax /Lmin  

Veiling 
Luminance 

Ratio 

Lv,max /Lavg  
Road Pedestrian 

Conflict Area 

Freeway Class A   0.6 3.5 6.0 0.3 

Freeway Class B   0.4 3.5 6.0 0.3 

Expressway High 1.0 3.0 5.0 0.3 

Medium 0.8 3.0 5.0 0.3 

Low 0.6 3.5 6.0 0.3 

Major High 1.2 3.0 5.0 0.3 

Medium 0.9 3.0 5.0 0.3 

Low 0.6 3.5 6.0 0.3 

Collector High 0.8 3.0 5.0 0.4 

Medium 0.6 3.5 6.0 0.4 

Low 0.4 4.0 8.0 0.4 

Local High 0.6 6.0 10.0 0.4 

Medium 0.5 6.0 10.0 0.4 
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Low 0.3 6.0 10.0 0.4 

  

Small Target Visibility - Recommended Values 

  STV Criteria Luminance Criteria 

Roadway & Pedestrian Conflict Area Weighting 
AverageVL 

Lavg cd/m
2
 

Median < 7.3m   

Lavg cd/m
2
  

Median ≥ 7.3m 

Uniformity Ratio 

Lmax/Lmin  

Road Pedestrian 
Conflict Area 

Freeway Class A   0.6 0.5 0.4 6.0 

Freeway Class B   0.4 0.4 0.3 6.0 

Expressway   3.8 0.5 0.4 6.0 

Major High 4.9 1.0 0.8 6.0 

Medium 4.0 0.8 0.7 6.0 

Low 3.2 0.6 0.6 6.0 

Collector High 3.8 0.6 0.5 6.0 

Medium 3.2 0.5 0.4 6.0 

Low 2.7 0.4 0.4 6.0 

Local High 2.7 0.5 0.4 10.0 

Medium 2.2 0.4 0.3 10.0 

Low 1.6 0.3 0.3 10.0 

Calculations Scattered Points Concepts 

Scattered Calculation Points are used to quantify Illuminance results in some arbitrary location. This capability allows you to place one or more light 
meters in a critical area of analysis for "spot" checking purposes. 

Scattered Calculation Points can measure Illuminance from any direction and may be created at any elevation height. You may locate Scattered 
Calculation Points in Plan, Elevation, or Isometric Views. 

Scattered calculation points are grouped together by label, for Numeric Analysis purposes; however, they cannot be contoured with Isolines. 

Scattered points may also be imported in the form of a text file. 
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Add Calculations - Scattered Illuminance Points 

This command allows you to specify individual points for which illuminance values will be calculated. Scattered Points are specified in Plan view. 

1. From the Add menu choose Calculations-Scattered, or from the Calculations toolbar select . 
2. Specify a unique label up to 32 characters. 
3. An optional description may be entered up to 80 characters. Meaningful descriptions that include size and color information will be useful when 

generating schedules. 
4. Specify the text size. By default, a text size of 5 is used. 
5. Select the light meter  type. 
6. Specify the Summary  options to calculate. By default, average, maximum and minimum illuminance are displayed along with uniformity ratios 

(Max/Avg ratio is not selected by default). If Number of Points is selected, the number of points that are in the calculation (not including points 
that have been removed) is shown. 

7. Select the display options, including precision, text color, point markers and labeling. 
8. Specify the Z coordinates of the first point. You will have the option to change the Z coordinate of each point, if desired, during the location 

process. By default, this value is set to zero. 
9. If desired, specify Highlight Values by clicking on the Highlight Values button. 

10. Click Ok to begin point placement. 
11. To change the point elevation, move the cursor into the Z-Coord text box and enter a new value or use the up and down arrow keys on the 

keyboard, before clicking the first point. Locate the first point and click the left mouse button. 
12. Drag the cursor to an additional point location and left click again. By default, the current Z coordinate will echo the first point's elevation. To 

change the elevation for the next point, before clicking move the cursor into the Z-Coord text box and enter a new value or use the up and down 
arrow keys on the keyboard. 

13. Continue in this fashion until complete. Click the right mouse button to confirm your point locations. 

 As an alternative to placing points one at a time, you may choose to import a set of points in the form of a text file. To do this, click on the Import 
Points button. In the dialog that opens, navigate to the file and click OK. About the text file: 

• We recommend that the file have extension .txt 

• Each point is specified as X,Y,Z values (with or without spaces) 

• One point (X,Y,Z) per line 

• Example: 

100, 0, 0  
110, 10, 0  
150, 50, 3  
200, 45, 15  
200, 37, 0 

Calculations UGR Concepts 

The Unified Glare Rating calculations available in AGi32 are calculated in accordance with the CIE document CIE 117-1995 - Discomfort Glare in 
Interior Lighting. The CIE definition of Discomfort Glare is "glare that causes discomfort without necessarily impairing the vision of objects". Glare 
which impairs the vision of objects is termed Disability Glare and is not covered in this metric. 

UGR values generally range from 10 to 30 where a high value indicates significant discomfort glare, and a low value indicates little discomfort glare. 
Electric lighting systems producing UGR values of 10 or less are assumed to produce no discomfort. In AGi32, all calculated UGR values of less than 
10 are rounded to 10. 

UGR Formula 

 

Where: 

Lb is the background luminance (cd/m
2
); 

L is the luminance of the luminous parts of each luminaire in the direction of the 

observer's eye (cd/m
2
); 

ω is the solid angle of the luminous parts of each luminaire at the observer's eye (sr); 

ρ is the Guth position index for each luminaire (displacement from the line of sight); 
 

UGR Limitations 
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• There is insufficient research to indicate whether the UGR calculations can be applied for indirect lighting or luminous ceilings. 

• Sources used within the UGR system should be limited between 0.0003 steradians and 0.1 steradian. This corresponds to luminaires ranging in 
size from an incandescent downlight seen at 10 meters away to a 1 meter square luminaire seen from 3 meters away. 

• UGR is only calculated for electric lighting sources, not daylighting. 
• AGi32 will calculate UGR for any electric lighting application. It is up to the user to understand the UGR limitations and applicability of UGR. 

UGR and Discomfort Glare Criteria 

One UGR unit represents the least detectable step in discomfort glare evaluation, and three UGR units represent an acceptability step in glare 
criteria. Average UGR value range from 10-13-16-19-22-25-28. The relationship between calculated UGR value and Hopkinson's discomfort glare 
criteria is as follows: 

UGR Discomfort Glare Criterion 

10 Imperceptible 

13 Just perceptible 

16 Perceptible 

19 Just acceptable 

22 Unacceptable 

25 Just uncomfortable 

28 Uncomfortable 

Correlated UGR and VCP Values 

Visual Comfort Probability (VCP) is a measure of discomfort glare for interior lighting applications. According to the IES Handbook, 9th Edition, page 
9-26: "The visual comfort probability (VCP) is the probability that a normal observer does not experience discomfort when viewing a lighting system 
under defined conditions. ... This system was tested and validated using lensed direct fluorescent systems only. VCP should not be applied to very 
small sources such as incandescent and high-intensity discharge luminaires, to very large sources such as ceiling and indirect systems, or to non-
uniform sources such as parabolic reflectors." With these caveats in mind, UGR can be correlated with VCP for lighting systems that consist of 
luminaires that fall within the scope of the definition of VCP. The following table shows this correlation. 

UGR VCP Equivalent 

11.6 90% 

16 80% 

19 70% 

21.6 60% 

24 50% 
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Add Calculations - Unified Glare Rating 

The CIE Unified Glare Rating (UGR) calculation predicts discomfort glare in interior applications from electric light sources. Discomfort Glare is 
defined as glare that causes discomfort without necessarily impairing the vision of the objects. In other words, you can see the object but may 
experience discomfort looking at it. 

UGR calculations are derived by considering the effect of the luminaire and surrounding environment on an observers eye. The UGR formula is 
based on three components: 

• Background Luminance 

• Luminance of luminous portions of luminaire 

• Luminaire position relative to observer 

1. From the Add menu choose Calculations-Unified Glare Rating, or from the Calculations toolbar select . 
2. Select the room in which to locate the UGR grids. 
3. Specify a unique label up to 32 characters. 
4. An optional description may be entered up to 80 characters. Meaningful descriptions that include room information and work plane height will be 

useful when generating schedules. 
5. Specify the point spacing from left to right and top to bottom. By default, a point spacing of 10 by 10 is used. As the point spacing changes, the 

text size adjusts automatically. You may override the text size, if desired. 
6. You may center the measurement points within the grid boundary, if desired, by clicking in the selection box adjacent to Center Points Relative 

to Grid Boundaries. 
7. Specify a Grid location and Orientation direction and/or specify individual observer locations and their respective orientations. 

Specify UGR Grids Specify UGR Observers 

i. UGR Grids are created by placing multiple observer positions in a uniform 
array, each looking in the same direction. 

ii. Choose which grids to include. By default, Grid 1 is selected and visible. 
iii. To change the grid elevation, move the cursor into the Z-Coord box and 

enter a new value. 
iv. To change the Viewing Angle, type the desired Orientation Angle or click 

the Specify button to specify the View angle graphically. 
v. The View Angle is specified graphically with 2 clicks. The first click locates 

the Observer position (only used for reference purposes). Drag the cursor 
to orient the observer and left click again. 

vi. Continue in this fashion until all the desired grids are specified. 
Conventionally, observers are placed to evaluate the worst case 
conditions (often this means looking at the luminaires crosswise and 
endwise). 

i. Click the Specify New or Specify Additional 
buttons to locate individual observer positions 
graphically. 

ii. Observer positions may be located anywhere in 
the interior environment. Conventionally, they are 
located at the midpoint of the room walls looking 
perpendicularly into the room. 

iii. To change the Observer elevation, move the cursor into 
the Z-Coord text box and enter a new value or use the 
up and down arrow keys on the keyboard, before clicking 
the Observer location. Locate the Observer by clicking 
the left mouse button. 

iv. Orient the Observer by dragging the mouse in the 
desired direction and left clicking again. 
Alternately, you may type in the Orientation angle. 

v. Continue in this fashion until all the Observers 
have been positioned. Right click to confirm your 
selections and return to the UGR dialog. 

8. Specify the Summary  options to calculate.  

UGR Options 

Default Selections 

• Average Value 

• Max and Min Values 

Other available options 

• Number of Points 

9. Select the display options, including precision (decimal places), text color, perimeter lines, point markers and labeling. 
10. If desired, specify Isoline contouring and Highlight Values by clicking on the appropriate buttons. 
11. Click Ok. 

Light Meter 
AGi32 provides up to four light meter types when specifying illuminance calculation entities: 
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Calculation Type Available Light Meters 

Grid Horizontal, Normal to Grid, Fixed, Variable 

Line Horizontal, Fixed, Variable 

Polygon Horizontal, Fixed, Variable 

Scattered Horizontal, Fixed, Variable 

  

Horizontal - The light meter at each point measures horizontal illuminance. There is no need to specify the calculation entity's vertices (or corners) in 
any particular order. 

 Normal to Grid - The light meter at each point will be located parallel to the grid's active surface and will measure light falling onto the grid's active 
surface. The grid is specified by locating the lower-left-hand corner and the upper-right-hand corner of the active surface. The direction of the light 
meter is displayed as the cursor is moved away from the first point. You may flip the grid’s active side if desired, before clicking the second point, by 
pressing the F5 key on the keyboard. 

• If the meter faces up or toward you, locate the 1st point of the grid at the lower-left 
corner of the grid and the 2nd point at the upper-right corner of the grid. 

• If the meter faces down (e.g., a ceiling plane) or away from you, locate the 1st point of 
the grid at the upper-left corner of the grid and the 2nd point at the lower-right corner of 
the grid. 

 

 

 Fixed - The light meter at each point is specified with fixed orientation and tilt angles independent of the calculation entity's orientation or slope. The 
meter's default position, before any Orientation or Tilt angles are applied, is facing up, and east = 0 degrees.  

 

The orientation angle is measured counterclockwise from due east. 
Before applying a Tilt, rotate (orient) your meter counterclockwise from 
east to 180 degrees opposite the direction that you want it to face! For 
example, if you want the meter to face north when titled, it needs to be 
rotated (orientated) 270 degrees. 



AGi32 Help System  Adding Entities 

180 

 

 

A positive tilt angle rotates the 0-degree plane (front of meter) up, 
toward zenith, and the face of the meter "leans" backward. For example, 
with Orient=0 (the front of the meter faces east), a Tilt of 45 degrees tilts 
the meter so that it is still pointed somewhat upward but slightly 
"backward," toward west. Another example: Beginning with an Orient 
angle of 90 degrees (front of meter faces north), a Tilt of 90 degrees tilts 
the meter all the way back so that it is pointed at the south horizon. 

When the calculation entity is created, its vertices (or corners) may be specified in any order. This method is often used to specify vertical illuminance 
on a horizontal plane. It can also be used to specify illuminance at an angle other than strictly horizontal or vertical.  

The following table contains the Orient and Tilt angles to use for four common meter aimings: 

Meter Aiming Orient Angle Tilt Angle 

Vertical meter facing West (toward -X) 
0 90 

Vertical meter facing South (toward -Y) 90 90 

Vertical meter facing East (toward +X) 180 90 

Vertical meter facing North (toward +Y) 270 90 

  

Variable 

 

The light meter at each point is aimed toward a specific point. Each calculation 
point has a different Orient (and possibly Tilt) angle, depending on its location 
relative to the specified aiming point. This is most commonly used for 
television lighting where the specified point indicates a camera location. 
Specify the point by entering its X, Y and Z coordinates in the appropriate 
cells, or click on the Specify button to locate the point in the graphics window. 

Summary 

Average 

This metric averages all of the values (that have not been removed) at each point. The average is obtained by summing all of the calculated values in 
the grid and dividing by the total number of points within the same grid. 

Maximum-Minimum values 

This metric looks at each point in the grid and finds the maximum and minimum value. 

Average-Minimum Ratio 
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The Average-Minimum ratio divides the calculated average by the calculated minimum value. In certain parts of the world, the inverse ratio 
(Minimum-Average) is used. See the Tools-System Settings for more information. 

Maximum-Minimum Ratio 

The Maximum-Minimum ratio divides the calculated maximum value by the calculated minimum value. The opposite uniformity ratio (Minimum-
Maximum) is used in certain parts of the world. See the Tools-System Settings for more information. 

Maximum-Average Ratio 

The Maximum-Average ratio divides the calculated maximum value by the calculated average value.  

Coefficient of Variation 

Coefficient of Variation (CV) is a metric used to measure uniformity in sports lighting. CV is defined as the ratio of the standard deviation of all values 
to the mean (average) value. Please see IES RP-6-88 for various recommendations on acceptable limits of CV. 

 

Uniformity Gradient 

Uniformity Gradient (UG) is typically used to measure uniformity in sports lighting applications, however it can be used to measure the rate of change 
for any calculated metric. This metric measures how fast the values falls off between measuring points. Specifically, the UG measures the rate of 
change of values between adjacent measuring points, side to side, up, down or diagonal. The rate of change is weighed by the distance between the 
points (the greater the distance, the less rate of change).The UG value is expressed as a ratio of values.  

The reported UG value indicates the highest ratio or greatest rate of change.  

Example: 

 

UG (Pt. 1 => Pt. 2) = 2/1 = 2.0 (reference distance; distance represent unit vector) 
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UG (Pt. 1 => Pt. 3) = 2/1* (5/10) = 1.0 (value weighed due to greater distance than Pt. 1 => Pt.2) 

UG (Pt. 1 => Pt. 4) = 2/1* (5/11.18) = 0.89 (value weighed due to greater distance than Pt. 1 => Pt. 2) 

Reported UG = 2.0 

Please see IES RP-6-01 for various recommendations on acceptable limits of UG for sports lighting.  

Luminance designation (labeling) 

Whenever luminance is calculated, the following designations are used to define which luminance metric is being referenced or displayed. 

• L_Roadway (Roadway Luminance) 

• L_Veiling (Veiling Luminance) 
• L_Diffuse (Diffuse Luminance) 

  

 

 Adding Luminaires 

Defining Luminaires 

Luminaire Definition - Concepts 

AGi32 requires that a luminaire type be defined before it is located in the project file. The luminaire definition includes photometric information as well 
as a symbolic representation of the luminaire. Each occurrence of the luminaire will access these parameters in addition to the aiming information 
specified by the user. AGi32 places no limits on the number of luminaire definitions available in a job file. 

The primary element in the luminaire definition is the photometric file associated with the luminaire. It is important to realize that without luminaire 
photometric information, AGi32 cannot perform any electric lighting computations. Therefore, photometric files are essentially the catalyst required to 
make the software function! A substantial database of photometric information provided by several dozen manufacturers of lighting equipment can be 
found within AGi32 using the Instabase option. Photometric information is also readily available from the luminaire manufacturer or representative. 

Photometric files are distributed in standardized formats. In North America, the photometric file format is determined by the Illuminating Engineering 
Society (IES). The extension for the IES format is .IES. More information on IES Standard File Format can be found here. In other parts of the world, 
there are two other commonly used standardized formats: CIBSE (which utilizes the .CIB, .CC, .C1S and .TML extensions) and EULUMDAT (which 
utilizes the .EXL and.LDT extensions). 

AGi32 supports CIBSE/1 format only. Support for CIBSE/2 may be added in a future release. 

The first step in defining a luminaire type to be used in AGi32 is the retrieval of the specific luminaire photometric information. Once the photometric 
file has been opened and a definition created, it is available to that job file until deleted. There is no need to redefine it to use it repeatedly. The 
defined luminaires represent a catalog of luminaires that can be conveniently located on the drawing by AGi32. It is often convenient to define all of 
the desired luminaires at the beginning of the project. However, additional luminaire types may be defined at any time. 

Selecting A Photometric File 

The first thing you will do upon entry to the Define Luminaire dialog is select a photometric file. 

Photometric Instabase 

The AGi32 Photometric Instabase is a database of photometric data compiled from luminaire manufacturers' databases downloaded through the 
Instabase System. It is designed specifically to display luminaire participating manufacturers' photometry in an organized manner.  

Manufacturers who provide photometry for AGi32 have taken the time to include photographic or graphic images of their luminaires within the tree 
structure created for their files. These images can be used elsewhere in AGi32 for presentation purposes and make browsing the Instabase fun and 
more informative. All luminaire manufacturers are invited to participate in the AGi32 Instabase without charge. 

More information can be found in the Photometric Instabase - Concepts topic. The Instabase Tutorial can also be helpful. 

Luminaire Collections 

Most users tend to use the same luminaires or arrangements over and over again. AGi32 provides a method to access your favorite or most 
commonly used luminaire definitions without having to redefine them for every job file. We call it a Collection. Simply, luminaire collections are lists of 
predefined luminaire definitions. 
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AGi32 will allow you to create as many collections as you like, each with a unique set of definitions. For example, specifiers may wish to create 
collections associated with particular jobs, and agents might like collections for individual manufacturers they represent, while a utility could simply 
create a collection of particular luminaires they have approved and stock. Any way you decide to establish your collections, they can be a dramatic 
time saver when you know what luminaires you need, and how they should be represented, without having to think through this process every time. 
For example, a collection could be called "My Favorite Roadway Luminaires" or "Chatfield Arena Project." 

All luminaires added to a collection must carry unique text Descriptions. It is by these Descriptions that they will be listed in the luminaire collections. 
If no Description was entered when the luminaire was defined, you will be prompted to enter one when you add it to a Collection. Descriptions cannot 
contain the characters *, ? or " (asterisk, question mark, or quote) and may be up to 255 characters long. 

To access luminaire collections, press the Collection button located at the left side of the Define Luminaire dialog. This will invoke the Luminaire 
Collection dialog. This dialog allows you to add defined luminaires to a collection and/or add predefined luminaires from a collection to the current 
Defined Luminaire List. You need only assign a unique label to a predefined luminaire from a collection to add it to the Defined Luminaire List in the 
current job file. 

When retrieving luminaires that are already part of a collection, AGi32 provides an automatic labeling feature that can save time. If you normally label 
luminaires using an alphanumeric or numeric scheme, AGi32 can do this for you as you pull the luminaires from the collection. Or if you prefer, you 
can assign any label manually. When you select the luminaire and click on the up arrow to add it to the defined list, the Label dialog opens. To use 
the Automatic Label you need only click the OK button. To manually label the luminaire select the radio button above Manual Labeling and enter your 
label. Then click OK to return. 

Select Photometric File 

The Select Photometric File button opens a common Windows Browse dialog with the file type set to *.IES, *.PPF, *.CIB, *.TML, *.CC, *.C1S *.EXL, 
*.LDT formats. The *.PPF format is a protected photometric file format created by Lighting Analysts. This dialog is used to navigate to the drive or 
directory where the desired photometric file is located. Once a file is selected, click OK to return to the Define Luminaire dialog. 

Find File 

The Find File button opens the MultiUse dialog used to search for files on your computer system or network. Simply enter the search criteria (specific 
filename or wildcard), select the drive to search and navigate to a folder from which to start your search. All files found matching the criteria will be 
displayed. Select any file and click Ok to return to the Define Luminaire dialog. 

Drag and Drop Photometric files 

Photometric files may be dragged and dropped into the Defined Luminaires section of the Define Luminaire dialog. Three primary drag-and-drop 
operations are available: 

1. Drag photometric files into AGi32 from an Internet site (selected graphic or link contains a hyperlink to photometric file) - Once AGi32 has 
confirmed the photometric file is valid, it will also look for an image file (JPG) and symbol file (SYM) in the same location (Web address). Image 
and Symbol files must have the same filename as the photometric file.  

Technical Details: 

• Photometric file is downloaded and copied to your \AGi32\Photometric Data\DragDrop folder 

• Image file, if found, is downloaded and loaded into job file 

• Symbol file, if found, is downloaded and copied to your \AGi32\Symbols\Instabase folder (default folder for symbols that are 
associated with photometric files) 

2. Drag "i-drop" file from Internet site – If the i-drop file contains tags for Symbol and/or Image file, the program will search for and download the 
indicated files.  If tags are not found, program will look for an image file (JPG) and symbol file (SYM) in the same location (address). Files must 
have the same filename as the photometric file.  

Technical Details: 

• The AutoDesk i-drop technology allows users to drag and drop content from the Internet into i-drop aware applications. AGi32 has 
been made i-drop aware specifically for all photometric formats supported by AGi32 (IES (.IES), CIBSE (.CIB, .CC, .C1S, .TML) and 
EULUMDAT (.EXL, .LDT) photometric files). The i-drop indicator will appear over the i-drop link when you are hovering over an i-drop 
file. The i-drop file must contain a photometric file to be useful in AGi32. Note: To add i-drop capability to your computer, download 
the i-drop indicator from http://idrop.autodesk.com/ 

• The embedded photometric file is downloaded and copied to your \AGi32\Photometric Data\DragDrop folder 

• Image file, if found, is downloaded and loaded into job file 

• Symbol file, if found, is downloaded and copied to \AGi32\Symbols\Instabase (default folder for symbols that are associated with 
photometric files) 

3. Drag photometric file from a folder on any device/drive (e.g., drag photometric files from your photometric folders instead of using the Select 
Photometric File method)  - If the selected photometric file is valid, AGi32 will also look for an image file (JPG) and symbol file (SYM) in the 
same folder. Files must have the same filename as the photometric file. 
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Technical Details: 

• Photometric file is not moved or copied 

• Image file, if found, is loaded into job file 

• Symbol file, if found, is copied to …AGi32\Symbols\Instabase (this is where symbols are located for luminaires that have associated 
symbols) 

Note: Dragging a photometric file contained in an attachment from an email message is not supported; due to formatting issues, the attachment 
needs to be dragged to a folder first, then dragged to AGi32 (see method "Drag photometric from a folder" above). Note: Search for Symbol and 
Image file is not performed for attachments. All associated files should be dragged to a folder. 

General Notes 

• Label and Description are assigned per the current Label and Description selections. 

• Drag-and-drop also works for protected photometric (PPF) and protected symbol files (_SY). 

Smart Symbols 

Smart Symbols assist you in selecting symbols within your luminaire definition by recommending a symbol for the selected photometric file. Smart 
Symbols are chosen using the luminaire's shape, size and distribution specified in the photometric file. In addition, the selected symbol is 
automatically scaled to match the luminaire's luminous box. 

You may select different mounting types for the selected file. Symbols shown for these mounting types will differ based on the distribution and 
application and may be undefined if the combination doesn't make sense (for example, you wouldn't want to recess an indirect luminaire in the ceiling 
plenum). 

Smart Symbols are recommended using the Smart Symbol Logic database. You may change the recommended symbols or add custom symbols by 
appending to the Smart Symbol Logic database. Access it from the System Settings-Defaults tab. 

Luminaire Label 

Once a photometric file has been selected, the next step is to specify the label that will reference the photometric definition whenever a luminaire is 
placed in the job file. If you retrieved a file from a Collection it will already be labeled. By default, the luminaire Label is specified per the settings in 
the Label and Description Defaults. To change the Default settings for future definitions, click the Defaults button. This label will reference the 
complete luminaire definition as assembled in the Define Luminaire dialog, including the photometric file, lumens, light loss factor, watts, pole 
information, arrangement and symbol specifics. 

The luminaire label is limited to 32 characters in length and cannot contain the characters * ? " or {} (asterisk, question mark, quote, bracket). 

Recall that the luminaire label references the complete photometric definition, not just the photometric file. Therefore, it is entirely feasible that you 
could have several different labels that will reference the same photometric file. For example, you may need to locate several different arrangements 
of an area lighting fixture. The label Single may be assigned to the single arrangement option, and Double would be assigned to the dual-headed 
arrangement. Other possibilities include assigning different labels to use prorated lamp lumens, for different wattages, or different arm lengths. Put 
simply, different labels may call the same photometric file but represent different applications. 

Luminaire groups constructed from individual luminaires must be assigned a unique label as well. In other words, the group label must carry a 
different label than any of the luminaires contained within the group. 

Luminaire Description 

By default, the luminaire Description is specified per the settings in the Label and Description Defaults. To change the Default settings for future 
definitions, click the Defaults button. The Luminaire Description text box allows user input of up to 80 characters. This text string is also shown in the 
Defined Luminaires list along with the label to help identify the variety of luminaires defined in the job file. The description contents are entirely up to 
the user (although they may not contain the characters * ? "). Possibilities include catalog numbers, mounting arrangement, group explanations, 
specifications, etc. Once a description has been associated with a luminaire definition, that description will be included in Text Prints and Luminaire 
Schedules. 

Poles and Pendants 

As part of the luminaire definition, a luminaire may reference a pole or pendant that is attached to its insertion point. In Plan view, the poles or 
pendants are not visible and do not change the appearance of the drawing. In Elevation or Isometric view, poles and pendants will make your work 
appear much more "real." Luminaires without poles or pendants will appear to be floating in space. To use the same photometric file with and without 
poles (or pendants), simply create two definitions. 

Dynamic 

A "dynamic" pole or pendant will always be attached to the same Z coordinate and will vary in length according to the mounting height of the 
luminaire. Example: A luminaire with a dynamic pendant attached at 12 feet and mounting height of 8 feet will have a pendant length of 4 feet. The 
same luminaire with a mounting height of 9 feet will have a pendant length of 3 feet. 
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Static 

Luminaires with "static" poles or pendants will always have the same pole/pendant length regardless of the mounting height. Example: A luminaire 
with a static pole length of 30 feet, inserted at a mounting height of 25 feet, will have 5 feet of the pole below the Z=0 datum. The same luminaire 
inserted at a mounting height of 35' will appear to have the pole base floating 5 feet off the ground. 

Light Loss Factor 

The Light Loss Factor is a multiplier used to simulate a reduction in lumen output due to factors such as dirt depreciation, lumen depreciation over 
time, ballast factor and others. The factors are multiplied together to achieve the total light loss factor. In its simplest form, the light loss factor is 
composed of many components, which will vary with any given project. 

AGi32 allows for the enumeration of several light loss factors. Click here for more information. 

Prorating Lumens per Lamp 

When a luminaire has been selected, the Lumens Per Lamp value that appears in the Define Luminaire dialog is extracted from the photometric file 
and is the basis for the photometric report. Should this test lumen value not be the desired one, it can be changed by simply clicking the mouse in the 
Lumens Per Lamp cell and changing the lumens. This is often necessary when prorating from one lamp output to another or when using a 
photometric file that is based upon a derated value such as 1000 lumens. For example, it is often necessary to prorate the lumen output to represent 
a lamp of different wattage or variety. AGi32 allows you to insert virtually any value for the lamp's lumen output, although it is recommended that the 
manufacturer be consulted with regard to the accuracy of the proration. In the case of luminaire photometry reported per 1000 lumens, the figure of 
1000 will appear in the Lumens Per Lamp cell. Simply change this to the rated lamp lumens. 

Generally, the lumen figure refers to a single lamp's lumen rating. Luminaires containing multiple lamps will be treated appropriately, provided the 
photometric format is followed. Luminaires containing multiple lamps of different varieties, such as metal halide and high-pressure sodium, will use a 
lumen value that averages the single lamp lumens of every lamp contained within the luminaire. 

Regarding LER and LCS and BUG ratings: 

• The calculated LCS and BUG metrics are automatically updated to reflect any changes to the Lumens Per Lamp value in the luminaire definition 
when the definition is Added or Redefined. When you initially change the lumen value, the LCS data and graph will indicate ‘Pending –
Add/Redefine – Lumens have been changed’. The data will be updated and displayed as soon as you click the Add/Redefine button. This 
feature allows you to generate accurate LCS data and BUG ratings for luminaires with prorated lamp lumen values. 

• The calculated LER metric is automatically updated to reflect any changes to the Lumens and/or Watts values in the definition when the 
definition is Added or Redefined. When you initially change the watts value, the Classification will display ‘Pending Add/Redefine – Watts have 
been changed’. The data will be updated and displayed as soon as you click the Add/Redefine button. 

• Important: LCS, BUG and LER metrics displayed in the Instabase are based on the test report lumen and watts values. Prorating the lumen 
and/or watts values in the luminaire definition will result in different LCS, BUG and /or LER metrics in the Luminaire Definition dialog than what 
is shown in the Instabase dialog!  

Linking to Photometric Toolbox from within the Luminaire Define dialog will include the lumen and watts values specified in the luminaire definition 
(not the original test data) to ensure that all generated reports in Photometric Toolbox are based on these modified values (this has changed from 
previous versions). 

There is an exception to the above when opening a file based on absolute photometry. In this case you cannot change the lumen figure. The Lumens 
for a file based on absolute photometry will appear as –1. Absolute photometry is often used for testing LED luminaires. 

Luminaire Watts 

As with lamp lumens, the luminaire test watts are also extracted from the photometric file. We recommend verifying that this value is accurate, as this 
is the value used to calculate Lighting Power Density. Typically, this figure should reflect the combination of lamp and ballast watts. As with lamp 
lumens, this value can be changed to represent luminaires of different wattage and variety. 

Regarding LER, LCS and BUG ratings: 

• The calculated LER metric is automatically updated to reflect any changes to the Lumens and/or Luminaire Watts values in the definition when 
the definition is Added or Redefined. When you initially change the watts value, the Classification will display ‘Pending Add/Redefine – 
Luminaire Watts have been changed’. The data will be updated and displayed as soon as you click the Add/Redefine button. 

• Important: LCS, BUG and LER metrics displayed in the Instabase are based on the test report lumen and luminaire watts values. Prorating the 
lumen and/or luminaire watts values in the luminaire definition will result in different LCS, BUG and /or LER metrics in the Luminaire Definition 
dialog than what is shown in the Instabase dialog!  

Linking to Photometric Toolbox from within the Luminaire Define dialog will include the watts values specified in the luminaire definition (not the 
original test data) to ensure that all generated reports in Photometric Toolbox are based on these modified values (this has changed from previous 
versions). 

Luminaire Efficiency 
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Luminaire Efficiency is the ratio of Luminaire Lumens to Total Lamp Lumens (number of lamps x lumens per lamp). If the calculated Efficiency is 
greater than 100%, an ERROR is displayed indicating that there is something seriously wrong with the file and that it should not be used. The 
luminaire manufacturer or supplier should be contacted for a corrected file. 

Luminous Box 

AGi32 uses the dimensions of the luminous box when performing lighting calculations using the Full Radiosity Method. With theDirect Only Method, 
the luminaire is assumed to be a point source. If the luminous dimensions found in the photometric file are incorrect, the lighting calculations may not 
be accurate. For example, if the distribution of a 1x4 luminaire is emitted from a point source instead of an appropriately sized luminous area, the 
luminous area will not be discretized appropriately. The effect is most noticeable when the luminaire is placed close to a reflective surface. 

In addition, care should be taken that the luminous box does not extend outside of the room and is not truncated by any objects. Most importantly, 
the luminous height (Z) should not be above the ceiling. If the photometric file has luminous height, the luminaire should be mounted such that the 
entire luminaire is below the ceiling. If the Z coordinate of the URHC (upper right-hand corner) is 0, the luminaire may be mounted flush against the 
ceiling. 

The luminous box is associated with the luminous area in the Render symbol. Specifically, the Z=0 portion of the luminous box is aligned with the 
center of the luminous area of the Render symbol. This association may place the luminous box at some distance away from the insertion point of 
the luminaire (mounting height). For example, if the Shoebox-Yoke symbol is selected, the luminous area is located 1 foot above the insertion point 
of the luminaire. If a 15 foot mounting height is specified, the calculations will actually consider the luminous source at 16 feet above grade. 

The luminous box is circumscribed using the luminous opening data in the photometric file. The X, Y and Z coordinates of the lower left hand corner 
(LLHC) and upper right hand corner (URHC) are given relative to the center of the luminous opening. The X dimension corresponds to the distance 
across the luminous opening along the 0-180 photometric plane. The Y dimension corresponds to the distance across the luminous opening along 
the 90-270 photometric plane. 

Note: Please see the IESNA document, LM-63, for more information about the luminous dimensions given in IES format photometric files.  
 

Rotate Photometry to conform to IES Standards 

European roadway luminaires are typically tested (but not always) such that the zero degree horizontal plane of photometry (C0) is on the right side 
of the luminaire parallel to an imaginary curb line. IES standard data specifies the zero degree photometric plane such that the zero degree 
horizontal plane is in front of the luminaire or perpendicular to the curb. 

This function allows you to rotate the photometry to conform to IES standards. This has the affect of rotating the photometric data negative 90 
degrees (or 90 degrees clockwise). Use this function with caution as it should not be applied to all European photometric data. It is up to the user to 
determine when and if this function should be used. Hint: In IES format, the horizontal cone trace (red line) should appear in polar plot like image on 
the right, below: 

 

Before Rotation 

 

After Rotation and Redefining 

• The function is applied when the adding or redefining a luminaire.  

• In addition to rotating the photometric web -90 degrees, the luminous box and symbol dimensions are reversed  

Luminaire Arrangements 

AGi32 provides a number of common Luminaire Arrangements already constructed for your use. A luminaire arrangement consists of a multiple 
occurrence (or single) of one photometric file arranged in a common configuration about a central location. For example: two luminaires back-to-back 
or four luminaires rotated 90 degrees apart (quad). 



AGi32 Help System  Adding Entities 

187 

 

The luminaire arrangement selection process is similar to the one described in the luminaire symbols discussion above. Simply click in the 
Arrangements window to display the variety of possibilities. The default luminaire arrangement type is a single luminaire with an arm length of zero. 

AGi32 Factory Arrangements 

With the exception of "Single," luminaire arrangements cannot be aimed at a point (cannot use Locate and Aim option).  

All occurrences of the luminaires within the luminaire arrangement are inserted at the same point when Arm Length and/or 
Offset are equal to zero. Depending on the arrangement type, it is possible to change the arrangement's Arm Length and 
Offset. These variables specify the distance between the luminous center of the luminaire and the insertion point of the 
luminaire. The numeric value entered in the Arm Length text box specifies the distance in feet between the luminous 
center and the insertion point along the 0-180 degree photometric plane. If multiple luminaires exist in the arrangement, 
perpendicular to each other (such as twin), the numeric value specified in the Offset text box is the distance in feet 
between the luminous center and the insertion point along the 90-270 degree photometric plane. 

The diagram to the right shows a Twin luminaire arrangement with a 2 foot offset and a 1 foot arm length. As you can see, 
it is simple to create luminaire arrangements with variable arm lengths and realistically model the luminaires photometric 
position relative to its insertion point. 

Custom Arrangements 

Should you need to create a luminaire other than the factory-supplied arrangements, AGi32 provides an easy method with 
which to create custom arrangements. You may create a new arrangement from scratch or use an existing arrangement to 
create a new arrangement. It is not recommended that you modify factory-supplied arrangements. 

Luminaire Symbols 

Users will increase the visual clarity of their presentations as well as distinguish different luminaires by taking advantage of AGi32's extensive 
luminaire symbol library when completing the luminaire definition. AGi32 provides many generic symbol representations that correspond to particular 
types of photometric files. 

The Model Mode symbols are symbolic representations of the luminaire in Model Mode (design mode) and are shown in Plan view. Model symbols 
are used to graphically represent the luminaire in Model Mode and do not participate in the calculations in any way. These symbols will represent the 
luminaires in Model Mode and when printing or exporting the job file as a 2D CAD file. 

The Render mode symbols are physical luminaire representations in Render mode and are shown in Isometric view. Render Symbols participate in 
the calculations in the Full Radiosity Method by reflecting and occluding light within the environment. They are constructed of surfaces making up two 
basic surface types, the symbol's housing and its luminous surface. Each surface type is assigned a color corresponding to a particular reflectance 
(luminaire housing) or luminosity (luminous area). 

Symbol Mirroring 

In the render Symbols dialog, the Symbol Mirroring option is automatically selected. When enabled, the Model mode version of the selected Render 
mode symbol is automatically used as the Model mode symbol. To use this function efficiently, always modify the Render symbol first. If the Model 
mode symbol is modified first, the rRender symbol is not changed. 

AGi32 Factory Symbols 

AGi32 symbols possess a number of properties that are important to understand prior to their application. A discussion of each follows. 

Symbol Scale 

The factory supplied luminaire symbols available in AGi32 are constructed to be true scale when symbol scale equals one. The actual symbol sizes 
are given in the table that follows. A symbol scale of one is the default value and is reasonably legible when working with small-scale projects such 
as interior lighting applications. It will also make the symbol appear correct when rendered. 

When working with large-scale projects, such as outdoor sites, true size symbols may be hard to see. The Model mode Symbols may be scaled so 
that they are better viewed in these types of layouts. Do not increase the symbol scale of Render symbols, however, as scaling this symbol will 
increase its luminous area. To scale all Model mode symbols in the job file uniformly, a better alternative is the Modify-Luminaire-Symbol Magnifier 
command. 

Symbols can be scaled in the X, Y or Z directions in order that a common shape may be used to resemble another. For example: A 1x4 symbol can 
be scaled by a factor of 2 in the Y direction to create a 1x8 symbol. 

Render Symbol Color 

The color of an AGi32 Render Symbol consists of two components, the housing color and the color of the luminous area. The housing color is the 
color of the non-light emitting portion of the symbol, while luminous color is the color of the light emitting (or luminous) portion of the symbol. 
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All colors in AGi32 are based on reflectance or luminance (SRE - Spectral Radiant Emittance). To select a color click the left mouse button with the 
cursor in the color cell. Follow the steps outlined below to select a color. 

1. Move the Hue slider to the color of choice. For gray only (no color), move the Hue slider to the very bottom of the graph. 

2. The Hue selected will be displayed with the range of intensities available. Move the Luminance (Lum.) and Saturation sliders to the 
desired intensity of the color, or simply click the left mouse button in the Lum./Saturation field. Alternatively, you can specification the RGB or 
HSL values. 

3. The selected color will appear in the Selected Color / Reflectance frame on the right side, with current reflectance shown below. Adjust the 
reflectance if necessary in the small reflectance slider. 

4. Click OK. 

SRE (Spectral Radiant Emittance) 

The luminous color selected affects the color of the light emitted 
from the associated luminaire when performing radiosity calculations 
and can easily be observed when rendering. Be aware that changing 
the color of the luminous area to other than white (100%) will derate 
the output of the luminaire. Therefore, it is not recommended to try to 
approximate the light source color simply by changing the Luminous 
color unless you are aware of the consequences. On the other hand 
it is useful for approximating the effect of colored gels applied to the 
light source, as the deprecation is realistic. 

 

Insertion Point & Computational Implications 

Symbols have no effect on the light emitted from the associated luminaire. For example, if the symbol has a mounting yoke, the yoke is part of the 
symbol and, consequently, has no effect on the light emitted from the associated luminaire. However, other luminaires or reflective surfaces in the 
environment can illuminate the luminaire symbol. Care should be exercised when using poles and pendants, as they do affect the light emitted from 
the associated luminaire (they are considered in the radiosity solution). 

Poles and pendants are attached to the insertion point of the symbol. The insertion point of each symbol is indicated with a small arrow. When 
selecting a symbol, you can also select an insertion point on either the Top or the Bottom of the symbol. Your choice will most likely depend on the 
application of the symbol in your job file. Different symbols default to top or bottom, although in many cases either choice can be valid. See the 
Symbols Table for recommendations for insertion point. 

Luminaire symbols are stored as files in the Symbols sub-folder of AGi32. 

Symbol Line Width 

The default line width of factory supplied symbols is 1 pixel. A Pixel is the smallest available line thickness. When placing luminaires on a complex 
background or printing in black and white, the symbols may be more distinguishable if the line width is increased. Line widths other than Pixel are 
stated in current display units (feet or meters). The line width scrolls in multiples of 0.25, although any value may be manually entered into the text 
box. If a value of zero is entered, the line width will default back to Pixel. 

Custom Symbols 

Custom symbols may be created in AGi32 by using Object and/or Drawing commands. To create a Model mode symbol, you may select entities from 
a CAD file background or create your own using the Drawing commands. To create Render symbols (and correlated Model mode symbols, if 
desired), use AGi32's Object modeling tools. Certain rules and restrictions are required. Details are provided here. 

Photometric File Description 

The Photometric File section contains a Description of the luminaire as extracted from the photometric format file, the Classification of the light 
distribution (calculated by AGi32), a photographic image if available (only files from the AGi32 Instabase), a graph of the luminaire's Candela 
distribution, and an LCS graph (toggle between the LCS graph and the Candela distribution display). 
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Description/Roadway/LCS/Indoor/Flood Classifications 

The Description tab reiterates the descriptive Keyword information contained in the selected photometric file. Use the scrollbars to see the entire IES 
description if it extends beyond the window extents. 

The Classification and LCS (exterior Luminaire Classification System) tabs display various metrics calculated by AGi32. These metrics may or may 
not be displayed, depending on the nature of the file. 

• Type "C" reports (commonly mislabeled Type "A") will generate Indoor, Roadway, LCS and BUG rating Classification information. Indirect 
photometric files will not display Roadway Classification information. 

• Type "B" reports, generally used to describe floodlights, will generate Flood classifications and LER (Luminaire Efficacy Rating). They will not 
generate LCS or BUG metrics. 

LCS / BUG / LER metrics and prorated lamp lumens 

• The calculated LCS metrics(including BUG rating) are automatically updated to reflect any changes to the Lumens Per Lamp value in the 
luminaire definition when the definition is Added or Redefined. When you initially change the lumen value, the LCS data and graph will indicate 
‘Pending –Add/Redefine – Lumens have been changed’. The data will be updated and displayed as soon as you click the Add/Redefine button. 
This feature allows you to generate accurate LCS data and an accurate BUG rating for luminaires with prorated lamp lumen values. 

• The calculated LER metric is automatically updated to reflect any changes to the Luminaire Lumens and/or Total Watts values in the definition 
when the definition is Added or Redefined. When you initially change the watts value, the Classification will display ‘Pending Add/Redefine – 
Watts have been changed’. The data will be updated and displayed as soon as you click the Add/Redefine button. 

• Important: LCS, BUG and LER metrics displayed in the Instabase are based on the test report lumen and watts values. Prorating the Lumens 
per Lamp and/or watts values in the luminaire definition will result in different LCS, BUG and /or LER metrics in the Luminaire Definition dialog 
than what is shown in the Instabase dialog!  

• Linking to Photometric Toolbox from within the Luminaire Define dialog will include the lumen and watts values specified in the luminaire 
definition (not the original test data) to ensure that all generated reports in Photometric Toolbox are based on these modified values (this has 
changed from previous versions). 

Classification metrics 

•••• Roadway Classifications: 

• IES Classification (Type I, II, III, IV, and V) - This classification describes the lateral (across the road) light distribution with regard to the 
lighted area width in terms of the mounting height (MH) ratio. 

• Longitudinal Classification (Very Short, Short, Medium, Long and Very Long) - This classification describes the distribution of light along 
the roadway. The classification is calculated by determining the location of the maximum candela point in terms of the mounting height 
ratio.  

• Cutoff Classification (Full Cutoff, Cutoff, Semi-Cutoff and Non-Cutoff)  -The Cutoff classifications are based on the candela values 
measure at 80 degrees above nadir and higher, in any horizontal angle. The luminaire cutoff classification was deprecated by the 
IESNA in 2007; it is superceded by the Luminaire Classification System (LCS). 

• Upward Waste Light Ratio (UWLR) - This is the luminaire lumens emitted at 90 degrees and above divided by the total luminaire 
lumens. 

•••• Indoor classifications: 

• CIE classification (Direct, Semi-Direct, General Diffuse, Semi Indirect and Indirect) 

• Luminaire Efficacy Rating (LER) - This classification is a measure of a luminaire's energy efficiency. LER is a measure of the 
luminaire's rated lumen output divided by its input power. 

•••• Flood classification (Only shown for Type B photometry): 

• Flood NEMA Type - The IES NEMA type is determined by the location of the 10% maximum candela value in the axial angles of the 
Type B photometric web. For example: If 10% of the maximum candela value falls between 46 and 70 degrees the designation is 
NEMA type 4 in that direction (horizontal or vertical).  

•••• LCS Metrics (Only shown for Type C photometry) 

• LCS Zones: Front - Low, Medium, High, Very High; Back- Low, Medium, High, Very High; Uplight - Low, High 

• Lumens - The calculated zonal lumens within each LCS zone. Values are rounded for display purposes. Any zonal lumen value that is 
greater than 0 but less than 0.05 will be displayed as "<0.05" rather than being rounded down to 0. 

• % Lamp - The percentage of total lamp lumens within each LCS zone. Values are rounded for display purposes. 

• % Lum - The percentage of luminaire lumens within each LCS zone. Values are rounded for display purposes. 

• Total - The sum of each column totaling  lumens, % Lamp and % L uminaire. The rounded values are used to sum the results. 

• BUG Rating - This refers to the Backlight, Uplight and Glare rating system, as established by the Model Lighting Ordinance (MLO), co-
written by the Illuminating Engineering Society (IES) and the International Dark-Sky Association (IDA). 

Photographic Image 

Manufacturers participating in the AGi32 Instabase program may have photographic images associated with their photometric files. When selecting a 
file from the Instabase or a Collection the image will appear in the luminaire define dialog. If the file is selected using Select File or Find File the 
image link is lost. Photographic images are selected by the manufacturer to match a group of files generally categorized by product type. This image 
can be used in your printed output from AGi32's Page Builder. 
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More Information link 

When a manufacturer creates an Instabase for their product lines, they have the option to specify a More Information URL in their file structure as 
well as to each specific photometric file. This URL allows them to link you to a website location where more information about the product is 
available. If they have specified a More Information URL link for the selected photometric file, a More Information link will appear above the 
photographic image. 

Candela Distribution Curves 

The candela curves of all photometric files selected, regardless of method (Instabase, Select File, etc.) are plotted on either a Polar or Cartesian 
graph and displayed in the define dialog. The contents of the graph can be user controlled using the More button. 

Factory provided graphs are created as follows: 

Type C photometric reports 
(indoor, fluorescent, 
industrial, roadway, area 
and most other luminaire 
types) are displayed in a 
Polar format graph. The 
Blue curve represents a 
vertical slice through the 
light distribution at the 
horizontal angle containing 
the maximum candela 
value. The distribution 180 
degrees (measured 
horizontally) away from the 
maximum makes up the 
other side of the curve. If a 
luminaire is symmetric, 
both sides of the curve are 
the same. The Red curve represents the cone dissecting the light distribution at the maximum 
candela value as measured in the vertical angle. Symmetric distributions will show as a 
perfect circle. In asymmetric distributions, the curve shape will depict the shape of the light 

distribution when viewed from above, as sliced through the vertical angle containing the maximum candela value.  

 Type B photometric reports (i.e., most floodlighting luminaires) are displayed in a Cartesian format graph similar to that shown at right. The red curve 
represents a vertical slice through the center of the light distribution from below the luminaire (left side) to above the luminaire (right side) when the 
luminaire is aimed at the horizon. The Blue curve represents a horizontal slice through the center of the light distribution from left to right. Visualize 
the Red curve as being the vertical beam spread and the blue curve being the horizontal beam spread. 

  

Add / Redefine Button 

When all the definition elements in the dialog have been completed, click the Add/Redefine button to add the luminaire definition to the list of 
luminaires that can be used with AGi32 . Once the definition has been added to the luminaire list, you may continue to add additional luminaire 
definitions or exit the Define Luminaire dialog box using the Exit button. All defined luminaires will be available in the Luminaire Toolkit as a drop-
down list. 

The luminaires in the Defined list will have an open check box to the left of the luminaire's name. Placing a checkmark in the box of one or more 
luminaires enables you to delete them (via the Delete button), or to examine them more closely in Photometric Toolbox by clicking on the PTB button 
(only available if PTB is installed ). 

Redefining a Luminaire 

Once a luminaire has been defined, it may redefined at any time. To redefine a luminaire, invoke the Define Luminaire dialog box (Define Luminaire 
button or Modify-Luminaire-Definition command) highlight the desired luminaire by left clicking the mouse button on the text line describing the 
luminaire in the luminaire list. Make the desired modifications. This might be as simple as a light loss factor change or as involved as the selection of 
a completely new photometric file to be assigned to the label. As soon as any item in the definition has been changed a warning will appear beneath 
the Add/Redefine button. This serves to remind the user that the Add/Redefine button must be selected prior to exiting the dialog in order to retain 
the changes. 

When the Add/Redefine Luminaire button has been selected, the following message will appear: "Label already exists, do you want to redefine 
<label>?" 

At this time, you have the opportunity to cancel the redefine operation and return to the Define Luminaire dialog. Once redefined, all occurrences of 
that luminaire type already present in the drawing will be changed to reflect the modifications of the redefined luminaire. If AutoCalc is enabled, 
AGi32 will recalculate all analysis points. 
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Relabel button 

Occasionally, it is necessary to change a luminaire label while retaining all of the properties and luminaire location associated with it. This is done 
with the Relabel command in the Define Luminaire dialog. 

To edit only the luminaire label without actually changing any of its assigned properties, do not change the value of the input cell directly. This will 
actually create a new luminaire definition, and the original luminaire definition will remain. Instead, click the Relabel button and enter a unique label 
name in the text box. Click Ok to apply the new luminaire label and return to the Define Luminaire dialog. If this is the only modification made while 
redefining the luminaire, there is no need to click the Add/Redefine Luminaire button. 

Luminaire Groups 

To begin, click on the Create Luminaire Group button in the Luminaire toolkit, or use the command to Modify - Luminaire - Group - Create Group. 
The Define Luminaire dialog will automatically appear as part of the luminaire group definition process. The only entry that is required to complete a 
group definition is the assignment of a label. You may specify the symbol color, description and pole designation. However, this is purely optional. All 
other attributes are properties of the group definition and cannot be altered. 

Defining Luminaires 

AGi32 requires that a luminaire be defined before it is located in the job file. The luminaire definition includes a reference label and brief description 
for the luminaire, photometric information, luminaire symbols, and your selection of luminaire arrangement. Each occurrence placed in the job file will 
access these parameters in addition to the aiming information specified by the user. AGi32 places no limits on the number of luminaire definitions. 

Once a luminaire has been defined, it can be used repeatedly. The defined luminaires represent a catalog of luminaires that can be conveniently 
located on the drawing by AGi32. Defining all of your luminaires initially is recommended, although they may be defined at any time. 

The Luminaire Definition process 

1. From the Add menu select Luminaire-Define, or from the Luminaire toolkit select . 
2. Photometric Files may be accessed in many different ways: 

• Select photometric data from leading manufacturers using AGi32’s Instabase  

• Select previously defined luminaires stored in Luminaire Collections 

• Select photometric data  using the Select command. This option allows you to browse for photometric files anywhere on your computer 
network 

• Search for photometric data on your computer or network using the Find command 

• Drag and drop photometric files from the Internet (e.g., from a manufacturer's website) or your computer into the Defined Luminaires 
section of the Define Luminaire dialog. AGi32 provides an Internet button for your convenience, which opens up your default web 
browser. 

3. A polar curve describing the candela distribution is displayed for all photometric files once they are selected. Alternately, you may display the 
LCS graph instead, showing a graphical representation of the LCS zonal lumens. The More button allows you to examine the candela 
distribution or LCS graph (changes depending on current display type) in more detail and specify additional options. Double clicking on the LCS 
graph or polar curve will also display the More dialog. Any zonal lumen value that is greater than 0 but less than 0.05 will be displayed as 
"<0.05" rather than being rounded down to 0. 

4. By default, Smart Symbols are enabled when a photometric file is selected. Smart Symbols assist you in selecting an appropriate symbol by 
extracting the luminaire's luminous shape and distribution from the photometric file. Select an appropriate mounting type and AGi32 will suggest 
and scale symbols for you. Once the symbol is selected, it is used in both Model and Render modes. 

Some luminaires in the Instabase have luminaire symbols associated with them. When these photometric files are selected, the luminaire 
symbols are included.  

When Smart symbols are disabled (or if you wish to change the luminaire symbols), you can select alternate symbolic representations. Two 
luminaire symbols are available for each luminaire definition: one for Render Mode and one for Model Mode.  

This differentiation allows you to symbolically represent the luminaire one way in Model Mode and display the actual luminaire 
representation in Render Mode. For example, you may wish to represent a floodlight luminaire graphically with an Arrow symbol in Model 
Mode and show the floodlight luminaire in Render Mode. Simply click in each Symbol field to invoke the Luminaire Symbols dialog. The 
Model Mode symbol selection allows for the specification of a Wire Frame color and symbol line width. You may specify the housing color 
and luminous area color for the Render Mode symbol based on reflectance and SRE values.  

Note: If you wish to apply the same symbol for both Render and Model modes, click in the Render Mode symbol cell and choose the desired 
symbol. By default, Symbol Mirroring is enabled and the Model Mode version of the Render Mode symbol is automatically used as the Model 
Mode symbol. 

5. Label - Luminaire labels are used to identify a specific luminaire type. By default, the luminaire label is specified per the settings in the Label and 
Description Defaults. To change the Default settings for future definitions, click the Defaults button. You may also manually assign a unique 
label up to 32 characters in length. 

6. Description - Descriptions are used to further identify a particular luminaire type. By default, the luminaire Description is specified per the 
settings in the Label and Description Defaults. To change the Default settings for future definitions, click the Defaults button. You may also 
manually assign a description up to 80 characters in length. 
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7. Add a pole or pendant to be displayed with this luminaire type by clicking in the appropriate box. Poles and pendants can be static or dynamic 
entities. Poles and pendants are considered to be physical entities when calculating using the Full Radiosity Method and may obstruct the light 
emitted from the luminaire. 

8. Specify the LLF and watts for the luminaire type. If desired, you may prorate the lamp lumens or change the size of the luminous box extracted 
from the photometric file. 

• The calculated LCS and BUG metrics are automatically updated to reflect any changes to the Lumens Per Lamp value in the luminaire 
definition when the definition is Added or Redefined. When you initially change the lumen value, the LCS data and graph will indicate 
‘Pending –Add/Redefine – Lumens per Lamp have been changed’. The data will be updated and displayed as soon as you click the 
Add/Redefine button. This feature allows you to generate accurate LCS data and BUG ratings for luminaires with prorated Lumens per 
Lamp values. 

• The calculated LER (Luminaire Efficacy Rating) metric is automatically updated to reflect any changes to the Lumens per Lamp and/or 
Luminaire Watts values in the definition when the definition is Added or Redefined. When you initially change the luminaire watts value, 
the Classification will display ‘Pending Add/Redefine – Luminaire Watts have been changed’. The data will be updated and displayed as 
soon as you click the Add/Redefine button. 

• Important: LCS, BUG and LER metrics displayed in the Instabase are based on the test report Luminaire Lumens and Total Watts 
values. Prorating the Lumens per Lamp and/or Total Watts values in the luminaire definition will result in different LCS, BUG and /or 
LER metrics in the Luminaire Definition dialog than what is shown in the Instabase dialog!  

• Note that if the Lumens per Lamp value is -1, this indicates that the luminaire was tested with absolute photometry. In this case, the 
Lumens per Lamp value cannot be changed. Absolute photometry is often used in testing LED luminaires. 

• Linking to Photometric Toolbox from within the Luminaire Define dialog will include the lumen and watts values specified in the 
luminaire definition (not the original test data) to ensure that all generated reports in Photometric Toolbox are based on these modified 
values (this has changed from previous versions). 

9. Select a luminaire arrangement from a number of factory supplied arrangements. As before, click in the Arrangement box to bring up the 
Luminaire Arrangements dialog. Depending on the selected arrangement, you may be able to specify the luminaire's Arm Length and Offset. 

10. To rotate the photometry to conform to IES standards (only applies to European formats: LDT, CC, C1S, CIB, TML, EXL), check the "Rotate 
Photometry to Conform to IES Standards" selection box. The rotation is not applied until you click the Add/Redefine button. 

11. Click the Add/Redefine Luminaire Definition button to complete the luminaire definition. The added luminaire will appear in the Define Luminaire 
List. 

Rotate Photometry to Conform to IES Standards 

European roadway luminaires are typically tested (but not always) such that the zero degree horizontal plane of photometry (C0) is on the right side 
of the luminaire parallel to an imaginary curb line. IES standard data specifies the zero degree photometric plane such that the zero degree 
horizontal plane is in front of the luminaire or perpendicular to the curb. 

This function allows you to rotate the photometry to conform to IES standards. This has the affect of rotating the photometric data negative 90 
degrees (or 90 degrees clockwise). Use this function with caution as it should not be applied to all European photometric data. It is up to the user to 
determine when and if this function should be used. Hint: In IES format, the horizontal cone trace (red line) should appear in polar plot like image on 
the right, below: 

 

Before Rotation 

 

After Rotation and Redefining 

• The function is applied when the adding or redefining a luminaire.  

• In addition to rotating the photometric web -90 degrees, the luminous box and symbol dimensions are reversed  

Redefining Luminaires 

A luminaire definition may be modified or updated at any time. If the modification involves selecting an alternate photometric file, the luminaire Label 
and Description may automatically update as well, depending on the Label and Description Defaults. You may choose an existing Label instead (in 
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effect updating an existing luminaire), by selecting the Label name from the Label pull-down menu. An existing Description may also be used, by 
selecting the desired Description from the Description pull-down menu. Once your modifications are complete, click the Add/Redefine button to 
update the existing luminaire definition. 

Note: If the current luminaire definition has changed, a note will appear reminding you to save the modifications before exiting. 

Relabeling Luminaires 

This option allows you to change the luminaire label for the currently selected luminaire definition. 

Deleting Luminaire Definitions 

Place a checkmark in the box to the left of a defined luminaire's name and click the Delete button to permanently delete the currently selected 
luminaire definition from the Defined Luminaire list. Several luminaires may be checked and deleted at the same time. You will be prompted to 
confirm the deletion for each luminaire selected. If you select Cancel, the deletion process will be terminated. Deleting a defined luminaire cannot be 
undone. 

Sorting and Reordering Defined Luminaires 

Defined luminaires can easily be sorted by Label or Description by clicking the appropriate column header. In addition, the list can be reordered by 
selecting a Label and then pressing Alt + Up Arrow key to move up in the list and Alt + Down Arrow to move down in the list. 

Note: The Label and Description columns in the Defined Luminaire list can be resized if necessary. Simply move the mouse over the column 
separator (beginning or end of column) until the resize icon appears. Drag left/right as needed. 

Accessing Photometric Toolbox from within the Define Luminaire dialog 

You can open PTB to examine a luminaire's characteristics more closely by highlighting it in the Defined list or placing a checkmark in its box. You 
can also select several luminaires in the list by placing checkmarks in their boxes. Then click on the PTB button. An independent instance of 
Photometric Toolbox will open with each of the selected luminaires (up to 25) listed. It may be useful to select more than one definition for 
comparison purposes. 

NOTE: PTB version 1.7 or newer must be installed in order to do this. 

The photometric file for Single or Arrangement is loaded into PTB. Groups and definitions using encrypted photometric files cannot be loaded into 
PTB. 

The photometric file loaded into PTB is an IES file generated by AGi32 using the specified data in the definitions. This file will reflect any changes 
that you have made to the Lumens Per Lamp and Watts fields. This might be useful to generate a report based on prorated Lumens Per lamp or 
different Luminaire Watts. The keyword [_AGi32] is included in the description as a reminder where of the file was generated from. 

The file generated by AGi32 is saved in your PhotometricData_FileFromJobFile folder (see Tools - System Settings). The filename (as displayed in 
PTB) is generated from the define luminaire label with '_AGI32" appended. You can, of course, save the file as a different name with Photometric 
Toolbox. 

You want to compare a defined luminaire with another file on your system without having to load it into AGi32. No problem: Select the defined 
luminaire in AGi32 and open Toolbox by clicking on the PTB button. Now you can drag-and-drop the file you would like to compare it to directly into 
PTB. 

Luminaire LLFs 

Luminaire Light Loss Factors (LLFs) 

It is important to specify any relevant light loss factors (LLFs) so that your calculations will reflect the true lighting conditions as closely as possible. 

You may simply enter a value for the Total LLF, or you may click on the Specify button to open the Light Loss Factor Specification dialog. 

It is not necessary to enter a value for each of the listed LLFs. For any given project, some of the listed light loss factors will be significant, while 
others may be irrelevant. 

 Each light loss factor that you wish to use should be entered as a decimal value, e.g., 0.85. Only light loss factors with values entered will be 
considered in the calculations.  

The individual values entered are multiplied to determine the Total LLF, shown at the bottom of the dialog.  

After entering each value that you wish to include, click OK to return to the Define Luminaire dialog. The Total LLF value is displayed. 

Note: Additional information on Light Loss Factors may be found in the IES Handbook. (www.ies.org)   
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Luminaire LLFs - Concepts 

It is important to specify any relevant light loss factors (LLFs) so that your calculations will reflect the true lighting conditions as closely as possible. 
The Total LLF acts to reduce the amount of light that reaches the room and object surfaces and calculation grids in the space. A Total LLF of 0.77 
means that the calculated lighting metrics (illuminance, luminance, etc.) will be reduced by a factor of 0.77 compared to "initial" conditions (no LLFs 
applied). The condition with LLFs applied is sometimes called the "maintained" lighting condition, and light loss factors are sometimes called 
maintenance factors. 

The LLFs listed in AGi32's Light Loss Factor Specification dialog are all defined by the Illuminating Engineering Society of North America (IES) in the 
IES Handbook. (In the 9th Edition, they are in Chapter 9.) 

Some of the LLFs are considered "recoverable," such as Luminaire Dirt Depreciation (LDD), while others are considered "non-recoverable," such as 
Ballast Factor (BF). Only the factors that are entered into the dialog's fields will contribute to the Total LLF. 

Note: Additional information on Light Loss Factors may be found in the IES Handbook. (www.ies.org)   
 

Label and Description Defaults 

This command specifies which data is extracted from the selected photometric file to be used as the Luminaire Label and Description. 

Photometric Instabase - Concepts 

The AGi32 Photometric Instabase System is a collection of the lighting industry’s most progressive manufacturers who have prepared their product 
photometric data specifically for AGi32. Each manufacturer has organized their products into a recognizable folder structure complete with product 
photographs for easy browsing and identification. Some have added Internet links and custom luminaire symbols to further enhance the user 
experience. 

Using the Instabase 

Accessing the Instabase System from within AGi32 is easy and intuitive: From the Luminaire Define dialog, simply click on the Instabase button. To 
select from the industry manufacturers represented in the Instabase System, click on the Manage button. 

The selection of manufacturer Instabase files is online at the Instabase System web server. If you have a persistent Internet connection you will see 
the manufacturers list as shown below. You may elect to Download and/or Subscribe to a manufacturer's Instabase. Subscribing will provide 
automatic notification when the manufacturer has posted an update to their Instabase. By default, when you select one checkbox, the other will auto-
select. You may remove either checkmark with a click. Subscribing alone will not download and install the Instabase. In order to add the 
manufacturer to your local Instabase, you must Download the information. 

 

When you have selected the manufacturer(s) of interest, click the “DO IT!” button at the bottom of the list. The manufacturers' data will be 
downloaded, installed and ready for use. All downloaded Instabase Files will appear in the pull down menu in the Instabase dialog (shown below). 
When a selection is made, the manufacturer's data tree will open and you are free to navigate and select a luminaire. 
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When the Instabase opens, the dialog depicting the data tree is displayed. The data tree is initially displayed in a condensed format with all of the 
nodes closed. A single click on the plus sign in front of any node will expand that node to reveal its contents. When clicking on a manufacturer's 
node, the following will be displayed: a graphic associated with the manufacturer (usually the logo), photometric and contact information, and the 
manufacturer's first data level structure. The data structure is created by the individual luminaire manufacturer and is generally intended to reflect 
their product offering. You can click on the plus sign next to any node to reveal an image associated with that node and either additional nodes or 
photometric files inside. 

At the photometric file level, click on any photometric file to see its description, calculated metrics, photometric curves and LCS Graph (only for Type 
C photometry). The photometric curves depict a vertical slice through the maximum candela value (in Blue) and a horizontal cone through the 
maximum candela value (in Red).  

The LCS tab displays a table with the Luminaire Classification System zonal luminaire lumens, % lamp lumens, and % luminaire lumens. Putting a 
dot in the LCS Graph radio button displays a shaded graphical representation of the zonal luminaire lumens. The graphical plot represents a section 
view looking at the luminaire in elevation. The lower-right quadrant of the graph represents the Front - Downlight components (Street Side); the 
lower-left quadrant of the graph represents the Back- Downlight components (House Side); and the upper hemispherical section represents the 
Uplight component. The shaded "pie wedge" inside each zonal section represents the percent of zonal lumens that exists in that specific zone.  

To look more closely at the photometric curves and LCS Graph, click the More button. If the photometric file has a graphic image associated with it, it 
will be displayed as well. 

For more information on Instabases, try out the Instabase Tutorial. 

Instabase Compatibility between Photometric Toolbox and other versions of AGi32 

If you have Photometric Toolbox (PTB) installed on your computer, there will be a PTB icon displayed next to the More button. If you click on that 
button, PTB will open and provide additional information from the selected luminaire's photometric file. Note the following limitations in compatibility 
between old: 

• AGi32 version 2.0x and 2.1x: During initial start up, Instabases in v2.1 are synced with v2.0x. Once synced, Instabases in v2.1 are moved to the 
new registry location. This breaks syncing between v2.0x and v2.1x; whatever changes are mad to Instabases in each program are not synced 
with the other. 

• Photometric Toolbox: Version 1.6x is synced with AGi32 v2.0x but not with v2.1x. PTB version 1.7x is synced with v2.1x but not with v2.0x. 

Luminaire Symbols 

Manufacturers can include luminaire symbols in the Instabase for use with their photometric files. Photometric files with an associated luminaire 
symbol (applied for both Render  Mode and Model Mode luminaire symbols) are shown with an asterisk alongside the filename. Custom luminaire 
symbols provided by the manufacturers in the Instabase are associated only with the selected photometric file and may not be used with any other 
photometric file. If the custom luminaire symbol is replaced by another luminaire symbol in the definition, or if the photometric file is changed, the 
symbol is no longer available for the luminaire definition. The original photometric file must be re-selected in the luminaire definition in order for the 
custom luminaire symbol to be shown. 

Query your Instabase 

The Instabase has a powerful Query utility that allows you to search for files matching a particular set of criteria. This capability is similar to doing a 
catalog search for luminaire performance and distribution characteristics. 

Export luminaire data as .txt file 
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From the Instabase dialog you have the ability to Export luminaire data to a .txt file. The resulting file is tab delimited and can therefore be opened 
with spreadsheet software such as Microsoft ExcelTM.  

Data Integrity Check 

Among the items that you can choose to Export is a Data Integrity Check. A Data Integrity Check looks for files that have data flaws and other 
potential problem data. 

Printing a luminaire's photometric information 

You may print photometric information on a selected luminaire by clicking the More button (lower-right corner) and then the Print button. The 
candela distribution curve and LCS Graph may also be printed from here.  

Photometric Instabase 

AGi32 allows you to assemble a collection of manufacturers' photometric databases into a single cohesive unit we call the Instabase. The Instabase 
System maintains all participating manufacturers' information online, allowing them immediate access to update and enhance their product offering. 
End users of AGi32 and Photometric Toolbox can easily access the Instabase System to download and subscribe to any manufacturer of interest. 

Adding Photometric Data to the Instabase 

To add photometric data to your local Instabase, click the Manage button from within the Luminaire Define dialog. If you have a persistent Internet 
connection, AGi32 will go online to find and display the various manufacturers' Instabase files (the term Suppliers is used interchangeably). 

To install the suppliers of interest: 

1. Click in the Download Checkbox; the Subscribe checkbox will also be selected. If you plan on using this supplier's data regularly, it is 
advantageous to subscribe. Subscribers receive an automatic notification in the Instabase dialog whenever an update is available for that 
manufacturer's data. 

2. With the desired suppliers selected, click the DO IT! button at the bottom of the form. AGi32 will proceed to download and install the 
manufacturer's data. 

3. It is possible to Remove a suppliers data form your local Instabase using the Remove tab. Simply select the supplier and click Remove. The 
Instabase is removed; however, the actual data remains on your computer system in the ...\My 
Documents\AGI32\PhotometricData_DownloadedInstabaseFiles folder. It can be re-added to the Instabase using the Advanced tab, or removed 
manually through Windows Explorer. 

Selecting photometric files from the Instabase: 

1. In the Instabase dialog , a listing of installed manufacturers is contained in the pull-down menu at the top. Select a manufacturer from the menu 
to see their product offering. Some manufacturers have stratified their product offering into multiple branches or product lines. When the branch 
list appears, choose the product line you wish to view. 

2. Expand the directory by clicking on the plus sign adjacent to a manufacturer's name. Continue expanding nodes until the photometric file you 
are interested in is revealed. To expand the tree entirely, click the Expand Nodes button. 

3. Once the photometric file is selected, its photometric description, calculated metrics, and the candela curve display will appear to the right. If an 
image is associated with the file, it will appear to the right as well. Photometric files with an associated luminaire symbol are displayed with an 
asterisk (*). 

4. When a manufacturer creates an Instabase for their product lines, they have the option to specify a More Information URL in their file structure 
as well as to each specific photometric file. This URL allows them to link to their website location where more information about the product is 
available. If they have specified a More Information URL link for the selected photometric file or node, a More Information link will appear above 
the photographic image. 

5. Click the Ok button to return to the Luminaire Define dialog box and insert the selected photometric file. 

Right clicking on a file or directory brings up a pop-up menu that allows you to delete a node and all of its sub-nodes from the Instabase. Once 
deleted, the file references are removed from the Instabase, but the associated photometric files remain on your hard disk. In other words, a file 
removed from the Instabase will reappear if the Instabase is recreated, unless you actually delete the file. 

Calculated Metrics 

The Description tab reiterates the descriptive Keyword information contained in the selected photometric file. Use the scrollbars to see the entire IES 
description if it extends beyond the window extents. 

The Classification and LCS tabs display various metrics calculated in AGi32. These metrics may or may not be displayed, depending on the nature of 
the file. 

• Type "C" reports will generate Indoor and Roadway/LCS Classification information. 
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• Type "B" reports, generally used to describe floodlights, will generate Flood classifications and LER. They will not generate LCS information or 
BUG Ratings. 

• Indirect photometric files will not display Roadway Classification information. 

• Classification metrics 
o Roadway Classifications: 

� IES Classification (Type I, II, III, IV, and V) - This classification describes the lateral light distribution with regard to the 
lighted area width in terms of the mounting height (MH) ratio. 

� Longitudinal Classification (Very Short, Short, Medium, Long and Very Long) - This classification describes the 
vertical light distribution along the roadway. The classification is calculated by determining the location of the 
maximum candela point in terms of the mounting height ratio.  

� Cutoff Classification (Full Cutoff, Cutoff, Semi-Cutoff and Non-Cutoff) - The Cutoff classifications are based on the 
candela values measure at 80 degrees above nadir (vertical) and higher, in any horizontal angle. The luminaire cutoff 
classification has been deprecated by the IESNA in 2007; it has been superceded by the Luminaire Classification 
System (LCS). 

� Upward Waste Light Ratio (UWLR) - This is the luminaire lumens emitted at 90 degrees and above divided by the total 
luminaire lumens. 

o Indoor classifications: 
� CIE classification (Direct, Semi-Direct, General Diffuse, Semi Indirect and Indirect) 
� Luminaire Efficacy Rating (LER) - This classification is a measure of a luminaire's energy efficiency. LER is a measure 

of the luminaire's rated lumen output divided by its input power, per NEMA LE-5:2001. 
o Flood classification: 

� Flood NEMA Type - The IES NEMA type is determined by the location of the 10% maximum candela value in the axial 
angles of the Type B photometric web. For example: If a candela value equal to 10% of the Maximum candela value 
falls between 46 and 70 degrees, the designation is NEMA type 4 in that direction (horizontal or vertical). 

• LCS Metrics 
o LCS Zones: Front - Low, Medium, High, Very High; Back- Low, Medium, High, Very High; Uplight - Low, High. Ref. IES document TM-

15. 
o BUG Ratings: Backlight, Uplight and Glare rating system, from IES TM-15, Addendum A. 
o Lumens - The calculated zonal lumens within each LCS zone. Values are rounded for display purposes. 
o % Lamp - The ratio of total lamp lumens within each LCS zone. Values are rounded for display purposes. 
o % Lum - The ratio of luminaire lumens within each LCS zone. Values are rounded for display purposes. 
o Total - The sum of each column totaling  lumens, % Lamp and % Luminaire. The rounded values are used to sum the results. 

View More detailed photometric information 

The candela or LCS graph can be viewed in more detail or modified to show additional information by clicking on the More button at the lower-right 
corner of the Photometric Instabase dialog. The button opens a larger version of the graph with labels and the ability to add or remove the curves 
that are displayed. Changes made at this level will be applied to the smaller graphs in all of the associated Luminaire Define dialogs. 

Double clicking on the LCS Graph or polar curve will also display the More dialog. 

For more information on Instabases, try out the Instabase Tutorial. 

Querying the Photometric Instabase - Concepts 

The Photometric Instabase has a powerful Query utility to search for photometric files matching a particular set of criteria. Suppose you are looking 
for a particular luminaire, such as a bollard, or a certain lamp wattage. You can query the Instabase for this information based on Keywords found in 
the photometric files. 

Instabase files can be created from IES (.IES), CIBSE (.CIB, .TML, .CC, .C1S) and EULUMDAT (.EXL, .LDT) photometric files. In order for the 
Instabase Query function to work at its fullest, the recommended format is IES. The Instabase Query function allows for queries based on IES 
keywords and associated data which are not present in CIBSE or EULUMDAT files (e.g. Catalog Number). In these specific cases, the CIBSE or 
EULUMDAT files will not show up in the Query results. However, you can successfully query all file formats for any calculated metric that does not 
depend on keywords (e.g., LER, LCS, and BUG ratings). 

AGi32 supports CIBSE/1 format only. Support for CIBSE/2 may be added in a future release  

Note: Not all manufacturers have updated their photometric data to IESNA LM-63-95 or later standards. Earlier versions of the IES photometric 
standard did not require keywords. These photometric files will not participate in Queries. 

All of the photometric databases available for download from www.AGi32.com are current to IESNA LM-63-95 standards or later. 

You may also use the Query utility to search for certain luminaire distribution or performance characteristics, such as Cutoff classification or NEMA 
Beam angle. These metrics are calculated directly in AGi32 and the Query tool will use AGi32's calculated metrics to filter for the requested results. 
Metrics listed in the photometric file's heading (in the Keyword section) are not used. 

Query Details 
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Query Item Comments 

Instabase(s) to Query Search across all of your current photometric databases, select specific manufacturers, or limit your Query 
to just one. 

  

Selecting more than one Instabase: Place a dot in the Selected radio button, then click on the button 
Specify Instabases to Query... . In the next dialog, you may select as many Instabases as you like. 
You may also confine your query to specific subheadings within one or more Instabases. To select a 
subheading, simply click on a + sign to expand the heading. If you have not already specified your other 
search criteria, click OK to return to the previous dialog. otherwise, you can click Run Query from here. 

  

Selecting just one Instabase: Put a dot in the Single radio button and then click on the drop-down arrow to 
select the manufacturer Instabase that you would like to Query. 

General Tab 

Filename 
Used to find a particular file, duplicates of the same file, or files with a particular name. The Query is not 
case sensitive. 

Examples: 

SHOEBOX - searches all files that have SHOEBOX in the filename. 

"SHOEBOX" - searches for filename SHOEBOX. 

Test Keyword [TEST] 

Used to find files with a particular test number or files with a test number containing a particular series of 
characters. The Query is not case sensitive. 

Examples: 

ITL - searches for all files with ITL in the [TEST] row (e.g., ITL1234, ITL 4567a) 

"ITL12345" - searches for all files with [TEST] = ITL12345 

Date (Year) Keyword [DATE] 

Used to find files tested after a particular year. Selection includes a span from  specified year to 10 years 
after specified date. 

Examples: 

1990 - searches for all files with year = 1990 + 10 years (from Jan-1-1990 to Dec-31-2000) 

Catalog Number Keyword [LUMCAT] 

Used to find files with a particular catalog number or files with a catalog number containing a particular 
string of characters. The Query is not case sensitive. 

Examples: 

AREA - searches for all files with AREA in the [LUMCAT] row (e.g. AREA1234, AREA LIGHTER 2) 

"AREA LIGHTER 1234" - searches for all files with [LUMCAT] = AREA LIGHTER 1234 

Luminaire Description Keyword [LUMINAIRE] 

Used to find files with a particular luminaire description or files with a luminaire description containing a 
particular string of characters. The Query is not case sensitive. 

Examples: 

Flood - searches for all files with Flood in the [LUMINAIRE] row (e.g. Floodlight ABC, Sports Flood 

"Flood-X" - searches for all files with [LUMINAIRE] = Flood-X 

Lamp Description Keyword [LAMP] 

Used to find files with a particular lamp type. 

Lamp Type Select from theses available lamp types: High Pressure Sodium (HPS), Metal Halide (MH), Low Pressure 
Sodium (LPS), Mercury Vapor (MV), Fluorescent (Fxx), Compact Fluorescent (CFL), Incandescent (INC), 
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quartz (MR), or LED. 

Lamp Wattage Used to find lamps with a rated lamp wattage 

Ballast Description Used to find a a particular ballast description 

 Luminaire Watts 
Used to find luminaires within a wattage range.  

Luminaire Watts are entered by the supplier of the data and may or may not be accurate. Note that some 
suppliers have elected not to include valid wattage information in the photometric file (e.g., Luminaire 
Watts = 1).  

If you simply enter one value, the query will search for files with that exact Watts value (luminaire watts). 

Classification Tab 

Roadway Classifications 

IES Classification Select from these classifications: Type I, II, III, IV and V 

Longitudinal Classification Select from these classifications: Very Short, Short, Medium, Long 

Cutoff Type (deprecated) Select from these classifications: Non Cutoff, Semi Cutoff, Cutoff and Full Cutoff. 

The luminaire cutoff classification was deprecated by the IESNA in 2007; it is superceded by the 
Luminaire Classification System (LCS). 

 Upward Waste Light Ratio (UWLR)  UWLR is not calculated for Type B photometric files. 

Indoor Classification 

CIE Type The CIE classification of the light distribution refers to the amount of flux emitted in the upper and lower 
hemispheres as a percentage of the total. 

Select from these classifications: Direct, Semi-Direct, General Diffuse, Semi Indirect, and Indirect 

Luminaire Efficacy Rating LER is a measure of the luminaire's rated lumen output divided by its input power.  

LER = [luminaire efficiency (EFF) x total rated lamp lumens (TLL) x ballast factor (BF)] divided by 
[luminaire input watts] ] 

LER Caveats: 

• LER will not be calculated if watts=0 or ballast factor = 0  

• LER will not be calculated for absolute photometry (lumens = -1)  

• LER will not be calculated properly for IES files prorated to 1000 lumens (or other prorations) -- it will 
be artificially low.  

Flood Classification 

NEMA Type (H x V) The IES NEMA typing is determined by the location of the 10% maximum candela value in the axial 
angles of the Type B web. 

The NEMA types available (and their corresponding angular set) for each axial angle are:  

0 -  < 10 

1 -  10 to 18 
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2 -  18 to 29 

3 -  29 to 46 

4 -  46 to 70 

5 -  70 to 100 

6 -  100 to 130 

7 -  130 and up 

LCS Tab 

Luminaire Classification System (LCS) - The IESNA Luminaire Classification System (LCS) defines the distribution of light into 10 solid angles. The 
LCS metrics are an indicator of optical distribution and are intended to be used in conjunction with the IES and Longitudinal Classifications to provide 
a thorough analysis of the light distribution. 

The BUG (Backlight, Uplight, Glare) rating system classifies luminaires (Type C photometry only) according the number of lumens in each of the LCS 
angular zones, based on IES document TM-15 (Appendix A).  

Unchecked zones have no limit restrictions.  

Query based on BUG Rating or Zonal Query may be selected as the main criterion on the LCS tab.  

BUG ratings range from 0 (most restrictive) to 5 (no restrictions). To meet a particular BUG rating, a 
luminaire must have a BUG rating less than or equal to the requested rating. For example: if the 
requested BUG rating is B4-U2-G0, the query will return all luminaires with BUG ratings of B0-B4, U0-U2, 
G0. 

Specifying or changing a BUG rating query automatically updates the Zonal Query information to reflect 
the requested LCS Zonal requirements. This is done to help give you a visual representation of the BUG 
rating. However, there are some caveats you need to be aware of: 

• The zonal value for lumens is based on asymmetrical luminaire types. The actual values for 
symmetrical luminaires differ for the BH zone. However, we can't display both at the same time! 

• In cases where the same zone is used for different ratings, the lesser of the lumen values is shown 
(e.g., FVH and BVH are used for Backlight and Glare ratings). 

The Zonal Query restricts one of the following options: Lumens, % Lamp or % Luminaire. The default 
option is Lumens. 

Lumens - This option restricts the lumen value in each specified zone. For example, if 0 is specified for 
both the High and Low Uplight zones, only luminaires producing zero zonal lumens in these zones will be 
displayed in the Query Results. 

% Lamp - This option restricts the % Lamp ratio in each specified zone. For example, if 5% is specified as 
the Query restriction in the Low and Medium Back zones, only luminaires producing 5% or fewer lamp 
lumens in these zones will be displayed in the Query Results.  

Note: % Lamp is always less than % luminaire (% Lamp refers to the percentage of the light emitted from 
the lamp that is emitted from the luminaire, which is always less than 100% total due to luminaire 
inefficiencies, whereas % luminaire refers to the zonal percentage that emits from the luminaire as a 
system (always sums to 100%). 

LCS Graph The LCS Graph displays the Query Type and a graphical representation of the zonal limits selected by the 
user. Unchecked zones are set to the maximum selected value for display purposes, but have no limit 
restrictions. 

Uplight Zones Front and Back Uplight zones: Low and High 

Select the maximum lumens or percentage desired for each zone to limit the query to these metrics. 

Back Zones Back Downlight zones: Low, Medium, High and Very High 
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Select the maximum lumens or percentage desired for each zone to limit the query to these metrics. 

Front Zones Front Downlight zones: Low, Medium, High and Very High. 

Select the maximum lumens or percentage desired for each zone to limit the query to these metrics. 

BUG Rating The Backlight, Uplight, and Glare ratings range from 0 (most restrictive) to 5 (no restrictions). The rating 
values that are desirable will depend on the application and may be set by local code.  

Select the maximum desired B, U, and G values for the luminaire Query. 

Querying the Photometric Instabase 

You can query the Instabase based on IESNA LM-63 keywords and calculated metrics. Any combination of keywords and characteristics can be 
selected and the results will be displayed in the dialog box. 

Instabase files can now be created from IES (.IES), CIBSE (.CIB, .CC, .C1S, .TML) and EULUMDAT (.EXL, .LDT) photometric files. In order for the 
Instabase Query function to work at its fullest, the recommended format is IES. The Instabase Query function allows for queries based on IES 
keywords and associated data which are not present in CIBSE or EULUMDAT files (e.g. Catalog Number). In these specific cases, the CIBSE or 
EULUMDAT files will not show up in the Query results. However, you can successfully query all file formats for any calculated metric that does not 
depend on keywords (e.g., LER, LCS, and BUG rating). 

AGi32 supports CIBSE/1 format only. Support for CIBSE/2 may be added in a future release  

Begin by pressing the Query button in the Photometric Instabase dialog box. The Query Photometric Instabase dialog will appear, prompting for the 
desired query conditions. 

1. Enter the desired query criteria (query will be automatically selected) or select from a pull-down menu. Please click on this topic's Concepts tab 
for query comments and examples. 

2. Click the Run Query button to search the existing Instabase for query matches. The filenames containing the specified query will appear in the 
Query Results window. 

3. Highlight a filename in the Query results window to see its associated file description, graphic, calculated metrics, candela curves display or 
LCS Graph. Note: Type B photometry is not subject to LCS or BUG rating queries, nor will they display LCS graph results (different angle 
parameters are used for these photometric files). 

4. When a manufacturer creates an Instabase for their product lines, they have the option to specify a More Information URL in their file structure 
as well as to each specific photometric file. This URL allows them to link you to their website location where more information about the product 
is available. If they have specified a More Information URL link for the selected photometric file or node, a More Information link will appear 
above the photographic image. 

5. To examine or modify the Candela or LCS display, click on the More button. Double clicking on the LCS Graph or polar curve will also display 
the More dialog. 

6. Click Ok to insert the highlighted photometric file into the Define Luminaire dialog box. 

Note: The Clear Query button will remove all previous query specifications from this dialog. 

Exporting the Query Results 

You may Export the results of your Query to a text (.txt) file, which may then be opened in a spreadsheet program such as Microsoft Excel. To do 
this, click the Export button. In the following dialog, select the information that you would like to Export to the text file. Then click OK.  
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Specify a file name and location to save the file, and then click OK.If you decide to open this file in Excel, start by opening Excel. Then click the Open 

File button. Change the file type to .txt and then navigate to the exported file. (Excel may ask you how the file is delimited. It is Tab delimited, and the 
data format is General.)  

 

You may also run a Data Integrity Check as part of the Export process. Click here for more information on Data Integrity Checks. 

Smart Symbols - Concepts 

Smart Symbols provide additional assistance when defining a luminaire by recommending a symbol for the selected photometric file. Smart Symbols 
are chosen for the selected photometric file using the luminaire's shape, size and distribution. In addition, the selected symbol is automatically scaled 
to match the luminaire's luminous box. 

You may select different mounting types for the selected file. Symbols shown for these mounting types will differ based on the distribution and 
application and may be undefined if the combination does not make sense (for example, you would not want to recess an indirect luminaire in the 
ceiling plenum). 

Symbol Characteristics 

Distribution Type - Four distribution types are recognized by AGi32: Direct, Direct-Indirect (Semi-Direct, General Diffuse and Semi-Indirect), Indirect 
and Floodlight. 

Luminous Area Type 

• Point, Rectangular, Rectangular with sides, Vertical Rectangular 

• Circular, Circular with sides (Vertical Cylinder), Horizontal Cylinder along length, Horizontal Cylinder along width 

• Ellipse along length, Ellipse along width, Ellipsoid along length, Ellipsoid along width 

• Sphere and Vertical Circle facing photometric horizontal  

• If an unsupported luminous shape is encountered, no symbol will be available. 

Luminous Box - A luminous box is inscribed from the luminous dimensions (Length, Width and Height) specified in the photometric file. The 
symbols are scaled to match the luminous box dimensions. 

Mounting Type 

The insertion point for the symbol is automatically set, based on the selected mounting type. Some mounting types allow you to override the 
recommended insertion point and select the one you prefer, Top or Bottom. 

With Pendant and Pole mounting types, an optional pendant or pole may be included with the symbol (selecting this option will enable the Pendant or 
Pole specification the Luminaire Define dialog). 

• In certain cases, with these mounting types, a minimum arm length or offset will be recommended, to prevent the pole or pendant from blocking 
the luminous area of the symbol, as in the Shoebox symbol. The minimum arm length and/or offset distance will be displayed and you will have 
the option to include these values (selecting this option includes these values in the Luminaire Define dialog). 

If the selected mounting type is undefined for the luminaire distribution (e.g., Ceiling Recessed - Indirect Distribution), a message is displayed 
indicating a different mounting type should be selected for this combination or the symbol should be selected manually. To select the symbol 
manually, click Cancel. 
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Recommended Symbols 

The symbols shown in the Recommended Symbols section are not scaled. Once a symbol is selected, it is scaled to match the luminous box. The 
Symbol scaling factors are displayed, as well as the scaled symbol itself. 

The selected symbol is loaded into both the Model Mode and Render Mode symbols in the Luminaire Define dialog. 

Note: Smart symbols are not recommended if the selected file has an associated symbol (e.g., luminaire selected from the Instabase with an 
associated symbol, or a luminaire from a Collection).  
 
Smart Symbols are enabled in Full Radiosity Method and Direct Only Method. You may modify these settings in the System Settings dialog, 
Switches/Settings tab. 

Related Topics 

Smart Symbol Logic 

Smart Symbols 

Smart Symbols provide additional assistance in defining a luminaire by recommending a symbol for the selected photometric file. Smart Symbols are 
chosen for the selected photometric file using the luminaire's shape, size and distribution. In addition, the selected symbol is automatically scaled to 
match the luminaire's luminous box. 

You may select different mounting types for the selected file. Symbols shown for these mounting types will differ based on the distribution and 
application and may be undefined if the combination does not make sense. For example, you would not want to recess an indirect luminaire in the 
ceiling plenum. 

1. Choose the Mounting Type to be used in conjunction with the selected photometric distribution. 
2. Select one of the recommended symbols. The selected symbol will be automatically scaled to match the luminous area described in the 

photometric file (the luminous box). 
3. Click Ok. 

Luminaire Symbols - Concepts 

AGi32 contains a luminaire symbol library with practical luminaire representations that can be used to model many different luminaire housings. 
Using appropriate luminaire symbols will increase the visual clarity of your presentations as well as distinguish different luminaire types. 

Symbol Folders 

AGi32 provides generic Render symbols for your use in the General (Symbol) folder. Model luminaire symbols are located in the General and 
Custom Symbols folders. Any folders within the Symbols subfolder will also be loaded. AGi32 searches for all symbols with the extension .SYM 
(Model and Render symbols) and .NSM (Model symbols) when opening the Model Symbols dialog. AGi32 searches for all symbols with the 
extension .SYM (Model and Render symbols) and .RSM (Render symbols) when opening the Render Symbols dialog. 

Custom folders for custom luminaire symbols will also be available in the Folder drop-down menus. 

Symbol Scaling Factor 

The factory-supplied symbols available in AGi32 are constructed to be true scale when the Symbol Scaling Factor is equal to one. The actual symbol 
sizes are given in a table below. A symbol scale of one is the default value and is reasonably legible when working with small-scale projects such as 
interior design applications. It will also make the symbol appear correct when rendered. 

When working with large-scale projects, such as outdoor sites, true size symbols may be hard to see. You may make the symbols easier to see in 
Model Mode by increasing the scale of the Model Mode Symbol only. Scaling the Render symbol will increase its size and may unrealistically effect 
your lighting calculations by obstructing the light in an exaggerated fashion.  

Each of the luminaire symbols may be scaled independently in the X, Y or Z directions to shrink, enlarge or change the shape of the luminaire 
symbol. The Factor column allows input of alternate scaling factors. The default symbol size is shown in the Size column. The Act. Size column 
indicates the modified symbol size (Factor x Size = Act. Size) 

For example, a 1x4 luminaire symbol can be changed to a 2x4 symbol by changing the Y scaling Factor to 2. The actual symbol size is X = 4, Y = 2, 
Z = 0.3. As the Symbol Scaling Factor is changed, the corresponding change will be shown in the selected symbol graphic. 

Symbol Color 

The color of a luminaire symbol comprises three components: Wireframe Color, Housing Color and Luminous Area Color. The wireframe color is the 
color of the Normal symbol in the graphics area. Choose colors to assist your visual presentations;for example to differentiate between luminaire 
types. The selected color has no effect on the lighting calculations. The Housing color is the color of the non light emitting portion of the luminaire 
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symbol. One housing color is applied to all portions of the luminaire that are not luminous. The Luminous Area color is the color of the luminous (light 
emitting) portion of the luminaire. 

The Housing color determines the symbol's reflectance and absorptance characteristics. The default housing color is a Gray 20% value. This means 
the any light that encounters the symbol will be attenuated in the following way: 80% will be absorbed, 20% will be reflected back into the 
environment. Choosing an appropriate Housing color for your luminaire, especially in interior applications will yield more meaningful results. 

The Luminous Area color selected effects the color of the light emitted from the selected luminaire when performing radiosity calculations and can 
easily be observed in the rendering. Be aware that changing the Luminous Area color to anything other than white (SRE = 1(100%)) will derate the 
output of the luminaire. Therefore, it is not recommended to try to approximate the light source color (color temperature) by using Luminous Area 
color unless you are aware of the consequences. On the other hand, it is useful for emulating the effect of colored gels or filters, as the depreciation 
is realistic. 

Insertion Point and Computational Implications 

Symbols have no effect on the light emitted from within themselves. For example, if a symbol has a mounting yoke, that yoke is part of the symbol 
and, consequently, has no effect on the light distribution from that luminaire. Similarly, choosing an inappropriate symbol for a selected photometric 
file (e.g., the Circle Up symbol for a recessed downlight photometric file) will not change the distribution of the luminaire. The symbol will simply 
appear mismatched to its apparent distribution in the rendering. However, other luminaires and surfaces in the environment can illuminate the 
luminaire symbol. Care should also be exercised when applying poles and pendants, as they too affect the light emitted from the luminaire (they are 
considered in the radiosity solution). See the Symbol Size table below for mounting recommendations. 

Poles and pendants are attached to the insertion point of the symbol. The insertion point of each symbol is indicated with a small arrow. When a 
symbol is selected, its current insertion point setting, relative to the symbol, is shown. You may change the insertion point of the luminaire (from top 
to bottom and vice versa) by clicking on the appropriate radio button. Your choice will most likely be governed by the application and mounting of the 
luminaire in the environment. Different symbols default to Top or Bottom, although either choice may be valid. See the Symbol Size table below for 
insertion point recommendations. 

Custom Luminaire Symbols 

Custom Luminaire Symbols for Model mode and Render mode can be created using AGi32's modeling tools or imported from a 3D CAD program via 
DWG or DXF format. 

Default Symbol Sizes 

Symbol Name Size (ft) Recommended Mounting 

Pole and Pendant will affect emitted light. 

INS-TOP Insertion pt. Top 

INS-BOT Insertion pt. Bottom 

Default Insertion 
Point 

Comments 

1200 x 300 MM 
DOWN 

X = 1.2 M 

Y = 0.3 M 

Z = 0.1 M 

Pendant ( INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Bottom, Center   

1200 x 300 MM 
RECESSED 

X = 1.2 M 

Y = 0.3 M 

Z = 0.003 M 

Ceiling Top, Center   

1200 x 300 MM 
UP 

X = 1.2 M 

Y = 0.3 M 

Z = 0.1 M 

Pendant 

Wall 

Top, Center   

1200 x 300 MM 
UP_DOWN 

X = 1.2 M 

Y = 0.3 M 

Z = 0.1 M 

Pendant ( INS-TOP) 

Wall 

Bottom, Center   

1X4 DOWN X = 4 

Y = 1 

Z = .3 

Pendant ( INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Bottom, Center X-Scale = 2 - produces a 1X8 
symbol 

1X4 LV DOWN X = 4 

Y = 1 

Z = .3 

Pendant (INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Bottom, Center X-Scale = 2 - produces a 1X8 
symbol 

1X4 LV 
RECESSED 

X = 4 

Y = 1 

Z = .003 

Ceiling Top, Center X-Scale = 2 - produces a 1X8 
symbol 

1X4 RECESSED 
LS 

X = 4 

Y = 1 

Ceiling Top, Center X-Scale = 2 - produces a 1X8 
symbol 
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Z = .15 Luminous Sides 

1X4 RECESSED X = 4 

Y = 1 

Z = .01 

Ceiling Top, Center X-Scale = 2 - produces a 1X8 
symbol 

1X4 UP X = 4 

Y = 1 

Z = .3 

Pendant 

Wall 

Top, Center X-Scale = 2 - produces a 1X8 
symbol 

1X4 UP_DOWN X = 4 

Y = 1 

Z = .3 

Pendant (INS-TOP) 

Wall 

Bottom, Center X-Scale = 2 - produces a 1X8 
symbol 

1X4 WRAP X = 4 

Y = 1 

Z = .3 

Pendant (INS-TOP) 

Wall 

Ceiling (Surface mount only INS-TOP) 

Bottom, Center X-Scale = 2 - produces a 1X8 
symbol 

2X4 DOWN X = 4 

Y = 2 

Z = .3 

Pendant ( INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Bottom, Center Y-Scale = 2 - produces a 4X4 
symbol 

2X4 LV DOWN X = 4 

Y = 2 

Z = .3 

Pendant ( INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Bottom, Center Y-Scale = 2 - produces a 4X4 
symbol 

2X4 RECESSED X = 4 

Y = 2 

Z = .01 

Ceiling Top, Center   

4X1 DOWN X = 1 

Y = 4 

Z = .3 

Pendant ( INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Bottom, Center Generally used for a wall-wash 
type luminaire (0 degrees 
horizontal is across the lamps) 

4X1 RECESSED X = 1 

Y = 4 

Z = .01 

Ceiling Top, Center   

4X1 UP_DOWN X = 1 

Y = 4 

Z = .3 

Pendant (INS-TOP) 

Wall 

Bottom, Center   

4X1 UP X = 1 

Y = 4 

Z = .3 

Pendant ( INS-TOP) 

Wall 

Bottom, Center   

4X1 WRAP X = 1 

Y = 4 

Z = .3 

Pendant ( INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Bottom, Center   

BOLLARD 
ROUND 12X36 

Dia. = 1 

Z = 3 

Ground Bottom, Center Can change diameter by scaling 
both X and Y 

BOLLARD 
SQUARE 3' 

X = 1 

Y = 1 

Z = 3 

Ground Bottom, Center   

BOX DOWN LS X = 1 

Y = 1 

Z = 0.45 

Pole (Apply an Arm Length >= X/2) 

Pendant (INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Top, Center Luminous Sides 

BOX DOWN X = 1 

Y = 1 

Z = 0.3 

Pole (Apply an Arm Length >= X/2) 

Pendant (INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Top, Center  X-Scale = 2, 

Y-Scale = 2 

- produces a 2X2 symbol 

BOX RECESSED 
LS 

X = 1 

Y = 1 

Ceiling Top, Center Luminous Sides 
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Z = .15 

BOX RECESSED 
UP 

X = 1 

Y = 1 

Z = .0 

Ground Top, Center   

BOX RECESSED X = 1 

Y = 1 

Z = .01 

Ceiling Top, Center   

BOX UP_DOWN 
LS 

X = 1 

Y = 1 

Z = .6 

Pole (Apply an Arm Length >= X/2) 

Pendant (INS-TOP) 

Wall 

Bottom, Center Luminous Sides 

BOX UP LS X = 1 

Y = 1 

Z = 0.45 

Pendant (INS-TOP) 

Wall 

Bottom, Center Luminous Sides 

BOX UP X = 1 

Y = 1 

Z = .3 

Pole (INS-BOT) 

Pendant 

Wall 

Ground 

Top, Center X-Scale = 2, 

Y-Scale = 2 

- produces a 2X2 symbol 

BOX UP_DOWN X = 1 

Y = 1 

Z = .3 

Pole 

Pendant (INS-TOP) 

Wall 

Bottom, Center X-Scale = 2, 

Y-Scale = 2 

- produces a 2X2 symbol 

CIRCLE DOWN 
LS 

Dia. = 2 

Z = 0.45 

Pole (Apply an Arm Length >= Dia./2) 

Pendant (INS-TOP) 

Wall 

Ceiling 

Top, Center Luminous Sides 

Can change diameter by scaling 
X and Y equally. 

X-Scale > Y-Scale - produces an 
ellipse along the X-axis. 

Y-Scale > X-Scale - produces an 
ellipse along the Y-axis. 

CIRCLE DOWN Dia. = 2 

Z = .3 

Pole (Apply an Arm Length >= Dia./2) 

Pendant (INS-TOP) 

Wall 

Ceiling 

Bottom, Center Can change diameter by scaling 
X and Y equally. 

X-Scale > Y-Scale - produces an 
ellipse along the X-axis. 

Y-Scale > X-Scale - produces an 
ellipse along the Y-axis. 

CIRCLE 
RECESSED 
DOWN LS 

Dia. = 1 

Z = .15 

Ceiling Top, Center Luminous Sides 

CIRCLE 
RECESSED 
DOWN 

Dia. = 2 

Z = .01 

Ceiling Top, Center   

CIRCLE 
RECESSED UP 
LS 

Dia. = 1 

Z = .15 

Ground Bottom, Center Luminous Sides 

CIRCLE 
RECESSED UP 

Dia. = 1 

Z = .3 

Ground Bottom, Center   

CIRCLE 
RECESSED 

Dia. = 2 

Z = .01 

Ceiling Top, Center   

CIRCLE 
UP_DOWN LS 

Dia. = 1 

Z = .6 

Pole (INS-BOT) 

Pendant 

Wall 

Ground (INS-BOT) 

Bottom, Center Luminous Sides 

CIRCLE UP LS Dia. = 1 

Z = .45 

Pole (INS-BOT) 

Pendant 

Wall 

Ground (INS-BOT) 

Bottom, Center Luminous Sides 

CIRCLE UP Dia. = 2 Pole (INS-BOT) Top, Center Can change diameter by scaling 
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Z = .3 Pendant 

Wall 

Ground (INS-BOT) 

X and Y equally. 

X-Scale > Y-Scale - produces an 
ellipse along the X-axis. 

Y-Scale > X-Scale - produces an 
ellipse along the Y-axis. 

CIRCLE 
UP_DOWN 

Dia. = 2 

Z = .3 

Pole 

Pendant (INS-TOP) 

Wall 

Bottom, Center Can change diameter by scaling 
X and Y equally. 

X-Scale > Y-Scale - produces an 
ellipse along the X-axis. 

Y-Scale > X-Scale - produces an 
ellipse along the Y-axis. 

DOWNLIGHT Dia. = 1 

Z (flange) = 
.1 

Pendant 

Wall 

Ceiling 

Top, Center Flange is below luminous area. 

Can change diameter by scaling 
X and Y equally. 

X-Scale > Y-Scale - produces an 
ellipse along the X-axis. 

Y-Scale > X-Scale - produces an 
ellipse along the Y-axis. 

FLOOD BOX 
RECESSED LS 

X = 1 

Y = 1 

Z = .15 

Ceiling Top, Center Luminous Sides 

FLOOD CIRCLE 
RECESSED LS 

Diameter = 
1 

Z = .15 

Ceiling Top, Center Luminous Sides 

FLOOD CIRCLE 
RECESSED 

Diameter = 
1 

Z = .01 

Ceiling Top, Center   

FLOOD LS X = 1 

Y = 1 

Z = .45 

Pole (Apply an Arm Length >= X/2) 

Pendant (INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Ground 

Bottom, Center Luminous Sides 

FLOOD 
RECESSED 

X = 1 

Y = 1.5 

Z = .001 

Ceiling Top, Center   

FLOOD X = 1 

Y = 1.5 

Z = .3 

Pole (Apply an Arm Length >= X/2) 

Pendant (INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Ground 

Bottom, Center   

FLOOR 
RECESSED UP 
LS 

Diameter = 
1 

Z = .15 

Ground Bottom, Center Luminous SIdes 

GLOWTOP Dia. = 1 

Z = 1 

Z (yoke) = 
.6 

Pole Bottom, Center Yoke has no effect on emitted 
light 

NULL X = .02 

Y = .02 

Z = 0 

Pole (Apply an Arm Length >= X/2) 

Pendant (INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Ground 

Top, Center Symbol has no housing or 
luminous area 

REFLECTOR Dia. = 1 

Z = .7 

Pendant (INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Bottom, Center Can change diameter by scaling 
X and Y equally. 

X-Scale > Y-Scale - produces an 
ellipse along the X-axis. 

Y-Scale > X-Scale - produces an 
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ellipse along the Y-axis. 

SCON DOWN LS X = 1 

Y = 1 

Z = .45 

Wall Bottom, Right 
Edge 

  

SCON DOWN X = 1 

Y = 1 

Z = .45 

Wall Bottom, Right 
Edge 

  

SCON ROUND 
DOWN LS 

Dia. = 0.5 

Z = 0.55 

Wall Bottom, Right 
Edge 

  

SCON ROUND 
DOWN 

Dia. = 0.5 

Z = 0.5 

Wall Bottom, Right 
Edge 

  

SCON ROUND 
UP DOWN LS 

Dia. = 0.5 

Z = 0.6 

Wall Bottom, Right 
Edge 

  

SCON ROUND 
UP DOWN 

Dia. = 0.5 

Z = 0.5 

Wall Bottom, Right 
Edge 

  

SCON ROUND 
UP LS 

Dia. = 0.5 

Z = 0.55 

Wall Bottom, Right 
Edge 

  

SCON ROUND 
UP 

Dia. = 0.5 

Z = 0.5 

Wall Bottom, Right 
Edge 

  

SCON UP X = .5 

Y = 1 

Z = .5 

Wall Top, Right Edge   

SCON UP_DOWN X = .5 

Y = 1 

Z = .5 

Wall 

  

Bottom, Right 
Edge 

  

SEMI-CYL X = 1 

Y = 2 

Z = .5 (dia.) 

Pole (INS-TOP) 

Pendant (INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Ground 

Bottom, Center   

SHOEBOX YOKE X = 1.5 

Y = 1 

Z = .3 

Z (yoke) = 
.6 

Pole Bottom of Yoke, 
Center 

Yoke has no effect on emitted 
light 

SHOEBOX X = 1.5 

Y = 1 

Z = .3 

Pole (Apply an Arm Length >= X/2) 

Pendant (INS-TOP) 

Wall 

Ceiling (If surface mount INS-TOP) 

Bottom, Center   

SPHERE Diameter = 
1 

Z = 1 

 Pendant (INS-TOP) Bottom, Center   

TRACK X = .6 

Y = .6 

Z = ..6 

Pole 

Pendant 

Wall 

Ceiling 

Ground 

Top, Center   

TUBE4 DOWN X = 4 

Dia. = 1 

Pendant ( INS-TOP) 

  

Bottom, Center X-Scale changes the length of 
the tube. 

Can change diameter by scaling 
Y and Z equally. 

TUBE4 UP X = 4 

Dia. = 1 

Pendant 

  

Top, 

Center 

X-Scale changes the length of 
the tube. 
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Can change diameter by scaling 
Y and Z equally 

TUBE4 
UP_DOWN 

X = 4 

Dia. = 1 

Pendant (INS-TOP) 

  

Bottom, Center X-Scale changes the length of 
the tube. 

Can change diameter by scaling 
Y and Z equally 

WALL BOX 
RECESSED LS 

X = 0.15 

Y = 1 

Z = 1 

Wall Bottom, Right 
Edge 

Luminous Sides 

WALL BOX 
RECESSED 

X = 0.02 

Y = 1 

Z = 1 

Wall Bottom, Right 
Edge 

  

WALL BOX 
SURFACE LS 

X = 0.45 

Y = 1 

Z = 1 

Wall Bottom, Right 
Edge 

Luminous Sides 

  

WALL BOX 
SURFACE 

X = 0.3 

Y = 1 

Z = 1 

Wall Bottom, Right 
Edge 

  

WALL CIRCLE 
RECESSED LS 

X = 0.15 

Dia. = 1 

Wall Bottom, Right 
Edge 

Luminous Sides 

Can change diameter by scaling 
Y and Z equally 

WALL CIRCLE 
RECESSED 

X = 0.01 

Dia. = 1 

Wall Bottom, Right 
Edge 

Can change diameter by scaling 
Y and Z equally 

WALL CIRCLE 
SURFACE LS 

X = 0.45 

Dia. = 1 

Wall Bottom, Right 
Edge 

Luminous Sides 

Can change diameter by scaling 
Y and Z equally 

WALL CIRCLE 
SURFACE 

X = 0.3 

Dia. = 1 

Wall Bottom, Right 
Edge 

Can change diameter by scaling 
Y and Z equally 

WALLPACK X = .6 

Y = 1 

Z = 1 

Wall 

  

Bottom, Right 
Edge 

  

Luminaire Symbols 

Users will increase the visual clarity of their presentations as well as distinguish different luminaires by taking advantage of AGi32's extensive 
luminaire symbol library when completing the luminaire definition. AGi32 provides many generic symbol representations that correspond to particular 
types of photometric files. 

The Model Mode symbols are symbolic representations of the luminaire in Model Mode (design mode) and are shown in Plan view. Model symbols 
are used to graphically represent the luminaire in Model Mode and do not participate in the calculations in any way. These symbols will represent the 
luminaires in Model Mode. 

The Render mode symbols are physical luminaire representations in Render mode and are shown in Isometric view. Render Symbols participate in 
Full Radiosity calculations by reflecting and occluding light within the environment. They are constructed of two basic surface types, the symbol's 
housing and its luminous surface. Each surface type is assigned a color corresponding to a particular reflectance (luminaire housing) or luminosity 
(luminous area).  

1. Select a symbol by clicking on the desired thumbnail image. The symbol will appear, enlarged, in the Selected Symbol box. You may change 
the direction that you're viewing the symbol from ("orbit" around the symbol) by holding your left mouse button down (on the image) and sliding 
the mouse. You may also zoom in or out using the mouse (rolling the mouse wheel) while the mouse in over the image. 

2. Model Wireframe Color - The color used to draw the symbol in Model Mode. This color has no effect on the lighting calculations. 
3. Render Housing Color - The housing color is assigned to the opaque non-light emitting portion of the symbol. By default, the color black is 

assigned to the housing surfaces (0.2 reflectance). 
4. Render Luminous Area Color  - The luminous portion of the symbol is assigned the color white by default (1.00 Spectral Radiant Emittance). 

The luminous surface can have a luminous color associated with it, e.g., from a colored gel, to affect the color of the light emitted from the 
luminaire. 

5. Symbol Scaling - To change the default scaling factors for the chosen symbols, enter the appropriate value in the X, Y and/or Z Factor text 
boxes. For example, to scale a 1x4 Symbol to a 2 x 4, change the Y Scaling Factor to 2. 
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Note: Symbols should generally be scaled to True Size. Changing the Model Symbol scaling factors can make the symbols easier 
to see without affecting the lighting calculations. Changing the Render Symbol Scaling Factors can affect your lighting calculations, 
especially for interiors. 

6. Insertion Point - The Insertion Point of the symbol positions the symbol relative to the chosen Mounting Height. Poles and Pendants are 
attached to the Insertion Point of the symbol. Each Symbol has its own default Insertion Point, which may be changed at any time. 

7. Click Ok to accept the selection. 

Note: You may create custom luminaire symbols for use in Render Mode and/or Model Mode using AGi32’s drawing and object tools. 

SRE - Concepts 

Spectral Radiant Emittance (SRE)  represents the intensity of light when a color other than white (100%) is selected. When a color is assigned to a 
light source, it behaves like a color filter, decreasing the output of the luminaire as indicated by the SRE figure. 

The colors displayed in the Spectral Radiant Emittance dialog are automatically gamma corrected based on the following equation: 

 

where C′ is the gamma-corrected displayed color value and C is the specified RGB value. 

Luminous Area vs. Housing Color 

The Color Selection dialog shows actual colors or gray-scale shades that correspond to a particular Reflectance or Spectral Radiant Emittance 
(SRE). All surface colors in AGi32 are based on their Reflectance or Spectral Radiant Emittance. Reflectance is a property of a non-luminous 
surface, such as the luminaire housing or ceiling or wall surface. Spectral Radiant Emittance is the light transmittance value of a luminous surface, 
such as the lensed portion of a recessed fluorescent luminaire, downlight, or floodlight, based on the combination of its red, green and blue spectral 
transmission characteristics. 

Luminous Area 

When luminous surfaces are specified, they are assigned an SRE value and a corresponding color that indicates the color of the emitted light. 

The luminous area of a luminaire symbol may be assigned a luminous color. The default luminous color of a symbol is white (SRE = 1). When 
assigning a luminous color other than white, you are decreasing the SRE and the lumen output of the luminaire. 

Luminous Area Color as a Gel, Not Lamp Color 

When a color is applied to a luminous surface, it decreases the emitted lumens. This is acceptable when using color to model the effect of a colored 
gel over the light source, since the gel has a transmittance value associated with it.  

Luminous color should not be used to model lamp color for the following reasons:  

1. Luminous color depreciates lumen output. 
2. Lamp spectral and surface spectroradiometric data would be required to accurately model the effects of color reflectance. In other words, a 

Spectral Power Distribution (SPD) curve for the light source and a similar curve describing the spectral reflectance characteristics of each of the 
surfaces in the space would be required for an accurate depiction of the effect of lamp color. 

3. There is currently no way to accurately reproduce the visual effects of lamp color using RGB monitors or any other 3-color  media. 

Equation for Surface Reflectance and SRE 

The relationship used by AGi32 between Color and Reflectance (including SRE) is based upon color weighting factors specified in ITU-R 
Recommendation BT-709, "Basic Parameter Values for the Studio and for International Programme Exchange (1990)," [formerly CCIR Rec. 709], 
ITU, 1211 Geneva 20, Switzerland.  

The weighting factors are representative of human visual sensitivity to the color phosphors used in contemporary computer monitors. 

• Red band weight (R) = 0.2125 

• Green band weight (G) = 0.7154 
• Blue band weight (B) = 0.0721 

Reflectance = (0.2125R + 0.7154G + 0.0721B) / 255 
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 Rosco and Lee Color Filters  

You may select a Rosco or Lee color filter by name or number. RGB values for Rosco color filters were derived from proprietary filter spectral power 
distributions provide by Rosco Laboratories, Inc. RGB values for Lee filters were derived from the filter CIE Tristimulus values (X, Y, Z) obtained from 
www.leefilters.com.  

The RGB values are based on industry standard ITU BT.709 phosphor chromaticities for HDTV and computer monitor displays with a white point of 
6500K. 

SRE Values for LED Dominant Wavelengths 

The RGB values listed in the tables below will allow you to simulate the perceived LED color associated with each dominant wavelength color and 
standard LED colors. 

LED Color and RGB decimal Values AGi32 Scaled RGB Values 

Royal Blue (0.05, 0.00, 0.95) ( 13, 0, 255) 

Blue (0.00, 0.11, 0.89) (0, 31, 255) 

Cyan (0.00, 0.63, 0.37) (0, 255, 149) 

Green (0.00, 0.77, 0.23) (0, 255, 76) 

Amber (0.70, 0.30, 0.00) (255, 109, 0) 

Red-Orange (0.97, 0.00, 0.03) (255, 0, 8) 

Red (0.92, 0.00, 0.08) (255, 0, 22) 
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Color / Spectral Radiant Emittance (SRE) Selector 

The Spectral Radiant Emittance (SRE) dialog allows you to change the luminous-area color of your luminaires. By default, luminaires emit a white 
light (1.00 SRE Value, or 100%). When SRE is applied, it can change the color of the light output as well as the amount transmitted. SRE application 
decreases the luminaire output as indicated by the SRE figure. 

For example, if a color is selected that corresponds to an SRE figure of 0.89, the output of the luminaire is then 89% of what it was without the color 
applied. This is acceptable when using color to model the effect of a colored gel over the light source, as the gel has a transmittance value 
associated with it. However, when attempting to use luminous color to approximate lamp color, be aware that the color selected is a gross 
approximation of the spectral characteristics of the lamp, and the output of the luminaire is decreased according to the SRE figure. It can be 
normalized by applying the reciprocal of the SRE value in the LLF using the "other" cell. 

To select a luminous color 

• On the Color Mixer tab, change the SRE value directly. The selected SRE color will continue to exhibit a gray tone. 

• Also on the Color Mixer tab, move the slider controls for Red, Green and Blue until the color desired appears both in the center of the Color 
Mixer and the selected SRE cell on the right side of the dialog. Alternatively, enter RGB values manually (between 0 and 255). 
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The calculated SRE value is shown below the Selected color. This is the amount the luminaire output has been derated. In the example above, the 
luminaire output is now 83%.  

• On the Favorites tab, you can select a color that you have previously saved as a Favorite. (See below.) 

• On the Color Filters tab, select a Lee or Rosco color filter by its name or number. You can sort the color filters in various ways by clicking on the 
column headers. In the example below, the luminaire output is now down to 39%. 

 

Add to Favorites 

It is convenient to be able to store favorite color combinations for later use. By selecting the Add to Favorites button, the color will be stored in the 
Favorites tab with Color, SRE, and Comments to aid in later identification. 

You can recall a favorite color selection anytime by selecting  the Favorites tab and clicking on the color cell. Click OK to exit the dialog and return 
the color to the luminaire define process. 

RGB Conversions for Source Color 

Computer graphics rendering technology cannot easily simulate light source Spectral Power Distribution data (SPD). However, it is possible to 
convert SPD data to an RGB equivalent. While this is not a perfect conversion, it is usually adequate for convincing visualizations. The two tables 
below provide RGB equivalents for standard CIE light sources as well as common Correlated Color Temperatures (Kelvins). It is important to 
remember to add the reciprocal of the SRE value as a multiplier in the LLF calculator (as a User Defined factor) if accurate calculations are expected. 
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Luminous Box 

AGi32 uses the dimensions of the luminous box when performing lighting calculations in Full Calculation mode. In Direct Calculation mode, the 
luminaire is assumed to be a point source. If the luminous dimensions found in the photometric file are incorrect, the lighting calculations may not be 
accurate. For example, if the distribution of a 1x4 luminaire is emitted from a point source instead of an appropriately sized luminous area, the 
luminous area will not be discretized appropriately. The effect is most noticeable when the luminaire is placed close to a reflective surface. 

In addition, care should be taken that the luminous box does not extend outside of the room and is not truncated by any objects. Most importantly, 
the luminous height (Z) should not be above the ceiling. If the photometric file has luminous height, the luminaire should be mounted below the 
ceiling at a distance equal to, at least, that dimension. If the Z dimension of the URHC is 0, the luminaire may be mounted flush against the ceiling. 

The luminous box is associated with the luminous area in the Render symbol. Specifically, the Z=0 portion of the luminous box is aligned with the 
center of the luminous area of the Render symbol. This association may place the luminous box at some distance away from the insertion point of 
the luminaire (mounting height). For example, if the Shoebox-Yoke symbol is selected, the luminous area is located 1 foot above the insertion point 
of the luminaire. If a 15 foot mounting height is specified, the calculations will actually consider the luminous source at 16 feet above grade. 

The luminous box is circumscribed using the luminous opening data in the photometric file. The X, Y and Z coordinates of the lower left hand corner 
(LLHC) and upper right hand corner (URHC) are given relative to the center of the luminous opening. The X dimension corresponds to the distance 
across the luminous opening along the 0-180 photometric plane. The Y dimension corresponds to the distance across the luminous opening along 
the 90-270 photometric plane. 

Note: Please see the IESNA document, LM-63, for more information about the luminous dimensions given in photometric files.  

Static and Dynamic Poles/Pendants 

Static or dynamic terminology refers to the pole length when the luminaire is located. In either case, the Mounting height specifies the location of the 
insertion point of the luminaire symbol in space. The top of the pole is always attached to the luminaire symbol at its insertion point. 

Dynamic Length 

Dynamic refers to the pole or pendant changing length based on the mounting height of the luminaire. The base of the pole or pendant is attached to 
the Z coordinate specified in the luminaire definition (Attach to Z=). By default, this Z coordinate is 0. 

• For example: If you specify a Dynamic pole attached to Z=0 AND you specify a luminaire mounting height of 30, your pole length will 
be 30 (30-0). If you specify a Dynamic pole attached to Z=10 AND a luminaire mounting height of 30, your pole length will be 20 (30-
10). 

Static Length 

Static refers to the pole length remaining constant regardless of the mounting height of the luminaire. Use this pole type when you the base of the 
pole changes in elevation but the relative pole length remains the same (as on a hill). 

• For example: If you specify a Static pole length of 10 AND you specify a mounting height of 30, you pole base would be located at 20 
(30-10).  If you  specified another luminaire with a mounting height of 25, you pole base would be located at 15 (25-10). 

Luminaire Collections - Concepts 

Luminaire collections are lists of predefined luminaire definitions that represent your most commonly used luminaires. AGi32 will allow you to create 
as many collections as you like, each with a unique set of definitions. For example, specifiers may wish to create collections associated with 
particular projects, agents may like to create collections for individual manufacturers they represent, while a utility could create a collection of 
luminaires they have approved and stock. Any way that you decide to establish your collections, they can be a dramatic time saver when you know 
what luminaires you need, and how they should be represented, without having to think about the process each time. 

All luminaires that will be added to a collection must carry unique descriptions. It is by these descriptions that they will be listed in the luminaire 
collections. If no description was entered when the luminaire was defined, you will be prompted to enter one. Luminaire Descriptions, as well as 
collection names, cannot contain the ASCII characters *, ?, “ and may be up to 255 characters long. 

You need only to assign a unique label to a predefined luminaire from a luminaire collection to add it to the Defined Luminaire List. The Collection 
Labeling dialog will assist you in this process.  

Luminaire Collections 

Most users tend to use the same luminaires or luminaire arrangements repeatedly. AGi32 provides a method to access your favorite or most 
commonly used luminaire definitions without having to redefine them in every job file. This system is called a Luminaire Collection. 

You can create any number of luminaire collections with unique names and luminaires. For example, a collection could be called “My Favorite 
Roadway Luminaires” or “Typical Area Lighting.” 
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What do you want to do? 

Create new collections 

1. Click the New button located at the bottom of the Luminaire Collection dialog box. 
2. Enter a unique collection name in the Collection Name text box. 
3. Click the Add button to add the new collection name to the Collections window. 
4. Continue in this manner until all of the desired collections have been added. 
5. Click Ok. 

Extract luminaires from a collection to the current job file 

Predefined luminaires will appear in the Description section at the bottom of the Luminaire Collection dialog. Each listing of luminaires is associated 
with a particular luminaire collection and will only be seen if that collection is the current one. 

1. In the Luminaire Collection dialog, select the collection name from the pull-down menu . 
2. The associated luminaire descriptions will appear in the Luminaire Collection area. Select the desired luminaires from the list by selecting and 

dragging the mouse over the desired luminaires. Alternately, you may use the Windows™ selection controls (Shift or Ctrl) to select the desired 
luminaire descriptions. 

3. Click the Add Selected Luminaires to Defined List button. 
4. The Collection Labeling  dialog will appear prompting you to select a method with which to label the selected luminaires. 
5. After labeling, the newly labeled luminaires will appear in the Define Luminaire List. 
6. Click Ok. 

Add luminaires from the current job file to a collection 

1. Click on the Luminaire Collection button in the Define Luminaire dialog box. 

2. In the Luminaire Collection dialog, select the collection name from the pull-down menu . 
3. All luminaires defined in the current job file will appear in the Define Luminaire List. Select the desired luminaire(s) from the list by selecting and 

dragging the mouse over the desired luminaires. Alternately, you may use the Windows™ selection controls (Shift or Ctrl) to select the desired 
luminaire descriptions. 

4. Click the Add Selected Luminaires to Collection button. 
5. If any of the selected luminaire do not have an associated description, you will be prompted to enter a unique description at this time. 
6. The new descriptions will appear in the Description window. 
7. Click Ok. 

Delete luminaires from a collection 

1. In the Luminaire Collection dialog, select the collection name from the pull-down menu . 
2. The description of every luminaire within the collection will appear. Select the desired luminaire(s) from the list by selecting and dragging the 

mouse over the desired luminaires. Alternately, you may use the Windows™ selection controls (Shift or Ctrl) to select the desired luminaire 
descriptions. 

3. Click the Delete button located at the bottom of the Luminaire Collection dialog box. 
4. The selected luminaires will be removed from the Description area. 
5. Click Ok. 

Delete an entire collection and its contents 
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1. In the Collections window, select the desired collections by selecting and dragging the mouse over the collection names. 
2. Click the Delete button to delete the collection name and any associated luminaires. 
3. The deleted collection names will be removed from the Collections window. 
4. Click Ok. 

Labeling Luminaires from Collections - Concepts 

When you add luminaires from a collection to your local job file, you are required to label them just as if you had created them locally. AGi32 provides 
automatic and manual labeling options for your convenience. 

If you normally label luminaires using an alphanumeric or numeric scheme, AGi32 can do this for you as you pull luminaires from a collection. Or, if 
you prefer, you may label them manually (for example IES filename or Catalog Number). 

Labeling Luminaires from Collections 

AGi32 provides you with three methods to label predefined luminaires: automatic alphanumeric, automatic numeric and manual labeling. 

Automatic Labeling 

If the Automatic Labeling method is selected, AGi32 will sequentially label the luminaires beginning with the first luminaire selected. 

1. Select Alphanumeric or Numeric labeling by clicking on the appropriate radio button. 

• AGi32 defaults to starting alphanumeric labeling with the letter A and numeric labeling with the number 1. 
• If alternate starting characters are desired, enter them in the appropriate text box. 

2. When using alphanumeric labeling, once the letter Z is reached, AGi32 continues labeling with A1, B1, etc. 
3. Click Ok. 

Manual Labeling 

When manual labeling is selected, the user chooses the Label for each luminaire type. 

1. Enter the label name adjacent to each luminaire. 

• The labels must be unique, contain 12 characters or less and cannot contain the characters * ? . 

• If a duplicate or invalid label is entered, AGi32 will prompt you to relabel the luminaire. 
2. Click Ok. 

Luminaire Arrangements - Concepts 

Luminaire arrangements consist of single or multiple occurrences of one photometric file arranged in common configurations about a central point. 
The default luminaire arrangement is a single luminaire with an arm length of zero. 

Depending on the arrangement, it is possible to change its arm length and/or offset. These variables specify the distance of the luminous center of 
the luminaire from the insertion point of the arrangement. Arm length represents the distance from luminous center to insertion point along the 0-180 
photometric plane. If multiple luminaires occur perpendicular to each other (For Example, twin), Offset represents the distance from luminous center 
to insertion point along the 90-270 photometric plane. 

Luminaire Arrangement Limitations 

• Luminaire arrangements can be oriented but cannot be aimed at a point. 

• All "heads" use the same photometric file. To create an assembly of luminaires around a central location with multiple photometric files, Create a 
Luminaire Group instead. 

Luminaire Arrangements 

Luminaire Arrangements consist of single or multiple occurrences of a photometric file arranged in a common configuration about a central location. 
AGi32 provides a number of common Luminaire Arrangements for your use. 

 Select an arrangement by clicking on the desired thumbnail image. The arrangement will appear, enlarged, in the Selected Arrangement box. Click 
Ok to accept the selection. 

How do I create Custom Luminaire Arrangements? 
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Custom Luminaire Arrangements - Concepts 

Should you need to create an arrangement other than the factory-supplied arrangements, AGi32 provides a useful dialog box with which to create 
custom arrangements. Luminaire arrangements are used to arrange any number of luminaires around a central location. The photometric file 
associated with each "head" is exactly the same for all luminaires. 

A knowledge of the aiming parameters used in AGi32 is required to apply the appropriate angle modifications. 

Custom Arrangement Examples 

 

 

  

 

 

 AGi32 also offers you the option of creating Luminaire Groups, which are different from Arrangements. This can be useful when the components of 
the arrangement are different luminaires, e.g., a cobrahead and a post-top luminaire on the same pole. 

Custom Luminaire Arrangements 

This dialog facilitates the creation of custom luminaire arrangements. The Custom Arrangements dialog box will prompt you to enter a unique 
arrangement name and the arrangement's relative coordinate and aiming information. You may create a new arrangement from scratch or use an 
existing arrangement to create a new arrangement. Factory-supplied arrangements can not be modified; you will be prompted for a unique 
arrangement name. 

The Clear button clears all coordinate and aiming information from the dialog box, allowing you a clean start. 

What do you want to do? 

Open and modify an existing arrangement 

1. Click on the Open button to invoke the Browse Dialog box. 
2. Select the desired arrangement by clicking on the arrangement name and then clicking on the Open button. Alternatively, you may double click 

on the arrangement name to select it. 
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3. The arrangement's relative coordinate and aiming information will appear. 
4. Rename the arrangement and modify the existing information to suit your needs. 
5. Click Ok. 

Create a new arrangement from scratch 

1. Enter a unique arrangement name. 
2. Enter coordinate and aiming information as desired. Each row in the dialog represents a single occurrence of the photometric file. Please see 

the Arrangement Rules for arrangement variable information and examples. 
3. Click Ok. 

Arrangement Rules 

The following rules apply when creating any custom arrangement: 

• Arrangement names may be up to 256 characters and may not contain the characters \ / : < > | * ? “. 

• To create an arrangement with variable arm length along the orientation angle, use the variable ARM instead of the X and /or Y coordinates. If 
the variable ARM is found in the custom arrangement, the appropriate input cell (Arm Length) will appear in the Define Luminaire dialog when 
that arrangement is selected. 

Example: Back-to-back 

X Y Z Orient Tilt Roll Spin 

ARM 0 0 0 0 0 0 

ARM 0 0 180 0 0 0 

  

Example: 3 @ 120 degrees 

X Y Z Orient Tilt Roll Spin 

ARM 0 0 0 0 0 0 

ARM ARM 0 120 * 0 0 0 

ARM ARM 0 240 * 0 0 0 

* When the arrangement's orientation is not orthogonal (+/- X or +/- Y), ARM should be specified for both X and Y coordinates where ARM in the X 
direction is specified as ARM * cos(Orient) and ARM in the Y direction is ARM * sin(Orient). 

• To create an arrangement with variable arm length perpendicular to the orientation angle, use the variable OFF (or -OFF) instead of the X and 
/or Y coordinates. OFF is applied perpendicular to the orientation angle (counterclockwise) and -OFF is applied perpendicular to the orientation 
angle (clockwise). If the variable OFF is found in the custom arrangement, the appropriate input cell (Offset) will appear in the Define Luminaire 
dialog when that arrangement is selected. 

Example: Twin Back-to-back 

X Y Z Orient Tilt Roll Spin 

ARM OFF 0 0 0 0 0 
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ARM -OFF 0 0 0 0 0 

ARM OFF 0 180 0 0 0 

ARM -OFF 0 180 0 0 0 

  

AGi32 also offers you the option of creating Luminaire Groups, which are different from Arrangements. This can be useful when the components of 
the arrangement are different luminaires, e.g., a cobrahead and a post-top luminaire on the same pole. 

Candela Distribution Curves 

The candela curves of all photometric files selected, regardless of method (Instabase, Select File, etc.) are plotted on either a Polar or Cartesian 
graph and displayed in the define dialog. The contents of the graph can be user controlled using the More button. 

Factory default graphs are as follows: 

Type C photometric reports, indoor, fluorescent, industrial, roadway, area and most other luminaire types, are displayed in a Polar format graph.  

The blue curve represents a vertical slice through the light distribution at the horizontal angle containing the maximum candela. The distribution 
measuring 180 degrees (horizontally) away from the maximum makes up the other side of the curve. If a luminaire is symmetric, both sides of the 
curve are the same.  

The Red curve represents a conical slice through the light distribution at the vertical angle 
containing the maximum candela as measured in the vertical angle. Symmetric distributions will 
show as a perfect circle. In asymmetric distributions, the curve will depict the shape of the light 
distribution when viewed from above and sliced through the vertical angle containing the 
maximum candela. 

  

  

 

 

 

 

 

 

Type B photometric reports (used with many floodlighting luminaires) are displayed in a 
Cartesian format graph, as shown at right.  

The red curve represents a vertical slice through the center of the light distribution from 
below the luminaire (left side) to above the luminaire (right side) when the luminaire is 
aimed at the horizon.  

The Blue curve represents a horizontal slice through the center of the light distribution from 
left to right. Visualize the Red curve as being the vertical beam spread and the blue curve 
as the horizontal beam spread. 

  

  

The More Button 

The candela graph can be modified to suit individual needs by clicking on the More button. This button opens a dialog containing a larger version of 
the graph with labels and the ability to change or add to the curves that are displayed. Changes made at this level will be applied to the smaller graph 
in the Define Luminaire dialog. 
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In addition to the candela distribution, the dialog displays the photometric file description, distribution classification, and photographic image from the 
Define Luminaire dialog. 

Note - when the LCS Graph is displayed (Define Luminaire, Instabase, Query Instabase dialogs) the More button will link to the Luminaire 
Classification System (LCS) tab. However, you can switch between the Candela and LCS tabs to see both types of information. 

Type C Display 

The candela curves and LCS Graph displayed in the Type C display can be modified or additional curves added easily by selecting the appropriate 
checkbox and entering the value of the angle of interest. 

Polar Curve Display - Vertical plane through Horizontal Angle 

This curve is blue by default and is plotted through the 
horizontal angle containing the maximum candela value. In 
the example shown at right, we have deselected the 
Horizontal Cone; (lower selection boxes) and selected 
several other vertical slices to plot. The graph now shows the 
light distribution at three horizontal angles and can be 
visualized as vertical slices through the light distribution, 
viewed perpendicularly. 

  

  

  

  

 

Polar Curve Display - Horizontal Cone through Vertical Angle 

The curve describing the Horizontal Cone is red by default. The cone is automatically plotted through the maximum candela value. In our example 
below, this occurs at 135 degrees above nadir. To visualize the graph of the horizontal cone, imagine a line drawn between the luminaire and 
maximum candela point at 135 degrees above nadir. Now rotate that line in a full circle (360 degrees) about the luminaire while maintaining the 135-
degree vertical inclination. Viewing that conical section from above will give the shape shown by the red curve. 

 

LCS Display Options 

The LCS Graph tab displays a shaded graphical representation of the Luminaire Classification System zonal luminaire lumens, % lamp lumens or % 
luminaire lumens. By default, the graph displays % lamp lumens and is scaled to the maximum LCS percentage for the specific luminaire. Each ring 
in the polar graph represents a 25% increment of the maximum. 

The graphical plot represents a section view looking at the luminaire in elevation. The lower-right quadrant of the graph represents the Front - 
Downlight components (Street Side), the lower-left quadrant of the graph represents the Back- Downlight components (House Side), and the upper 
hemispherical section represents the uplight component. The shaded "pie wedge" inside each zonal section represents the percent of zonal lumens 
that exist in that specific zone.  
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The Display Colors and Display Type may be customized by the user. 

Front - This section specifies the shading colors to be applied to the 
Front Downlight zones: Low, Medium, High and Very High. By default, 
green hues are specified. 

Back - This section specifies the shading colors to be applied to the 
Back Downlight zones: Low, Medium, High and Very High. By default, 
blue hues are specified. 

Uplight (includes front and back uplight) - This section specifies the 
shading colors to be applied to the Uplight zones: Low and High. By 
default, red hues are specified. 

Display Type - This section determines whether to generate the graph 
based on % Lamp Lumens, % Luminaire Lumens or Luminaire Lumens. 
By default,% Lamp Lumens are applied. If % Luminaire Lumens or 
Luminaire Lumens are shown, the graph will look the same and only the 
percentages or totals will change. Note: If user-defined lumens are 
selected as the Scaling basis, the only Display Type allowed is 
Luminaire Lumens. 

You may apply the selected settings to all LCS Graphs by clicking on the Ok button. To retain the previous settings, click on the Cancel button. 

Type B display 

The candela display for Type B photometric reports plots the axial candela values from -90 degrees to +90 degrees vertically and from -90 degrees 
to +90 degrees horizontally in a Cartesian format by default. The display can be switched to a polar representation if desired, although there is no 
provision to show curves other than the axial plots. 

Print button 

The print button within the photometric curve display will print a pre-formatted output page with the candela curves you have selected. Included in the 
output are: the photographic image associated with the selected luminaire; the manufacturer's logo (if available); an echo of the description section 
from the IES file; the classification as computed by AGi32 and a description of the candela information plotted. 

Related Topics 

Type B Photometrics 

Type C Photometrics 

Photometric File Type B 
This dialog provides more information about the selected Type B photometric file shown in AGi32's Instabase or Luminaire Definition dialog.  

The luminaire description, luminaire metrics (Classifications tab) and graphic image (if any) are shown at the top of the dialog. When this dialog is 
accessed from the Photometric Instabase or Query Instabase dialog, the graphic file associated with the selected Manufacturer node is loaded and 
will be included as part of the output, if printed. When the dialog is accessed from the Luminaire Definition dialog, this graphic file is not loaded and 
will not be included in the output if you elect to print the photometric file. 

You may print the selected candela curves in a preformatted fashion by clicking on the Print button. The information is sent automatically to your 
default system printer using the default page settings. You may change the default printer and/or media size by clicking on the Print Setup button. 

1. Select whether to display the vertical and horizontal axial candela curves. You may change the default colors if desired, by clicking in the 
appropriate color cell. 

2. By default, the calculated candela curves are displayed using a Polar graph. To display them using a Cartesian graph, click on the Cartesian 
radio button. 

3. You may apply the selected settings to all Type B photometric files by clicking on the Ok button. To retain the previous settings, click on the 
Cancel button. Click on the Reset Defaults button to reset all settings to factory defaults. 

Show me more information about Type C Photometry 

Calculated Metrics 

The General section contains two small tabs with the following metrics: Description and Classification. 

The Description tab reiterates the descriptive Keyword information contained in the selected photometric file. Use the scrollbars to see the entire IES 
description if it extends beyond the window extents. 
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The Classification tab display various metrics calculated in AGi32.  

• Type "B" reports, generally used to describe floodlights, will generate Flood classifications and LER. They will not generate LCS metrics. 

Classification metrics 

•••• Indoor classifications: 

• Luminaire Efficacy Rating (LER) - This classification is a measure of a luminaire's energy efficiency. LER is a measure of the 
luminaire's rated lumen output divided by its input power. 

•••• Flood classification: 

• Flood NEMA Type - The IES NEMA type is determined by the location of the 10% maximum candela value in the axial angles of the 
Type B photometric web. For example: If 10% of the maximum candela value falls between 46 and 70 degrees the designation is 
NEMA type 4 in that direction (horizontal or vertical).  

Photometric File Type B - Concepts 

Axial Candela Display 

 

When viewing Type B polar curves in AGi32, the axial candela through the Horizontal and Vertical Axes are shown. These are the only candela 
values shown for this photometry type. 

The polar diagram is divided into 4 rings, each representing a 25% increase in magnitude. At the center of the polar diagram, the candela intensity 
equals 0. At the outer ring, the candela intensity equals the maximum candela value. The inner ring represents 25% of the maximum value, the 
second ring 50% of the maximum, and the third ring 75% of the maximum. 

Radiating along the diagram are angular increment lines - each representing a 10 degree angle increment. By following the angular increments to the 
horizontal cone or vertical slice, it is easy to approximate the candela value for any location on the polar plot. 

Horizontal Axis 

The Horizontal axis displays the luminous distribution from the left side of the beam (-90)  through the beam center (at 0) to the right side of the beam 
(90). Although most beams are symmetrical in the Horizontal axis, they are not required to be.  

Vertical Axis 

The Vertical axis displays the luminous distribution from the bottom  of the beam (-90)  through the beam center (at 0) to the top of the beam (90). 
The maximum candela often occurs at the vertical beam center, but it may also occur above or below this point, or even off center depending on the 
floodlight's distribution. 

Cartesian Diagrams 

Type B Photometry may also be plotted on a Cartesian axis instead of a polar diagram. Cartesian diagrams display the same type of information as a 
Polar diagram. 



AGi32 Help System  Adding Entities 

225 

 

 

The Cartesian graph is divided into grids along the X and Y axis. The X axis is hatched by vertical grid lines, each representing 30 degree 
increments. The vertical line at the center of the Cartesian axis represents the 0 degree plane The Y axis is hatched by horizontal grid lines, each 
representing a 25% increase in magnitude of candlepower. The topmost horizontal line represents the maximum candela value (or maximum scaling 
value). Both horizontal and vertical distributions may be read in the Cartesian graph by plotting their locations relative to the nearest grid line.  

NEMA Beam Spread 

The IES or NEMA typing is determined by the location of the 10% maximum candela value in the axial angles of the Type B photometric web. For 
example: If 10% of the maximum candela value falls between 46 and 70 degrees the designation is NEMA type 4 in that direction (horizontal or 
vertical).  

NEMA Type Field Angle degree range 

0* < 10 

1 10 to 18 

2 18 to 29 

3 29 to 46 

4 46 to 70 

5 70 to 100 

6 100 to 130 

7 130 and up 

* NEMA Type 0 is actually considered a spotlight instead of a floodlight. 

Show me more information about Type C Photometry 
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Photometric File Type C - Concepts 

Candela Graph 

 

Type C Photometry is used to indicate the light distribution for architectural lighting products (interior and area lighting luminaires). Type B 
Photometry is used for floodlight distributions. 

When viewing Type C polar curves in AGi32, the horizontal cone and vertical slice through the maximum candela point is shown by default. In 
general, this is analogous to viewing the photometric web in Plan and Section view at the most luminous location. 

Plan View 

Begin by looking at the horizontal cone (the Plan View). This shape indicates the horizontal directionality of the luminaire with respect to its testing 
position and any symmetry it exhibits. 
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• Symmetric Distribution - A symmetric distribution will appear as a circular cone at the outmost edge of the polar plot. 

• Quadrilateral Symmetry - A quadrilaterally symmetrical distribution will present a horizontal cone that is symmetrical in each of the 4 quadrants 
of the polar plot. The horizontal cone may be square, elliptical or irregular, however, each quadrant is exactly the same as the other 3. 

• Bilateral Symmetry - A bilaterally symmetric distribution presents a horizontal cone that is symmetric about the 0-180 horizontal plane. These 
photometric distributions generally present a more directional thrown towards the Street Side (forward throw). Another case of bilateral 
symmetry occurs when the luminaire is tested such that it is symmetrical about the 90-270 photometric plane. 

• Asymmetric Distribution - An asymmetric distribution presents a horizontal cone that contains no symmetry or one that is symmetrical in a 
manner not described by the symmetrical distributions described previously. 

• House Side / Street Side - Horizontal values between 270° and 90° are in front of the luminaire and are referenced as "Street Side". Horizontal 
values between 90° and 270° are behind the luminaire and are referenced as "House Side" (this assumes counterclockwise rotation). 

Section View 

The Vertical plane is also taken through the maximum candela angle. When viewing the Vertical plane, you are looking at a section of the 
photometric web from the side, perpendicular to the maximum candela angle. 

The vertical plane provides us with the luminaire's vertical distribution type and cutoff characteristics.  

• The horizontal line separating the upper and lower portions of the polar plot represents Horizon. When the vertical plane is shown 
below the Horizon, the distribution produces light in the downward direction. When the vertical plane is shown above the Horizon, the 
distribution produces light in the upward direction. When the vertical plane is shown above and below Horizon, the luminaire produces 
both uplight and downlight (not necessarily equally). 

• The horizontal symmetry discussed in Plan View will also be apparent in Section View. 

• Cutoff characteristics - Cutoff classifications are based on the proportion of the maximum candela value present at 80° and above. 

• The vertical angle that produces the maximum candela is displayed in Section view. This information describes how wide or narrow the 
luminaire distribution is. 

 

Narrow Distribution (Vertical Plane) 

 

Wide Distribution (Vertical Plane) 
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Show me more information about Type B Photometry 

LCS Graph 

The IESNA Luminaire Classification System (LCS) defines the distribution of light into 10 solid angles. The LCS metrics are an indicator of optical 
distribution and are intended to be used in conjunction with the IES and Longitudinal Classifications to provide a thorough analysis of the light 
distribution. While the application of the LCS metrics are to be addressed in individual IESNA Recommended practices, the intended use is to 
provide data that allows evaluation of light trespass and sky glow. 

The LCS metrics within each zone are reported in lumen totals as well as percent lamp lumens and percent luminaire lumens. 

Additional Information can be found in the IESNA Document TM-15-07. 

Note: TM-15-07 specifies LCS criteria as the ratio of % Lamp Lumens. It is anticipated that the next release of TM-15 will change the criterion to 
Lumen values (not percentage). In anticipation of this change, AGi32 will display LCS in terms of lumens, % lamp and % luminaire (in case this 
metric is specified in the future). 

Photometric File Type C 

This dialog provides more information about the selected Type C photometric file shown in AGi32's Instabase or Luminaire Definition dialog. The 
luminaire description, luminaire metrics (Classifications, LCS) and graphic image (if any) are shown at the top of the dialog. When this dialog is 
accessed from the Photometric Instabase or Query Instabase dialog, the graphic file associated with the selected Manufacturer node is loaded and 
will be included as part of the output, if printed. When the dialog is accessed from the Luminaire Definition dialog, this graphic file is not loaded and 
will not be included in the output if you elect to print the photometric file. 

For a Type C photometric file, two tabs are shown in the body of the dialog: a Candela tab containing the Candela graph and settings and a LCS tab 
with the LCS Graph and settings. You may tab between the two to extrapolate the necessary information. 

You may print the selected candela curves and LCS Graph in a preformatted fashion by clicking on the Print button. The information is sent 
automatically to your default system printer using the default page settings. You may change the default printer and/or media size by clicking on the 
Print Setup button. 

Show me more information about Type B Photometry 

Candela tab 

1. Select which vertical planes and horizontal cones will be displayed in the polar graph. By default, a vertical plane and horizontal cone are taken 
through the maximum candela angle. Up to 3 additional vertical planes and horizontal cones may be defined. Each plane and cone can be 
assigned a different color by clicking in the appropriate color cell. 

2. For vertical planes, select the desired horizontal angles to slice through. The program automatically calculates the complete plane (on either 
side of nadir and/or zenith). 

• For example, when the 0-degree horizontal plane is selected, polar graph will display all of the vertical angles through the 0-180 horizontal 
plane. When the 45-degree horizontal plane is selected, polar graph will display all of the vertical angles through the 45-225 horizontal plane. 

3. For horizontal cones, select the desired vertical angles to circumscribe. The program automatically displays the complete cone (through 360 
degrees). 

4. You may apply the selected settings to all Type C photometric files by clicking on the Ok button. To retain the previous settings, click on the 
Cancel button. Click on the Reset Defaults button to reset all settings to factory defaults. 

LCS tab 

What is LCS? 

The IESNA Luminaire Classification System (LCS) defines the distribution of light into 10 solid angles. The LCS metrics are an indicator of optical 
distribution and are intended to be used in conjunction with the IES and Longitudinal Classifications to provide a thorough analysis of the light 
distribution. While the application of the LCS metrics are to be addressed in individual IESNA Recommended practices, the intended use is to 
provide data that allows evaluation of light trespass and sky glow. 

The LCS metrics within each zone are reported in lumen totals as well as percent lamp lumens and percent luminaire lumens. 

Display Options 

The LCS Graph tab displays a shaded graphical representation of the Luminaire Classification System zonal luminaire lumens, % lamp lumens or % 
luminaire lumens. By default, the graph displays % lamp lumens and is scaled to the maximum LCS percentage for the specific luminaire. Each ring 
in the polar graph represents a 25% increment of the maximum. 
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The graphical plot represents a section view looking at the luminaire in elevation. The lower right quadrant of the graph represents the Front - 
Downlight components (Street Side); the lower left quadrant of the graph represents the Back- Downlight components (House Side) and the upper 
hemispherical section represents the uplight component. The shaded "pie wedge" inside each zonal section represents the percent of zonal lumens 
that exists in that specific zone.  

1. The Display Colors and Display Type may be customized by the user. 
2. Front - This section specifies the shading colors to be applied to the Front Downlight zones: Low, Medium, High and Very High. By default, 

green hues are specified. 
3. Back- This section specifies the shading colors to be applied to the Back Downlight zones: Low, Medium, High and Very High. By default, blue 

hues are specified. 
4. Uplight (Front + Back) - This section specifies the shading colors to be applied to the Front and Back Uplight zones: Low and High. By default, 

red hues are specified. 
5. Display Type - This section determines whether to generate the graph based on % Lamp Lumens, % Luminaire Lumens or Luminaire Lumens. 

By default,% Lamp Lumens are applied. If % Luminaire Lumens or Luminaire Lumens are shown, the graph will look the same, only the 
percentages or totals will change. Note: If user defined lumens are selected as the Scaling basis, the only Display Type allowed is Luminaire 
Lumens as well. 

6. You may apply the selected settings to all LCS Graphs by clicking on the Ok button. To retain the previous settings, click on the Cancel button. 

Calculated Metrics 

The General section contains three small tabs with the following metrics: Description, Classification and LCS.  

The Description tab reiterates the descriptive Keyword information contained in the selected photometric file. Use the scrollbars to see the entire IES 
description if it extends beyond the window extents. 

The Classification and LCS tabs display various metrics calculated in AGi32. 

• Type "C" reports (commonly mislabeled Type "A") will generate Indoor and Roadway/LCS Classification information. 

• Indirect photometric files will not display Roadway Classification information. 

Classification metrics: 

•••• Roadway Classifications: 

• IES Classification (Type I, II, III, IV, and V) - This classification describes the lateral light distribution with regards to the lighted area 
width in terms of the mounting height (MH) ratio. 

• Longitudinal Classification (Very Short, Short, Medium, Long and Very Long) - This classification describes the vertical light distribution 
along the roadway. The classification is calculated by determining the location of the maximum candela point in terms of the mounting 
height ratio.  

• Cutoff Classification (Full Cutoff, Cutoff, Semi-Cutoff and Non-Cutoff)  -The Cutoff classifications are based on the candela values 
measure at 80 degrees above nadir (vertical) and higher, in any horizontal angle. The luminaire cutoff classification has been 
deprecated by the IESNA in 2007; it is superceded by the Luminaire Classification System (LCS). 

•••• Indoor classifications: 

• CIE classification (Direct, Semi-Direct, General Diffuse, Semi Indirect and Indirect) 

• Luminaire Efficacy Rating (LER) - This classification is a measure of a luminaire's energy efficiency. LER is a measure of the 
luminaire's rated lumen output divided by its input power. 

•••• LCS Metrics 

• LCS Zones: Front - Low, Medium, High, Very High; Back- Low, Medium, High, Very High; Uplight - Low, High 

• Lumens - The calculated zonal lumens within each LCS zone. Values are rounded for display purposes. 

• % Lamp - The ratio of total lamp lumens within each LCS zone. Values are rounded for display purposes. 

• % Lum - The ratio of luminaire lumens within each LCS zone. Values are rounded for display purposes. 
• Total - The sum of each column totaling  lumens, % Lamp and % Luminaire. The rounded values are used to sum the results. 

Locating Luminaires-Concepts 

Luminaires are located in the drawing to add their contribution to the lighting application. Their effect depends on the photometric distribution, aiming 
parameters applied and surrounding environment.  

In most cases, the insertion point specified in the Luminaire Definition locates the luminaire "head" in this command. The Mounting Height (MH) 
specified floats the luminaires at the desired Z coordinate. Virtually any aiming position is attainable with this command, using a combination of 
graphical and manual aiming parameters. 

All luminaires are located and switched on  in the current project. Luminaires may be located in other projects for management purposes (e.g. place 
them in a different project so that you can lock them for multiple switching routines). More information is available in Project Manager. 

Luminaires may be modified once initially located. Here are some of the options available: 

• Re-Aim or Reorient luminaires graphically to modify their aiming position. 

• Move, Array, Mirror or Copy luminaires to other locations. 
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• Predict the direct contribution for a luminaire with a Luminaire Template. 

• Edit Luminaires to change their location, aiming parameters, switching and/or luminaire type in a worksheet like fashion. You may operate on 
luminaires individually or in Bulk fashion. 

• Delete luminaires or switch them on or off. 

• Add a text label adjacent to each luminaire for identification purposes. 

• Group luminaires together to create cohesive unit that can be arrayed, copied, repositioned as one. 
• Create a Luminaire Aiming Diagram for pole locations (used in Sports Lighting applications). 

Locating Luminaires 

Luminaires are located based on the current selections shown on the Luminaire toolbar. These selections include luminaire type, mounting height 
and aiming parameters. 

The mounting height may be changed while the command is active by entering a new value in the Mounting Height text box 

(  -  located in the lower right corner of the desktop), changing the current Z coordinate with the up and down 
arrow keys or entering a new value in the MH text box on the Lum define toolbar. When locating and aiming luminaires in elevation view, you may 
wish to lock the current mounting height. 

When luminaire locations are undone, all luminaires located in a single session with one press of the Locate button are undone as a group. 

Once the luminaire type has been selected, select from your choice of aiming type: Static Aiming, Locate and Orient or Locate and Aim. Static 
Aiming locates the luminaire(s) with the 0 degree photometric plane oriented at 0 degrees (due East). Luminaires are located with a single click. 
Locate and Orient allows you to locate the luminaires with the first click and select the orientation angle with the second click. Additional three-
dimensional aiming can be employed by setting the Tilt, Roll and Spin angles. Locate and Aim is intended for luminaires aimed at a point. Set the Z 
coordinate of the aiming point with the AimZ control on the Luminaire toolbar. 

All aiming types are available for single luminaires. Luminaire groups or arrangements can be located with Static Aiming and Locate and Orient only. 

To locate luminaires on the drawing: 

1. Select a luminaire label from the Luminaire Type pull-down menu. 
2. Select an aiming type from the Aiming Type pull-down menu. 
3. Specify a mounting height with the arrow keys or by entering a value in the MH text box. 
4. Specify any additional aiming parameters that will be independent of the Aiming Type. 

5. From the Add menu choose Luminaire-Location, or from the Luminaire toolbar select . 

• The Locate function and Aiming Type parameter are combined in the Locate button. 

• Three options are available from the pull-down menu: Locate, Locate and Orient and Locate and Aim. The default function is Locate 
(Static Aiming). 

• The last used aiming type is automatically saved and used for subsequent sessions of AGi32. 

• If the last used aiming type was "Locate and Aim" and the current luminaire type does not allow aiming (e.g. luminaire groups and 
arrangements), the aiming type will revert to Locate. 

• Changing the aiming type invokes the Locate command (no need to click the button again). 
6. Locate the luminaire at the desired location and left click. Alternately, you may press Ctrl+A on the keyboard to invoke the current Aiming Type 

and parameters. 

• If Locate was specified, no additional location criterion is required. 

• If Locate and Orient was specified, move the cursor to the desired orientation angle and left click again. 

• If Locate and Aim was specified, move the cursor to the desired aiming angle and left click again. To change the Z coordinate of the 
aiming point, use the AimZ arrow keys or the up and down arrows on the keyboard before confirming the aiming angle. 

7. Another luminaire will be attached to the crosshairs. The distance and orientation angle from the previous luminaire will be displayed. Continue 
placing luminaires or right click (ENTER) to terminate. 

Note: Pressing the Ctrl and Shift keys together after selecting the luminaire location and before selecting an aiming point, allows you to select 
multiple aiming points with the same location (without having to respecify the insertion point). 

Aiming Parameters - Concepts 

AGi32 positions luminaire photometry with respect to the counterclockwise from East (CCE) system approved and published by the IES in document 
LM-72-97. All four aiming angles can be applied sequentially to any luminaire and are (in order): Orient, Tilt, Roll, Spin. 

The CCE system states that with all four angles equal to zero, the luminaire's zero-degree plane of photometry is pointing due East. All subsequently 
applied angles are positive when rotated in a counterclockwise direction following the right-hand rule. 
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The Procedures tab describes the Orient, Tilt, Roll and Spin aiming processes. It refers to Global and Local axes. The Global axes don't change; they 
are the axes that represent the luminaire's environment. The Local axes are affixed to the luminaire. When the luminaire is reoriented, its axes rotate 
with it.  

It cannot be over emphasized that when aiming luminaires, you must have knowledge of the luminaire distribution and how it is represented by the 
photometric file. Manufacturer and testing laboratory alike have exercised a fair amount of liberty when testing luminaires photometrically. Alignment 
of the luminaire on the testing apparatus can vary for similar luminaires when tested by different laboratories. This essentially changes the location of 
the zero-degree plane of photometry with respect to the luminaire. Needless to say, an incorrect assumption can render all computations performed 
by AGi32 inaccurate. 

Loading any file into our Photometric Toolbox program will allow you to examine the luminaire's distribution via its polar curve and offers the easiest 
way to visualize the light distribution. A knowledge of the LM-63-95 document (IES format for photometry) is also extremely valuable. 

Application of the aiming angles 

AGi32 allows the Orient and Tilt angles to be easily adjusted using the mouse when locating or modifying a luminaire. Using the Locate and Orient 
option from the Luminaire Define Toolbar will allow you to adjust the luminaire Orient angle by simply moving the mouse in the direction you would 
like to point the zero-degree plane of photometry. Using the Locate and Aim option, both the Orient and Tilt angles are adjusted when moving the 
mouse to an aiming-point location. 

Applying Roll and Spin to a luminaire can only be done by entering the angle value in the appropriate cell on the Luminaire Define Toolbar; it cannot 
be adjusted using the mouse. Orient and Tilt can, of course, be applied from the toolbar as well. However, the Static Aiming option should be 
employed when specifying Orient and Tilt on the toolbar. Using Locate and Orient or Locate and Aim will adjust the angle values. 

The four aiming angles are always applied in succession, beginning with Orient, followed by Tilt, then Roll, and finally Spin. Thus, when visualizing a 
combination of aiming angles, always apply them in order. 

Note that all luminaire positions are possible by applying a combination of three aiming angles. The ability to use four aiming angles is simply for 
ease of operation. Please note that it is also possible to manipulate luminaire position beyond what is possible with conventional mounting hardware! 

TIP: In AGi32, you can turn on the Photometric Web (in the Luminaire toolkit) to help with aiming! You will be able to see a three-dimensional 
representation of the luminaire's candela distribution, which can help tremendously when aiming a luminaire. 

Aiming Parameters-Procedures 

 

Orient - Orient is applied counterclockwise about the Z-axis. Looking 
toward -Z (downward), the +X axis tends toward +Y. This is a positive 
Orient angle. Orient=0 places +X due east. Orient is always the first 
aiming angle applied when multiple aiming angles are specified. Note 
that before any aiming is applied the Global and Local coordinate 
systems are aligned. 

Example: In Plan View (looking down on the luminaire), Orient=0 points 
the zero-degree horizontal plane of photometry due east. Orient=45 is 
45 degrees counterclockwise from there, which is northeast. Typically, 
for outdoor pole mounted luminaires the zero-degree horizontal plane of 
photometry points out the front of the luminaire. 

 

Tilt - Tilt is applied about the local Y-axis. Looking toward +Y, local -Z 
tends toward local +X. This is positive Tilt. Tilt=0 aligns photometric 
nadir and zenith with the Z-axis. Tilt is the second aiming angle applied 
when positioning a luminaire.  

Another way to picture this is to begin with the luminaire aimed straight 
down (Tilt=0). Now look in the direction of the front of the luminaire. A 
positive tilt will bring the aim of the luminaire up in that direction. If you 
are looking east (Orient=0), a positive tilt will bring photometric nadir up 
toward the east. 

Example: A Tilt angle of 90 degrees (and Orient=0) will point 
photometric nadir due east at the horizon. Likewise, with Orient=90 and 
Tilt=90 the luminaire's photometric nadir will point north at the horizon. 
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Roll - Roll is applied about the local X-axis. Local -Z tends toward local 
+Y. This is a positive Roll angle. The Roll angle is the third aiming angle 
applied in succession. 

Example: With Orient=0 and Tilt=0, a Roll angle of 90 degrees will point 
photometric nadir due north at the horizon by rolling the luminaire to its 
right. This effectively stands the luminaire on its side.  

 

Spin -Spin is applied about the local Z-axis. With a positive Spin, +X 
tends toward +Y. A positive Spin is then identical to Orient when no 
other angles are applied. However, once a Tilt or Roll has been applied, 
the Spin angle operates in the Local coordinate system, whereas the 
Orient angle continues to act Globally. 

Example: With Orient=0 and Tilt=45 (applied before Spin), a Spin angle 
of 45 degrees will then rotate the luminaire about the local Z-axis by 45 
degrees. This effectively "leans" the luminaire's photometric distribution 
45 degrees to its left. 

Spin is typically used to rotate the optics within a luminaire assembly. When a Spin angle is applied, the luminaire housing symbol will also rotate. 
For Spin angles of 90 or 270, you may need to change the symbol scaling factors such that the spun housing appears with the appropriate 
dimensions. For example, when spinning a luminaire with a Shoebox symbol (x=1.5', Y=1.0') 90 or 270 degrees, you will want to apply an X Scaling 
Factor of 0.66 and a Y Scaling Factor of 1.5, so that the dimensions become x=1.0' and Y=1.5'. 

Single luminaires and luminaire arrangements can use all four aiming parameters: Orient, Tilt, Roll and Spin. Orient is applied to the luminaire 
arrangement as a whole, and Tilt, Roll and Spin are applied to each luminaire occurrence independently. Luminaire groups may only be oriented. 

Labeling Luminaires - Concepts 

Luminaires may be labeled to identify them on drawings. You may specify many parameters about the luminaires such as, Label, Sequence Number, 
Location and Aiming Parameters.  

Luminaire positions are dynamic in the AGi32 job file. if you move or reposition a luminaire, its Luminaire Number does not change. Similarly, if you 
move a label from its relative luminaire position to a new position, when the luminaire is modified, the label maintains the same relative offset as it 
had previously. 

Luminaires placed with Locate and Orient or Static Aiming have aiming points that match their insertion points. Labeling their aiming points will result 
in duplicate labeling. 

Labeling Luminaires-Procedures 

Luminaire labels are used to identify luminaires. Labels can be assigned to luminaire insertion points and/or aiming points. AGi32 provides many 
labeling options including sequence number, label, coordinates and aiming parameters. When labeling luminaire locations or aiming points, every 
occurrence of the luminaire is labeled. 

Luminaire labels are dynamic. In other words, they update themselves during every redraw to reflect any changes in luminaire definition, locations, 
etc. Due to their unique structure, they cannot be edited. However, you can modify the type of labeling information shown (label, mounting heights, 
aiming parameters, etc.). 

In addition, luminaire labels are attached to the luminaire such that when a luminaire is moved, the label moves as well. This relationship prevents 
deleting a luminaire’s label without deleting the luminaire. The luminaire label text font uses the current Default System Font, located in Systems 
Setup. The luminaire label uses the luminaire’s Model Mode Symbol color. 

What do you want to do? 

Add Luminaire Labels 

Label luminaires to identify them  in your graphics area or output. 

1. From the Add menu chooseLuminaire-Labels-Specify Labelsor from the Luminaire toolbar select . 
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2. Click on the Labels On radio button. 
3. Select Label Insertion Point and/or Label Aiming Point. 
4. Specify the offset between the luminaire's insertion point (aiming point) and the top left portion of the luminaire label. 

• By default, the "Reset Offset for Existing Locations" checkbox is enabled when a new offset value is entered. When enabled, all 
luminaire labels will use the newly specified offset parameters, even luminaire labels that have been moved to a alternate location 
locally. 

• To retain current luminaire label locations, and only apply the offset to new luminaire instances, deselect the "Reset Offset for Existing 
Locations" checkbox. When this checkbox is deselected, all existing luminaires will retain their current offset parameters (whether the 
label has been moved separately or not) and the new offset will only be applied to new luminaire locations. 

5. Select the labeling options to be included with every luminaire. 
6. If sorting (resequencing) is desired, click the Sort button. 
7. Specify the Font and Font Style to use for the luminaire labels. 
8. Specify the text size in current display units (ft. or m) 
9. Click Ok. 

Change the Luminaire Labels 

AGi32 allows the user to modify their luminaire labels in many ways. The user can respecify the offset location, labeling information, sorting 
sequence and text size or simply turn them on and off. 

1. From the Modify menu choose Luminaire-Labels-Specify Labels, or from the Luminaire toolbar select . 
2. Select (or deselect) the labeling options according to the new label criteria. 
3. If sorting (resequencing) is desired, click the Sort button. 
4. Click Ok. 

Note: The Offset values will behave differently depending on whether the "Reset Offset for Existing Locations" checkbox is selected or not. By 
default, the "Reset Offset for Existing Locations" checkbox is enabled when a new offset value is entered. When enabled, all luminaire labels will use 
the newly specified offset parameters, even luminaire labels that have been moved to a alternate location locally. To retain current luminaire label 
locations, and only apply the offset to new luminaire instances, deselect the "Reset Offset for Existing Locations" checkbox. When this checkbox is 
deselected, all existing luminaires will retain their current offset parameters (whether the label has been moved separately or not) and the new offset 
will only be applied to new luminaire locations. 

Move Individual Luminaire Labels 

Luminaire labels may be moved from their default location to another location to improve the visual clarity of the presentation. In cases where 
luminaires are stacked in the Z direction, their labels are also stacked on top of each other. When the label is selected the entire label is moved from 
one location (Luminaire Label – Luminaire Number, Coordinates, Aiming Parameters, etc.) to another. Luminaire labels may be moved at any time, 
as they will retain their position even if the luminaire is modified. 

1. From the Modify menu select Luminaire-Labels-Move, or from the Luminaire toolbar select . Click on the arrow adjacent to the Labels 
button to see the secondary menu. Select Move. 

2. Select the label to move. 
3. Locate the point to move the label from and click the left mouse button. 
4. Drag the label to its new location and left click again. 

Delete Individual Luminaire Labels 

Luminaire labels may be deleted on an individual basis. 

1. From the Modify menu select Luminaire-Labels-Delete, or from the Luminaire toolbar select . Click on the arrow adjacent to the Labels 
button to see the secondary menu. Select Delete. 

2. Select the label to be deleted. 
3. Continue selecting labels in this manner, if desired. When complete, press ENTER (right mouse click) to confirm your selections and delete the 

labels. 

Related Topics 

Sorting Luminaires 

Adding Parametric Mirrors - Concepts 

The Parametric Mirror command establishes an imitative relationship between luminaires about a defined parametric mirror line. Any action taken on 
one side of the mirror will be duplicated automatically on the other side of the mirror. Once the parametric mirror has been applied, all subsequent 
luminaire placements will reproduce the original luminaire and aiming parameters on the other side of the parametric mirror line. 

Only two parametric mirrors may be active in the job file at any one time. 
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Note: Luminaires that have been located with Add-Luminaire-Array on one side of the parametric mirror will not be duplicated on the other side. 

Adding Parametric Mirrors-Procedures 

1. From the Add menu choose Luminaire-Parametric Mirror, or from the Luminaire toolbar select . 
2. Locate the first endpoint of the mirror line and click the left mouse button. 
3. Drag the cursor to the second endpoint of the mirror line and left click again. 
4. The parametric mirror will be drawn between the two endpoints with the words “Parametric Mirror” identifying the line 

LPD / UWLR Areas - Procedures 

This command calculates the Lighting Power Density and/or Upward Waste Light Ratio based on the luminaires within a user defined area. 

Lighting Power Density Areas (LPD Areas) calculate the lighting power density based on the number of luminaires within a user-defined polygon. 
Lighting power density is defined as watts per area, where area is dictated by the current display units (ft. or m) in AGi32. Example: If the current 
display units are feet, the LPD is defined as watts/ft

2
. The watts are extracted from the photometric file when the luminaire is defined. 

Upward Waste Light Ratio (UWLR) calculates the proportion of the luminous flux emitted by the luminaire above the horizontal. 

The LPD/UWLR Area dialog allows the user to specify the parameters for a new or existing LPD/UWLR Area. 

What do you want to do? 

Add an LPD/UWLR Area 

Edit an LPD/UWLR Area 

LPD/UWLR Areas - Concepts 

This command displays the Lighting Power Density and/or Upward Waste Light Ratio based on the luminaires within a user defined area. 

Lighting Power Density (LPD) 

Lighting Power Density is defined as watts per area where the area is dictated by the current display units in AGi32 (feet or meters). For example, if 
the current display unit is Feet, LPD is defined as watts/ft

2
. Initially, the watts are extracted from the photometric file when the luminaire definition is 

created. We recommend that you verify that the watts displayed in the Luminaire Definition are accurate, because the values in the photometric file 
may be nominal values, not accurate representations. The watts in the luminaire definition should be Luminaire Input Watts, not just Lamp wattage. 

Upward Waste Light Ratio (UWLR) 

Upward waste light ratio (UWLR)is defined as the proportion of the luminous flux emitted by the luminaire above the horizontal, in the installed 
position. The metric was developed by the Joint Standards Australia/Standards New Zealand Committee LG/2, Road Lighting, and is published in 
documents AS/NZS 1158.0:1997 and 1158.1:1997,Road Lighting, and 1158.2:1997, Lighting for Roads and Public Spaces (Part 2: Computer 
Procedures). 

UWLR =FA / FB  

where  

ΦA= the flux emitted by the luminaire above the horizontal 

ΦΒ= the total flux emitted by the luminaire 

UWLR considers the total lumen and total upward lumen output for each luminaire. In order to calculate these values, the program creates a 
temporary internal photometric file for each luminaire label, tilt, roll and spin combination. This can be very calculation intensive if the application 
contains several luminaires at varying aiming angles. 

Suggested Maximum UWLR Values 

The Institution of Lighting Engineers (ILE, United Kingdom) has produced a document titled "Guidance Notes For The Reduction Of Obtrusive Light" 
describing the maximum value of UWLR for varying environmental zones. 
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Environmental 
Zone 

Category ULWR (max %) 

E1 Intrinsically dark areas, e.g., “National Parks”, “Areas of Outstanding 
Natural Beauty” or other “dark landscapes” 

0 

E2 Low district brightness areas, e.g. Rural or small village locations 2.5 

E3 Medium district brightness areas, Small town centres or urban 
locations 

5 

E4 High district brightness areas, e.g., Town/city centres with high levels 
of night-time activity 

15 

Technical Details 

A Luminaire's Insertion Point must be within or on the LPD/UWLR polygon to be included in the LPD/UWLR Area. The Luminaire Symbol and/or 
Aiming Vector are not used to determine inclusion in the LPD/UWLR Area. 

LPD/UWLR Areas are dynamic entities that are updated automatically if the luminaires within or on the boundary change. This capability allows you 
to place LPD/UWLR Areas at any time, even before you add a luminaire to your job file. Light Power Density (LPD) and/or Upward Waste Light Ratio 
(UWLR) are dynamically updated (calculated) whenever the luminaire layout changes or whenever the job file is saved. Calculating UWLR may take 
several seconds to calculate in some situations. Therefore, it may be best to define LPD and/or UWLR Area(s) AFTER the luminaire layout is 
complete, if the luminaire quantity is large. 

The LPD/UWLR Area boundary may be created in either a clockwise or counterclockwise direction. You may undo line segments one at a time while 
you are creating the boundary by using the Undo button or pressing Ctrl+Z on your keyboard. Once the boundary is created, there is no Undo 
functionality for recreation. You must delete the LPD/UWLR Area and recreate it if you make a boundary specification error. 

Adding LPD/UWLR Areas-Procedures 

1. From the Add menu choose Calculations -LPD/UWLR Area, or from the Calculations toolbar select . 
2. Specify a unique label in the LPD/UWLR Area dialog  box, up to 32 characters long. 
3. An optional description may be entered if desired, up to 80 characters in length. 
4. The Summarize Project list indicates the project the LPD/UWLR Area will extract information from. The LPD/UWLR Area may be attached to 

one project (usually the current project) but summarize another project or all projects. For example, you may wish the LPD/UWLR Area to 
summarize a project containing only emergency luminaires although the LPD/UWLR Area is in another project. By default, LPD/UWLR Areas 
summarize all projects. 

5. In the Summary section, select the options you wish to quantify and display in association with this label in the Statistical Summary form. 
6. Select the information to be included as part of the LPD/UWLR Area label, adjacent to the LPD/UWLR Area in the job file. If no label is desired, 

clear all of the selection boxes. 
7. If desired, change the text font or text size. 
8. Creation Method: Choose whether to manually create boundary lines of LPD/UWLR Area or choose an existing line, room or object as the 

boundary line. 

• In Plan View, Z coordinate is always 0. 

• If a tilted line, object or room is selected, polygon will be projected down to and created at lowest Z coordinate elevation.  
9. Click Ok. Follow the steps below depending on the selected creation method: 

Specify a Polygon Manually Create Polygon from Drawing Entity, Room or Object  

i. Locate the first point of the polygon and click the left mouse 
button. 

ii. Move the cursor to the second vertex on the polygon and left 
click again. 

iii. Continue in this fashion until the polygon is complete. Right click 
to close the polygon shape. The LPD/UWLR Area will be created. 

i. Locate the pickbox on the drawing entity line, object or room 
boundary you wish to use and left click. 

ii. If a valid polygon is found (see Notes below), it will be displayed 
as a bold line, and the Polygon Search results dialog will appear: 

• Accept Polygon and Repeat - Select another polygon line as a 
template for another LPD/UWLR Area with the same properties. 
Use pickbox to select another closed polygon. 

• Accept Polygon - Create LPD/UWLR Area using selected entity 
as polygon boundary. 

• Reselect Entities - Choose this option if invalid polygon was 
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found or if incorrect line was chosen. Use pickbox to select 
another closed polygon. 

• Manually Specify Polygon - Select vertices manually to specify 
polygon boundary, right clicking once all vertices are specified. 
This option is necessary if no valid polygon is found. 

• Cancel - Do not create LPD/UWLR Area. 

Notes: 

• Drawing Entity line segments do not need to be joined, just need 
to be within tolerances (2 decimals of precision - .05) 

• Line segments do not need to make a closed polygon - AGi32 will 
automatically close boundary line 

• AGi32 filters related lines by color. 

Caveats: 

• Disconnected line segments or line segments disconnected by 
gap larger than tolerance level will not form valid polygon. 

• Polygons with intersecting lines will not form valid polygon. 

• Incomplete polygons are not valid, may close in an unacceptable 
manner. 

Luminaire Labels 

Luminaire labels are used to identify luminaires. Labels can be assigned to luminaire insertion points and/or aiming points. AGi32 provides many 
labeling options including sequence number, label, coordinates and aiming parameters. When labeling luminaire locations or aiming points, every 
occurrence of the luminaire is labeled. 

Luminaire labels are dynamic. In other words, they update themselves during every redraw to reflect any changes in luminaire definition, locations, 
etc. Due to their unique structure, they cannot be edited. However, you can modify the type of labeling information shown (label, mounting heights, 
aiming parameters, etc.). 

In addition, luminaire labels are attached to the luminaire such that when a luminaire is moved, the label moves as well. This relationship prevents 
deleting a luminaire’s label without deleting the luminaire. The luminaire label uses the luminaire’s Model Mode Symbol color. 

What do you want to do? 

Add Luminaire Labels 

Label luminaires to identify them  in your graphics area or output. 

1. From the Add menu chooseLuminaire-Labels-Specify Labelsor from the Luminaire toolbar select . 
2. Click on the Labels On radio button. 
3. Select Label Insertion Point and/or Label Aiming Point. 
4. Specify the offset between the luminaire's insertion point (aiming point) and the top left portion of the luminaire label. 
5. Select the labeling options to be included with every luminaire. 
6. If sorting (resequencing) is desired, click the Sort button. 
7. Specify the Font and Font Style to use for the labels. 
8. Specify the text size in current display units (ft. or m) 
9. Click Ok. 

Change the Luminaire Labels 

AGi32 allows the user to modify their luminaire labels in many ways. The user can respecify the offset location, labeling information, sorting 
sequence and text size or simply turn them on and off. 

1. From the Modify menu choose Luminaire-Labels-Specify Labels, or from the Luminaire toolbar select . 
2. Select (or deselect) the labeling options according to the new label criteria. 
3. If sorting (resequencing) is desired, click the Sort button. 
4. Click Ok. 

Move Individual Luminaire Labels 
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Luminaire labels may be moved from their default location to another location to improve the visual clarity of the presentation. In cases where 
luminaires are stacked in the Z direction, their labels are also stacked on top of each other. When the label is selected the entire label is moved from 
one location (Luminaire Label – Luminaire Number, Coordinates, Aiming Parameters, etc.) to another. 

1. From the Modify menu select Luminaire-Labels-Move, or from the Luminaire toolbar select . Click on the arrow adjacent to the Labels 
button to see the secondary menu. Select Move. 

2. Select the label to move. 
3. Locate the point to move the label from and click the left mouse button. 
4. Drag the label to its new location and left click again. 

Delete Individual Luminaire Labels 

Luminaire labels may be deleted on an individual basis. 

1. From the Modify menu select Luminaire-Labels-Delete, or from the Luminaire toolbar select . Click on the arrow adjacent to the Labels 
button to see the secondary menu. Select Delete. 

2. Select the label to be deleted. 
3. Continue selecting labels in this manner, if desired. When complete, press ENTER (right mouse click) to confirm your selections and delete the 

labels. 

Related Topics 

Sorting Luminaires 
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 Editing 

Canceling Commands 

The Edit-Cancel command allows you to cancel the current command while in progress. 

 From the Edit menu choose Cancel, or from the keyboard press Esc. 

   

Copying the Contents of a View Window 

The Edit-Copy command allows you to copy the contents of the current view as a bitmap to the Windows™ Clipboard for use in other applications. 

 From the Edit menu choose Copy, or from the keyboard press Ctrl+C. 

   

Undoing Commands 

The Undo command allows you to cancel the effects of the last command given while in the graphics display area. In other words, you can take back 
any action that creates or modifies AGi32 entities. Example: Undo will reverse the Modify-Luminaire-Re Aim command, but will not undo a View-
Elevation command. 

The command subject to the Undo action is shown following the Undo command in the Edit Menu. An unlimited number of Undos are available until 
the job file is saved. When the job file is saved, the available Undo actions are purged. 

 From the Edit menu choose Undo, or from the Common toolbar select , or press Ctrl-Z. 

If you are unsure of what action is going to be undone, open the Edit menu. The Undo action is appended to the Undo command. 

   

Redoing the Last Command 

The Redo command invalidates the last Undo command. Only one Redo is available. The Redo action is shown following the Redo command in the 
Edit Menu. 

Example: A luminaire is located and then "Undone", thereby eliminating the luminaire location. The Redo command would relocate the luminaire at 
its original position. 

 From the Edit menu choose Redo, or from the Common toolbar select . 

If you are unsure of what action is going to be redone, open the Edit menu. The Redo action is appended to the Redo command. 

  

Undo and Redo Concepts 

AGi32 allows unlimited levels of Undo selection back to the first command or most recent save Saving your job files results in compressed, purged 
databases, which clears the Undo and Redo tables. Switching between Design modes (Model,Page Builder and Render) also clears the Undo/Redo 
tables. 

Once a command has been completed, it can only be Undone in its entirety. However, within a Command that allows coordinate specification 
onscreen, you may undo the coordinate specifications as well. For example, if you are creating a polygonal  room and mistakenly specified a room 
vertex, you may undo that vertex. 

Note: Arcs are comprised of multiple straight line segments emulating the arc curvature. To undo an entire arc, you will need to undo each line 
segment in the arc.
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 Modifying Entities 

Modifying Projects 

Modifying Projects in Project Manager 

Projects and their associated entities have certain properties that may be modified in Project Manager. To modify a project or entity, select the item 
and edit the desired table cells. Multiple cells may be edited at once by selecting the entity rows and right clicking after selection. A pop up menu will 
appear with appropriate options. Project modifications will affect the entities within.  For example, if a project is switched off, all entities associated 
with that project will be switched off. 

The following modification choices are available for all projects and individual entities within: 

Off - Switching a project or individual entities off results in the project and/or associated entities being made invisible and no longer participating in 
the lighting calculations. In addition, the switched off project and/or associated entities will not be affected by other entities in enabled projects, such 
as luminaires in other projects. 

Lock - Locking a project or individual entities prevents the project and/or associated entities from being modified. Locked projects and/or associated 
entities can be switched on or off. 

The following modification options are only available in the Project table on a project wide basis: 

Load - Loading a project allows the user to make modifications to specific entities within the loaded projects. By default, only one project is loaded at 
a time. Multiple projects may be loaded for global modification by pressing the Alt keyboard key while clicking in the Load selection cells for the 
desired projects. 

Freeze - Freezing a project results in the project and associated entities within no longer participating in the lighting calculations. The project is still 
visible - all entities are shown in Model Mode using the Frozen Entity Color specified in System Settings - Defaults.  In addition, the frozen project 
and associated entities will not be affected by other entities in enabled projects, such as luminaires in other projects. 

1. From the Control Bar click on the Project Manager button . 
2. To make project level modifications, select the options desired within the Project table. To make modifications to multiple projects, select the 

rows representing the projects you wish to select, then right click. Select the desired option from the secondary menu. 
3. To make entity level modifications, load the projects to be modified in Project Manager. To select multiple projects, press the Alt key while 

selecting the Load selection boxes. 
4. Select the entity type to modify from the Entity Type pull-down menu. Only one entity type may be displayed at a time. 
5. Make the modification in the Entities table. To make modifications to multiple entities, select the rows representing the entities you wish to 

select, then right click. Select the desired option from the secondary menu. Continue in this fashion until all modifications have been applied. 
6. Click Ok. 

Project Management 

Why use multiple projects? 

Create multiple projects when there are several tasks in the job file that you do not want to interact. For example, you could have several 
independent rooms in a building that do not affect each other. Create each room, and its associated luminaires, objects and statistical areas, as a 
separate project. Lock the other projects (rooms) in the job file so you can apply lighting metrics just to the one project (room) you are interested in. 

Multiple Project Concepts 

1. Locate equivalent luminaire locations within individual projects. The ability to switch Off projects easily allows you to compare "equals" during 
design or bidding phases while maintaining all the data within one file for easy recollection. 

2. Sports Lighting - Create a project for each field in a multiple use sports complex. 
3. Sports Lighting - Separate horizontal and vertical calculation grids into multiple projects for optimization and analysis purposes. 
4. Roadway Lighting - Create a project for each section of roadway or for proposed vs. existing. 
5. Theatrical Lighting - Separate house and theatrical luminaires into multiple projects for analysis. 
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When multiple projects are specified, you can choose to associate a schedule with a particular project or all projects. If an entity is in the wrong 
project, it will not be listed in the intended schedule. You will need to transfer the entity to the correct project. 

You can import selected entities of one job file into another, placed in a separate project in AGi32. Users can work on different parts of same project 
and merge them together for the final presentation. 

You may also choose to break up luminaires into multiple projects, so that you can break up the Luminaire Location Summaries accordingly. If the 
projects remain unlocked and visible, the lighting calculations will not be affected. 

Creating additional projects 

1. Right click in the Project table and select New. 
2. You will be prompted for a new Project Name. Project names must be unique. 
3. Continue adding New projects in this fashion until all projects have been defined. 
4. Click Ok. 

To add entities to a new project, make the project current on your AGi32 desktop by selecting it from the Project pull-down menu. Projects must be 
On, Unfrozen and Unlocked to be able to be selected for entity addition. 

Freezing and Switching Off projects 

Projects can be frozen or switched off before or after calculation to prevent them from calculating and affecting/being affected by other projects. 
Frozen projects are displayed in Model Mode using the Frozen Entity Color (by default a neutral purple). Entities within frozen projects are not 
selectable or modifiable using any command in AGi32, including entity commands in Project Manager, until they are unfrozen. 

1. To freeze a project in AGi32, select the Freeze selection box. 
2. To make a project invisible and not calculate, select the Off selection box instead. 

Transferring entities between projects 

Entities may be transferred between projects at any time, as long as the projects are already created and Unlocked/Visible. This allows you to create 
all entities within one project, then separate them or move a mistakenly placed entity to the proper project. 

To transfer entities between projects, you have two options. Within Project manager, select the entities you wish to transfer (one entity type at a time) 
and select Transfer from the secondary menu, accessed by right clicking anywhere in the Entity table. Alternately, you may select multiple entity 
types at once through graphical selection with the Modify-Project-Transfer Entity command (available from the Project Manager pull-down menu on 
the Control Bar). 

Password Protecting Projects 

Projects may be password protected to prevent others from modifying the content of the project without entering the associated password. Projects 
must be locked before they can be password protected. 

Deleting projects 

Select the project to be deleted then click the Delete keyboard key. Alternately, you may select Delete from the secondary menu available by right 
clicking in the Project table. 

Project Table 

Secondary Menu Options Functionality 

Load Load entities for individual/group modification. 

Name Project Names are modifiable. Names must be unique 

Imported Indicates whether project was imported into current AGi32 file. 

Freeze This option allows you to remove entire project from calculations. Project is still visible but cannot 
be modified until it is Unfrozen. 

In Project Manager, a project that is Frozen is colored Gray in the Project list. 
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Off This option allows you to remove entire project from calculations and make it invisible. Project 
cannot be modified until it is switched on. 

In Project Manager, a project that is Off is colored Gray in the Project list. 

Lock Locking a project makes its internal entities not modifiable - entities are visible but cannot be 
edited, moved, deleted, etc, unless project is unlocked. 

In Project Manager, a layer that is Locked is colored Yellow in the Entity list. 

Color By (Entity, Project) By default, entities within a project are displayed with their individually specified line color. To 
colorize all entities using a single Project Color, choose Color By Project 

Color Specify Project Color to apply in conjunction with Color By Project column. By default, Project 
Color is Black. 

Summary The Summary column indicates the entity count within each project. Entities are abbreviated. The 
following abbreviations apply: 

L - Luminaires 

O - Objects 

R - Rooms 

C - Calculation Points 

SA - Statistical Areas 

LA - LPD/UWLR Areas 

S - Schedules 

D - Drawing Entities or Layers 

For example: 94-L indicates 94 luminaire locations. 

New This secondary menu option allows you to add a new project to the job file. 

Copy This secondary menu option allows you to copy all the entities within the current project to 
another defined project (defined project must be existing and unlocked, on and unfrozen). 

Protect / Unprotect This secondary menu option allows you to password protect locked projects to prevent 
unauthorized modifications. 

Delete This secondary menu option allows you to delete the current project and all entities within. 

Transfer This secondary menu option allows you to transfer all the entities within the current project to 
another defined project (defined project must be existing and unlocked, on and unfrozen). 

Select All This secondary menu option allows you to select all projects. 

Hint: You can also select all Projects at once by clicking in the upper left corner of the Project table. 

Managing imported CAD files 

When a DXF or DWG file is imported into AGi32, the layers selected are retained individually by default. You can use Project Manager and the 
Identify Entity tool in concert to clean up your DWG/DXF background in AGi32.  
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1. Use the Tools-Identify Entity command to identify on which layer the drawing entities reside. The third line in the Identify Entity dialog defines 
the layer information. 

2. In Project Manager, the DWG/DXF background is stored in its own project named<DXF or DWG name>--<Import date>--<Import Time>. Load 
the CAD project to be modified. 

3. To lock all or part of an imported CAD file, apply the lock option. This allows you to view the CAD background but protect it from modification (so 
it remains a static piece of information). This is very valuable when trying to align multiple CAD files to a fixed location (e.g. align an elevation 
view with a plan view). 

4. Select the layers you wish to make invisible, then select the Off selection box. Alternately, you may delete the layers with the Delete keyboard 
key or from the secondary menu. Selecting Off allows you to restore the layer at a future time, whereas Delete is a permanent option. 

5. To hide the entire background, click on the selection row in the upper left corner of the Entity table. Select Invisible or Delete from the secondary 
menu. For example, you may wish to strip the background to import an updated CAD drawing or to export only AGi32 layers. 

Entity Management 

When entities are modified in Project Manager only the current entities are affected. For example, when switching aiming vectors off, the aiming 
vectors for all the current luminaires are switched off. Any new luminaires added with the Locate Luminaire command and Locate and Aim will have 
visible aiming vectors. However, modifying the luminaires within the graphics environment (moving, copying) will result in the aiming vectors 
remaining off if the selected luminaire have this attribute assigned. 

Table options 

Within the Entity table, each modification option applies only to an individual entity. To make modifications to multiple entities at once, the secondary 
menu must be used (you cannot click in the selection box once multiple entities are selected, the selection will change to the current row). 

Multiple Select 

To select multiple entities, use standard Windows selection methods: 

1. To select adjacent entities select the first entity (by clicking in the left most column - the row marker). An arrow will appear within the row marker 
and the entire row will be highlighted. 

2. While depressing the Shift key on the keyboard, the select the last row to mark the end of the selection set. All rows in between will be 
highlighted as well. 

3. To select non-adjacent entities, select the first entity (by clicking in the left most column - the row marker). An arrow will appear within the row 
marker and the entire row will be highlighted. 

4. While depressing the Ctrl key on the keyboard, select each row marker to continue adding to the selection set.  
5. You may use these selection methods in combination with each other as required. 
6. To select all entities within the Entity table, click on the upper left cell in the corner of the Entity table. All rows will be selected. 

Secondary menu 

The secondary menu is revealed by right clicking in the Entity table. The options within will vary based on the current entity type. For most common 
options, the selections will be available directly in the secondary menu. These and less common options may also be available from the Bulk Edit 
option. 

Copy - The Copy option allows you to copy the selected entities to the current project or another project. Entities will exist in the same locations in 
both projects and may interfere with one another unless the entities or projects are switch off or frozen. Once copied over, the entities may be 
modified as required. 

Transfer -  The Transfer option allows you to move the selected entities to another project. Once transferred, the entities may be modified in any 
available manner. 

Only projects that are not locked, frozen of off will be available for selection. 

Entity Types 

Entity Available Options Functionality 

Drawing AGi32 created and 
Imported Projects 

Layer Names are not modifiable 

Layer-Off Turning a layer off makes its internal entities invisible. 

In Project Manager, a layer that is Off is colored Gray in the Entity list. 

Layer-Lock Locking a layer makes its internal entities not modifiable - entities are visible but cannot be edited, 
moved, deleted, etc, unless layer is unlocked. 
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In Project Manager, a layer that is Locked is colored Yellow in the Entity list. 

Layer-Color By 
(Entity, Layer) 

By default, entities are displayed with their individually specified line color. To colorize all entities using a 
single Layer Color, choose Color By Layer 

Layer Color Specify Layer Color to apply in conjunction with Color By Layer column. By default, Layer Color is Black. 

Schedule Schedule Name Schedules are shown individually. Schedule Names are not modifiable in Project Manager (modifiable 
by editing schedules). 

Off Turning a schedule off makes it invisible. 

In Project Manager, a schedule that is Off is colored Gray in the Entity list. 

Lock Locking a schedule makes it not modifiable - the schedule is visible and updates automatically if the 
data within changes but it cannot be edited, moved, deleted, etc, unless the schedule is unlocked. 

In Project Manager, a schedule that is Locked is colored Yellow in the Entity list. 

Line Vis This option indicates the visibility of the schedule gridlines. By default, gridlines are visible. 

Line Color This option allows you to change the grid line color. 

Font Color This option allows you to change the font color. All text fields will have this color applied, even fields 
previously assigned a field color. 

Reference Point This field indicates the insertion point of the schedule for location reference. 

Object Label Objects are shown individually. Object labels are modifiable in Project Manager (can also be modified by 
editing objects). 

Description This field displays the object description and is modifiable in Project Manager 

Off Turning an object off makes it invisible. 

In Project Manager, an object that is Off is colored Gray in the Entity list. 

Lock Locking an object makes it not modifiable - the object is visible and participates in the calculations but it 
cannot be edited, moved, deleted, etc, unless the object is unlocked. 

In Project Manager, an object that is Locked is colored Yellow in the Entity list. 

Color This option allows you to change the object wireframe color. 

Labeling This option allows you to add Object Labeling options (Object, Component and Component Surface).  

A Labeling Flag is shown if Labels are applied (3 digit number, each number indicates an option in the 
correlated Object Labeling tab). 

Reference Point This field indicates a point on the object for location reference. 

Bulk Edit This secondary menu option allows you to make global changes to a selection set of objects. 

Surface Edit This secondary menu option allows you to use the Surface Edit command incorporating the selection set 
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of objects. 

Room Label Rooms are shown individually. Room labels are modifiable in Project Manager (can also be modified by 
editing rooms). 

Description This field displays the room description and is modifiable in Project Manager. 

Off Turning a room off makes it invisible. 

In Project Manager, a room that is Off is colored Gray in the Entity list. 

Lock Locking a room makes it not modifiable - the room is visible and participates in the calculations but it 
cannot be edited, moved, deleted, etc, unless the room is unlocked. 

In Project Manager, a room that is Locked is colored Yellow in the Entity list. 

Color This option allows you to change the room wireframe color. 

Labeling This option allows you to add Room Labeling options (Room and Room Surface).  

A Labeling Flag is shown if Labels are applied (3 digit number, each number indicates an option in the 
correlated Room Labeling tab). 

Reference Point This field indicates a point on the room for location reference. 

Bulk Edit This secondary menu option allows you to make global changes to a selection set of rooms. 

Surface Edit This secondary menu option allows you to use the Surface Edit command incorporating the selection set 
of rooms. 

CalcPts* Label Calculation Point entities are shown individually. Calc point entity labels are modifiable in Project 
Manager (can also be modified by editing calculation points). 

Obs This field indicates if there is a IES or CIE observer (only valid for Glare calculation grids) 

Description This field displays the calculation point description and is modifiable in Project Manager. 

Off Turning a calc point entity off makes it invisible and not calculate. 

In Project Manager, a calc point entity that is Off is colored Gray in the Entity list. 

Lock Locking a calc point entity makes it not modifiable - the calc point entity is visible and participates in the 
calculations but it cannot be edited, moved, deleted, etc, unless the calc point entity is unlocked. 

In Project Manager, a calc point entity that is Locked is colored Yellow in the Entity list. 

Vis Turning a calc point entity invisible makes both the calculation points and Isoline lines invisible. The calc 
point entity will still calculate. 

In Project Manager, a calc point entity that is Invisible is colored Light Gray in the Entity list. 

PtsVis This option allows you to make the point by point values within the calc point entity Invisible (e.g. to only 
show Isolines). 

PtsView By default, point by point values and Isolines (if visible) are displayed in all views. This option allows you 
to allocate the point by point values for one particular calculation entity to one specific view. Note: 
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multiple views are only available if defined in View Manager and the views are visible. 

If a calculation is assigned to a view that is later made invisible (e.g. no longer selected in View 
Manager) visible, the calculation will not be visible. 

IsoVis This option allows you to make the Isolines within the calc point entity Invisible (e.g. to only show point 
by point values). 

IsoView By default, point by point values and Isolines (if visible) are displayed in all views. This option allows you 
to allocate the Isoline values for one particular calculation entity to one specific view. Note: multiple 
views are only available if defined in View Manager and the views are visible. 

If Isolines are assigned to a view that is later made invisible (e.g. no longer selected in View Manager) 
visible, the Isolines will not be visible. 

LnVis This option allows you to control the visibility of the Grid Perimeter Lines (perimeter lines are Invisible by 
default). 

Sum This option allows you to control the inclusion of the calculation summary in the Statistics Window. By 
default, the summary for every calculation entity is included in the Statistics Window. 

Note: The Summary Visibility also pertains to the inclusion of the selected calculation point entities in 
their corresponding Schedules.  

Label This option allows you to add Calculation Points Labeling options (First Point, Each Point, Each Line 
and Observer Positions).  

A Labeling Flag is shown if Labels are applied (3 digit number, each number indicates an option in the 
correlated Calculation Points Labeling tab). 

Color This option allows you to change the point by point and perimeter gridlines color. 

Luminaire Lum No. The luminaire number is shown for reference purposes. To renumber all luminaires in the project, right 
click to display the secondary menu and select Renumber.  

Luminaire labels may be displayed in Model mode with the Specify Luminaire Labels command. 

Label Luminaires are shown individually. The luminaire label option allows you to replace the current luminaire 
"type" with an alternate from a selection of defined luminaires. 

Luminaire Labels are not modifiable in Project Manager (modifiable by relabeling luminaires in Define 
Luminaire command). 

Off This option allows you to change the calculation status of luminaires. When Off, luminaires are both 
invisible and do not participate in the lighting calculations. 

In Project Manager, a luminaire that is Off is colored Gray in the Entity list. 

Lock Locking a luminaire makes it not modifiable - the luminaire is visible and participates in the calculations 
but it cannot be edited, moved, deleted, etc, unless the luminaire is unlocked. 

In Project Manager, a luminaire that is Locked is colored Yellow in the Entity list. 

SwitchOff This option allows you to change the calculation status of luminaires but still keep them visible in Model 
Mode and Render mode (in Render mode, luminaire housing is visible but luminous area is black). 

Dimming This option allows you to dim the luminaire output as a decimal percentage between 0 and 1.00. By 
default, luminaires are not dimmed (Dimming value = 1.00). 

Dimming linearly prorates the lumen output of the selected luminaire. No spectral color difference is 
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applied in Render mode. 

AimVis This option allows you to control the visibility of Aiming Vectors for the selected luminaires. By default 
Aiming vectors are visible. 

Only luminaires located with Locate and Aim have aiming vectors visible. 

TempVis This option allows you to control the visibility of Templates for the selected luminaires. By default 
Templates are visible. 

Luminaire Templates must be defined to be displayed in Model Mode (i.e. both definition and visibility 
must be enabled to visualize templates in Model Mode). 

WebVis This option allows you to control the visibility of Photometric Webs for the selected luminaires. By default 
Photometric Webs are invisible. 

Photometric Webs use the current Photometric Web Specifications when made visible. 

LabelVis This option allows you to control the visibility of luminaire labels. By default labels are visible. 

Luminaire Labels must be specified (e.g. ON and attributes defined) to be displayed in Model Mode (i.e. 
both specification and visibility must be enabled to visualize labels in Model Mode). 

Insertion Point This field indicates the insertion point of the luminaire for location reference. 

Renumber This secondary menu option allows you to renumber all the luminaires in the project and select the 
starting number. 

Numbers have to be numeric (no letters) and have positive value. 

LPD/UWLR 
Area 

Label LPD/UWLR Areas are shown individually. LPD/UWLR Areas labels are modifiable in Project Manager 
(can also be modified by editing LPD/UWLR Areas). 

Off Turning an LPD/UWLR Area off makes it invisible and not calculate. 

In Project Manager, an LPD/UWLR Area that is Off is colored Gray in the Entity list. 

Lock Locking an LPD/UWLR Area makes it not modifiable - the LPD/UWLR Area is visible and participates in 
the calculations but it cannot be edited, moved, deleted, etc, unless the LPD/UWLR Area is unlocked. 

In Project Manager, an LPD/UWLR Area that is Locked is colored Yellow in the Entity list. 

LineVis This option allows you to control the visibility of the LPD/UWLR Area Perimeter Lines (perimeter lines 
are visible by default). 

SumStatus This option allows you to control the inclusion of the LPD/UWLR Area summary in the Statistics 
Window. By default, the summary for every LPD/UWLR Area is included in the Statistics Window. 

Note: The Summary Visibility also pertains to the inclusion of the selected calculation point entities in 
their corresponding Schedules.  

Color This option allows you to change the LPD/UWLR Area perimeter lines and text label color. 

Reference Point This field indicates the first specified point of the LPD/UWLR Area for location reference. 

Statistical Area Label Statistical Areas are shown individually. Statistical Areas labels are modifiable in Project Manager (can 
also be modified by editing Statistical Areas). 
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Off Turning a Statistical Area off makes it invisible and not calculate. 

In Project Manager, a Statistical Area that is Off is colored Gray in the Entity list. 

Lock Locking a Statistical Area makes it not modifiable - the Statistical Area is visible and participates in the 
calculations but it cannot be edited, moved, deleted, etc, unless the Statistical Area is unlocked. 

In Project Manager, a Statistical  Area that is Locked is colored Yellow in the Entity list. 

LineVis This option allows you to control the visibility of the Statistical  Area Perimeter Lines (perimeter lines are 
visible by default). 

SumStatus This option allows you to control the inclusion of the Statistical Area summary in the Statistics Window. 
By default, the summary for every Statistical Area is included in the Statistics Window. 

Note: The Summary Visibility also pertains to the inclusion of the selected calculation point entities in 
their corresponding Schedules.  

Color  This option allows you to change the Statistical Area perimeter lines and text label color. 

Reference Point This field indicates the first specified point of the Statistical Area for location reference. 

* Note: Applying certain functions to one or more grids in a roadway calculation family affects all grids in the family. For example, if you select and 
delete the Luminance grid,all other grids in the same family (specified together in the same dialog) are also deleted, i.e., Illuminance, Veiling 
Luminance and Visibility (STV). This is done to prevent dependant grids from being disassociated. For example, Veiling Luminance requires 
Luminance, Target Luminance and Background Luminance in order to be calculated. This applies to the following functions in Project Manager: 

• Selecting from the grid itself: Delete (Del key), Calc Status (Off), and Loc Status. 

• Selecting from secondary menu: Copy, Delete, Transfer, Off, On, Lock, and Unlock. 

Importing AGi32 job files into other AGi32 job files 

You may create a conglomerate of individual job files in one master AGi32 file by using the Import command. Each job file is imported into its own 
project in the master job file. If the imported job file contains multiple projects, these will be combined into one project, as nested projects are not 
allowed in AGi32. 

Imported Project 

Import Option Description 

Project Name A unique project name must be entered. 

Locked A project may be imported in a Locked state if required. By default, 
projects are imported Unlocked. 

Color By Entity or Project By default, entities are displayed with their individually specified line 
color. To colorize all entities using a single Project Color, choose Color 
By Project. 

Offset An imported project may be offset from its original location to account 
for other entities in the master job file. For example, you may wish to 
import three job files of the same room with different lighting 
configurations. To prevent the rooms from overlaying on each other, 
use an Offset distance to separate them. The offset distance is 
specified using the current display units in the master job file (feet or 
meters). Specify the offset distance in the X, Y and Z directions. 

Entities to Import 

Drawing Drawing entities created in AGi32 are imported as well as any DXF 
import projects (combined into current project) 

Text Text created in AGi32 is imported 

Schedules Schedules are imported 

LPD/UWLR Areas LPD/UWLR Areas are imported 

Statistical Areas Statistical Areas are imported 

Calculation Points Calculation Points are imported 
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Rooms Rooms are imported 

Objects Objects are imported 

Luminaire Types and Locations Import luminaire types and locations 

Some tips: 

1. When importing job files with the same background, only import the background once. 
2. Create a title block file by saving a job file with a title block, text and schedules. 
3. Use meaningful project names. 

Apply 

The Apply option allows you to see project and entity level modifications in Model Mode. The Statistical Summary form is not updated when Apply is 
invoked. 

Project Map 

The Map button displays a project map for the current job file detailing the project and entity structure within Project Manager. The Project Map may 
be printed if desired. 

Modification Tracking 

Each modification type is tracked and displayed in the Modifications section. Property modifications do not require a recalculation. Entity 
modifications require recalculation. Modifications are applied to the AGi32 file instantaneously even if the visual modifications are not applied. For 
example, switching an entity off then on again will require recalculation, unless the Cancel button is applied. 

Column Sorting 

Both project and entity fields may be sorted in ascending order for any modification type. By default projects are sorted by project name, entities are 
sorted by entity label. 

Note: Clicking the "Cancel" button undoes any project additions or modifications. 

Project Manager-Bulk Edit 

The Bulk Edit dialog in Project Manager provides global modification options tailored to specific entity types. The modifications selected within will be 
applied to all selected entities within Project manager. 

Bulk edit options 

Entity Bulk Edit Options Functionality 

Drawing Not available   

Schedule Not available   

Object Label Object labels are not required to be unique. This option allows you to apply a consistent label to all 
selected objects. 

Description Object descriptions are not required to be unique. This option allows you to apply a consistent 
description to all selected objects. 

Calc Status Options - On or Off. Turning an object off makes it invisible. 

Lock Options - Locked or Unlocked. Locking an object makes it not modifiable - the object is visible and 
participates in the calculations but it cannot be edited, moved, deleted, etc, unless the object is 
unlocked. 

Wireframe Color Apply a consistent wireframe color to all selected objects. 
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Labeling This option allows you to add consistent  Object Labeling options (Object, Component and Component 
Surface) to all selected objects. 

A Labeling Flag is shown if Labels are applied (3 digit number, each number indicates an option in the 
correlated Object Labeling tab) 

Room Label Room labels are not required to be unique. This option allows you to apply a consistent label to all 
selected rooms. 

Description Room descriptions are not required to be unique. This option allows you to apply a consistent 
description to all selected rooms. 

Off Options - On or Off. Turning a room off makes it invisible. 

Lock Options - Locked or Unlocked. Locking a room makes it not modifiable - the room is visible and 
participates in the calculations but it cannot be edited, moved, deleted, etc, unless the room is unlocked. 

Color Apply a consistent wireframe color to all selected rooms. 

Labeling This option allows you to add consistent Room Labeling options (Room and Room Surface) to all 
selected rooms.  

A Labeling Flag is shown if Labels are applied (3 digit number, each number indicates an option in the 
correlated Room Labeling tab). 

CalcPts Not available   

Luminaire Label Replace the current luminaire "types" with an alternate from a selection of defined luminaires. 

Calc Status Options - On or Off. When Off, luminaires are both invisible and do not participate in the lighting 
calculations. 

Locked Status Options - Locked or Unlocked. Locking a luminaire makes it not modifiable - the luminaire is visible and 
participates in the calculations but it cannot be edited, moved, deleted, etc, unless the luminaire is 
unlocked. 

Switch Options - On or Off. This option allows you to change the calculation status of luminaires but still keep 
them visible in Model Mode and Render mode (in Render mode, luminaire housing is visible but 
luminous are is black). 

Dimming Factor This option allows you to dim the luminaire output as a decimal percentage between 0 and 1.00. 

Dimming linearly prorates the lumen output of the selected luminaire. No spectral color difference is 
applied in Render mode. 

Aiming Vector 
Visibility 

Options - On or Off. This option allows you to control the visibility of Aiming Vectors for the selected 
luminaires. By default Aiming vectors are visible. 

Only luminaires located with Locate and Aim have aiming vectors visible. 

Template Visibility Options - On or Off. This option allows you to control the visibility of Templates for the selected 
luminaires. By default Templates are visible. 

Luminaire Templates must be defined to be displayed in Model Mode (i.e. both definition and visibility 
must be enabled to visualize templates in Model Mode). 

Photometric Web Options - On or Off. This option allows you to control the visibility of Photometric Webs for the selected 



AGi32 Help System  Modifying Entities 

250 

 

Visibility luminaires. By default Photometric Webs are invisible. 

Photometric Webs use the current Photometric Web Specifications when made visible. 

Label Visibility Options - On or Off. This option allows you to control the visibility of luminaire labels. By default labels 
are visible. 

Luminaire Labels must be specified (e.g. ON and attributes defined) to be displayed in Model Mode (i.e. 
both specification and visibility must be enabled to visualize labels in Model Mode). 

LPD/UWLR Area Not available   

Statistical Area Not available   

Project Map 

The Project Map dialog is available from within Project Manager. It allows you to see the stratification and organization of entities within projects and 
projects within the job file. 

The project map may be printed for reference purposes. 

Transferring Entities between Projects 

To graphically transfer entities (room, object, luminaire, etc.) from one project to another, use the Transfer Entity command. Entities may be selected 
in Plan, Elevation or Isometric View in Model Mode to allow the user the most options for graphically selecting a desired selection set. For example, 
to select luminaires above objects, it may be easiest to create the selection set in a particular elevation view. 

1. From the Control Bar click on the pull-down arrow adjacent to the Project Manager button and choose Transfer Entity and the selection type - 
Single, Window or All. 

2. Select the entities to transfer by clicking on them with the left mouse button or windowing around them. If "All" is selected, the Project Transfer 
dialog will appear immediately. 

3. Select the project to transfer the selected entities to. 
4. Click Ok. 

Note: Entities may also be transferred by label within Project Manager. In Project Manager, select the entities you wish to transfer (one entity type at 
a time) and select Transfer from the secondary menu, accessed by right clicking anywhere in the Entity table. 

  

 Surface Edit 

Surface Edit - Concepts 

The Surface Edit command provides access to all surface properties in AGi32. Once surfaces have been created in AGi32, a 3D CAD model is 
imported, those existing surfaces may be modified with the Surface Edit command. 

Many selection options are provided. You may individually select entities with the Single (Any Type) option. You may globally select multiple entities 
with the Window (Any Type) method. Finally, you can filter for Room or Object entities by using the Window (Rooms Only or Objects Only) selection 
methods. 

All of the entities loaded into the Surface Edit dialog may be operated on globally, on an entity by entity basis, or on a surface by surface basis. The 
power of this command lies in its ability to make sweeping global changes or small surface by surface modifications, within the same command, as 
needed. 

Application Examples 

• Consider an exterior daylight analysis by computing a shadow study a for an exterior site. Before daylighting calculations can be applied to the 
surfaces, the surface types must be assigned the daylight Exterior attribute. You may select all of your surfaces at once using the Surface Edit-
Window (Any Type) selection method, then window around your entire site. Once all of the entities have been loaded into the dialog, Tag All 
Surfaces, then change the Daylight Exterior modifier to Yes. 

• Assign all Daylight Transition Glass (Transparent) values a different Transparency value globally. Select all of your Daylight Transition Glass 
(Transparent) surfaces at once using the Surface Edit-Window (Objects Only) selection method. Once all of the entities have been loaded into 
the dialog, use the Move to Next Surface or Next Component icons to move to one of your Daylight Transition Glass (Transparent) entities. 



AGi32 Help System  Modifying Entities 

251 

 

(Hint: Watch the Surface Type cell for confirmation). Use the Tag Surfaces with Same Surface Type as Current Surface option to select all of 
your Daylight Transition Glass (Transparent) surfaces, then change the Transparency value to the desired value. Don't forget to press ENTER 
to confirm your values. 

• Replace Daylight Transition Glass (Transparent) surface types with Daylight Transition Glass (Diffuse) surface types for diffused daylight 
designs (such as skylights). 

• Change the surface color of related entities globally, such as partitions, chairs, cars, etc. 

• Apply a texture to a surface, or multiple surfaces, easily. Modify the texture application size, in this dialog as well, if the initial texture application 
does not look right. Note: You'll need to preview texture application in Render mode. 

• Change the mesh level of a wall panel with surface mounted luminaires to reveal a smoother light distribution and better quality renderings. 

• Create photoluminous (self luminous) surfaces, such as Neon or glowing TV screens, by assigning a Luminance value, and color, to the 
appropriate surfaces. A Luminance Calculator can help you convert between common self emission values. 

• Flip surfaces and make surface Single Sided to make objects behave like rooms (especially imported objects), so that you can "see" inside the 
space without having to walk inside in Render mode. 

• Relabel surfaces and assign component labels to related surfaces for easier manipulation in the future. For example, you can assign the 
component label "frame" to multiple entities in a "chair" object, so that you can edit the "frame" component as one selection (e.g., change color, 
apply texture, etc.). 

Surface Edit 

The Surface Edit command allows you to modify surface attributes for any selection of Rooms and Objects. Users may quickly select individual 
surfaces or multiple surfaces collectively, for which they wish to change material properties such as color, texture, meshing, etc. 

1. From the Modify menu, choose Surface Edit, or from the Rooms/Objects Toolkit select . Click the arrow adjacent to the 
Surface Edit button to view the secondary menu with additional selection options. 

2. Many selection options are available to assist you in selecting only the entities that you wish to edit. You may choose from the following 
parameters:  

• Single Any Type – Select surface entities (Rooms or Objects) individually for surface modification. In the first step of the command, you 
may continue to select additional entities with the pick box until the right mouse button is clicked. 

• Window Any Type – Select multiple entities(Rooms of Objects) by positioning a selection box around the desired entities. The selection 
box selects all entities it crosses, even if they are only partially selected. Only one selection box may be specified during each 
command. 

• Window (Objects Only) - Select multiple Objects for surface modification by positioning a selection box around the desired objects. The 
selection box selects all Object entities it crosses, even if they are only partially selected. Rooms are not selected, even if they exist 
within the boundaries of the selection box. 

• Window (Rooms Only) - Select multiple Rooms for surface modification by positioning a selection box around the desired rooms. The 
selection box selects all room entities it crosses, even if they are only partially selected. Objects are not selected, even if they exist 
within the boundaries of the selection box. 

3. In the Surface Edit dialog, you may use the Display Options button below the image to change its appearance, such as showing it as outlines 
only or filled in, and changing the background color. You may use the interactive navigation buttons to view the object from different angles. 
(Additional information below) 

4. Use the navigate at the top-left in the dialog to change the highlight to the surface or group of surfaces you wish to edit. Tagging surfaces allows 
you to quickly select multiple surfaces based on inherent relationships in AGi32 entities. 

5. The Surface and Advanced Surface Properties sections provide access to all of the available options. More discussion of each attribute is 
discussed below. As each modification is applied, the Session History section, in the lower left corner of the dialog, provides continuous 
feedback on the changes made. 

6. Click Ok. The surfaces will be changed per your specifications. To see a preview of the changes in most cases, view the Shaded surfaces 
(available from the Display Properties dialog) in Render Mode. 

Navigation, Tag and View Control Icons 

Icon Command Keyboard 
Shortcut 

Comments 

 
Move to 
Previous 
Surface 

F9 Navigates to previous surface in selected room or object. 

 
Move to Next 
Surface 

F10 Navigates to next surface in selected room or object. 

 
Move to 
Previous 
Component 

F11 Navigates to the first surface in the previous component in the selected object. Objects only contain 
multiple components if they are composed of grouped objects (Library Objects) or multiple layers 
(imported 3D Objects). 

To navigate within the surfaces of a component, use the Move to Next/Previous Surface commands. 

 
Move to Next 
Component 

F12 Navigates to the first surface in the next component in the selected object. Objects only contain 
multiple components if they are composed of grouped objects (Library Objects) or multiple layers 
(imported 3D Objects). 

To navigate within the surfaces of a component, use the Move to Next/Previous Surface commands. 
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Tag Current 
Surface 

F8 Selects the current surface for surface modifications. Surfaces only need to be tagged if you want to 
make modifications to more than one surface. 

 
Tag Ceiling, 
Top or Roof 

Ctrl+
E 

Selects all surfaces that were created as ceilings (in Rooms) or tops (in Objects) for surface 
modifications. Surfaces only need to be tagged if you want to make modifications to more than one 
surface. 

 
Tag Walls or 
Sides 

Ctrl+
W 

Selects all surfaces that were created as walls (in Rooms), or sides (in Objects) for surface 
modifications. Surfaces only need to be tagged if you want to make modifications to more than one 
surface. 

 
Tag Floor or 
Bottom 

Ctrl+
F 

Selects all surfaces that were created as floors (in Rooms), or bottoms (in Objects) for surface 
modifications. Surfaces only need to be tagged if you want to make modifications to more than one 
surface. 

 
Tag Object 
Component 

Ctrl+
O 

Selects all surfaces in the current Object component for surface modifications. Surfaces only need to 
be tagged if you want to make modifications to more than one surface. 

 
Tag All 
Surfaces 

Ctrl+
A 

Selects all surfaces for surface modifications. Surfaces only need to be tagged if you want to make 
modifications to more than one surface. 

 
Tag Surfaces 
With Same 
Color/Reflectan
ce as Current 
Surface 

Ctrl+
S 

Selects all surfaces with the same Color and Reflectance attribute as the current selected surface. 
Surfaces only need to be tagged if you want to make modifications to more than one surface. 

 
Tag Surfaces 
With Same 
Surface Type 
as Current 
Surface 

Ctrl+
Y 

Selects all surfaces with the same Surface Type (e.g. Single Sided) as the current selected surface. 
Surfaces only need to be tagged if you want to make modifications to more than one surface. 

 
Remove All 
Tags 

Ctrl+
R 

Deselects all selected surfaces. Necessary when you wish to apply alternate surface modifications to 
different surfaces. Note: Surfaces remain tagged, even when additional surfaces are tagged, until 
Tags are individually or collectively removed. 

 
Front View   Displays a Front (South) Elevation View of Object or Room in graphic display. 

 
Back   Displays a Back (North) Elevation View of Object or Room in graphic display. 

 
Left   Displays a Left (West) Elevation View of Object or Room in graphic display. 

 
Right   Displays a Right (East) Elevation View of Object or Room in graphic display. 

 
Top   Displays a Top Plan View of Object or Room in graphic display. 

 
Bottom   Displays a Bottom Plan View of Object or Room in graphic display. 

 
Clip   Cuts away the front plane of the image continuously to reveal the objects within and beyond. The size of 

the image does not increase or decrease. This command is very useful when viewing an image with 
exterior and interior components (e.g., interior and site lighting). 

 
Dolly   Moves the observer and the focus point in and out of the model along a straight line. Depending on the 

view direction, from the observer’s point of view, this feature allows you to “walk” into and out of the 
space. 

 
Orbit   Moves the observer around the model while maintaining the same focus point. Imagine that you are a 

spaceship orbiting the earth, always looking at the center of the earth. 

 

Pan   Moves the observer and focus point relative to a fixed model position. Imagine that you are looking 
straight ahead and moving laterally left/right or up/down. The image will move opposite to the panning 
direction. 

 

Rotate   Allows the observer to look left or right and up or down from a fixed position. Use this command when 
you are in a space and want to look at different surfaces without changing your position. A panorama 
view is obtained by moving constantly to the left or right. 

 
Walk   Combines the Dolly, Pan and Rotate commands into one movement. Dragging the mouse up/down 

moves the observer forward and backward. Dragging the mouse left/right, rotates the observer view 
position left and right. Using the Shift and Ctrl keys in conjunction with dragging or the arrow keys 
invokes the Rotate and Pan commands as well. 

 
Zoom   Similar to the Zoom In and Zoom Out commands in AGi32’s Model Mode, with the difference being that 

the image size is continuously increased or decreased as the mouse is held down and dragged. 

  

Display Options 

Clicking on the Display Options button below the image opens a list of ways that the image appearance may be modified. For example, you may 
select to keep outlines visible and surfaces filled in, but not show text or drawing entities associated with this Object or Room. These selections apply 
to the image seen in the Surface Edit dialog only. By default, all options are selected, with the background color available for modification.  
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 Additional Dialog Options - In order of appearance in Surface Edit dialog 

Entity Selection 

The Entity pull-down menu contains a list of all selected entities. By default, All entities are selected and available for modification. Selection 
proceeds by navigating through each surface of each entity in alphabetical order as they are presented in the Entity list. Individual Entity selection is 
also available as an alternative. This is handy if you graphically selected multiple entities in close proximity, but are only interested in modifying a 
partial or singular Entity from the group. For example, if you selected both a room opening and planar object insert (e.g. a window) and wish to edit 
only the window, you could select the Object by name and edit it directly without having to navigate through the room surfaces first. 

Dialog Settings 

This dialog section controls the display options for surfaces. This section is hidden by default. 

Tag Surface Color - Indicates the line color of tagged surfaces. Default color is yellow, color may be changed by user. 

Current Surface Color - Indicates the line color of current selected surface. Default color is cyan, color may be changed by user. 

Removed Surface Color - Indicates the line color of removed surfaces. Default color is Black, color may be changed by user. 

Normal Vector Color - Indicates the line color of the Normal Vector. Default color is black, color may be changed by user. 

Normal Vector Length - Indicates the Normal Vector length in current units - feet or meters (e.g. 4 feet). The Normal Vector indicates the Normal 
side of the selected surface by default. Vector Length is automatically calculated from 15% of maximum entity extents in X or Y (whichever is 
largest), may be changed by user. 

Axis Color - Indicates the line color of Coordinate Axis. Default color is red, color may be changed by user. Coordinate Axis is displayed in centroid 
of selected entity. 

Axis Size - Indicates the Axis length in current units - feet or meters (e.g. 4 feet). Axis Length is automatically calculated from 15% of maximum 
entity extents in X or Y (whichever is largest), may be changed by user. 

General 

This dialog section indicates which entity and surface is currently selected. 

Entity Type - Indicates the type of Entity selected - Room or Object. Text box is only displayed for informational purposes, not changeable by user. 

Entity Label - Indicates the Label of the selected Entity - originally assigned by user when entity was created. Text box is only displayed for 
informational purposes, not changeable in this dialog by user. 

Component Label - Indicates the Label of the current component in the selected Entity - originally assigned by user when entity was created. 
Component Label only contains information if Objects are selected. 

Surfaces 

The following Surface properties can be applied to any of the surfaces of your objects (except for number which is assigned when the room or object 
is created). 

Number - Indicates the surface number of the currently selected surface. You may also scroll through the surfaces with the Up and Down arrows 
provided here or type in a number manually. 

Tag - Indicates if the surface is tagged or not. You may manually change the Tag associated with the current surface by changing the Tag text box 
from Off to On and vice versa. 

Label - Indicates the surface Label (Floor, Bottom, Walls, Sides, Ceiling or Top) of the selected surface. 

Removed- Indicates whether the surface is considered in the calculations. Surfaces may be removed to create complex spaces from composite 
models, by making a surface invisible. Removed surfaces may be added back to the environment by changing the removed parameter back to No. 

• Yes - Indicates the surface is removed (invisible). 

• No (default)  -  Indicates the surface participates in the calculations and all specified settings are considered. 

• Removed surfaces are also disregarded in Direct Only Method. 
• Removed surfaces retain all their original attributes in case surface consideration is desired in future iterations. 

Type 

The Surface Type menu provides many specific surfaces used for various calculation purposes in AGi32. Some surfaces types are available purely 
for optimization and visualization purposes in AGi32. For example, Single Sided surfaces are more efficient for swift calculations than Double Sided 
surfaces. They also allow the user to look within the space from the "back" side, without having to move within the space in render mode. Rooms are 
created from Single Sided surfaces (with the Normal facing into the room for each surface) primarily for these reasons. Other surface types are 
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available for specific calculation purposes, such as Daylighting or interreflected roadway calculations (e.g., Tunnel Lighting). A list of each surface 
type is provided below. 

Daylight - Surfaces imported in to or created within AGi32 must be assign appropriate surface types (and attributes) specifically for 
daylighting analysis. Exterior surfaces considered in daylighting computations are handled differently, and separately, from other surfaces. 
These surfaces must have the Daylight Exterior attribute (set to Yes) in the Daylight Exterior property cell. Surfaces associated with windows 
or openings (we call these Daylight Transition surfaces) that bring daylight into interior spaces must be assigned one of the Daylight 
Transition surface types (numbers 20, 21 & 22). (Note: 14-Glass is not appropriate for windows and skylights.) 

Roadway - Surfaces to be used in conjunction with the Roadway Calculation grids (luminance, veiling luminance, etc.) must be allocated as 
Roadway Pavement or Roadway Contributors. Roadway surfaces should be specified as Roadway Pavement Single Sided (Direct Flux 
Only). Surfaces that obstruct and/or reflect light onto pavement should be specified as Roadway Contributor Single Sided.  

Once the model is created, use the Surface Edit command to change the surface types for any relevant surfaces according to the following table: 

Surface Type Comments 

10- Single Sided Receives and reflects Direct and Indirect Daylight (through transition surfaces) and 
Electric Light. 

Surfaces are single sided - surface normal must face target direction. This is the default 
for Rooms - surface normals face inwards. 

Surface type is more efficient than Surface 11 (less surfaces to consider). 

11- Double Sided Receives and reflects Direct and Indirect Daylight (through transition surfaces) and 
Electric Light. 

Surfaces are double sided (default for Objects). 

14- Glass Surface transmits both direct and interreflected electric light and daylight through Glass 
surface by diffusing it (surface is a Lambertian emitter). This surface type appears 
transparent in Render Mode and Raytrace images. Note: Daylight must pass through a 
Daylight Transition surface before it can pass through Glass. 

 In Raytrace images, transmittance is based on incident angle (surface behaves as a 
Fresnel transmitter). 

Surface is double sided. More information on Glass Concepts 

20- Daylight Transition Glass (transparent) Daylight Transition surfaces are required to bring daylight into an interior environment 
(used to model fenestration and skylights). Allows transparency values between 0-100%: 
0 - Opaque, 100 - Clear). Surface may be assigned color tint. 

This surface type appears transparent in Render Mode and Raytrace images. 

Surface attenuates light based on Fresnel Transmittance and Reflectance methods. 
Predefined glazing Visible Transmittance (VT) values are available. 

21- Daylight Transition Glass (diffuse) Daylight Transition surfaces are required to bring daylight into an interior environment 
(used to model fenestration and skylights). Allows Transmittance values between 0-
100%: 0 - Opaque, 100 - Clear). Surface may be assigned color tint. 

Surface transmits daylight into interior in lambertian manner (perfectly diffuse). 

22- Daylight Transition Opening Daylight transition surfaces are required to bring daylight into an interior environment. 
Surface Type is perfectly clear (100% Transparency); all light entering environment is 
white. 

Surface Type does not reflect light. 

40- Roadway Pavement Single Sided (Direct 
Flux Only) 

Receives Direct Electric Lighting. This surface type receives only direct light from electric 
lighting sources; daylighting is disregarded. 

Surfaces are single sided - surface normal must face out. 

41- Roadway Contributor Single Sided Receives and reflects Direct and Indirect Electric Lighting. Daylighting is not considered. 

Surfaces are single sided - surface normal must face towards Roadway Pavement. 

  

Daylight Exterior - Indicates the surface receives direct and indirect daylight and is located on the exterior side of any Daylight  Transition surfaces -
- those directly visible to sun and sky. This option is only necessary when daylighting calculations are performed. For electric lighting only 
computations, it does not matter whether the application is exterior or interior, and this attribute is disregarded. 

• Yes - Indicates the surface functions as a daylight exterior surface 

• No (default)  -  Indicates the surface functions as an interior surface when daylighting calculations are performed. 

Color - Indicates the surface color of the selected surface - both a thumbnail and hexadecimal color value are displayed. To change the Surface 
Color, click in the Color text box, then click on the pull-down arrow icon (or press F4). Depending on the associated surface type, an appropriate 
Color specification dialog will appear. 



AGi32 Help System  Modifying Entities 

255 

 

Surface Type Associated Dialog 

Single or Double Sided Color/Reflectance selector 

Glass Color/Transparency Selector 

Daylight Transition Glass (Transparent) Color/Transparency Selector 

Daylight Transition Glass (Diffuse) Color/Reflectance selector 

Daylight Transition Opening Not Available 

Roadway Pavement Single Sided Not Available - Based on associated R-table selected in Roadway Luminance calculation grid dialog. 

Roadway Contributor Single Sided Color/Reflectance selector 

Reflect - Indicates the Reflectance of the selected surface. The current or tagged surface reflectances may be changed in this text box without 
having to access the Color/Reflectance dialog. If the specified reflectance exceeds the maximum allowable reflectance for the currently selected 
color, a message is displayed indicating the maximum allowable reflectance. When the Reflectance is changed, the associated Color is recalculated 
and redisplayed. 

Texture - Indicates whether a texture is applied to the selected surfaces. The text box displays the following options: 

Display Comments 

None No texture is specified 

Texture Name Specified texture name is displayed 

Textures are graphic images that may be applied to surfaces to make them appear more realistic. The average reflectance and color of the texture 
are calculated and used instead of the surface's original color in the radiosity calculations. 

AGi32 comes with a selection of assorted textures that may be applied to any surface. You may also obtain textures from many other sources, 
including free texture sites online and commercial texture collections. You may even use your digital camera to obtain them directly. Click here to 
read about texture tips. 

Assign a texture to the selected surface by clicking in the Texture cell, then clicking on the ellipsis (dots) icon, or press F4. The Select Texture dialog 
will appear, allowing you to choose a texture from the Textures database. Alternatively, you may Browse for a texture anywhere on your system or 
assign a texture already in use on another surface in the job file. Once the desired texture is selected, you can specify how the texture should be 
applied to the surface. Textures may be stretched across the entire surface, applied in a grid pattern, or assigned a fixed size (representing real 
dimensions) and tiled on the surface accordingly. In addition, you may elect to rotate the texture on the surface. 

To delete a texture from the surface, click in the Texture cell and hit the Delete key on your keyboard. When a texture is deleted from a surface, its 
calculated overall color and reflectance are used as the current color and reflectance. 

Transmittance - Indicates whether Transmittance is assigned to the selected surfaces. Transmittance is available for Double Sided  and Daylight 
Transition Glass (diffuse) surface types. In addition to reflectance, surfaces can have an optional diffuse Transmittance value, allowing a percentage 
of light to pass through the object in a lambertian manner. The specified transmittance value is entered as a decimal value (e.g., 20% Transmittance 
is specified as 0.2). 

This transmittance value is mathematically related to the color of the object, thus limiting the response acceptable in the Transmittance cell. AGi32 
automatically computes the maximum transmittance possible for the surface based on the color/reflectance selected. If you enter a transmittance 
value greater than the maximum allowed, AGi32 will display a message specifying the maximum allowable Transmittance value. 

This is not to be confused with the Transparency property used to model transparent Daylight Transition Glass (e.g., clear windows). Surfaces with 
transmittance do not appear transparent in the AGi32 rendering. 

Transparency - Indicates whether Transparency is assigned to the selected surfaces. Transparency is available for the following surfaces types: 
Daylight Transition Glass (transparent) and Glass. This allows you to consider transparent surfaces in order to model the transmission of daylight 
through clear glass or plastic.  

The transparency value may be entered manually (specify a value between 0.01 and 1), or you may select  the pull-down arrow icon (alternately 
press F4) to view a list of common glazing configurations with their associated transparency value. Note: To obtain transparency values from other 
commercial glazing products or systems, look for the Visible Transmittance value (VT). This value corresponds to the Transparency value in AGi32. 

The transmission of light through transparent materials is dependent on the angle of incidence. When light strikes a surface in a perpendicular 
manner, nearly all of the light is transmitted (approximately 96%). However, when light strikes the surface at a glancing angle, a very large 
percentage of the light may be reflected. AGi32 is able to accurately consider the transmission of light through a transparent surface. It is not, 
however, able to consider the reflection of light off of the transparent surface, except in Ray Tracing. 

AGi32 is capable of assigning a color to a transparent surface in order to model tinted glass. Light passing through the surface will be assigned this 
color along with the appropriate depreciation in the amount of light that can pass through. The tinted surface is visible in the rendering. 

Facts about Transparent surfaces in AGi32 

• The Glass surface type (Type 14) appears transparent in the radiosity calculations but behaves as a Lambertian diffuser in the model. 

• Light through tinted surfaces is colored and depreciated accordingly. 



AGi32 Help System  Modifying Entities 

256 

 

• The Index of Refraction for the Fresnel Reflection calculations is assumed to be 1.5. 

• The minimum allowable Transparency is 1% (0.01). 

Transparent surfaces -vs- Transmittance surfaces 

Both Transparent and Transmittance surfaces can consider the transmittance of light from one side of the surface to the other. However, the way in 
which they do so is completely different. 

• Double Sided surfaces can both reflect and transmit light. The amount of light transmitted is related to the reflected value and is controlled by 
surface color. Transmitted light is reemitted on the opposite side in a Lambertian distribution. This completely diffuse transmission model is a 
reasonable approximation for translucent materials, such as white plastic, but not transparent materials.  

• Transparent Daylight Transition Glass surfaces transmit light in accordance with Fresnel transmittance principals. Transparent Daylight 
Transition Glass surfaces can be up to 100% transparent. Their reflectance capability is not considered (they absorb all light they do not 
transmit). 

• Glass (Type 14) surfaces are transparent, and their transmittance losses are calculated in accordance with Fresnel transmittance principals. 
However, they behave as Lambertian diffusers, and they do not reflect light.  

• Transmittance values can be assigned to Daylight Transition Glass (diffuse) surfaces as well as Double Sided surface types. 

• Transparency values are available for the Daylight Transition Glass (transparent) and Glass surface types.  

Creation of a Daylight Transition surface 

Any surface can be assigned as a Daylight Transition Glass (transparent or diffuse or Opening) surface type, including surfaces associated with 
Rooms or Objects. The surface Normals must face into the desired interior space to properly direct the daylight into the space. 

When an opening is cut into a Room or Object, an option to create a Planar Object as an insert is offered. Select Yes to create a Planar Object with 
the same boundary as the opening. The Insert is assigned the following attributes by default: 

• Surface Type: 20 - Daylight Transition Glass (transparent) 

• Color: light gray (no color tint) 

• Transparency: 0.8 (80%) 

• Specularity: 0.8 (80%) 

Advanced Surface Properties 

This section provides additional surface parameters for ray tracing applications as well as advanced surface modifications. 

Specularity (Ray Trace Only) - Indicates the specularity (shininess) of the selected surfaces. By default, the value is 0 (no specularity); it may be 
increased up to 1 (100%, mirror reflection). The value may be entered directly or specified in the Specularity dialog. To use the Specularity dialog, 
click in the Specularity text box and then click on the ellipsis (dots) icon (or press F4). 

Surfaces may be made to look shiny by adding a Specularity value to their surface properties. This attribute is only visible in Ray Trace images and 
does not affect the numeric and radiosity calculations is any way. It is simply a post-process effect that is added to the surface when Ray Trace 
images are created. 

Glossiness (Ray Trace Only) - Indicates the apparent smoothness (low gloss or high gloss) of the selected specular surfaces. The range of 
Glossiness is 0.0001 (essentially diffuse) to 1.00 (perfectly specular). The default value is 0 - no glossiness applied. A value of 0.10 is recommended 
to provide a realistic appearing low gloss finish to surfaces for most applications. The value is entered directly. 

Glossiness may be added to any Specular surface, including Transition surfaces and Glass. This attribute is only visible in Ray Trace images and is 
not used in the numeric and radiosity calculations is any way. It is simply a post process effect that is added to the surface when Ray Trace images 
are created. 

Assigning a Glossiness value will increase the Ray Trace calculation time. 

Color Bleed - Indicates the Color Bleed scale of the selected surfaces. By default, the value is 1 (100%, full Color Bleed); it may be decreased to 0 
(0%, no Color Bleed). The value may be entered directly or specified in the Color Bleed dialog. To use the Color Bleed dialog, click in the Color Bleed 
text box and then click on the ellipsis (dots) icon (or press F4). 

Color Bleed is a real, physically observable phenomenon that occurs when strongly saturated colors are reflected to adjacent surfaces. Take a 
brightly colored surface (like red construction paper) and hold it horizontally next to any white wall. You'll observe a red tint on the wall from the red 
light reflected off the paper; the red color is the color bleed. 
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Computer generated environments with strong colors (e.g., a bright green carpet) tend to produce a color cast in the rendered environments. In real 
life, our eyes and brain compensate for the color cast and we would see the walls and ceiling as white. Color photographs and video displays do not 
compensate for the color cast automatically, and the rendered environment can appear unrealistic in this regard. 

The Color Bleed scale simulates human color vision adaptation. It is applied on an individual surface basis and should be applied to surfaces with 
strongly saturated color. 

Mesh Level - Indicates the Mesh Level of the selected surfaces. Mesh Level may be modified as necessary: increased  to improve the surface's 
response to its environment, or decreased to improve calculation times (opposite considerations). The Mesh Level value may be entered directly 
(e.g., 4.1), or specified in the Mesh Level dialog. To use the Mesh Level dialog, click in the Mesh Level text box and then click on the ellipsis (dots) 
icon (or Press F4). 

The Mesh Level syntax is as follows: <Patch level>.<Element Level>, per the Radiosity process used in AGi32. Increasing the Patch Level and/or 
Element Level will increase your calculation times. Note: Increasing the Patch Level, automatically increases the number of elements in each surface 
(even without additionally increasing the Element Level). 

Transition Surfaces: Daylight Transition Glass (transparent) and Daylight Transition Opening surface types only use the Patch Level specification 
and are originally meshed based on the "Initial Meshing -Transition Surface Types" settings in the Advanced System Settings dialog. These surface 
types do not include Elements (all light hitting the surfaces from other Patches or direct electric sources is absorbed). Diffuse Daylight Transition 
Glass (diffuse) surface types are composed of Patches and Elements and are originally meshed based on the "Initial Meshing -General Surface 
Types" settings in the Advanced System Settings dialog. 

Note: Changing the Mesh Level  manually in the Surface Edit dialog requires a thorough knowledge of how patches and elements are used in the 
radiosity calculations. Changing these values inappropriately can lead to unreasonably long calculations times (at best) or to inaccurate simulations 
(at worst). 

If you are unfamiliar with AGi32's radiosity process and need to refine your mesh, consider using Adaptive Subdivision instead. 

Luminance- Indicates the absolute Luminance of surfaces. By default, this value is zero, meaning that a surface does not self "emit"; it is only 
illuminated by the light it receives from other surfaces, luminaires, or daylight.  

Surfaces assigned a Luminance value are used to emulate virtual luminous surfaces - such as cold cathode, neon, computer monitors, photo-
luminous surfaces and more. 

Luminance is only available for Single and Double Sided Surface types, and is specified as a value between 1 and 30000 cd / m2. This specification 
allows you to set an absolute Luminance of the surface as a lambertian emitter. 

Double sided surfaces assigned a Luminance value may also be assigned a Transmittance value. 

The surface Luminance is used in the calculation results as well as in the rendered images. 

Luminance is always specified in cd/sq.m, regardless of your current display units. A Luminance Calculator is available allowing you to convert the 
following units to cd/sq.m: Lumens/Sq.Ft, Lumens/Sq.M, Lumens/Linear Ft, and Lumens/Linear M. 

Luminance Color - Indicates the emitted surface color of the selected surface; both a thumbnail and hexadecimal color value are displayed. By 
default, Luminance color is equal to Reflectance color; however, they can be different. To change the Luminance Color, click in the Color text box 
and then click on the pull-down arrow icon (or Press F4).The Color / SRE dialog will appear.  

• If Luminance value = 0 and surface reflectance color changes, Luminance color will revert back to reflectance color (reflectance hierarchy). 
However, once Luminance value is set > 0, the Luminance color is independent of reflectance color. 

• Luminance color does not have to relate to Reflectance color, although in most cases it will. 

Direct Flux Only - This attribute indicates that the surface receives, reflects, and obstructsdirect daylighting and/or electric lighting only (no 
interreflected light). In other words, DFO surfaces totally ignore reflected light; they do not receive, reflect or block reflected light. This attribute is 
useful for surfaces that receive little or no reflected light, to speed up radiosity calculation process. For example, a parking lot surface in a project with 
few other reflective surfaces (e.g., objects) may benefit from this optimization.  

When secondary sources are enabled, DFO (Direct Flux Only) surfaces will receive one additional interreflected "bounce" due to these secondary 
sources. 

Session History 

The Session History section indicates surface count as well as a running tabulation of the calculation options applied in this session. 

Total Surfaces - The total surface count for the selected Object and/or Room entities. 

Number Selected/Tagged - The total number of surfaces currently selected and tagged. Any modifications made are applied to all selected 
surfaces. Hint: If you wish to make individual changes to certain surfaces, click Remove All Tags and then only select the surfaces you wish to apply 
these changes to. 

Number of Surfaces Changed - Indicates the number of surfaces that the last modification was applied to. 
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Color and Transparency Selection - Concepts 

The Color/Transparency Selector dialog is available when a Color Tint is to be applied to a Daylight Transition Glass (transparent) surface. 

When a color tint is applied to a transition surface, it decreases the amount of light coming through the window. 

Beginning with version 1.9, the colors displayed in the Spectral Radiant Emittance Dialog are automatically gamma corrected based on the following 
equation: 

 

where C′ is the gamma-corrected displayed color value and C is the specified RGB value. 

Color and Transparency Selection 

Transparency Color - Transparency represents the reduced amount of light transmitted through a transparent surface when a color other than white 
(100%) is selected. When a color other than white  is assigned to a transparent surface, it tints the light that is passing through it and decreases the 
transmittance of the surface, as indicated by the Transparency Value. For example, if a color is selected that corresponds to a Transparency Value of 
0.58, the transmittance of the surface is then 58% of what it was without the color applied. 

To select a transparent color 

  

Methods to change the transparency and/or add a surface color tint: 

On the Color Mixer tab , change the Transparency Value directly. 
The selected Color/Transparency will continue to exhibit a gray 
tone. 

Also on the Color Mixer tab, move the slider controls for Red, Green 
and Blue until the color desired appears both in the center of the 
Color Mixer and the selected Transparency cell on the right side of 
the dialog. Alternatively, enter RGB values (between 0 and 255). 

Click on the Favorite Colors tab to select a color that you have 
previously saved as a Favorite. (See below.) 

Note: The Color Filters tab is not available for modifying a surface 
color, only for adding a color filter to a luminaire. 

The calculated Transparency Value is shown below the selected color. 

  

Add to Favorites 

It is convenient to be able to store favorite color combinations for later use. By selecting the Add to Favorites button, the color will be stored in the 
Favorites tab with Color, Transparency, and Comments to aid in later identification. 

You can recall a favorite color selection anytime by selecting  the Favorites tab and clicking on the color cell. Click OK to exit the dialog and return 
the color to the Object selection process. 

Reflectance and Color Selection - Concepts 

The Reflectance and Color Selector dialog is used to choose Color, and its associated reflectance, for all reflective surface specification in AGi32. 
The dialog is composed of graphic color selection as well as manual HSL and RGB specification for selecting an exact color choice. 

Graphic Color Selection 
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AGi32 provides a graphic HSL selection method for an intuitive approach. The HSL method matches human perception of color by first prompting for 
a color (hue), then a shade of that hue (Saturation and Luminance). 

Each of the three components (Hue, Saturation and Luminance) are measured on a scale from 0 to 240. Hue provides the absolute color choices 
such as green and blue. The hues are arranged in a linear strip from Red at the top (240), through the Color Spectrum - Violet (200), Indigo (170), 
Blue (128), Green (85), Yellow (42), Orange (21) - then back to Red (0). 

Saturation indicates the pureness, or intensity, of a hue, or the amount of gray it contains. A vivid color typically has a high saturation level (low gray 
selection). As the saturation decreases, the amount of gray increases, and the color becomes less vivid. Saturation is sometimes called Chroma. 

Luminance indicates the lightness of the color. A luminance value of 0 indicates the final color is black. A value of 240 produces a pure white color. 
Pure black and white colors do not exist in the architectural surface realm, so more realistic (and typically muted colors) should be used for accurate 
lighting simulations. This characteristic is sometimes called Value. 

Color and Reflectance 

The human eye is visually sensitive to a small portion of the electromagnetic spectrum between 400 and 700 nanometers. We are not equally 
sensitive to all wavelengths (colors). The variation in sensitivity is described by the CIE Photopic spectral luminous efficiency function and is shown 
graphically with a bell curve. The shape of the curve indicates that our eyes are most sensitive to yellow-green, and exhibit lesser sensitivity to violet 
and red (our eyes respond least to violet light). 

 

 

  

Computer monitors display all colors as a mix of the three primary additive colors: Red, Blue and Green. Much of the visible spectrum that humans 
perceive can be duplicated by this color space, but not all colors (especially saturated colors) can be simulated. 

The relationship between grayscale reflectance (overall reflectance) of a surface and its RGB color equivalent is as follows: 

Grayscale Reflectance  = 0.2125 * R + 0.7154 * G + 0.0721 * B. 

From this relationship we can derive the following assumptions: 

• The maximum reflectance a saturated Red color can exhibit is 21%. 

• The maximum reflectance a saturated Blue color can exhibit is 7%. 

• The maximum reflectance a saturated Green color can exhibit is 72%. 
• Surfaces with high reflectances always have a large green component in their color makeup. 

Transmittance relationship to reflectance value 

Transmittance is mathematically related to the color of the surface. AGi32 automatically computes the maximum non-dichroic transmittance possible 
for surfaces where applicable and displays this value in the transmittance cell. 

The relationship is based on the premise that all light that is not reflected or absorbed can be transmitted. 

Transmittance Equation: 



AGi32 Help System  Modifying Entities 

260 

 

Transmittance = (0.2125)(Ravail) + (0.7154)(Gavail) + (0.0721)(Bavail) 

To compute the maximum transmittance for any particular color we first must find the percentage of each component (Red, Green, Blue) that is 
available for transmittance. 

Consider the following example: 

Suppose we have a color (somewhat of a subdued red) with the following components, R=210, G=105, B=105. What is the maximum transmittance? 

Begin by computing the percentages of each component that can be reflected. What is not reflected or absorbed is then available to be transmitted. 
We know that full saturation of any color is 255. Divide each component by 255 to find the maximum amount that can be reflected. 

� Max reflected R = 210/255 = 0.824 
� Max reflected G = 105/255 = 0.412 
� Max reflected B = 105/255 = 0.412 

To find the maximum amount of light that can be transmitted we must look at which component of the color allows the most light to be reflected, as 
this color then has the least amount of available light remaining to transmit. In non-dichroic transmittance, the other colors must follow in proportion. 
In our example, the Red (R) component has the greatest reflected component (that's why it looks red). The maximum transmitted amount of red is 
then whatever is remaining after reflection. 

� Max transmitted R = 1 - 0.824 = 0.176 
� The ratio of transmitted to reflected light for red is 0.176/0.824 = 0.2135 

� Apply this multiplier to the other color components to arrive at the relative amounts of light that can be transmitted: 
� Green: 0.2135 x 0.412 = 0.088 
� Blue: 0.2135 x 0.412 = 0.088 

Note that Red also has the greatest transmitted component, so the light that passes through will be reddish in appearance. 

Now plug these relative amounts of transmissible light into the equation for Transmittance. 

Transmittance = (0.2125)(0.176) + (0.7154)(0.088) + (0.0721)(0.088) = 0.1004 

The maximum transmittance for our example color is then 0.1004, or roughly ten percent. (As a side note, since 50% of the light striking this surface 
was reflected and 10% was transmitted, that leaves 40% to be absorbed.) 

Reflectance and Color Selection 

The Reflectance and Color Selection dialog is used to specify the color of non-luminous surfaces such as luminaire housing surfaces,  room surfaces 
and objects surfaces. When these entities are created, they are assigned a reflectance value and a corresponding color that mathematically matches 
that reflectance. 

The color  of a surface is specified by first selecting the Hue with the vertical slider bar on the left side of the dialog or clicking in the color 
specification strip. Once a Hue has been selected, the color intensity (saturation and luminance) may be changed by moving the respective slider 
bars. The reflectance is shown beneath the large color swatch on the right side of the dialog along with a small slider that shows the range of 
reflectances available in the approximate range of this Hue. 

Selecting a Color 

1. Move the Hue slider to the color of choice. For gray only (no color), move the Hue slider to the very bottom of the graph. 
2. The Hue selected will be displayed with the range of intensities available. Move the Luminance (Lum.) and Saturation sliders to the desired 

intensity of the color, or, simply click and hold the left mouse button within the Luminance and Saturation graph and drag to the desired color. 
Alternatives are the specification of RGB or HSL values. 

3. The selected color will appear in the Selected Color/Reflectance frame on the right side with the current reflectance shown below. Adjust the 
reflectance if necessary in the small reflectance slider.  

4. Click Ok. 

Illuminated Appearance - Selected colors are shown in the bottom right corner of the dialog as they might appear under various levels of 
illumination. Colors appear less luminous under low light conditions and more luminous under very high light levels. 
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Add to Favorites - It is valuable to be able 
to store color selections for later retrieval 
with a note as to why it was saved. To do 
this simply click on the "Add to Favorites" 
button. The Favorites dialog will be 
displayed with its selected color, typical 
illuminated appearance, reflectance and a 
text note for description. 

To select a saved color from the Favorites 
dialog, first click on the Favorites tab in the 
color dialog. Then click in the color cell of 
the desired color and click OK to close the 
dialog. 

Alternately, you may double click on a 
Favorite color to select it. 

 

Glass - Concepts 

Glass and Daylight Exterior Glass model transparent glass and plastic surfaces for both interior and daylight exterior environments (AGi32 surface 
type 14) 

These surface types must not be used as a substitute for Daylight Transition surfaces to radiatively couple exterior and interior environments for 
daylighting calculations ( instead of AGi32 surface types 20, 21 and 22). In other words, they should not be used as windows. 

Recommended Uses – Office partitions, tabletops, shower doors, exterior glass enclosures (e.g., bus stop waiting area). 

Technical Details 

Visibility in Radiosity and Ray-Traced Images - Glass surfaces are correctly rendered as transparent surfaces in both radiosity and in ray-traced 
images. Note: Be sure to set specularity (recommended minimum = 0.05) for the glass to look realistic in the Ray Trace images. 

VRML Renderings – VRML97 does not support transparency effects. Therefore, glass surfaces are rendered as double-sided transmissive surfaces 
(i.e., they look opaque in VRML). 

Meshing – Glass surfaces are meshed into an array of patches as specified in the meshing parameters for glass/transition surfaces (Tools-System 
Settings-Advanced Settings). Glass surfaces are not further subdivided during adaptive subdivision, as they contain no elements. 
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Radiosity Calculations - Glass surfaces are considered to be double-sided transmissive surfaces for the purposes of radiosity calculations. They 
behave as Lambertian emitters; that is to say they diffuse both direct and interreflected light to surface elements on the other side of the glass. 
However, unlike double-sided transmissive surfaces (AGi32 surface type 11 with Transmittance assigned),they appear transparent in the renderings 
and their reflectance value is zero. 

Glass will appear in the RGB Color and Grayscale Color Renderings as a shaded surface but not in the Pseudocolor renderings (the glass surface 
shades other surfaces as seen through the glass, the glass surface itself has no luminance/brightness). There is no practical way to change the 
Pseudocolor appearance of surfaces as seen through the absorbing glass, so in order to display these surfaces as they are changing in gradient the 
glass surface cannot be displayed. 

Fresnel Equations - The Fresnel Equations describe the behavior of light when moving between media of differing refractive indices. The reflection 
of light that the equations predict is known as Fresnel reflection. (ref. Wikipedia, Fresnel equations.) In Radiosity calculations, Glass surfaces do not 
currently support Fresnel reflectance (they do not reflect light at all). However, they do support Fresnel transmittance losses, as daylight transition 
surfaces do for direct sources. The transmission of light through transparent materials is dependent on the angle of incidence. When light strikes the 
surface perpendicularly, nearly all of the light is transmitted (approximately 96% of the specified Transparency value). However, when light strikes the 
surface at a glancing angle, a very large percentage of the light may be reflected instead. In Radiosity calculations, AGi32 is able to accurately 
consider the transmission of light through a transparent surface based on incident angle. It is not, however, able to consider the reflection of light off 
of the transparent surface. (Ray Trace calculations do consider Fresnel reflection and transmission.) 

Refraction - Glass surfaces do not support refraction, as they are primarily intended to model planar surfaces. All light not transmitted through is 
absorbed. 

Caveats - In general, AGi32 will provide correct results for direct illuminance transmitted through glass surfaces, when glass occupies a small 
percentage of the overall surface area. However, the diffusing properties of the glass in the radiosity calculations may unduly influence the entire 
radiosity solution if there are large expanses of glass. This may affect the indirect illuminance distribution and hence the accuracy of the photometric 
calculations. Note: This is a temporary situation that will be addressed in a forthcoming maintenance release. 

We recommend that glass should only be used in environments where photometric accuracy is a low priority (i.e., for visualization purposes only), 
especially where the environment depends considerably upon interreflection or where glass plays more than a minor role in interreflection. 

Exitance Meter and Virtual Meterresponse to Glass surfaces  - The Exitance Meter values corresponds with the radiosity calculations - point by 
point values reflect a Lambertian effect from glass transmittance. The Virtual Meter is applied after the radiosity calculations and therefore sees the 
glass differently. The Virtual Meter sees the glass as an image preserving material instead of a diffusing material. In general, luminaires and other 
direct sources (such as daylight) are attenuated correctly through the glass material. Interreflected light (patches seen through the glass) is not 
attenuated using Fresnel transmission. 

We suggest using the Exitance meter instead of the Virtual meter for calculations through Glass surfaces. The following general disparities were 
noticed between the Exitance and Virtual meters: 

� Direct light through Glass - The Virtual Meter values may be significantly higher than the Exitance Meter within the beam of light. 
� Interreflected light through Glass - The Virtual Meter may be significantly lower than the Exitance Meter, especially with low Transparency 

values. 

Raytracing Calculations - Glass behaves as a Fresnel transmitter in the ray tracing calculations (it does not diffuse the light; instead it behaves as 
an image-preserving surface). 

Luminance Calculator - Concepts 

The Luminance value in cd/sq. m indicates the absolute diffuse Luminance of Emittance surfaces. Luminance is only available for the Emittance 
Surface Type, and is specified as a value between 1 and 30000. This specification allows you to set an absolute ‘brightness’ of the surface. 

For backward compatibility, Emittance Factor in older version files will be used as the Luminance value (e.g. Emittance Factor = 10, Luminance = 10 
cd/sq.m). It may be necessary to change this value in order to achieve desirable results. This also applies to emittance surfaces in older version 
library objects 

Technical Details 

Lambertian (diffuse) Luminance is defined as Exitance / Pi. The following conversion factors are applied automatically in the Luminance Calculator: 

Unit Width Conversion Example: 

Lumens / Square Ft Included Multiply by 10.76 (Sq Ft to Sq M 
conversion); divide by Pi 
(3.14159265) 

100 Lumens / Square Ft  = 100 * 10.76 / 
3.14159265 

= 342.451 Cd / Square M 

Lumens / Square 
Meter 

Included Multiply by 10.76 (Sq Ft to Sq M 
conversion); divide by Pi 
(3.14159265) 

100 Lumens / Square M = 100 / 3.14159265 

= 31.831 Cd / Square M 
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Lumens / Linear Ft 0.042 Ft 
(may be 
changed) 

Multiply by 10.76 (Sq Ft to Sq M 
conversion); divide by (Pi 
(3.14159265) multiplied by calculated 
Square footage) 

100 Lumens / Linear Ft  = 100 * 10.76 / 
(3.14159265* 0.042 Sq Ft) 

= 8153.584 Cd / Square M 

Lumens / Linear 
Meter 

0.015 Meters  
(may be 
changed) 

Multiply by 10.76 (Sq Ft to Sq M 
conversion); divide by (Pi 
(3.14159265) multiplied by calculated 
Square meterage) 

100 Lumens / Linear 
Meter 

= 100 / (3.14159265* 
0.015 Sq M) 

= 2122.066 Cd / Square M 

Note: If the luminance exhibited by the Emittance surface is not essentially diffuse, this assumption of Luminance will yield inaccurate simulations. 
You must obtain a photometric file from the manufacturer describing the candela distribution to use instead. 

Luminance Calculator 

The Luminance Calculator allows you to convert the following Units to Cd/Sq.M: 

� Lumens/Sq.Ft 

� Lumens/Sq.M 

� Lumens/Linear Ft - Nominal width of 0.042 Ft (1/2 inch) 

� Lumens/Linear - Nominal width of 0.015 M (1/2 inch) 

To convert a luminous unit to Luminance 

1. The Luminance Calculator dialog is accessed from the Luminance cell in the Surface Edit dialog. 
2. Enter the Unit value given. You may change the nominal Width when entering Lumens per linear Ft or M. AGi32 will automatically convert all 

other Units and the Luminance values accordingly. 
3. Click Ok. 

Color Bleed - Concepts 

Color Bleed is real, physically observable phenomenon that occurs when strongly saturated colors are reflected to adjacent surfaces. Take a brightly 
colored surface (like red construction paper) and hold it horizontally next to any white wall. You'll observe a red shadow from the paper - the red color 
is the color bleed. 

Computer generated environments with strong colors (e.g., a bright green carpet) tend to produce a strong color cast on nearby surfaces in the 
rendered environments. In real life, our eyes and brain compensate for the color cast and we would see the walls and ceiling as white. Color 
photographs and video displays do not compensate for the color cast automatically, and the rendered environment appears overly saturated in this 
manner. 

The Color Bleed scale simulates human color vision adaptation. It is applied on an individual surface basis, and should be applied to surfaces with 
strongly saturated color (the emitters). 

Technical Details 

Color Bleed Scale is applied by decreasing the amount of spectral color in the surface, while maintaining the same grayscale color reflectance. The 
following example illustrates a red carpet with a Color Bleed Scale of 0.25 applied: 

Carpet Spectral reflectance (RGB values) - R = 230, G = 13, B = 13. The saturation ratio of each color is: R = 0.9 (230/255), G = 0.05 (13/255), B = 
0.05 (13/255) 

Carpet Grayscale reflectance Value: 

• Reflectance = 0.21R + 0.72G + 0.07B 

• Carpet Reflectance = 0.21*(230/255) + 0.72*(13/255) + 0.07*(13/255) = 0.23 (23%) 

Color Bleed Scale = 1 (No Color Bleed Scale) 

1. Luminaires emit white light 
2. Carpet reflects red light (R = 230, G = 13, B = 13) 
3. Ceiling and walls receive red light 
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Color Bleed Scale = 0.25 

1. Luminaires emit white light 
2. Carpet reflects pinkish white light 

• Each individual carpet color is scaled: 

• Rscaled = Grayscale reflectance (0.23*255 = 59) + Scaled Red Reflectance (0.25 * (230 - 59) = 102 

• Gscaled = Grayscale reflectance (0.23*255 = 59) + Scaled Green Reflectance (0.25 * (13 - 59) = 48 
• Bscaled = Grayscale reflectance (0.23*255 = 59) + Scaled Blue Reflectance (0.25 * 13 - 59) = 48 

3. Carpet Grayscale Reflectance remains the same = 0.21*(102/255) + 0.72*(48/255) + 0.07*(48/255) = 0.23 (23%) 

Color Bleed 

The Color Bleed dialog allows you to set the Color Bleed Scale using a slider bar. A sample Color Bleed image is used with a Range of Color Bleed 
values to simulate how increasing or decreasing the Color Bleed Scale (for the saturated surfaces) changed the color cast on the adjacent surfaces. 

1. The Color Bleed dialog is accessed from the Color Bleed cell in the Surface Edit dialog. 
2. Use the Slider Bar to determine the desired Color Bleed Scale. 
3. Click Ok. 

Mesh Level - Concepts 

Mesh Level may be modified as necessary, on an individual surface basis, to refine the calculation mesh of surfaces. For example, the Mesh Level 
may be increased to improve the surfaces response to its environment or decreased to improve calculation times for insignificant surfaces (these are 
opposite considerations). 

Every surface in AGi32 is automatically assigned a default Patch level based on its size. The Element Size Factor applied to each surface further 
meshes Patches into Elements. These global settings are found in the Advanced System Settings dialog. 

If you are unfamiliar with AGi32's radiosity process and need to refine your mesh, you may wish consider using Adaptive Subdivision. 

Transition Surfaces 

Transparent Window and Daylight Opening Transition surface types only use the Patch Level specification and are originally meshed based on the . 
"Initial Meshing -Transition Surface Types" settings in the Advanced System Settings dialog. The direct and interreflected daylight coming through 
the Patches is assumed to be a point source. These surface types do not include Elements (all light hitting the surfaces from other Patches or direct 
electric sources is absorbed). For these surface types you will typically see and specify Mesh levels such as 3.0,4.0,5.0, etc. 

Diffuse Window Transition surface types are composed of Patches and Elements and are originally meshed based on the "Initial Meshing -General 
Surface Types" settings in the Advanced System Settings dialog. The direct and interreflected daylight coming through the Patches is assumed to be 
a point source. This surface type does include Elements and will reflect light back into the environment (both exterior and interior) based on the 
Reflectance value. For these surface types you will typically see and specify Mesh levels such as 3.1,4.1,5.1, etc. 

Syntax 

The Mesh level Syntax is as follows: Patch level . Element Level, per the Radiosity process used in AGi32. Increasing the Patch Level and/or 
Element Level will increase your calculation times. Note: Increasing the Patch Level, automatically increases the number of elements in each surface 
(even without additionally increasing the Element Level). 

The individual Patch and Element Level can each be specified up to 8, however, the total sum of their values may not be greater than 8. 

Examples: 

• Patch level = 3, Element Level = 1, Mesh Level = 3.1 

• Patch level = 5, Element Level = 2, Mesh Level = 5.2 
• Patch level = 6, Element Level = 3, Mesh Level = Invalid (6 + 3 > 8) 

Actual Patch or Element Size 

The Patch and Element levels determines the maximum Patch or Element size that each surfaces can be divided into. The Actual Patch Size is 
determined by dividing the Longest Side of each surface by 2

Patch Level
, unless Patch Level = 0. The Actual Element Size is determined by dividing the 

Actual Patch Size by 2
Element Level

. 
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Patch and Element Levels used in manual meshing 

Level Number of Patches or Elements 

0 2
0
 Special Cases apply: If Patch level = 0, entire surface is considered as one Patch. If Element level = 0, Element Size = Patch Size. 

1 2
1
 = 2 rectangles on each side, 4 rectangles per surface. 

2 2
2
 = 4 rectangles on each side, 16 rectangles per surface. 

3 2
3
 = 8 rectangles on each side, 64 rectangles per surface. 

4 2
4
 = 16 rectangles on each side, 256 rectangles per surface. 

5 2
5
 = 32 rectangles on each side, 1032 rectangles per surface. 

6 2
6
 = 64 rectangles on each side, 4096 rectangles per surface. 

7 2
7
 = 128 rectangles on each side, 16,384 rectangles per surface. 

8 2
8
 = 256 rectangles on each side, 65,536 rectangles per surface. 

Example of Patch and Element Level application 

 

Additional Examples of Patch and Element Level application 

Increasing the Patch Level by a factor of one has the effect of decreasing the Actual Patch Size by a factor of two. 

Actual Patch Size = Longest Side of each surface / 2
Patch Level

 

Example: Patch Level = 3, Longest Side of Surface = 32, Actual Patch Size = 32/2
3
 = 4 

        Patch Level = 4, Longest Side of Surface = 32, Actual Patch Size = 32/2
4
 = 2 

Actual Element Size = Actual Patch Size / 2
Element Level

 

Example: Element Level = 1, Actual Patch Size = 4, Actual Element Size = 4/2
1
 = 2 

        Element Level = 3, Actual Patch Size = 4, Actual Element Size = 4/2
3
 = 0.5 

Mesh level Notes 

• If Patch Level and Element level both equal 0, then default mesh levels are applied for the surface. 

• Manually changing the Mesh Level will override Smart Meshing if it's enabled. 

• Changing the Mesh Level  manually requires a thorough knowledge of how patches and elements are used in the radiosity calculations. 
Changing these values inappropriately can lead to unreasonably long calculations times (at best) to inaccurate simulations (at worst). 

Auto Levels 

Resetting the current Mesh Levels to Auto Levels will replace the current meshing levels with a default mesh level based on the surface size and 
AGi32's General Meshing Settings specified in Advanced System Settings. The Mesh Level syntax 0.0 indicates that default mesh levels are being 
applied. 
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Mesh Level 

The Mesh Level dialog allows you to select the Patch and Element Levels using a slider bar. A dynamic Mesh Level display illustrates the Patch and 
Element density on a surface as the Patch and Element Level values are changed. 

1. The Mesh Level dialog is accessed from the Mesh Level cell in the Surface Edit dialog. 
2. Use the Slider Bars to determine the desired Mesh Level setting. 

• Patch Level: Indicates the number of Emitters per surface. Increasing the patch level automatically creates more Elements per surface. 

• Element Level: Indicates the number of Receivers per surface 
3. Auto Levels - Pressing this button will reset Patch and Element Levels to their automatic levels (0.0). this override setting instructs the surface to 

determine the Mesh level sizing based on the Meshing Settings set in Advanced System Settings. 
4. Click Ok. 

Specularity - Concepts 

Surfaces may be made to look shiny (or mirror-like) by adding a Specularity value to their surface properties. This attribute is only visible in Ray 
Trace images and is not used in the numeric and radiosity calculations is any way. It is simply a post process "layer" that is added to the surface 
when Ray Trace images are created. 

Specular surfaces may be rendered less mirror-like (i.e., with a low or high gloss) by specifying an additional Glossiness attribute in the Surface Edit 
dialog. 

Technical Details 

Specularity Value indicates the percentage of the reflected light that will be reflected in a specular (shiny) manner in the Ray Traced image. 

If Specularity = 1.0, then Specularity = Reflectance. If some of the light is reflected diffusely, you have what is sometimes called "combination" 
reflection, and Specularity < 1.0. For example, a Specularity value of 1 indicates that 100% of the light reflected off a surface is reflected specularly. 
A Specularity value of 0.5 indicates that 50% of the reflected light is reflected specularly, and the reflected image will be dimmer, less distinct, against 
its background. The lower the Specularity value, the smaller the specular component of the reflection, and the dimmer, less intense the specular 
component of the reflected image is. One example is polished marble. A reflected image in the marble has hard edges, even if the image is 
somewhat dim. 

 

Floor Reflectance = 80%, Specularity = 1.0   Floor Reflectance = 80%, Specularity = 0.5 Floor Reflectance = 80%, Specularity = 
0 (diffuse) 

Specularity 

The Specularity dialog allows you to set the Specularity value using a slider bar. A sample image with a specular floor is used with a Range of 
Specularity values to simulate how increasing or decreasing the Specularity changes the reflection displayed on the specular surface. 

1. The Specularity dialog is accessed from the Specularity cell in the Surface Edit dialog. 
2. Use the Slider Bar to determine the desired Specularity value. 
3. Click Ok. 

Glossiness - Concepts 

Surfaces may be made to look shiny or glossy by adding a Glossiness value to their surface properties. Glossiness refers to the shininess and 
apparent smoothness of a surface. A highly gloss surface appears very smooth and shiny (e.g. polished marble), while a low gloss surface appears 
somewhat rough and dull (e.g. a hardwood floor with a low satin finish). 

This attribute is only visible in Ray Trace images and does not affect the numeric and radiosity calculations in any way. It is simply a post process 
"layer" that is added to the surface when Ray Trace images are created. 
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Glossy surfaces will increase the number of rays and ray tracing time - generally by a factor of 3 to 5 times. It is strongly recommended to limit the 
use of glossy surfaces and/or soft shadows for presentation grade images only. 

Technical Details 

The range of Glossiness is 0.0001 (essentially diffuse) to 1.00 (perfectly specular). The default value is 0 - No glossiness applied. A value of 0.10 is 
recommended to provide a realistic appearing low gloss finish to surfaces for most applications.  

Glossiness can be applied to any surface which also has a Specularity Value greater than 0 assigned, including glass (which produces a ‘frosted’ 
effect). 

Glossy surfaces only work with specular materials where you can see the reflections of other objects. When you enable the glossy surfaces feature, 
AGi32 bounces 9 rays from each pixel intersection within a specular surface instead of one. The rays are 'jittered' (scattered) from the specular 
reflection direction based on the glossiness value. With a value of 1.0 (perfectly specular), the rays are not jittered and the reflected image is 
perfectly reflected (all rays are reflected in the same direction, no distortion). As the value approaches 0 (essentially diffuse), the amount of jittering 
increases, yielding a dull (or distorted) reflected image (the rays are not reflected in the same direction). As a result, you will not notice glossy surface 
reflections from strongly curved surfaces. Again, when Glossiness = 0, that does not mean that the surface is diffuse. Rather, it means that 
glossiness is not considered; no glossiness is applied. 

The effect of the glossy reflections becomes more apparent as the distance between the glossy surface and the reflected object increases. 

 

10% Specular Floor; Glossiness at Default 
Level (0) - Specular Reflection is consistent for 

all parts of reflected image. 

 

10% Specular Floor; Glossiness at 0.1  - Effect of 
low gloss surface is most apparent at bottom of 

image, at farthest point of reflection. 
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Specular Interior Glass 

 

20% Specular Interior Glass, 2 Panels assigned 10% Glossiness Factor 
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 Identify Entity 

Identifying Entities-Concepts 

The Identify Entity command is used to identify AGi32 or imported CAD entities for reference or modification. Some possible uses include, but are not 
limited to: 

• Identify CAD layers that need to be hidden, then switch them off in Project Manager 

• Identify luminaire types 

• Identify Surface type (e.g. room or object) for appropriate modification commands. 
• Identify Project association when using multiple projects 

Using the Identify Entity Control 
The Identify Entity command identifies the selected entity and specifies how it may be modified. The Identify Entity dialog displays the entity type, 
associated project, associated layer or label, and how to modify the entity. 

1. From the Tools menu, choose Identify Entity or, from the Common toolbar, select  
2. Select by positioning the pickbox cursor on the entity and clicking the left mouse button. 
3. The Identify Entity dialog will appear describing the selected entity. 

4. Click Ok to terminate the command. 

 

 

 Modify Calculations 

Modifying Isolines 

The Modify-Calculation Points-Isoline command provides another point of access to the Isoline dialog. The current Isoline values will be displayed 
and may be modified for value or color.  

Deleting Calculation Points - Concepts 

You can delete different types of calculation points (grids, polygons, lines, etc.) in their entirety (by label). Once a calculation entity is selected, any 
related points will also be deleted. For example, if you delete a Roadway Luminance grid, all related Roadway grids (using the same label) will also 
be deleted. 

Calculation Type What Gets Deleted 

Automatic Placement Selected grid(s) or polygon(s) 

Grid Selected grid(s) – including correlated GR grids and Roadway 
Luminance grids, if applicable. 

Line Entire family of lines (same label) 

Polygon Selected polygon(s) 

Scattered Entire family of points (same label) 

Removing Points 

Choosing the Delete Calculation Points command deletes the entire calculation entity (all points). if you wish to mask out particular areas from the 
grid, use the Remove Points command instead. 

Project Manager 

Calculation entities may also be deleted in Project Manager on a grid by grid basis. 
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Deleting Calculation Points 

This command deletes entire definitions of calculation points (grids, lines, polygons, etc.). This option will not remove individual points within a 
definition, use the Remove Points command instead. You may delete calculation entities individually or in multiples through a window. 

1. From the Modify menu choose Calculations -Delete, or from the Calculations toolbar select . To use the Window option, left click on the 
pull-down arrow to the right of the button to invoke the secondary menu. Select Window. 

2. Select the calculation entities in one of the following ways: 

• Single: Select an individual calculation entity by moving the pickbox cursor over it and clicking the left mouse button. You may continue 
deleting additional calculations by selecting them with the pickbox. 

• Window: Select multiple calculation entities by specifying two opposing corners of a window frame that surrounds the desired 
calculations. 

3. Right click the mouse or press [ENTER] on the keyboard to confirm your selection(s) and delete. 

 Editing Calculations 

Editing Calculation Points - Concepts 

Once calculation points have been placed in the job file, they may be edited at any time. The Edit dialog provide all of the functionality of the original 
Add dialogs, some with additional specification capability. 

General cosmetic changes, such as changing the Label, Description, Display Options, Text Size and Labeling will not require recreation or 
recalculations. Non cosmetic changes that involve changing the calculation point positions or light meter type or direction, will require recreation and 
recalculation. 

If you have removed points from the calculation entity prior to editing, they will be replaced if non-cosmetic changes are made. 

Editing Calculations 

After calculation points are placed, they may be edited at any time. Editing functions include, but are not limited to, new point spacings, text size, 
meter type, size and location of grid, visibility status, display options, etc. 

What do you want to do? 

Edit a calculation grid 

Edit a family of calculation lines 

Edit a family of scattered calculation points 

Edit a calculation polygon 

Edit a 2-pt. Glare Rating Grid 

Edit a Daylight Factor Grid 

Edit a UGR Grid 

Edit Roadway Luminance calculation points 

Editing A Calculation Grid 

The Edit Calculation Grid dialog looks just like the original ‘Add’ calculation dialog, with the addition of the specified grid coordinates and the 
opportunity to respecify the grid. You may change the label, description, point spacing, text size, labeling and display options, light meter, summary, 
elevation coordinates or respecify the grid's location and extents. 

If you have removed points from the grid prior to editing, they will be replaced if you recreate the grid (change point spacing, or respecify the grid). 
Cosmetic changes, such as changing text color or text size, will not result in removed points being replaced. 

1. From the Modify menu choose Calculations -Edit, or from the Calculations toolbar select . 
2. Select the calculation grid by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes. You have two options when respecifying the grid: 

• In the Specified Grid section, you can change the current X, Y and/or Z coordinates. 
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• Click on the Respecify Grid button to specify the 2 input points of the grid in the graphics window. You will not be returned to the Edit Grid 
dialog after specification. 

4. Click Ok. 

Note: 3-pt. Calculation grids are edited in the same manner with the addition of a third input point grid coordinate. When respecifying the grid from 
this dialog, you will be prompted for three input points in the graphics window. 

Edit a 2-pt. Glare Rating Grid 

The Edit Glare Rating Grid dialog looks just like the original ‘Add’ calculation dialog, with the addition of the specified grid coordinates and the 
opportunity to respecify the grid. You may change the label, description, point spacing, text size, labeling and display options, summary, elevation 
coordinates or respecify the grid's location and extents. In addition you can add, replace or delete observer positions. 

If you have removed points from the grid prior to editing, they will be replaced if you recreate the grid (change point spacing, or respecify the grid). 
Cosmetic changes (such as changing text color or text size) will not result in removed points being replaced. 

1. From the Modify menu choose Calculations -Edit, or from the Calculations toolbar select . 
2. Select the calculation grid by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes. You have two options when respecifying the grid: 

• In the Specified Grid section, you can change the current X, Y and/or Z coordinates. 

• Click on the Respecify Grid button to specify the 2 input points of the grid in the graphics window. You will not be returned to the Edit Grid 
dialog after specification. 

4. Click Ok. 

Edit Calculations - Daylight Factor 

The Edit Daylight Factor Grid dialog looks just like the original ‘Add’ calculation dialog. You may change the label, description, point spacing, text 
size, labeling and display options, summary, even select a different room or respecify the polygon boundary. 

If you have removed points from the grid prior to editing, they will be replaced if you recreate the grid (change point spacing, or respecify the grid). 
Cosmetic changes (such as changing text color or text size) will not result in removed points being replaced. 

1. From the Modify menu choose Calculations -Edit, or from the Calculations toolbar select . 
2. Select the calculation grid by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes.  
4. You may respecify the entire polygon by clicking the Re-Specify Polygon button. Two modification choices are provided: Manually Specify 

Polygon and Create Polygon from Drawing Entity, Room or Object. Depending on which choice is selected, different steps will be required once 
you click the Re-Specify Polygon button. You will be returned to the graphics window where the existing polygon will be visible as a reference. 
Specify the polygon vertices as required and right click when the polygon is complete. At this time, any other changes that were specified in the 
Edit dialog before the Re-Specify Polygon button was clicked will also be applied. You will not be returned to the Edit Polygon dialog. 

5. Follow the steps below depending on the selected Creation Method: 

Specify a Polygon Manually Create Polygon from Drawing Entity, Room or Object  

i. Locate the first point of the polygon and click the left mouse 
button. 

ii. Move the cursor to the second vertex on the polygon and left 
click again. 

iii. Continue in this fashion until the polygon is complete. Right click 
to close the polygon shape. The Polygon grid will be created. 

iv. To change the polygon elevation, move the cursor into the Z-
Coord text box and enter a new value or use the up and down 
arrow keys on the keyboard, before clicking the first point. Locate 
the first point of the grid and click the left mouse button. 

i. Locate the pickbox on the drawing entity line, object or room 
boundary you wish to use and left click. 

ii. If a valid polygon is found (see Notes below), it will be displayed 
as a bold line, and the Polygon Search results dialog will appear: 

• Accept Polygon and Repeat - Grayed out during this operation - 
can only respecify one polygon at a time. 

• Accept Polygon - Create grid using selected entity as polygon 
boundary. 

• Reselect Entities - Choose this option if invalid polygon was 
found or if incorrect line was chosen. Use pickbox to select 
another closed polygon. 

• Manually Specify Polygon - Select vertices manually to specify 
polygon boundary, right clicking once all vertices are specified. 
This option is necessary if no valid polygon is found. 

• Cancel - Do not create calculation entity. 
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Notes: 

• Drawing Entity line segments do not need to be joined, just need 
to be within tolerances (2 decimals of precision - .05) 

• Line segments do not need to make a closed polygon - AGi32 will 
automatically close boundary line 

• AGi32 filters related lines by color. 

Caveats: 

• Disconnected line segments or line segments disconnected by 
gap larger than tolerance level will not form valid polygon. 

• Polygons with intersecting lines will not form valid polygon. 

• Incomplete polygons are not valid, may close in an unacceptable 
manner. 

Edit Calculations - UGR 

The Edit Unified Glare Rating Grid (UGR) dialog looks just like the original ‘Add’ calculation dialog. You may change the label, description, point 
spacing, text size, labeling and display options and summary. In addition you can add or modify observer grids and individual observer positions. 

If you have removed points from the grid prior to editing, they will be replaced if you recreate the grid (change point spacing, or respecify the grid). 
Cosmetic changes (such as changing text color or text size) will not result in removed points being replaced. 

1. From the Modify menu choose Calculations -Edit, or from the Calculations toolbar select . 
2. Select the calculation grid by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes. 

• Existing UGR Analysis Grids may be changed and new Analysis grids may be added 

• To add additional Individual observer positions, click the Specify Additional button. 

• To delete an Individual observer position, click in the shaded cell with the arrow to the left of the Observer Number, so that the entire row is 
highlighted. Press the Delete key on your keyboard to permanently delete this observer position. 

• To replace all existing Individual observer positions with new observers, click the Specify New button. 

• The Individual observer position parameters (Label, X, Y , Z coordinates and View Angle may be changed manually. 
• To relabel all Individual observer positions with the default Labeling scheme (Obs 1, Obs 2, etc.), click the Re-label All button. 

4. Click Ok. 

Edit Calculations In A Polygon 

The Edit Calculation Polygon dialog looks just like the original ‘Add’ calculation points dialog, with the addition of the specified polygon coordinates 
and the opportunity to respecify the polygon boundary. You may change the label, description, point spacing, text size, meter type, labeling and 
display options, and summary. In addition, you may edit each of the vertex's coordinates independently if desired. 

If you have removed points from the polygon prior to editing, they will be replaced if you recreate the polygon (i.e. change point spacing, or respecify 
the polygon). Cosmetic changes, such as changing text color or text size, will not result in removed points being replaced. 

Each line segment in the polygon will be identified by its line number, and its beginning X, Y and Z coordinates. 

1. From the Modify menu choose Calculations - Edit, or from the Calculations toolbar select . 
2. Select the calculation polygon by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes. 

• To modify one or more of the line segments, click in the appropriate cell(s) and type in the new value(s). 

• To delete a line segment, click on the shaded cell to the left of the line number where the arrow is so that the entire row is highlighted, 
then press the [Delete] key on your keyboard. The selected segment will be permanently deleted. 

4. You may respecify the entire polygon by clicking the Re-Specify Polygon button. Two modification choices are provided: Manually Specify 
Polygon and Create Polygon from Drawing Entity, Room or Object. Depending on which choice is selected, different steps will be required once 
you click the Re-Specify Polygon button. You will be returned to the graphics window where the existing polygon will be visible as a reference. 
Specify the polygon vertices as required and right click when the polygon is complete. At this time, any other changes that were specified in the 
Edit dialog before the Re-Specify Polygon button was clicked will also be applied. You will not be returned to the Edit Polygon dialog. 
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Follow the steps below depending on the selected Creation Method: 

Specify a Polygon Manually Create Polygon from Drawing Entity, Room or Object  

i. Locate the first point of the polygon and click the left mouse 
button. 

ii. Move the cursor to the second vertex on the polygon and left 
click again. 

iii. Continue in this fashion until the polygon is complete. Right click 
to close the polygon shape. The Polygon grid will be created. 

iv. To change the polygon elevation, move the cursor into the Z-
Coord text box and enter a new value or use the up and down 
arrow keys on the keyboard, before clicking the first point. Locate 
the first point of the grid and click the left mouse button. 

i. Locate the pickbox on the drawing entity line, object or room 
boundary you wish to use and left click. 

ii. If a valid polygon is found (see Notes below), it will be displayed 
as a bold line, and the Polygon Search results dialog will appear: 

• Accept Polygon and Repeat - Grayed out during this operation - 
can only respecify one polygon at a time. 

• Accept Polygon - Create grid using selected entity as polygon 
boundary. 

• Reselect Entities - Choose this option if invalid polygon was 
found or if incorrect line was chosen. Use pickbox to select 
another closed polygon. 

• Manually Specify Polygon - Select vertices manually to specify 
polygon boundary, right clicking once all vertices are specified. 
This option is necessary if no valid polygon is found. 

• Cancel - Do not create calculation entity. 

Notes: 

• Drawing Entity line segments do not need to be joined, just need 
to be within tolerances (2 decimals of precision - .05) 

• Line segments do not need to make a closed polygon - AGi32 will 
automatically close boundary line 

• AGi32 filters related lines by color. 

Caveats: 

• Disconnected line segments or line segments disconnected by 
gap larger than tolerance level will not form valid polygon. 

• Polygons with intersecting lines will not form valid polygon. 

• Incomplete polygons are not valid, may close in an unacceptable 
manner. 

Edit Calculations Along A Line 

The Edit Calculation Lines dialog looks just like the original ‘Add’ calculation dialog, with the addition of the specified lines coordinates and the 
opportunity to add lines to the existing family. A “Family” of lines refers to all lines created under the same label. You may change the label, 
description, point spacing, text size, meter type, labeling and display options, and summary. In addition, you may edit each of the line's vertices 
independently if desired. 

A line may contain multiple segments and each will be identified by its line number and starting and ending X, Y and Z coordinates. You cannot add 
additional segments to an existing line, however you can add new lines (some of which may be tacked on to the end of another line) by clicking on 
the Add Lines button. 

If you have removed points from the line(s) prior to editing, they will be replaced if you recreate the lines (change point spacing, meter type, or modify 
the current coordinate locations). Making simple cosmetic changes, such as changing text color or text size, will not result in the recreation of the 
lines and the removed points will not be replaced. 

1. From the Modify menu choose Calculations -Edit, or from the Calculations toolbar select . 
2. Select one of the calculation lines in the desired family by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To respecify one or more of the lines vertices, click in the appropriate cell(s) and type in the new value(s). 

• To delete a line segment, click on the shaded cell to the left of the line number (the one with the arrow), so that the entire row is 
highlighted and press the [Delete] key on your keyboard. That segment will be permanently deleted. 

4. If no additional lines are required, click Ok to apply the changes and return to the graphics window. 
5. If additional lines are desired, click on the Add Lines button. You will be returned to the desktop and prompted to define the line (or lines). Once 

you have finished adding lines, click the right mouse button. Any other changes you selected in the Edit dialog before the Add Lines button was 
clicked will also be applied. You will not be returned to the Edit Lines dialog. 
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Edit Calculations - Scattered 

The Edit Scattered Calculation Points dialog looks just like the original ‘Add’ calculation points dialog, with the addition of the specified points 
coordinates and the opportunity to add points to the existing family. The term “Family” refers to all points under the same label. You may change the 
label, description, text size, meter type, labeling and display options, and summary. In addition, you may edit each of the point's coordinates and 
visibility independently if desired. 

Each point is identified by its point number, current X, Y and Z coordinates and visibility status. By default, all points are visible (On), unless 
otherwise specified in the Status cell or collectively in Project Manager. 

1. From the Modify menu choose Calculations -Edit, or from the Calculations toolbar select . 
2. Select one of the calculation points in the desired family by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes. 

• To respecify one or more of the point's coordinates, click in the appropriate cell(s) and type in the new value(s). 

• To change the visibility of a point, click the appropriate radio button (On or Off) in the Status cell. 

• To delete a point, click on the shaded cell to the left of the point number where the arrow is, so that the entire row is highlighted, then press 
the [Delete] key on your keyboard. That point will be permanently deleted. 

4. If additional points are desired, click on the Add Points button. You will be returned to the desktop and prompted to locate the point (or 
points). Once you have finished adding points, any other changes that were made in the edit dialog before clicking the Add Points button 
will also be applied. You will not be returned to the Edit Scattered Points dialog. 

5. Click Ok. 

Edit Roadway Luminance Calculation Points 

The Edit Roadway Luminance dialog looks just like the original ‘Add’ calculation dialog, with the addition of the specified grid coordinates and the 
opportunity to respecify the grid. You may change the label, description, point spacing, text size, R-table, calculation types, observer type, summary, 
labeling and display options, elevation coordinates or respecify the grid's location and extents. 

If you have removed points from the grid prior to editing, they will be replaced if you recreate the grid (change point spacing, observer, or respecify 
the grid). Cosmetic changes, such as changing text color or text size, will not result in removed points being replaced. 

1. From the Modify menu choose Calculations -Edit, or from the Calculations toolbar select . 
2. Select the calculation grid by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes. You have two options when respecifying the grid: 

• In the Specified Grid section, you can change the current X, Y and/or Z coordinates. 

• Click on the Respecify Grid button to specify the 3 input points of the grid in the graphics window. You will not be returned to the Edit Grid 
dialog after specification. 

4. Click Ok. 

Editing Calculation Point Labels 

Calculation point Labels may be edited to switch them off or to change their displayed content, text size, or font style. 

1. From the Modify menu choose Calculations -Edit, or from the Calculations toolbar select . 
2. Select the calculation entity by moving the pickbox cursor over it and clicking the left mouse button. 
3. Click the Labeling button and make the desired changes. 

4. Click Ok. 

Moving Calculation Points - Concepts 

Moving Calculation Entities is similar to moving other entities in AGi32. When Calculation Entities are moved, any text labeling that had been 
previously moved will be returned to its original position. 

Calculation Entities placed with Automatic Placement, that are associated with Rooms, Buildings or Objects may not be moved from their predefined 
locations. You can Edit these points to change their point spacing and centering options if you wish. 
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Moving Calculation Points 

The Move Calculation Points command moves entire definitions of calculation points (grids, lines, polygons, etc.) from one location to another. 
Calculations with many points will be replaced with a cube surrounding the selection's extents, in order to facilitate the move. If the selected 
calculation has related points associated with it, such as glare rating grids, those will be moved as well. 

For Example, if you select a grid that has two observer positions (3 grids of points total), all 3 grids will be moved along with the observer points. 

1. From the Modify menu choose Calculations -Move, or from the Calculations toolbar select . 
2. Select the calculation entity by moving the pickbox cursor over it and clicking the left mouse button. 
3. Locate the base point to move the calculation from and click the left mouse button. 
4. Drag the calculation to the desired location and left click again. 

Modifying Calculation Point Labels - Concepts 

Text Labels can be added to Calculation entities to identify Calculation attributes (such as Label, reflectance, coordinates, etc.) using the Labeling 
button in the Calculation Points dialogs. Labels may be added to Calculation Entities in the original Add dialog, when the Calculation Entity is initially 
specified, or after the Calculation Entity is created, in the Edit dialog. 

Calculation Points Labels are dynamic. If the Calculation Entity properties are modified and a Calculation Point Label is selected that references this 
attribute (e.g. Meter Orient and Tilt), the label will automatically update when the attribute changes. 

Once a label is created, it may be moved or deleted as desired. Moving individual labels may be advantageous as the label may interfere with other 
data on the drawing. 

Calculation Entity Labels may be removed in two ways. On an individual basis, they can be deleted one at a time. To remove all labels from the 
Calculation Entities, deselect the labels used by Editing the Calculation Entity and clicking the Labeling button. 

Text labels cannot be separated into separate lines. First, Point, Each Point, Each Line and Observer Position Labels are placed together as a 
paragraph and are moved and deleted as such. 

Deleting Calculation Point Labels 

Calculation Point labels may be deleted on an individual basis to improve the visual clarity of the presentation. To remove all labels from the 
calculation entity, deselect the labels used by Editing the calculation grid and clicking the Labeling button. 

1. From the Modify menu choose Calculations -Label-Delete, or from the Calculations toolbar select . Left click on the pull-down arrow to 
the right of the button to invoke the secondary menu. Select Delete. 

2. Select the label by moving the pickbox cursor over it and clicking the left mouse button. 
3. Right click the mouse or press [ENTER] on the keyboard to confirm your selection and delete the label. 

Moving Calculation Point Labels 

You may move the calculation point label located at the first point, each line, or observer position from its original position to any other location. You 
may not move the labels located at each point. 

1. From the Modify menu choose Calculations -Label-Move, or from the Calculations toolbar select . 
2. Select the label by moving the pickbox cursor over it and clicking the left mouse button. 
3. Locate the base point of the label (the point you want to move from) and left click. 
4. Drag the label to the new location and left click again. 

Note: If the associated calculation grid is edited, the labels will reset to their original locations. 

Removing Points - Concepts 

AGi32 provides the ability to remove points from a calculation entity (grid, polygon, lines, etc.) so that they are no longer considered in the numerical 
analysis. Obstructed points should be removed from calculation consideration as not to negatively effect the average and minimum calculation 
values, and their respective ratios. Calculation points may be removed individually with the Single selection option or in multiples with the Window or 
Polygon options. Additionally, you may use the footprint boundaries of existing surfaces (Rooms, Buildings and Objects) as selection boundaries to 
remove the points within these Entities. 

Calculations must be visible and unlocked in Project Manager to have points within their boundaries removed. 

The Remove Points command is not undoable. Use the Replace Points command to replace the removed points. 
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Each of the Remove Points command options is an exclusionary option. This means that all points within the selection boundary will be removed, 
points outside the selection boundary will remain in their original locations.  

Note: Only points with their insertion points (Mark Point) inside or on the boundary line are removed. If only the numerical value (or ? if uncalculated) 
is enclosed, the calculation point will not be removed. Remember, the actual light meter position is slightly above and to the left of the numerical 
value. To see the exact point locations, enable the Mark Points option when specifying the calculation entity. The large dot indicating each point 
location must be inside the polygon to be removed. 

Removing Points Within Entities 

Only the X, Y coordinates are used to determine inclusion within the Entity boundary. If your selected entity has varying Z coordinates (such as a 
Polygon-Vertical Extrusion Object), the Z coordinates are not taken into consideration. All points within the X and Y bounding box will be removed, 
even if they are outside of the real physical location. 

Removing Calculation Points 

This command allows you to remove individual calculation points from a calculation (grid, surface, scattered, lines, polygon, object). Removed points 
are no longer considered in the calculations. Removed points can be replaced back into the calculation at any time and calculated. When removing 
points using the Polygon or Under Entities option, all points inside the boundary are removed. 

What do you want to do? 

Remove points using a polygon 

The polygon option is used to remove points within a user-defined boundary. During specification of the polygon, it is possible to undo the polygon 
vertexes by selected the Undo button on the main toolbar or by pressing Ctrl-Z. 

1. From the Modify menu choose Calculations -Remove Points-Polygon, or from the Calculations toolbar select . 
2. Locate the first vertex of the polygon and click the left mouse button. 
3. Drag the cursor to locate the second vertex of the polygon and click the left mouse button. 
4. Continue until all of the vertices have been specified. 
5. Right click the mouse or press [ENTER] on the keyboard to close the polygon and remove the points within. 

Remove points using a window 

The window option is used to remove points bounded by a user-defined rectangle. 

1. From the Modify menu choose Calculations -Remove Points-Window, or from the Calculations toolbar select . Left click on the pull-
down arrow to the right of the button to invoke the secondary menu. Select Window. 

2. Locate the first corner of the window and click the left mouse button. 
3. Drag the cursor to the opposite window corner and click the left mouse button. The points within the window will be removed. 

Remove single points 

1. From the Modify menu choose Calculations -Remove Points-Single, or from the Calculations toolbar select . (hold down the button for 
a moment to bring up the secondary menu and select Single). 

2. Locate the insertion point of the desired calculation point with the pickbox cursor and click the left mouse button. 
3. Continue selecting points in this fashion, if desired. 
4. Right click the mouse or press [ENTER] on the keyboard to confirm your selections and remove the selected points. 

Remove points under entities 

This option is used to remove points within the X-Y perimeter of a user selected entity or entities. Calculation points are removed within or under the 
entity footprint (in Plan View) regardless of their own or the entity’s Z coordinates. 

Note: Points cannot be removed under Odd-Vertical Extrusion objects, as the "base of the object is defined as the vertical surface, not the bottom. 

1. From the Modify menu choose Calculations -Remove Points-Under Entities (Single, Window or All), or from the Calculations toolbar select 

. Left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select Under Entities – Single, Window or All. 
2. Select the entity(ties) that contains the points you wish to remove. 
3. If the Single option was selected, you may continue selecting entities that contain calculation points you wish to remove. 
4. Right click the mouse or press [ENTER] on the keyboard to confirm your selections and remove the points within. 
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Replacing Points - Concepts 

You may replace any previously removed points with this command. Calculation points may be replaced individually with the Single option, in 
multiples with the Window option, or All at once. 

Once the command is selected, all removed points are displayed using the Temporary On Color specified in the System Settings dialog. 

Replacing Calculation Points 

The Replace Calculation Points command replaces calculations points previously removed with the Remove Points command. 

What do you want to do? 

Replace individual points 

1. From the Modify menu choose Calculations -Replace Points-Single, or from the Calculations toolbar select . 
2. All of the previously removed points will reappear and be displayed using the Temporary On color specified in the Defaults tab of the System 

Settings dialog. By default, this color is red. 
3. Locate the calculation point with the pickbox cursor and click the left mouse button. The point will change color using the Selected Entity color 

specified in the Defaults tab of the System Settings dialog to indicate its selection. By default, this color is dark gray. 
4. Continue selecting points in this fashion, if desired. 
5. Right click the mouse or press [ENTER] on the keyboard to confirm your selections and replace the selected points. 

Replace points with a window 

1. From the Modify menu choose Calculations -Replace Points-Window, or from the Calculations toolbar select . Left click on the pull-
down arrow to the right of the button to invoke the secondary menu. Select Window. 

2. All of the previously removed points will reappear and be displayed using the Temporary On color specified in the Defaults tab of the System 
Settings dialog. By default, this color is red. 

3. Locate the first corner of the window and click the left mouse button. 
4. Drag the cursor to the opposing window corner and left click again. The points within the window frame will change color using the Selected 

Entity color specified in the Defaults tab of the System Settings dialog to indicate their selection. 
5. Right click the mouse or press [ENTER] on the keyboard to confirm your selections and replace the selected points. 

Replace all removed points 

1. From the Modify menu choose Calculations -Replace Points-All, or from the Calculations toolbar select . Left click on the pull-down 
arrow to the right of the button to invoke the secondary menu. Select All. 

2. Right click the mouse or press [ENTER] on the keyboard to replace all of the removed points. 

Note: This command cannot be undone. Points that were erroneously replaced must be removed again with the Remove Points command.  

  

 Modify Statistical Areas                                                                

Modifying Statistical Areas - Concepts 

Once created, Statistical Areas can be modified in three ways within Model Mode: you may Delete the Statistical Area, you may Edit the Statistical 
Area or you may move the text label of the Statistical Area from one location to another. 

Deleting Statistical Areas 

Statistical Areas may be deleted on an individual basis, in multiples or all at once. The calculation points underlying the Statistical Area are not 
removed. 

Project Manager 

Statistical Areas may also be deleted in Project Manager on an individual basis or collectively if desired. 

Editing Statistical Areas 
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Once a Statistical Area has been created, you may find it necessary to modify the quantity summarized or the text label applied. This is easily done 
by editing the Statistical Area. 

Only the information associated with the Statistical Area many be changed. You cannot respecify the polygon boundary for this command. If you 
need to change the boundary shape, you must delete the Statistical Area  and recreate it. 

Summarize Project - Statistical Areas can look across All Projects within their boundary or be linked to a particular one. This option is very valuable 
if you have broken your job file into multiple projects for management or analysis purposes. Otherwise, retain the default option (All Projects). 

Values Type to Summarize - Each Statistical area references a particular calculation type to summarize (e.g. illuminance or exitance). Statistical 
Areas can only summarize on quantity at a time. Selecting a Value Type that doesn't exist in the boundary will result in no summary. 

Move Label 

Statistical Area labels can be moved from their default locations. Statistical Area Labels are located adjacent to the first point selected when creating 
the Statistical Area polygon. The bottom line of the Statistical Area text label is attached to this point. 

Related Topics 

Add Statistical Area 

Project Manager 

  

Modifying Statistical Areas 

Once located, statistical areas can be easily edited, deleted or have their label moved to another location. The statistical area itself cannot be moved 
or have its shape changed in any way. 

What do you want to do? 

Edit a statistical area 

Delete a statistical area 

Move the label of a statistical area to another location 

Editing Statistical Areas 

When you select a statistical area to edit, the original Statistical Area dialog is recalled. You may change the label, description, project 
summary,numeric summary options, labeling options, font and text size. 

1. From the Modify menu choose Calculations-Statistical Area-Edit, or from the Calculations toolbar select . 
2. Select the statistical area by moving the pickbox cursor over the boundary line or label and click the left mouse button. 
3. Make the desired modifications. 
4. Click Ok.  

Deleting Statistical Areas 

Statistical areas can be deleted individually, in multiples using a selection window or all at once. 

1. From the Modify menu select Calculations -Statistical Area-Delete, or from the Calculations toolbar select . Left click on the pull-down 
arrow to the right of the button to invoke the secondary menu to choose multiple select options - Window or All.. 

2. Select the statistical area(s) to delete by locating the pickbox over the boundary line or on the label and clicking the left mouse button. 
3. If the Single selection option method was chosen, you may continue selecting statistical areas individually. 
4. Press ENTER (right mouse click) to verify your selections and delete. 

Moving Statistical Area Labels 

Statistical Area labels may be moved from their original location to any other location as necessary. 

1. From the Modify menu choose Calculations -Statistical Area-Move Label, or from the Calculations toolbar select . Left click on the 
pull-down arrow to the right of the button to invoke the secondary menu. Select Move Label. 

2. Locate the Statistical Area label and left click on it. 
3. Specify the reference point (where to move the label from) by left clicking at the desired location. 
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4. Drag the label to the new location and left click again.  

Modifying LPD/UWLR Areas 

Modifying LPD/UWLR Areas - Concepts 

Once created, LPD/UWLR Areas can be modified in three ways within Model mode: you may Delete the LPD/UWLR Area, you may Edit the 
LPD/UWLR Area or you may move the text label of the LPD/UWLR Area from one location to another. 

Deleting LPD/UWLR Areas 

LPD/UWLR Areas may be deleted on an individual basis, in multiples or all at once. The luminaires underneath the LPD/UWLR Area are not 
affected. 

Project Manager 

LPD/UWLR Areas may also be deleted in Project Manager on an individual basis or collectively if desired. 

Editing LPD/UWLR Areas 

Once a LPD/UWLR Area has been created, you may find it necessary to modify the information summarized or the text label applied. This is easily 
done by editing the LPD/UWLR Area. 

Only the information associated with the LPD/UWLR Area many be changed. You cannot respecify the polygon boundary for this command. If you 
need to change the boundary shape, you must delete the LPD/UWLR Area  and recreate. 

Summarize Project - LPD/UWLR Areas can look across All Projects within their boundary or be linked to a particular one. This option is very 
valuable if you have broken your job file into multiple projects for management or analysis purposes. Otherwise, retain the default option (All 
Projects). 

Move Label 

LPD/UWLR Area labels can be moved from their default locations. LPD/UWLR Area Labels are located adjacent to the first point selected when 
creating the LPD/UWLR Area polygon. The bottom line of the LPD/UWLR Area text label is attached to this point. 

Related Topics 

Add LPD/UWLR Area 

Project Manager 

  

Modifying LPD/UWLR Areas 

Once an LPD/UWLR Area has been specified, it can be modified to display more, or less, descriptive information within the Label, move the Label, or 
delete it altogether. 

What do you want to do? 

Edit an LPD/UWLR Area 

Move the Label of an LPD/UWLR Area 

Delete an LPD/UWLR Area 

  

Editing an LPD/UWLR Area 

LPD/UWLR Areas can be edited to change the parameters considered within their boundaries. Options available include: Perimeter, Area, Total 
Watts, Lighting Power Density and Upward Light Waste Ratio, as well as Label, Description and Project. 

1. From the Modify menu choose Calculations -LPD/UWLR Area-Edit, or from the Calculations toolbar select . 
2. Locate the LPD/UWLR Area and left click on the polygon or its label. 
3. Make the desired modifications in the LPD/UWLR Area dialog box. 
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4. Click Ok. 

  

Deleting an LPD/UWLR Area 

LPD/UWLR  Areas are removed from the job file with this command. Multiple selection options are available: single selection, multiple selection 
through a Window, or All LPD/UWLR Areas at once. 

1. From the Modify menu choose Calculations -LPD/UWLR Area-Delete Single, Window or All, or from the Calculations toolbar select . 
Left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select the selection filter- Single, Window or All.. 

2. Locate the LPD/UWLR Area and left click on the polygon or its label. 
3. Press ENTER (right mouse click) to verify your selection and delete the LPD/UWLR Area. 

  

Moving an LPD/UWLR Area Label 

An LPD/UWLR Area Label can be moved from one location to another, for increased legibility when required. 

1. From the Modify menu choose Calculations -LPD/UWLR Area-Move Label, or from the Calculations toolbar select . Left click on the 
pull-down arrow to the right of the button to invoke the secondary menu. Select Move Label. 

2. Locate the LPD/UWLR Area and left click on the label. 
3. Specify the reference point (where the label is being moved from). 
4. Drag the label to the new location and left click again. 

  

  

Modify Drawing Entities 

Arraying Drawing Entities - Concepts 

Individual entities, blocks or multiple selections of drawing entities can be duplicated in a uniformly spaced fashion in a copying method called Array. 
A Rectangular arrays create rectilinear, three dimensional duplication sets that are specified with X, Y and Z quantities and spacings. An array is an 
enormous time saver when it is necessary to create repetitive elements such as lines, circles, text and more. 

Rectangular Arrays 

Rectangular Arrays are created by specifying three criteria types; Number of entities, Spacing of entities and Array Angle. 

Number of Entities in X, Y or Z Direction - Indicates the total number of entities in the stated direction, including the original, after the array is 
created. There will always be at least one entity in each direction. 

Spacing in X, Y or Z Direction - Indicates the distance between entities, from start of one entity to start of another, in the stated direction. Units are 
specified using the current Display Unit, Feet or Meters. A spacing of zero is equivalent to no entities arrayed in stated direction. 

Array Angle (X Direction) - Indicates counterclockwise rotation of array from due East or zero degrees horizontal in world coordinates. The 
orientation of the entities in the array will be identical to the original. Spacing between entities in an angled array will be measured along the direction 
of the array, not parallel to the Cartesian axis. 

Arraying Drawing Entities 

You may duplicate a single drawing entity or selection of drawing entities in a rectangular array. From the Array dialog box specify the number of 
copies in the X, Y, an Z direction and the spacing between them. Two dimensional arrays are the most common, in this case the number of 
occurrences in the Z direction is one. 

What do you want to do? 

Create A Rectangular Drawing Entity Array 

1. From the Modify menu select Drawing -Array, or from the Drawing/Schedules Toolbar select . 
2. To select multiple entities, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select Window or All. 
3. Select the entity(ies) to be arrayed. 
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4. Enter the number of copies in each direction. 
5. Specify the spacing between copies in each direction. 
6. Click Ok. 

Create A Rotated Rectangular Drawing Entity Array 

1. From the Modify menu select Drawing -Array, or from the Drawing/Schedules Toolbar select . 
2. To select multiple entities, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select Window or All. 
3. Select the entity(ies) to be arrayed. 
4. Enter the number of copies in each direction. 
5. Specify the spacing between copies in each direction. 
6. Enter the angle by which you want to rotate the array counterclockwise from the X axis. 
7. Click Ok. 

Copying Drawing Entities - Concepts 

The Copy Drawing Entity command duplicates drawing entities in the graphics area. You may copy a Single entity, multiple entities in a user-defined 
Window or select All entities. Text may also be copied in this manner. 

Once the duplicate entities have been created, each copied entity can be modified independently. Each new copy has the same attributes as the 
original (color, line type, text size, etc.). 

Copying large blocks of drawing entities (lines, rectangles, text, etc.) 

When copying large blocks of drawing entities, the grouping may appear as a large rectangle representing the limits of the selected entities. This is 
done to facilitate movement without sacrificing refresh times. If you find the rectangle difficult to work with, you can increase the number of entities 
allowed before the rectangle is displayed by increasing the Ghost Image - Number of Entities Cutoff parameter in Advanced System Settings. 

Copying Drawing Entities 

To copy drawing entities within a job file, first select the entities to be copied, then select a reference point to copy from and an endpoint for the copy. 
These points are called the base point and the new location point, respectively, and can be anywhere within the drawing. The two points define a 
displacement vector that indicates the distance the selected objects are to be copied and their relative direction. 

To copy a selection of drawing entities: 

1. From the Modify menu select Drawing -Copy, or from the Drawing/Schedules Toolbar select . 
2. To select multiple entities, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select Window or All. 
3. Select the entities to be copied. 
4. Select the point to copy from (the base point) with the mouse. 
5. Move the cursor to the new location point. 
6. Continue inserting copies or press ENTER (right mouse click) to end the command.   

Creating Blocks - Concepts 

AGi32 uses blocks to help you organize and manipulate several individual drawing entities as one single drawing entity. Simply, a block is a 
collection of drawing entities and/or text you can associate together to form a single object, or block definition. Internally, all blocks are stored in units 
of Feet, although they are scaled automatically according to the current units type. Once created you can insert, scale, and rotate the block in your 
job file. In addition, you can explode a block into individual entities, modify them, and redefine the block. AGi32 will insert all future occurrences of 
that block based on the updated block definition. 

Blocks are very useful because they streamline the drawing process. 

Blocks usage: 

Build a library of frequently used objects. You can insert the same block numerous times instead of re-creating the drawing elements each time. 

Build job files more productively by inserting, moving, and copying blocks as singular objects rather than manipulating a selection of drawing entities. 

Blocks are global entities. In other words, they may be referenced from any job file no matter where or when they were created. 
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Create A Block 

The Create Block commands saves a selection of drawing entities as one block to be recalled in future job files. All drawing entities, except 
schedules may be included in the block definition. Imported CAD files may also be saved as blocks in AGi32 (title blocks and borders are good 
examples). 

To create a block of drawing entities: 

1. From the Modify menu select Drawing -Create Block, or from the Drawing/Schedules Toolbar select . 
2. To select multiple entities, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select Window or All. 
3. Select the entities to be defined as a block. 
4. Select or enter the coordinates of the insertion point. 
5. Enter a unique block name. 
6. Click Ok. The Block Manager will automatically appear allowing you to insert this, or any other, block. 

Create Model Luminaire Symbol - Concepts 

This command allows you to create custom luminaire symbols used in Model mode from drawing entities. Model luminaire symbols may be two-
dimensional or three-dimensional depending on the graphic symbol you wish to represent. For example, you may wish to represent a floodlight 
luminaire with an arrow instead of the physical representation of the luminaire. You may use the drawing entity tools provided in AGi32 or use 
symbols from a CAD file that you have imported. In either case, symbols should be created using a reasonable size, since the user can change the 
Scaling Factors of symbols as necessary. Luminaire symbols that are larger than 8’ x 8’ may overrun the display section in the Luminaire Symbols 
dialog. 

The current drawing properties (line type, line width and color) are not maintained 
with the symbol. The user can specify these properties when selecting the symbol 
from the Luminaire Define dialog. 

We recommend that you store user-defined symbols in the Custom Symbols 
folder, or one of your own, so that you may share your symbols with other users. 
This is accomplished by copying these folders into their AGi32\Symbols folder. 
You cannot overwrite any luminaire symbols found in the General folder (i.e., the 
Symbols folder) but you can overwrite symbols found in any other folder. 

When creating the Model luminaire Symbol using AGI32’s drawing tools, you may 
wish to create the symbol using a grid template. We have provided one for you in 
the Sample Files folder named Symbols Template. This template consists of a web 
of grid lines one foot apart that you can use for reference when drawing your 
symbols. The template is shown to the right with a sample Model symbol. 

  

  

  

  

  

Create Model Luminaire Symbol 

The Create Model Luminaire Symbol provides the ability to create Model Luminaire Symbols from drawing entities you have previously created in 
AGi32 or use drawing symbols from CAD files imported in AGi32. 

To create a Model luminaire symbol: 

1. Draw the symbol using AGI32’s drawing tools or import a CAD file containing the desired symbol. 

2. From the Modify menu select Drawing -Create Model Luminaire Symbol, or from the Drawing/Schedules Toolbar select . 
3. Select Single, Window or All. Click on the arrow adjacent to the Create Model Luminaire Symbol button to select Window or All. 
4. Select the entities to include in the symbol. 
5. Specify the insertion point of the symbol that corresponds to the luminaire insertion point. This point can be 0,0 or any other point that is 

appropriate. 

6. Enter the symbol name in the Symbol Name text box. We recommend using short symbol names so that they display well in the Symbol dialog. 
7. Select the folder to save the symbol file in or click the New Folder button to create a new folder. 
8. Click Ok. 
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Deleting Drawing Entities - Concepts 

The Delete Drawing Entity command provides the ability to remove drawing entities from the job file in a Single, Window or All selection method. You 
may choose to delete drawing entities that were created with AGi32 drawing tools or from imported CAD backgrounds. 

Project Manager 

AGi32's Project Manager dialog also provides removal capabilities for drawing entities collectively. in addition, it provides a very simple way of 
removing imported CAD files in their entirety or layer by layer. 

Deleting large blocks of drawing entities (lines, rectangles, text, etc.) 

When deleting large blocks of drawing entities, the grouping may appear as a large rectangle representing the limits of the selected entities. If you 
find the rectangle difficult to work with, you can increase the number of entities allowed before the rectangle is displayed by increasing the Ghost 
Image - Number of Entities Cutoff parameter in Advanced System Settings. 

When deleting drawing entities in Isometric View, large blocks may appear as a cube instead of a rectangle. 

Deleting Drawing Entities 

This command provides the ability to delete drawing entities (including schedules). 

1. From the Modify menu select Drawing -Delete, or from the Drawing/Schedules Toolbar select . 
2. To select multiple entities, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select Window or All. 
3. Select the entities to be deleted. 
4. If the Single selection option method was chosen, you may continue selecting entities to delete. 
5. Press ENTER (right mouse click) to verify your selections and delete.  

Exploding Drawing Entities - Concepts 

The Explode Drawing Entity command allows you to explode multi-piece drawing entities (like blocks), multi-segmented drawing entities (such as 
circles), and multi-lined text pieces into single pieces. 

• Multi-piece drawing entities are exploded into individual entities such as text, lines, etc. By exploding a block occurrence, you can modify the 
block, or add to or delete the objects that define it. 

• Multi-segmented entities such as circles and arcs are exploded into individual line segments. The quantity and size of the line segments is 
determined by the Initial Curve Increment in the Advanced System Settings dialog.  

• Multi-lined text paragraphs are exploded into individual lines. 

Exploding Drawing Entities 

Use the Explode Drawing Entity command to explode groupings of drawing entities into their individual components, such as lines and text. 

To explode a selection of drawing entities: 

1. From the Modify menu, select Drawing -Explode, or from the Drawing/Schedules Toolbar select . 
2. Select Single, Window or All. Click on the arrow adjacent to the Explode button to select Window or All. 
3. Select the entities to be exploded. 
4. If the Single selection option method was chosen, you may continue selecting entities to explode. 
5. Press ENTER (right mouse click) to verify your selections and end the command.  

Moving Drawing Entities - Concepts 

The Move Drawing Entity command allows you to move drawing entities and text in the current job file.  

Moving large blocks of drawing entities (lines, rectangles, text, etc.) 

When moving large blocks of drawing entities, the grouping may appear as a large rectangle representing the limits of the selected entities. This is 
done to facilitate movement without sacrificing refresh times. If you find the rectangle difficult to work with, you can increase the number of entities 
allowed before the rectangle is displayed by increasing the Ghost Image - Number of Entities Cutoff parameter in Advanced System Settings. 

When moving drawing entities in Isometric View, large blocks may appear as a cube instead of a rectangle. 
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Moving Drawing Entities 

To move drawing entities, specify the selection set, a starting point and endpoint. These points are called the base point and the new location point, 
respectively, and can be anywhere within the drawing. The two points define a displacement vector that indicates the distance the selected objects 
are to be moved and their relative direction. 

Schedules can be moved like all other Drawing entities. 

To move a selection of drawing entities: 

1. From the Modify menu select Drawing -Move, or from the Drawing/Schedules Toolbar select . 
2. Select Single, Window or All. Click on the arrow adjacent to the Move button to select Window or All. 
3. Select the entities to be moved. 
4. Select the point to move from (the base point) with the mouse. 
5. Move the cursor to the new location point. 

Modifying Drawing Entity Properties - Concepts 

The line type and color properties associated with every drawing entity in AGi32 may be changed with this command. The style of line, or line type, 
can be set to five different styles: solid, dash, dot, dash-dot and dash-dot-dot. The solid style is available in various line thicknesses. 

The Properties and Line Type dialog save and recall settings separately for Model and Page Builder modes. Each mode is independent of the other.  

You can set the color of the drawing entities you create to help distinguish them from other drawing entities. When you print or plot your job file to a 
color printer or plotter, these colors will become part of the presentation. 

Modifying Drawing Entity Properties 

The Modify Drawing Entities Properties command provides the ability to change the color of drawing entities and text as well as the line type of 
drawing entities. 

What do you want to do? 

Change a drawing entity line type 

1. From the Modify menu select Drawing -Properties, or from the Drawing/Schedules toolbar select . 
2. Select Single, Window or All. Click on the arrow adjacent to the Modify Properties button to select Window or All. 
3. Select the entities whose properties are to be modified. 
4. If the Single selection method is chosen, you may continue to select entities until ENTER (right mouse click) is pressed. 
5. Click in the line type graphic in the Properties dialog box. 
6. Select the desired style and/or line thickness in the Line Type  dialog box. 
7. Click Ok to return to the Properties dialog box. 
8. Click Ok. 

Change a drawing entity color 

1. From the Modify menu, select Drawing -Properties, or from the Drawing/Schedules toolbar select . 
2. Select Single, Window or All. Click on the arrow adjacent to the Modify Properties button to select Window or All. 
3. Select the entities whose properties are to be modified. 
4. If the Single selection method is chosen, you may continue to select entities until ENTER (right mouse click) is pressed. 
5. Click in the color graphic in the Properties dialog box. 
6. Select the desired color in the Color  dialog box. 
7. Click Ok to return to the Properties dialog box. 
8. Click Ok. 

Make a line type current 

1. Click in the line type cell from the Drawing/Schedules toolbar. 
2. This will invoke the Line Type  dialog box. 
3. Select the desired style and/or line thickness. 
4. Click Ok. 

Make a color current 
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1. Click in the Line Color cell in the Drawing/Schedules toolbar. 
2. This will invoke the Color dialog box. 
3. Select the desired color. 
4. Click Ok. 

Rotating Drawing Entities - Concepts 

The Rotate Drawing Entity  command allows you to rotate drawing entities and text. Drawing entities may be rotated in any view, although in 
Elevation view, the entities are always rotated about the Y axis. 

Drawing entities can be rotated by choosing a base point and rotation angle in Plan View or about the Y Axis in Elevation View. The specified angle 
will rotate the selection from a 0-degree orientation around the base point by that angle. Whether the entities are rotated counterclockwise or 
clockwise depends on the sign of the rotation angle (+/-), + is counterclockwise, - is clockwise. The rotation angle may be specified by entering a 
numeric value or by dragging the mouse to the desired rotation angle. 

When rotating drawing entities in Elevation View, the entities are always rotated about the Y axis regardless of the selected Elevation View. We 
recommend selecting an Elevation View parallel to the X Axis (the 0 degree elevation rotation) to avoid confusion. To rotate drawing entities in other 
elevations, rotate the entities in Plan view to align the axis of rotation with the Y axis, then rotate in Elevation view. 

Example 

It is common to import 2D CAD files representing an Elevation View that were created in Plan View in the CAD program. In order to use this 
background intuitively, we need to rotate it so that it appears in Elevation View. This example illustrates how to do this. 

Step 1: 

Original DXF background 

 

Step 2: 

Rotate background in Plan View to align 
rotation axis with Y axis 

(90 degrees shown) 

 

Step 3: 

Elevation View taken parallel to X axis 

 

  

Step 4: 

Rotate background in Elevation View to 
desired angle (270 degrees shown) 

 

Step 5: 

Isometric View showing final background 
rotation 
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Rotating Drawing Entities 

Drawing entities and text may be rotated after their initial placement as required. 

To rotate a selection of drawing entities: 

1. From the Modify menu select Drawing -Rotate, or from the Drawing/Schedules Toolbar select . 
2. Select Single, Window or All. Click on the arrow adjacent to the Rotate button to select Window or All. 
3. Select the entities to be rotated. 
4. Select the point to rotate about (the base point). 
5. Drag the cursor to, or enter the coordinates of, the rotation angle. 

Scaling Drawing Entities - Concepts 

Drawing entities placed in AGi32 can be scaled to increase or reduce their overall size. The scaling factor is a multiplier applied to all dimensions 
equally. Single, Window or All selection methods are provided. 

Scaling Imported CAD files 

Drawings that are created in a CAD environment using drawing units of feet, inches or non-specific units (decimals, scientific, or fractions) may be 
imported into AGi32. It is very important that the CAD file be used at the correct scale so that the spatial relationship between all of the entities 
(luminaires, calculation points, objects, etc.) is correct. 

The Scale Drawing Entity command can be used to scale the background so that it is of a true size for lighting calculations. When prompted for the 
reference point, use the Origin coordinates (0,0,0) at all times. The Scaling Factor required is the ratio of known / measured (known length - true 
dimension of line / measured length in AGi32 (at incorrect scale)). 

Scaling Drawing Entities 

All drawing entities and text can be scaled up or down in size by entering the appropriate scaling factor. A scale factor greater than one enlarges the 
object. A scale factor less than one shrinks the object. All scaling will maintain the entity's aspect ratio. 

To scale a selection of drawing entities: 

1. From the Modify menu select Drawing -Scale, or from the Drawing/Schedules Toolbar select . 
2. Select Single, Window or All. Click on the arrow adjacent to the Scale button to select Window or All. 
3. Select the entities to be scaled. 
4. Select the point (base point) to scale about. 
5. In the Scale dialog box enter the desired scaling factor. For example, a scaling factor of two will double the size of the selection set about the 

base point. A scaling factor of 0.5 will reduce the size of the selection by half. 

Modifying Schedules - Concepts 

Once placed in the job file, schedules may be edited for content, deleted or moved as required. To move or delete schedules, use the appropriate 
Modify Drawing commands. 

Modifying Schedules 

Once a schedule is placed on the drawing, it may be edited, moved or deleted very easily. 

What do you want to do? 

Edit a schedule 

Delete a schedule 

Move a schedule 
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Editing Schedules 

A schedule may be edited at any time after it has been placed in the job file. You may change the current schedule type, description, project 
reference, layout, field lengths, style changes, font and text size. 

1. From the Modify menu select Drawing -Schedule-Edit, or from the Drawing/Schedules Toolbar select . 
2. Select the schedule to edit by locating the pickbox cursor over a gridline or piece of text and clicking the left mouse button. 
3. The Schedule dialog will appear with the selected schedule loaded. Make the desired changes and click Ok. 

Editing Text - Concepts 

The Edit Text command allows you to edit previously located text for content, text size, and text style. Text size and style are applied to the entire text 
selection as a whole (for example to the entire paragraph). if you would like to apply a certain text style or size to just one sentence, first explode the 
paragraph, then edit the sentence in question. It is not possible to explode sentences into individual words or characters. 

Change Font and Style 

Text size needs to be specified in scaled Feet or Meters depending on the current Display Units setting. An entry of 2 in the Text Size box will 
generate text 2 feet or meters tall. 

It is convenient to consider the text size used for calculation points as a benchmark when considering appropriate text size for other information. This 
information can be found in the Edit Calculation Point dialogs. 

Related Topics 

Text Size 

Editing Text 

When preparing a job file for presentation, it is often convenient to copy a particular piece of text to several locations and then edit its content. In 
addition, you may find it necessary to enlarge or decrease some text or change its font style in order to make the drawing more readable. These 
functions are available from the Edit Text dialog box. 

Note: Text contain within a drawing entity block may only be edited after the block is exploded. 

What do you want to do? 

Change or add words in a piece of existing text 

1. From the Modify menu select Drawing -Edit Text, or from the Drawing/Schedules Toolbar select . 
2. Select the desired text. 
3. In the Edit Text dialog box, insert the cursor at the desired insertion point. 
4. To type over existing text, drag the cursor over the existing text and begin typing. The new text will replace the existing text. 
5. To enter new text, begin typing at the desired insertion point. 
6. To delete text, drag the cursor over the desired text and press the Delete key. 
7. You may use the standard Windows™ Cut (Ctrl+X), Copy (Ctrl+C) and Paste (Ctrl+V) shortcuts within this dialog box. 
8. Click Ok. 

Change the text size of existing text 

1. From the Modify menu select Drawing -Edit Text, or from the Drawing/Schedules Toolbar select . 
2. Select the desired text. 
3. Enter the desired numeric value in the Text Size box. 
4. Click Ok. 

Change the style of existing text 

1. From the Modify menu select Draw -Edit Text, or from the Drawing/Schedules Toolbar select . 
2. Select the desired text. 
3. Click the Change button to invoke the Font dialog box. 
4. Make the desired changes in the Font dialog box and click Ok. 
5. Click Ok. 
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 Modify Luminaires 

Arraying Luminaires - Concepts 

Arraying luminaires provides a variation of the Copy Luminaire command where a fixed replication pattern is specified for each subsequent luminaire 
location. 

Rectangular Arrays 

Rectangular arrays specify subsequent luminaire locations in a 2D or 3D rectilinear pattern using dynamic spacings between a given number of 
luminaires or dynamic luminaire placement for constant spacing parameters. Use luminaire arrays whenever you need to create a linear or 
rectangular grid of luminaires Arrays can be diagonal just be specifying the Left-Right vertices at the desired angle. 

The array Quantity always includes the first luminaire. The array also includes at least one luminaire in all three dimensions- since each luminaire 
exists in all three dimensions. Quantity and Spacing are always entered as positive values. 

Rectangular Array - 1 Direction 

Rectangular Array: Set Spacing 10 Left to Right; 0 Top to Bottom; Initial luminaire location indicated in Red 

 

 

Rectangular Array: Set Spacing 10 Left to Right; 0 Top to Bottom; Initial luminaire location indicated in Red - Left to Right only indicates relative 
direction of 1st two vertices, there is no requirement to create an orthogonal array (parallel to the Cartesian coordinate axis) 

 

 

Rectangular Array - 2 Directions 

Rectangular Array:  
Set Quantity:  
5 Left to Right; 3 Top to Bottom; 
Luminaire Offset: Fixed Distance: 3 LR and 3 TB 
Resultant spacing based on vertices input and offset distance 
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Rectangular Array:  
Set Spacing:  
10 Left to Right; 0 Top to Bottom; Z-Direction - Quantity 3; Z Spacing 20 
Resultant Left to Right quantity based on vertices input 

 

 

 

Rectangular Array - 3 Directions 

Rectangular Array:  
Set Spacing:  
4 Left to Right; 70 Top to Bottom; Z-Direction - Quantity 2; Z Spacing 2 
Resultant Left to Right and Top to Bottom quantity based on vertices input 
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Rectangular Luminaire Arrays - Procedure 

Polar Arrays 

Polar arrays specify a luminaire pattern in a circular or semi-circular manner. Polar arrays work very well in circular spaces, such as rotundas and 
domes, when you need to create an evenly spaced circular pattern.  Inputs include the selected luminaire, array center (center of proposed circle or 
semi circle), number of luminaires and luminaire rotation. Unlike rectangular arrays which leave the luminaire aiming unchanged, you may choose to 
orient the luminaire towards, away from or perpendicular to the luminaire center. 

Polar arrays create a perfectly circular or semi-circular pattern. You may move luminaires apart from one another (for example to fit within an 
ellipsoidal shape) once the array is finished. 

The angle between the selected luminaire and the polar center indicates the Starting Angle of the polar array. To create a complete circle, enter this 
angle as the Ending Angle as well. 

Polar Arrays 

Luminaires can be duplicated along a circular or semi-circular path using the Modify-Luminaire-Polar Array command. The specification criteria 
includes Starting and Ending angles of the Array, center point, number of locations to be produced and luminaire orientation. The luminaire 
orientation can either be the same as the original, directed inward or outward from the array center, or perpendicular to the array center. 

Selection Point - When the Luminaire -Polar Array command is initiated, the cursor changes to a pickbox so that an individual luminaire, luminaire 
arrangement or luminaire group may be selected. The selection point always moves to the insertion point of the luminaire, regardless of the actual 
selection point. 

Array Center Point - Once the luminaire is selected, you are prompted for the location of the polar array center. The distance specified is the radius 
of the array and dictates the distance that each duplicate luminaire will be located from the array center. The angle between the selection point and 
the array center is the Starting Angle. This starting Angle may not be altered, so choose your center point deliberately. Tip: Polar Arrays are always 
created in a counter clockwise direction. 

Careful selection of the array center point will allow you to create symmetrical arrays or relatively abstract ones. 

Starting Angle - The Starting Angle of the array is determined by the angle formed between a line formed from selection point to array center and a 
line formed between array center to due East. This angle cannot be entered manually by the user, it is determined by the location of the selection 
point and the array center point. 
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Ending Angle - The Ending Angle of the array dictates the location of the last luminaire to be placed in the array. If the Ending Angle is equal to the 
Starting Angle the array will form a complete circle. In this case, there will be a luminaire placed at the Starting Angle but not the Ending Angle, 
otherwise two luminaires would occupy the same position. If the Ending Angle does not equal the Starting Angle, a luminaire is placed at both the 
Starting and Ending Angles.  

Number of Locations - This value indicates the total number of luminaires in the polar array, including the original luminaire. The total number of 
luminaires in the array must be two or more. 

Angle Increment - This value describes the angle between each pair of luminaires in the polar array. 

• If Starting Angle Does Not Equal Ending Angle - Angle Increment is calculated this way: (Ending Angle - Starting Angle) / (Number of Locations 
- 1) 

• If Starting Angle Equals Ending Angle - Angle Increment is calculated this way: (Ending Angle - Starting Angle) / (Number of Locations) 

Entity Orientation - Four selections are provided for luminaire orientation. 

• Same as Selected Entity - Indicates that all luminaires created in the array will be oriented the same as the original. 

• Same as Polar Angle (Orient away from center of array) - Indicates that all luminaires created in the array will be oriented away from the array 
center and in alignment with the displacement vector. 

• The Opposite of Polar Angle (Orient towards center of array) -  Indicates that all luminaires created in the array will be oriented towards the 
array center and in alignment with the displacement vector. 

• Perpendicular to Polar Angle (Orient perpendicular to center of array)-Indicates that all luminaires created in the array will be oriented 
perpendicular to center of array and the displacement vector. This option is best for linear luminaires placed in a round or circular position, such 
as a cove. 

 

Orientation - Same as Selected Entity 

 

Orientation - Same as Polar Angle (Orient away from center of array) 

 

Orientation - Opposite Of Polar Angle (Orient towards center of 
array) 

 

Orientation - Perpendicular To Polar Angle (Orient perpendicular to center 
of array) 

Polar Luminaire Arrays - Procedure 
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Rectangular Luminaire Arrays 

The Luminaire-Rectangular Array command allows you to create a uniform line or grid of luminaires in any direction using Dynamic or Static 
luminaire placement. The rectangular array is comprised of replicated luminaires or luminaire groups in the X, Y and Z directions.  

Polar Luminaire Arrays 

1. From the Modify menu choose Luminaire-Rectangular Array, or from the Luminaire toolbar select  
2. The Rectangular Luminaire Array dialog appears with tow tabs: Dynamic Array Placement and Static Array. The tab shown by default at the 

forefront is the Dynamic Array Placement.  
3. Dynamic Luminaire Placement: This tab allows the user to initialize the array by using an existing luminaire location or the current luminaire 

specification. 
o Select From Existing Location - This option allows the user to select an existing luminaire as the 1st luminaire in the array. The 

attributes (Label, MH, Aiming Parameters - Orient, Tilt, Roll and Spin) of the selected luminaire will be used for all subsequent 
luminaires in the array. 

� Note: You must Define and Locate a luminaire to use this option 

o Use Current Luminaire Specification (New Location) - This option allows the user to use the attributes (Label, MH, Aiming 
Parameters - Orient, Tilt, Roll and Spin) of the current luminaire specification on the Lum Define toolbar for all luminaires in the 
array. 

o  

� In this method, users may choose to Orient the luminaire relative to the array boundary direction, in lieu of using the current 
specified Orient angle. The following three Luminaire Orientation options are available: 

o Use Specified Orient – All luminaires in the array will use the current Orient specified in the Luminaire Define toolbar. 
o Parallel to Array (Along Left-Right) – All luminaires in the array will be oriented parallel to the array baseline (along the left-right 

boundary - equivalent to the 1st and 2nd vertices of the array). 
o Perpendicular to Array (Along Top-Bottom) – All luminaires in the array will be orientated perpendicular to the array baseline (along 

the top-bottom boundary of the array – equivalent to the 2nd and 3rd vertices of the array). 

Specified Orient Parallel to Array Perpendicular to Array 

 
  

Note: You must specify the current luminaire parameters before selecting the Array Luminaire command, attempting to specify the 
luminaire parameters after specify the array will cancel the command. 

o The Array Specification section prompts you to specify the Array Type and Offset from the boundaries (if any). 
o Select the Array Type - Set Spacing or Set Quantity: 

• Set Spacing - This option allows you to set a fixed spacing for the Left-Right and Top-Bottom boundaries of the array. Either 
spacing may be set equal to zero to create a one dimensional array (line) of luminaires. The Quantity specified in each 
direction will be dynamically displayed based on the specified boundaries and Offset parameters. Note: If the Top-Bottom 
Spacing = 0, AGi32 will only prompt you for vertices 1 and 2. If the Left-Right Spacing = 0, AGi32 will prompt you for all three 
vertices. 

• Set Quantity - This option allows you to set a fixed quantity for the Left-Right and Top-Bottom boundaries of the array. Either 
Quantity may be set equal to one to create a one dimensional array (line) of luminaires. The Spacing specified in each direction 
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will be dynamically displayed based on the specified boundaries and Offset parameters. Note: The Array Quantity always 
includes the 1st luminaire in the total count. 

o To add additional luminaires in the Z direction and create a three dimensional luminaire array, specify the Quantity and Spacing for the 
Z boundary. By default, only a single luminaire is created in each Z location making for a two dimensional array. 

o Specify the Luminaire Offset. Not all options are available for all Array selections: 
 

Offset Option Existing 
Location 

Current 
Specification 

Set 
Spacing 

Set 
Quantity 

No Offset Yes Yes Yes Yes 

Fixed Distance Not Available Yes Yes Yes 

Center - Relative to Array 
Boundaries 

Not Available Only For Set Spacing Yes Not Available 

 
� No Offset: - Luminaires are not offset relative to the first luminaire in the array or the array boundaries 
� Fixed Distance - Luminaires are offset left-right and top-bottom relative to the array boundaries. Offsets must be >=0 
� Center Luminaires - Luminaires are centered left-right or top-bottom or in both directions relative the array boundaries: 
� Centered left-right only – Luminaires are only centered left-to relative to the array boundaries. As a result, luminaires may end 

up on the array boundary lines (top and bottom) depending on the spacing and distance top-bottom. 
� Centered top-bottom only - Luminaires are only centered top-to-bottom relative to the boundaries. As a result, luminaires may 

end up on the array boundary lines (left and right) depending on the spacing and distance left-right. 
� Centered in both directions – Luminaires are centered in both directions. No luminaires will be located on the array boundaries. 
 
 
 

Set Spacing: 5 Left to Right; 5 Top to Bottom 
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Set Quantity: 3 Left to Right; 3 Top to Bottom 

 
 

o Click Ok. 
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o If Select From Existing Location was chosen, select the 1st luminaire in the array. Otherwise, click the first vertex of the array boundary. 
Hint: If no Offset was specified, this is the location of the 1st luminaire in the array. 

o Click the second vertex of the array boundary.  
o Click the third vertex of the array boundary (not necessary if Top-Bottom Spacing = 0 in Set Spacing section). 
 

4. Static Array: This tab allows the user to apply rectilinear array settings to an existing luminaire location. 
o Enter the quantity and spacing  in each primary X, Y and/or Z direction. The total quantity must include the original luminaire in each 

set. For example if you wish to create three additional luminaire locations, spaced 10 feet apart in the X direction, the array quantity 
would equal four. 

• Each luminaire in the array is a replica of the selected existing location (aiming parameters, MH, etc.) 

• Negative values may be entered for spacing values. Quantity values must be positive. 
o By default, the luminaire positions in array are created orthogonally, parallel to the X and Y axis. To rotate the entire array at some 

angle offset from the X axis (due East equaling zero), entire the array angle in theArray Angle text box. 
o Click Ok. 
o Select the luminaire to use as the starting point for the array. 

Polar Luminaire Arrays 

The Luminaire-Polar Array command allows you to create a circular or angular arrangement of luminaires about a rotational axis. Each luminaire in 
the array exhibits the same attributes as the original luminaire and can be modified independently. 

1. From the Modify menu choose Luminaire-Polar Array, or from the Luminaire toolbar select . Left click on the pull-down arrow to the 
right of the button to invoke the secondary menu. Select Polar. 

2. Select a luminaire to array. 
3. Drag the cursor to the center point of array and click the left mouse button. 
4. In the Polar Array dialog, specify the ending angle. 
5. Specify the total number of luminaire locations in the array including the original. 
6. Specify the luminaire orientation: same as selected entity , same as polar angle, opposite of polar angleor perpendicular to polar angle. The 

selected luminaire will also be rotated if necessary to match the selected luminaire orientation. 
7. Click Ok. 

Changing Luminaire Mounting Height - Concepts 

The Luminaire-Change Height command provides the ability to change the luminaire mounting height of a single luminaire, multiple luminaires, or All 
luminaires, with or without changing the associated aiming parameters. Two options are provided within the command - Same Aiming Angles or 
Same Aiming Point. 

The Same Aiming Angles option is intended for luminaires placed with the Static Aiming or Locate and Orient options and may be used in 
conjunction with luminaire groups or arrangements. This is the option most often required for most applications, such as site lighting, indirect lighting 
and many other applications.  

This option may also be used in conjunction with luminaires placed with Locate and Aim, with the aiming vector being recalculated as necessary. 

The Same Aiming Points option is intended for luminaires placed with the Locate and Aim option and is not available for luminaire groups or 
arrangements. Use this option, whenever you need to maintain an aiming point but requires an alternate mounting height. Consider this option with 
sports lighting, facade lighting, and other floodlighting applications. 

Selecting luminaires to filter for a particular Z coordinate 

Press the SHIFT key during the selection process to select luminaires located at the current Z coordinate. This can be very helpful when selecting 
stacked luminaires. Set the Z coordinate using the Page Up and Page Down keys on the keyboard. 

Changing Luminaire Mounting Height 

The Luminaire-Change Height command provides the ability to change the luminaire mounting height with or without changing the associated aiming 
parameters. Two options are provided within the command - Same Aiming Angles or Same Aiming Point. 

The Change Height-Same Aiming Angles command modifies the luminaire mounting height without affecting the aiming angles. The aiming points 
are relocated accordingly. For example, if a luminaire is tilted 45 degrees prior to applying the Mounting Height Change, the luminaire will remain 
tilted at 45 degrees afterwards. 

The Change Height-Same Aiming Points command modifies the luminaire mounting height and retains the same aiming points. The aiming angles 
are recalculated accordingly. For example, if a luminaire is aimed towards an object with an Aiming Point at Z=10, the luminaire will remain aimed at 
Z=10, after the Mounting Height Change is applied. 

Luminaire groups and luminaire arrangements must use the Change Height-Same Aiming Angles command due to multiple aiming points. 
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1. From the Modify menu choose Luminaire-Change Height-Same Aiming Angles or Same Aiming Points, or from the Luminaire toolbar 

select . To use Same Aiming Points, left click on the pull-down arrow to the right of the button to invoke the secondary menu. 
2. To select multiple luminaires, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select Window or All. 
3. Select the luminaire(s) to change. 
4. Enter the new mounting height in the Change Height dialog box. 
5. Click Ok. 

Copying Luminaires - Concepts 

You may place multiple replicas of single or multiple luminaires, luminaire arrangement or luminaire groups with the Copy Luminaire command. Each 
subsequent replica will exhibit the same attributes and aiming parameters as the original. This provides a shortcut in locating luminaires with identical 
aiming angles by replacing the need to Locate and Aim or Locate and Orient, both two clicks, to a single mouse click. 

Selecting luminaires to filter for a particular Z coordinate 

Press the SHIFT key during the selection process to select luminaires located at the current Z coordinate. This can be very helpful when selecting 
stacked luminaires. Set the Z coordinate using the Page Up and Page Down keys on the keyboard. 

Copying Luminaires 

Luminaires can be copied to subsequent locations while maintaining their current aiming angles. 

1. From the Modify menu select Luminaire-Copy, or from the Luminaire toolbar select . 
2. To select multiple luminaires from the toolbar, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select 

Window or All. 
3. Select the luminaire(s) to copy. 
4. Select the point to copy from (the base point) with the mouse. 
5. Move the cursor to the new location point and left click.  
6. You may continue copying additional luminaires in this manner until you right click. 

Deleting Luminaires - Concepts 

The Delete Luminaires command allows you to remove single or multiple luminaires quickly and easily. Removed luminaires are no longer 
considered in the lighting calculations as light sources or as physical entities in the Radiosity calculations. Any poles or pendants associated with the 
removed luminaires are also removed. 

Selecting luminaires to filter for a particular Z coordinate 

Press the SHIFT key during the selection process to select luminaires located at the current Z coordinate. This can be very helpful when selecting 
stacked luminaires. Set the Z coordinate using the Page Up and Page Down keys on the keyboard. 

Project Manager 

Luminaires may also be deleted by Label in Project Manager. 

Deleting Luminaires 

The Delete Luminaire command allows you to delete luminaires with multiple selection options, Single selection, multiple selection through a 
Window, or All luminaires at once. 

1. From the Modify menu select Luminaire-Delete, or from the Luminaire toolbar select . 
2. To select multiple luminaires from the toolbar, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select 

Window or All. 
3. Select the luminaires to delete. 
4. If the Single selection option method was chosen, you may continue selecting luminaires. 
5. Press ENTER (right mouse click) to verify your selections and delete. 

Editing Luminaires - Concepts 

AGi32 provides a method to modify luminaire locations and aiming parameters in tabular format instead of graphical manipulation in the graphics 
area. The Luminaire Edit command allows you to make numerical changes to selected luminaires without having to move or reposition the luminaires 
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using a mouse. You may select any number of single luminaires, luminaire arrangements or luminaires groups to edit. Each luminaire occurrence (or 
group occurrence) is independently editable. 

The Edit Luminaire dialog provides the following capabilities: 

1. Change Luminaire Status (switch On and Off) 
2. Change Luminaire Label (change the luminaire at this location to a different type) 
3. Change coordinate location (move luminaire or change mounting height) 
4. Change luminaire aiming (apply Orient, Tilt, Roll or Spin) 
5. Change luminaire aiming point (only applicable if luminaire was aimed at a point using Locate and Aim) 

Applications 

The Edit Luminaire command provides one of the most powerful and useful tools in AGi32. Power users will certainly find the tool useful for many 
applications, some of which are described below: 

• Swap out luminaires using the same coordinate locations to compare luminaire performance at many stages of the lighting design process (e.g. 
Value Engineering or Shop comparisons). 

• Troubleshoot calculation anomalies by verifying correct coordinate locations and aiming parameters. 

• Obtain total luminaire counts and find duplicate luminaire positions which can cause incorrect lighting levels. 

• Apply multiple switching schemes by changing the Calculation Status for selected luminaires. 

Same Aiming Angles or Same Aiming Point 

Changing a luminaire's insertion point location results in either the aiming point or aiming angles being recalculated depending on the setting of the 
radio button at the top of the dialog. If the Same Aiming Angles radio button is selected, the aiming point is recalculated while the aiming angles 
remained the same. If the Same Aiming Points radio button is selected, the aiming angles are recalculated (Orient and Tilt) while the original aiming 
points are maintained. 

Luminaires placed with Static Aiming or Locate and Orient have an aiming point that is identical to the insertion point. Therefore, when editing these 
types of luminaires, the Aiming Point coordinates are displayed as N.A.. 

Under certain circumstances, the aiming points for luminaires placed with Locate and Aim will display N.A.: 

1. Performing changes using the same Aiming Angles radio button with the luminaire mounting height above the aiming points Changing the 
luminaires mounting height below the original aiming points will result in the Aiming Point coordinates changing to N.A.. 

2. Performing changes using the same Aiming Angles radio button with the luminaire mounting height below the aiming points Changing the 
luminaires mounting height above the original aiming points will result in the Aiming Point coordinates changing to N.A.. 

3. If the luminaire mounting height is above the original aiming point, and the luminaire Tilt is changed to 90 degrees or higher, the Aiming Point 
coordinates will be displayed as N.A.. 

4. If the luminaire mounting height is below the original aiming point, and the luminaire Tilt is changed to less than 90 degrees, the Aiming Point 
coordinates will be displayed as N.A.. 

5. Changing a luminaire's Label from a Single arrangement to a multiple head arrangement or luminaire group will result in the Aiming Point 
coordinates changing to N.A.. 

Bulk Modifications 

To make global modifications to all selected luminaires, or all of the same Label, use the Bulk Modifications button. This provides an alternative to 
changing every cell manually (e.g. for a constant mounting height modification). Four categories of modification are available: General, Location, 
Aiming Angles or Aiming Points. Making a change in this dialog, will apply the change to each of the selected luminaires. For example, adding a Roll 
of 25 degrees, will roll every luminaire 25 degrees. 

Each type of modification is independently applied. You may not apply a change in more than one category at once, to prevent conflicts in aiming 
intent. To apply changes in more than one category, make the changes in one category, click Ok, then choose Bulk Modifications again, and change 
the next category. 

Editing Luminaires 

The Edit Luminaire command modifies a luminaire’s location and aiming parameters in tabular format instead of graphically on the desktop. The Edit 
Luminaire command allows you to make numerical (or alphanumerical) changes to selected luminaires without having to move or re-aim the 
luminaires in question. Any number of luminaires, luminaire arrangements and luminaire groups may be selected to edit. Each luminaire occurrence 
(or group occurrence) is independently editable. 

To edit luminaires: 

1. From the Modify menu select Luminaire-Edit, or from the Luminaire toolbar select . 
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2. To select multiple luminaires from the toolbar, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select 
Window or All. 

3. Select the luminaires to edit. 
4. To edit a luminaire’s status, location, label or aiming parameters, simply click in the appropriate cell and enter the desired value. 
5. To make a constant modification to every luminaire within the Edit Luminaires dialog or to all luminaires of a selected luminaire type, select the 

Bulk Modifications button. 
6. Click Ok. 

 Note: Press the Shift key during the selection process to select luminaires located at the current Z- coordinate. This is handy when selecting stacked 
luminaires (i.e., multiple luminaires on one pole at different heights). 

Bulk Luminaire Modifications 

The Bulk Luminaire Modifications command provides a method for luminaire modifications that affect every luminaire currently within the Edit 
Luminaires dialog box or just the selected luminaire type. This command provides an alternative to changing every cell manually (i.e., for a constant 
mounting height modification). Only one type of modification can be applied at any one time: General, Location, Aiming Angles or Aiming Points. 
However, the user can return to the Bulk Luminaire Modifications dialog at any time and make additional modifications. 

You may also apply a bulk modification to a selected luminaire type even though multiple luminaire types are currently selected. For instance, this 
selection mode allows you to change the mounting height of all type A’s in one step without affecting the mounting height of type B’s. 

1. From the Edit Luminaires  dialog box, select . 
2. Select the radio button to apply the modifications to every luminaire currently shown in the Edit dialog or apply changes just to the selected 

luminaire type. 
3. Select the radio button adjacent to the type of modification: General, Location, Aiming Angles or Aiming Points. 
4. Select the modification option(s) and, if necessary, enter the appropriate numeric value(s). 
5. Click Ok. 

Mirroring Luminaires - Concepts 

The Mirror Luminaire command provides a method of duplicating luminaires about a user specified mirror line. The mirror line is specified in Plan 
View as a horizontal line of any orientation and will impact all currently unlocked luminaires. 

The Mirror Luminaire command allows for three selection options; choose a Single luminaire, select multiple luminaires using a Window, or choose 
All luminaires. Each luminaire selected will be mirrored about the specified mirror line using the same Incidence angle on both sides. 

 

Mirroring Luminaires 

The Mirror command provides a method to duplicate luminaires about a user specified mirror line. 

1. From the Modify menu select Luminaire-Mirror, or from the Luminaire toolbar select . 
2. To select multiple luminaires from the toolbar, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select 

Window or All. The number of luminaires selected is shown in the Command line. 
3. Select the luminaires to mirror. 
4. Specify the first point of the mirror line. 
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5. Drag the cursor to the second point of the mirror line and left click again. 

   

Moving Luminaires - Concepts 

The Move Luminaire command provides the ability to move a single luminaire, multiple luminaires, or All luminaires, with or without changing the 
associated aiming parameters. Two options are provided within the command - Same Aiming Angles or Same Aiming Point. 

The Same Aiming Angles option is intended for luminaires placed with the Static Aiming or Locate and Orient options and may be used in 
conjunction with luminaire groups or arrangements. This is the option most often required for most applications, such as site lighting, indirect lighting 
and many other applications.  

This option may also be used in conjunction with luminaires placed with Locate and Aim, with the aiming vector being moved statically. 

The Same Aiming Points option is intended for luminaires placed with the Locate and Aim option and is not available for luminaire groups or 
arrangements. Use this option, whenever you need to maintain an aiming point but require an alternate coordinate location - such as setback. 
Consider this option with sports lighting, facade lighting, and other floodlighting applications. 

Selecting luminaires to filter for a particular Z coordinate 

Press the SHIFT key during the selection process to select luminaires located at the current Z coordinate. This can be very helpful when selecting 
stacked luminaires. Set the Z coordinate using the Page Up and Page Down keys on the keyboard. 

Moving Luminaires 

Luminaires can be moved in any direction while maintaining their current aiming angles or aiming points. 

The Move-Same Aiming Angles command moves the luminaires without changing the aiming angles. Aiming Points are recalculated. Luminaire 
groups and luminaire arrangements can only use the Move-Same Aiming Angles command. 

The Move-Same Aiming Points command moves the luminaires and keeps the original aiming points. The aiming angles are recalculated according 
to the magnitude and direction of the move. 

1. From the Modify menu select Luminaire-Move, or from the Luminaire toolbar select . To use Same Aiming Points left click on the pull-
down arrow adjacent to the Move Luminaire button. Select Same Aiming Points. 

2. To select multiple luminaires from the toolbar, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select 
Window or All. 

3. Select the luminaire(s) to move. 
4. Select the point to move from (the base point) with the mouse. 
5. Move the cursor to the new location point and left click. 

Re-Aiming Luminaires - Concepts 

The Re-Aim Luminaire command allows you to change a single luminaire's aiming point. You may operate the command in Plan, Elevation or 
Isometric Views depending on the aiming condition you wish to alter. The Re-Aim function focuses the luminaire's Nadir (the 0 degree vertical point 
of photometry) at a point. It should not be used with indirect luminaires  or others tested in an operating position away from Nadir. 

Luminaires placed with Aim and Orient or Static Aiming should be Re-Oriented instead of Re-Aimed so as not to alter their tilt angles. Luminaire 
arrangements and groups cannot be Re-Aimed as they consist of multiple luminaires with unique aiming points. 

Note: When the Parametric Mirror command is applied, all parametric related luminaires will re-aim. You can temporarily disable the Parametric 
relationship, and re-aim a single luminaire, by holding down the Ctrl key during the Re-Aim process. 

Selecting luminaires to filter for a particular Z coordinate 

Press the SHIFT key during the selection process to select luminaires located at the current Z coordinate. This can be very helpful when selecting 
stacked luminaires. Set the Z coordinate using the Page Up and Page Down keys on the keyboard. 

Re-Aiming Luminaires 

The Re-Aim command modifies a single luminaire’s aiming point in Plan, Isometric or Elevation view. The Re-Aim function changes the aiming vector 
of a luminaire placed with Locate and Aim. 

1. From the Modify menu select Luminaire-Re-Aim, or from the Luminaire toolbar select . 



AGi32 Help System  Modifying Entities 

300 

 

2. Select the luminaire to Re-Aim. 
3. Drag the cursor to the new aiming point and left click. In plan or isometric view, use the up and down arrow keys to change the Z-coordinate. 
4. Continue Re-Aiming luminaires or right click (ENTER) to terminate the command and accept your changes.  

Re-Orienting Luminaires - Concepts 

The Re-Orient Luminaire command allows you to change the Orientation angle of any single luminaire, luminaire arrangement or group without 
changing the luminaire Tilt. Luminaires with aiming vectors (originally positioned with Locate and Aim) are re-oriented with a static aiming vector.  

Note: When the Parametric Mirror command is applied, all parametric related luminaires will re-orient. You can temporarily disable the Parametric 
relationship, and re-orient a single luminaire, by holding down the Ctrl key during the Re-Orient process. 

Selecting luminaires to filter for a particular Z coordinate 

Press the SHIFT key during the selection process to select luminaires located at the current Z coordinate. This can be very helpful when selecting 
stacked luminaires. Set the Z coordinate using the Page Up and Page Down keys on the keyboard. 

Re-Orienting Luminaires 

The Re-Orient command changes the orientation of a single luminaire, arrangement or group without changing the tilt. Luminaires that have aiming 
vectors (located with Locate and Aim) are re-oriented with a static aiming vector, tilt remains constant. 

1. From the Modify menu select Luminaire-Re-Orient. or from the Luminaire toolbar select . 
2. Select the luminaire to Re-Orient. 
3. Drag the cursor to the new orientation point and left click. 
4. Continue Re-Orienting luminaires or right click (ENTER) to complete the command.  

Switching Luminaires - Concepts 

The Luminaire Switch command temporarily switches luminaires On or Off allowing them to be removed from calculations. Many will find this a useful 
tool when considering multiple switching strategies. 

Luminaires may be switched individually, in multiples by a Window selection, or All at once. Once off, they may be switched back On again in the 
same manner. 

Project Manager 

Luminaires may also be switched On or Off by Label in Project Manager. 

Switching Luminaires 

The Switch Luminaire command allows the user to temporarily remove luminaires from the calculations, such as in the case when considering 
multiple switching strategies. Luminaires can be individually toggled off or on or selectively switched using the Single, Window or All functions. 

1. From the Modify menu select Luminaire-Switch-Toggle On/Off or On or Off, or from the Luminaire toolbar select . To selectively switch 
luminaires On or Off, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select On or Off. 

2. If On or Off is selected, select Single, Window or All. 
3. Select the luminaires to switch. 
4. Continue switching luminaires or right click (ENTER) to apply the switch. 

Symbol Magnifier - Concepts 

The Luminaire Symbol Magnifier command allows you to magnify all luminaire symbols by an integer amount, up to 10. By default, the symbol 
magnification = 1 which inserts the symbol into the job file using the scaling factors that were specified in the Luminaire Symbols dialog. In exterior 
applications, the scale of the project is often too large to see the symbols when they are true to scale. In this case it is often valuable to increase the 
luminaire symbol size (e.g., apply a magnification factor of 5). All luminaire symbols placed in the job file will be magnified by the same factor. 

The magnification factor is purely a graphical representation. The insertion point remains the same and the distance between photometric center and 
the insertion point (Arm Length and/or Offset) used in numerical calculations does not change. In Render mode, all symbols are shown at true scale, 
the magnification factor is not applied. 

Magnification is not applied until after a luminaire is located and aimed or oriented in the job file. 
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Symbol Magnifier 

This command allows you to magnify all luminaire symbols by an integer amount, up to 10. Magnification is not applied until after a luminaire is 
located and aimed or oriented in the job file. 

1. From the Modify menu choose Luminaire-Symbol Magnifier, or from the Luminaire toolbar select . 
2. Increase or decrease the current Symbol Magnifying Factor by left clicking on the up/down scrolling arrows. 
3. Click Ok.  

Luminaire Template - Concepts 

AGi32 will display Iso-illuminance contours for any single luminaire, luminaire Arrangements or Groups of luminaires. Iso-illuminance contours that 
are specific to a single coordinate location and mounting height are called Templates. 

Templates provide valuable assistance when you are trying to determine the coverage of a luminaire for achieving minimum coverage for a particular 
luminaire or luminaire arrangement. Templates are often used to determine luminaire spacing to meet a specific minimum light level in outdoor area 
lighting applications. However, AGi32 can also be used to apply templates in other applications other than grade, both vertical and horizontal 
uplighting templates are easily created. This means that you can create templates on a ceiling or on a facade, the application is up to you.  

Template Values 

The values assigned to the luminaire templates are important when using templates for layout purposes. The minimum Illuminance level required is 
your starting point. If only the average level is given then the uniformity ratio, Average/Minimum can be used to determine the necessary minimum 
requirement. One the minimum requirement is known, the following contours are typically used: 1/4 minimum, 1/2 minimum and minimum. You can 
then see the interaction of four luminaires (1/4 minimum), two luminaires (1/2 minimum) and where a single luminaire performs to meet its minimum 
on its own. 

Template Settings 

When creating a new template, the Create Template dialog uses the previous template settings except for mounting height. When modifying an 
existing template, the Create template dialog uses the template's current settings. 

Horizontal Template "Down" 

This is the most common application of templates and is used often in exterior site lighting applications, as a starting point to the final design. 
Horizontal templates (up and down) are based on Label, Mounting Height, Tilt, Roll and Spin, and will only appear on luminaires exhibiting the same 
positioning parameters. 

Horizontal Template "Up" 

Templates created in an Up direction are representative of uplight from a particular luminaire at a particular distance (typically suspension length). 
This template type is most often applied to indirect luminaires to see the pattern of light on the ceiling. 

Vertical Template Four Cardinal Directions 

Vertical Templates contour vertical Illuminance levels on an imaginary or real surface at a specific distance. Facade, track and sign lighting are some 
of the possible applications. Vertical Templates are based on Label, Tilt, Roll and Spin, Orientation and Mounting Height can be altered. 

Vertical templates are only available in the North, South East and West directions, and are created relative o the initial orientation direction of the 
selected luminaire. For example, if your Orient a luminaire 45 degrees, then create a Vertical North Template, the Template will be created parallel to 
the X axis, relative to AGi32's 0-180 axis. If the same luminaire is placed with a rotation of 0 degrees, the associated template will be angled 45 
degrees relative to its current position. 

Template Extents 

The Template Extents setting allows you to vary the grid size used for the template based on a multiplier against the current distance from the 
luminaire to the template. The extents of the grid = -{extents} X {Distance from Luminaire to Template} to +{Extents} X {Distance from Luminaire to 
Template} in both the Left-to-right and top-to-bottom directions. For example; if Distance = 30 and Extents = 6, Grid lower left-hand corner = -180, -
180, upper right-hand corner = 180, 180. By default, the Template Extents setting is equal to 6 or the last used setting. If the Template Isolines 
appear to be cut off, as may occur with tilted luminaires, increasing the Templates Extents setting may be necessary. 

The maximum Template Extents is 100. 

Line Width 
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The default line width for templates is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). Wider template 
lines may increase a template’s clarity against the background when printing or when using light template colors against a light screen background. 

Details 

If a template is created with many Isolines and/or Isoline labels, it may appear dashed when it is being located or moved. If this effect is 
unacceptable, you can reduce the number of Isoline and/or labels or you can increase the Ghost 2D Image - # of Entities Cutoff limit. For more 
information, please see the System Parameters. 

To optimize redrawing times, use templates without Isoline labels and use the same color as the luminaire. 

The Isoline labels are drawn using the current Default System Font, and associated font style, located in the System Settings dialog.  

Creating Luminaire Templates 

Iso-illuminance templates are composed of lines of equal illuminance surrounding a single luminaire, luminaire arrangement or group. Templates are 
used to predict the shape and coverage of the light distribution, in any direction, from a selected luminaire, arrangement or group. 

What do you want to do? 

Create a horizontal template 

1. From the Modify menu select Luminaire-Template-Create Template, or from the Luminaire toolbar select . 
2. Select the desired luminaire by locating the pickbox cursor anywhere on the luminaire symbol and left clicking. 
3. Select the direction for the horizontal template; up (above the luminaire) or down (below the luminaire). 
4. Specify the distance from the luminaire to the template. By default, the distance echoes the selected luminaire's mounting height. 
5. Specify the extents of the template in terms of the current setting multiplied by the distance from the luminaire to the template. Use the scrolling 

arrows to change the variable up to 50. 
6. The default line width for templates is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). 
7. Specify whether the Isolines will be of the same color as the luminaire symbol or of variable colors. 
8. Specify the illuminance values (FC or Lux) that will define the Isolines. It is not necessary to fill in all of the Isoline Value boxes or indicate the 

values in any particular order. Only positive values are used, empty boxes have a zero value. When specifying Isolines of variable color it is 
possible to match a particular value to a particular color. 

• For Example: If only one blue Isoline is desired, indicate the appropriate value above the Blue colored box. 

9. If Isoline labels are to be shown, check the Label Isolines selection box. You can also change the label increment and text size (in ft. or m), if 
desired. 

10. Click Ok. 

Note: Horizontal templates (up or down) are based on the; label, mounting height, tilt, roll, and spin of the currently selected luminaire. In other 
words, the template will only appear when you select the same luminaire type, mounting height, tilt, roll, and spin (orientation can be variable). 

Create a vertical template 

1. From the Modify menu select Luminaire-Template-Create Template, or from the Luminaire toolbar select . 
2. Select the desired luminaire by locating the pickbox cursor anywhere on the luminaire symbol and left clicking. 
3. Select the direction for the horizontal template; North (parallel to the X-axis, above the luminaire), South (parallel to the X-axis, below the 

luminaire), East (parallel to the Y-axis, to the right of the luminaire) or West (parallel to the Y-axis, to the left of the luminaire). 
4. Vertical templates are created relative to the orientation of the selected luminaire. When additional luminaires bearing the same parameters are 

located and oriented, the template will orient itself about the current luminaire according to the original luminaire's orientation. 
5. Specify the distance from the luminaire to the luminaire template. By default, the distance echoes the selected luminaire's mounting height. 
6. Specify the extents of the template in terms of a setting multiplied by the distance from the luminaire to the template. Use the scrolling arrows to 

change the variable up to 50. 
7. The default line width for templates is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or meters). 
8. Specify whether the Isolines will be of the same color as the luminaire symbol or of variable colors . 
9. Specify the illuminance values, using FC or Lux, that will define the Isolines. It is not necessary to fill in all of the Isoline Value boxes or indicate 

the values in any particular order. Only positive values are used, empty boxes have a zero value. When specifying Isolines of variable color it is 
possible to match a particular value to a particular color. 

� For Example: If only one blue Isoline is desired, indicate the appropriate value above the Blue colored box. 

10. If Isoline labels are to be shown, check the Label Isolines selection box. You can also change the label increment and text size (in ft. or m), if 
desired. 

11. Click Ok. 
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Vertical Template - Example 1 

 

A vertical East template is created for a 
luminaire with zero degrees orientation. 

 

An Elevation view of the East template, 
looking due East. 

 

Another luminaire with the same 
parameters is located and oriented forty-
five degrees. Notice that the template has 
rotated (45 degrees) relative to the 
orientation of the current luminaire. 

Vertical Template - Example 2 

 

A vertical North template is created for a 
luminaire with forty-five degrees 
orientation. 

 

An Elevation view of the North template, 
looking due North. 

 

Another luminaire with the same 
parameters is located and oriented zero 
degrees. The template has rotated (315 
degrees) relative to the orientation of the 
current luminaire. 

Note: Vertical templates (north, south, east, and west) are based on the label, tilt, roll, and spin of the currently selected luminaire. In other words, 
the template will only appear when you select the same luminaire type, tilt, roll, and spin. Mounting height and orientation can be variable. 

 

Modify the Isoline values 

1. From the Modify menu select Luminaire-Template-Create Template, or from the Luminaire toolbar select . 
2. Select the desired luminaire by locating the pickbox cursor anywhere on the luminaire symbol or template and left clicking. 
3. Replace the current Isoline values with the desired values. 
4. Click Ok. 
5. You will be asked whether the existing template should be overwritten. Click on the Yes button. 

Modify the Isoline label increment 



AGi32 Help System  Modifying Entities 

304 

 

The Isoline label increment specifies the distance between Isoline labels along the length of the Isoline. To specify a single label per Isoline, enter a 
large number for the Label increment (e.g., 10000). 

1. From the Modify menu select Luminaire-Template-Create Template, or from the Luminaire toolbar select . 
2. Select the desired luminaire by locating the pickbox cursor anywhere on the luminaire symbol or template and left clicking. 
3. Replace the current Isoline label increment with the desired increment (ft. or m). 
4. Click Ok. 
5. You will be asked whether the existing template should be overwritten. Click on the Yes button. 

Modify the Isoline label text size 

1. From the Modify menu select Luminaire-Template-Create Template, or from the Luminaire toolbar select . 
2. Select the desired luminaire by locating the pickbox cursor anywhere on the luminaire symbol or template and left clicking. 
3. Replace the current Isoline label text size with the desired text size (ft. or m). 
4. Click Ok. 
5. You will be asked whether the existing template should be overwritten. Click on the Yes button. 

Changing the Visibility of Templates - Concepts 

AGi32 allows you to change the visibility of luminaire templates On or Off either by label or in their entirety. When using templates for layout work, it 
can be convenient to change the visibility of template for a particular luminaire type Off in order to more easily work with another. It is also useful to 
be able to turn all of the templates Off in their entirety, once the layout work is done, to use more effective methods of output and presentation (e.g. 
point by point values and Isolines). 

Similarly, you can change the visibility luminaire templates On by Label or in their entirety using the converse options. Switching template visibility Off 
does not affect future luminaire locations (Template will be visible once defined, by default). 

Changing the Visibility of Templates 

The Visibility-Templates command selectively changesChanging the Visibility of Templates on or off. Only existing Templates are affected by this 
command, subsequently located templates will always be visible. 

 From the Modify menu choose Luminaire - Template - Visible- All On or All Off or All On Same Label or All Off Same Label , or from the 

Luminaire toolbar select . Left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select Visible- All On, All 
Off, .All On Same Label or All Off Same Label  

Note: Luminaire locations with defined luminaire templates may have their templates made visible or invisible singularly or collectively from Project 
Manager. 

Deleting All Luminaire Templates 

The Delete All Templates command deletes all templates for every luminaire type. In addition, all templates are deleted from the template database. 
Consequently, templates are no longer shown for any additional luminaire locations (until the Create Template command is invoked again). 

1. From the Modify menu choose Luminaire - Template - Delete All Templates, or from the Luminaire toolbar select .  
2. Left click on the pull-down arrow to the right of the button to invoke the secondary menu.  
3. Select Delete All Templates. 
4. Press Enter to confirm your selections. 

Note: This command cannot be undone (a warning message will appear asking you to confirm the deletions. 

Luminaire Photometric Web Specification - Concepts 

This command allows for the  specification and customization of the photometric web parameters (candela curves and maximum candela indicator) 
which can be used to facilitate proper placement and aiming. By default, photometric webs can be toggled on/off (made visible) for previously located 
luminaires in the AGi32 job file. In addition, the Photometric Web specification dialog allows the option to display photometric webs for all new 
luminaire locations. If this option is enabled, when each luminaire is located and oriented or aimed, the photometric web display will update 
dynamically to show how the applied aiming parameters affect the distribution. 
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Uplight luminaire in tested position (max 
candela at 125 degrees vertical above 
nadir) 

 

Uplight luminaire during re-aiming 
(Tilt adder of 45 degrees vertical 
shown) 

 

Uplight luminaire in newly aimed position 
(max candela now at 170 degrees vertical 
above nadir - 125 + 45) 

 

Photometric webs are enabled for display and design purposes and have no affect on the environment or calculated values. They may however, slow 
down the refresh time of your environment if you have many photometric webs displayed. Each candela value in the associated file is represented 
and traced in the photometric web. Photometric distributions with a high density of candela values may appear very dense and complex when 
displayed and may cause some delay in AGi32's refresh response. 

Photometric webs for each luminaire in an arrangement or group are displayed individually. In other words, the photometric distributions of luminaires 
in an arrangement or group are not combined to produce a single photometric web. 

Back To Back arrangement with bilateral symmetric luminaires 

 

Luminaire group with bilateral symmetric luminaires and NEMA 
4 x 4 floodlights tilted at 45 degrees 
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Luminaire Photometric Web Specification 

The Luminaire Photometric Web dialog allows you to specify how to display the candela curves and maximum candela indicator associated with 
photometric webs in AGi32. Photometric webs are very helpful to ensure proper luminaire placement and aiming when working in AGi32. 

Photometric Web Display 

This section allows the option to display photometric webs (candela curves and maximum candela indicator, if both are enabled) for all new luminaire 
locations. By default, photometric webs can be toggled on/off (made visible) for previously located luminaires in the AGi32 job file on an individual 
basis. 

Candela Curves 

The Candela Curves section provides the parameters to control Line Width, Line Color and Scaling variables for the three dimensional wireframe 
representation of the candela curves. 

Line Width - The default line width for photometric webs is 0 (one pixel wide). You may specify an alternate width using the current units (ft. or 
meters). Wider photometric web lines may increase the photometric web clarity against the background when printing or when using light photometric 
web colors against a light screen background. 

Line Color - Specify the Color variable to use for the candela curves: Set, Same As Symbol or Colorize (RGB). 

� Set: Specify the Color to use for all candela curves across all luminaire definitions. 
� Same As Symbol - All candela curves within each luminaire definition will be displayed with the same color as the Normal luminaire symbol. 
� Colorize (RGB) - The candela curves will be colorized using a five color system based on their percentage of the maximum candela value within 

each luminaire definition, as follows: 

Candela Value Color 

> 80% of Max. Cd. Red 

> 60% of Max. Cd. Yellow 

> 40% of Max. Cd. Green 

> 20% of Max. Cd.  Cyan 

<= 20% of Max. Cd.  Blue  

Scaling - The candela curves may be scaled per 100 candela (scale of photometric web based on strength of photometric distribution) or per the 
maximum candela value (scale of photometric web is constant across all distributions). 

� Per 100 Candela - The candela curves are scaled relative to each other based on an intensity of 1000 candela. This results in photometric web 
display size being different for luminaires with different maximum intensities (curve size increases relative to intensity). This gives you a visual 
indication of which luminaires have more or less intensity relative to each other. The scaling factor allows you to increase or decrease the curve 
display size. 

For Example: Luminaire A: Max. Cd = 5000, Luminaire B: Max. Cd = 20000, scaling factor = 1 

Luminaire A – The candela curve containing the maximum candela value will be 5000/1000 = 5 (ft or m) from the insertion point at its 
greatest point 

Luminaire B - The candela curve containing the maximum candela value will be 20000/1000 = 20 (ft or m) from the insertion point at its 
greatest point (equivalent to this photometric web appearing 4X larger than Luminaire A's photometric web). 

� Per Max. Candela - The candela curves are scaled relative to the maximum candela value within each luminaire type. In other words, the 
photometric web is scaled relative to its own 100% value (max candela value), not relative to a fixed scale. This results in photometric web 
displays for all luminaires being about the same size regardless of the relative output (intensity) of each luminaire. The scaling factor determines 
the length (distance) of the maximum candela value. A value >=1 is recommended. For example: If the Scaling Factor = 1, the curve containing 
the maximum candela value will be 1 (ft or m) from the insertion point at its greatest point. If the Scaling Factor = 10, the curve containing the 
maximum candela value will be 10 (ft or m) from the insertion point at its greatest point. 
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Maximum Candela Indicator  

The Maximum Candela Indicator is a line representing the angle at which the maximum candela value occurs. Depending on the luminaire's 
horizontal photometric distribution symmetry, more than one Maximum Candela Indicator line may be displayed: 

� Symmetric Distributions: 12 lines, one every 30 degrees (only this distribution displays a line at nominal angles because all angles are equal) 
� Quadrilaterally Symmetric Distributions:4 or more lines 
� Bilaterally Symmetric Distributions: 2 or more lines 
� Asymmetric Distributions: 1or more lines 

Line Width - The default line width for the Maximum Candela Indicator is 0 (one pixel wide). You may specify an alternate width using the current 
units (ft. or meters). Wider the Maximum Candela Indicator lines may increase the photometric web clarity against the background when printing or 
when using light photometric web colors against a light screen background. 

Line Color - Specify the Color to use for the Maximum Candela Indicator 

Scaling - The Scaling Factor determines the length of the Maximum Candela Indicator line relative to the maximum candela curve (curve containing 
the maximum candela value). A value >1 insures that the Maximum Candela Indicator line will extend beyond the largest candela curve making it 
easier to distinguish from the candela curves. 

Changing the Visibility of Luminaire Photometric Webs - Concepts 

AGi32 allows you to change the visibility of luminaire photometric webs On or Off via many methods; toggle on/off, by label or in their entirety.  

By default, luminaire photometric webs can be toggled On and Off using the default (or current) Photometric Web specifications. When using 
luminaire photometric webs for layout work, it is very convenient to toggle on the photometric webs for individual luminaires to see complicated 
aiming information or consistency in layout. Another effective method for using photometric webs is to enable the visibility for specific luminaire types.  

Finally, it is also useful to turn all of the luminaire photometric webs Off in their entirety, once the layout work is done, to use more effective methods 
of output and presentation (e.g. point by point values and Isolines). 

Luminaire photometric webs are not visible by default, as they can cause a delay in screen refreshes when being redrawn. As additional luminaires 
are located in the job file, it is up to the user to Toggle On the luminaire photometric webs for luminaire locations they wish to view. 

Changing the Visibility of Luminaire Photometric Webs 

The Visibility-Photometric Web commands selectively switch luminaire photometric webs on or off as to change their visibility. Only existing 
photometric webs are affected by this command, newly located luminaires will have their photometric webs displayed only if this option is enabled in 
Photometric Web Specification dialog. 

Note: This command is not undoable. 

1. From the Modify menu choose Luminaire - Photometric Webs - Toggle On/Off, Switch- All On or All Off or All On Same Label or All Off 

Same Label , or from the Luminaire toolbar select . The default option is Toggle On/Off.  
2. Select the luminaires whose photometric webs you wish to make visible. Multiple luminaires may be selected at once. 
3. Right click to confirm your selection and display the luminaire photometric webs. 
4. To change the visibility of luminaire photometric webs in their entirety or by label, left click on the pull-down arrow to the right of the button to 

invoke the secondary menu. Select Visibility - All On, All Off, All On Same Label or All Off Same Label. 

Note: Luminaire locations may have their photometric webs made visible or invisible singularly or collectively from Project Manager. 

Creating Luminaire Aiming Diagrams - Concepts 

Luminaire aiming diagrams (“bubble” diagrams) may be created for poles and racks quickly and easily. AGi32 allows you to create customized 
bubble diagrams to show pertinent information and will even arrange the diagram according to the aiming parameters and mounting heights of the 
selected luminaires. You may add a bubble “key” to your layout and print the aiming diagram and key separately for reference. Simply Locate and 
Aim the luminaires as desired, then select the Modify-Luminaire-Aiming Diagram command. 

Aiming Diagram Process 

AGi32 provides a method for creating luminaire aiming diagrams for any selected luminaires placed in the job file. 

The following process creates an aiming diagram: 
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1. From the Modify menu select Luminaire-Aiming Diagram or from the Luminaire toolbar select . 

2. Begin by windowing around the selected luminaires. Luminaire locations must be contained within the window to be selected (aiming points are 
disregarded). 

3. If you windowed around multiple individual locations, you will be prompted for the Reference Point – the pole location. If an arrangement or 
group was selected, this step is skipped (pole is specified in definition). 

4. For Single and Arrangement selections, the Reference Angle is specified next. This angle specifies the local zero degree orientation angle for 
the pole. Luminaire orientations are specified Left or Right of this reference angle. The Reference Angle is generally specified towards the 
playing field. Luminaire Groups are prompted for the Reference Angle when they are defined. 

5. The Offset Location is specified last. This coordinate point allows you to indicate a different user coordinate system for the rack or pole. Offsets 
are useful when you are designing a layout with multiple playing fields and wish to reference the pole locations relative to the individual field. To 
maintain the original coordinates, press ENTER (right mouse click). 

6. The Aiming Diagram dialog appears. The Information section displays the quantity of luminaires selected, the reference angle, pole location, 
offset location and relative pole location. A Label may be specified to identify the pole or rack. To display the Label adjacent to the pole location, 
check the Show at Location selection box. A Description may also be specified to identify the pole or rack. To display the Description adjacent to 
the pole location, check the Show at Location selection box. The selected Reference Angle is shown at the pole location with an arrow. 

7. The Configuration section specifies whether the Aiming Diagram is created automatically based on the luminaire locations or if the diagram is 
created based on a user defined grid. The default option is Automatic. 

• The Automatic configuration option uses the luminaire locations to create the diagram. If the luminaires are located in the same location 
(as in a pole instance), the bubbles are placed in one row based on their orientation angle (Left or Right of the Reference Angle). If the 
luminaires are located at multiple locations, the diagram is created based on the absolute luminaire locations. In the case of Luminaire 
Arrangements, where the distance between luminaires is constant, the bubbles will overlap each other. In this case, use the Grid option 
to create the Aiming Diagram accurately. 

• The Grid configuration places the luminaires into columns based on the number of rows selected. When multiple rows are specified, the 
luminaires are sorted according to their Tilt angle (higher Tilts on top, lower Tilts on the bottom), then in columns according to their 
orientation angle. Alternately, you may select the Coordinates option to configure the bubbles according to luminaire position (choose this 
option for racks with cross aimed luminaires). Luminaires will be sorted by Left to Right Coordinates, then Top to Bottom. 

8. The Shape Color indicates the "bubble" color. You may select the Font Color (specified here) or the Luminaire Color (the wireframe color 
specified for the Model symbol). 

9. The Font and Text Size may be changed if desired. The diagram is sized dynamically based on the Text Size. 
10. The Labeling options allow you to identify Aiming Diagram parameters. The selected labels are placed beneath the diagram. 
11. The Aiming Diagram is shown in the upper right corner of the dialog. It is automatically updated if any of the parameters are changed. To print a 

formatted page with the diagram for reference, click the Print button. 
12. The Diagram Key in the lower right corner of the dialog displays the bounding shape and information that will be extracted for each selected 

luminaire. The default diagram displays a square diagram containing Orientation Left/Right angle, Tilt Up angle and the XY Aiming Point. 

• To modify the diagram “bubble”, click the Modify button. The Aiming Diagram Key Worksheet will appear for your use. 

• To print the selected Diagram Key, click the Print button. 

• You may paste the Diagram Key into your layout by clicking the Paste button. You will be returned to the graphics window with the key 
attached to the cursor. Locate the key in the desired location and left click. You may also scale the Diagram Key and rotate it if you wish 
(see steps 13 and 14). Once the Diagram Key is placed, you will be returned to the Aiming Diagram dialog. 

13. Click Ok to create the Aiming Diagram and return to the graphics window. The Aiming Diagram is attached to the cursor at the insertion point. 
Locate the Aiming Diagram at the desired location and click. 

14. Next, you may scale the Aiming Diagram dynamically using the cursor or keyboard entry. To increase the size of the diagram, drag right. To 
decrease the size, drag left. If you wish to maintain the original size, click without dragging the mouse. 

15. The Aiming Diagram may also be rotated at this time. Simply, drag the cursor to indicate the desired orientation angle (or enter it from the 
keyboard) and click again. 

Note: Aiming Diagrams are static blocks that do not update if the pole locations are modified. If the luminaire layout is changed, the Aiming Diagrams 
should be deleted (Modify-Drawing-Delete) and recreated. Aiming Diagrams are drawing entity blocks and may be modified using the Modify-
Drawing commands. 

Aiming Diagram Key Worksheet 

The Aiming Diagram Key Worksheet allows you to customize the shape and information extracted in the “bubble” diagrams. As the changes are 
implemented, the Diagram Key on the right side of the dialog updates to reflect the changes. 

1. The Shape section allows you to select a square, circle or octagon boundary for the diagram. The default shape is a square. The thickness of 
the boundary may also be changed, if desired. The default thickness uses a factor of 0.1 multiplied by the current text size (ft or m) to scale the 
boundary proportionately with the selected text size. 

2. Divider lines are used to separate the information contained within the diagram. By default, a divider line is located between lines 2 and 3, 
bisecting the diagram. You may display additional divider lines by checking the appropriate selection boxes. As with the boundary line, you may 
change the thickness of the divider lines as well. 

3. The Include in Diagram section lists all of the parameters you may include in the diagram. To add a parameter, check the selection box adjacent 
to the Parameter name. The Row and Justification radio buttons will be enabled for that parameter. The Row selection allows you to select Row 
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1-4. The Justify selection allows you to specify Left, Center or Right Justification within the boundary box. Keep in mind that displaying too much 
information within the diagram will result in loss of clarity and possibly overlapping text. 

• Note: When using the Center-Justify option, we recommend you select a non-proportionately scaled font (e.g., Courier New). 
Proportionately spaced fonts (such as Arial) may shift the text slightly to the left. 

4. The Diagram Key indicates the Row locations (on the left) and Justify columns (across the top). This Diagram will update as the worksheet is 
modified. 

5. Click Ok to apply your modifications to the Aiming Diagram. 

Printing Aiming Diagrams 

Aiming diagrams can be printed as a single page for each pole or by printing the entire drawing with all aiming diagrams pasted in place. The key for 
the aiming diagram can also be printed as a single page or pasted on the drawing. 

To print the Key - select the Print button from the Diagram Key section of the aiming diagram dialog. If you wish to attach a banner to the page, click 
the selection box adjacent to Banner. The default banner is shown. To change the banner, click on the Banner button or double click on the banner 
image. 

To print each diagram on a single page - select the print button under the visual representation of the aiming diagram on the right side of the main 
aiming diagram dialog. The specific diagram under construction (the pole or luminaires selected) will be printed on a single page.  If you wish to 
attach a banner to the page, click the selection box adjacent to Banner. To change the banner, click on the Banner button or double click on the 
banner image. 

To change the printer, click the Print Setup button. 

Note: All text summaries are formatted to 8.5 x 11 pages with portrait orientation. You may select other media if desired, but the formatting will not 
change.  

Modifying Luminaire Definitions - Concepts 

The Modify-Luminaire-Define command invokes the Define Luminaire dialog. Previously defined luminaire types can be easily redefined to reflect 
changes from simple (e.g., change Luminaire Watts) to complex (e.g., change associated photometric file). All luminaire locations previously placed 
in the graphics area will immediately be updated to reflect the changes made in the Define Luminaire dialog, provided that the luminaire Labels are 
the same. If the Label has changed, you have  in effect created a new luminaire definition. In this case, the original luminaire definition remains 
unchanged. 

Be aware that many of the input cells have direct bearing on the AGi32 computations and will require recalculation when changed. 

1. The Total LLF is a direct multiplier to the computed values. 
2. The Lumens per Lamp value represents the lumens for one lamp, and is generally extracted and used directly from the selected photometric 

file. Changes to this value will result in proportional changes to your calculated values. However, if this value is -1, this indicates that the 
luminaire was tested with absolute photometry. In this case, the Lumens per Lamp cannot be changed. 

3. The Luminaire Watts cell is only used in LPD Area calculations (Lighting Power Density) and should represent the entire wattage requirements 
of the luminaire (lamps and ballast) not just lamp wattage. 

Modifying Luminaire Definitions 

Once defined, luminaires may be redefined as often as desired. All instances of the redefined luminaire in the job file will then reflect the 
modifications. Luminaire groups are limited in allowable modifications and will only display the available sections. 

1. From the Modify menu select Luminaire-Definition, or from the Luminaire Define toolbar select . 
2. Highlight the desired luminaire from the Define Luminaire List. 
3. Make the desired modifications and click the Add/Redefine button. 
4. If relabeling the luminaire, click the Relabel button. 
5. Click Ok.  

Grouping Luminaires - Concepts 

Luminaire groups consist of multiple luminaires or luminaire arrangements linked together to assist in design and placement. Luminaire Groups can 
be created from any photometric type and mounting height. Once a luminaire group is created it may be placed in the project with Locate and Orient 
or Static Aiming and can be modified exactly like a single luminaire or luminaire arrangement (e.g., copied, moved, deleted, etc.). After creation, 
individual luminaire group locations may be exploded into their original luminaire or luminaire arrangement components. 

Arms are not displayed for luminaire groups. The Arm Length will still be applied separating the luminaires insertion points from the luminous center, 
but a graphical arm is not displayed. 

Related Topics 
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Creating luminaire groups 

Exploding luminaire groups 

Creating Luminaire Groups 

1. From the Modify menu select Luminaire-Group-Create Group, or from the Luminaire toolbar select . 
2. Enclose the luminaires to be grouped in a window. 
3. Select the group insertion point. 
4. Select the group reference angle. Reference angles are used in flood lighting when creating aiming diagrams. For other applications, the 

reference angle will be zero. 
5. Assign a unique label to the group in the Define Luminaire dialog box. If desired, add a group description, pole or pendant and/or modify the 

group color. 
6. Click the Add/Redefine button to add the group to the Define Luminaire List. 
7. Click Exit. 
8. The selected luminaires will be replaced with the defined luminaire group. 

Note: Arms are not shown in luminaire groups. The Arm Length is applied but the arm is not displayed graphically in Model Mode.  

Exploding Luminaire Groups 

Luminaire Groups can be exploded into their individual luminaire  components, so that the individual luminaire occurrences may be applied. 

1. From the Modify menu select Luminaire-Group-Explode Group, or from the Luminaire toolbar select . Left click on the pull-down arrow 
to the right of the button to invoke the secondary menu. Select Explode. 

2. Select the luminaire group to explode. 
3. The selected group will be returned to its individual luminaires and/or luminaire arrangements. 

Deleting Luminaire Labels 

Luminaire labels may be deleted on an individual basis. Luminaire labels should not be deleted until after all luminaire modifications have been 
made, since they return to their default location whenever the luminaire is modified. 

1. From the Modify menu select Luminaire-Labels-Delete, or from the Luminaire toolbar select . Click on the arrow adjacent to the Labels 
button to see the secondary menu. Select Delete. 

2. Select the label to be deleted. 
3. Continue selecting labels in this manner, if desired. When complete, press ENTER (right mouse click) to confirm your selections and delete the 

labels. 

Moving Luminaire Labels - Concepts 

Luminaire labels may be moved from their default location to another location to improve the visual clarity of the presentation. In cases where 
luminaires are stacked in the Z direction, their labels are also stacked on top of each other. When the label is selected the entire label is moved from 
one location (Luminaire Label – Luminaire Number, Coordinates, Aiming Parameters, etc.) to another.  

Moving Luminaire Labels 

The Move Luminaire Labels command moves a single luminaire text label from one location to another. 

1. From the Modify menu select Luminaire-Labels-Move, or from the Luminaire toolbar select . Click on the arrow adjacent to the Labels 
button to see the secondary menu. Select Move. 

2. Select the label to move. 
3. Locate the point to move the label from and click the left mouse button. 
4. Drag the label to its new location and left click again. 

Modifying Parametric Mirrors - Concepts 

Once located in the job file, parametric mirrors can be deleted or switched off. Deleting a parametric mirror breaks the luminaire parametric 
relationship. You may delete a single parametric mirror or both of them (all). 

You may disable a parametric mirror without deleting it completely by switching it Off. Disabling the parametric mirrors allows you to break luminaires 
out of the parametric relationship or add luminaires that do not need to be mirrored. Once the modifications have been applied, the parametric mirror 
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may be re-enabled and the parametric relationship restored to those luminaires that have not been modified. Re-enabling the parametric mirrors will 
result in new luminaire placements being mirrored. 

Luminaires that were modified while the parametric mirror was switched off will not retain their parametric relationship. To restore this relationship, 
restore the luminaire to its original location and/or aiming parameters. 

Related Topics 

Deleting parametric mirrors 

Switching parametric mirrors on or off 

Deleting a Parametric Mirror 

Parametric Mirrors can be deleted, and no longer be taken into consideration, with this command. 

1. From the Modify menu choose Luminaire-Parametric Mirror-Delete, or from the Luminaire toolbar select . 
2. Select Single or All. 
3. If Single is selected, select the parametric mirror to delete. 

Switching a Parametric Mirror 

Switching a Parametric Mirror On or Off allows you to determine whether the Parametric Mirror is enable or disabled in the file. Disabling the 
Parametric Mirror allows you to break luminaires out of the Parametric relationship or add luminaires that do not need to be mirrored. 

1. From the Modify menu choose Luminaire-Parametric Mirror-Switch-Toggle On/Off or All On or All Off, or from the Luminaire toolbar select 

. To switch all parametric mirrors on or off, left click on the pull-down arrow to the right of the button to invoke the secondary menu. Select 
All On or All Off. 

2. If Toggle On/Off is selected, select the parametric mirror to switch on or off. 
3. The parametric mirrors will be switched accordingly. 

Sorting Luminaires - Concepts 

This command offers several alternatives to sorting luminaires by Sequence Number once they are placed in the job file. Sorting luminaire locations 
is generally desirable for all applications that will have luminaire labeling applied once they are close to completion. It makes little sense to have 
luminaires that are close in Sequence Number appear on opposite sides of the room or site plan. More likely, you would want the luminaire sequence 
numbers appear in some order based on how they will be read in the construction documents. 

Six sorting methods are available for your selection. 

Sort Method Possible Application Comments 

Label Interiors Sorts luminaires according to the Label assigned in the Define Luminaire dialog. 

Top to Bottom; Left to 
Right 

Bottom to Top flow: 
Roadway, Parking, 
Commercial, Industrial 

Sorts luminaires top to bottom by decreasing Y coordinate, if multiple luminaires 
are found at the same Y coordinate, they are subsequently sorted left to right by 
increasing X coordinate. 

Bottom to Top; Left to 
Right 

Top to Bottom flow: 
Roadway, Parking, 
Commercial, Industrial 

Sorts luminaires bottom to top by increasing Y coordinate, if multiple luminaires are 
found at the same Y coordinate, they are subsequently sorted left to right by 
increasing X coordinate. 

Left to Right; Bottom to 
Top 

Left to Right flow: 
Roadway, Parking, 
Commercial, Industrial 

Sorts luminaires left to right by increasing X coordinate, if multiple luminaires are 
found at the same X coordinate, they are subsequently sorted bottom to top by 
increasing Y coordinate. 

Counterclockwise 
Rotation 

Racetracks, Sports Sorts luminaires in a counterclockwise direction beginning at the Starting Angle 
specified. The first luminaire placed by this Sorting method is located at the center 
point, determined by averaging the minimum and maximum X and Y luminaire 
coordinates. The sort then sweeps about this center point until it covers 360 
degrees. 

Clockwise Rotation Racetracks, Sports Sorts luminaires in a clockwise direction beginning at the Starting Angle specified. 
The first luminaire placed by this Sorting method is located at the center point, 
determined by averaging the minimum and maximum X and Y luminaire 
coordinates. The sort then sweeps about this center point until it covers 360 
degrees. 

Luminaires are automatically renumbered when sorted (starting sequence number is One). 

The Sort Luminaires command can also be accessed from the Specify Luminaire Labels dialog. 
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Sorting Luminaires 

The Sort command offers several alternatives for sorting luminaires by sequence number. When labeling luminaires, sequence numbers help you 
identify a particular luminaire.  

1. From the Modify menu choose Luminaire-Sort or from the Luminaire toolbar select . 
2. Select the desired sort method. 
3. Click Ok.  

Luminaires may be resequenced and sorted according to six sorting types 

Label 

Sorts luminaires according to the label assigned in the Define Luminaire dialog box. Possible application – interiors. 

 

 

Top to Bottom, Left to Right 

Sorts Left to Right by increasing X-coordinate. If multiple luminaires are found at the same X-coordinate, they are subsequently sorted Top to Bottom 
by decreasing Y-coordinate. Possible application – Left to right flow, Roadway, Parking, Facade. 
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Bottom to Top, Left to Right 

Sorts Bottom to Top by increasing Y-coordinate. If multiple luminaires are found at the same Y-coordinate, they are subsequently sorted Left to Right 
by increasing X-coordinate. Possible application – Bottom to top flow, Roadway, Parking. 

 

 

Sort Left to Right, Bottom to Top 

Sorts Bottom to Top by decreasing Y-coordinate. If multiple luminaires are found at the same Y-coordinate, they are subsequently sorted Left to 
Right by increasing X-coordinate. Possible application – Bottom to Top flow, Roadway, Parking. 
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Counterclockwise Rotation 

Sorts luminaires in a Counterclockwise direction starting at the Starting Angle. The first luminaire placed by this sort method is located off the center 
point. This point is determined by averaging the minimum and maximum X and Y luminaire coordinates. The sort then sweeps counterclockwise 
about the center point 360 degrees. Possible application – racetracks, sports, arenas. 

 

 

Clockwise Rotation 

Sorts luminaires in a Clockwise direction starting at the Starting Angle. The first luminaire placed by this sort method is located off the center point. 
This point is determined by averaging the minimum and maximum X and Y luminaire coordinates. The sort then sweeps clockwise about the center 
point 360 degrees. Possible application – racetracks, sports, arenas. 
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Modify Objects and Rooms 

Modify Objects 

Arraying Objects - Concepts 

Individual or Library objects can be duplicated in a uniformly spaced fashion in a copying method called Array. AGi32 provides two types of Arrays: 
Rectangular and Polar. Rectangular arrays create rectilinear, three dimensional duplication sets that are specified with X, Y and Z quantities and 
spacings. Polar arrays create three dimensional circular or semi-circular duplication sets that are specified with angle, quantity and rotation criteria. 
Both array types can provide enormous time savers when it is necessary to create repetitive elements such as cubicles, parking barriers, partitions, 
furniture and more. 

Rectangular Arrays 

Rectangular Arrays are created by specifying three criteria types; Number of Objects, Spacing of Objects and Array Angle. 

Number of Objects in X, Y or Z Direction - Indicates the total number of objects in the stated direction, including the original, after the array is 
created. There will always be at least one object in each direction. 

Spacing in X, Y or Z Direction - Indicates the distance between objects, from start of one object to start of another, in the stated direction. Units are 
specified using the current Display Unit, Feet or Meters. A spacing of zero is equivalent to no objects arrayed in stated direction. 

Array Angle (X Direction) - Indicates counterclockwise rotation of array from due East or zero degrees horizontal in world coordinates. The 
orientation of the objects in the array will be identical to the original. Spacing between objects in an angled array will be measured along the direction 
of the array, not parallel to the Cartesian axis. 

Polar Arrays 

Objects can be duplicated along a circular or semi-circular path using the Object Polar Array command. The specification criteria includes Starting 
and Ending angles of the Array, center point, number of locations to be produced and object orientation. The object orientation can either be the 
same as the original or directed outward from the array center. The inward orientation is disabled for object polar arrays, because it produces 
identical results as an outward orientation. 

Selection Point - When the Object-Polar Array command is initiated, the cursor changes to a pickbox so that an individual object may be selected. 
The selection point should be chosen carefully, because this location becomes a reference point by which the objects will be arrayed. Selecting the 
corner of an object will produce different results than selecting the midpoint of a side. Consider this example: 
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In the example on the left, the selection point was the lower left corner of the original object. The array operation duplicates the original object around 
a circular path with this corner used as the reference point. The example on the right uses the same exact parameters with the exception of the 
reference point. The selection point chosen is in the middle of the left short side instead of the corner. The resultant array is now symmetrical. 

As the above example illustrates, the initial starting point location is critical to the placement of arrayed objects. 

Array Center Point - Once the object is selected, you are prompted for the location of the polar array center. The distance specified is the radius of 
the array and dictates the distance that each duplicate object will be located from the array center. The angle between the selection point and the 
array center is the Starting Angle. This starting Angle may not be altered, so choose your center point deliberately. Tip: Polar Arrays are always 
created in a counter clockwise direction. 

Careful selection of the array center point will allow you to create symmetrical arrays or relatively abstract ones. 

Starting Angle - The Starting Angle of the array is determined by the angle formed between a line formed from selection point to array center and a 
line formed between array center to due East. This angle cannot be entered manually by the user, it is determined by the location of the selection 
point and the array center point. 

 

 

Ending Angle - The Ending Angle of the array dictates the location of the last object to be placed in the array. If the Ending Angle is equal to the 
Starting Angle the array will form a complete circle. In this case, there is an object placed at the Starting Angle but not the Ending Angle, otherwise 
two objects would occupy the same position. If the Ending Angle does not equal the Starting Angle, an object is placed at both the Starting and 
Ending Angles.  

Number of Locations - This value indicates the total number of objects in the polar array, including the original object. The total number of objects in 
the array must be two or more. 

Angle Increment - This value describes the angle between each pair of objects in the polar array. 

• If Starting Angle Does Not Equal Ending Angle - Angle Increment is calculated this way: (Ending Angle - Starting Angle) / (Number of Locations 
- 1) 

• If Starting Angle Equals Ending Angle - Angle Increment is calculated this way: (Ending Angle - Starting Angle) / (Number of Locations) 

Entity Orientation - Two selections are provided for object orientation. 
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• Same as Selected Entity - Indicates that all objects created in the array will be oriented the same as the original. 

• Same as Polar Angle (Orient way from center of array) - Indicates that all objects created in the array will be oriented away from the array center 
and in alignment with the displacement vector. 

• The Opposite of Polar Array and Perpendicular to Polar Array options are disabled for objects. 

 

Orientation - Same as Selected Entity 

 

Orientation - Same as Polar Angle (Orient way from center of array) 

  

Arraying Objects 

Objects can be duplicated in a rectangular or polar (circular) manner, where each incremental object is a duplicate of the original. This type of 
duplication is called an array. In each type of array, the newly created objects may be modified independently of the rest of the objects. Rectangular 
arrays are used to create evenly spaced rows, columns and/or grids of objects. Polar arrays are used to specify circular or semicircular arrangements 
with evenly spaced luminaires. 

What do you want to do? 

Create a rectangular array of objects 

Create a polar array of objects 

Object Rectangular Array 

The Object-Rectangular Array command allows you to create a rectangular grid, or matrix, of objects. The rectangular array is comprised of 
replicated objects in the X, Y and/or Z directions. If desired, you may translate the array about the X axis to create an aligned array. The spacing 
between objects is defined as the distance from the center of one object to the center of the next. 

1. From the Modify menu choose Object-Array-Rectangular, or from the Rooms/Objects toolbar select . 
2. Select an object to array. 
3. Enter the quantity of objects in each direction and the spacing between them. Spacing value is ignored when Quantity equals One. 
4. If an aligned array is desired, enter the angle from the X-axis that the array is to be rotated. 
5. Click Ok.  

Object Polar Array 

The Object-Polar Array command creates a circular or semicircular arrangement of objects about a center point. Each object in the array is a replica 
of the original object and is modified independently. Each object copy will be labeled with the original object name and appended with “-#.” 

For example: Array an object called column, creating 5 copies. The copies will be labeled: “column_1”, “column_2”, “column_3”, “column_4” and 
“column_5.” 

1. From the Modify menu choose Object-Array-Polar, or from the Rooms/Objects toolbar select . Left click on the pull-down arrow to the 
right of the button to invoke the secondary menu. Select Polar. 

2. Select an object to array. The selection point will determine whether the objects are inscribed in, or circumscribed about, an imaginary circle. 
3. Drag the cursor to the center point of the array and click the left mouse button again. These two points define the distance and starting angle for 

the array. 
4. In the Polar Array dialog, specify the ending angle. 
5. Specify the number of object locations in the array. 
6. Specify the appropriate object orientation; same as selected entity, same as polar angle or opposite of polar angle. 
7. Click Ok. 
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Copying Objects - Concepts 

The ability to copy objects is of substantial value in the modeling of complex architectural spaces. AGi32 allows you to copy individual or multiple 
objects to multiple additional locations. 

Technical Details 

Copies will retain the original object attributes such as Side Height and color/reflectance. Once an object is copied, its properties can be modified 
with the Edit Object command. 

Calculation points placed on the object surfaces with the Automatic Placement command are not duplicated with the object when copied. Calculation 
points can be easily placed on the newly copied objects using the same procedure. 

Any Labeling applied to the object will also be retained, however, if any labels have been moved on the original, they will be returned to their original 
locations on the copied objects. 

Each object copy will be labeled with the original object name and appended with “ _#” (e.g. _1, _2, etc.) For example, if objectABC is copied twice, 
the first copy will be labeled objectABC_1, the second objectABC_2. 

The selected object will be displayed using the Selected Entity Color (default color is gray). The Selected Entity Color may be changed in the 
Defaults tab of the System Settings dialog. 

Copying Objects 

Objects can be easily selected and copied to any number of locations within the job file. You may select an object individually or window around a 
selection of objects. The copied objects are recreations of the original object; any relocated object labels will be returned to their original locations. 
Each object copy will be labeled with the original object name and appended with “-#.” 

For example: An object originally labeled column would have copies called “column_1”, “column_2,” etc. 

1. From the Modify menu select Object-Copy, or from the Rooms/Objects Toolbar select . 
2. Select Single or Window. By default, clicking on the Copy Object button invokes the Single selection option. To select multiple objects, left click 

on the pull-down arrow to the right of the button to invoke the secondary menu. Select Window. 
3. Select the objects to be copied. 
4. Select the point to copy from with the mouse. 
5. Drag the copied objects to their new location and left click again. 
6. Continue inserting copies or press ENTER (right mouse click) to end the command.  

Render Symbol Rules 

1. Symbols in Render Mode are created using objects in AGi32.  
2. Imported 3D CAD models converted to objects may also be used, as long as Luminance is assigned to the luminous surfaces (see rule #3). 
3. Surfaces with non-zero reflectance and zero luminance are assigned as housing surfaces. Surfaces with positive luminance values (assign a 

Luminance value using the Surface Edit command) are assigned as the luminous surfaces of the symbol. 
4. The Luminance value itself is irrelevant - any positive value is an indicator (e.g., you can assign a Luminance value of 1 for simplicity). 
5. Surfaces may be removed to simplify the symbol or to create more-complex symbols. 
6. Transmittance values are not considered in the symbol creation. 
7. Any assignment of housing color is overridden; the housing is assigned a dark gray exterior, 0.2 reflectance, by default. 
8. All surfaces in the symbol also become single sided, regardless of their original surface type. The original surface normal direction applies, and 

may need to flipped before the symbol is created, using the Surface Edit command. Normals should point outward. 
9. Any object may be edited to change one of its surface attributes. For example, to create a 2x4 lensed troffer symbol, you could create a 2x4 

Rectangular-Flat object. Edit the object and assign a Luminance value of 1 cd/m2 to the bottom surface  to assign it as the luminous surface. 
10. As a general rule, symbols should be created at Z=0 and above or at Z=0 and below. A symbol should not have surfaces above and below 0, for 

ease of placement. Symbols that are located at Z=0 and above are assigned an insertion point = Bottom for the symbol. Symbols that are 
located at Z=0 and below are assigned an insertion point = Top for the symbol. The insertion point for the luminaire should also be placed at 
Z=0 as well. 

11. When creating symbols with yokes, the distance between the luminous surface and the yoke base should be at least 1 foot. This distance 
separates the luminous box from the pole enough so that the pole does not obstruct the luminous box. We recommend creating the base of the 
yoke at Z=0 and the remainder of the symbol above to insert the symbol at the bottom of the yoke. 

12. When creating ceiling-recessed symbols, create the symbol housing at Z=0 using a planar object. Create the luminous surface slightly below the 
symbol at Z = -0.01 or less. The symbol will be inserted at the Top of the symbol. 

Create Render Luminaire Symbol 

This command allows you to create custom luminaire symbols used in Render Mode using objects in AGi32. The three-dimensional luminaire 
symbols should be created to actual size, since the user can change the Scaling Factors of symbols as necessary. Luminaire symbols that are larger 
than 8’ x 8’ may overrun the display section in the Luminaire Symbols dialog. 
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The current object properties (surface color, reflectance and wireframe color) are not maintained with the symbol. The user can specify these 
properties when selecting the symbol from the Luminaire Define dialog. The housing of the symbol (surfaces with reflectances > 0) are assigned one 
global housing color. The exception to this are surfaces with non zero Luminance values. These surfaces define the luminous surfaces of the 
luminaire.  

The luminaire symbol must contain at least one luminous surface (Luminance > 0) in order to create the Render luminaire symbol. Luminance may 
be any value greater than zero and is assigned to the surface from the Surface Edit command - Advanced Surface Properties section. 

We recommend that you store user-defined symbols in the Custom Symbols folder, or one of your own, so that you may share your symbols with 
other users. This is accomplished by copying these folders into the AGi32\Symbols folder. You cannot overwrite any luminaire symbols found in the 
General symbols folder, but you can overwrite symbols found in any other folder. 

Check the Concepts tab (above) for all the Render Symbol Rules. 

To create a Render luminaire symbol: 

1. Draw the symbol using AGI32’s objects commands, or import a 3D CAD file into AGi32 and choose to import the 3D entities into objects. 
2. Using Surface Edit, in the Advanced Surface Properties section, designate at least one surface of the object as luminous by setting the 

Luminance (cd/sq.m) to a value greater than zero. Note that the Luminance value itself is irrelevant; any positive value is an indicator (e.g., you 
can assign a Luminance value of 1 for simplicity). 

3. From the Modify menu select Object - Create Render Luminaire Symbol, or from the Rooms/Objects toolbar select . 
4. Select Single or Window. Click on the arrow adjacent to the Create Render Luminaire Symbol button to select Window. 
5. Select the objects to include in the symbol. 
6. Specify the point on the symbol that will correspond to the luminaire insertion point. The Z coordinate of the insertion point should be 0. 

6. The custom symbol may be saved as a Render symbol (surfaces considered) and/or as a Model symbol (wireframe only). The default option 
allows you to save the symbol in both modes. For example, our parabolic troffer is available as a symbolic representation (Model Mode) and as 
a luminaire representation (Render Mode). 

7. Enter the symbol name in the Symbol Name text box. We recommend using short symbol names so that they display well in the Symbol dialog. 
8. Select the folder to save the symbol file in, or click the New Folder button to create a new folder. 
9. Click Ok. 

Deleting Objects - Concepts 

Objects placed in the AGi32 job file can be deleted using Single or Window selection methods. Library Objects are deleted just like individual objects. 
Components of Library Objects can be deleted individually by first exploding the object. 

The Single selection method allows you to select objects individually. You may choose just one object, or individually select multiple objects for 
deletion. The Window selection method allows you to select a group of objects, by windowing on the objects such that all of the objects are contained 
within the selection window or that the window crosses the objects that are to be included. 

You must right click, once the desired objects are selected, to confirm your selection and actually delete the objects. 

Deleting objects will also remove all text labels that were associated with the object. Any calculation grids added to the original object with the 
Calculation Points-Automatic Placement command will also be deleted. 

Deleting Objects 

This command deletes the selected object or objects. You may select an object individually or window around a selection of objects. 

1. From the Modify menu select Object-Delete, or from the Rooms/Objects toolbar select . To delete multiple objects, left click on the pull-
down arrow to the right of the button to invoke the secondary menu. Select Window. 

2. Select the object to be deleted with the left mouse button. To window around multiple objects, select the opposing corners of a window that 
surrounds all of the desired objects. 

3. Press ENTER (right mouse click) to confirm your selection and delete the room. 

Editing Objects - Concepts 

Objects placed in AGi32 can be edited at any time after they are created. Only one object may be selected during any single Edit session. However, 
if you are interested in modifying the object surface properties (such as color/reflectance, texture, etc.), the Surface Edit command allows you to 
select multiple objects at once. 

Each individual object type has both common and unique properties. Selecting an object with the Edit Object command will open a dialog specific to 
that object type. 

All object properties displayed in the dialog may be modified. Non-geometric or surface modifications can be made without having to recalculate - 
Labeling, Description and Wireframe color. Surface modifications will require recalculation. Geometric modifications will also require recalculation 
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 and may require recreation, depending on the modification applied. For example, if you change the Height on a Round-Sphere-Object , the object 
needs to be recreated. When a object is recreated, its surface attributes default to their original parameters. Most importantly, flipped surfaces 
(surfaces whose normals were modified to face the opposite direction from their original specification) will be lost when the object is recreated. In 
these cases, simply flip the surfaces back with the Surface Edit command. 

The Edit dialogs allow you to change the Geometric and General properties directly. A 3D preview of all object surfaces is shown in the dialog. To 
edit any of the surface attributes, click the Surface Edit button to show the Surface Edit dialog. 

Curved Surfaces 

AGi32 approximates curved surfaces with a series of rectangular planar objects (flat objects). The parameter specifying the angular increment used 
is Initial Curve Increment specified in the Advanced System Settings dialog. Increasing or decreasing this value will not affect the current object. You 
must recreate the object with the appropriate Add-Object command to change the number of panels in the object arcs. 

Note: AGi32 automatically smooths adjacent surfaces composing a dome or arc, for presentation purposes in Render mode. If all that is desired is a 
smoother appearance, AGi32 provides that automatically. However, if you require more surfaces for calculation or geometric modeling  purposes, 
then the Initial Curve Increment modification is necessary. 

Related Topics 

Object Concepts 

Object Labeling 

Editing Objects 

Objects may be edited to change their label, description, wireframe color labeling options, height and/or surface reflectances, transmittances and 
textures. 

Each object is edited in a modified version of the original Add dialog. These dialogs provide all of the original properties in addition to some more 
editing capabilities. 

What do you want to do? 

Edit a rectangular object 

Edit a flat rectangular object 

Edit a vertical extrusion rectangular object 

Edit a round object 

Edit a flat round/elliptical object 

Edit a vertical rotation round/elliptical object 

Edit a cone object 

Edit a sphere object 

Edit a polygonal object 

Edit a flat Polygon object 

Edit a vertical extrusion Polygon object 

  

Edit a planar object 

Edit a library object 

Editying Object Types 

Edit a Rectangular Barrel Vault Object 
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The Edit Rectangular Object with a Barrel Vault Roof dialog looks similar to the original ‘Add’ dialog, with the addition of an Object Preview at the 
bottom. You may change the object label, description, wire frame color, labeling options, wall height, vault height and vault width. In addition, you 
may edit each surface's properties by clicking the Surface Edit button, if desired. 

If you have moved or deleted a object label prior to editing, it will be replaced in its original location after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after any object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Flat Rectangular Object 

The Edit Flat Rectangular Object dialog looks just like the original ‘Add’ dialog, with the addition of an Object Preview at the bottom. You may change 
the object label, description, wire frame color labeling options and side height. In addition, you may edit each surface's properties by clicking the 
Surface Edit button, if desired. 

If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Emittance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Rectangular Gable Object 

The Edit Rectangular Object with a Gable Roof dialog looks similar to the original ‘Add’ dialog, with the addition of a Object Preview at the bottom. 
You may change the object label, description, wire frame color, labeling options, wall height, and gable height. In addition, you may edit each 
surface's properties by clicking the Surface Edit button, if desired. 

If you have moved or deleted a object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after any object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Rectangular Hip Object 

The Edit Rectangular Object with a Hip Roof dialog looks similar to the original ‘Add’ dialog, with the addition of a Object Preview at the bottom. You 
may change the object label, description, wire frame color labeling options, wall height, hip height and hip length. In addition, you may edit each 
surface's properties by clicking the Surface Edit button, if desired. 
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If you have moved or deleted a object label prior to editing, it will be replaced in its original location after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after any object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Rectangular Pyramid Object 

The Edit Rectangular Object with a Pyramid Roof dialog looks similar to the original ‘Add’ dialog, with the addition of a Object Preview at the bottom. 
You may change the object label, description, wire frame color labeling options, wall height and pyramid height. In addition, you may edit each 
surface's properties by clicking the Surface Edit button, if desired. 

If you have moved or deleted a object label prior to editing, it will be replaced in its original location after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after any object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Rectangular Vertical Extrusion Object 

The Edit Rectangular Vertical Extrusion Object dialog looks similar to the original ‘Add’ dialog, with the addition of an Object Preview at the bottom. 
You may change the object label, description, wire frame color, labeling options and side height. In addition, you may edit each surface's properties 
by clicking the Surface Edit button, if desired. 

If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the object surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Round/Elliptical Object with a Dome Roof 

The Edit Round/Elliptical Object with a Dome Roof dialog looks similar to the original ‘Add’ dialog, with the addition of a Object Preview at the bottom. 
You may change the object label, description, wire frame color labeling options, wall height and dome height. In addition, you may edit each surface's 
properties by clicking the Surface Edit button, if desired. 
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If you have moved or deleted a object label prior to editing, it will be replaced in its original location after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after any object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Round/Elliptical Flat Object 

The Edit Round/Elliptical Flat Object dialog looks similar to the original ‘Add’ dialog, with the addition of an Object Preview at the bottom. You may 
change the object label, description, wire frame color labeling options and side height. In addition, you may edit each surface's properties by clicking 
the Surface Edit button, if desired. 

If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Round/Elliptical Vertical Rotation Object 

The Edit Vertical Rotation Round/Elliptical Object dialog looks similar to the original ‘Add’ dialog, with the addition of a surface matrix. You may 
change the object label, description, wire frame color, labeling options and side height. In addition, you may edit each surface's properties by clicking 
the Surface Edit button, if desired. 

If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the object surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Cone Object 

The Edit Round/Elliptical Cone Object dialog looks similar to the original ‘Add’ dialog, with the addition of an Object Preview at the bottom. You may 
change the object label, description, wire frame color labeling options and cone height. In addition, you may edit each surface's properties by clicking 
the Surface Edit button, if desired. 
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If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Emittance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Sphere Object 

The Edit Round/Elliptical Sphere Object dialog looks similar to the original ‘Add’ dialog, with the addition of an Object Preview at the bottom. You may 
change the object label, description, wire frame color labeling options and sphere height. In addition, you may edit each surface's properties by 
clicking the Surface Edit button, if desired. 

If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Polygon Flat Object 

The Edit Polygon Flat Object dialog looks similar to the original ‘Add’ dialog, with the addition of an Object Preview at the bottom. You may change 
the object label, description, wire frame color labeling options and side height. In addition, you may edit each surface's properties by clicking the 
Surface Edit button, if desired. 

If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Polygon Vertical Extrusion Object 

The Edit Polygon Vertical Extrusion Object dialog looks similar to the original ‘Add’ dialog, with the addition of an Object Preview at the bottom. You 
may change the object label, description, wire frame color labeling options and object depth. In addition, you may edit each surface's properties by 
clicking the Surface Edit button, if desired. 
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If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the object surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Planar Object 

The Edit Planar Object dialog is a truncated version of the original ‘Add’ dialog, with the addition of an Object Preview at the bottom. You may 
change the object label, description, wire frame color and labeling options. In addition, you may edit the surface properties by clicking the Surface 
Edit button, if desired. 

If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the object surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Library Object 

The Edit Library Object dialog looks similar to the original ‘Add’ dialog. You may change the object label, description, wire frame color and labeling 
options. In addition, you may edit each surface's properties by clicking the Surface Edit button, if desired. 

If you have moved or deleted an object label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting object labels until after all object modifications have been made. 

1. From the Modify menu choose Object-Edit, or from the Rooms/Objects toolbar select . 
2. Select the library object by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the object surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Object Surface properties (such as Color, Texture, Transmittance, Transparency, Emittance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  
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Exploding Objects - Concepts 

The Explode Object command operates on AGi32 Library Objects that have been constructed of multiple individual objects or other Library Objects. 
Exploding a Library Object breaks it down into its original objects (those objects that were used to make up the Library Object). Once exploded, 
individual components become ordinary objects that can be modified, scaled, rotated, moved, copied or deleted. 

Imported objects (created from imported 3D CAD models converted to AGi32 Objects) can also be exploded into their individual layers and blocks for 
internal modification. 

Exploding a composite object  can be quite useful  if you need to build upon, or modify structurally, that object. Once modified to meet your needs, 
you can make the collection of objects into a new Library Object and add it to the library of your choice. 

The Explode Object command has no effect on future instances of the Library Object, it only acts on the current selected object. 

Labeling 

Text labels applied to objects will retain their relationship with the exploded object. Any moved text labels will revert to their default locations. 

Calculation points 

Calculation points placed on the Object surfaces with the Automatic Placement command will be deleted. 

Exploding Objects 

The Explode Objects command explodes library objects into their original object components, or imported objects into their individual layers. 

1. From the Modify menu select Object-Explode, or from the Rooms/Objects toolbar select . 
2. Select the library object to be exploded. 
3. Right click to confirm your selection and explode the selected object. 

Make Library Object - Concepts 

Any number of previously created objects can be combined into a composite Library Object and stored in an object library for later use. The Make 
Library Object command allows both the addition of a composite object into an existing object library and the creation of new libraries for your 
objects. Once an object has been stored in a library, it can be recalled from any job file and modified as necessary. 

Library objects can be extremely useful in shortening the input time required for many projects. By storing complex objects that have been created 
previously, you have the ability to add them to future projects with just a few mouse clicks. Objects not only assist in modeling accuracy for items that 
have impact on calculated lighting results, they can also add realism and scale to your projects when examined in the rendered views. 

Several object libraries are delivered with AGi32 for your use. However, you will most likely find it necessary (and fun) to create other libraries of your 
own relative to the types of applications that you most often tackle. Objects within the factory delivered libraries are protected, and you may not add 
your own objects to these libraries. However, these Library Objects can be modified and saved as new Library Objects in your own libraries. 

Library objects can also be created from 3D CAD models imported into AGi32 and converted into AGi32 objects. Library Objects will obviously be 
something you create and use on a regular basis as you become more proficient with AGi32. 

Creating a library object 

Library objects are created from other objects that already exist in the current job file. A library object can contain a single object or multiple objects 
grouped together. The objects used may be created with AGi32's various Object command or from an imported 3D CAD model that has been 
converted to AGi32 objects. 

Before selecting the Make Library Object command, make sure that all objects that will be contained in the Library Object are in the appropriate 
positions relative to each other as this cannot be changed once the Library Object is created. To change these positions, after the fact, you would 
need to recall the Library Object into the job file, explode it, make the necessary modifications, then Make the Library Object again to save your 
changes. 

To create a Library Object, use the Make Library Object command. Two selection methods are provided. The Single selection method allows you to 
select objects individually. You may choose just one object, or individually select multiple objects for inclusion. The Window selection method allows 
you to select a group of objects, by windowing on the objects such that all of the objects are contained within the selection window or that the window 
crosses the objects that are to be included. 

Once the objects are selected, they will be displayed using Selected Entity Color (gray by default) specified in System Settings. AGi32 will prompt for 
an Insertion Point next. The insertion point determines the X, Y and Z reference point of the new library object. This point determines how the 
composite objects are attached to the crosshairs when the object is inserted in the future. Usually, it is wise to make the insertion point the center of 
the composite object or one of the exterior vertices. 
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Creating new object libraries 

Library Objects may be added to any existing unprotected library (or a protected library, where the password is known) or to a new library of your 
own making. 

Object Libraries can be password protected in many ways to prevent others from modifying them or even using them. In most cases, protection is 
unnecessary. 

• Library Properties Protected - Protecting the properties of an object library indicates that all objects in the library are accessible, however, the 
Library Properties themselves (Library Name, Description, and Created By information) cannot be modified without the correct password. 

• Write Protected - A Write Protected Library indicates that all objects in the library are accessible, however, it will not allow new objects to be 
added to the Library or existing objects to be deleted from the Library without the correct password. This mode of protection is used with all of 
the delivered AGi32 libraries. 

• Read Protected - A read Protected Library cannot be used without the correct password. This is an extreme method of protection that may be 
used with commercial libraries that are available for a fee. 

Once the object has been added to the library 

Once the composite objects have been added to the library, and saved as a new Library Object, the original occurrences of the individual objects will 
be removed from the local job file. It is assumed that your are interested in placing occurrences of the new Library Object in your job file. AGi32 
automatically displays the Select Library Object dialog. If you are not interested in adding the Library Object to your current job file, simply Cancel. 
Your new Library Object has already been placed into the library you chose, you are only cancelling the ability to place this Library Object in your job 
file. 

Transporting or sharing Object Libraries 

Object libraries can be shared between AGi32 installations such that one user can create a library of objects and make it available to others. 

Object Libraries are stored in the C:\Program Files\Lighting Analysts\AGi32\Object Libraries folder and are given the .OBL extension. Once created, 
OBL files can be transported between computers, Simply, copy the OBL files you want to share to the C:\Program Files\Lighting 
Analysts\AGi32\Object Libraries folder on the other computers. AGi32 will automatically see the new Object Libraries the next time the Add Library 
Object or Make Library Object commands are used.   

Make Library Object 

Any number of previously created objects can be combined into a composite Library Object and stored in an object library for later use. Once an 
object has been stored in a library, it can be recalled from any job file and modified as necessary. 

1. From the Modify menu select Object-Make Library Object, or from the Rooms/Objects toolbar select . To select multiple objects, left 
click on the pull-down arrow to the right of the Make Library Object button to invoke the secondary menu. Select Window. 

2. Select the object or objects to include in the library object. 
3. Select, or enter the coordinates of, the library object insertion point. 
4. Enter a label for this library object. Label names must be unique within each library. 
5. If desired, you may include a detailed description of the object (size, color etc.). 
6. Select a library for the object. To create a new library, click on the New button. 
7. You may change a library’s properties by clicking on the Properties button. 
8. Click Ok. 
9. The original objects used to create the library object will be deleted from the job file and the Select Library Object dialog will automatically 

appear. At this time you may insert this library object, or any other, into the job file. 

Create Object Library 

Object libraries are stored in the Object Libraries folder in the AGi32 folder and are characterized by their OBL extension. Object libraries can be 
transported to other AGi32 installations by copying the OBL file to the Object Libraries folder on the other computer. 

When sharing object libraries, we recommend protecting them to maintain their original integrity. When the library is created, you are offered four 
levels of protection: 

• No protection – objects may be added to and deleted from the library as desired. Full access to the objects within the library is provided to any 
user and the library properties, Created By, Revision, Protection options, Password, may be changed at will. 

• Library Properties Protected – this option protects the library properties from being modified without a password. When password protected, the 
Library Properties dialog will appear empty unless a valid password is used. 

• Write Protected – this option prevents anyone from adding objects to or deleting objects from the library without entering the proper password. 
• Read Protected – this option prevents anyone from accessing objects from the library without entering the proper password. 

Do not forget your password! There is no other location where the password can be accessed and changed. 

1. Enter a unique library name. We suggest using a name that easily identifies objects in the library, such as Office Furniture, Trees, Cars, etc. 
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2. If desired, enter a detailed description of the library. 
3. By default, the Created By text box information defaults to the company name found in the Update User Information dialog. 
4. Enter a revision number for this library. 
5. Select the Protection options, and enter a password. 
6. Click Ok.  

Object Library Properties 

The Object Library Properties dialog allows you to modify the library description, Created By and Revision info and Protection options. You can not 
change the Library name. 

If the Library Properties are protected, you will be presented with a Password Request form first. Unless the proper password is entered, you will not 
be allowed to view or modify the library properties. 

Four levels of protection are offered for object libraries: 

• No protection – objects may be added to and deleted from the library as desired. Full access to the objects within the library is provided to any 
user and the library properties, Created By, Revision, Protection options and Password, may be changed at will. 

• Library Properties Protected – this option protects the library properties from being modified without a password. When password protected, the 
Library Properties dialog will appear empty unless a valid password is used. 

• Write Protected – this option prevents anyone from adding objects to or deleting objects from the library without entering the proper password. 
• Read Protected – this option prevents anyone from accessing objects from the library without entering the proper password. 

Moving Objects - Concepts 

Moving objects is similar to moving other entities in AGi32. 

When objects are moved, any text labeling that had been previously moved will be returned to its original position. Calculation points placed on the 
Object surfaces will be deleted. 

Moving Objects 

When objects are moved, the original object definition is accessed and relocated. If any object labels were moved prior to moving the object, they will 
be reinserted in their original location once the object is moved. To move objects in a job file, select the desired objects, the starting point and 
destination point. The two points define a displacement vector that indicates the distance the objects will to be moved and their relative direction. You 
may select an object individually or window around a selection of objects. 

1. From the Modify menu select Object-Move, or from the Rooms/Objects toolbar select . 
2. Select Single or Window. By default, clicking on the Move Object button invokes the Single selection option. To select multiple objects, left click 

on the pull-down arrow to the right of the button to invoke the secondary menu. Select Window. 
3. Select the objects to be moved. 
4. Select the point to move from by clicking on it with the left mouse button. 
5. Drag the cursor to the new location point and left click again.  

Modifying Object Labels - Concepts 

Text Labels can be added to Objects to identify object attributes (such as Label, reflectance, coordinates, etc.) using the Labeling button in the 
Object dialogs. Labels may be added to objects in the original Add dialog, when the object is initially specified, or after the object is created, in the 
Edit dialog. 

Object Labels are dynamic. If the object properties are modified and a object Label is selected that references this attribute (e.g. Wall Height), the 
label will automatically update when the attribute changes. 

Once a label is created, it may be moved or deleted as desired. Moving individual labels may be advantageous as the label may interfere with other 
data on the drawing. 

Object Labels may be removed in two ways. On an individual basis, they can be deleted one at a time. To remove all labels from the object, deselect 
the labels used by Editing the object and clicking the Labeling button. 

Some Object Labels cannot be separated into separate lines. Object Labels (Object Label, Description, Project Name), Object Component Labels 
(Component Label, Coordinates) and Object Component Surface Labels (Surface Label, Reflectance/Transmission) are placed together as a 
paragraph and are moved and deleted as such.  

Modifying Object Labels 

Object labels can be moved or deleted from their original locations at any time. However, if the object is edited after the labels have been moved or 
deleted, the labels will be replaced in their original locations. 



AGi32 Help System  Modifying Entities 

329 

 

What do you want to do? 

Delete object labels 

Move Object Labels 

Moving Object Labels 

Object labels may be moved from their default location to another location to improve the visual clarity of the presentation. When the label is selected 
the entire label is moved from one location (Object – Object Label, Project Name, etc.) to another. Object labels should not be moved until after all 
object modifications have been made, since they return to their default location whenever the object is modified. 

1. From the Modify menu select Object-Labels-Move, or from the Rooms/Objects toolbar select . Left click on the pull-down arrow to the 
right of the Object Labels button to invoke the secondary menu. Select Move. 

2. Select the label to move. 
3. Locate the point to move the label from and click the left mouse button. 
4. Drag the label to its new location and left click again. 

Deleting Object Labels 

Object labels may be deleted on an individual basis. 

1. From the Modify menu select Object-Labels-Delete, or from the Rooms/Objects toolbar select . 
2. Select the label to be deleted. 
3. Continue selecting labels in this manner, if desired. When complete, press ENTER (right mouse click) to confirm your selections and delete the 

labels. 

Rotating Objects - Concepts 

Objects can be rotated either clockwise or counterclockwise from their original position by any angle. Angles can be specified from the keyboard 
relative to due East (0 degrees in world coordinates) or by freely rotating the object using the mouse. 

The specified angle will rotate the selection from a 0-degree orientation around the base point by that angle. Whether the entities are rotated 
counterclockwise or clockwise depends on the sign of the rotation angle (+/-); + is counterclockwise, - is clockwise. The rotation angle may be 
specified by entering a numeric value or by dragging the mouse to indicate the desired rotation angle. 

Rotating Objects in Elevation View 

When rotating an object in Elevation View, the object is always rotated about the axis perpendicular to the selected Elevation View.  

Three Angle rotation 

A viable alternative to rotating objects in Elevation View is to use the Rotate Objects - Three Angle command instead. This command is only 
available in Isometric or Plan View.  

Labeling 

Text labels applied to objects will appear to rotate with the selected object. However, when the rotation is concluded the labels will be reoriented to 
be legible from left to right. Any moved text labels will revert to their default locations. 

Editing rotated objects 

Once an object has been rotated in Elevation View, it may not be edited for geometric changes, however, its surface properties may be changed 
using the Surface Edit command. 

Calculation points 

Calculation points placed on the Object surfaces with the Automatic Placement command will be deleted one the object is rotated. They can easily 
be recreated on the newly rotated objects using the Automatic Placement command again.  

Rotating Objects - Procedure 

Objects can be rotated about the Z axis using a user defined base point in Plan View or Isometric views or about the X or Y Axis in Elevation View. 
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1. From the Modify menu select Object-Rotate, or from the Rooms/Objects toolbar select .. To rotate multiple objects at once, select the 
Window option from the secondary menu. 

2. Select the objects to be rotated. 
3. Select the point to rotate about (the base point). 

• In Plan or Isometric views, the rotation axis is the Z axis. 

• In Elevation View, the rotation axis is perpendicular to the current Elevation view. For example, if you take an Elevation view along the 
X axis, the Y axis is the rotational axis used.  

4. Drag the cursor to, or enter the coordinates of, the rotation angle. 

Rotating Objects - Three Angle - Concepts 

This command is only available in Plan or Isometric views. 

Technical Details 

Rotation angles are applied relative to the object coordinate system (OCS). Specifying the OCS is part of the command process (‘specify object 
orientation angle’). The object orientation angle becomes the X-axis in the OCS. 

All three angles must be specified. Angles are specified one at a time in order (orient, tilt, roll). You can not enter all three angles at one time. 

Pressing the Enter key without specifying an angle will cancel the command. If you do not want to apply a particular angle, simply enter 0 (zero) and 
press the Enter key when prompted for that angle 

Rotating Objects - Three Angle - Procedures 

The Rotate Object - Three Angles command allows the user to apply three rotational angles to any objects selected, in the following order: Orient, Tilt 
and Roll. 

Rotation angles are applied relative to the object coordinate system (OCS). The object orientation angle must be specified and it becomes the X-axis 
in the OCS. 

1. From the Modify menu select Object-Rotate-Three Angle, or from the Rooms/Objects toolbar select the . Left click on the pull-down 
arrow to the right of the button to invoke the secondary menu. Select Rotate-Three Angle - Single or Rotate-Three Angle - Window. 

2. Select the object or objects (window selection) to  be rotated. 
3. Select the 1st point on the local X axis (this axis defines the local X axis of the Object Coordinate system).  
4. Select the 2nd point on the local X axis. 
5. Select the point to rotate about (the base point). 
6. 1st Rotation angle (Orient) – Local X axis rotates horizontally; Rotation is applied about the Z-axis. 
7. 2nd Rotation angle (Tilt) – Local X axis rotates vertically; Rotation is applied about the OCS Y-axis. 
8. 3rd Rotation angle (Roll) – Local Y axis rotates vertically;Rotation is applied about the OCS X-axis. 

Scaling Objects - Concepts 

Objects placed in AGi32 can be scaled to increase or reduce their overall size. The scaling factor is a multiplier applied to all dimensions equally. 
Individual objects or Library Objects may be selected. 

Labeling 

Text labels applied to objects will retain their relationship with the scaled object. However, the text size is not scaled. Any moved text labels will revert 
to their default locations. 

Calculation points 

Calculation points placed on the Object surfaces with the Automatic Placement command will be deleted one the object is scaled. They can easily be 
recreated on the newly rotated objects using the Automatic Placement command again. 

Scaling Objects 

Objects can be scaled up or down in size by entering the appropriate scaling factor. A scale factor greater than one enlarges the object. A scale 
factor less than one reduces the size of the object. All scaling will maintain the entity's aspect ratio. 

1. From the Modify menu select Object-Scale, or from the Rooms/Objects toolbar select . 
2. Select the object to be scaled. 
3. Select the point (base point) to scale about. 
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4. In the Scale dialog box enter the desired scaling factor. For example, a scaling factor of two will double the size of the object about the base 
point. A scaling factor of 0.5 will reduce the size of the object by half. 

 Object Openings 

Object Openings - Concepts 

Object Openings are used to let light pass through adjacent object surfaces (openings must be created in both entities) or from exterior to interior. 
When Daylighting calculations are desired, a Daylight Opening or Daylight Window must be added within the Object Opening for calculation 
purposes. 

Rules for creating flat bottom openings 

1. Openings must be contained within the surface. Attempting to locate a vertex outside the surface will prompt a warning. 
2. The sides of an opening must not cross one another. 
3. Openings can be of any shape and may include arcs (F4). 
4. Openings can be created in either clockwise or counterclockwise directions. 

Limitations of flat bottom openings 

1. Openings cannot be edited in any way, they are fixed. 
2. Openings cannot be copied or arrayed at this time. 
3. Modifications in Object height do not effect flat bottom openings. 

Rules for creating side openings 

1. Openings must be contained within the surface. Attempting to locate a vertex outside the surface will prompt a warning. 
2. The sides of an opening must not cross one another. 
3. Openings can be of any shape and may include arcs (F4). 
4. Openings can be created in either clockwise or counterclockwise directions. 

Limitations of side openings 

1. Openings cannot be edited in any way, they are fixed. 
2. Openings cannot be copied or arrayed at this time. 
3. If  Object height is increased, the opening will stay in the same location relative to the base elevation. 
4. If Object height is decreased, all side openings are lost. 

Rules for creating top openings 

1. Openings must be contained within the surface. Attempting to locate a vertex outside the surface will prompt a warning. 
2. The sides of an opening must not cross one another. 
3. Openings can be of any shape and may include arcs (F4). 
4. Openings can be created in either clockwise or counterclockwise directions. 

Limitations of top openings 

1. Openings cannot be edited in any way, they are fixed. 
2. Openings cannot be copied or arrayed at this time. 
3. Modifications in Object height will cause all Top openings to be lost. 

Related Topics 

Surface View 

Add Object Opening - Bottom 

Creating an opening in the base of an object might be used to append an object to another space thereby utilizing the inside reflectance of the object 
to extend the space. 

In the case of Object Bottom openings, when the object is selected,  AGi32 will automatically change the view to Plan View and zoom to Extents. 

To create a bottom opening 
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1. Select the Object-Opening-Add-To Flat Bottom command from the Modify menu or from the Rooms/Objects toolbar, select . Left click 
on the pull-down arrow to the right of the button to invoke the secondary menu. Select To Flat Bottom. 

2. Select the Object to receive the opening. 
3. Draw the opening on the flat bottom surface, right click to close. The opening can be any shape and can include Arcs (F4). 

Add Object Opening - Side 

The ability to create an opening in the side of an object expands object use beyond applications concerning simple solids. An object can now serve 
as an interior space, much like a room, albeit, with opaque (2-sided walls), or, as an object that displays access to both interior and exterior surfaces. 

The creation of openings utilizes Surface View mode. When you select a surface to locate an opening, AGi32 will display that surface in surface view 
where only entities in the same coordinate plane are visible. In the case of Object Side openings, surface view mode looks at all surfaces from the 
frame of reference of an observer OUTSIDE of the object. 

To create an opening in an object side 

1. Select the Object-Opening-Add-To Side command from the Modify menu or from the Rooms/Objects toolbar, select . 
2. Select the side surface to receive the opening. 
3. Draw the opening on the surface, right click to close. The opening can be any shape and can include Arcs (F4). 

Using Snap when specifying openings 

1. Openings must be contained within the surface. Attempting to locate a vertex outside the surface will prompt a warning. 
2. The sides of an opening must not cross one another. 
3. Openings can be of any shape and may include arcs (F4). 
4. Openings can be created in either clockwise or counterclockwise directions. 

Limitations of top openings 

1. Openings cannot be edited in any way, they are fixed. 
2. Openings cannot be copied or arrayed at this time. 
3. Modifications in Object height will cause all Top openings to be lost.  

Add Object Opening - Top 

Creating an opening in the top of an object could possibly by used in the same way as openings in the base and sides - to extend the space into the 
object itself. However, it might also be used to create more realistic objects, for example: imagine a bottle, then cut the hole in the top. The inside of 
the bottle is now visible. 

In the case of Object Top openings, when the object is selected, AGi32 will automatically change the view to Plan View and zoom to Extents. 

To create a bottom opening 

1. Select the Object-Opening-Add-To Top command from the Modify menu or from the Rooms/Objects toolbar, select . Left click on the 
pull-down arrow to the right of the button to invoke the secondary menu. Select To Flat Top 

2. Select the Object to receive the opening. 
3. Draw the opening on the Top surface, right click to close. The opening can be any shape and can include Arcs (F4).  

Delete Object Opening 

Openings in an Object surface can be deleted by selecting the Modify-Object-Opening-Delete command. 

1. Select the Object-Opening-Delete command from the Modify menu or Rooms/Objects toolbar . 
2. Select the object opening with the pickbox. 
3. Right click to confirm your selection and delete the opening. 

Modify Rooms 

Copying Rooms - Concepts 

Rooms of all types can be copied as required in the current job file. This command is very useful for commercial lighting projects with many rooms of 
the same size and shape - such as office buildings or schools. 
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Technical Details 

Copies will retain the original room attributes such as Wall Height and color/reflectance. Once a room is copied, its properties can be modified with 
the Edit Room command. 

Any Labeling applied to the room will also be retained, however, if any labels have been moved on the original, they will be returned to their original 
locations on the copied rooms. Any grid of points added to the original room with the Calculation Points-Automatic Placement command will not be 
copied with the room. 

Each room copy will be labeled with the original room name and appended with “ _#” (e.g. _1, _2, etc.) For example, if RoomABC is copied twice, the 
first copy will be labeled RoomABC_1, the second RoomABC_2. 

The selected room will be displayed using the Selected Entity Color (default color is gray). The Selected Entity Color may be changed in the Defaults 
tab of the System Settings dialog. 

Related Topics 

Editing Rooms 

Surface Edit (edit material properties of several rooms at once) 

Labeling Rooms 

Moving Rooms 

Copying Rooms 

A single room may be selected and copied to any number of locations within the job file. The copied rooms are recreations of the original room 
definition and any relocated room labels will be returned to their original locations. Each room copy will be labeled with the original room name and 
appended with “-#.” 

For example: A room originally labeled “a” would have copies called “a_1”, “a_2,” etc. 

1. From the Modify menu select Room-Copy, or from the Rooms/Objects toolbar select . 
2. Select the room to be copied. 
3. Select the point to copy from with the mouse. 
4. Drag the room copy to its new location and left click again. 
5. Continue inserting copies or press ENTER (right mouse click) to end the command.  

Deleting Rooms - Concepts 

Rooms placed in the AGi32 job file can be deleted with the Modify - Room - Delete command, or by clicking the Delete Room button in the 

Rooms/Objects Toolkit.  

Once the desired room is selected, right click to confirm your selection and delete the room. 

Deleting rooms will also remove all text labels that were associated with the rooms. Any calculation grids added to the original room with the 
Calculation Points - Automatic Placement command will also be deleted. 

Deleting Rooms 

This command deletes the selected room and any associated calculation points. 

1. From the Modify menu select Room-Delete, or from the Rooms/Objects toolbar select . 
2. Select the room to be deleted by locating the pickbox cursor over the room border and left clicking. 
3. Continue selecting rooms in this manner, if desired. When complete, press ENTER (right mouse click) to confirm your selections and delete the 

rooms. 

Editing Rooms - Concepts 

Rooms placed in AGi32 can be edited at any time after they are created. Only one room may be selected during any single Edit session. However, if 
you are interested in modifying the room surface properties (such as color/reflectance, texture, etc.), the Surface Edit command allows you to select 
multiple rooms at once. 

Each individual room type has both common and unique properties. Selecting a room with the Edit Room command will open a dialog specific to that 
room type. 
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All room properties displayed in the dialog may be modified. Non-geometric or surface modifications can be made without having to recalculate - 
Labeling, Description and Wireframe color. Surface modifications will require recalculation. Geometric modifications will also require recalculation 
 and may require recreation, depending on the modification applied. For example, if you change the Dome Height on a Round-Dome Room, the room 
needs to be recreated. When a room is recreated, its surface attributes default to their original parameters. Most importantly, flipped surfaces 
(surfaces whose normals were modified to face the opposite direction from their original specification) will be lost when the room is recreated. In 
these cases, simply flip the surfaces back with the Surface Edit command. 

The Edit dialogs allow you to change the Geometric and General properties directly. A 3D preview of all room surfaces is shown in the dialog. To edit 
any of the surface attributes, click the Surface Edit button to show the Surface Edit dialog. 

Curved Surfaces 

AGi32 approximates curved surfaces with a series of rectangular planar objects (flat objects). The parameter specifying the angular increment used 
is Initial Curve Increment specified in the Advanced System Settings dialog. Increasing or decreasing this value will not affect current rooms. You 
must recreate the room with the appropriate Add-Room command to change the number of panels in the room arcs or domes. 

Note: AGi32 automatically smooths adjacent surfaces composing a dome or arc, for presentation purposes in Render mode. If all that is desired is a 
smoother appearance, AGi32 provides that automatically. However, if you require more surfaces for calculation or geometric modeling  purposes, 
then the Initial Curve Increment modification is necessary. 

Related Topics 

Room Concepts 

Room Labeling  

Editing Rooms 

You can edit rooms after they have been located in the drawing. Editing functions include but may not be limited to new wall heights, wireframe color, 
labeling and surface modifications. 

Each room is edited in a modified version of the original Add dialog. These dialogs provide all of the original properties in addition to some more 
editing capabilities. 

What do you want to do? 

Edit a rectangular room 

Edit a rectangular flat room 

Edit a rectangular barrel vault room 

Edit a rectangular gable room 

Edit a rectangular hip room 

Edit a rectangular pyramid room 

Edit a rectangular vertical extrusion room 

Edit a round room 

Edit a round/elliptical flat room 

Edit a round/elliptical dome room 

Edit a round/elliptical vertical rotation room 

  

Edit a polygon room 

Edit a polygon flat room 

 Editying Room Types 

Edit a Rectangular Flat Room 
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The Edit Rectangular Room with Flat Ceiling dialog looks just like the original ‘Add’ dialog, with the addition of a Room Preview at the bottom. You 
may change the room label, wire frame color labeling options, ceiling grid and wall height. In addition, you may edit each surface's properties by 
clicking the Surface Edit button, if desired. 

If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Rectangular Barrel Vault Room 

The Edit Rectangular Room with a Barrel Vault Ceiling dialog looks just like the original ‘Add’ dialog, with the addition of a Room Preview at the 
bottom. You may change the room label, wire frame color labeling options, wall height, vault height and vault width. In addition, you may edit each 
surface's properties by clicking the Surface Edit button, if desired. 

If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 12 
characters long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Rectangular Gable Room 

The Edit Rectangular Room with a Gable Ceiling dialog looks just like the original ‘Add’ dialog, with the addition of a Room Preview at the bottom. 
You may change the room label, wire frame color labeling options, wall height and gable height. In addition, you may edit each surface's properties 
by clicking the Surface Edit button, if desired. 

If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 12 characters 
long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the dialog, then check the 
labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed control or 
surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing you to modify each 
surface's properties individually or collectively. 
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• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex models. 
Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Rectangular Hip Room 

The Edit Rectangular Room with a Hip Ceiling dialog looks just like the original ‘Add’ dialog, with the addition of a Room Preview at the bottom. You 
may change the room label, wire frame color labeling options, wall height, hip height and hip length. In addition, you may edit each surface's 
properties by clicking the Surface Edit button, if desired. 

If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 12 
characters long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Edit a Rectangular Pyramid Room 

The Edit Rectangular Room with a Pyramid Ceiling dialog looks like the original ‘Add’ dialog, with the addition of a Room Preview at the bottom. You 
may change the room label, wire frame color labeling options, wall height and pyramid height. In addition, you may edit each surface's properties by 
clicking the Surface Edit button, if desired. 

If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 12 
characters long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Rectangular Vertical Extrusion Room 

The Edit Rectangular Room with a Vertical Extrusion Ceiling dialog looks just like the original ‘Add’ dialog, with the addition of a Room Preview at the 
bottom. You may change the room label, wire frame color, labeling, and wall height. In addition, you may edit each surface's properties by clicking 
the Surface Edit button, if desired. 

If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 
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• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing you 
to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Round/Elliptical Room with a Flat Ceiling 

The Edit Round/Elliptical Room with a Flat Ceiling dialog looks just like the original ‘Add’ dialog, with the addition of a Room Preview at the bottom. 
You may change the room label, wire frame color, labeling options and wall height.  In addition, you may edit each surface's properties by clicking the 
Surface Edit button, if desired. 

If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing you 
to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Round/Elliptical Room with a Dome Ceiling 

The Edit Round/Elliptical Room with a Dome Ceiling dialog looks just like the original ‘Add’ dialog, with the addition of a Room Preview at the bottom. 
You may change the room label, wire frame color, labeling options, wall height and dome height. In addition, you may edit each surface's properties 
by clicking the Surface Edit button, if desired. 

If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing 
you to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Round/Elliptical Room with Vertical Rotation 

The Edit Round/Elliptical Room-Vertical Rotation dialog looks just like the original ‘Add’ dialog, with the addition of a Room Preview at the bottom. 
You may change the room label, wire frame color, and labeling options. In addition, you may edit each surface's properties by clicking the Surface 
Edit button, if desired. 
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If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 characters 
long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the dialog, then check 
the labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing you to 
modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex models. 
Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window.  

Edit a Polygon Room with a Flat Ceiling 

The Edit Polygon Room with a Flat Ceiling dialog looks just like the original ‘Add’ dialog, with the addition of a Room Preview at the bottom.  You may 
change the room label, wire frame color, labeling options and wall height.  In addition, you may edit each surface's properties by clicking the Surface 
Edit button, if desired. 

If you have moved or deleted a room label prior to editing, it will be replaced in its original location, after any editing changes have been made. For 
this reason, we recommend not moving or deleting room labels until after any room modifications have been made. 

1. From the Modify menu choose Room-Edit, or from the Rooms/Objects toolbar select . 
2. Select the room by moving the pickbox cursor over it and clicking the left mouse button. 
3. Make the desired changes in the dialog. 

• To change the label of a surface, click in the appropriate Label cell and enter the new label name. Label names may be up to 32 
characters long. If you are unsure of which label is associated with a particular surface, label the room surfaces, click Ok to exit the 
dialog, then check the labels in the graphics window 

• To change any Room Surface properties (such as Color, Texture, Transmittance, Transparency, Luminance, Specularity, Color Bleed 
control or surface specific Mesh Levels) select the Surface Edit button in the Edit dialog. The Surface Edit dialog will appear allowing you 
to modify each surface's properties individually or collectively. 

• Removing Surfaces - Removing surfaces allows you to append other surfaces to factory defined shapes and create more complex 
models. Surfaces may be removed by selecting the Surface Edit button in the Edit dialog. 

4. Click Ok to apply the changes and return to the graphics window. 

Moving Rooms - Concepts 

Moving rooms is similar to moving other entities in AGi32. 

When rooms are moved, any text labeling that had been previously moved will be returned to its original position. Calculation points placed on the 
Room surfaces will be deleted. 

Moving Rooms 

When rooms are moved, the original room definition is accessed and relocated. This means that if any room labels have been moved away from their 
original location, they will be reinserted in their original location once the room is moved. To move rooms in a job file, select the desired room, the 
starting point and endpoint. The two points define a displacement vector that indicates the distance the room will to be moved and its relative 
direction. Only one room can be moved at a time. 

1. From the Modify menu select Room-Move, or from the Rooms/Objects toolbar select . 
2. Select the room to be moved. 
3. Select the point to move from by clicking on it with the left mouse button. Usually a corner of the room makes a good selection point. 
4. Drag the cursor to the new room location point and left click again. As the cursor moves, the room will also move accordingly.  
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Modifying Room Labels - Concepts 

Text Labels can be added to Rooms to identify room attributes (such as Label, reflectance, coordinates, etc.) using the Labeling button in the Room 
dialogs. Labels may be added to rooms in the original Add dialog, when the room is initially specified, or after the room is created, in the Edit dialog. 

Room Labels are dynamic. If the room properties are modified and a room Label is selected that references this attribute (e.g. Wall Height), the label 
will automatically update when the attribute changes. 

Once a label is created, it may be moved or deleted as desired. Moving individual labels may be advantageous as the label may interfere with other 
data on the drawing. 

Room Labels may be removed in two ways. On an individual basis, they can be deleted one at a time. To remove all labels from the room, deselect 
the labels used by Editing the room and clicking the Labeling button. 

Some labels cannot be separated into separate lines. Room Labels (Room Label, Description, Project Name, Coordinates, Wall Height) and Room 
Surface Labels (Surface Label, Reflectance) are placed together as a paragraph and are moved and deleted as such.  

Modifying Room Labels 

Room labels can be moved or deleted from their original locations at any time. However, if the room is edited after the labels have been moved or 
deleted, the labels will be replaced in their original locations. 

What do you want to do? 

Delete Room labels 

Move Room Labels  

Deleting Room Labels 

Room labels may be deleted on an individual basis. 

1. From the Modify menu select Room-Labels-Delete, or from the Rooms/Objects toolbar select . 
2. Select the label to be deleted. 
3. Continue selecting labels in this manner, if desired. When complete, press ENTER (right mouse click) to confirm your selections and delete the 

labels. 

Moving Room Labels 

Room labels may be moved from their default location to another location to improve the visual clarity of the presentation. When the label is selected 
the entire label is moved from one location (Room Label - Room Name, Project Name, Coordinates, etc.) to another. Room labels should not be 
moved until after all room modifications have been made, since they return to their default location whenever the room is modified. 

1. From the Modify menu select Room-Labels-Move, or from the Rooms/Objects toolbar select . Click on the arrow adjacent to the Labels 
button to see the secondary menu. Select Move. 

2. Select the label to move. 
3. Locate the point to move the label from and click the left mouse button. 
4. Drag the label to its new location and left click again. 

Room Openings 

Room Openings - Concepts 

Room Openings are used to let light pass through adjacent room surfaces (openings must be created in both rooms) or from exterior to interior. 
When Daylighting calculations are desired, a Daylight Opening or Daylight Window must be added within the Room Opening for calculation 
purposes. 

Rules for creating ceiling openings 

1. Openings must be contained within the ceiling surface. Attempting to locate a vertex outside the surface will prompt a warning. 
2. Openings can only be placed in flat ceilings at this time. Sloped ceiling panels of Vertical Extrusion rooms are not eligible.  
3. The sides of an opening must not cross one another. 
4. Openings can be of any shape and may include arcs (F4). 
5. Openings can be created in either clockwise or counterclockwise directions. 



AGi32 Help System  Modifying Entities 

340 

 

Limitations of ceiling openings 

1. Openings cannot be edited in any way, they are fixed. 
2. Openings cannot be copied or arrayed at this time. 
3. If  Room height is increased or decreased the opening is deleted. 

Rules for creating wall openings 

1. Openings must be contained within the surface. Attempting to locate a vertex outside the surface will prompt a warning. 
2. The sides of an opening must not cross one another. 
3. Openings can be of any shape and may include arcs (F4). 
4. Openings can be created in either clockwise or counterclockwise directions. 

Limitations of wall openings 

1. Openings cannot be edited in any way, they are fixed. 
2. Openings cannot be copied or arrayed at this time. 
3. If  Room height is increased, the opening will stay in the same location relative to the base elevation. 
4. If Room height is decreased, all wall openings are lost. 

Rules for creating floor openings 

1. Openings must be contained within the surface. Attempting to locate a vertex outside the surface will prompt a warning. 
2. The sides of an opening must not cross one another. 
3. Openings can be of any shape and may include arcs (F4). 
4. Openings can be created in either clockwise or counterclockwise directions. 

Limitations of floor openings 

1. Openings cannot be edited in any way, they are fixed. 
2. Openings cannot be copied or arrayed at this time. 
3. Modifications in Room height do not effect floor openings. 

Related Topics 

Surface View 

Add Room Opening - Ceiling 

Openings inserted into ceiling planes can be used for a wide variety of modeling tasks from simple skylights, to the addition of domes and other 
complex shapes,  even appending rooms on top of one another.  

In the case of Room Ceiling openings, when the room is selected, AGi32 will automatically change the view to Plan View and zoom to Extents. 

To create a ceiling opening 

1. Select the Room-Opening-Add-To Ceiling command from the Modify menu or from the Rooms/Objects toolbar, select . Left click on the 
pull-down arrow to the right of the button to invoke the secondary menu. Select To Flat Ceiling 

2. Select the Room to receive the opening. 
3. Draw the opening on the ceiling surface, right click to close. The opening can be any shape and can include Arcs (F4). It is not necessary to 

change the Z-coordinate manually to the ceiling height, the command does this automatically. 

Add Room Opening - Floor 

An opening in the floor might be useful if stacking rooms on top of one another. Create an opening in the floor of the second story room to open the 
space to the room below which will, in turn, require an opening in the ceiling. 

In the case of Room Floor openings, when the room is selected, AGi32 will automatically change the view to Plan View and zoom to Extents. 

To create a floor opening 

1. Select the Room-Opening-Add-To Floor command from the Modify menu or from the Rooms/Objects toolbar, select . Left click on the 
pull-down arrow to the right of the button to invoke the secondary menu. Select To Flat Floor 
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2. Select the Room to receive the opening. 
3. Draw the opening on the floor surface, right click to close. The opening can be any shape and can include Arcs (F4). 

Add Room Opening - Wall or End Panel 

The ability to create an opening in a Wall or End Panel (Vertical Extrusion) is useful primarily for Windows and Doors although there may certainly be 
other needs for openings that we have not yet imagined. 

The creation of openings utilizes Surface View mode. When you select a surface to locate an opening, AGi32 will display that surface in surface view 
where only entities in the same coordinate plane are visible. In the case of Room openings, surface view mode looks at all surfaces from the frame of 
reference of an observer INSIDE of the space. 

To create a wall opening 

1. Select the Room-Opening-Add-To Wall or End Panel command from the Modify menu or from the Rooms/Objects toolbar, select .  
2. Select the wall surface to receive the opening. 
3. Draw the opening on the surface, right click to close. The opening can be any shape and can include Arcs (F4). 

Using Snap when specifying openings 

When selecting a room wall , the following Snap rules apply: 

1. If the selected wall is orthogonal (parallel to the X or Y axis) and is specified within the current snap value (e.g. - Surface Y=10, Snap =1), Snap 
can be used and set while specifying the opening. 

2. If the selected wall is orthogonal and is NOT specified using  the current snap value (e.g. - Surface Y=10.123, Snap = 1), Snap is automatically 
set to 0.01 and can not be changed while specifying the opening. This is done to make sure the opening is located on the surface. 

Hint: Change your Snap value to a small enough value within your surface constraints, to leave Snap on. For example, if your surface is located at X 
= 70.5, change your Snap to 0.5 or 0.25 before selecting the surface. 

3. If the selected wall is not orthogonal, Snap is automatically set to 0.01 and can not be changed while specifying the opening. This is done to 
make sure the opening is located on the surface.  

Delete Room Opening 

Openings in a Room surface can be deleted by selecting the Modify-Room-Opening-Delete command. 

1.  Select the Room-Opening-Delete command from the Modify menu or Rooms/Objects toolbar . 
2. Select the room opening with the pickbox. 
3. Right click to confirm your selection and delete the opening. 
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 Calculate 

Batch Processing 

The Batch Processor command allows you to calculate multiple AGi32 job files in succession. All calculated job files will be saved after processing. 
All selected job files must exist in the same folder. You may not process job files from multiple folders. 

1. Save any unsaved work before selecting the Batch Processor command. Any unsaved work will be lost once the command is selected. 
2. From the Control Bar select Batch Processor from the secondary menu adjacent to the Calculate button. 
3. Select the folder in which the job files are located. By default, AGi32 uses the JobFies folder location specified in the Tools-System Settings-File 

System tab. If necessary, select the appropriate drive from the Drives pull-down menu. If the desired network drive does not appear in this 
menu, click on the Network button to map the network drive. 

4. Select the files to process by clicking on them using the Shift and/or Ctrl selection options. 
5. Specify the processing options to be implemented. 
6. Click Ok. 

  

Batch Processing Options 

Full Radiosity Method Files – Save Rendered Environment File – This option saves the Radiosity Solution file separately with the same name as 
the AGi32 job file. By saving the Radiosity solution file, you are able to view the rendered environment. The Radiosity solution file is saved with an 
RSF extension in the same folder as the calculated AGi32 job file.  

Minimize While Processing – This option minimizes AGi32 while the calculations are run so that you may work on other applications. Once the 
calculations are complete, AGi32 is Maximized and the calculation report displayed (if the Display Report at End of Processing option is selected). 

Display Report at End of Processing – This option displays a calculation report once the batch processing is complete. The report indicates which 
job files were calculated, their calculation times and the status of the calculations. 

   

Batch Processing-Concepts 

The Batch Processing command allows you to calculate and save multiple AGi32 job files in succession at any given time. The Batch Processing 
command is fully automated and can be run without supervision or assistance on its own. 

Batch Processing is best applied during off hours when other use of the computer resources is not required. By freeing up your computer's 
resources, the lighting calculations can proceed as quickly as possible. 

Batch Processing requires that all of the selected files exist in the same folder. The selected files are calculated in order. If a calculation error occurs 
in one of the files, then the Batch Processing process will stop at that point. Successive files will not be calculated. 

Older version files (.A32) will automatically be saved as current version files (.AGI) in the same location (drive and folder). 

   

AutoCalc 

The AutoCalc command will automatically recalculate all of the illuminance values each time a luminaire modification or calculation modification is 
applied. This is especially valuable when fine tuning your application. Each time you move a luminaire or an aiming point, AGi32 will subtract the 
contribution of the old luminaire location and add in the contribution of the new one. 

AutoCalc is only available with the Direct Only Calculation method. The reflective or transmissive contribution of objects and rooms are not 
considered, however, their obstructive capability is considered. 

 From the Control Bar select . To enable AutoCalc, choose the following option from the Calculate secondary menu: Direct Only 
method: AutoCalc On.  
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AutoCalc-Concepts 

The AutoCalc command automatically recalculates the Illuminance values each time a luminaire modification or calculation modification is applied. It 
does so by removing the direct component of the existing luminaire distribution and replacing it with the new luminaire distribution. In other words, 
AutoCalc reacts to a luminaire or calculation modification by subtracting the old luminaire contribution and adding in the new luminaire contribution. 

AutoCalc calculations are much faster than normal calculations because of this calculation method. No loss in accuracy is achieved with AutoCalc. 

AutoCalc is only available with the Direct Only calculation method, as only the Direct component can be calculated in this manner. 

   

Calculate 

The Calculate command calculates all of the values in the current job file. When the Full Radiosity Method is enabled, both the direct and 
interreflected light available in the environment contribute to the values. In the Direct Only Method, only the direct component of each luminaire 
affects the calculation values. 

The AGI32 Desktop icon (on Windows task bar) will indicate "AGi32 calculating" while the calculations are proceeding as a helpful visual indicator if 
you are multitasking.  

 From the Control Bar select  

Note - three calculation options are available from the secondary menu adjacent to the Calculate button; the icon will indicate which option is active: 

 
Full Radiosity Method 

Full Radiosity calculations are calculated (direct and indirect 
components). These results may be rendered. This mode is 
recommended for most applications, particularly where reflected light 
is a major contributor. It is also recommended if you intend to render 
the results. You must use Full Radiosity Method for the computation of 
Daylight component. 

 
Direct Only Method 

A fast calculation type where only basic point-by-point calculations are 
applied (direct component only). The obstructive effects of objects and 
rooms are considered in the calculations but the results can not be 
rendered. This method is recommended for applications where 
reflected light is not considered or inconsequential.  

You can always switch to Full Radiosity Method to render the results 
once the layout is complete. 

 
Direct Only Method: AutoCalc On 

Same as above, but with AutoCalc enabled to minimize calculation 
time  when adjusting an exterior layout (e.g. – sports lighting, parking 
lots, roadway, etc.) 

If the job file has been previously calculated and you select the Calculate command, you will be prompted to recalculate. This prevents you from 
accidentally calculating the job file. 

A warning message is displayed after calculating in Full Radiosity Method if the desired Radiosity Stopping Criterion was not reached. In order to 
assure the most precision in an environment, we recommend allowing the calculations to reach the Radiosity Stopping Criterion each and every time. 

A message is displayed if the Stop or Cancel buttons are pressed to give you the option to continue with command or not. This fail safe ensures you 
do not accidentally cancel the calculation process. 

Calculating in Render Mode 
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In Render mode, calculations may be paused and resumed to interact with the environment before the calculations have reached the preset 
Radiosity Stopping Criterion. Most render commands may be initiated while the calculations are paused including: default views, interactive views, 
Render View Manager, View Properties and Display Properties. 

Calculations may also be paused in Model mode. 

   

Calculation Concepts 

The Calculate command initiates the lighting calculations in AGi32. When Full Radiosity Method is enabled, both the direct and interreflected light 
available in the environment contribute to the values. In Direct Only Method, only the direct component of each luminaire affects the calculation 
values. 

Until the Calculate command is chosen, all Illuminance values are displayed as question marks in the environment. This indicates that no value has 
yet been determined for the calculation points. The calculation engine used to calculate point by point values in Full Radiosity Method is the same 
engine that produces a rendered environment. If you create an AGi32 environment with surfaces (e.g. Rooms and/or Objects) in addition to 
luminaires and calculation points, you will have rendered that environment simultaneously when you choose to Calculate. 

The Calculate command can also be selected in Render mode when Full Radiosity Method is enabled. By calculating in Render mode you can see 
the evolution of the radiosity process during calculations. This mode allows you to gauge the validity of your design and stop the calculations before 
they complete so that changes can be made.  

There is no calculated difference between calculating in Model mode or Render mode, however calculations will take slightly longer in Render mode 
because of the display updates. 

Calculations may be paused and resumed in Render mode to allow for interaction with the environment. 

Processing priority 

AGi32 automatically applies a lower processing priority whenever another application has focus during the calculation process. For example: If you 
open Outlook while calculating, AGi32 will automatically relinquish resources to Outlook allowing it to operate with minimal interruption. Therefore, it 
may not be necessary to Pause calculations in order to execute other tasks 

Pause/Resume is only available while in the Full Radiosity Method during the radiosity and calculation points steps. It is NOT available in Direct Only 
Method or during Roadway or Glare Rating calculations (point x point only). 

The following commands are active while calculating in Render Mode or when Paused in Render Mode: 

• Default views 

• Interactive commands 

• View Manager 

• Display Properties 

• View Properties 
• Status Bar – Textures, Wire Overlay, Model Overlay, Anti-Aliasing 

Selecting commands during the calculation process may not take affect immediately depending on where the program is in the calculation process. 
Therefore, it may be necessary to click the command multiple times before it becomes active. Note: The program is generally more responsive after 
the adaptive subdivision step. 

Pausing the calculations allows for more responsive interactive display manipulation (smoother image display). This may be necessary on computers 
with limited resources. 

Radiosity explained 

AGi32 uses Radiosity techniques to calculate when the Full Radiosity Method is used.  

Radiosity is a global illumination technique used to process interior and exterior environments where luminaires and surfaces are defined. Global 
illumination describes the interaction between objects and/or rooms with the light sources and each other. In AGi32, each surface on every entity is 
broken up into smaller pieces, called patches. Each patch is divided into additional pieces, called elements. Patches emit light, elements receive 
light. Each patch reacts with the other elements that are visible to it by reflecting light towards them. The process of distributing the light between 
surfaces is known as a step. 

The Rendering process begins by emitting the light from the luminaires to those patches visible to them. Each patch will absorb and reflect a certain 
amount of light, depending on its reflectance. AGi32 optimizes the rendering process by identifying the patch that receives the most light and makes 
it a secondary light source. The process is then repeated by calculating the transference of light between these patches and all elements visible to 
them. At each step, the luminance values at the vertex of each element (calculated from the received light) are accumulated and tabulated. 

The process is repeated, one step at a time, until the amount of light remaining unabsorbed in the environment is very small (compared to the 
original amount of light emitted by the light fixtures) unless the calculations are stopped manually by the user. The total amount of light reflected by 
each patch is added up and the luminance for each patch is calculated. 
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Patch/Element Sizes 

Patch and elements sizes are specified internally based on the surface size. Larger surfaces are broken up into bigger patches and smaller surfaces 
are broken into smaller patches. Each patch is subdivided automatically into elements, using the default Element Size Factor (default factor = 0.5, 4 
elements per patch). 

You may apply different meshing parameters to each individual surface using the Surface Edit command. 

Radiosity Limitations 

Radiosity techniques are currently limited to diffuse surface calculations. You may model the effect of shiny or specular surfaces in AGi32, such as 
chrome, marble or glass, for visualization purposes using post process Ray Tracing, however, these non-diffuse surface attributes will not be 
considered for calculation purposes. 

Advantages of Radiosity 

1. Color Bleed – The light emitted from a surface carries the surface color with it.  Light color in AGi32 is additive, so that light color mixes together 
as we would see it in real life. 

• For example, place a piece of bright colored paper close to a white wall and shine a flashlight on it. Even under normal room 
illumination, you will likely see a strong blotch of color reflected from the wall.  

2. Soft Shadowing – Shadowing is captured because of the surface meshing (one patch is distinct from its neighbors) Finite shadows can be 
produced by breaking up the surfaces into small enough patches. 

3. Global interactivity – you can look at the environment from any point of view without having to recalculate because the surface luminance for 
each patch is the same in any viewing direction. 

Coplanar Polygon Merging (during surface meshing) 

Many imported CAD objects are poorly constructed in terms of radiosity calculations and rendering. For example: A round surface is typically 
constructed of several long and skinny triangles which commonly lead to rendering artifacts. To alleviate these artifacts, AGi32 examines each 
surface during the meshing process to determine if the surface is constructed of multiple polygons and, if so, merges adjacent polygons into a single 
polygon. This reduction in polygons has a direct affect on calculation time and reduces rendering artifacts.  

Note: The coplanar polygon merging feature requires an exceedingly complex algorithm with a number of heuristics to handle problem surfaces that 
may include extremely small polygons or holes. While every attempt has been made to anticipate every possible variation of surfaces, there will most 
likely be environments that the program cannot handle properly. 

Patch leak 
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Radiosity techniques assume that the gradient of light across an element is linear. 
The luminance is calculated at the center of each element. The element vertices are 
calculated by calculating the average of the surrounding elements and a linear 
gradient is interpolated in between. Imagine that you have an object intersecting an 
element.  The luminance calculated outside the object at the element center would 
be positive. The luminance calculated at the elements underneath the stack would 
be 0. The luminance would be graduated from the center of the element to the 
vertices and not sharply cut of at the stack boundary. This phenomenon is known as 
patch leak.  

Typically, applying adaptive subdivision is the simplest method to repair patch leak. 
However, sometimes the elements cannot be made small enough to completely 
eliminate the patch leak. In these situations, there are several alternative that may 
be employed to create more realistic imagery: 

• Produce a Ray Trace image and Ray Trace Direct Illumination (for 
visualization purposes only). 

• Assign a finer mesh to the surface exhibiting the patch leak using the Surface 
Edit command. Use the Mesh Level attribute to assign an initial denser 
mesh. 

• Apply the High Setting of Adaptive Subdivision instead of the default setting. 

• Remove the calculation points under the solids (e.g. under the racks) if these 
are showing small positive values. 

• Build the surfaces separately (e.g. in a cove application, build the wall and 
cove as a vertical extrusion object instead of using multiple objects so that 
the single wall is not created above and below the cove) 

Radiosity Stopping Criterion - Accuracy vs. Calculation times 

AGi32 processes the Radiosity calculations until the Stopping Criterion is met. Stopping Criterion indicates the amount of unabsorbed light that can 
remain in the environment before the Radiosity calculations are stopped. The default Stopping Criterion is 99% 

For most Electric lighting applications, the environment will show little numerical change (the FC results will be stable) at a Stopping Criterion of 95% 

For Daylighting applications, the calculations should not be stopped until the default Stopping Criterion is reached (99%) as the values can still 
fluctuate above acceptable tolerances. 

Exitance Meter vs. Virtual Meter 

When each meter is applied: 

1. Exitance meter - The Exitance meter is applied whenever Automatic Placement Calculation points are created on reflective surfaces. 
2. Virtual meter - The Virtual Meter is applied whenever calculation points are placed manually in the layout (grids, polygons, scattered calculation 

points, lines of calculation points). The Virtual meter may also be used when Automatic Placement is applied in the following cases: 

• The reflectance of the associated surface is 0 or transmittance is greater than 0. 

• The associated surface has been removed from the room. 

• Automatic Placement points are placed on a workplane (in a room). 

• The light meter has been changed and is no longer normal to the surface.  

• Automatic Placement points exist over an opening. If the distance from the calculation point to the associated surface exceeds 0.5ft or 
0.15M, the program automatically switches to the Virtual Meter 

Differences in numbers 

The Exitance meter calculates Exitance or Illuminance values on surfaces using the luminance values from the elements. If the elements are too 
large to accurately capture the gradient of light across them, then the calculated values will reflect this limitation. The virtual meter calculates 
Illuminance by using an independent calculation meter, which looks at the direct component of light and the reflected component of light from the 
surfaces that are visible to it. The virtual meter is the most accurate meter type. 

The Exitance meter calculates much faster than the Virtual meter. It should be used whenever possible, except in special cases. 
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Special Cases 

In cases where the luminaires is positioned very close to the surface with the calculation points, the Exitance meter may not accurately calculate the 
illuminance values for large patches. The linear gradient assumed across the patch is not accurate in these cases, unless the patches are small. 

You have three options in these cases: 

1. Use a manually positioned calculation grid or polygon, so that the Virtual Meter is used. 
2. Apply adaptive subdivision, to decrease the element size based on the photometric distribution. 
3. Manually change the meshing parameters for the nearby surfaces using Surface Edit so that the patch size is decreased. 

• Advantages – Small patch size leads to more accurate gradients across patch. 
• Disadvantages – Patching is applied to all surfaces, increased calculation time. 

Calculation Method ramifications  

The Calculation Method choices allows you to select whether direct only or direct and reflected light will be considered in the calculations.  

Luminaires are applied differently in each mode and your results may vary based on these differences. Further discussion is provided below. 

In general, Full Radiosity Method is used in most cases, especially where reflected light is a major contributor and you wish to render the results. 
Daylighting can only be computed in Full Radiosity Method . 

Direct Only Method considers the obstructive properties of rooms and objects in the calculations. All rooms and objects are considered as opaque, 
non-reflective surfaces in Direct Only Method regardless of their original specifications. Direct Only Method will not compute daylight component. 

Calculation Method applications 

Consider the following examples to help you decide which mode will suit your requirements: 

Interior: 

In most interior applications, interreflected light is very important so the use of Full Radiosity Method is most common. However, if you wish to 
evaluate only the direct contribution from the luminaires to the calculation points, while considering the obstructive capabilities of objects, switch to 
Direct Only Method and recalculate. While in this mode you will not be able to see the rendered view. 

Site Lighting or interchange: 
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• Reflective and obstructive objects need to be created in order to take advantage of Full Radiosity Method. Use the Automatic Placement 
command to place calculation points on a planar object representing the ground or roadway plane in addition to other objects. It is now possible 
to render the environment. 

• In the case where no reflective objects are to be considered but rendered results are wanted, use Full Radiosity Method. Place Automatic 
Placement points on a planar object representing the ground or roadway plane. 

• Obstructive capabilities of objects are desired. Use Direct Only Method. Specify the objects that obstruct light in the environment. Rendered 
results are not available. 

• No reflective objects are to be considered and rendering is not required. Use Direct Only Method. Place calculation points using calculation 
Grids, Polygons or Lines. Rendered results are not available. 

Sports Lighting: 

Start by placing calculation grids and polygons in Direct Only Method. You may also place objects in the environment to consider their obstructive 
nature (elements such as scoreboards or bleachers). 

Luminaire Application 

Luminaires are considered differently in Full Radiosity Method vs. Direct Only Method. This topic discusses the differences in application and the 
ramification on the calculated values. 

Full Radiosity Method  

The Full Radiosity Method considers the luminaire size and location accurately in the Radiosity calculations. First, the luminous area is extracted 
from the photometric file and inscribed within a luminous box. The luminous box is intended to represent the luminous area of the fixture. If the 
luminous box is larger than 1 square foot, it is subdivided along the largest axis and the lighting distribution is divided equally among these pieces. 
The piece size is specified in Advanced System Settings, and is 1 foot by default. This process allows the light “energy” to emit across the entire 
luminaire (as happens in real life) as opposed to being emitted entirely from the center. 

The luminous box is located within the selected Render symbol according to the luminous areas ascribed to the symbol. Render symbols with a 
luminous surface located at the bottom of the symbol will have the luminous box centered at the bottom of the symbol. Render symbols with a 
luminous surface located at the top of the symbol will have the luminous box centered at the top of the symbol. Render symbols with a luminous 
surface located at the top and bottom of the symbol or along the sides will have the luminous box centered within the symbol. 

In addition, the symbol itself is attached to the cursor using the insertion point of the symbol (Top or Bottom). The Mounting Height of the luminaire 
correlates to this insertion point. If the insertion point of the symbol is not located in the same plane as the luminous area, the light “energy” is emitted 
from a different location than the specified Mounting Height. A few examples of this are discussed below: 

• Interior application: An Indirect/Direct photometric file is selected. The Tube4 Up_Down symbol is chosen to represent the luminaire. The 
default Height of this symbol is 1 foot and its default insertion point is Bottom. Recall, that a symbol with luminous areas on the top and bottom 
locate the luminous box at the center of the symbol. If a Mounting Height of 10’ is specified, the luminous box is actually located at 10.5’ (1/2 Z 
dimension of symbol + MH at bottom). Your calculation points would pick up the luminous flux emitted from a MH of 10.5’. 

• Exterior Application: A Type V Area Lighting photometric file is selected. The Shoebox Yoke symbol is chosen to represent the luminaire. The 
default Height of this symbol is 1.3 feet and its default insertion point is Bottom. The luminous area is located at the bottom of the shoebox 
housing, 1 foot above the Yoke. The Insertion point is at the Yoke (yoke is attached to top of pole). If a Mounting Height of 30’ is specified, the 
luminous box is actually located at 31’. Your calculation points would pick up the luminous flux emitted from a MH of 31’. 

Poles and pendants are physical objects in Full Radiosity Method. Each pole or pendant has a rectangular footprint with a 2" length. If selected, they 
acquire the housing color of the associated luminaire. Poles and pendants block and reflect light and should be selected such that they do not block 
the luminaire's luminous area. When selecting a pole, use Arm Length to distance the pole from the luminous box. If a pole is needed directly 
beneath the luminaire, be sure to select the "Shoebox with Yoke" or "Glow" symbols. These symbols create a distance between the pole top and the 
luminous box by using a Yoke. 

Pendants should only be applied to direct distribution luminaires (like a Hibay). When used with an indirect, the pendant blocks the luminous box. 

Even if you do not view the rendering, the Rendering symbol is used in the calculations. It is important to select an accurate symbol to physically 
represent the luminaire. In Full Radiosity Method, the luminaire housing obstructs and reflects light in the environment, making its physical shape and 
size a significant component in the calculations. AGi32 considers the effect of luminaires in the calculations, as would occur in real life. To compare 
AGi32 to other lighting software that does not consider the effects of luminaires in the calculations, choose the NULL symbol for the Render symbol. 
This removes the physical luminaire presence from the calculations. In addition, the NULL symbol associates the luminous box with the insertion 
point of the symbol, as occurs in Direct Only Method. 

The selection of an appropriate Render symbol is also important for accurate placement of the luminous box, as illustrated above. 

Direct Only Method 

Direct Only Method considers the luminaire to be a point source regardless of the luminous area specified in the photometric file. In addition, the light 
is emitted from the insertion point of the symbol and does not take the luminous symbol surfaces into account. The luminaire symbols are not 
considered in the calculations. Poles and pendants are also not considered. 
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• Interior application: Same situation as above: The point source is located at the specified Mounting Height (10’). Also, the light is emitted from 
the center of the symbol (at the insertion point location). 

• Exterior application: The light is emitted from the insertion point of the Shoebox Yoke symbol (at the Yoke) at a Mounting Height of 30’. 

   

Radiosity Stopping Criterion - Concepts 

The Radiosity Stopping Criterion dialog provides calculation parameters that control the Radiosity calculations. The settings chosen in this dialog will 
affect your calculation point accuracies as well as your renderings.  

Stopping Criterion (% Light Absorbed) 

The progressive refinement radiosity techniques AGi32 employs lead to a converging solution. In other words, with each subsequent radiosity step, 
and less light is reflected (and absorbed) and the amount of unabsorbed light diminishes with each pass. It is impossible to account for every photon 
of light with this calculation technique; instead calculations are processed until an acceptable amount of light is absorbed. This is called the Radiosity 
Stopping Criterion. The default Radiosity Stopping Criterion is 99% - meaning that 99% of the light has been absorbed and 1% is unaccounted for. 

Radiosity Stopping Criterion - Accuracy vs. Calculation times 

AGi32 processes the Radiosity calculations until the Stopping Criterion is met. Stopping Criterion indicates the amount of unabsorbed light that can 
remain in the environment before the Radiosity calculations are stopped. The default Stopping Criterion is 99% 

For most Electric lighting applications, the environment will show little numerical change (the FC results will be stable) at a Stopping Criterion of 95% 

For Daylighting applications, the calculations should not be stopped until the default Stopping Criterion is reached (99%) as the values can still 
fluctuate above acceptable tolerances. 

More on Calculation Concepts 

  

Radiosity Stopping Criterion - Procedures 

The Radiosity Stopping Criterion dialog specifies the Stopping Criterion parameters used for daylighting and non-daylighting calculations in Full 
Radiosity Method. When the Calculate command is initialized, these settings will determine calculation length and accuracy. This dialog provides 
access to preset recommended Stopping Criterion as well as the option to enter your own criterion. 

 From the Control Bar select . To change the Stopping Criterion, choose the following option from the Calculate secondary menu: 
Radiosity Stopping Criterion. 

Changing the Radiosity Stopping Criterion does not reinitialize the mesh settings (surface mesh in Render mode continues to show previous settings 
until the environment is recalculated). 

Accuracy Presets 

Three Accuracy Preset Stopping Criterion Levels are available - High (default), Medium and Low. 

Accuracy 
Preset 

Stopping 
Criterion (% 
Light 
Absorbed) 

Comment 

High 99 The finest level applied; default for all calculations. Necessary when the highest level of accuracy is 
expected; calculation time is also longest. 

Recommended for these applications: 

• Daylighting 

• Emergency / Egress 

• Close proximity between luminaire and surface (coves, facade lighting, indirect applications 
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Medium 

95 Appropriate for most interior electric lighting applications, except as noted above. 

Low 90 Appropriate for most exterior electric lighting applications. 

Stopping Criterion (% Light Absorbed) – The Stopping Criterion indicates the amount of unabsorbed light that can remain in the environment 
before the Radiosity calculations are stopped. Simply, each time the light bounces around in the environment, less light remains unabsorbed. The 
Radiosity calculations are repeated until the stopping criterion has been met. The default Stopping Criterion is 99%. 

Values between 0% and 99.99% are allowed, however, values below 90% are not recommended unless you are doing preliminary or non-production 
grade calculations. 

   

Adaptive Subdivision - Concepts 

Adaptive Subdivision changes the sampling level of all surfaces based on the electric lighting and/or daylighting beam patterns to create more 
accurate representations of the beam's interactions with the surfaces. Applying Adaptive Subdivision generally results in more accurate renderings 
and calculated values, with the necessary requirement of longer calculation times. Without exception, Adaptive Subdivision should be applied to all 
Full Radiosity Method calculated environments before the final results are outputted from AGi32. Generally speaking, it can be applied as a finishing 
touch, unless one of the following cases applies: 

Source close to illuminated surface (e.g. coves) 

In certain circumstances, it may be necessary to apply Adaptive Subdivision during the design process to eliminate "patch leak". For example, a 
mesh element is divided by an object down the middle of the element (i.e. a cove on a wall, where the wall is the mesh element and the cove is the 
object). If the element is illuminated from one side of the object, the mesh element may appear equally illuminated on both sides of the object. 
Adaptive Subdivision can minimize or eliminate this effect. 

Source close to calculation points on surface  

Adaptive Subdivision may be applied to accurately capture the photometric distribution from a source placed close to a surface. By remeshing the 
surface, the gradient of light is distributed more finitely and associated Exitance Meter calculation points are accurately calculated. 

Adaptive Subdivision Settings 

Enable Adaptive Subdivision – Select this check box to activate Adaptive Subdivision. Adaptive Subdivision is deactivated by default. To apply 
Adaptive Subdivision to Daylight Exterior surfaces, select the Apply to Daylight Exterior Surfaces selection box. 

Maximum Subdivision Level – Indicates the level that each element will be divided into for each subdivision loop. The range is from 1 to MAX. The 
default setting is 3. Level 1 subdivides each element into four smaller elements. Level 2 subdivides each newly created element into four smaller 
elements. This process is continued until the Minimum Element Area is reached. If the default Level of 3 is used, the Level 3 subdivision loop bridges 
the transition from small elements to large elements by subdividing the elements in between into triangles. Selecting the MAX level allows surfaces to 
subdivide to the Minimum Element Area size. 

• Recommendations: For Electric lighting only the Default setting of 3 will be adequate for most situations. An increase to the High 
setting (5) will handle all but the most rigorous requirements. For Daylighting, the High setting of 5 is recommended and insures crisp 
shadows in direct sunlight cases. 

Minimum Element Area – Indicates the smallest element that will be produced by Adaptive Subdivision. The value should be defined on a per-
environment basis. The Default value is 0.5. The value is specified in current display units (e.g., square ft or square m). 

• Recommendations: For Electric lighting only the Default setting of 0.5 will be adequate for most situations. An increase to the High 
setting (0.1) will handle all but the most rigorous requirements. For Daylighting, the High setting of 0.1 insures crisp shadows in direct 
sunlight cases. 

Element Luminance Threshold – This setting determines the maximum allowable difference in luminance levels between adjacent elements. The 
Default setting is 1.5. 

• Recommendations: For Electric lighting only the Default setting of 1.5 will be adequate for most situations. An increase to the High 
setting (1.1) will handle all but the most rigorous requirements. For Daylighting, the High setting of 1.1 insures crisp shadows in direct 
sunlight cases. 
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Adaptive Subdivision-Procedures 

Adaptive Subdivision is the dynamic process of subdividing the initial environment "mesh" into smaller areas where required. The primary intention of 
Adaptive Subdivision is to increase the rigor of the radiosity process to more accurately consider situations of extreme luminance differential. 
Adaptive Subdivision also has the effect of bringing out details in complicated environments (i.e., shadows around objects). 

Adaptive Subdivision is applied separately to Non-Daylight and Daylight Exterior surfaces. The settings within each category are independent and 
may differ, if the application warrants more detail in one or the other. 

 From the Control Bar select . To change the Adaptive Subdivision parameters, choose the following option from the Calculate 
secondary menu: Adaptive Subdivision. 

Adaptive Subdivision Settings 

Two Adaptive Subdivision sections are provided: Adaptive Subdivision  and Daylight Exterior Surfaces. The settings for each section function in the 
same manner, only their surface association is different. 

Enable Adaptive Subdivision - This section will subdivide all surfaces except Daylight Exterior surfaces. By default, all surfaces are automatically 
not created as Daylight Exterior Surfaces by AGi32. Enable this section when considering applications with electric lighting and/or interior daylighting 
applications. Note: To transition daylight into interior spaces, you will need to define your windows and openings as Transition Daylight surface 
types. 

Select this check box to enable Adaptive Subdivision. Adaptive Subdivision is deactivated by default. 

Daylight Exterior Surfaces - This section will subdivide surfaces which have the Daylight Exterior attribute applied in Surface Edit. These surfaces 
are intended for exterior daylighting applications and for applications where exterior surfaces (such as light shelves, vertical fins, trees. etc.) obstruct 
and reflect light into the interior space. Exterior surfaces receiving and reflecting direct daylight, must be assigned the Daylight Exterior Surface 
attribute in Surface Edit.  

Select this check box to enable Adaptive Subdivision for Daylight Exterior surfaces. Adaptive Subdivision is deactivated by default. 

Preset Levels - The preset level options apply recommended settings for Adaptive Subdivision based on application recommendations. The Presets 
available are Default and High. 

 

Preset 
Level 

Maximum 
Subdivision 

Level 

Minimum 
Element 

Area 

Element 
Luminance 
Threshold 

Application 

Default 3 0.5 (ft
2
) / 

0.0465 
(m

2
) 

1.5 Electric Lighting 

High 5 0.1 (ft
2
) / 

0.0093 
(m

2
) 

1.1 Daylighting (with or without Electric Lighting), 
Facade Lighting or Cove applications (source 
is close to illuminated surfaces) 

Maximum Subdivision Level – Indicates the level that each element will be divided into for each subdivision loop. The range is from 1 to MAX. The 
default setting is 3. Level 1 subdivides each element into four smaller elements. Level 2 subdivides each newly created element into four smaller 
elements. This process is continued until the Minimum Element Area is reached. If the default Level of 3 is used, the Level 3 subdivision loop bridges 
the transition from small elements to large elements by subdividing the elements in between into triangles. Selecting the MAX level allows surfaces to 
subdivide to the Minimum Element Area size. 

Minimum Element Area – Indicates the smallest element that will be produced by Adaptive Subdivision. The value should be defined on a per-
environment basis. The default value is 0.5 ft

2
 (0.0465 m

2
). The value is specified in current display units (e.g.,square  ft or square m). 

Element Luminance Threshold – This setting determines the maximum allowable ratio between luminance levels between adjacent elements. The 
default value is 1.5. 

   

Luminaire Application 

Luminaires are considered differently in the Full Radiosity method vs. the Direct Only method. This topic discusses the differences in application and 
the ramification on the calculated values. 

Full Radiosity Method 



AGi32 Help System  Calculate 

352 

 

Full Radiosity Method considers the luminaire size and location accurately in the Radiosity calculations. First, the luminous area is extracted from the 
photometric file and inscribed within a luminous box. The luminous box is intended to represent the luminous area of the fixture. If the luminous box 
is larger than 1 square foot, it is broken up into 1 foot pieces and the lighting distribution is divided equally among these pieces. This process allows 
the light “energy” to emit across the entire luminaire (as happens in real life) as opposed to being emitted entirely from the center. 

The luminous box is located within the selected Render symbol according to the luminous areas ascribed to the symbol. Render symbols with a 
luminous surface located at the bottom of the symbol will have the luminous box centered at the bottom of the symbol. Render symbols with a 
luminous surface located at the top of the symbol will have the luminous box centered at the top of the symbol. Render symbols with a luminous 
surface located at the top and bottom of the symbol or along the sides will have the luminous box centered within the symbol. 

In addition, the symbol itself is attached to the cursor using the insertion point of the symbol (Top or Bottom). The Mounting Height of the luminaire 
correlates to this insertion point. If the insertion point of the symbol is not located in the same plane as the luminous area, the light “energy” is emitted 
from a different location than the specified Mounting Height. A few examples of this are discussed below: 

Interior application: An Indirect/Direct photometric file is selected. The Tube4 Up_Down symbol is chosen to represent the luminaire. The default 
Height of this symbol is 1 foot and its default insertion point is Bottom. Recall, that a symbol with luminous areas on the top and bottom locates the 
luminous box at the center of the symbol. If a Mounting Height of 10’ is specified, the luminous box is actually located at 10.5’ (1/2 Z dimension of 
symbol + MH at bottom). Your calculation points would pick up the luminous flux emitted from a MH of 10.5’. 

Exterior Application: A Type V Area Lighting photometric file is selected. The Shoebox Yoke symbol is chosen to represent the luminaire. The 
default Height of this symbol is 1.3 feet and its default insertion point is Bottom. The luminous area is located at the bottom of the shoebox housing, 1 
foot above the Yoke. The Insertion point is at the Yoke (yoke is attached to top of pole). If a Mounting Height of 30’ is specified, the luminous box is 
actually located at 31’. Your calculation points would pick up the luminous flux emitted from a MH of 31’. 

Poles and pendants are physical objects in Full Radiosity Method. Each pole has a rectangular footprint with a 4" base. Each pendant has a 
rectangular footprint with a 2" base. If selected, they acquire the housing color of the associated luminaire.  

This will obstruct a portion of the luminous area of the luminaire and cause erratic Illuminance computations. It is therefore necessary to include an 
ARM of minimum length as recommended in the Render symbol dialog (lower right corner) to move the pole away from the luminaire. An exception 
would be when using a Yoke mounted symbol such as "Shoebox-Yoke". 

Pendants are also physical entities. Pendants should only be applied to direct distribution luminaires (like a Hibay). When used with an indirect, the 
pendant blocks the luminous box. 

Even if you do not view the rendering, the Rendering symbol is used in the calculations. It is important to select an accurate symbol to physically 
represent the luminaire. In Full Radiosity Method, the luminaire housing obstructs and reflects light in the environment, making its physical shape and 
size a significant component in the calculations. AGi32 considers the effect of luminaires in the calculations, as would occur in real life. To compare 
AGi32 to other lighting software that does not consider the effects of luminaires in the calculations, choose the NULL symbol for the Render symbol. 
This removes the physical luminaire presence from the calculations. In addition, the NULL symbol associates the luminous box with the insertion 
point of the symbol, as occurs in Direct Only Method. 

The selection of an appropriate Render symbol is also important for accurate placement of the luminous box, as illustrated above. 

Direct Only Method 

Direct Only Method considers the luminaire to be a point source regardless of the luminous area specified in the photometric file. In addition, the light 
is emitted from the insertion point of the symbol and does not take the luminous symbol surfaces into account. The luminaire symbols are not 
considered in the calculations. Poles and pendants are also not considered as physical entities and do not obstruct light or create shadowing. 

Interior application: Same situation as above: The point source is located at the specified Mounting Height (10’). Also, the light is emitted from the 
center of the symbol (at the insertion point location). 

Exterior application: The light is emitted from the insertion point of the Shoebox Yoke symbol (at the Yoke) at a Mounting Height of 30’.  

   

Calculation Summary 

The Calculation Summary dialog provides information about the calculation time, final Radiosity Stopping Criterion and environment information. This 
dialog is available from the Control Bar in all modes (access from the pull-down menu to the right of the Calculate button). The more light absorbed, 
the more accurate the rendered image and calculated environment, however,allowing more light to be absorbed can dramatically increase calculation 
time with minimal improvement in accuracy. Complicated environments generally take longer to absorb more light since there are more surfaces 
exchanging light. 

Total Calculation Time – Indicates the total calculation time in hh:mm:ss (e.g. 00:01:10) to calculate the given environment and calculation points 
based on the type of calculation specified by the user. For example, if the user were calculating point by points in a room in Full Radiosity Method, 
the total calculation time includes the Radiosity and Calculation Points calculations. In Direct Only Method, only the Calculation Points would be 
calculated. 

Summary By Category – Indicates the time in hh:mm:ss to initialize, calculate and update the database for each type of calculation performed in 
AGi32. The Radiosity time indicates the calculation time to reach the Radiosity Stopping Criterion the time reached if the calculations were stopped 
prematurely by the user. 
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% Light Absorbed – Indicates the percentage of light absorbed. This value may differ from the specified Radiosity Stopping Criterion if the user 
stopped the calculations prematurely. 

Number of Steps - Indicates the number of steps completed if the specified Radiosity Stopping Criterion was attained, or the number of steps 
completed before the calculations were stopped prematurely by the user 

Number of Surfaces – Indicates the number of surfaces in the environment, if any. 

Number of Patches – Indicates the number of patches for all surfaces as discretized according to Advanced Render Settings. Surfaces are broken 
up into patches for the Full Radiosity Method according to the surface Level and given Patch Size. 

Number of Elements – Indicates the number of elements in the environment. Elements comprise the smallest surface area for the Full Radiosity 
Method as discretized according to the Advanced Render Settings (Element Size Factor x Patch Size). 

Subdivision – Indicates the number of subdivision loops that were performed if Adaptive Subdivision was enabled. 

Ray Trace - Indicates the calculation time and number or rays required to complete last raytrace image. 

 From the drop down menu adjacent to the Calculate button on the Control Bar select Calculation Summary 
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 Daylighting 

Daylighting Overview 

 

What is daylighting? 

The application of daylighting in AGi32 allows you to consider the effect of sun, sky and ground as a light source in the environment. The daily 
rotation of  the earth as well as its location in its orbit about the sun produce a predictable amount of sunlight at a given location. As the sunlight 
enters the atmosphere, a portion of the light is scattered by the atmospheric conditions. AGi32 uses many categories of sky to emulate these 
conditions: (1) Clear, (2) Partly Cloudy and (3) Overcast, in addition to 15 other general sky conditions described by the CIE. The sky conditions used 
in AGi32 are based on accepted IES and CIE equations. 

How do I apply daylighting? 

Daylighting can be applied to interior and exterior environments in AGi32. In exterior environments, the exterior surfaces must first be designated 
Daylight Exterior surfaces. Then daylighting can be enabled and your geographical location and analysis information selected. For interior 
applications, the daylight will need to be "let into" the space by creating transition openings such as windows and daylight openings in the Room or 
Object. Exterior surfaces that obstruct and/or reflect light into the interior environment can also be considered. 

Once the environment specification is complete, the application of daylighting can be calculated. AGi32 provides two methods of daylighting analysis. 
Both take place in Full Radiosity Method: 

Daylighting - This method allows you to calculate the daylight contribution for one particular moment in time (e.g., Friday, November 29, 2010 at 
9:35 AM) with one sky condition. The option to consider the effect of electric lighting as well is offered. 

Daylight Study - This method allows you to set up multiple instances of daylight application to the environment. You can analyze several times 
within one day and/or several dates, per your specifications. Multiple sky conditions may be specified, as well as the application of electric lighting. 
The images created within the daylight study are saved and can be viewed and shared with the Daylight Study Viewer. 
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Daylighting Calculations 

 

When daylighting is enabled in AGi32, two separate radiosity solutions are processed: exterior and interior. The following steps are applied: 

1. Direct - Sunlight and electric light are emitted to all elements visible to them, including normal and daylight exterior surfaces. Sunlight is 
transmitted directly into interiors only through Daylight Transition Glass and Openings. Simply creating rooms and cutting holes in the surfaces 
is insufficient (see Surface Types section below). 

2. Adaptive Subdivision - If adaptive subdivision is enabled (for interior and daylight exterior surfaces), the adaptive subdivision for both daylight 
and electric light is processed at this time. 

3. Indirect Daylight - Radiosity (exterior) - The Sky Dome, Virtual ground plane and any other daylight exterior surfaces proceed through radiosity 
calculations until the specified Radiosity Stopping Criterion is reached. Direct light from the Sky Dome and interreflected light from other 
surfaces is collected on the external surface of the Daylight Transition Glass and Openings.  

4. Transition - The Daylight Transition Glass and Openings serve as transition zones to bring the external interreflected component inside as a 
virtual luminaire. The photometric distribution of each window (based on the direction and intensity of the luminances calculated in the exterior 
radiosity solution) is computed. 

5. Indirect Interior - Radiosity (interior) - The Radiosity solution is computed for the interior environment, with the Daylight Transition Glass and 
Daylight Transition Openings acting as luminaires. The calculations are processed, as described above, until the specified Radiosity Stopping 
Criterion is achieved. Note: Light hitting the interior of Daylight Windows and Openings is not emitted to the exterior, it is absorbed. 

Surface Types and Properties 

To consider the effect of daylighting in exteriors as well as interiors, surfaces imported into or created within AGi32 must be designated appropriate 
surface types (and assigned attributes) specifically for daylighting analysis. Exterior surfaces considered in daylighting computations are handled 
differently, and separately, from other surfaces. Once the model is created, use the Surface Edit command to change the surface types for all 
relevant surfaces. 

• Single Sided and Double Sided Objects and Rooms may be used to create both interior and exterior surfaces. 

• Windows, skylights and openings should be modeled with Planar objects (or their CAD equivalent). One of the following surface types should be 
assigned to each: 

• 20 - Daylight Transition Glass (transparent) 

• 21 - Daylight Transition Glass (diffuse) 

• 22 - Daylight Transition Opening 

• Room surfaces can also be designated as a transition surface to model a window wall. 



AGi32 Help System  Daylighting 

356 

 

• Surfaces exterior to the fenestration need to be specified in this way by selecting them and giving them the Daylight Exterior attribute. 

Adaptive Subdivision 

We strongly recommend that Adaptive Subdivision be enabled and appropriate settings used when Daylighting is considered. This technique will 
make your shadowing elements look more realistic and produce a much "crisper" image. Adaptive Subdivision is available within the Calculate - 
Adaptive Subdivision command. 

Adaptive Subdivision is applied separately to Non-Daylight and Daylight surfaces. The settings within each category are independent and may differ, 
if the application warrants more detail in one or the other. 

• In interior environments, where no exterior surfaces other than the virtual ground plane are specified, only the default (upper) section in the 
dialog needs to be enabled. 

• In interior environments where exterior surfaces are to be considered, both the default and Daylight Exterior sections may need to be enabled. 
However, to save calculation time, you may not want to subdivide exterior daylight surfaces unless they are directly visible in the rendering of 
the interior environment. 

• In exterior environments, both sections needs to be enabled, although no interior subdivision will occur. 

For daylight applications, it is recommended that the Adaptive Subdivision parameters be set to the High Level: Maximum Subdivision Level = 5, 
Minimum Element Area = 0.1, Luminance Threshold = 1.1. 

Rendering Exposure and Daylighting 

As humans, we often perceive the luminance of an interior space to be similar to that outdoors as we look out the window from within. However, it is 
generally several orders of magnitude different. While the human eye can adapt by changing the aperture of the pupil, AGi32 must attempt  to render 
a scene while restricted to a limited exposure setting (similar to the F-stop on a camera lens). This results in an image that is similar to what one 
might see with a digital camera attempting to correctly expose both interior and exterior in one image: If the interior exposure is “normal”, the exterior 
is overexposed. Similarly, if the exterior is correctly exposed, the interior is usually dramatically underexposed. AGi32 has the ability to view the 
Exposure setting for both interior surfaces and exterior daylight surfaces individually and attempt a single setting to optimize the appearance of both. 

AGi32 provides three exposure settings to handle the interior (Non-Daylight Surfaces) vs. exterior (Daylight Surfaces) exposure settings. 

1. All Surface Types - This method treats the Non-Daylight and Daylight surfaces individually as discussed below, and then sets the exposure for 
the different surface types individually for the rendered image. The result is an image that appears closer to that of human vision. 

2. Non-Daylight Surfaces - The average Luminance of all non-daylight surfaces is calculated. The average Luminance value is divided by 18% 
reflectance to determine the average Illuminance value. Exposure is set to properly display this average value. 

3. Daylight Surfaces - The average Luminance of all exterior daylight surfaces is calculated. The average Luminance value is divided by 18% 
reflectance to determine the average Illuminance value. Exposure is set to properly display this average value. 

4. If the average reflectance of the current environment differs greatly from the assumed 18% value, the image may appear under- or 
overexposed. Exposure modification may need to be applied to properly display the image. 

Tone mapping may also be used to help correct the overexposure of daylit images. Tone Mapping is only available for Ray Traced images. 

Daylight Application Caveats 

The following caveats should be taken into account when considering daylighting availability in AGi32. 

• It is recommended that Adaptive Subdivision be enabled with the High Settings for daylighting calculations (Illuminance, Exitance, Daylight 
Factor, etc.) when computing daylight component to react to the dramatic luminance ratios on incident surfaces. For crisp renderings with no 
point-by-point calculations, post- process ray tracing may be used instead of a finer mesh. 

• AGi32 uses the IESNA and CIE accepted sky models to calculate the sky's contribution in the daylight calculations. The CIE recognizes the 
Kittler (CIE Clear Sky) model and the Moon and Spencer (CIE Overcast Sky) model, as well as 15 additional Standard General Sky models. 
The IESNA further recognizes the Pierpoint (Partly Cloudy) model.  

• The IES Handbook states that the traditional sky models (Clear, Partly Cloudy and Overcast) should not be compared to instantaneous sky 
conditions (especially for a partly cloudy sky, where the sky luminance distribution can change rapidly and in large amounts as the sun is 
revealed, partially obstructed or fully obstructed). It is not unusual for the instantaneous measured sky luminance to differ from the average 
mean value by a factor of 2 from measurement to measurement.  

CIE Standard General Skies 

The CIE mathematically defines fifteen sky types in CIE Publication S 011/E:2003, Spatial Distributions of Daylight - CIE Standard General Skies. 
The relative sky luminance distributions are described in the following table: 
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Type Gradation Group Indicatrix Group Description of luminance distribution 

1 I 1 CIE Standard Overcast Sky 

Steep luminance gradation toward zenith, azimuthal uniformity. 

2 I 2 Overcast, with steep luminance gradation and slight brightening towards the sun. 

3 II 1 Overcast, moderately graded with azimuthal uniformity. 

4 II 2 Overcast, moderately graded and slight brightening toward the sun. 

5 II 1 Sky of uniform luminance. 

6 III 2 Partly cloudy sky, no gradation toward zenith, slight brightening toward the sun. 

7 III 3 Partly cloudy sky, no gradation toward zenith, brighter circumsolar region. 

8 III 4 Partly cloudy sky, no gradation toward zenith, distinct solar corona. 

9 III 2 Partly cloudy, with obscured sun. 

10 IV 3 Partly cloudy, with brighter circumsolar region. 

11 IV 4 White-blue sky with distinct solar corona. 

12 V 4 CIE Standard Clear Sky, low luminance turbidity. 

13 V 5 CIE Standard Clear Sky, polluted atmosphere. 

14 VI 5 Cloudless turbid sky with broad solar corona. 

15 VI 6 White-blue turbid sky with broad solar corona. 

Gradation Group - indicates the gradation between horizon and zenith. Indicatrix Group - indicates the scattering function, which relates the 
luminance of a sky element to its angular distance to the sun. 

These models provide mean data averaged over a variety of time, location and measurement conditions. The CIE states that the Standard General 
Sky models (1 - 15) give an approximation to clear, overcast and skies of broken clouds that are sufficiently accurate for most daylight calculations.  

• A Daylight Transition Glass (Transparent) surface emulates a Fresnel reflector with an index of refraction of 1.5. It may be assigned a 
Transmittance color to tint the glass, and the tinted windows can be seen in the renderings. The transmission and reflectance of light through 
transparent materials such as glass and plastic (which are referred to technically as dielectric materials) is dependent on the angle of the incident 
light. When the direction of the incident light is normal to the material surface, approximately four percent of the light is reflected. However, at 
grazing incidence angles, nearly all of the light may be reflected. This Fresnel reflection is important for accurate daylight calculations. 

• The Daylight Transition Glass (Transparent) surface type can be assigned to any surface to model glass, with appropriate transmission and color. 
Daylight Transition Glass surfaces are visible in radiosity and ray-traced images. The color of the altered light will be evident on any incident 
surfaces.  

• The geometric altitude of the site locations is assumed to be 0 (sea level). The IESNA and CIE sky models used in AGi32 include exponential 
atmospheric extinction parameters that model Rayleigh scattering by air molecules, haze, and particulate matter. 

• Including daylight occluders and reflectors (e.g., surrounding buildings), modeled as Daylight Exterior surfaces, will make your daylighting 
calculations more accurate, as will modeling any exterior fenestration for blocking and reflection purposes. 

   

Daylighting Procedures 

What is daylighting? 

The application of daylighting in AGi32 allows you to consider 
the effect of sun, sky and ground as a light source in the 
environment. The daily rotation of a geographical location 
about the sun produces a predictable amount of sunlight from a 
known location. As the sunlight enters the atmosphere, a 
portion of the light is scattered by the atmospheric conditions. 
AGi32 uses many categories of sky to emulate these 
conditions: (1) Clear, (2) Partly Cloudy and (3) Overcast, in 
addition to 15 other general sky conditions described by the 
CIE. The sky conditions used in AGi32 are based on accepted 
IES and CIE equations. 
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How do I apply daylighting? 

Daylighting can be applied to interior and exterior environments in AGi32. In exterior environments, the exterior surfaces must first be assigned as 
Daylight surface types, then daylighting can be enabled and your geographical location and analysis information selected. For interior applications, 
the daylight will need to be "let in" to the space by creating transition openings such as Windows and Daylight Openings in the Room, Object or 
Building. Exterior surfaces that obstruct and/or reflect light into the interior environment can also be considered. 

Once the environment specification is complete, the application of daylighting can be calculated. AGi32 provides two methods of daylighting analysis. 
Both take place in Full Calculation mode: 

Daylighting - This method allows you to calculate the daylight contribution for one particular moment in time (e.g. Friday, November 29, 2002 at 9:35 
AM) with one sky condition. The option to consider the effect of electric lighting, as well, is offered. 

Daylight Study - This method allows you to set up multiple instances of daylight application to the environment. You can analyze several times 
within one day and/or several dates per your specifications. Multiple sky conditions may be specified as well as the application of electric lighting. 
The images created within the daylight study are saved and can be viewed and shared with the Daylight Study Viewer. 

   

Daylight Parameters 

This dialog allows you to enable daylighting calculations for a known geographical location at a specific date and time. Within this dialog, you will also 
be able to select the desired sky model, choose whether or not to consider the contribution of electric lighting, and manage multiple site locations. 

Enable Daylighting - This checkbox provides the On/Off switch for daylighting calculations. To consider daylight availability, check this selection 
box. 

Consider Electric Lighting in Daylight Calculations - This checkbox provides the On/Off switch for electric lighting when daylighting is enabled. To 
consider electrical lighting, check this selection box. This selection is enabled by default. 

Sky Conditions - AGi32 uses the IESNA and CIE accepted sky models to calculate the sky's contribution in the daylight calculations. The CIE 
recognizes the Kittler (CIE Clear Sky) model and the Moon and Spencer (CIE Overcast Sky) model, as well as 15 additional Standard General Sky 
models. The IESNA further recognizes the Pierpoint (Partly Cloudy) model.  

CIE Standard General Skies 

The CIE mathematically defines fifteen sky types in CIE Publication S 011/E:2003, Spatial Distributions of Daylight - CIE Standard General Skies. 
The relative sky luminance distributions are described in the following table: 

Type Gradation Group Indicatrix Group Description of luminance distribution 

1 I 1 CIE Standard Overcast Sky 

Steep luminance gradation towards zenith, azimuthal uniformity. 

2 I 2 Overcast, with steep luminance gradation and slight brightening towards the sun. 

3 II 1 Overcast, moderately graded with azimuthal uniformity. 

4 II 2 Overcast, moderately graded and slight brightening towards the sun. 

5 II 1 Sky of uniform luminance. 

6 III 2 Partly cloudy sky, no gradation towards zenith, slight brightening towards the sun. 

7 III 3 Partly cloudy sky, no gradation towards zenith, brighter circumsolar region. 

8 III 4 Partly cloudy sky, no gradation towards zenith, distinct solar corona. 

9 III 2 Partly cloudy, with obscured sun. 

10 IV 3 Partly cloudy, with brighter circumsolar region. 

11 IV 4 White-blue sky with distinct solar corona. 

12 V 4 CIE Standard Clear Sky, low luminance turbidity. 

13 V 5 CIE Standard Clear Sky, polluted atmosphere. 

14 VI 5 Cloudless turbid sky with broad solar corona. 

15 VI 6 White-blue turbid sky with broad solar corona. 

Gradation Group - indicates the gradation between horizon and zenith.  

Indicatrix Group - indicates the scattering function, which relates the luminance of a sky element to its angular distance to the sun. 

These models provide mean data averaged over a variety of time, location and measurement conditions. The IES Handbook states that the 
traditional sky models (Clear, Partly Cloudy and Overcast) should not be compared to instantaneous sky conditions (especially for a partly cloudy 
sky, where the sky luminance distribution can change rapidly and significantly as the sun is revealed, partially obstructed or fully obstructed). It is not 
unusual for the instantaneous measured sky luminance to differ from the average mean value by a factor of 2 from measurement to measurement. 
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The CIE states that the Standard General Sky models (1 - 15) give an approximation to clear, overcast, and skies of broken clouds that are 
sufficiently accurate for most daylight calculations. 

Absolute Zenith Luminance Factor 

This setting allows you to  calibrate the chosen sky models to local conditions by prorating the calculated sky luminance distribution according to a 
measured zenith luminance value. 

Sky Dome - AGi32 allows you to generate physically realistic daylight visualizations by including a variable luminance background to simulate the 
sky. The Sky Dome is for visualization purposes only and has no effect on the calculations. The default setting is On. More on the Sky Dome. 

Site Location 

This section allows you to specify the geographical location of your site and True North orientation. 

Name - Choose a saved site location from this list, or add a new site location by clicking the Manage button.  Latitude information is entered in 
Degrees, Minutes and Seconds and converted to decimal degrees. 

It is highly recommended that one obtain the exact geographical coordinates for the intended daylighting analysis (Latitude and Longitude 
coordinates). This will make your daylighting calculations more accurate.  

The following is a short list of major metropolitan city coordinates for your reference.  

Name  Location  Latitude Longitude 

Athina  Attiki, Greece 037°58'59"N 023°43'59"E 

Beijing   Beijing, China 039°55'44"N 116°23'17"E 

Berlin  Berlin, Germany  052°31'00"N 013°24'00"E 

Buenos Aires  Distrito Federal, Argentina  034°35'15"S 058°40'21"W 

Cape Town  Cape Province, South Africa 033°55'00"S 018°25'00"E 

Caracas  Distrito Federal, Venezuela  010°30'00"N 066°55'00"W 

Chicago Illinois United States 041°51'00"N 087°39'00"W 

Dallas Texas United States 032°46'59"N 096°48'00"W 

Detroit Michigan United States 042°19'53"N 083°02'44"W 

Dusseldorf  Nordrhein-Westfalen, Germany  051°13'00"N 006°46'00"E 

Frankfurt  Brandenburg, Germany 052°21'00"N 014°33'00"E 

Guadalajara   Jalisco, Mexico 020°40'00"N 103°19'59"W 

Houston Texas United States  029°45'47"N 095°21'47"W 

Istanbul   Istanbul, Turkey 041°01'06"N 028°57'52"E 

Jakarta   Jawa Barat, Indonesia 006°10'08"S 106°49'18"E 
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Lima   Lima, Peru 012°03'00"S 077°03'00"W 

London Greater London, United 
Kingdom 

 051°30'00"N 000°07'00"W 

Los Angeles California United States  034°03'07"N 118°14'34"W 

Madrid  Madrid, Spain 040°24'00"N 003°40'59"W 

Manila  Manila, Philippines  014°34'59"N 121°00'00"E 

Melbourne  Victoria, Australia 037°49'00"S 144°58'00"E 

Milano  Lombardia, Italy  045°28'00"N 009°12'00"E 

Napoli   Campania, Italy 040°49'59"N 014°15'00"E 

Osaka   Osaka, Japan 034°40'00"N 135°30'00"E 

Paris   France 048°52'00"N 002°19'59"E 

Philadelphia Pennsylvania United States  039°57'07"N 075°09'51"W 

Recife  Brazil  008°03'00"S 034°54'00"W 

Rio de Janeiro  Rio de Janeiro, Brazil  022°54'00"S 043°13'59"W 

Salvador   Bahia, Brazil 012°58'59"S 038°31'00"W 

San Francisco California United States  037°46'30"N 122°25'05"W 

Santo Domingo  Dominican Republic 018°28'00"N 069°54'00"W 

Shanghai   Shanghai, China 031°06'33"N 121°22'05"E 

Singapore   Singapore 001°17'35"N 103°51'20"E 

Sydney  New South Wales, Australia  033°52'59"S 151°13'00"E 

Tokyo Tokyo, Japa 035°41'06"N 139°45'05"E 

Toronto   Ontario, Canada 043°40'00"N 079°25'00"W 

Latitude - This text box echoes the Latitude coordinates for the chosen site location. Latitude information is entered in decimal degrees. Latitude is 
measured from the equator, with positive values going north and negative values going south. 

Longitude - This text box echoes the Longitude coordinates for the chosen site location. Longitude information is in decimal degrees. Longitude is 
measured from the Prime Meridian, (the meridian that runs through Greenwich, England), with positive values measured West and negative values 
measured East. 
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True North - Specify the direction of True North for the site location. This orients your site location locally in AGi32 to the site's location on the planet. 

When setting True North you are provided with two options: 

1. Enter the True North orientation in the text box. The default True North position is 90, which orients your site location using the standard North 
direction in AGi32 (top of the screen in Plan View). 

2. Click the Set Compass button to orient the North direction of your site graphically in AGi32. Locate two reference points parallel to your North 
orientation to set the compass direction. You must be in Model Mode to set the compass graphically. 

Date and Time - Select the calendar date and time for the daylighting analysis. AGi32 will warn if the sun is below the horizon for the date and  time 
selected. Daylight calculations are not valid for dawn or twilight conditions. 

Daylight Savings - Be sure and select the checkbox for Daylight Savings Time if it is in effect in the area of interest. Daylight Savings Time is 
typically in effect from mid-spring to mid-fall in most states in the USA. 

   

Dates of Interest (2007 - 2014) 
 

Year Vernal Equinox (northern 
hemisphere) 

Autumnal Equinox 
(northern hemisphere) 

Winter Solstice (northern 
hemisphere) 

Summer Solstice (northern 
hemisphere) 

Day when night and day 
are nearly the same 

length, first day of Spring. 

Day when night and day 
are nearly the same 
length, first day of 

Autumn. 

Shortest day of the year in the 
northern hemisphere, Sun is 

farthest south, first day of 
Winter. 

Longest day of the year in the 
northern hemisphere, sun is 
farthest north,  first day of 

Summer. 

2007 21 March 23 September 22 December 21 June 

2008 20 March 22 September 21 December 20 June 

2009 20 March 22 September 21 December 21 June 

2010 20 March 23 September 21 December 21 June 

2011 20 March 23 September 22 December 21 June 

2012 20 March 22 September 21 December 20 June 

2013 20 March 22 September 21 December 21 June 

2014 20 March 23 September 21 December 21 June 

   

Manage Site Locations 

AGi32 is able to store as many site locations as you need. Site locations are stored alpha-numerically by location for ease of retrieval. 

Adding to the site list - To add locations to the list, select the Add button at the bottom of the dialog displaying the site list.  

Site Specifications - Site locations are added by entering a Site Name and the location in terms of Latitude and Longitude. Latitudes are angles 
North or south of the Equator while Longitudes are angles East or West of the Prime Meridian in Greenwich, England. 

Latitude and Longitude are entered in terms of Degrees, Minutes (of arc) and Seconds (of arc) and are typically denoted by symbols °,'," . For 
example, 39° 45' 6" means an angle of 39 degrees, 45 minutes and 6 seconds. Do not confuse the notations (', ") for feet and inches. There are 60 
seconds of arc in a minute and 60 minutes of arc in a degree. 
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Site location are stored by AGi32 in decimal degrees. The conversion from the degrees, minutes, seconds notation to decimal degrees is automatic. 
Latitudes east of the prime meridian are negative, Longitudes south of the equator are negative. 

Removing locations from the site list - To remove a location, select the site and press the Delete key on your keyboard. 

   

Add Site Locations 

By selecting the Add button from the Manage Site Locations dialog, you can add site locations of your choice. Enter the name of the site on the top 
line in the dialog followed by the Latitude and Longitude in the spaces provided below. Be sure to select the proper direction from the radio buttons; 
East or West for Longitudes , North or South for Latitudes. 

Latitude -  the angle north or south of the equator as specified in Degrees, Minutes and Seconds. Latitude is measured from the equator, with 
positive values going north and negative values going south. 

Longitude - the angle east or west of the prime meridian in Greenwich, England as specified in Degrees, Minutes and Seconds Longitude is 
measured from the Prime Meridian, with positive values going east and negative values going west. 

   

Set Compass 

Compass Angle 

Compass refers to the counterclockwise angle in degrees from computer East that describes the declination of True North. This is consistent with the 
AGi32 angular positioning scheme using World Coordinates (0 is East, counterclockwise is positive). The Compass angle can be entered manually 
by typing in the space provided, or by using the Set Compass button. 

Examples 

• If your project is constructed such that the top of the screen is True North (it is also computer North), then the Compass angle is 90 degrees. 

• If True North is facing due North East with respect to the computer screen, the Compass angle is 45 degrees. 

Set Compass 

The Set Compass button allows you to manually draw a vector on your drawing that is parallel to True North. Select the button and control will return 
to the graphics area to draw the vector. Set the reference point anywhere on your drawing keeping in mind that the second point you select will 
define a line parallel or pointing towards True North. Proceed to select the second point. Make the vector long enough (distance from first to second 
point) that the angle will be accurate. You can watch the Compass angle in the lower left corner of the screen as denoted by the Orient angle. 

Once complete, control will return to the Daylight Parameters dialog. 

   

Sky Dome 

AGi32 allows you to include a realistic Sky Dome in your daylight enabled renderings. The sky dome changes color slightly depending on the Sky 
Condition selected and includes a small sun image. 

• The sky dome is used in for visualization purposes only, turning it on or off does not affect your point by point calculations or surface 
luminances. 

• The sky dome includes a virtual ground plane with 18% reflectance. The 18% reflectance value is derived from Eastman Kodak's average 
reflectance of exterior environments. Additional exterior surfaces may be added, including a ground plane specified by the user with alternate 
reflectance (created using a Planar object). The virtual ground plane will not interfere with "real" surfaces, if a user-defined ground is specified, it 
will be used in place of the virtual ground plane in the areas it occupies. 

• The sky and sun colors are fixed. Sky color will change with orientation and selection of sky model (clear, partly overcast, overcast, CIE General 
Sky selection). 

• The sky dome is On by default. 

• The specified environment luminances and other settings (e.g. Exposure Setting) may have a dramatic affect on the appearance of the sky 
dome. If the sky dome is overexposed, the variation in the sky dome luminance may not be visible. In general, it is best to select exposure 
based on daylight surfaces in the Display Properties dialog. If this is not possible, experiment with lowering the Exposure Setting to create more 
contrast in your images. 
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Sky dome position - The sky dome is automatically positioned and sized. It is centered over the extents of the environment with base at Z=0. The 
radius of the sky dome is 5 times the extents of the environment. In order to accommodate the Sky Dome, the back clipping plane has been moved 
to 100,000 to insure the sky dome is not clipped. It is possible in large environments that this distance may need to be increased. 

The images shown below show the Sky Dome for each IES and CIE General Sky Type available for selection. 

Sky Dome images for IES and CIE Sky Conditions 
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 Daylight Studies 

Daylight Study Overview 

Daylight Studies are calculated to understand the progression and intrusion of daylight into an environment over some defined time interval or at 
critical dates and times during the year, such as at solstices and equinoxes. 

Depending on the number of samples requested, Daylight Studies can take significant amounts of time to calculate. 

A Daylight Study can give you the following results: 

1. Visualizations - Both RGB and Pseudocolor images can be generated from each daylight analysis pass. To see multiple images for each date 
and time, create multiple Render views in render mode and specify the Viewpoint you'd like to use. Radiosity renderings or Ray Tracing images 
(radiosity and ray trace) may be generated. 

2. Illuminance and/or Daylight Factor calculations - To see the calculated point by point values for each daylight analysis pass, save the AGi32 job 
files for each date and time. The Daylight Study Set parameters tab includes a checkbox allowing for this selection. Once the Daylight Study is 
complete, you may open each job file and view the calculated results. 

3. Interactive Renderings - By saving the Radiosity Solution files (RSF Files) in addition to the AGi32 job files, you may see the completed 
rendering for each daylight analysis pass and navigate inside or around your environment without having to recalculate. RSF files can be quite 
large and take time to save. Enabling this switch requires that you have plenty of disk space and time. 

Improving the images generated from a Daylight Study 

1. Create your desired viewpoints at a large enough Zoom level so that the daylit sections are clearly visible. 
2. If you are planning on using the scale with a pseudocolor view be sure and select it prior to starting the daylight study. 
3. For cleaner images enable Anti-aliasing prior to starting the study. 

4. Select Ray Tracing images and enable Ray Trace Direct Illumination, Anti-Aliasing and Tone Mapping in the Ray Trace-Parameters command 
prior to starting the study. 

Related Topics 

Daylighting Overview 

Daylight Study 

AGi32 provides a convenient method to que a series of daylight calculations to be executed sequentially. This allows the study of daylight within a 
particular model to be achieved over a specific time period with a variety of different conditions. This can be incredibly handy as we can perform all 
the calculations we might need in batch with the computer unattended. 

Daylight Studies can be specified in either Model Mode or Render mode, however, they can only be executed in Render mode. 

 From the drop down menu adjacent to the Daylight button on the Control Bar select Daylight Study 

 

Set Parameters Tab 

Within the Set Parameters tab you are able to set both General parameters and those specific to the site location for the study.  

General Parameters 

Study Name - Enter a name for the daylight study. This will be the name of the Daylight Study file (e.g. My Daylight Study.DVF) and the name of the 
folder where the study and all images are saved. By default, the folder will be created inside the JobFilefolder or in the DaylightStudyFiles folder 
specified in the Tools-System Settings-File System tab. 

A Daylight Study name can contain up to 255 characters. Invalid characters are  * ? " (asterisk, question mark, quote). 

Image Type - Daylight Studies will generate the image types selected and automatically save them as JPG files in the study folder. The Daylight 
Study Viewer will load the saved  images for review. For each view created using the Render View Manager (Render mode View menu), you can 
elect to show RGB, Pseudocolor or both. 
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Ray Tracing Images - The option to generate Ray Trace images is available. If this option is selected, images will be ray traced using the current 
Ray Trace Parameters. When Ray Tracing Images is selected, images saved with the daylight study will be Ray Trace images, not radiosity only 
images and will not be labeled. 

 It is important to note that the render views of interest should be set prior to executing the Daylight Study. Otherwise, the render view 
generated uses only the image that was visible when the study is executed. Multiple render views may be saved using the Render View Manager 
command. 

•  If you are planning on using the scale with a pseudocolor view be sure and select it prior to starting the daylight study. 
• For cleaner images enable Anti-aliasing prior to starting the study. AGi32 will ignore anti-aliasing if image labels are applied (below). 

Label Images - Rendered images can be labeled with Study Name, Site Name, Latitude/Longitude, Compass, Sky Conditions, Date and Time. The 
labels are applied in the lower left corner of the image and are included in the JPG file generated as well. Text labels are Times New Roman font and 
cannot be edited once generated. AGi32 will ignore anti-aliasing if image labels are applied. 

Raytrace images cannot be labeled. 

Files 

Save all Generated AGi32 Job files - If you are interested in examining point by point calculations or interacting with any of the individually 
calculated files as specified in your Daylight Study, this switch must be checked. The Daylight Study Viewer is only capable of viewing rendered 
images. The switch need not be enabled for the Daylight Study Viewer to access the rendered images as they are saved automatically as JPG 
images. 

Save Rendered Environment Files (Radiosity Solution Files) - As a supplement to saving AGi32 Job Files, if you would like to be able to recall 
the interactive rendering associated with any single calculation specified in the daylight study, this switch must also be checked. Do not confuse this 
with saving the rendered images in the Daylight Study, these still images are saved automatically. By saving Radiosity Solution Files (RSF) you are 
saving the entire radiosity solution which enables the AGi32 Job Files to be opened at some time in the future and display the interactive rendering 
without having to recompute.  

IMPORTANT - RSF files can be quite large and take time to save. Enabling this switch requires that you have plenty of disk space and time. 

Create Tab Delimited Text File for Each Sample - Checking this option will include your Daylighting specifications and numerical analysis 
results (Average, Maximum, Minimum and Avg/Min and Max/Min ratios) as a text file for each sample in the Daylight Study Viewer File 
(DVF File). The data is not viewed directly in the viewer, but can be loaded into a spreadsheet or other program for analysis. The text files 
are named Sample1.txt, Sample2.txt, etc. 

Location for Studies - • The folder location for Daylight Studies is specified globally using Tools-System Settings command (File System tab). The 
default location is: <JobFileFolder> \_DaylightStudy\<Study Name>. 

Daylight Parameters 

Site Location - These parameters are identical to those set in the Daylighting command. A Daylight Study can only be conducted on a single site 
location with a single true North setting.  

Sky Dome -  Select this checkbox to enable the Sky Dome for all calculations in the Daylight Study. The Sky Dome is a variable luminance 
background and has no effect on the calculation of daylight component. More on the Sky Dome. 

Set Dates and Times Tab 

A Daylight Study can consist of as little as a single calculation although this is an underutilization. The purpose of the Daylight Study command is to 
design a study composed of a variety of meaningful dates and times, sky conditions and combinations of electric lighting,  which, when combined, 
can number as high as one thousand. Most likely, the average study will consist of somewhere between four to twenty different calculations.  

Date and Time Sample - The dates and times selected for the study are tabulated in the center of the window. To add dates and times select the 
Add button. If you have composed a sample of dates and times that you would like to use repeatedly, save the sample using the Save button. 
Individual dates and times can be deleted by selecting the row and pressing the delete key on your keyboard. To delete multiple date/time samples, 
use the Shift select and Ctrl select methods to select the row marker for multiple rows, then click the keyboard Delete key. The entire collection of 
dates and times can be deleted using the Delete All button. 

Add Study Dates and Times 

Save and Load Study Dates and Times 

Sky Conditions - Select any or all sky conditions to be considered for the selected dates and times. Each date and time will be computed for each 
sky condition selected. 
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Absolute Zenith Luminance Factor - This setting allows you to  calibrate the chosen sky models to local conditions by prorating the zenith 
luminance values based on measured horizontal Illuminance values. It is best applied to overcast skies, as one factor is applied to every patch in the 
sky dome uniformly. 

To calibrate your sky model, measure the actual unobstructed exterior Illuminance value and divide by the calculated Illuminance value at the same 
point. 

 

Electric Lighting - Select one or both Electric Lighting considerations. Each sample date and time will be computed for each electric lighting option 
selected. 

Number of Samples - The number of samples (individual calculations) to be computed in the study considers to cumulation of all selections; dates 
and times, sky conditions and electric lighting. The maximum number of samples permitted in a study is one thousand. A cumulative study count is 
supplied for your convenience. 

Daylight Study Viewer 

A Daylight Study Viewer is shipped and installed with AGi32 that allows you to view the images associated with the Daylight Study. The Daylight 
Study Viewer will open the current Daylight Study automatically. 

 From the drop down menu adjacent to the Daylight button on the Control Bar select Daylight Study Viewer 

 

The Daylight Study Viewer is also available at no charge for individual installation and use from the AGi32.com website.   

Add Daylight Study Date and Time 

From the Add Date and Time dialog select either a Single Date and Time, or a Date and Time Interval by clicking on the appropriate radio button 
adjacent to the selection. You can add multiple entries from both the single and interval sections to complete the desired study.  

Add Single Date and Time 

A single date and time can be selected for the study if desired. Typically, if only a single date and time is selected, it will be combined with multiple 
sky conditions and electric lighting options in order that a series of calculations is performed. If this is not the case, a single daylight calculation can 
be computed by simply using the Daylighting command and not the Daylight Study. 

Selecting a date 

The default date setting in the pull-down menu will be the current 
system date on your computer. Click on the drop-down arrow to reveal a 
monthly calendar that you can use to select a date. Scroll between 
months using the arrows on top of the calendar, click on the date to 
select. 

 

Selecting a time - Times are specified in hours minutes and seconds. The time can be changed by clicking on any of the units of time, manually 
typing from the keyboard or using the scroll buttons beside the time setting. 

Daylight Savings - If the date and time selected should consider Daylight Savings, select the checkbox. In most states in the USA, daylight savings 
time is In-effect in the summer months. 

Add a Date and Time Interval 

The most common use of the daylight study will be to compute the contribution of daylight over a specific time period in order to establish the 
extreme effects of daylight on an exterior site or interior space. Generic dates of interest may be the Equinox and Solstice dates. 
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Start Date - Select the date (inclusive) that you would like to begin the interval. Select the date from the drop-down calendar as explained above. 

End Date - Select the date  that you would like to complete the interval from the drop-down calendar as explained above. 

Increment in days - Enter the number of days between samples. This number may range between 1 and 365. 

Start Time - Select the time of day (inclusive) that you would like to begin the interval. You should be careful to select a time when the sun is above 
the horizon. 

End Time - Select the time of day  that you would like to end the interval. Again, it is important  to select a time when the sun is above the horizon. 

Daylight Savings - If the date and time selected should consider Daylight Savings, select the checkbox. 

Interval - Select the interval between samples in decimal hours. If you want a sample every two hours, enter 2. 

Total number of studies - The total number of studies in the specified interval is computed at the bottom of the dialog. You can add multiple 
intervals as required so this total applies to this interval only. An absolute total number of samples is calculated in the main Daylight Study dialog, Set 
Dates and Times tab.  

Add Study Manager 

Saving and Loading user defined studies - Using the Save and Load capability, you can create and save your own studies containing exactly the 
dates and times of interest. You may elect to save a generic study that considers the Equinox and Solstice dates, or perhaps a project specific study 
with dates and times relative to the task at hand. Either way,with a little time spent creating the studies initially, they will be available for later retrieval 
when required. 

Saving a study - Select the Save button from within the Set Dates and Times tab of the Daylight Study dialog.  When the Study Sample  Manager 
appears, assign a Description for this study. It can be up to 255 characters but should not contain an asterisk, question mark, or quote. Click on the 
Save button to save the study and transfer its description to the lower portion of the dialog. The study is now saved for later use. 

Deleting a previously saved study - Select the study from the list and click the Delete button. 

Loading a previously saved study - Select the Load button from the Set Dates and Times tab of the Daylight Study dialog. The Study Sample 
Manager will appear with a list of your previously saved daylight studies. Select a study from the list and click OK.  
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Textures  

Textures Overview 

Textures are images that are applied to surfaces when rendered in AGi32. The textures provide more photorealistic images by making the surfaces 
look more real - like brick, marble, tile etc. 

In general, there are two different types of textures used. Tiling 
textures produce seamless patterns when applied in a Grid or 
Static pattern to the surface. Most architectural surfaces (e.g., 
brick, carpet, stone, stucco) are created by applying tiled 
textures to the surface. Images that do not tile (such as artwork 
and photos) are also textures and are usually stretched across 
a surface. 

A texture is a 2D image that is applied to a surface. Although 
the texture may look three dimensional, it is really flat and casts 
no shadows on itself or other surfaces. For example, a texture 
of brick looks 3D, with the bricks and mortar appearing to have 
different thicknesses, but the texture is just a "picture" of the 
brick. When the brick wall is illuminated in AGi32, the surface is 
flat. 

Textures are considered in calculations when applied in AGi32. 
The average color and reflectance of the texture is calculated 
and used in the Radiosity calculations. Turning the textures on 
or off in Render mode only effects the texture visibility not the 
calculations. 

To preview how a textures are applied to your surfaces, go to 
Render mode. Select the View-Display Properties command, 
enable the Shaded view and select the Textures option. This 
way you can preview your textures before proceeding with the Radiosity calculations. 

Applying textures to surfaces 

Textures can be applied to Room, Building and Object surfaces in one of two ways. When a Room, Building or Object is initially created, textures can 
be applied to each of the related surfaces collectively (e.g. apply Texture to Ceiling, Walls and/or Floor). Once the surface has been created, the 
individual surfaces may have textures applied to them individually or collectively with the Surface Edit command. 

How textures are applied to surfaces 

The selected texture is applied to the entire selected surface. For composite surfaces with multiple parts (like domes) the texture is applied to each 
piece individually - not stretched across the entire dome. We recommend selecting a uniform texture with no discernable luminance or hue contrast 
in these cases so that the entire surface looks homogeneous. To add areas with different texture, create another object to contain the texture (e.g., 
an object on the wall with art stretched across it or molding with ornamental texture on it). 

Textures appear on both sides of a two sided surface. The texture is reversed on the back side of the surface. 

Design Guidelines 

• When applying textures to an environment, you will find that too many textures can make the renderings look unrealistic. Applying realistic 
textures to a few select surfaces creates rich, dynamic renderings. 

• Size the textures realistically. Stretching a texture across a large surface can make the texture look blurry and out of focus. Static sizing places 
a fixed size on the texture - like a 1' floor tile. Each tile is 1' across and will be tiled accordingly, no matter how small or large the floor. When 
selecting a static size for a texture, look at the texture details and gauge a realistic size. For example, when looking at a brick texture - each 
brick is 8" long. If the texture contains 4 bricks across, you know the texture is approximately 2' long. 

• Making textures: You may make textures yourself by scanning in surface photographs or using a digital camera. When capturing images to use 
as tileable textures, care should be taken that the texture is uniform - no luminance contrast from one side to the other, the image should be 
cropped such that it does not create an undesirable pattern, edges should be undetectable. 
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• Texture libraries are available for commercial sale, there are also many textures available for free online. Try searching for "free textures" or 
search through commercial manufacturers websites (such as flooring or stone retailers). 

Texture Notes 

Textures are not included in VRML files at this time. VRML does not support shaded textures (i.e., all lighting effects would be lost!). 

When sharing object libraries that include textures, the texture files need to be shared as well. The texture files are not included in the Object Library; 
only references to the textures are included. The textures need to be copied into the same subfolders in Textures that they originated in and the 
texture name must rename the same as well. The Textures database should be updated before the Library Object is selected for the textures to be 
applied. 

   

Select Texture 

Textures are photographic or artistic images that you can map to surfaces to add a more photorealistic effect to your renderings in AGi32. Textures 
are used to represent patterns across the surface instead of a solid color (i.e., brick, carpet, grass, tile, art, etc.). 

Unlike the real surface, textures only overlay images on top of a flat surface. For example, a texture of brick appears to have mortared joints and 
rough bricks, but in reality the image is two dimensional. This means that you cannot graze the brick texture with light and expect to see shadowing 
from the bricks. 

Textures are considered in the Radiosity calculations as their average reflectance is applied to the surface they are mapped to, replacing the original 
surface reflectance. 

Selecting textures 

The Select Textures dialog is displayed when you wish to apply textures to a surface in AGi32. It provides three avenues for selecting textures. 

Database - This tab allows you to search the Textures database for a texture using material classifications and/or reflectances. 

Textures In Job File - This tab allows you to select a texture that has already been applied to another surface in the job file. 

Browse - The Browse button allows you to search your computer or network for an image file to use as a texture. Acceptable image file types include 
bitmap (BMP), JPEG (JPG). When an image is selected in this manner, you are prompted to add it to the Textures database as well. 

   

Select Texture - Database 

The Database tab lets you look for a texture in the Textures database in many different ways. You can search for a texture by classification (i.e., 
wood) or by average reflectance (i.e., between 0.20 and 0.40). If Favorites were specified when the database was created, you may limit the search 
functions to just these images. 

Search by Classification 

All textures in the Textures database are classified into categories. Some textures appear in only one category, others in several. Select the 
Classification checkbox and select the desired category to see the textures available in the category. The Other classifications displays all 
miscellaneous categories. These additional categories include ones from Lighting Analysts as well as any you have specified when the Textures 
database is created or updated. 

Search by Average Reflectance 

When a texture is added to the Textures database, its average reflectance and color is calculated. This value is stored along with the texture in the 
database. You may search the database by average reflectance ranges if desired. this ability allows you to quickly find all textures within the same 
reflectance range - like light colored surfaces (i.e., for ceilings or walls). 

The Search by Average Reflectance filter may be used in conjunction with the other classification types. For instance, you may search through the 
Wood classification for materials with reflectances between 40 - 60%. 

Favorites 

At any time, you may rate a particular texture as a favorite. To quickly find a favorite texture, use the Favorites filter. 
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The Favorites filter stratifies the database choices further by only displaying the textures marked Favorite in addition to the filters discussed above. 
For example, when the Wood classification is selected, only wood textures rated as a Favorite would appear. If no Wood textures were marked as 
favorites, no textures would be available for selection. 

Texture Database 

The Texture characteristics are shown in this section. The average texture reflectances, colors, name and categories are displayed. Textures may be 
rated as favorites by selecting the Favorite checkbox when the texture is displayed. Similarly, a texture marked as a favorite can be derated by 
unchecking the Favorites checkbox when the texture is displayed. 

 To navigate through the categorized textures, use the arrow buttons at the bottom of the dialog. To use a particular texture, click OK once it is 
displayed in the dialog. 

You may change the Texture classifications on the fly by clicking the Re-Classify button. A Classification dialog will appear, allowing you to add or 
remove classifications as desired to customize the database. 

A texture may be removed from the Textures database by clicking the Remove button. Removing textures allows you to pare down the database of 
textures you never specify. However, if these textures are located in the Textures folders in AGi32, you will be prompted to add them when the 
Texture database is updated. 

Note: You can use the keyboard to scroll through the textures found instead of the mouse. Click in the Texture Name textbox in the Search results 
section. Use the Ctrl-Left Arrow and Ctrl-Right Arrow keys to scroll forward and backward. The Ctrl-End and Ctrl-Home keys advance you to the first 
or last texture. 

   

Browse for a Texture 

The Browse Texture button allows you to navigate through the file structure on your computer or network to add an image that exists outside of the 
Textures database. Image types recognized in the Browse tab include bitmap (BMP) and JPEG (JPG). 

Select the Drive to browse, then use the folder structure to navigate to the desired folder location. To search other drives on your network that are not 
visible, click the Network button to map the network drive. 

Once the texture is selected, it is added to your Texture database. Select a classification for the texture (or multiple classifications if you wish). 

Once the selected texture is added to the Textures database, you may select the surface application options in the Texture dialog. 

   

Textures in Job File and Recent Textures 

The Job File category lists textures that are currently, or were at one time, applied to surfaces in the current job file. 

The Recent category lists the last 20 textures applied to surfaces in any job file. When a texture is placed in the Recent category, its display mode 
(stretched, grid pattern, etc.) is saved and restored with the recent texture is selected from this category. 

The textures in these two categories may be reapplied to other surfaces quickly by selecting them from this category instead of going through the 
(probably larger) original categories.   

Once a texture is selected, its properties (name, average reflectance, etc.) and display options are shown on the right side of the Texture dialog. 

   

Texture Application 

The Textures dialog specifies how the texture is applied to the surface. You may also select an alternate texture to apply by clicking the Select 
button. 

Display Mode 

The Display Mode section specifies whether the texture is stretched, in a grid or applied using a fixed size across the surface. The default option 
stretches the texture across the surface. 

A tiling pattern may be used in place of the original texture if the original texture is not already seamless. By using tiled textures, the pattern of 
images is less apparent although additional patterns may be visible from the tile. Tiled textures may be stretched, in a grid or assigned a fixed size 
just like the original. 
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Tiling Pattern 

Textures may be tiled if desired. When this option is selected, the image is 
paneled (copied and rotated in three quadrants) to create a seamless texture. 

A tiled copy of the texture is created in the Textures folder in addition to the 
original texture. The tiled copy is referenced when the environment is rendered 
in place of the original texture. The tiled texture is not added to the Textures 
database as any texture may be tiled on the fly. 

Most architectural textures found in textures libraries are already tiled. 

 

Original Texture 

 

Tiled Texture 

The Stretch option stretches a single instance of the texture across the entire surface. 

In the example shown at right, the texture is stretched across a 10' (X) by 15' (Y) planar object. 

 

The Grid option places a pattern of textures across the surface using the specified grid layout. The texture is 
resized to conform to the grid pattern. 

In the example shown at right, a 2 x 2 grid of the "skier" texture is applied across a 10' (2 in the X) by 15' (2 in the 
Y) planar object. 

 

The Fixed Size option creates a repeating pattern of the texture by assigning a fixed size to the texture. 

In the example shown at right, the texture is assigned a Fixed Size of 5'. The texture itself has a square aspect 
ratio which is maintained in this pattern type. 6 copies of this texture are needed to cover the 10' (2 in the X) by 15' 
(3 in the Y) planar object. 

 

Rotation Angle 

This section specifies the rotation of the texture across the surface. The default rotation angle is 0. You may specify rotation angles in 90 degree 
increments (0, 90, 180, 270) to rotate the texture counterclockwise across the surface. 

Textures are applied to a surface based on the first baseline. This baseline aligns the texture of the surface. For vertical surfaces, textures are 
aligned from bottom to top automatically. 
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Textures Database 

The Textures database allows you to search for textures based on classification category. AGi32 provides you with a multitude of factory provided 
textures, pre-classified into easily recognizable categories. New textures may be added by browsing or using a drag-and-drop method. In the drag-
and-drop method, you may drag a BMP or JPG file into the Select Textures dialog, and even into a specific folder, where it will be saved for future 
use. 

AGi32 recognizes textures placed in the Textures folder within the AGi32 application data folder. You may add textures to the database that are in 
other locations on your hard drive; this must be done with the Browse command. When a texture is selected individually, it will be placed into the 
checked category, if one is selected; otherwise, it will be placed in the Unclassified category. Once there, it can easily be moved to another category 
by clicking on it and dragging it to the desired category. 

The Textures database may be accessed at any time from the Tools menu (Tools - Textures). You may rename or add new classifications, move or 
delete textures, or simply view the available textures. 

Adding to the Textures Database 

 When adding your own textures to the database, please keep these general "rules" in mind: 

• Textures must have width and length set to 64, 128, 256 or 512 pixels in order to prevent pixelization anomalies on the screen.  

• The average reflectance and associated color are calculated and displayed once the texture has been added to the database. These values 
may not be altered. 

• You can classify the texture by dragging it into the appropriate category.  

• You may add a new texture category: Right click in the categories list area and select New Category from the menu that opens. 

• A texture may be added to your Favorites by right clicking on the texture and selecting Add to Favorites from the menu that opens. The 
Favorites category is at the top of the list of textures categories. 

• A texture may be omitted right clicking on it and selecting Delete Texture.  
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 Multi-Use Commands 

Object Labeling - Concepts 

Text labels for Objects are accessed from the labeling button within any Add or Edit Object dialog. There are three types of labels applied to Objects. 
Those specific to Objects in general are listed under the Object tab. Labels related to the Component objects when combined into a Library Object 
(or layers in an imported 3D CAD model) are found under the Component tab. Labels related to the individual surfaces in an object are found under 
the Component Surfaces tab. Text labels can be placed in your choice of Windows fonts and scaled text size. 

Object Tab 

In the example at right, an Object with all of the Labeling options from the Object tab is selected. All labels are 
located below the last vertex point specified when creating the object. 

  

  

Component Tab 

Selecting the Component tab in the Object Labeling dialog presents the selection of text labels relative to the individual objects (or layers in a 3D 
CAD model) combined to make a Library Object. Selecting this Labeling scheme is only applicable to Library or Imported Objects and will not apply 
to Objects placed individually. 

  

Component Surfaces Tab 

Selecting the tab labeled Component Surfaces provides text labels to identify each surface of each component. In the example below left, the image 
shows the display of Component Surface Labels. The example below, displays Component Surface Reflectances. Depending on the object, these 
labels can be numerous and may overlap each other. Labels appearing upside down indicate the surfaces are facing away from you. Generally, all 
labels will be visible if you examine the object from multiple angles. If you plan on using the labels for presentation, you will want to move the 
obstructed labels with the Move Room Labels command. 
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Font and Text Size 

Text Labels can be applied in any Windows™ font present on your computer system. The default font is set in System Settings. Clicking on the 
Change button will open the  Fonts dialog used to select from your installed fonts. Select your choice of font , font  style and color. 

Text size is specified in scaled meters or feet in AGi32. This allows convenient scaling of your paper output, as well as legible text labels in the 
graphics area. Text placed on the drawing at a certain size will remain that size regardless of the output scale. For example, if you place a text label 
with size equal to five feet, that text will always be five feet tall, regardless if printed at 1" = 20' or 1" = 100'. 

  

  

Object Labeling 

The Object Labeling dialog is available from within any object dialog by clicking on the Labeling button. This dialog provides the ability to attach a 
label to objects, library components and component surfaces. Labels identify the object's characteristics, such as label name, project name, 
reflectance/transmission, etc.. Each label type, object, component and component surface, has its own tab and unique labeling options. 

Object labels are dynamic and will update themselves, upon redraw, if the object has been modified. 

What do you want to do? 

Label the object 

This labeling option is available for all objects and library objects. 

1. Click in the selection box adjacent to the labeling options you are interested in. 

2. If desired, change the current font and text size. 

3. Click Ok. 

The object may be labeled with the following options: 

Object Label - this option will extract the label name associated with this object and locates it below the first point of the object. 

Description - this option will extract the user-defined description associated with this object and locates it below the first point of the object. 

Project Name - this option will extract the project name associated with this object and locates it below the first point of the object. 

Label the components in a library object 

This labeling option is available for library objects with multiple components. The label will be attached to the first point of each component. 

1. Select the Component tab, so that it moves to the forefront of the dialog. 
2. Click in the selection box adjacent to the labeling options you are interested in. 

3. If desired, change the current font and text size. 

4. Click Ok. 
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The components may be labeled with the following options: 

Component Label - this option will extract the label name associated with this component and locate it below the first point of the component. 

Coordinates - this option extracts the X, Y and Z coordinate information of the first point of the component. 

Label the object surfaces 

This labeling option is available for all objects. Object surface labels are useful in identifying a particular surface. Labels may overlap and can be 

moved using the Modify-Object-Labels-Move command ( ). 

1. Select the Component Surface tab, so that it moves to the forefront of the dialog. 
2. Click in the selection box adjacent to the labeling options you are interested in. 

3. If desired, change the current font and text size. 

4. Click Ok. 

The object surfaces may be labeled with the following options: 

Surface Label - this option will extract the descriptive name associated with each surface of this object. 

Reflectance - this option will extract the reflectance associated with each surface in the object. 

   

Room Labeling - Concepts 

The Room Labeling features are accessed from the labeling button in any Add or Edit Room dialog. There are two types of Room labels. Those 
specific to the Room in general are found under the Room tab. Labels related to the individual surfaces can be found under the Room Surfaces tab. 

Room Tab 

In the example at right, a room with all of the Labeling options from the Room tab is selected. 
All labels with the exception of the coordinate values are located below the first point selected 
when creating the room. The coordinate values (X, Y, Z of room base) are placed adjacent to 
each vertex point. 

Generally speaking, you will seldom employ all text labels at one time. Some may prove 
useful for presentation purposes while others may only be necessary for temporary 
identification. 

Room Surfaces Tab 

Selecting the tab labeled Room Surfaces provides text labels to identify each surface (Walls, 
Ceiling and Floor) composing the room. Depending on the room type, these labels can be numerous and may overlap each other. Use of this 
labeling scheme is most often employed to identify specific surfaces for surface modification or calculation point placement. 

In the Plan View image below the room surface labels are clearly visible with the exception of a Ceiling label which is obstructed by a Wall label. 
Looking in Isometric view, we now see the Floor label is obstructed. 

This is common due to the infinite possibilities encountered in space creation. Generally, all labels will be visible if you examine the room from 
multiple angles. If you plan on using the labels for presentation, you will want to move the obstructed labels with the Move Room Labels command. 
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Wall and Ceiling Label Order 

The room in the example above was created beginning from the lower left most corner and progressing in a counterclockwise direction. You may 
choose any desired starting point and direction most comfortable to you. Keep in mind that maintaining a convention will make identifying surfaces 
easier for complicated spaces. Wall and Ceiling Labels are always applied to the right of each surface (Surface Normals are facing into room by 
default). 

 

Font and Text Size 

Text Labels can be applied in any Windows™ font present on your computer system. The default font is set in System Settings. Clicking on the 
Change button will open the Fonts dialog used to select from your installed fonts. Select your choice of font, font style, and color. 

Text size is specified in scaled meters or feet in AGi32. This allows convenient scaling of your paper output, as well as legible text labels in the 
graphics area. Text placed on the drawing at a certain size will remain that size relative to its surroundings regardless of the output scale. For 
example, if you place a text label with size equal to five feet, that text will always be five feet tall, regardless if printed at 1" = 20' or 1" = 100'. 

   

 

Room Labeling 

The Room Labeling dialog is available from within any room dialog by clicking on the Labeling button. This dialog provides the ability to attach a label 
to rooms and room surfaces that identifies the element's characteristics (such as label name, project name, reflectance, etc.) Each element (room, 
room surfaces) has its own tab and unique labeling options. 

Room labels are dynamic and will update themselves, upon redraw, if the room has been modified. 

What do you want to do? 

Label the room 

This labeling option is available for all rooms. 
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1. Click in the selection box adjacent to the labeling options you are interested in. 

2. If desired, change the current font and text size. 

3. Click Ok. 

The room may be labeled with the following options: 

Room Label - this option will extract the label name associated with this room and locate it below the first point of the room. 

Description - this option will extract the user-defined description associated with this room and locate it below the first point of the room. 

Project Name - this option will extract the project name associated with this room and locate it below the first point of the room. 

Coordinates - this option extracts the X, Y and Z coordinate information of each vertex in the room perimeter. Arcs will be broken into straight wall 
segments and each segment will be labeled. 

Wall Height - this option extracts the wall height specified in the room dialog and locates it below the first point of the room. 

Label the room surfaces 

This labeling option is available for all rooms. Room surface labels are useful for identifying a particular ceiling or wall surface. The labels may 

overlap and may need to be moved using the Modify-Room-Labels-Move command ( ) 

1. Select the Room Surface tab, so that it moves to the forefront of the dialog. 
2. Click in the selection box adjacent to the labeling options you are interested in. 

3. If desired, change the current font and text size. 

4. Click Ok. 

The room may be labeled with the following options: 

Surface Label - this option will extract the descriptive name associated with each surface of this room. 

Reflectance - this option will extract the reflectance associated with each surface in the room. 

   

Find Files 

The Find Files dialog searches your computer, or network, for particular file names or file types. When searching for file types (such as DXF or AGI 
files), search strings are used. The search string may contain all or part of the file name you are searching for. wildcard characters (*, ?) may be used 
to make the search more generic. For example, to search for all AGi32 job files, specify *.AGI as the search string. 

By default, the current file extension is used as the search criteria. 

Searching for a file: 

1. Specify the file name or search string to search for. 
2. Specify the drive to search. If a network drive does not appear, map it using the Network button. 
3. Specify the starting folder by double clicking on it and opening it. Subsequent folders located within the starting folder will be searched as well. 
4. Click on the Find Now button to begin the search. 
5. Once the search is complete, select the desired file from the Files Found section. You may organize the files by Name, Modified date or Path by 

clicking on any of the Column headers. 
6. Click OK. 

   

Print Setup 

The Print Setup dialog is a Windows™ common dialog that allows you to select from all available printers configured on your computer (both local 
and network). In addition, you may select from all available paper sizes and specify a preferred orientation. Internal help is available by clicking on 
the ? button at the top right hand corner of the dialog.  
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 View Functions 

Redrawing Views-Concepts 

After repeated modifications and additions to an AGi32 drawing, you may notice irregularities in the drawing information displayed. Operations such 
as rotating a drawing entity or moving a luminaire may leave ghosts behind in the old position occupied by the entities. Redrawing the display 
eliminates blips and ghosts and generally cleans up the display. Some operations will regenerate the graphic image automatically, however, in some 
circumstances it is desirable to force the graphic image to regenerate. The Redraw commands - Redraw All Views and Redraw Current View - will 
force the graphics area to regenerate. 

Redrawing also updates any smart text and statistical areas within the job file. 

  

Redrawing the Current View 

The Redraw Current View command will redraw and clean up the current view. If you are working with multiple views, the current view can be 
identified by its active Title bar (the top border of the current view is shown in color, others are gray). Other open views are not regenerated. 

 From the View menu choose Redraw Current View, or from the Common toolbar select .  

   

Redrawing All Views 

The Redraw All Views command is similar to the Redraw Current View command except it will regenerate all views open in AGi32. The regeneration 
time will reflect the time to redraw all views currently open. This may be significantly longer than redrawing only the current view. 

 From the View menu choose Redraw All Views. 

  

Previous View 

Use the View Previous command to return quickly to the prior view. AGi32 can restore up to 10 previous views in succession. These views include 
not only zoomed views (such as zoom window and zoom limits), but also panned, isometric and elevation views. 

 From the View menu choose Previous, or from the Common toolbar select .  

   

View Manager-Concepts 

On startup, AGi32 displays a single view window to be used as the working area. However, the program is capable of opening many different view 
windows on the screen at one time. This is an exceptionally powerful feature allowing you to work and watch your actions across multiple views 
simultaneously (plan, elevation or isometric). Once created separate view windows can be individually sized and arranged to work with your current 
visual requirements. 

View Manager provides your control point for creating and managing View windows. Within View Manager you can easily add or delete a View and 
tile or cascade the display. 

Working with multiple views 

Working with multiple view windows on the screen is simple and powerful. You can display the views exactly as you like and move between them 
with a single mouse click. It can also be helpful to have a certain view open to watch a function being carried out in another view window (e.g. facade 
lighting, seeing luminaires aimed from the side). 
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The View window display can either be Tiled or Cascaded . A tile effect will split the graphics area into as many View windows as are selected. When 
the Tile display is selected, AGi32 determines how the windows are displayed and their position on the screen. While it is possible to override and 
resize the Tiled windows manually, AGi32 will redisplay them using its default parameters each time the current mode is changed (e.g. switching 
between Model, Render, or Page Builder Modes) or when the Statistical Summary window is displayed. 

A Cascade effect displays all of the selected window the same size, then slightly overlaps them so that the upper portion of each window is visible. 
When cascaded Views are resized, they maintain their new size and location regardless of change in mode or calculation. Cascaded views are also 
best when you wish to display a critical area or section of your application a similarly sized window for printing or Page Builder views. 

View windows can be custom sized by clicking and dragging the borders of the View window. View windows can also be Maximized and Minimized 
using the standard controls in the upper right corner of each view window. 

Note: Be aware that having multiple View windows open will increase AGi32 regeneration times. 

Application Examples 

Roadway Lighting - Divide street sections and intersections into multiple views for more detailed views 

Facade / Theatrical Lighting - Locate in Plan, Aim in Elevation 

Indirect / Cove Lighting - Dynamically verify MH  using Elevation information, Locate in Plan 

Presentation - Assign calculation points with Project Manager to certain views to differentiate information 

   

View Manager 

View Manager allows the user to create and manage view windows. Within View Manager you can easily add or delete a view and tile or cascade the 
display. 

What do you want to do? 

Add a view 

1. From the View menu choose View Manager, or from the Common toolbar select . 
2. Add a unique view name in the View Name text box. 
3. Click the Add button. Views are always added in Plan view. 
4. Continue in this fashion until all of the desired views have been added. 
5. Highlight the views to be displayed on the desktop. By default, AGi32 will highlight all views. 
6. Click OK. 

Delete a view 

1. From the View menu choose View Manager, or from the Common toolbar select . 
2. Highlight the views to be deleted. 
3. Click the Delete button. 
4. Highlight the views to be displayed on the desktop. 
5. Click Ok. 

Change the way views are displayed 

View Manager allows the user to determine how the selected views will be displayed. 

A tile effect will split the graphics area to arrange the selected views so that they are all visible on the desktop at once. This option requires that each 
view be resized according to the total number of views displayed at one time. For example, if three views are tiled, each view will be resized to one-
third the original size. When the Tile option is selected, the views are automatically resized when the graphics window is resized or changed. Tiled 
views will be resized to accommodate the lesser width of the graphics window. 

A cascade effect will create all views the same size and overlap them slightly so that the upper portion of each view is showing. Only one view is 
clearly visible at any one time unless the views are resized. When the Cascade option is selected, the views are not resized automatically when the 
graphics window is resized or changed. Select this option when you want to manually resize the views from their default size. 

1. From the View menu choose View Manager, or from the Common toolbar select . 
2. Highlight the views to be displayed on the desktop. By default, AGi32 will highlight the last selections. 
3. Under View Display, select Tiled or Cascade. 

• Whenever the View Display type is change, AGi32 selects Resize Views by default.  
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• When Resize Views is unchecked, all current views will remain in their current location and size. This prevents AGi32 from resizing your 
views when new views are added. Resizing views may be undesirable when working with Viewports in Page Builder (e.g. when the 
Display option is selected). 

4. Click Ok. 

Note: This setting affects the views displayed in Model Mode and Render Mode concurrently. In other words, the same setting will be applied to both 
modes whenever multiple views are created. 

   

Statistics Window 

The Statistics Window contains information regarding statistical areas, calculation planes and LPD/UWLR areas for each project in the job file. By 
default, the Statistics Window is displayed and displays results soon as any calculations have been computed, or when corresponding metrics have 
been added to the analysis environment.  

The Statistics Window can be easily closed. To display it again, toggle the Statistics button  on the Status Bar. 

The Statistics Window is located along the right edge of the graphics area by default and any visible views will automatically resize themselves to 
accommodate its width (and the Model Toolkit as well, as both are docked right by default). You may resize the window’s width by locating the cursor 
on the left edge and dragging in the appropriate direction. The cursor will change to a horizontal double ended arrow when the window can be 
resized. 

The Statistics Window may also be docked on the left side, aligned left or right, and disconnected. Please see the Displaying Toolkits topic for more 
information. 

Calculation Progress 

While the calculations are proceeding, the Statistics Window also shows the Calculations progress bar and the Radiosity topping Criterion (% Light 
Absorbed) progress as the computations take place. During this time, you may Cancel, Stop or Pause the calculations if desired. 

Cancel - Cancel all calculation processes, no results will be displayed. 

Stop - Stop the calculation process at the current stage. If the radiosity process is stopped prematurely, calculation points will be computed from the 
current light levels. 

Pause - Pause the calculations to interact with the environment, then resume calculations. Note, the calculation process need not be paused to 
interact with the environment in Render mode (you can navigate and change the display properties while calculating), however pausing the 
calculations may be desirable to free up some CPU resources if needed at a given time. 

Calculations may be paused in Model mode or Render mode. 

Note: minimizing AGi32 while calculating will allocate the calculation processes lower priority amongst other processes if desired. 

Statistics Window and Project Manager 

Change the type of data displayed in the Statistics Window 

  

Interactive View Commands 

Interactive commands in Model and Page Builder Mode are always active and do not need to be selected in order to use them. These types of 
commands are referred to as 'transparent commands'.Transparent commands are included in the menu for reference only (indicated by brackets {}), 
clicking on the commands has no effect. 

Interactive commands use a set time interval to redraw the display while the command is active. For large environments, the view contents may be 
only partially drawn to minimize delays. Once the interactive command is complete (stop moving the mouse or mouse button), the environment will 
be completely redrawn. 

Interactive-Pan 

Press and hold the mouse wheel button and move the mouse in the direction you would like to pan (e.g. move mouse up to pan up).  

Interactive-Zoom 
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Scroll the mouse wheel button up to zoom in and scroll down to zoom out.  

Interactive-Isometric 

Press and hold the Shift key and press and hold mouse wheel button. Move the mouse left/right to rotate the view, move up/down to tilt the view. You 
can also interactively change the isometric view by pressing the Shift key in conjunction with the left/right arrows keys to rotate or with the up/down 
arrows keys to tilt. 

• This interactive command is only available Model Mode. 

• The 'virtual axis' will be displayed while interactively changing the isometric view indicating the point at which the view is being rotated and titled 
about (rotation point). 

• Trick - If you want to set a particular point to rotate about (rotation point), simply move the cursor to the desired point and zoom in/out using the 
mouse wheel button. This process centers the view about the cursor position which then becomes the current rotation point! 

 

 Pan 

Pan - Concepts 

AGi32 can displace the current view in any direction, called Panning, by specifying a point (X, Y, Z position) and moving it to a new location across 
the screen. Pan is convenient when moving between adjacent portions of the drawing, and is flexible in magnitude up to one complete screen width 
when selecting the displacement points with the mouse. In addition, the user may transparent pan to move to displace the current view while in 
another command. 

Panning doesn't change the physical location of your entities nor the magnification factor, only the view is changed. 

All Pan commands are transparent, which means the command can be initialized while another command is in progress, without breaking the current 
command. 

What do you want to do? 

Interactive panning 

Pan Point 

Pan Center 

Pan in a primary direction 

Pan Center 

The Pan-Center command will center the drawing about a user selected point. This command is available in Model and Page Builder modes. 

The Pan-Center command is transparent - it may be selected within another command without canceling the current command. 

 From the View menu choose Pan-Center  

Panning In A Primary Direction 

 From the View menu choose Pan, and the desired direction, Left, Right, Up or Down. Alternatively, you may use the corresponding keyboard keys, 
right and left arrows, and up and down arrows to move the view in the appropriate direction. 

The current view will pan in the chosen primary direction using the Pan Factor. The default Pan factor on the System Settings - Defaults Tab is 0.75 . 
Using this Pan factor, you will Pan over 3/4 of the view width/height. 

Pan with Scrollbars 

The current view may also be panned by using the Scrollbar sliders. Click and hold the Scroll bar sliders, then move them to shift the view contents in 
the same direction. 

Pan Point 

The Pan-Point command allows you to translate the drawing position in the graphics area to a different location using the mouse. The Pan-Point 
command is transparent - it may be selected within another command without canceling the current command. 
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1. From the View menu choose Pan-Point, or from the Common toolbar select . 
2. Select a point on the screen to be translated. 
3. Select a second point (the translation point) that the first point will move to. The distance and direction between the two specified points dictates 

the magnitude of the move. 

   

Zoom 

Zoom - Concepts 

Each view created in AGi32 has infinite zoom capability meaning the image contained within the view can be viewed at any size. The process of 
Zooming increases or decreases the size of the image displayed in the graphics area. In other words, you can bring a remote object into focus 
through sharper magnification (zooming In), or decrease the magnification in order to see more of the area surrounding the object (Zooming Out). 

Zooming does not change the location of the origin of coordinates. It simply increases or decreases the view within the graphics display window. 
AGi32 offers several Zoom options including specifying a window, zooming to a reference view, and zooming to display the entire job file. 

AGi32's Zoom functions are available from the View pull-down menu through several buttons on the Common Toolbar as well as on your computer’s 
keyboard. Zoom functions provided by AGi32 include Zoom Extents, Extents++, In, Out, Window and Limits. Zoom functions are available in any 
view. 

All Pan and Zoom commands are transparent. 

What do you want to do? 

Interactive Zoom 

Zoom Extents++ 

Zoom Center 

Zoom In 

Zoom Out 

Zoom Window 

Zoom Limits  

Zoom Center 

The Zoom-Center command will center the drawing about a user selected point and enlarge the size of entities by the current Zoom-In Factor. The 
default Zoom Factor on the System Settings - Defaults Tab is 1.25. This command is available in Model and Page Builder modes. 

The Zoom-Center command is transparent - it may be selected within another command without canceling the current command. 

 From the View menu choose Zoom-Center 

Zoom In 

The Zoom-In command will enlarge the size of entities in the current view by the current Zoom In factor about the center point. The default Zoom 
Factor on the System Settings - Defaults Tab is 1.25. Using this factor, entities will appear 25% larger than their previous size although the view will 
contain less area. You can use the Zoom-In command repeatedly to enlarge the view until you arrive at the desired focus. 

The Zoom-In command is transparent - it may be selected within another command without canceling the current command. 

 From the View menu choose Zoom-In 

 Keyboard: You may Zoom-In by  using the Home key on your keyboard. 

 Mouse: You may Zoom In by scrolling your mouse wheel up. Each wheel click (scroll increment) enlarges the size of the current view contents by 
the Zoom In factor.  
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Zoom Out 

The Zoom-Out command will reduce the size of entities in the current view by the current Zoom Out factor about the center point. The default Zoom 
Out Factor on the System Settings - Defaults Tab is 0.8 (the reciprocal of the default Zoom In factor). Using this value, entities will appear 80% 
smaller than their previous size and the view will contain more area. You can use the Zoom-Out command repeatedly to move away from the center 
point of the view until you arrive at the desired focus. 

The Zoom-Out command is transparent - it may be selected within another command without canceling the current command. 

 From the View menu choose Zoom-Out 

 Keyboard: You may Zoom-Out by using the End key on your keyboard. 

 Mouse: You may Zoom Out by scrolling your mouse wheel down. Each wheel click (scroll increment) reduces the size of the current view contents 
by the Zoom Out factor.  

Zoom Window 

Zoom-Window command is used to enlarge an area of interest on your computer screen. The area contained by the selection window will be sized to 
fit within the current view. The Zoom-Window command is transparent - it may be selected within another command without canceling the current 
command. 

 From the View menu choose Zoom-Window or from the Common toolbar select . 

 Specify the window by locating one corner of the window and clicking, enclose the window around the area of interest and click again. 

Zoom Extents++ 

A simple variation of the Zoom Extents command, the addition of the ++ implies an imaginary border around the drawing. The purpose of this border 
is to enable the selection of entities that may lie exactly on the edge of the drawing extents. The use of Extents++ will move the drawing 
approximately 0.25 inch (0.635 cm) away from the controlling edges of the current view. The border size is based on real dimensions, not drawing 
dimensions. Therefore, the border will always be ¼” wide. 

A drawing’s extents are defined by its coordinate extremities. Every line, piece of text, luminaire and all other entities have 3-dimensional coordinate 
values (X, Y, Z), the range of these values is used to compute the drawing extents. The smallest and largest coordinate values dictate the drawing 
extents in the X, Y and Z dimensions. When Zooming Extents++, the overall drawing is sized to fit within the confines of the current view selected on 
your computer’s screen with the ¼” border. This command is functional in Plan, Elevation and Isometric views. The drawing will automatically be 
centered within the View boundaries. 

The Zoom-Extents++ command is transparent - it may be selected within another command without canceling the current command. 

 From the View menu choose Zoom-Extents++, or from the Common toolbar select .   

Zoom Extents 

A drawing’s extents are defined by its coordinate extremities. Every line, piece of text, luminaire and all other entities have 3-dimensional coordinate 
values (X, Y, Z), the range of these values is used to compute the drawing extents. The smallest and largest coordinate values dictate the drawing 
extents in the X, Y and Z dimensions. When Zooming Extents, the overall drawing is sized to fit within the confines of the current view selected on 
your computer's screen. This command is functional in plan, elevation and isometric views. The drawing will automatically be centered within the 
View boundaries. 

The Zoom-Extents command is transparent - it may be selected within another command without canceling the current command. 

 From the View menu choose Zoom-Extents.  

Set Limits 

The View-Set Limits command allows the user to define a reference view that can be accessed using the Zoom-Limits command. This reference 
view can be changed as often as you like by simply redefining the Limits using the View-Set Limits command. 

1. From the View menu select Set Limits. 
2. Enter the Lower Left Corner coordinates (X, Y) in the appropriate cells. Repeat for the Upper Right Corner. 

Alternately, you may click on the Specify button to specify a Limits window graphically in Model Mode. Click two opposing corners of the 
window (from Lower Left to Upper Right) to specify the Limits. After the 2nd click, you will be returned the Set Limits dialog where the Limits 
will be displayed in the Lower Left and Upper Right Corner cells. 
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1. Click Ok. 

Zoom Limits 

The View-Zoom-Limits command changes the graphics display to cover the coordinate window defined by the View-Set Limits command. The lower 
left corner of the graphics display corresponds to the lower left corner of the Limits as specified in the View-Set Limits dialog. The larger of the X or Y 
coordinate values of the upper right corner Limits dictates the size of the graphics window. The upper right corner of the desired Limits will be 
situated as close as possible to the upper right corner of the graphics display. 

The Zoom-Limits command is transparent - it may be selected within another command without canceling the current command. 

Limits are generally used as simply a reference view, i.e., specify some area of the drawing that you can return to easily using the Zoom-Limits 
command. Limits can be modified as often as necessary in the course of your work. 

When the job file is first opened, AGi32 uses the default limits in System Settings. 

 From the View menu choose Zoom-Limits, or from the Common toolbar select . 

 

 3D Views 

Plan View-Concepts 

A Plan View is a birds eye view of the environment, looking from the Top down. Regardless of the room or object heights in your environment, AGi32 
will also display all entities visible in Plan View. While Plan View is often used to do much lighting application work, it cannot provide Z coordinate 
information. All entities appear to be at the same height, even when their Z coordinates and mounting heights differ. 

AGi32 also has the ability to rotate the normal Plan View to an angle of your choosing. This is particularly useful when you are working with a 
drawing that is aligned with some other axis. When a Plan View is rotated, you can place drawing entities, calculation entities, rooms, objects, etc. in 
alignment with the axis you desire. 

You may apply a Rotated Plan View at any time, as often as you would like, to continually change the axis of alignment.  

Plan View 

Plan view refers to a birds-eye view of the graphic display such that X coordinates increase from left to right and Y coordinate increase from bottom 
to top. Plan view does not refer to the area covered by the view. In other words, a Plan view may exist in any level of Zoom from square inches (or 
cm) to square miles (or km). 

AGi32 always opens the default view and any new views in Plan. Once you begin working, you will inevitably change a view to Elevation or Isometric. 
Use the View-Plan command to return a particular view to Plan. The contents of the View are automatically Zoomed to Extents++ after the view is 
changed. 

 From the View menu choose Plan, or from the Common toolbar select .  

  

Rotated Plan View 

The Rotated Plan View command rotates the plan view, and any associated entities, by a specified angle. This comes in handy when you need to 
create rectangles or cubes that are not parallel to the XY axis. It is also useful to rotate the view when you have imported an aligned CAD drawing. 
This allows you to place entities, such as luminaires, in a more convenient manner without having to calculate complex angles. The contents of the 
View are automatically Zoomed to Extents++ after the view is changed. 

1. From the View menu choose Plan-Rotated 
2. Locate the first point of the rotation line and click the left mouse button. If the rotation angle is known, you may enter it (from the keyboard) at 

this time instead of clicking the first point. 
3. Drag the cursor along the desired rotation angle and left click again. 

Isometric View-Concepts 

Isometric Views are used to visualize the three dimensional wireframes of all existing entities in the Normal environment. AGi32 provides six different 
Isometric View types for choosing: 4 Architectural Isometrics (NE, NW, SW, and SE), a Default Isometric View whose parameters can be manually 
specified in System Settings as well as an Isometric View-Specify  command that can change the current Isometric parameters. 
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While a classic Isometric drawing is presented with at standard angle set of 30,60, 90, AGi32 allows you to specify alternate Isometric angles with the 
Isometric View-Specify  

An Isometric View is drawn as a parallel view where the lines do not converge on each other. Lines are not hidden in Isometric Views in AGi32. 

  

Isometric View 

The Isometric View command allows you to create a three dimensional view with user defined viewing angles. Many drawing and luminaire relevant 
commands are active in Isometric view allowing you to add or modify luminaires or drawing entities as required. AGi32 provides several default 
viewing angles for your convenience as well as the ability to create a user defined isometric view. 

What do you want to do? 

Interactively set/change the isometric view 

Display the default isometric view 

Display a preset isometric view 

Define a viewing angle with the Isometric View dialog 

Related Topics 

Change the Default Isometric Viewing angles in System Settings 

Default Isometric View 

The View-Isometric-Default command changes the current view to an isometric view in accordance with the default values specified in System 
Settings. The contents of the View are automatically Zoomed to Extents++ after the view is changed. 

 From the View menu choose Isometric-Default, or from the Common toolbar select . 

Preset Isometric Views 

AGi32 has four preset isometric views available: North East, North West, South East and South West. Each of these four views has a predefined 
Rotation and Tilt angle that is automatically applied to the current view. The applied angles rotate the drawing to the selected viewing direction. A 
virtual axis is displayed in the lower left corner of the view. The contents of the View are automatically Zoomed to Extents++ after the view is 
changed. 

 From the View menu choose Isometric and the desired view: South West, South East, North East, and North West or from the Common toolbar 

select one of the following buttons . 
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Preset View Definitions: 

North East View: Displays a three-dimensional view with a 225 degree 
Rotation angle and a 45 degree Tilt. 

 

North West View: Displays a three-dimensional view with a 135 degree 
Rotation angle and a 45 degree Tilt. 

 

South East View: Displays a three-dimensional view with a 315 degree 
Rotation angle and a 45 degree Tilt. 

 

South West View: Displays a three-dimensional view with a 45 degree 
Rotation angle and a 45 degree Tilt. 

 

Specify Isometric View 

Use the View-Isometric-Specify command to change the current view to a user defined isometric view. When specifying the Rotation angle, the Up 
arrow rotates the view counterclockwise and the Down arrow rotates the view 
clockwise. When specifying the Tilt angle, the Up arrow tilts the drawing up and the 
Down arrow tilts the drawing down. 

1. From the View menu choose Isometric-Specify. 
2. Use the up and down arrow keys to select Tilt and Rotation angles. The 

isometric graphic will change accordingly. 
3. Click Ok to apply the isometric specifications to the current view.  

Elevation View-Concepts 

The Elevation View commands allow user to specify an orthographic view parallel to 
the Z plane, looking at your environments from one side. The specified orthographic 
view presents a two dimensional view representing the exact shapes and locations 
of entities in AGi32 seen from one side. No object depth is seen and all lines are 
displayed (no hidden line removal is available). 

AGi32 provides two ways to specify Elevations Views. Primary Elevation views 
(Looking North, South East or West) allow the user to specify the View location with 
just one click. The Elevation View-Specify command is used to specify any 
orthographic view, even non primary views, by selecting two point along the Viewing 
plane. 
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Primary Elevation Views Looking North and South extract the specified Y coordinate to create the orthographic view. The specified view will exist in 
the XZ plane. Primary Elevation Views Looking East and West extract the specified X coordinate to create the orthographic view. The specified view 
will exist in the YZ plane.  

Elevation Views are depth aware. Entities located in the Viewing plane or in front of the viewing plane (in the View direction) are visible; entities 
located behind the Viewing  plane are not. 

Once in an Elevation View, you may shift the Viewing plane forward or back by using the Page Up and Page Down keys keyboard keys. Each press 
of the Page Up or Page Down keys will result in one step forward or back. One step is equal to one Snap increment. For example, if you specified an 
Elevation View Looking North at Y=0, and the current Snap increment equals 1, then using the Page Up key will move the Viewing plane to Y=1. 

Cartesian Axis Alignment 

 

Elevation View - Specify 

The View-Elevation Specify command allows you to look at the drawing from one side (through the Z-plane). To change the view to Elevation you 
must locate the viewing plane in Plan view. First, locate the left corner then drag the cursor along the viewing plane from left to right and locate a 
second alignment point to the right of the first. The elevation viewing plane defines a two dimensional view that may be created to look in any 
direction. The contents of the View are automatically Zoomed to Extents++ after the view is changed. 

1. From the View menu choose Elevation-Specify, or from the Common Toolbar select . 
2. Locate the left hand corner of the elevation view and click. 
3. Drag the cursor along the viewing plane and click on a second (alignment) point. 
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Primary Viewing Direction Orient Angle (Alignment point) 

North 0 

South 180 

East 270 

West 90 

Related Topics 

Elevation View - Looking North 

Elevation View - Looking South 

Elevation View - Looking East 

Elevation View - Looking West 

Elevation View - Looking East 

The View-Elevation-Looking East command allows you to look at the drawing from the side (through the Z-plane) looking in the East direction. To 
change the view to Elevation you must locate the viewing plane in Plan view. The contents of the View are automatically Zoomed to Extents++ after 
the view is changed. 

Elevation views are one directional; you can only see entities located in front of you. To see all entities in front of you, choose a viewing location 
outside of the drawing extents (in this case West of the drawing). 

1. From the View menu choose Elevation – Looking East, or from the Common toolbar select . 
2. Click on a location in the drawing area to select the viewing point. 

 

Elevation View - Looking North 

The View-Elevation-Looking North command allows you to look at the drawing from the side (through the Z-plane) looking in the North direction. To 
change the view to Elevation you must locate the viewing plane in Plan view. The contents of the View are automatically Zoomed to Extents++ after 
the view is changed. 

Elevation views are one directional; you can only see entities located in front of you. To see all entities in front of you, choose a viewing location 
outside of the drawing extents (in this case South of the drawing). 

1. From the View menu choose Elevation – Looking North, or from the Common toolbar select . 
2. Click on a location in the drawing area to select the viewing point. 
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Elevation View - Looking South 

The View-Elevation-Looking South command allows you to look at the drawing from the side (through the Z-plane) looking in the South direction. To 
change the view to Elevation you must locate the viewing plane in Plan view. The contents of the View are automatically Zoomed to Extents++ after 
the view is changed. 

Elevation views are one directional; you can only see entities located in front of you. To see all entities in front of you, choose a viewing location 
outside of the drawing extents (in this case North of the drawing). 

1. From the View menu choose Elevation – Looking South, or from the Common toolbar select . 
2. Click on a location in the drawing area to select the viewing point. 

  

Elevation View - Looking West 

The View-Elevation-Looking West command allows you to look at the drawing from the side (through the Z-plane) looking in the West direction. To 
change the view to Elevation you must locate the viewing plane in Plan view. The contents of the View are automatically Zoomed to Extents++ after 
the view is changed. 

Elevation views are one directional; you can only see entities located in front of you. To see all entities in front of you, choose a viewing location 
outside of the drawing extents (in this case East of the drawing). 

1. From the View menu choose Elevation – Looking West, or from the Common toolbar select . 
2. Click on a location in the drawing area to select the viewing point. 
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Surface View-Concepts 

The Surface View command in AGi32 allows Room and Object surfaces to be selected and viewed singularly with only entities lying in the exact 
same coordinate location visible. This can be very handy when you are interested in performing operations either on that surface or in the immediate 
vicinity. Surface View is available from the View menu and from the Common toolbar. 

The Surface view command functions in a slightly different manner 
depending on the entity type selected 

Rooms - Surfaces selected are viewed from the perspective of an 
observer INSIDE the room. See the example at right. Looking at the Room 
in Plan view and selecting the wall seen as arrow (1), the surface view 
would appear as if you are inside the room. You can verify this by creating 
an example of your own and examining the X-coordinates. 

Objects - Surfaces are viewed from the perspective of an observer 
OUTSIDE the Object. In the example shown below, both surfaces (1) and 
(2) are seen from the outside of the Object. 

 

  

Leaving surface view - Surface view is like any other view, simply adjust the view 
using any of the View commands. It is typical to return to Plan view. 

Movement In and Out from a Surface - The current coordinate plane can be 
altered using the PageUp and PageDown keys from the keyboard. This can be 
valuable when placing objects slightly off a surface. For example: Set the Snap to 
the desired movement and back away using PageDown. 

  

  

 

Surface View 

The Surface View command in AGi32 allows Room or Object surfaces to be selected and viewed singularly with only entities lying in the exact same 
coordinate location visible. This can be very handy when you are interested in performing operations either on that surface or in the immediate 
vicinity. 

1. From the View menu choose Surface, or from the Common toolbar select . 
2. Click on the Room or Object surface to be viewed. 
3. The current view will change to the Elevation View in line with the surface you selected. Rooms will be displayed looking outwards, Objects 

looking inwards. 

 



AGi32 Help System  AGi32 Tools 

393 

 

 

 AGi32 Tools 

Measurement - Concepts 

AGi32 provides two dynamic measurement tools for your use: Measure Area and Measure Distance. 

Measure Area 

The Measure Area command provides the ability to measure the area enclosed by any polygon dynamically. The area and perimeter length 
calculation actually takes place while you are constructing the polygon and is constantly displayed in the coordinate window below AGi32's graphics 
area. 

The area of the polygon is calculated by continuously tracking the mouse movement once the second vertex of the polygon is entered. You may 
continue to enter vertices by clicking the left mouse button, until the perimeter of the polygon encompasses the area of interest. At this point, note the 
area of the polygon in the coordinates window. Click the right mouse button to terminate the command. 

Measure Distance 

The Measure Distance command is used to determine the distance between two points (along a line), or the angle of orientation formed by the 
current line and an imaginary line drawn from due East (0 degrees world coordinates). 

Once the first point has been specified, the distance measurement is dynamic. The length of the line and orientation angle are constantly displayed in 
the coordinate window below AGi32's graphics area. 

The distance of a line between two points at different Z elevations can also be measured by using the PageUp and PageDown  keys to adjust the Z 
coordinate of each point as the Measure Distance command is applied. 

   

Measuring Area 

The Measure Area command measures the area enclosed by any polygon. The area calculation takes place while the polygon is constructed and is 
displayed in the coordinate window at the bottom of the AGi32 graphics screen. 

1. From the Tools menu choose Measure-Area, or from the Common toolbar select . 
2. Locate the first vertex on the polygon with the left mouse button. 
3. Drag the cursor to another vertex on the polygon and click again. 
4. Continue in this fashion until the perimeter of the polygon is complete. At this time, note the polygon area in the coordinate window along the 

bottom of the screen. 
5. Right click (ENTER) to terminate the command. 

   

Measuring Distance 

The Measure Distance command is used to verify a distance between two points along a line or the angle of orientation of a line from computer East 
(world coordinate zero). The length and orientation angles are continuously updated as the cursor is moved along the screen. 

1. From the Tools menu choose Measure-Distance, or from the Common toolbar select . 
2. Locate the first endpoint on the line with the left mouse button. 
3. Drag the cursor along the distance of the line or in the direction of the orientation angle. The length and orientation angle of the line are 

displayed dynamically in the coordinate window across the bottom of the screen. 
4. Right click (ENTER) to terminate the command. 
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Quick Commands 

AGi32 employs a convenient system to assign keyboard shortcuts to most program commands. It is called Quick Commands and can be found in the 
Tools menu or by typing QC<enter>. Many users will appreciate the ability to automate favorite commands with keystrokes much like their preferred 
CAD software. 

Quick Commands can be initiated from Model, Render or Page Builder modes, however, they are not functional when a dialog box is open. 

Factory Delivered Quick Commands 

 

To use any of the factory delivered quick commands, you need only type the Quick Command from the keyboard followed by the enter key <enter>. 

TIP: Quick Commands are not case sensitive! 

Adding your own Quick Commands 

Most commands can be added to the Quick Command list. 

1. Click on the Add button at the bottom of the Quick Commands dialog. A new slot in the list will open for the command to be added. 
2. Click on the Drop down menu and select the command to be added. 
3. Enter the characters to be typed as the command in the adjacent cell. Quick commands cannot begin with a numeric value. 
4. If applicable, select from the Single,Window,All options. 

Example: The graphic below shows the Luminaire_Edit-All  command added to Quick Commands as "EL". 

 

Deleting a Quick Command 

Simply highlight the command in the dialog and press the Delete key on your keyboard. 

   

Keyboard Shortcuts-Concepts 

Keyboard Shortcuts provide an efficient way to access many AGi32 commands and functions without having to use your mouse or pull-down menus. 
Commonly, as one becomes more of a power user of CAD software, including AGi32, the use of the keyboard provides a fast method of interacting 
with the necessary commands. The keyboard shortcuts that AGi32 provides are a combination of common Windows shortcuts as well as CAD 
shortcuts. 

In particular, the Zoom, Pan, Snap, SnapTo and Ortho shortcuts are very useful for speedy design creation. 

   

Keyboard Shortcuts 

The Keyboard Shortcuts and command modifiers listed below provide access to many AGi32 commands and functions directly from the keyboard. 
You can also assign custom keyboard shortcuts, in addition to these factory defaults, with Quick Commands. 
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Function Keys  Model Render Page Builder 

F1 Context sensitive help Context sensitive help Context sensitive help 

F2   Viewpoints - Quick Add - 

F3 Toggles SnapTo On/Off * - - 

F4 Invokes ‘arc’ command during 
the following commands: 

• Calculations - Line 

• Calculations - Polygon 

• Calculations - Stat Area 

• Calculations - LPD/UWLR 
Area 

• Drawing Entity - Line 

• Object - Rect - VE 

• Object - Round - VR 

• Object - Polygon - Flat 

• Object - Polygon - VE 

• Room - Rect - Flat 

• Room - Round - VR 

• Room - Polygon - Flat 

- Invokes ‘arc’ command during 
the following commands: 

• Drawing Entity - Line 

F5 When specifying an ‘arc’, flips 
direction of arc 

Flips grid normal when 
specifying the following 
calculation types: 

• 2pt-Grid-Normal Meter 

• 3pt Grid–Normal Meter 

- When specifying an ‘arc’, flips 
direction of arc 

F6 - Applies Anti-Aliasing (if level > 
None) 

- 

F7 - Toggles Model Overlay On/Off - 

F8 Toggles Ortho On/Off * - Toggles Ortho On/Off * 

F9 Toggles Snap On/Off * - Toggles Snap On/Off * 

F10 - Toggles Textures On/Off - 

F11 - Toggles Wire Overlay On/Off - 

F12 Calculate Calculate Calculate 
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Key Pad Model Render Page Builder 

Left Arrow View - Pan - Left Interactive – Drag mouse left View - Pan - Left 

Right Arrow View - Pan - Right Interactive – Drag mouse right View - Pan - Right 

Up Arrow View - Pan - Up Interactive – Drag mouse up View - Pan - Up 

Down Arrow View - Pan - Down Interactive - Drag mouse down View - Pan - Down 

Shift+Left Arrow View-Isometric - Rotates view 
+5 degrees 

Slows interactive action - 

Shift+Right Arrow View-Isometric - Rotates view -
5 degrees 

Slows interactive action - 

Shift+Up Arrow View-Isometric - Tilts view -5 
degrees 

Slows interactive action - 

Shift+Down Arrow View-Isometric - Tilts view +5 
degrees 

Slows interactive action - 

Ctrl+Left Arrow - - Pan contents of active 
Viewport left (click in Viewport 
to activate) 

Ctrl+Right Arrow - - Pan contents of active 
Viewport right (click in Viewport 
to activate) 

Ctrl+Up Arrow - - Pan contents of active 
Viewport up (click in Viewport 
to activate) 

Ctrl+Down Arrow - - Pan contents of active 
Viewport down (click in 
Viewport to activate) 

Ctrl+Shift+Left Arrow - Speeds up interactive action - 

Ctrl+Shift+Right Arrow - Speeds up interactive action - 

Ctrl+Shift+Up Arrow Dynamically increases the size 
of a schedule when placing 

Speeds up interactive action - 

Ctrl+Shift+Down Arrow Dynamically decreases the 
size of a schedule when 
placing 

Speeds up interactive action - 

PgUp Increments Z-coordinate by 
current snap value 

- Increments Z-coordinate by 
current snap value 
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PgDn Decrements Z-coordinate by 
current snap value 

- Decrements Z-coordinate by 
current snap value 

Ctrl+PgUp     Display Next Page 

Ctrl+PgDn     Display Previous Page 

Home View - Zoom-In - View - Zoom-In 

End View - Zoom-Out - View - Zoom-Out 

Ctrl+Home - - Zoom in on contents of active 
Viewport (click in Viewport to 
activate) 

Ctrl+End - - Zoom out from contents of 
active Viewport (click in 
Viewport to activate) 

  

Control Keys Model Render Page Builder 

Ctrl+A Add - Luminaire - Location - - 

Ctrl+C Edit - Copy Edit - Copy - 

Ctrl+D - - Toggles Viewport Visibility 
On/Off 

Ctrl+F  Modify - Luminaire - 
Parametric Mirror Off 

- - 

Ctrl-N  Modify - Luminaire - 
Parametric Mirror On 

- - 

Ctrl+O   File - Open File - Open File - Open 

Ctrl+P  File-Print File-Print File - Print File - Print File - Print 

Ctrl+S File-Save File-Save File - Save File - Save File - Save 

Ctrl+V - - Edit - Paste Directly To 
Imageport 

Ctrl+W - View - Viewpoints - 

Ctrl+Z Edit - Undo - Edit - Undo 

Misc Model Render Page Builder 
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Esc  Edit - Cancel Edit - Cancel Edit - Cancel 

Enter numeric value on 
keyboard 

- Sets Eye Position and Focus 
Position to that height 

- 

  

Modifiers Model Render Page Builder 

Shift 
Press and hold 

Filters by current Z-coordinate 
value when selecting 
luminaire(s) 

- - 

Ctrl 
Press and hold 

Disables parametric mirror 
when Re-Aiming or Re-
Oriented a luminaire 

- - 

Shift+Ctrl 
Press and hold 

During Luminaire - Locate & 
Aim command, advances to 
next aiming point while 
maintaining the last luminaire 
location (skips extra click to 
specify luminaire location) 

- - 

* A note regarding Snap, SnapTo, Ortho and keyboard entry prioritization: A data entry hierarchy has been established to prevent Snap, SnapTo, 
Ortho and keyboard entry (typing values) conflicts. The hierarchy, from highest to lowest, is: Keyboard entry, Ortho, SnapTo, and Snap. For example: 
As the cursor is moved, Snap is applied to the coordinates. As the cursor gets close to another entity, SnapTo takes over (if it is enabled). If Ortho is 
enabled, the "snapped" or "snapped to" coordinates are controlled by Ortho, disallowing diagonal movement or selection. Entering coordinates via 
the keyboard overrides all three of the other settings, even if they are enabled. 

   

Translate Origin - Concepts 

It is not unusual to import CAD created drawings with the origin of coordinates in an undesirable location. AGi32 allows you to move the origin easily 
using the Tools-Translate Origin command. Furthermore, to insure the integrity of the drawing when exported to CAD, the origin can be moved back 
during the export process and all coordinate values automatically compensated. 

 

Moving the origin back to its original location - If exporting the project for use in CAD software for another party, it may be important to restore 
the original origin position in the drawing. This would enable the receiving party to seamlessly incorporate your drawing with the original CAD 
drawings. 
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1. Select the Export command from the File menu or the Common toolbar . 
2.  Provide a name for the exported file in the dialog. 
3. Select Reset Origin in the subsequent dialog. The coordinates of the original origin are shown. All coordinate values in the job file are 

automatically correlated to the original origin. 

  

Translate Origin 

The Translate Origin provides a method for creating a simple User Coordinate System (UCS) by moving the origin to another location (e.g. closer to 
a drawing with large coordinates, effectively making the coordinates smaller and easier to work with). 

To translate an origin - 

1. Select the Translate Origin command from the Tools menu.  
2. Select the location of the new origin using the mouse or type the X and Y coordinates from the keyboard. 
3. The origin will move to the new location as evidenced by the coordinate marker. 

   

Room Estimator - Concepts 

AGi32 provides a quick design tool for interior spaces using the IES Zonal Cavity method, called Room Estimator. Use Room Estimator to determine 
an approximate number of luminaires required to meet a specified average level of Illuminance on a workplane or floor or based on a maximum LPD 
(lighting power density) specification. Room Estimator will also reverse the process and calculate an estimated average Illuminance level  and LPD 
based on a set number of luminaires. 

Once the basic inputs have been entered (room size, reflectances, luminaire label), Room Estimator will show you the calculated results immediately 
as you interact with the dialog. This functionality allows you to change any of the variables used in your analysis while the results are continuously 
and automatically updated. You may create up to three different room layouts in Room Estimator at the same time and compare their results. 

Once the luminaire quantity has been determined, you may export your results to AGi32's Model Mode and let Room Estimator automate the process 
of room creation, grid creation, and luminaire placement. The Automatic Placement command will open, allowing you to set the point spacing. Once 
you have returned to Model Mode, you may calculate point-by-point Illuminance values in the room by simply clicking the Calculate button on the 
Switches toolbar. 

IES Zonal Cavity Method 

The IES Zonal Cavity Method (also known as the Lumen Method) is used to calculate average illuminance on a work plane in an interior space. 
AGi32 provides the Room Estimator tool as a quick means of calculating average illuminance in a rectangular room with a flat ceiling. 

The average illuminance on the work plane is defined as: 

E (average, maintained) = [(lumens per lamp) x (lamps per luminaire) x (number of luminaires) x CU x LLF] / [work plane area] 

If the desired maintained illuminance is known, the equation may be solved for the total number of luminaires: 

Number of Luminaires = [E (desired, average, maintained) x (workplane area)] / [(lamps per luminaire) x (lumens per lamp) x CU x LLF] 

This method has some limitations that may cause the average estimated illuminance value to vary from one obtained by averaging individual point by 
point calculations (in AGi32). The limitations are as follows: 

1. Luminaires must be spaced uniformly and at the same height to obtain a uniform average illuminance value. 
2. The coefficient of utilization (CU) calculation is based on a completely empty room. Adding objects in the space will completely change the 

average value from that derived in an empty room. 
3. The average Illuminance calculation is defined as the total number of lumens reaching the work plane divided by the area of the work plane. 

This is a simplified method of calculation and results will generally be higher than the average calculated from a set of discreet measurements 
as is the case in point by point calculations. Point by point calculations will always be more accurate than the average method resulting from the 
IES Zonal Cavity calculations and will generally be lower (by approximately 10% in most cases). 

4. Room reflectances are based on grayscale color values. 

Room Estimator Metrics 

All calculations are based on the published IESNA Zonal Cavity Method and associated algorithms.  Results are calculated from the content of 
manufacturer photometric files. 
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Light Loss Factor (LLF) - LLF is a multiplier used to simulate a reduction in lighting system effectiveness due to factors such as dirt accumulation 
(Luminaire Dirt Depreciation, Room Surface Dirt Depreciation), depreciation of lamp output over time (Lamp Lumen Depreciation), ballast 
performance (Ballast Factor), and others. These factors are multiplied together to achieve the total Light Loss Factor. Consult the IES Lighting 
Handbook for details about how to determine the LLF for different luminaires and lighting applications.  This metric is extracted from the selected 
luminaire's definition. 

Luminaire Orientation - The horizontal rotation angle (about the Z-axis) of the zero-degree photometric plane as measured counterclockwise from 
due east (X-axis, 0 degrees). All luminaires are placed using a zero degree orientation by default. Users may also enter an alternate Orient Angle of 
90, 180 and 270 degrees if desired, to better align luminaires within the geometric constraints of the room. 

Calculated Average Illuminance - This metric may vary from the desired Illuminance value. The variation is resultant from the calculated number of 
luminaires generated and generally depends on the specified room size and ceiling grid. 

Calculated Number of Luminaires - Room Estimator generates a uniform grid of luminaires using the room geometry, luminaire spacing criteria, 
and end spacing requirements. This number may vary from the luminaire quantity entered. For example, if you request a layout using 27 luminaires, 
Room Estimator may calculate a grid of 5x6 luminaires (30 total) depending on the room geometry and ceiling type. 

Luminaire Locations and Spacing - Luminaire layouts begin from the lower left corner of the room. End spacing refers to the distance from the first 
luminaire's insertion point to the wall. 

Luminaire Suspension Length - This metric is obtained by deducting the ceiling cavity height, if any, from the room's height. 

Lighting Power Density - This metric is calculated using the watt value specified in the selected luminaire's definition. 

LPD = [(Watts per Luminaire) x (Number of Luminaires)] / [Room Area] 

Room Cavity Ratio - The RCR describes the radiative exchange between the ceiling cavity and the floor cavity. The effective reflectances of the 
cavities are used as the reflectances of the rectangular space. If there are no cavities in the layout (surface mounted and recessed luminaires and a 
work plane on the floor), the RCR describes the radiative exchange between the base and top of the room. This number is used when finding the 
Coefficient of Utilization. 

Coefficient of Utilization - The CU describes the fraction of lamp lumens that reach the work plane directly from the luminaire and via 
interreflections.  It takes into account 'room efficiency', luminaire efficiency, and luminaire photometry. This value is valid for empty rooms exhibiting 
perfectly diffuse reflectance. 

Effective Cavity Reflectances - Single reflectance vales that give the combined reflectance effect of the ceiling cavity and floor cavity. The ceiling 
cavity is bounded by the room walls, the ceiling, and the luminaire plane (suspension length). The floor cavity is bounded by the room walls, the floor, 
and the work plane. Effective cavity reflectances are applied at the opening of their respective cavity and are used to determine the Coefficient of 
Utilization.  

Estimated Average Illuminance (E) [fc, lux] - Total lumens reaching the work plane divided by the area of the work plane. This value is valid for 
empty rooms exhibiting perfectly diffuse reflectance. This value might vary considerably from that obtained by averaging discrete values of 
Illuminance at several points.  

Lighting Power Density (LPD) [W/ft2, W/m2] - Total wattage of all luminaires within the room divided by the area of the room.  

Room Cavity Ratio (RCR) - Ratio indicating room cavity proportions based on the perimeter and height of the room cavity. The room cavity is 
bounded by the walls of the room, the work plane, and the luminaire plane (suspension length). RCR is used to determine the Coefficient of 
Utilization.  

Spacing Criteria - An interior classification calculated for luminaires with > 60% downlight, describing the maximum limit of luminaire spacing. The 
criterion is defined as the ratio of luminaire spacing to mounting height. Two criteria values are displayed; one for the 0-180 luminaire axis and one 
for the 90-luminaire 270 axis. With a Luminaire Orientation angle of zero degrees, these axes correlate to the Columns and Row layout in the room. 
However, if the luminaire Orientation angle is specified as 90 or 270 degrees, the Spacing Criteria ration will switch as well. When the calculated 
spacing to mounting height ratio exceeds the recommended criteria, Spacing Criteria is displayed in Red; indicating possible inadequate overlapping 
of light from adjacent luminaires. 

Maximum Recommended Spacing  =  SC * (MH  -  WP), where 

SC  =  spacing criteria  

MH  =  height of the luminaires above the floor  

WP  =  height of the work plane above the floor.  

3D Interactive Display 

Navigation Modes 

Orbit  - The focus and the focal distance remain fixed while the eye moves (changes the view direction about the focus).  

Walk - You may move forward, back, and turn left and right. The focal distance remains fixed while the eye moves. 
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Zoom - The focus remains fixed while the eye moves (focal distance changes along the view direction). 

Default Views  

The following default views have been implemented.  All default views zoom extents with the focus at halfway between the minimum and maximum 
extents. 

� Top - Plan  
� Front - Viewing from the Front looking North. 
� Left - Viewing from the Left looking East. 
� Southwest 

Mouse & Keyboard  

The mouse is used to navigate (using the current navigation mode) by left-clicking and dragging (while pressing the left mouse button) the mouse up, 
down, left, and/or right. The navigation speed is increased by dragging the mouse cursor farther from the click-point and decreased by dragging the 
mouse cursor closer to the click-point. When the left mouse button is released, navigation stops. The mouse wheel and keyboard keys may also be 
used to navigate in the 3D display. 

Mouse: You may Zoom In and Out by scrolling your mouse wheel up and down.  

The following keystrokes affect navigation control: 

� Arrow Up - Navigates up  
� Arrow Down - Navigates down  
� Arrow Left - Navigates left  
� Arrow Right - Navigates right  
� Home - temporarily overrides the current navigation mode and zooms in (navigates up in zoom mode).  
� End - temporarily overrides the current navigation mode and zooms out (navigates down in zoom mode).  
� PageUp - increases mouse and keyboard sensitivity.  
� PageDown - decreases mouse and keyboard sensitivity. 

   

Using Room Estimator 

1. Room Estimator uses luminaires defined in AGi32. Before Room Estimator can be accessed, you must define at least one luminaire with the 
Add-Luminaires-Definition command. Room Estimator only uses single luminaires (no arrangements or groups) with zero arm length. 
Luminaires that do not meet this requirement are not loaded into Room Estimator. You will be prompted to define a luminaire if one has not 
been previously defined. 

2. From the Control bar select the Design Tools button . Room Estimator is the default design tool, if it is not current select it 
from the Design Tools secondary menu. 

3. By default, Layout 1 is presented first. If desired, type in a description of up to 32 characters for this layout. 

� To define additional luminaires at this time, click the Luminaires button at the top of the dialog. 
� You may copy all of the input metrics from this layout into another by putting a dot in the radio button for Layout 2 or 3. This feature is 

very useful when you want to compare luminaire types in an identical room layout or make subtle changes, such as reflectance or 
ceiling height, to the room layout. The Comparison tab allows you to see the results of each layout next to each other. 

4. Select the luminaire label from the Luminaire Label list box. If a description is associated with the selected luminaire label it will be shown in the 
Description text box. Lumens per Lamp, Number of Lamps, Light Loss Factor (LLF) and Luminaire Watts are shown for reference. 

� Luminaire Symbols - The Render symbol shape and dimensions associated with the selected luminaire label is used in Room 
Estimator. 

� Lumens per Lamp, Light Loss Factor (LLF) and Luminaire Watts may not be modified in this dialog; they must be changed in the 
Luminaire Define dialog and the definition redefined. 

5. By default, the luminaires are oriented 0 degrees. If desired, users can opt to orient luminaires 90, 180 and 270 degrees instead. 
6. Room Estimator's interactive 3D display may be rotated and zoomed to provide additional information. 

� Room Geometry editing: When editing the room length, width or height, red arrows appear in the display denoting the room length, 
width and height.  

� Room Geometry editing: When editing the work plane height or suspension length, the work plane or luminaire plane is highlighted in 
the display. 

� By default, left-clicking and dragging in the 3D interactive display will initiate an Orbit command where the user rotates around the room 
center. To Zoom instead, click the Zoom icon in the interactive display. Once Zoom is initiated, you may return to Orbit mode by clicking 
the Orbit icon. 

� You may also use the mouse wheel or arrow keys to move around. 
� Home Key - temporarily overrides the current navigation mode and zooms in (navigates up in zoom mode). End Key - temporarily 

overrides the current navigation mode and zooms out (navigates down in zoom mode).  
7. The Room Geometry tab provides input cells to enter room dimensions, luminaire suspension length and work plane height. A scaled isometric 

view of the room is shown in the graphic display window. The dimension units (ft. or m) are based on the current units in the System Settings 
dialog. Click on the Units button to change the current units. 
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� If the luminaire is suspended from the ceiling, enter the suspension length in feet or meters as the Suspension Length. For recessed 
luminaires, enter a Suspension Length of zero. 

� To locate the work plane above the floor, enter a positive Workplane Height. To calculate Illuminance on the floor, use a Workplane 
Height of zero. 

� The Room Cavity Ratio is shown for reference value underneath the input cells.  

8. The Reflectances tab provides input cells to enter the reflectances (as a decimal percentage between 0 and 1) for the ceiling, walls and floor. 
� All reflectances assume a grayscale color association. 
� The CU (Coefficient of Utilization) value is displayed here for reference. 
� The Effective Floor and Ceiling Cavity Reflectances are displayed here for reference. 

9. The Specify section allows you to select which numeric method to use. Each numeric method is based on a default assumption of an 
appropriate Criterion limitation, Maximum, Target or, Minimum. 

� Illuminance: To calculate the number of luminaires required based on a desired average Illuminance value, enter the Illuminance value 
in the Desired Avg. Illuminance text box. You will be shown the results instantaneously in the Specify section and the graphic display 
window will be updated to display the calculated luminaire layout. By default, the desired average Illuminance is assumed to be a 
minimum value (AGi32 will calculate the results such that the Illuminance provided meets or exceeds the desired Illuminance value). 

� Number of Luminaires: To calculate the average Illuminance based on a known number of luminaires, enter the luminaire quantity in 
the Number of Luminaires text box. You will be shown the results instantaneously in the Specify section and the graphic display window 
will be updated to include luminaire locations. By default, the desired number of luminaires is assumed to be a target value (AGi32 will 
calculate the results such that the number of luminaires provided is as close as possible to the specified number of luminaires, while 
maintaining the uniform spacing requirements inherent to the IES Zonal Cavity method) 

� LPD: To calculate the average Illuminance based on a maximum LPD value, enter the LPD value in the Desired LPD  text box. You will 
be shown the results instantaneously in the Specify section and the graphic display window will be updated to include luminaire 
locations. By default, the desired LPD level is assumed to be a maximum value (AGi32 will calculate the results such that the calculated 
LPD is equal to or less than the desired LPD value). 

� Calculate based on set spacing or quantity: In the Luminaire Layout section, check the selection boxes corresponding to the desired 
layout constraint, then enter the required values. AGi32 will update the Calculated Illuminance, LPD and luminaire quantities as 
calculated. 

� The Illuminance (Fc or Lux) and LPD distance units are based on the current units in the System Setup dialog. To change the current 
units, click the Units button. 

10. The Luminaire Layout section displays the calculated luminaire results and allows you to constrain the layout to suit your needs. Clearly, 
constraining the layout to new values may in turn result in new Illuminance, LPD and luminaire quantity values. 

� Quantity- The layout row displays the number of rows and columns in the calculated luminaire grid. To constrain by rows (number of 
luminaires occurring along the Y axis) or by columns (number of luminaires occurring along the X axis) check the selection box on the 
outside of the corresponding option. 

For example: A 50 FC Desired Illuminance request using the Z Lux ZLF1 luminaire results in a layout requiring 28 luminaires 
producing 52.5 Calculated FC (4 Rows and 7 Columns). To create an alternate layout using 5 Rows and 6 Columns (30 luminaires 
producing 56 Calculated FC), check the selection box to the left of the Columns cell and change the Column value to 6. 

 

Original Layout 

 

New Layout Constrained by 6 Columns instead 

� Spacing - The Spacing row displays the spacing between rows and columns in the calculated luminaire grid. To constrain by rows 
(spacing between luminaires along the Y axis) or by columns (spacing between luminaires occurring along the X axis) check the 
selection box on the outside of the corresponding option. 

Same example: A 50 FC Desired Illuminance request using the Z Lux ZLF1 luminaire results in a layout requiring 28 luminaires 
producing 52.5 Calculated FC (5 Ft. between Rows and 5.714 FT. between columns).To create an alternate layout using 8 Ft 
between Rows instead, check the selection box to the left of the Rows cell and change the Row value to 8. 
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Original Layout 

 

New Layout Constrained by 8 Ft in between Rows 

� Wall Spacing - The Wall Spacing row displays the spacing between the wall and the luminaire center for the 1st row and columns. To 
constrain by rows (spacing between the wall and the 1st luminaire along the Y axis) or by columns (spacing between the wall and the 
1st luminaire along the X axis) check the selection box on the outside of the corresponding option. It is usually preferred to constrain 
Wall Spacing by applying and centering a ceiling grid or by applying continuous rows or columns instead. 

� Spacing Criterion - The Spacing Criterion row displays the maximum spacing criterion for both rows and columns. If the maximum 
Spacing Criterion is exceeded (either because the Spacing constraint entered by the user is too large or because the Calculated 
Illuminance value is too small) the value will appear in red as a visual warning. 

11. To constrain luminaire spacing to fit within a ceiling grid, apply the ceiling grid by selecting the Apply selection box. Indicate the appropriate 
spacing between Rows and Columns. To center the luminaires within the room, click in the Center selection box so that a checkmark appears. 

� Luminaires are centered within the room and the ceiling grid follows the luminaires centering requirements. 
� The lower left corner of the first tile in the ceiling grid is located in the lower left hand corner of the room. Depending on the room size, 

the tiles located along the top and right side of the room may be  truncated. Centering the grid in the room will result in the tiles along 
each side of the room being equal. 

� Luminaire spacings will be calculated in multiples of the specified grid spacings. 
� Luminaire Orientation modification may be required to "fit" the selected luminaire within the ceiling grid. For example, specify a 4 x 2 

ceiling grid vs. a 2 x 4 ceiling grid will require luminaires to be oriented 90 degrees. 

2x2 Grid (2 Ft between Rows, 2 Ft between Columns)Luminaire 
Orient = 0 

 

2x2 Grid (2 Ft between Rows, 2 Ft between Columns)Luminaire 
Orient = 90 

 

 
2x4 Grid (2 Ft between Rows, 4 Ft between Columns), Luminaire 

Orient = 0 
4 x 2 Grid (4 Ft between Rows, 2 Ft between Columns), Luminaire 

Orient = 90 

  

12. To constrain luminaire spacing within continuous rows and/or columns, click in the Rows and /or Columns selection box. You may need to apply 
an Orient angle as well if you desire to align the luminaires end-to-end. If a ceiling grid is applied, continuous rows and columns will ensure 
luminaires lie in consecutive ceiling tiles, though they may not be end-to-end.  
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Constrained by Continuous Rows, Orient Angle = 0 Degrees 

 

Constrained by Continuous Columns, Orient Angle = 90 Degrees 

13. You may print any of the layouts and the layout comparison by clicking on the Print button. Only valid layouts with the Estimated Average 
Illuminance > 0 will be available to print. 

14. You may export any of your layouts to AGi32's Model Mode, including the room size and reflectances, calculation grid, and luminaire locations, 
by clicking on the Export button. The current layout is exported. 

  

Room Estimator - Print Layouts 

This dialog allows you to select which layouts and/or layout comparison to print. Blank (unused) layouts will not appear in the dialog. Similarly, the 
Layout Comparison is only printed by default if two or more layouts have been created.  

A custom banner may be appended to the top of each output page, if desired. To modify the current banner image, click on the Banner button or 
double click on the banner image.  

1. Select the layouts to print by clicking in the selection box adjacent to the layout name. A checkmark will appear in the box when it is enabled. 
Clear the selection box in order not to print the selected layout.  

2. To include the displayed banner as part of the input, click in the Include Banner selection box so that a check mark is shown.  
3. Specify a printer by clicking on the Print Setup button.  
4. Click Ok to print the selected items and return to Room Estimator.  

Two views (Top and Southwest) of the room are printed in the right section of each layout page. If a graphic image is associated with the luminaire 
definition, it will be printed as well.  

   

Exporting the Room Estimator Layout 

Layouts created with Room Estimator can be exported to AGi32's Model mode. The room and luminaires will be inserted into the current project at 
the specified cursor location. The Automatic Placement (AP) dialog will automatically appear, allowing you to locate discreet point by point values on 
the workplane or any other surface. Once the Automatic Placement points are positioned, calculate the point by point Illuminance values by clicking 
on the Calculate button on the Control Bar. 

1. Bring the layout you wish to export to the forefront of the Room Estimator dialog. 
2. Click on the Export button. 
3. The specified room and luminaire layout will be imported into AGi32's Model Mode and the lower left corner of the room will be attached to the 

cursor. 
4. Drag the cursor to the desired location and click the left mouse button. 
5. The Calculation Points – Automatic Placement dialog will appear for your use allowing you to specify calculation grids on the workplane and 

room surfaces. By default, the AP workplane height will echo the specified workplane height in Room Estimator. 
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Roadway Optimizer - Concepts 

The Roadway Optimizer tool provides you with a means of designing typical straight roadway sections using illuminance and/or luminance criteria. 
You may optimize the pole locations based on known illuminance and/or luminance criteria, or calculate the metrics for given pole spacings. The 
luminance criteria may be calculated in accordance with IES, CIE, BSEN, Australia, or New Zealand methods. Up to five layouts may be created and 
compared at any one time. 

The Roadway Optimizer tool and Roadway Luminance command provide assistance in computing calculations for straight segments of roadways 
using IES, CIE, BSEN, CIE-Australia, or CIE-New Zealand methods. You may select from several R-Tables, which provide information to the 
software on the nature of the light reflected from various pavement types. You may specify the width of the road, the number of lanes, the existence 
of a median and its width, whether the luminaires are in mounted in an opposite or staggered configuration, and whether they are at the edge of the 
road, have a setback or are median mounted. 

A description of the design criteria and some recommended values are provided in the Calculation Metrics topic. A diagram of the IES RP-8-00 grid 
layout is given here. 

IESNA RP-8-00 Layout 

 

Roadway Optimizer Results 

When the calculations are complete, you will be presented with the statistics for the standard that you selected. For example, if IES RP-8 is selected, 
the statistics will include illuminance, luminance and STV calculated results. Luminance on the pavement is based on the quantity and direction of 
light, observer location, and the pavement reflectance characteristics. Illuminance simply informs us of the amount of light incident on the pavement 
without regard to the pavement's surface type or angle of observation. 

Once the calculations are completed and the requested criteria met, you may print out the results. You may also Export the layout into AGi32’s Model 
Mode to incorporate it into your design. 

   

Using Roadway Optimizer 

The Roadway Optimizer tool uses luminaires defined in AGi32. Before it can be accessed, you must define at least one luminaire with the Define 
command in the Luminaire Toolkit. Roadway Optimizer only uses single luminaires or luminaire arrangements; groups are not allowed. Luminaires 
that do not meet this requirement are not loaded. You will be prompted to define a luminaire if one has not been previously defined.  

1. From the Control bar, select the Design Tools button . Roadway Optimizer is not the default design tool unless it was the last 
one accessed. If it is not current, select it from the Design Tools secondary menu. 

2. By default, the Layout #1 radio button will be selected. If desired, type in a Description of up to 48 characters for this layout. 
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3. Select the Roadway Standard that you wish Roadway Optimizer to use. This will determine the calculation grid spacing, location of the 
observer, and other details. There are five standards provided with AGi32 for you to choose from. 

4. Select the R-Table from the pull-down menu that best describes the roadway pavement. There are 18 R-Tables to choose from. The Q0 value 
that best summarizes the selected R-Table is displayed. If there is a specific Q0 value that you wish to use instead, you may enter it in the Q0 
field. This will apply one value to all reflected light, rather than taking values from the R-Tables depending on the geometry of the 
circumstances. 

5. Roadway Layout section: 

• Select the type of layout from the drop-down menu. A scaled plan view of one cycle of the roadway will be shown in the window. 

• Specify the Roadway Width. In RP-8 layouts, this is the width on the driver's side only. For other standards, if there is a median, this is the 
width on the driver's side only; if there is no median, it is the entire width of the road, for both directions of traffic flow. The dimension units 
(feet or meters) will be based on the current units in the AGi32 System Settings dialog. 

• If there is a median, you may specify its width (feet or meters). 

• Specify the number of lanes in the direction of travel. If there is no median and RP-8 is not selected as the standard, you may also specify 
the number of lanes in the opposite direction.  

• You may select which side of the road the driver is on, but it is set by default to left or right depending on the standard that you selected. 
• You may select whether the calculation area will be the top or bottom of the road as displayed in the graphic. 

6. Luminaire Layout section:  

• Select the luminaire label from the Luminaire Label list box. 
• Set the MH, Setback, +-Orient, Tilt, and Spin, for each row of luminaires as applicable. 

� You will be able to set the mounting, setback and other details for each row of luminaires. depending on the Layout Type selected. 
For example, if you have selected the Roadway Layout type One Row, Near Side; 1RNS, you will have only Row 1 to enter values 
for. If you selected Two Rows, Opposite; 2R_OPP, you will have Row 1 and Row 2 to set input values for. The MH, setback, etc. can 
be different for each row. the row names are color coded to the display graphic. 

� The Setback distance indicates the distance from the base of the pole to the edge of the roadway. A positive setback will pull the 
luminaire center away from the roadway curb. To have the luminaire hang over the roadway, redefine the luminaire with a positive 
arm length in the Define Luminaire dialog. The Arm Length is displayed in the layout diagram. 

� The +-Orient field allows you to enter an Orient angle that is relative to the initial Orient angle. In other words, since the luminaire on 
the curb and median are initially oriented at either 90 (north) or 270 degrees (south), you may add a value here that will change that. 
For example, for a luminaire with an initial Orient angle of 90 (north), entering a value of 90 in the +-Orient field will give the 
luminaire a final orient of 180 degrees (west). Entering -90 would give the luminaire a final orient of 0 degrees (east). 

� Tilt and Spin work the same way here as in Model Mode. See Aiming Parameters - Procedures for more information on Orient, Tilt 
and Spin.   

7. You may view the luminaires' photometric webs by clicking on the Photometric Web button on Roadway Optimizer's top menu bar. 

8. What are your Optimization Criteria? In this section, you can calculate the spacing needed to achieve specific design criteria, or you may 
specify the spacing and calculate to see the resulting metrics. 

• Calculate the pole spacing between luminaires based on known criteria: Click on the radio button adjacent to Calculate Spacing to 
Achieve. Then click in the selection box adjacent to each desired metric so that a checkmark appears, and enter the value in the adjacent 
field. You may specify multiple parameters by enabling the appropriate metrics. Please note: When selecting multiple criteria, some of the 
results may exceed the acceptable accuracy. Roadway Optimizer optimizes the pole spacing by evaluating the selected metrics in the 
order that they are listed ,from top to bottom, but it does not optimize for metrics that are not selected with a checkmark. 

Optimizing based on Max Veiling Luminance Ratio (Max Lv Ratio): When selected, this ratio generally dictates the results - when 
this metric is achieved, all related metrics are generally met or exceeded. Calculated spacing based on the Max Veiling 
Luminance Ratio will not be increased to meet any other selected criteria -- only decreased. See Roadway Optimizer - Settings 
for more information on precision settings. 

Example 1: Desired Minimum Illuminance value = 0.5 and Desired Average Illuminance Value 
= 2. The program will attempt to achieve the minimum value first. If the average value is met 
or exceeded, calculations stop. When the average value is above the acceptable accuracy, 
the program is unable to increase the spacing to lower the average without sacrificing 
achievement of the minimum value. 

Example 2: Desired Max Lv Ratio = 0.3 and Desired Average Luminance Value = 0.8. 
Calculated spacing to achieve the Max Lv Ratio is 150 feet. The calculated Average 
Luminance value using 150 ft pole spacing is 1.0 cd/m

2
 (which exceeds the precision range). 

Spacing will not be increased to meet the Average Luminance precision level range, as this 
would adversely affect the Max Lv Ratio 
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• Calculate illuminance, luminance and other criteria, depending on the selected roadway standard, for a known 
pole spacing: Click on the radio button adjacent to Calculate Based on Set Spacing and enter the spacing 
value for each Row of luminaires (in the Luminaire Layout section, after the Spin field). The spacing need not 
be the same for each row. 

 NOTE: The illuminance units (fc or lux) are based on the current units in the System Setup dialog. To change the current units, click the 
Units button at the top of the dialog. 

9. Click on the Calculate button on the top menu bar. 

10. You will be shown the calculated results in the Results section and the roadway layout graphic will be updated to display the calculated 
luminaire layout. Any time that the input metrics are adjusted, the results will be cleared and you will need to recalculate. 

• If you selected Calculate Spacing to Achieve, you will see achieved criteria in black bold. Any criteria that were not achieved will be in 
red bold. Note: For Average and Minimum criteria, achieving the criterion value or higher is acceptable and the value achieved will be 
black bold. For Max/Min, Avg/Min, and Max Lv Ratio, achieving the criterion value or lower is acceptable. For Min/Max and Min/Avg 
criteria, achieving the criterion value or higher is acceptable. 

• Clicking once on a metric in the Results field will display the point-by-point grid for that metric in the graphics area.  

• You may choose to display the calculated results in the graphics area in a color other than black.  Do this in the Settings dialog (top menu 
bar). 

• The calculation grid is placed within differing luminaire cycles, depending on the selected criteria. For IES criteria, the calculation grid is 
generally located at the 2nd luminaire cycle of 5 luminaire cycles. Roadway Optimizer can handle very short luminaire cycle spacing. A 
problem with the minimum number of cycles recommended by IES-RP-8-2000 can result in the observer for Veiling Luminance being 
located outside of the luminaire cycles. AGi32 now adds 2 additional luminaire cycles to the left of the calculation area (behind the 
observer) when necessary. In these cases,  the calculation grid is located at the 4th luminaire cycle of 7 luminaire cycles.  For CIE criteria, 
the calculation grid is located at the 4th luminaire cycle of 7 luminaire cycles. 

11. You may define additional luminaires from within Roadway Optimizer by clicking the Luminaires button at the top of the dialog. 

12. You may copy all of the input metrics from this layout into another by clicking on the Copy Layout button. Use this feature when you want to 
compare luminaire types on the same roadway section or to make subtle changes (such as median width or setback) to the roadway layout. 
Alternatively, you may simply put a dot in a different radio button, and the current information will be copied into the selected layout. 

13. The Comparison tab allows you to see the results of each layout next to each other. Note: to be shown on the Comparison tab, a layout must be 
calculated. If layouts have different standards (IES, BSEN, etc.), or if they have a different number of lanes, they will not be displayed on the 
Comparison tab. 

14. You may print any of the layouts and/or the layout comparison by clicking on the Print button. Only valid layouts with Calculated Spacing > 0 will 
be available to print. By default, all calculated metrics will be printed. You may select or deselect metrics in the Settings dialog (top menu bar in 
Roadway Optimizer). 

15. You may export the displayed layout into AGi32’s Model Mode by clicking on the Export button. Only valid layouts with Calculated Spacing > 0 
will be available to export. In Model Mode, your first click will locate the lower-left corner of the grid. Your second click will allow you to rotate 
the grid into a different angle/position. 

Note: The results are calculated in accordance with precision settings specified in the Roadway Optimizer Settings 
properties. To modify these settings, click on the Settings button on the Roadway Optimizer's menu bar.  

  

Pavement Surfaces (R-Tables) 

The roadway's reflective characteristics are defined by its physical surface properties. Sufficient data has been collected on the reflectance 
characteristics of different pavement types to allow them to be described by reflectance tables or R-Tables. 

The R-Table types described below are from several global roadway standards. 

R-Table Weighted Average 
Luminance Coefficient (Q0) 

Description 

C1  0.10 Concrete, CIE C1 

C2  0.07 Asphalt, CIE C2 

N1  0.10 CIE CLASS = 1 - very diffuse 

N2  0.07 CIE CLASS = 2 - concrete 

N3  0.07 CIE CLASS = 3 - asphalt 

N4  0.08 CIE CLASS = 4 - glossy asphalt 

NZN4 0.09 Diffuse chip seal surface 

NZR2 0.09 Glossy polished asphaltic surface 

R1 0.10 Mostly diffuse reflectance properties characteristic of Portland cement or asphalt 



AGi32 Help System  AGi32 Tools 

408 

 

surface with a minimum of 15% of the aggregates composed of artificial brightener 
aggregates. 

R2 0.07 A combination of diffuse and specular reflectances characteristic of asphalt surfaces 
with aggregate composed of a minimum of 60% gravel of size greater than 10mm. Also 
asphalt surfaces composed of 10-15% artificial brightener in aggregate mix. 

R3 0.07 Slightly specular reflectance typical of asphalt surfaces with dark aggregates, rough 
texture and some months of use. This surface is common in the United States. 

R4 0.08 Mostly specular surface typical of very smooth asphalt texture. 

UKR2 0.05 Porous Asphalt (UK) 

W1 0.11 Wet surface 

W2 0.15 Wet surface 

W3 0.20 Wet surface 

W4 0.25 Wet surface 

ZOAB  0.10 CIE Class 2 Dutch Porous 

   

Luminaire Cycles 

The Luminaire Cycles dialog may be accessed from Roadway Optimizer or from the Roadway Calculation Grids dialog. 

• In Roadway Optimizer, Luminaire Coverage section, click on the Override button. 

• In the Roadway Calculation Grids dialog, click on the Configure button and then on the Luminaire Cycles button. 

"Luminaire Cycles" refers to the number of luminaire cycles that will be included in the Roadway Optimizer calculation and optimization procedure. A 
luminaire cycle is the distance between consecutive luminaires on the same side of the roadway. 

The Luminaire Cycles Towards Observer can be based on: 

•  A Set Distance, measured in feet or meters, depending on the units you are working in, or 

• A distance defined in luminaire mounting heights (MH's). For example, if your luminaire has a mounting height of 30' and you select 6 MH's, 
luminaires up to 180' (6x30') measured in the direction of the Observer will be included in the calculation. 

The IES RP-8-00 default toward the observer is 83.07 meters or 272.4696 feet. Other standards have different defaults. 

The Luminaire Cycles From End of Calculation Area are defined similarly. The IES RP-8-00 default is 12 mounting heights past the calculation 
area. Other standards have different defaults. 

   

Roadway Optimizer Settings 

The Roadway Optimizer Settings dialog allows you to specify the allowable precision and spacing ranges for Roadway Optimizer as well as some 
display and printing options. These settings are applied towards all new job files. 

General 

Symbol Scaling Factor - The default value is one; the symbol will be displayed at the same scale as the rest of the layout. You may increase the 
size of the luminaire symbol to make it easier to see by entering a different value in this field (whole numbers only). 

Symbol Line Weight Factor - Changing this value will make the lines used in the luminaire symbol thicker or thinner. 

Photometric Web Scaling Factor - This value will increase or decrease the size of the photometric web for each luminaire (visible only by clicking 
on the Photometric Web button on the top menu bar). 

Include Surfaces In Display - This is checked by default, causing a gray colored area to be displayed within one luminaire cycle in the graphics 
display area, representing the pavement surface. Removing the checkmark removes the gray colored area. 

Comparison 

This section allows you to choose the information to display on the Comparison tab. All are selected by default. Click in the check box to add or 
remove a checkmark. 

Calculation Metrics 
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In this section, you may select which metrics will be included on the Comparison tab and in printed output. All are selected by default, but only those 
that are calculated (as determined by the selected roadway standard) will be included. Click in the check box to select or deselect a metric. 

To change the color of the metric in the graphic display, click in the Color box for that metric (initially black). Select a color and click OK to return to 
the Settings dialog. 

Optimizer 

Precision - Average (Avg) - This setting allows you to set the acceptable precision range (+/- percent) for the calculated average value of luminance 
and illuminance when calculating spacing to achieve desired values. Calculations stop once the value falls within the acceptable range. Ranges are 5 
to 50% above the desired value, and 0 to 50% below the desired value. For example: If the calculated average value is to be >= to the desired value, 
set the (-) range to 0%. 

Precision - Minimum (Min) - This setting allows you to set the acceptable precision range (+/- percent) for the calculated minimum value of 
luminance and illuminance when calculating spacing to achieve desired values. Calculations stop once the value falls within the acceptable range. 
Ranges are 5 to 50% above the desired value, and 0 to 50% below the desired value. For example: If the calculated minimum value is to be >= to the 
desired value, set the (-) range to 0%. 

Precision - Ratio- This setting allows you to set the acceptable precision range (+/- percent) for the calculated Avg/Min, Max/Min, Min/Avg, Min/Max, 
and Max Lv Ratio when calculating spacing to achieve desired values. Calculations stop once the value falls within the acceptable range. Ranges are 
0-5% above the desired value, and 0 to 5% below the desired value. The default precision range for any of these ratios is +0% ><-3%; for a 0.3 
Value this range corresponds to 0.3><0.291.  

Maximum Allowable Spacing - This setting defines the maximum allowable spacing in units of mounting height up to 30. Calculations stop when 
the spacing exceeds this value. For example: Maximum Allowable Spacing = 10 and Mounting Height =30 ft. The actual maximum allowable spacing 
= 10 x 30 = 300 ft. 

Minimum Allowable Spacing - This setting defines the minimum allowable spacing in units of mounting height down to 1. Calculations stop when 
the spacing falls below this value. For example: Minimum Allowable Spacing = 1 and Mounting Height =30 ft. The actual minimum allowable spacing 
= 1 x 30 = 30 ft. 

Maximum Number of Iterations - This setting determines the maximum number of iterations (up to 30) that Roadway Optimizer will perform in order 
to achieve each desired criteria. Calculations will stop once this value is reached. In this case, the last iteration results will be displayed. 

Round Spacing to Nearest - This setting specifies the rounding to apply to the calculated spacing value. For example: A rounding of one results in 
possible spacing values of 130,131,132,etc. A rounding value of 5 will yield spacing values of 130, 135, 140, etc. A rounding value of 0.25 will yield 
spacing values of 130.25, 130.5,130.75, etc. The units will be feet or meters, depending on the units selected in Model Mode. 

   

Roadway Optimizer - Print Layouts 

This dialog allows you to select which layouts and/or layout comparison to print. Blank layouts will appear grayed out in the dialog. Similarly, the 
Layout Comparison is only available if two or more layouts have been created. 

1. Select the layouts to print by clicking in the selection box adjacent to the layout name. A checkmark will appear in the box when it is enabled. 
Clear the selection box in order not to print the selected layout. Only layouts that have been calculated will be available for selection. 

2. To include the displayed banner as part of the input, click in the Include Banner selection box so that a check mark is shown. You may change 
the Banner by clicking the Banner button. 

3. Also included by default: General / Luminaire Locations:This page echoes the input criteria and luminaire definition information. If you do not 
wish to include this information, go to the Settings dialog and uncheck these items. 

4. If you wish to include the information on the Comparison tab, leave the Comparison box checked (it is checked by default). 
5. Specify a printer by clicking on the Print Setup button. 
6. Click Ok to print the selected items and return to Roadway Optimizer.  

Note: Before printing, you should open the Settings dialog to see what is checked. By default, all calculation metrics are checked. The Print 
command will result in all metrics that are checked and have been calculated to be printed for any layouts that are selected in the Print command. 

   

Roadway Optimizer Export 

The Roadway Optimizer Export process exports all calculated grids in the currently displayed layout to Model Mode. To export some but not all, open 
the Settings dialog (on the top menu bar) and uncheck any that you don't wish to export to Model Mode.  

Once the Export button is clicked, the layout will be attached to the cursor at the lower-left corner of the calculation grid. Placing the grid is a two-step 
process. The first step is to drop the layout into position by clicking on the appropriate location. The next step is to rotate the grid into whatever is an 
appropriate orientation. Click when at the correct angle (shown just below the Command Line) to complete the Export process. The exported 
calculation grid is reset and will need to be recalculated. 
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The calculation grid is placed within differing luminaire cycles depending on the selected standard and criteria. For IES criteria, the calculation grid is 
generally located at the 2nd luminaire cycle of 5 luminaire cycles. Roadway Optimizer has been enhanced to handle very short luminaire cycle 
spacing. A problem with the minimum number of cycles recommended by IES-RP-8-2000 can result in the observer for Veiling Luminance being 
located outside of the luminaire cycles. AGi32 now adds 2 additional luminaire cycles to the left of the calculation area when necessary. In these 
cases,  the calculation grid is located at the 4th luminaire cycle of 7 luminaire cycles. 

  

Copy Layout - Concepts 

The Copy Layout dialog is displayed in conjunction with the Roadway Optimizer and Room Estimator commands. It provides a method for duplicating 
a layout created in a particular tab to another tab in  these dialogs. This command allows you to consider the results of different luminaire layouts or 
surface reflectances in the environment quickly and easily. 

For example, if Room Estimator, you can use the layout tabs to consider the effect of different luminaire suspension lengths or surface reflectances. 
In the Roadway Optimizer tab, you may want to consider the effect of different setbacks or Layout Types. 

   

Copy Layout 

This dialog allows you to copy the current contents of any layout into any other layout. 

1. In the Copy section, click on the radio button adjacent to the layout number you wish to copy. 
2. In the Into section, click on the radio button adjacent to the layout number to replace. 
3. Click Ok.  

  

 System Settings 

Color Setting 

The Color dialog box that appears for wireframe color, line color and entities not associated with reflectance or transmittance is common to all 
Windows™ programs. Internal help is provided by the What's This Assistant (?) at the upper right hand corner of the screen.   

Line Type - Concepts 

AGi32 allows for several commonly used architectural styles when creating drawing entities for backgrounds or presentation. To change the line 
style, click the Line Type cell in the Properties toolbar. The Line Type dialog offers 5 line styles to choose from. 

When the solid line type is selected, you may select a solid line width based on the current display units (feet or meters) or "pixel" (where line width is 
1 pixel wide. If a line width of 0 is entered, the line width will default back to "pixel". A pixel is defined as a dot on your screen or a dot on the printer. 

The line width text box scrolls in increments of 0.25, although any value may be manually entered instead. For other line types, the line width is fixed 
at one pixel. 

Be aware that different Zoom levels may make solid lines of more than one pixel in width look different. For example, if a line of 1 Meter is specified, 
the line width will look different at a Zoom level of 100m x 100m than 1000m x 1000m. The absolute width is based on your printed resolution.  

Line Type Setting 

The Line Type dialog controls the line style used to create drawing entities, except text, in AGi32. To change the Line Type, click in the Line Type cell 
on the Properties toolbar. 

Selecting line type: 

1. Click on the radio button adjacent to the desired line type. 
2. If solid line type is selected, use the up and down arrows to select the desired line width or enter the desired line width manually. For Pixel 

(thickness of one pixel), enter 0 or scroll down to the bottom of the list. 
3. Click Ok.  
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Ortho Setting - Concepts 

The ability to restrict the cursor to horizontal or vertical directions of movement simplifies the process of drawing straight lines or locating entities 
along straight lines. Ortho Mode can be toggled On or Off from the Switches Toolbar or by toggling the F8 key on your keyboard. 

Ortho Mode is transparent, which means that it can be accessed at any time without breaking the current command.  

Ortho Setting 

The Ortho Setting constrains the cursor movement to vertical and horizontal directions. This feature allows you to quickly specify straight line 
segments for rooms, drawing entities, objects and calculation grids. 

  Select the Ortho button on the Switches toolbar .  or press F8 on your keyboard  

Snap Setting - Concepts 

The Snap command sets the Snap increment for all entities in AGi32. The Snap increment restricts mouse movement to user defined intervals to 
assist in precise placement of lines, luminaires, objects, calculation points, etc. Cursor movement in all three Cardinal directions (X, Y and Z) is 
controlled by one Snap setting. In addition, the Orientation angle available when placing luminaires with Locate and Orient as well as Tilt with Locate 
and Aim is governed by the Snap setting, as are all free rotation specifications. 

AGi32 provides two methods for changing the Snap setting: (1) From the Snap text box and button on the Status Bar, (2) By pressing the F9 key on 
your keyboard to toggle Snap On and Off The Snap text box provides the ability to change the Snap increment transparently - simply change the 
value at any time! 

The Snap value is bounded on the lower end by 0.001 and is unlimited on the upper end. However, we recommend working with a Snap value no 
smaller than 0.01 for symmetrical results. To maintain surface hierarchy, and avoid co-planar surface problems, we further recommend working with 
a Snap increment no smaller than 0.1 when specifying surfaces.  

Snap Setting 

The Snap Setting button and text box on the Status bar allows you to change the current Snap value and setting On or Off directly. If you need to 
change the Snap value while in another command, simply input the desired value in the Snap box. 

To toggle Snap On/Off quickly, use the F9 key instead. 

 
Snap Button Enabled Snap Button Disabled 

  

 The Snap may be toggled on or off by clicking on the Snap button. When Snap is disabled, changing the current Snap value will have no effect. 

 To change the current Snap value, click in the Snap text box and replace the current value with the desired value. 

Snap To Setting - Concepts 

The Snap To mode allows you to snap to the endpoints of drawing entities, rooms and objects while creating the environment using AGI32’s 
modeling tools – such as rooms, objects, luminaires, calculation points, etc. The Snap To command is transparent and may be toggled on and off 
during commands by clicking on the Snap To button on the Status Bar or by pressing F3. The Snap To command shows the endpoints with an X 
when the cursor is positioned close to the endpoint and will snap to that point automatically. 

Snap To is available in Model Mode and Page Builder modes. The Snap To command snaps to the endpoints of all entities, including drawing 
entities, rooms and objects. 

Snap To is not active for all commands at all times. 

1. Snap To is active for the first 2 endpoints in Rooms and Objects but not the 3
rd
 point. The 3

rd
 point is constrained to a depth perpendicular to the 

baseline. 
2. In Elevation view, Snap To only snaps to drawing entities within the Elevation “slice”. Other drawing entities may be visible but will not be 

detected by the Snap To mode. In particular, Snap To snaps to different planes when creating rectangular – vertical extruded entities. When 
creating Rectangular-Vertical Extrusion rooms, the elevation rotation slice is taken from the lower left corner of the room to the lower right corner 
(at the baseline). When creating Rectangular-Vertical Extrusion objects, the elevation rotation slice is taken from the upper right corner of the 
room to the upper left corner (opposite the baseline). 
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 Click on the Snap To button on the Status Bar  or use the F3 shortcut. 

Note: The tolerance settings governing the Snap To settings are found in the System Settings - Advanced dialog.  

Snap To 

Snap To allows the user to snap to drawing entity, room and object endpoints when positioning entities such as luminaires, rooms, objects, etc. in 
AGi32. 

The Snap To setting indicates the current state (On or Off) of the Snap To command. 

To toggle SnapTo On and Off by keyboard, use the F3 shortcut. 

Snap To Button Enabled Snap To Button Disabled 

  

Units - Concepts 

The Units command is used to modify the current units specified for distance and illuminance calculations in the current AGi32 job file. Select from 
English or Metric units or a combination of both, such as Meters and Footcandles, fc or lux.  

Units 

Click on the Units button to invoke the Units tab in the System Settings dialog and change the current distance and illuminance units. 

 From the Status Bar , click on the Units button . 

Related Topics 

System Settings  

System Settings 

The System Settings dialog is most often accessed at the beginning of job file creation. From this dialog you may set the snap increment, units 
settings, drawing entity properties and much more. You may also decide to permanently change some of the startup settings whenever opening 
AGi32 in the future. In this case, you would select Save Settings As Startup Defaults. If this is not selected, any modifications will only apply to the 
current job file. When the job file is saved, certain system settings will automatically be saved along with the drawing contents. 

 From the Common toolbar, click on the System Settings button . 

The System Settings dialog also provides access to the Advanced Settings dialog. Please use caution when modifying the settings in the Advanced 
Settings dialog, as you may hinder the productivity of this software inadvertently. We recommend that these settings remain unchanged unless you 
are specifically instructed to modify them by Lighting Analysts staff. 

Note: Please see System Parameters for a listing of system parameters and default settings. 
 

Switches/Settings tab 
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The Switches/Settings tab allows you to change many of the settings that affect the AGi32 drawing environment. For example, you can specify how 
often AGi32 automatically saves the job file, and you can specify whether calculation planes will automatically update whenever a luminaire 
modification has been applied. Here too, you may determine how the cursor will move and what properties will be applied to drawing entities. Feel 
free to experiment with the settings on the Switches/Settings tab until you find the best environment for your needs. 

Setting Default 
Value 

Description 

Switches 

Show Welcome 
Browser 

Enabled Welcome Browser appears each time AGi32 is started. 

Ortho Mode Disabled Restricts the cursor to pure horizontal and vertical movements 

Undo/Redo Enabled The Undo/Redo setting enables or disables the Undo/Redo functions. Disabling the Undo Switch will speed up 
the operation of some commands. 

When the Undo/Redo function is turned off, all pending Undo/Redo functions are cleared from AGi32’s internal 
database and the Undo/Redo feature is disabled for all future commands. 

When the Undo Switch is disabled, the Undo function still functions within a command. For example, when 
drawing the perimeter of a polygon shaped room, you may undo the last line segment by using the Ctrl-Z 
keystrokes on the keyboard. Once the room specification is complete, you may not undo the entire room 
(command level Undo). 

Smart Text Enabled Enabling shows data contained in smart text instead of the actual smart string or block. 

Snap To Disabled Snap To allows the user to snap to drawing entity endpoints when positioning entities such as luminaires, 
rooms, objects, etc. 

The Snap To setting indicates the current state (On or Off) of the Snap To command. 

Calculation Method 

Full Radiosity  Enabled The Full Radiosity Method setting indicates that reflective, obstructive and/or transmissive surfaces will be 
considered in the calculations. 

Direct Only Disabled The Direct Only Method setting indicates that reflective, and/or transmissive surfaces will not be considered in 
the calculations. Only obstructive properties of surfaces are considered. When Direct Only Method is active, 
interreflectance is not calculated. 

Direct Only - 
AutoCalc 
Enabled 

Disabled Selection enables automatic calculation whenever any luminaire modifications are made. Only applicable with 
the Direct Only Method . 

Smart Symbols 

Full Radiosity 
Method 

Enabled This setting enables the Smart Symbol selection routine when the Full Radiosity Method is applied, to be 
applied when photometric files are selected in the Luminaire Definition dialog. 

Smart Symbols automatically recommend a symbol for the selected photometric file using the luminous shape 
and dimensions specified in the photometric file along with the luminaire distribution. 

Direct Only 
Method 

Enabled This setting enables the Smart Symbol selection routine when the Direct Only method is applied (with / without 
AutoCalc enabled), to be applied when photometric files are selected in the Luminaire Definition dialog. 

Symbol Logic   The Symbol Logic button provides access to the Symbol Logic dialog. This dialog specifies which luminaire 
symbols are displayed when photometric files are selected. The symbol logic is based on photometric 
characteristics, luminous area size and shape and mounting options. 

Hints 

Activate All or 
Deactivate All 

Activate All Activates or Deactivates All Hints globally in AGi32. Hints provide front line assistance to complex dialogs. 

Virtual Axis 

Off   Disables the Virtual Axis from displaying. 

Display in Upper 
Left Corner 

  Displays the Virtual Axis in the upper left corner of each view, regardless of coordinate display. 

Attach To Enabled, 
attached to 
origin (X=0, 
Y=0) 

Attaches the Virtual Axis to the origin. The virtual axis is a 3D indicator showing coordinate axes. It does not 
appear in output. 

Dimensions 

Precision 3 Indicates the maximum number of decimals to display when specifying dimensions. 

Model Mode - Properties 

Line Color Black Line and text color used to draw in Model mode. 

Line Type Solid The default line type used to draw in Model mode. 

Line Width Pixel The default line width used to draw in Model mode. 

Model Mode - Snap 
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Snap On Enabled Enables cursor precision for all Model Mode commands. 

Snap Value 1 Indicates the minimum interval (in feet or meters) for cursor movement. A value of 1 restricts the cursor to 
recognizing whole units (e.g., 0, 1, 2, etc.). 

Snap Off   Disables cursor precision. Movement is allowed in 1/1000 of a foot or meter. Disabling Snap while drawing is 
not recommended, as it can lead to precision, symmetry and coplanar surface problems. 

Page Builder - Snap 

Snap On Enabled Enables cursor precision for all Page Builder Mode commands. 

Snap Value 1 Indicates the minimum interval (in Inches and millimeters) for cursor movement. A value of 1" restricts the 
cursor to snapping to whole inches (e.g., 0, 1, 2, etc.). 

Snap Off   Disables cursor precision. Movement is allowed in 1/1000 of an inch. 

Page Builder - Properties 

Line Color Black Line and text color used to draw in Page Builder. 

Line Type Solid The default line type used to draw in Page Builder. 

Line Width Pixel The default line width used to draw in Page Builder. Two Line Width values are displayed to handle all paper 
sizes (Inches and mm). 

 

Defaults Tab 

The Defaults tab allows the user to specify the default settings used in Model Mode. 

Setting Default 
Value 

Description 

Default System Font 

Font Courier 
New 

The font used for calculation points, dimension and axes entities as well as in text entities and statistical areas. 
Although the font may be modified when adding/modifying text entities and statistical areas, calculation points, 
dimensions and axis entities will always reference the default system font. 

Default Luminaire Symbols 

Model BOX 
DOWN 

The default luminaire symbol used in Model Mode. Click the Select button to specify an alternate Model 
symbol as the default. This symbol may be changed by invoking the Luminaire Symbols dialog while defining 
the luminaire. However, if one symbol is used more than others, you may wish to specify it as the default 
Model luminaire symbol. 

Render BOX 
DOWN 

The default luminaire symbol used in Render mode. Click the Select button to specify an alternate Render 
symbol as the default. This symbol may be changed by invoking the Luminaire Symbols dialog while defining 
the luminaire. However, if one symbol is used more than others, you may wish to specify it as the default 
Render luminaire symbol. 

Default Colors 

Frozen Entity Color Purple The color applied to entities within a Frozen project. 

Selected Entity 
Color 

Dark Gray The color applied to entities when selected within a command. 

Temporary On 
Color 

Red The color applied to removed calculation points when the Replace Points command is selected. 

Calc Areas Text 
Color 

Red The color applied to Calculation Labels in the Statistics window. This color assists in identifying the summary 
type. 

Stat Areas Text 
Color 

Blue The color applied to Statistical Area Labels in the Statistics window. This color assists in identifying the 
summary type. 

LPD/UWLR Areas 
Text Color 

Green The color applied to LPD and UWLR Area Labels in the Statistics window. This color assists in identifying the 
summary type. 

Model Mode 
Background 

White The Model Mode Background color indicates the color of the graphics area in Model Mode. The default color 
for the graphics area is controlled by the Window setting in Windows™ Display Properties dialog and is 
normally White by default. The Model Mode Background color is modifiable independently of the Windows 
setting by clicking in the Color cell and selecting an alternate color (e.g., black, blue, gray, white, etc.). There is 
no need to change any other colors when changing the background color since AGi32 automatically maps 
entity colors to keep them from disappearing. For example, when using a black background, black entities are 
automatically mapped to white to prevent them from disappearing. Whether or not an entity will 'flip' color will 
depend on the current Flip Color Tolerance parameter specified in Advanced System Settings). 

Default Isometric View 

Rotation -30 The rotation angle applied to the current view when the Default Isometric View command is selected. To 
change the rotation angle click the Change button. 

Tilt 60 The tilt angle applied to the current view when the Default Isometric View command is selected. To change the 
tilt angle click the Change button. 
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Default View Factors 

Zoom Factor 1.25 The Zoom In / Out Factor controls the amount the display is decreased / increased when a user Zooms In / 
Zooms Out using the Zoom In and Out commands. For example: If the current screen display width is 100’, 
and the Zoom In Factor is 1.25, the display width will decrease to 80’ when the user zooms in. 

Pan Factor 0.75 The Pan Factor controls the percentage amount a display is panned (in terms of screen width/height) when a 
user pans left, right up or down. For example: If the current screen display width is 100’, and the Pan Factor is 
0.75, panning left will shift the display 75’ to the left. 

Entity Dialog Defaults 

Reset with Each 
File (New or Open) 

Enabled Defaults for all entity dialogs are reset whenever a new or existing file is opened. 

Defaults are only applied for the current job file. 

Reset at Startup 
Only 

Disabled Defaults for all entity dialogs are reset when AGi32 is started. 

Defaults are retained for the entire AGi32 session and are applied to all opened or new job files in that session. 

No Reset at 
Startup or With 
Each File 

Disabled Defaults for all entity dialogs are not reset. 

Defaults are retained for all sessions of AGi32 and are applied to all opened or new job files. 

Reset All Dialog 
Defaults Now 

- This option allows you to reset defaults for all entity dialogs. 

Note: You may also reset defaults within each entity dialog individually (only selected dialog is affected). 

 

View/Projects Tab 

The View/Project tab provides default View and Project parameters used in AGi32. These settings are only used during startup and changes are not 
applied in the current job file. To make changes, enable the Save Settings as Startup Defaults option. 

Setting Default 
Value 

Description 

Default View 

View Name View_1 The default View Name is assigned to the initial view when a job file is opened. 

The View Name may not contain the characters: *, ?, or . 

Coordinates of Lower Left 
Corner 

X=0, Y=0 The lower left coordinates of the initial view. 

Coordinates of Upper 
Right Corner 

X=100, 
Y=100 

The upper right coordinates of the initial view. The applied coordinates of the upper right corner 
depend on the size and shape of the view and AGi32 desktop. 

Default Project Name 

Project Name Project_1 The default Project Name is assigned to the initial project when a job file is opened. 

The Project Name may not contain the characters: *, ?, or . 

 

Units Tab 

The Units tab specifies the settings for distance and illuminance units as well as some lighting metric parameters. The default number of decimal 
places used to display calculation values and the point demarcation is specified here, as well. Modifying the Display and Illuminance Units will 
change the current job file and possibly necessitate recalculation. 

If the Display units are changed or converted, all existing dimensions and templates will be erased (a warning is displayed). 

Setting Default Value Description 

Display Units 

Feet Enabled Indicates that each drawing unit equals 1 foot. Lengths less than 1 foot are specified in decimals. 

Feet and 
Inches 

Disabled Indicates that each drawing unit equals 1 foot. Lengths less than 1 foot are specified in decimals, although 
inches are displayed on screen. 

Meters Disabled Indicates that each drawing unit equals 1 meter. Lengths less than 1 meter are specified in decimals. 

Convert 
current units 
to new units 

Disabled Scales all entities using new units setting. If setting is not selected, units conversion is 1:1 

For example, if the display units are changed from Feet to Meters, and the units are not converted, each 
drawing unit remains the same. Only the unit changes (i.e., 1 foot = 1 meter). If the units are converted, the 
entities are scaled (i.e., 1 foot = 0.3048 meters) 

Illuminance Units 

Footcandles Enabled Indicates the current illuminance unit is footcandles. You may convert between lux and footcandles without 
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recalculating. 

Note: Exitance values are based on the Illuminance Units chosen in System Settings, not on the Display Units. 
If the Illuminance units are FC, Exitance values will be displayed in Lumen / Sq. Feet.  If the Illuminance units 
are Lux, Exitance values will be displayed in Lumen / Sq. Meter 

Lux Disabled Indicates the current illuminance unit is lux. 

Note: Exitance values are based on the Illuminance Units chosen in System Settings, not on the Display Units. 
If the Illuminance units are FC, Exitance values will be displayed in Lumen / Sq. Feet.  If the Illuminance units 
are Lux, Exitance values will be displayed in Lumen / Sq. Meter 

Number of 
Decimals 

1 Indicates the display precision. The range is from 0 to 4. Level 0 rounds each calculated value to whole 
numbers (e.g., 0, 1,10, 100, etc.). Level 1 rounds each calculated value to a decimal place of 1 (e.g., 0.2, 1.4, 
10.2, 99.5, etc.). Level 2 rounds each calculated value to a decimal place of 2 (e.g., 0.15, 1.38, 10.23, 99.46, 
etc.). Level 3 rounds each calculated value under 100 to a decimal place of 3 (e.g., 0.148, 1.375, 10.234, 
99.456, etc.). Level 4 rounds each calculated value under 100 to a decimal place of 4 (e.g., 0.1485, 1.3754, 
10.2342, 99.4559, etc.). 

3 and 4 decimal points of precision should be used with caution. Although this level of precision can be 
calculated in AGi32, it is nearly impossible to measure in the real world.  

When using 3 or 4 decimals points it may be necessary to reduce the text size of the calculation points to 
prevent the numbers from overlapping. 

Decimal places of precision of one or more are only available for calculated values under 100). Values over 
100 will round to 0 decimal places of precision. 

Numerical Ratios 

Avg/Min, 
Max/Min 

Enabled Displays the numerical ratios using Average/Minimum and Maximum/Minimum nomenclature. 

This is the typical convention in North America. 

Min/Avg, 
Min/Max 

Disabled Displays the numerical ratios using Minimum/Average and Minimum/Maximum nomenclature. 

Some international countries use this convention instead. 

 

Rendering Tab  

The Rendering tab allows you to save the Radiosity solution, change the convergence parameters that affect the AGi32 rendering environment and 
calculation results. In addition, you may select a default anti-aliasing level and enable Adaptive Subdivision as well as modify its parameters. Feel 
free to experiment with the settings in the Rendering tab until you find the best environment for your needs. 

Setting Default Value Description 

General 

Anti-Aliasing 
Sampling Level 

None The Anti-Aliasing Sampling Level allows the user to apply anti-aliasing to the rendered images in Render 
Mode. Anti-aliasing is a software technique used to make jagged edges in images appear smoother. By 
overlaying the original images with slightly offset copies, the eye is fooled into seeing straighter lines and 
smoother curves (instead of “jaggies”). The Sampling Level indicates the number of image copies applied and 
offset from the original image. The Default Level is None indicating no anti-aliasing may be applied. The 
Maximum Sampling Level is 15. Higher sampling levels increase the image quality but also take longer to 
produce (up to several seconds). 

Render Image 
Refresh 
Interval 

10 Indicates the percentage change in light absorption at which the display is refreshed during the radiosity 
calculations. The default value is 10%. At this interval, the display is refreshed whenever the Light Absorbed 
value increases by 10% from its previous level, starting from the amount initially absorbed (e.g. 30, 33, 37, 41, 
45, 50, etc.). Note: When calculating in Model mode, the render image is never directly displayed, hence the 
refresh interval does not apply. Calculating in Model mode will be slightly faster than calculating in Render 
mode, because the display does not require refreshing. 

Radiosity Stopping Criterion 

Accuracy 
Presets 

High Three Preset Stopping Criterion Levels are available - High (default), Medium and Low. 

High - 99%. The finest level applied; default for all Full Radiosity Method calculations. Necessary when the 
highest level of accuracy is expected; calculation time is also longest. Recommended for these applications: 
Daylighting, Emergency / Egress, Close proximity between luminaire and surface (coves, facade lighting, 
indirect applications 

Medium - 95%. Appropriate for most interior electric lighting applications, except as noted above 
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Low - 90%. Appropriate for most exterior electric lighting applications. 

Stopping 
Criterion (% 
Light 
Absorbed) 

99 The Stopping Criterion indicates the amount of absorbed light that is accounted for in the environment before 
the Radiosity calculations are stopped. Simply, each time the light “bounces” around in the environment, more 
light is absorbed. The Radiosity calculations are repeated until the stopping criterion has been met. The 
default Stopping Criterion is 99%, but any value between 0% and 99.99% may be entered. Values below 90% 
are not recommended unless you are doing preliminary or non-production grade calculations. 

Adaptive Subdivision 

Adaptive 
Subdivision 

Disabled Select check box to activate Adaptive Subdivision for surfaces not identified as Daylight Exterior Surfaces. 

Preset Level Default Applies the following values as the Adaptive Subdivision levels: 

• Maximum Subdivision Level - 3 

• Minimum Element Area - 0.5 ft
2
 (0.0465 m

2
) 

• Element Luminance Threshold - 1.5 

Preset Level 

High Applies the following values as the Adaptive Subdivision levels: 

• Maximum Subdivision Level - 5 

• Minimum Element Area - 0.1 ft
2
 (0.0093 m

2
) 

• Element Luminance Threshold - 1.1 

Maximum 
Subdivision 
Level 

3 Indicates the level that each element will be divided into for each subdivision loop. The range is from 1 to 
MAX. Level 1 subdivides each element into four smaller elements. Level 2 subdivides each new element into 
four smaller elements. Level 3 subdivides each new element into four smaller elements, except when it is the 
last subdivision level. In this case, the last subdivision level creates triangular elements that span between 
small elements and larger elements. 

There are 9 finite levels. The MAX level offers unlimited subdivisions; it is limited by the Minimum Element 
Area and Luminance Threshold. In other words, subdivision will continue to occur until one of these limiting 
factors is reached. 

Minimum 
Element Area 

0.5 Indicates the smallest element that will be produced by Adaptive Subdivision. The value should be defined on 
a per-environment basis. The value is specified in current display units (i.e., square ft or square m). 

Element 
Luminance 
Threshold 

1.5 This setting determines the maximum allowable difference in luminance levels between adjacent elements. If 
the threshold is crossed, the adjacent elements are subdivided. 

Apply To 
Daylight 
Exterior 
Surfaces 

Disabled Select check box to activate Adaptive Subdivision for surfaces identified as Daylight Exterior Surfaces. 

Maximum 
Subdivision 
Level 

3 Indicates the level that each element will be divided into for each subdivision loop. The range is from 1 to 
MAX. Level 1 subdivides each element into four smaller elements. Level 2 subdivides each new element into 
four smaller elements. Level 3 subdivides each new element into four smaller elements, except when it is the 
last subdivision level. In this case, the last subdivision level creates triangular elements that span between 
small elements and larger elements. 

There are 9 finite levels. The MAX level offers unlimited subdivisions; it is limited by the Minimum Element 
Area and Luminance Threshold. In other words, subdivision will continue to occur until one of these limiting 
factors is reached. 

Minimum 
Element Area 

0.5 Indicates the smallest element that will be produced by Adaptive Subdivision. The value should be defined on 
a per-environment basis. The value is specified in current display units (i.e., square feet or square meters). 

Element 
Luminance 
Threshold 

1.5 This setting determines the maximum allowable difference in luminance levels between adjacent elements. If 
the threshold is crossed, the adjacent elements are subdivided. 

 

File System Tab 

Setting Default Value Description 

General 

Compress 
Job File 
When 
Saving 

Enabled The Compress Job File When Saving option compresses the saved job file to a size typically 
3-6 times smaller than the original file size. 
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Automatical
ly Create 
Job File 
Backup 
(BAK) 

Enabled By default, AGi32 creates a backup file (*.BAK extension) of the previous saved job file. Users 
may elect not to save a BAK file, however, this not recommended. 

Save 
Rendered 
Environme
nt 

Enabled By default, the Rendered Environment is saved when the job file is saved. AGi32 will ask if 
you wish to save the rendered environment when closing the current job file as long as this 
option is disabled. When a rendered environment is saved, a separate Radiosity Solution File 
is saved containing the rendered elements within the environment. The Radiosity solution file 
may be quite large, up to several megabytes. To save the Rendered Environment whenever 
the job file is saved, enable this option in the System Settings command (File System tab). 
The Radiosity Solution File will carry an RSF extension and will be saved in the same folder 
as the job file. 

Saving the rendered environment for large applications with many surfaces may be time 
extensive; therefore, AGi32 reports the save status on its command line to indicate progress. 
The AGi32 button on the Windows taskbar will also change its caption to AGi32-Saving as a 
visual clue if you are working on other applications at the same time. Finally, while the 
rendered environment is being saved, AGi32 is assigned 'below normal" priority so that you 
may open and work in other applications at the same time. 

Prompt For 
File 
Information 
Before 
Closing File 

Enabled By default, AGi32 prompts for File Information when a file is saved for the very first time, when 
the Save As command is invokes or when AGi32 is closed, if the file has changed since the 
previous save. The File-Information command includes more information regarding what 
information is entered at this time. 

Enable 
Automatic 
File System 
Cleanup 

Enabled When enabled, user is prompted to perform File System Cleanup every 30 days. Files deleted 
during Automatic Cleanup include: 

Render Working Files, AGi32 Temporary Files, Temporary Job Files, non existent file 
references (such as when a Recent or template file is deleted under Windows methods, but a 
reference still exists in AGi32 databases). Once files are cleaned up, AGi32 will report which 
files have been removed. 

Auto Save On, Interval 15 Minutes, 
Display Reminder 

Auto Save prompts you to save your file (or saves automatically) when enabled. You may 
specify the interval between Auto Save appearances. The default value is 15 minutes - it may 
be increased to 60 minutes. The option is also offered to display a reminder or save 
automatically. 

Default File Locations 

The Default File Locations section allows the user to specify the location of all AGI32 related file types. By default, the user's My Documents folder 
location is specified. However, users may specify a different local or network (shared) folder if desired. 

Working Files (including Render working files and temporary job files) must be stored on the same drive as the program (generally C:\), not in a 
network location. The default location will depend on the which edition of Windows is installed. The location may be changed, but the new location 

will not be applied until the next time that AGi32 is started up. 

User Files 
Folder 

Specify location or leave 
blank to use the last 
accessed folder. 

All AGi32-related files (temporary files, working files, and render working files) are stored in 
the User Files folder or subfolders within it. Changing the User Files folder will automatically 
change all subsequently saved files to the updated User Files folder the next time that the 
program is started. To share files on a network, change the User Files folder to centralized 
location on the network server. 

Job Files User Files Folder   

Daylight 
Study Files 

<Same Folder as Job 
File> 

Daylight Study Files are automatically saved in the same location as the job file. 

Movie Files <Same Folder as Job 
File> 

Exported Movie files are automatically saved in the same location as the job file. 

Ray Trace 
Image Files 

<Same Folder as Job 
File> 

Ray Trace images are automatically saved in the same location as the job file. 

Import Files User Files Folder AGi32 will look in the User Files folder for files to import.  

Import File 
Maps 

<Same Folder as Job 
File> 

Surface Import Mapping maps are stored in this directory. An Import Map is automatically 
stored for each imported CAD file containing imported 3D entities. They are stored in a 
subfolder of this folder called Automatically Saved Import Maps. User defined Import Maps 
are also saved in a subfolder here. 

Export Files <Same Folder as Job 
File> 

Unless directed elsewhere, AGi32 will save exported files in the same folder as the job file.  

Job File 
Template 
Files 

User Files Folder When changing the location of Job File Templates, the contents of the current Job Files 
Templates folder should be moved manually to the current Templates folder location (AGi32 
does not copy them automatically). If the Template Files are not moved, they will not be 
visible in the File-Templates tab. 

Note: The database file located in the User Files folder called AGI32-FS_TemplateFiles.mdb 
must also be copied to the current Templates folder in order for Templates to be available to 
network users. This database file contains user-defined file information including name, 
description, information and template image thumbnails from Model and Render modes. 
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Page 
Builder 
Report 
Files 

<Same Folder as Job 
File> 

Unless directed elsewhere, AGi32 will save PageBuilder report files in the same folder as the 
job file. 

Photometri
c Data 
Files, 
Downloade
d and 
Extracted 
Instabases 

Photometric Files Folder 
(This specified location is 
considered the "root" 
photometric data folder.) 

This is the location of extracted Instabase photometric files. When changing the location of 
Photometric Files, you have the option to Move Photometric Data, which will move any 
existing photometric data to a new location. This might be used to set up photometric data 
sharing, perhaps from a central location on a server. Or, you may choose Do Not Move 
Photometric Data, allowing you to simply access photometric data from a different (and 
possibly shared) location. 

Photometri
c Data 
From Job 
Files 

Root 
Folder\PhotometricData_
FilesFromJobFile 

These are photometric files from job files that do not exist in your currently loaded Instabases. 
Photometric data locations are defined by path. When job files are opened in AGi32, the path 
used originally to define the luminaire is followed. If the specified path does not exist, AGi32 
copies the photometric data stored in the job file to this folder and paths are redefined 
accordingly. 

Photometri
c Data, 
Downloade
d 

but not 
Extracted 
Instabases 

Root 
Folder\PhotometricData_
Downloaded 

InstabaseFiles 

These are unextracted Instabase Files that have been downloaded from the Lighting Analysts 
server. When downloading an Instabase File, the Instabase is automatically installed. 
However, you can manually install a downloaded Instabase File from the Advanced tab in the 
Manage Photometric Instabases dialog. This may be useful when the Instabase Files are 
located in a shared centralized location.  

Photometri
c Data, 
Locally 

Created 

Instabase 
Files 

Root 
Folder\PhotometricData_
LocallyCreated 

InstabaseFiles 

These are Instabase files created using the Instabase Creator Tool (Tools-Create Photometric 
Instabase command) are stored in this location. You can install Instabases from this folder by 
browsing to this folder in the Advanced tab in the Manage Photometric Instabases dialog. This 
may be useful to test Instabase Files before uploading for public use.  

Reset Defaults- This button resets all the System Settings variables, including default File Locations, to the factory provided settings. Note: 
Photometric Data File Locations will NOT be changed by resetting the defaults. 

Save Settings As Startup Defaults - If the Save Settings As Startup Defaults selection box is checked, the current System Settings will be used for 
new job files. Otherwise, the settings only apply to the current job file.   

Smart Symbol Logic 

The Smart Symbol Logic dialog provides the settings for the Smart Symbol selection in the Luminaire Define dialog. Modifications should only be 
undertaken with a thorough understanding of Smart Symbols. Any modifications are not overwritten with updated installations. 

The Smart Symbol Logic dialog is displayed in a tree format. The format is outlined at the bottom of the dialog along with some basic instructions. 

Symbols are assigned at the Distribution Type level by right clicking on the desired node (e.g., Direct) and selecting the Add Symbol option from the 
secondary menu. The Luminaire Render Symbols dialog is displayed and the symbol may be selected from any symbols folder. Color, Scaling 
Factors and Insertion point may not be modified at this time, they are specified when Smart Symbols are selected. 

A Distribution Type may be allocated as undefined for a particular Mounting Type-Luminous Shape combination so that users are prompted to select 
a more appropriate mounting type. Right click on the Distribution Type node (e.g., Indirect) and select Set as Undefined from the secondary menu. 
No symbols should be defined for an undefined Distribution Type. 

Some luminous shapes (such as Point, Rectangular and Rectangular with Sides) are common and it is desirable to have multiple symbols defined 
with varying length ratios. We recommend selecting symbols that have equal Length and Width (L = H), symbols that have Length greater than Width 
(L > W) and symbols with Length less than Width (L < W). Having at least one symbol selected for each of these options, ensures that the user will 
have an appropriate symbol to select for each photometric distribution.   

Advanced System Settings 

The Advanced Settings dialog provides access to advanced parameters used in AGi32. Users should NOT modify these settings unless they know 
what they are doing or have been instructed to do so by Lighting Analysts staff. 

General Tab 

The General Tab provides Advanced parameters related to working with AGi32's graphic area and importing files. 

Setting Default Value Description 

Ghost Image - 
Repaint Cutoff 

250 Sets cutoff distance, in twips, when repainting ghost images. When the distance moved is greater than 
the cutoff value, the image is not repainted. 
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Increment 

Ghost Image - 
Number of Entities 
Cutoff 

1000 Sets the cutoff for determining whether the complete ghost image will be seen or a cube covering the 
image's extents. 

Ghost 2D Image - 
Number of Entities 
Cutoff 

500 Sets cutoff for determining whether complete 2D ghost Images will be displayed or partial images. 

Ghost 2D Image - 
Segment Step 

3 Sets increment step for entity list if number of entities exceeds Ghost 2D Image - Number of Entities 
Cutoff. 

Initial Curve 
Increment 

15 Sets the initial curve increment in degrees. Changing this parameter does not effect existing entities. 

Font - Line 
Segments Per Line 

8 Sets the number of selection lines per line of text. Changing this parameter does not effect existing text 
entities. 

Direct Calc Mode 
Limiting Value 

0.0025 This setting specifies the minimum testing footcandle value required to determine whether the 
contribution from a luminaire is considered. The maximum candela value is used to test the contribution 
of the luminaire initially. If the contribution is equal or greater than the limiting value, a real calculation is 
applied. 

Surface View 
Mode - Tolerance 

0.2 When in Surface View Mode, either directly or by creating an Opening, only entities that are located 
within the tolerance are displayed. 

For primary views (0,90,180,270)            Front tolerance = 0.2 

  Back tolerance = snap+0.2 

Other viewing directions Front tolerance = snap+0.2 

  Back tolerance = snap+0.2 
 

Import Text - Size 
Factor 

2 
Text factor is applied when importing CAD files.  

Import Text - Offset 
Factor 

1.5 
Offset factor is applied when importing CAD files.  

Flip Color 
Tolerance 

128 
This setting will flip an entity color to the opposite color if the RGB components of the entity minus the 
Flip Color Tolerance is equal to or less than the RGB components of the background color. This setting 
is intended to keep entities from disappearing against the background if they're the same color. For 
example, black entities are mapped to white against a black background. The higher this setting, the 
lesser the tolerance (more colors flip).  

Snap To Initial 
Tolerance 

2 
This setting specifies the initial tolerance distance (in the current units - ft, meters, inches or mm) for 
drawing entity endpoints to be selected as potential Snap To points. If several Snap To points are 
available within the initial tolerance distance, the closest point to the current cursor location becomes 
the actual Snap To point. The default initial tolerance distance is 2. Increasing this value increases the 
potential Snap To points.  

Snap To Final 
Tolerance 

.05 
This setting determines the final tolerance distance (in current units) to the drawing entity endpoint from 
the cursor for it to become the actual Snap To point. In the case where several potential Snap To points 
are within reach of the cursor, this setting determines which is closest. The default setting is .05. In very 
small detailed environments, this value may need to be decreased in order to select the appropriate 
Snap To point.  

Snap To Mouse 
Detect 

3 
This setting determines the pixel amount the cursor needs to move in order for the Snap To command 
to search for potential Snap To points. In Zoomed-In views, relatively large mouse movements may not 
show the Snap To setting correctly outside of the specified tolerance distance. The user may need to 
move the cursor slightly to show the current Snap To setting. The default value is 3. For large drawings 
with many drawing entities, it may be necessary to decrease this value. This will decrease the number 
of searches the Snap To commands, providing smoother mouse movement.  

Max. Imported 
Surfaces Per Layer 

5000 
Layers containing more than 5000 surfaces are automatically broken into sub-layers for more efficient 
handling internally. For example: if layer XYZ has 7823 surfaces, it will be broken into two layers; XYZ 
with 5000 surfaces and XYZ_1 with 2823 surfaces.  

3D Entity Vertex 
Check Range 

0.25 
The percentage of each object checked for consistent surface orientation and duplicate surfaces in an 
imported CAD file containing 3D entities. This is based on the assumption that adjacent surfaces in any 
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object should be within the same range of each other in the CAD file. This may not always be true in 
which case the percentage of surfaces checked should be increased. The larger this number, the longer 
the file will take to check for consistent surface orientation and/or duplicate surfaces. Files with 
duplicate and/or inconsistent surface orientations may not render with Adaptive Subdivision enabled - 
they may terminate abruptly (crash).  

 

Render Tab 

The Render tab provides Advanced parameters related to AGi32 meshing parameters and render files. 

Setting Default Value Description 

Initial Meshing - 
General Surface 
Types 

Several This section specifies the initial discretization of all surfaces in rooms and objects and Diffuse Window 
Transition  surfaces. The mesh level is based on the longest side of each surface. Decreasing the patch 
size increases the number of patches and elements and lengthens the calculation time, may increase 
accuracy. 

Initial Meshing - 
Glass/Transition 
Surface Types 

Several This section specifies the initial discretization of Transparent Window and Daylight Opening Transition 
 surfaces. The mesh level is based on the longest side of each surface. Decreasing the patch size 
increases the number of patches and lengthens the calculation time, may increase accuracy. Note: 
Only Patches are used in these Transition surface types, Elements are not included (reflected light is 
not considered). 

Initial Meshing - 
Miscellaneous 

Patch - 0 

Element - 1 

This section specifies which patch and element levels (from the Variable section) to use when 
discretizing poles, pendants and luminaire symbols. 

Luminaire 
Subdivision 

1 This setting allows you to specify the maximum discretization level for luminaires. The default value is 1 
foot. Point sources are not discretized. 

By default, luminaire subdivision occurs based on closest element proximity. If luminaires subdivision is 
forced (see row below), all luminaires are subdivided when applicable regardless of surface geometry. 

Luminaire Subdivision only occurs when there are room and/or object surfaces defined (surfaces must 
be on - not Frozen, Removed or Off in Project Manager). 

Force Luminaire 
Subdivision 

Off 
This setting forces luminaire to subdivide to specified size regardless of surface proximity. Subdivision 
occurs along and across the luminous box producing a rectangular array of sources. 

The absolute maximum number of subdivisions for each luminaire is 16 in each direction regardless of 
specified size, this results in a maximum of 256 sources (16x16). For example, if the Luminaire 
Subdivision value were set to 0.1, a four foot by one foot luminaire would only be subdivided into 0.25 
foot pieces (4/16). The subdivision level applied along the maximum dimension is also applied to the 
opposite dimension so that a point source summarizing a box is created. 

Luminaire Subdivision only occurs when there are room and/or object surfaces defined (surfaces must 
be on - not Frozen, Removed or Off in Project Manager). 

This option should be used with caution, as forcing luminaire subdivision will increase calculation time 
particularly when raytracing direct illumination. Luminaire subdivision increases the number of 
luminaires,which increases calculation time. 

Secondary 
Sources: 
Threshold 

Off 
Secondary light sources (secondary sources) reduce the occurrence of surface mottling which can 
occur by light emitted from bright patches to small elements. 

Secondary sources are disabled by default. When enabled, secondary sources are ‘activated’ only if 
both of the following situations occur: 

� One or more patches in the environment emit a Threshold value of the Total or Average Luminous 
Flux in the environment. The default threshold value is 0.01 (or 1%). If the threshold value if too high 
(e.g. 0.1), none of the patches will be enabled as secondary sources. If the threshold value is set too 
low (e.g. 0.0001), too many patches will be considered as secondary sources which would have an 
adverse affect on calculation time. As a general rule of thumb, threshold value should never be 
increased, it may be necessary to decrease the threshold value to achieve optimum results. 

� There are elements receiving light from these patches that are small enough to require ray tracing 
when the radiosity step is calculated. Small elements are encountered if the elements are quite a 
distance from the patch or the elements were created by adaptive subdivision. As a rule of thumb, the 
projected area of the element must be less than approximately 0.5 degree for ray tracing to occur. 

When these conditions exists, the first bounce of light from the patches that meet these requirements 
will be ray traced to the elements, instead of being calculated by radiosity algorithms. Ray tracing 
secondary sources can increase calculation times significantly, as the number of steps increases; 
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however, the visual results are more aesthetically appealing and smoother than mottled surfaces. 

Each additional secondary source ray trace will add an additional step to the total radiosity calculations. 
Users can tell if a secondary source calculation occurred by comparing the number of steps in the 
Calculation Summary dialog with and without secondary sources enabled. 

� For non-daylight environments (interior and exterior), Average Luminous Flux is approximated by 
taking the total amount of light (luminous flux) emitted by the luminaires divided by the total number 
of luminaires. 

� For daylight environments (interior and exterior), the Total Interior Luminous Flux or Total Exterior 
Luminous Flux is used. 

These situations may require a necessary decrease in the Secondary Sources Threshold value 

� A small patch of daylight is present in an interior simulation and the patches caused by electric light 
sources are not being used as secondary sources (because the daylight patch increases interior flux 
so high that electric light sources are not considered as secondary sources). 

� Significant surface mottling is still observed with tight adaptive subdivision settings. 
� Electric light sources are not emitting the same flux values and secondary source considerations are 

required of lower flux emitting luminaires (e.g. gelled sources or lower lamp wattages). 

Note: Secondary Sources are also applied to Direct Flux Only surfaces when enabled, except for 
Roadway pavement surfaces. To utilize a Direct Flux Only surface as only considering Direct Flux, 
Secondary Sources must be disabled. 

Smart Meshing On This setting specifies how surfaces with Automatic Placement calculation points are meshed. Surfaces 
with Automatic Placement points are meshed finer than surfaces without points. Note: Only General 
Surface Types respond to Smart Meshing. 

Coplanar Polygon 
Merging 

On Coplanar Polygon Meshing is the process where surfaces that lie in the same plane, in the same object, 
with the same properties are 'merged' into a single surface. This reduces the number of surfaces and 
minimizes shading discontinuities between adjacent surfaces. This process may process undesirable or 
unexpected results when the merged surfaces have different initial mesh properties (resultant mesh 
may be less than expected). If the occurs, simply disable coplanar polygon merging. 

Computer Monitor 
Gamma Factor 

2.2 
The Gamma Factor adjusts for the non-linearity of phosphor excitation in computer monitors. A 
computer monitor displays colors by exciting phosphors on the screen. Since phosphors are not excited 
linearly, when the computer reads a luminance value from the rendered image and sends it directly to 
the monitor the displayed luminance will be less than the calculated luminance. The actual Gamma 
Factor varies between makes and models of monitors but in general, a value of 2.2 is used. 

Reset Defaults- This button resets all the advanced variables to the factory provided settings. 

Save Settings As Startup Defaults - If the Save Settings As Startup Defaults selection box is checked, the current advanced settings will be used 
for new job files. Otherwise, the settings only apply to the current job file.  

Update Light 

The update light informs the user whether their lighting layout information (Statistical Areas, LPD Areas, etc.) is current. If the update light is green, 
the lighting layout is current, and the statistical data is up to date. When the update light is red, some statistical data has changed. 

 Clicking on the Update Light on the Status Bar will redraw the graphics window and update the job file. Similarly, redrawing the view (or views) will 
update the job file and turn the Update Light green. 

Green Update 
Light 

Red Update Light 
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Digitizers 

Digitizer - Concepts 

Moving a drawing on the digitizer surface 

Users of large format digitizer tablets (24x36 or greater active area) will not generally require a drawing be moved to complete the digitizing process. 
However, users of smaller tablets will find it necessary to move the drawing perhaps more than once to complete the task. Moving a drawing requires 
the digitizer to be reinitialized using the following process. 

• Mark and note coordinates of a point that will be in the lower left corner of the active surface once the drawing is moved. Draw a straight line 
through the point parallel with the X-axis. 

• Move the drawing such that the undigitized area is now on top of the digitizers active surface. 

• Select the Digitizer command in AGi32 and click on your choice of initialization methods. Method 2 is usually the easiest. Enter the coordinates 
of the point described in item 1. 

• Proceed to digitize in the new area. 

Digitizer driver technical description 

Communication protocols desired by AGi32 are described below for each driver. If your digitizer table is not listed here, it can most likely 
communicate via an emulation to one of the modes supported. The most popular digitizer emulations are "GTCO DP5" and "Summagraphics 
(Summa) Microgrid". 

All tablets communicate with AGi32 in Stream mode, high resolution packed binary. Abbreviations for resolution are English as follows: 

• PPI=point per inch  

• LPI=lines per inch 

Tablet Baud rate Data bits Stop bits Parity Resolution 

Calcomp 2300 9600 8 2 None 1000 PPI 

Calcomp 2500 9600 8 2 None 1000 PPI 

Calcomp 9100 9600 8 2 None 500 PPI 

GTCO DigiPad 5 9600 8 2 None 1000 PPI 

Kurta Is-1 9600 8 2 None 1000 PPI 

Kurta Is-3 9600 8 2 None 1000 PPI 

Kurta XLC 9600 8 2 None 500 PPI 

Numonics Gridmastr 9600 8 1 None 1000 PPI 

Numonics 2200 9600 8 2 None 1000 PPI 

Summa LCL 9600 7 2 Even 1000 LPI 

Summa Microgrid 9600 7 2 Even 1000 LPI 



AGi32 Help System  AGi32 Tools 

424 

 

Summa-sketch 9600 8 1 None 500 PPI 

Using A Digitizer 

AGi32 allows data to be traced from a paper drawing using a digitizer tablet. While this method is not as simple as importing drawing data to AGi32 
electronically, it does allow users in possession of only a paper drawing to construct background information. AGi32 contains drivers for most popular 
digitizer models communicating with binary data transmission. Models using strictly ASCII formats are not compatible with AGi32. The list of digitizer 
drivers contained in AGi32 can be found in the Digitizer Concepts. 

Before any digitizer tablet can be used with AGi32 it must be correctly configured. Hardware configurations involve setting the proper communication 
parameters in order for the tablet to converse with the AGi32 software drivers. Most modern digitizer tablets can be configured using software 
provided by the tablet manufacturer, however, older models may require a physical setting of dip switches. Communication parameters expected by 
the AGi32 drivers are listed at the end of this topic. 

Once your digitizer hardware has been correctly configured to communicate with one of the AGi32 software drivers, getting your digitizer working is 
quick and easy. Any failure of the tablet to communicate with the AGi32 software at this point will generally mean the hardware configuration process 
is not correct. 

Once the drawing is located, the digitizer is active and can be used to carry out any command in the graphics window, AFTER that command has 
been selected using the mouse. The digitizer cursor remains active continuously and simultaneously with your mouse and both pointers are used 
interchangeably. However, be aware the digitizer cursor is active only in the graphics area and can not be used to select a command or click on a 
button. All commands must be selected using the mouse. Once a command is active you can carry it out using the digitizer. 

The digitizer button will appear depressed when the digitizer command is active and unpressed when the digitizer is off. 

What do you want to do? 

Configure a digitizer 

Initialize the digitizer for a particular drawing 

Configuring A Digitizer 

The first time the Digitizer window is accessed the Configure tab will be in front. The Configure tab contains AGi32's software driver selection, 
communication port setting (COM) and active testing procedure. Begin by selecting the appropriate digitizer driver from the pull-down menu next to 
Driver name. Once selected it should show in the window. Continue to select the communication port to which you have connected the digitizer. The 
Connection menu will show only COM ports available on your system. 

Testing your connection 

With the driver and COM port selected you are ready to begin testing your selections. Begin the test by clicking on the "Start Test" button. If your 
digitizer is correctly configured the testing procedure will display the X & Y coordinate values of the cursor position in inches (regardless of units 
setting) as measured from the lower left corner of the digitizers active surface. The lower left corner of the active area will be X=0, Y=0. The upper 
right corner will be the total active area of the digitizer; for example a 36x24 inch tablet will display X=36, Y=24. The coordinate display is automatic 
and does not require you to press a button on the cursor. 

In addition to the coordinate display the test will display the button number of each button depressed on the digitizers cursor. AGi32 uses buttons 1 
through 4 so be sure to identify their location on your cursor. 

1. With your digitizer tablet on, from the Tools menu choose Digitizer. 
2. The very first time the Digitizer dialog is accessed the Configure tab will be shown. Select the appropriate digitizer driver name from the Driver 

Name list box. 
3. Select the communications port that your digitizer is connected to from the Connection list box. Only available COM ports will appear. 
4. Begin testing your connection by clicking the Start Test button. If your digitizer is correctly configured, the testing procedure will display the X & 

Y coordinate values of the cursor position in inches, regardless of units setting, as measured from the lower left corner of the digitizer's active 
surface. In addition to the coordinate display, the test will display the button number of each button depressed on the digitizer's cursor, AGi32 
uses buttons 1 through 4 . 

5. Press the Stop Test button to end the testing procedure. 
6. Click Ok. 
7. Once the digitizer is successfully configured, the Locate tab will be shown in the Digitizer dialog. 

If the Digitizer Test fails: 

The table below discusses the most likely causes and solutions to a failed digitizer test. 
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Test Result Cause/Solution 

Test does not display X & Y coordinate values. Your digitizers' hardware configuration does not match the 
communication settings expected by the AGi32 driver. Double check the 

hardware setup is in accordance with the AGi32 driver. See driver 
technical descriptions later in this topic. 

Message displayed: Selected COM port currently active. COM port is already in use by another device. 

    

X & Y coordinate values do not correspond to the size of the tables 
active area. 

The resolution setting of the tablet and that expected by the driver do 
not match. Change resolution in tablet hardware settings to match 

driver. 

Initializing The Digitizer 

The Locate tab is used to initialize the digitizer with respect to a particular paper drawing. AGi32 offers three methods of initialization. The method 
you will choose will depend on the drawing information and your own personal preference. 

1. With your digitizer tablet on, from the Tools menu choose Digitizer. 
2. Select a method by which to locate the drawing and its scale by clicking on the appropriate radio button: 

Method 1 

To use Method 1 you must know the exact coordinate values of two diagonally opposed points on the paper drawing. These points should 
approximate the lower left and upper right corners of the drawing. Generally, the lower left point can be the origin (0,0) and the upper right point can 
be scaled if you know the scale of the drawing. The drawing does not need to be square on the digitizer surface. The only requirement is that the 
lower left point be below and to the left of the upper right point. 

1. In the Method section select the radio button adjacent to Method 1. 
2. In the Required Input section, enter the X and Y coordinates of the lower left hand corner of the drawing and the X and Y coordinates of the 

upper right hand corner of the drawing. 
3. Click the Start button. 
4. Digitize the lower left-hand corner (the origin) of the drawing. 
5. Digitize the upper right hand corner of the drawing. 

 

Method 2 

Method 2 is the easiest way to initialize a drawing when the drawing scale is known. Method 2 requires that you locate a single point, usually the 
origin, followed by a second point along the X-axis. The second point is used as an alignment point and is assumed to have the same Y-coordinate 
as the first digitized point. The drawing scale is entered from the keyboard. 

1. In the Method section select the radio button adjacent to Method 2. 
2. In the Required Input section, enter the X and Y coordinates of the lower left hand corner of the drawing and the drawing scale. 
3. Click the Start button. 
4. Digitize the lower left-hand corner (the origin) of the drawing. 
5. Digitize the lower right hand corner of the drawing (an alignment point along the X-axis). 
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Method 3 

Method 3 is used when the scale of the paper drawing is not known such as in the case of an enlargement or reduction. To use method 3 you must 
know some dimension on the drawing. This can be the width of a parking stall or length of a wall or any other dimension that can be used to size the 
drawing. 

The Method 3 Initialization begins by locating the origin (0,0) followed by an alignment point anywhere on the X-axis. To scale the drawing you will 
then digitize the beginning and ending points of the known dimension. The actual dimension length is entered from the keyboard. 

1. In the Method section select the radio button adjacent to Method 3. 
2. In the Required Input section, enter the X and Y coordinates of the lower left hand corner of the drawing and the actual dimension length. 
3. Click the Start button. 
4. Digitize the lower left-hand corner (the origin) of the drawing. 
5. Digitize the lower right hand corner of the drawing (an alignment point along the X-axis). 
6. Digitize the first point of the known dimension. 
7. Digitize the second point of the known dimension. 

 

3. Enter the Required Input as dictated by the selected method before clicking on the Start button. 
4. Click the Start button and follow the instructions that appear on the bottom of the Locate Drawing tab. They will prompt you to input information 

using the digitizer tablet and your paper drawing. 
5. Click Ok.  

Digitizer Buttons 

AGi32 uses buttons one through four on the digitizer cursor. If you are not sure how your digitizer buttons are numerically assigned you can check 
this by using the digitizer test found under the Configure tab of the AGi32 digitizer command. The illustration below shows a common four-button 
cursor configuration. The AGi32 functions assigned to each button number will always be the same regardless of the position of the buttons. 

 

 

Button 1 – Primary pick button: similar to the left mouse button. 

Button 2 – Invokes the Enter command or re-invokes the last command: similar to the 
right mouse button 

Button 3 – Undoes the last command or action 

Button 4 – Invokes the Arc command when the Line command is active. 

Digitizer Active Surface 

The lower left corner of the active area will be X=0, Y=0. The upper right corner will be the total active area of the digitizer; for example a 36x32 inch 
tablet will display X=36, Y=32. The coordinate display is automatic as you move the cursor across the tablet and does not require you to press a 
button on the cursor.
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 Rendering 

Rendering Overview 

AGI32’s Render mode allows you to view and manipulate a three dimensional model of your job file. If you added and calculated any calculation 
points in AGI32’s Model mode, the model will already be rendered when you enter the Render mode. If you have not calculated prior to entering 
Render, you will be presented with a wireframe view that needs to be rendered. 

AGi32 uses Radiosity calculations in concert with computer graphics functionality to create synthetic environments, both interior and exterior ones 
that are photometrically accurate. This methodology allows for subtle effects that add realism to the environment, such as shadow effects and color 
bleeding. 

All reflective entities within the environment participate in the Radiosity solution, including luminaires, pendants and poles. This means that a 
luminaire, whether switched on or off, will shadow other surfaces around it as do poles and pendants. 

Within Render mode, you may create multiple Render views, each with its own perspective, which may be used as an Imageport image in Page 
Builder. 

The Common toolbar provides preset views (top, bottom, primary elevations, and perspective views) in addition to interactive tools that allow you to 
view the model from any angle. 

The Viewpoints toolbar provides animation and playback capabilities. 

You may Toggle Model mode entities on top of the rendered environment with the Toggle Model Overlay command on the Status Bar. This allows 
you to create highly informative composite images where you can combine numeric and graphical results for presentation. 

 From the Control Bar select the Render tab .  

   

Default Views - Concepts 

AGi32 provides ten predefined views for your use with any rendered environment. The display extents of the environment are used to display the 
entire environment each time a default view is selected. 

Default View Summary 

The following table lists the Eye and Focus positions of all default views. 

Default 
View 

Eye Position Focus Position Comments 

Front X = Center of Display Extents 
in X direction 

Y = Set distance from 
minimum Y 

Z = Center of display extents 
in Z direction 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Default view for all new views 

Parallel to X axis looking at the center of display extents. 
(Looking North in AGi32 world coordinates) 

Back X = Center of Display Extents 
in X direction 

Y = Set distance from 
maximum Y 

Z = Center of display extents 
in Z direction 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Parallel to X axis looking at the center of display extents. 
(Looking South in AGi32 world coordinates) 

Left X = Set distance from 
minimum X 

Y = Center of Display Extents 
in Y direction 

Z = Center of display extents 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Parallel to Y axis looking at the center of display extents. 
(Looking East in AGi32 world coordinates) 
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in Z direction 

Right X = Set distance from 
maximum X 

Y = Center of Display Extents 
in Y direction 

Z = Center of display extents 
in Z direction 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Parallel to Y axis looking at the center of display extents. 
(Looking West in AGi32 world coordinates) 

Top X = Center of display extents 
in X direction 

Y = Center of Display Extents 
in Y direction 

Z = Set distance from 
maximum Z 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Parallel to Z axis looking at the center of display extents. 

Bottom X = Center of display extents 
in X direction 

Y = Center of Display Extents 
in Y direction 

Z = Set distance from 
minimum Z 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Parallel to Z axis looking at the center of display extents. 

South 
East 

X = Maximum X + Display 
Extents in X Direction/2 

Y = Set distance from 
minimum Y 

Z = Maximum Z 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Set back from the South East corner of the display (at the top of 
the display extents in the Z direction) looking at the center of 
display extents. 

South 
West 

X = Minimum X - Display 
Extents in X Direction/2 

Y = Set distance from 
minimum Y 

Z = Maximum Z 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Set back from the South West corner of the display (at the top of 
the display extents in the Z direction) looking at the center of 
display extents. 

North 
East 

X = Maximum X + Display 
Extents in X Direction/2 

Y = Set distance from 
maximum Y 

Z = Maximum Z 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Set back from the North East corner of the display (at the top of 
the display extents in the Z direction) looking at the center of 
display extents. 

North 
West 

X = Minimum X - Display 
Extents in X Direction/2 

Y = Set distance from 
maximum Y 

Z = Maximum Z 

Center of Display 
Extents in all 
directions (X, Y 
and Z) 

Set back from the North West corner of the display (at the top of 
the display extents in the Z direction) looking at the center of 
display extents. 

 

Graphic Examples 

Icon View Name Comments 

 
Front 

 

The Front view is used as the default view for all new Views. The 
view presents a one point perspective of the environment looking 
at the front (South) elevation of the image. The View is taken 
parallel to the X axis and at a fixed distance from the minimum Y 
coordinate. The focus point is placed at the center of the image. 

 
Back 

 

The Back view presents a one point perspective of the 
environment looking at the back (North) elevation of the image. 
The View is taken parallel to the X axis and at a fixed distance 
from the maximum Y coordinate. The focus point is placed at the 
center of the image. 
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Left 

 

The Left view presents a one point perspective of the 
environment looking at the left (West) elevation of the image. The 
View is taken parallel to the Y axis and at a fixed distance from 
the minimum Y coordinate. The focus point is placed at the 
center of the image. 

 
Right 

 

The Right view presents a one point perspective of the 
environment looking at the right (East) elevation of the image. 
The View is taken parallel to the Y axis and at a fixed distance 
from the maximum Y coordinate. The focus point is placed at the 
center of the image. 

 
Top 

 

The Top view presents a one point perspective of the 
environment looking at a plan view of the image. The View is 
taken perpendicular to the Z axis and at a fixed distance from the 
maximum Z coordinate. The focus point is placed at the center of 
the image. 

 
Bottom 

 

The Bottom view presents a one point perspective of the 
environment looking up from the bottom of the image. The View 
is taken perpendicular to the Z axis and at a fixed distance from 
the minimum Z coordinate. The focus point is placed at the 
center of the image. 

 
North 
East 

 

The North East view presents a two point perspective of the 
environment looking from the North East corner towards the 
center of the image. 

 
North 
West 

 

The North West view presents a two point perspective of the 
environment looking from the North West corner towards the 
center of the image. 
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South 
East 

 

The South East view presents a two point perspective of the 
environment looking from the South East corner towards the 
center of the image. 

 
South 
West 

 

The South West view presents a two point perspective of the 
environment looking from the South West corner towards the 
center of the image. 

  

Default Views 

The Common toolbar provides several default views for your use. These predefined viewing angles provide the ability to look at the image from 
virtually any common viewpoint quickly and easily. Some of the views look at the model from an orthogonal viewpoint (Front, Back, Left, Right, Top 
and Bottom) and some present the view from a corner (Southwest, Southeast, Northwest and Northeast). 

When a default view is selected, the current view is replaced using all of the settings of the default view. In other words, if you applied a Clipping 
Plane to the image (or any other Interactive View commands) prior to selecting a default view, its effects are no longer considered when the default 
view is applied. 

Before the selected view is displayed, the display extents of the environment are calculated so that the entire environment is displayed in the View 
window. The display extents correlate to a box (parallel to the X, Y and Z axes) that encompass the entire image. 

The default views use the perspective projection technique. Each of the default views is taken by locating the observer at a fixed point and focusing 
the eye at another fixed point, which correlates to the center of the model. 

Interactive Commands  

Interactive View Commands 

Interactive commands allow you interactively alter various view parameters. If multiple views are open, the commands only effect the active view, you 
can activate a view by clicking the view. Only one view can be active at a time. 

As a visual clue, the mouse pointer will change to a camera when an interactive command is active. Imagine you are an observer holding a camera 
looking at an image. You can move your position (eye position), point the camera somewhere (focus position), or increase/decrease the camera focal 
length (zoom). 

You may interact with the model in one of two ways: with the mouse or with the arrow keys on the numeric pad on your keyboard. The keyboard 
offers more precise movement in the primary left/right and up/down directions. When using the mouse, you need to drag the mouse in a particular 
direction to activate the command action. To drag the mouse, click and hold down the left mouse button and move the mouse left and right and/or up 
and down. The Interactive command will provide continuous movement until the mouse button is released. Similar movements can be obtained by 
using the arrow keys on your keyboard (e.g., right arrow = drag right). 

Accelerator Keys 

There are special keys available when using the arrow keys that speed up or slow down the default speed of the movement. If you press and hold 
down the Shift key, subsequent arrow key movements will be accelerated (faster). If you press and hold down the Ctrl and Shift keys, subsequent 
arrow key movements will be decelerated (slower). 

What do you want to do? 

Use the Dolly command 

Use the Orbit command 
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Use the Walk command 

Use the Pan command 

Use the Rotate command 

Use the Zoom command 

Use the Clip command 

Interactive Clip Command 

The Clip command cuts away the front plane of the image continuously to reveal the objects within and beyond. The size of the image does not 
increase or decrease. This command is very useful when viewing an image with exterior and interior components (e.g., interior and site lighting). The 
clip distance specifies how far away from the eye position the image will be truncated. 

 

 

1. From the View menu, select Interactive - Clip, or from the Common toolbar select . 
2. The cursor will change to a camera to indicate interactive mode. 
3. Drag (left click and hold) up, or arrow up, to clip in (clip distance increases). 
4. Drag (left click and hold) down, or arrow down, to clip out (clip distance decreases).  

Interactive Dolly Command 

The Dolly command moves the observer and the focus point in and out of the model along a straight line. Depending on the view direction, from the 
observer’s point of view, this feature allows you to “walk” into and out of the space. 
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1. From the View menu, select Interactive - Dolly, or from the Common toolbar select . 
2. The cursor will change to a camera to indicate interactive mode. 
3. Drag (left click and hold) up, or arrow up, to dolly in the image. 
4. Drag (left click and hold) down, or arrow down, to dolly out of the image. 

Interactive Orbit Command 

The Orbit command moves the observer around the model while maintaining the same focus point. Imagine that you are a spaceship orbiting the 
earth, always looking at the center of the earth. 

 

1. From the View menu, select Interactive - Orbit, or from the Common toolbar select . 
2. The cursor will change to a camera to indicate interactive mode. 
3. Drag (left click and hold) up or down, or arrow up or down, to orbit up and down. 
4. Drag (left click and hold) left or right, or arrow left or right, to orbit left or right. 

Interactive Walk Command 

The Walk command combines the Dolly, Pan and Rotate commands into one movement. Dragging the mouse up/down moves the observer forward 
and backward. Dragging the mouse left/right, rotates the observer view position left and right. Using the Shift and Ctrl keys in conjunction with 
dragging or the arrow keys invokes the Rotate and Pan commands as well. 

Cursor 
Movement 

Action 

Left/Right Rotate Left/Right 

Up/Down Dolly In/Out 

Shift-Left/Right Rotate Left/Right 

Shift-Up/Down Rotate Up/Down 

Ctrl-Left/Right Pan Left/Right 

Ctrl-Up/Down Pan Up/Down 

1. From the View menu, select Interactive - Walk, or from the Common toolbar select . 
2. The cursor will change to a camera to indicate interactive mode. 
3. Drag (left click and hold) up, or arrow up, to walk in. 
4. Drag (left click and hold) down, or arrow down, to walk out. 
5. Drag (left click and hold) left, or arrow left, to rotate eye position to the left. 
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6. Drag (left click and hold) right, or arrow right, to rotate eye position to the right. 

Interactive Pan Command 

The Pan command moves the observer and focus point relative to a fixed model position. Imagine that you are looking straight ahead and moving 
laterally left/right or up/down. The image will move opposite to the panning direction. 

 

1. From the View menu, select Interactive - Pan, or from the Common toolbar select . 
2. The cursor will change to a camera to indicate interactive mode. 
3. Drag (left click and hold) up or down, or arrow up or down, to pan up and down. 
4. Drag (left click and hold) left or right, or arrow left or right, to pan left or right.  

Interactive Rotate Command 

The Rotate command allows the observer to look left or right and up or down from a fixed position. Use this command when you are in a space and 
want to look at different surfaces without changing position. A panorama view is obtained by moving constantly to the left or right. 

 

1. From the View menu, select Interactive - Rotate, or from the Common toolbar select . 
2. The cursor will change to a camera to indicate interactive mode. 
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3. Drag (left click and hold) up or down, or arrow up or down, to rotate the focus position up or down. 
4. Drag (left click and hold) left or right, or arrow left or right, to rotate the focus position left or right.  

Interactive Zoom Command 

The Zoom command is similar to the Zoom In and Zoom Out commands in AGi32’s Model Mode, with the difference being that the image size is 
continuously increased or decreased as the mouse is held down and dragged. 

 

1. From the View menu, select Interactive - Zoom, or from the Common toolbar select . 
2. The cursor will change to a camera to indicate interactive mode. 
3. Drag (left click and hold) up, or arrow up, to increase the image size, increasing the viewing angle. 
4. Drag (left click and hold) down, or arrow down, to decrease the image size, decreasing the viewing angle.  

Render View Manager - Concepts 

When Render mode is first accessed, only one view is visible on the screen. The Render View Manager command allows you to create multiple 
rendered views that are displayed on the screen simultaneously. Once created each view may be resized and moved if desired. 

The Render View Manager dialog provides the ability to create and manage view windows within Render mode. Within Render View Manager, you 
can easily add or delete a view and tile or cascade the display. 

Both the Render View Manager and the View Manager in Model mode share the same database of names, so be sure to specify a unique name for 
each view in each mode. 

Working with multiple views 

Working with multiple view windows on the screen is simple and powerful. You can display the views exactly as you like and move between them 
with a single mouse click. Setting up multiple Render views also allows you to display several render images in Page Builder. 

The Tiled option arranges the views so that they are all visible on the 
desktop at once. This option requires that each view be resized 
according to the total number of views displayed at one time. For 
example, if three views are tiled, each view will be resized to one-third 
the original size. 
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The Cascade option decreases the original view just slightly and 
overlaps the selected views on top of each other. Only one view is 
clearly visible at any one time unless the views are moved or resized. 

 

View windows can be custom sized by clicking and dragging the borders of the View window. View windows can also be Maximized and Minimized 
using the standard controls in the upper right corner of each view window. 

  

Render View Manager 

The Render View Manager command provides the same functionality that the View Manager command affords in AGI32’s Model mode. It allows you 
to specify multiple views on the Render desktop. View Manager provides your control point for creating and managing View windows. Within View 
Manager you can easily add or delete a View and tile or cascade the display. 

What do you want to do? 

Add a view 

1. From the View menu choose Render View Manager, or from the Common toolbar select . 
2. Add a unique view name in the View Name text box. 
3. Click the Add button. Views are initially displayed using the Front orientation. 
4. Continue in this fashion until all of the desired views have been added. 
5. Highlight the views to be displayed on the desktop. By default, Render will highlight all views. 
6. Click OK. 

Delete a view 

1. From the View menu choose Render View Manager, or from the Common toolbar select . 
2. Select the View Names to be deleted in the Defined Views section. 
3. Click the Delete button. 
4. Highlight which remaining views to display. 
5. Click OK. 

Change the way views are displayed 

1. From the View menu choose Render View Manager, or from the Common toolbar select . 
2. Highlight the views to be displayed on the desktop. 
3. In the View Display section, left click on the radio button adjacent to Tiled or Cascade. 
4. Click OK. 

Note: This setting affects the views displayed in Model mode and Render mode concurrently. In other words, the same settings will be applied to 
both modes whenever multiple views are created. 

   

View Properties - Concepts 

The View Properties dialog has two tabs, General and Interactive, described below. 
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General Tab 

The General tab provides the following options. These parameters may be altered to explicitly create rendered views of your choosing. Each View 
window is controlled separately. 

Background Color - The color used for the background of the render image. By default, background color is white when wire-frame is displayed and 
black when the Radiosity solution is displayed. It may be desirable to alter the background color when printing to minimize the amount of “black” 
printed. 

Camera Parameters - The Camera Parameters section includes camera settings that affect the view regardless of view direction and focus point. 
These settings will remain constant for all Interactive View commands except Interactive Zoom , which temporarily effects the camera lens. 

Projection – This option specifies either perspective (vanishing point) or parallel (orthogonal) projection. All default views use perspective projection. 
Parallel produces an orthogonal type projection, the same as used in AGI32’s graphics window. Scaling factor scales the image relative to the 
display window. 

Clipping Planes - Clipping Planes are applied perpendicular to the view direction vector and are always applied in front of the eye position (i.e. Front 
Distance must be >0). Only entities or portions thereof between these two planes are visible. The remainder are “clipped” from the field of view. Front 
Distance must be >0 and <Back Distance. Front Distance is effected by the Interactive-Clip command. Clipping planes are dynamically calculated 
based on environment extents and eye and focus points. 

 

Field of View - The Field of View is defined as the view angle from the eye position along the view direction vector. The aspect ratio of the image 
determines whether the view angle is applied to the vertical or horizontal direction. The specified view angle is applied to the smaller of the two 
directions. As the view angle increases, the image will appear smaller, whereas smaller view angles will increase the image. View angle is effected 
by the Interactive-Zoom command and must be between 0 and 180 degrees. 

View Parameters - The current eye and focus positions in three-dimensional space (all units are in current display units) are displayed here. These 
positions are effected by Default View and Interactive commands. 

Eye Position - The Eye Position corresponds to the camera position inside or outside of the space. This coordinate pinpoints the camera's endpoint 
on the view direction vector. The Eye Position will change automatically as a function of the Pan, Orbit and Dolly Interactive View commands as the 
observer moves through the environment. The Eye Position uses the current display units of the job file (feet or meters) and relates to the physical 
location of entities as specified in AGi32's Model Mode. Note that Eye Position can also be set in Render Mode by simply entering the height with the 
keyboard. Using this method will set both Eye Position and Focus Position to the same, entered value. 

Focus Position - The Focus Position pinpoints the second endpoint on the view direction vector and indicates the direction of view for the observer. 
In the Interactive Dolly command, the Focus Position moves progressively along the view direction vector as the camera travels forward through the 
space. In the Interactive Pan command, the Focus Position always remains parallel to the Eye Position  as the camera moves left/right and up/down. 
The Interactive Rotate command swivels the camera lens to the specified Focus Position while the Eye Position remains fixed. The Focus Position 
uses the current display units of the job file (feet or meters) and relates to the physical location of entities as specified in AGi32's Model Mode. Note 
that Focus Position can also be set in Render Mode by simply entering the height with the keyboard. Using this method will set both Focus Position 
and Eye Position to the same, entered value. 

Note: You can see the effects of any changes by selecting the ‘Apply’ button. The dialog will disappear momentarily allowing you to see the image. 
Click on the Ok button to make the changes, or click the Cancel button to revert to the original image. 

  

Interactive Tab 

The Interactive tab allows you to adjust the refresh rate for the rendered image and the animation speed as you navigate with the interactive viewing 
commands.Each View window is controlled separately. You may set Default and Alternate values for both Refresh Rate and Animation Speed. 
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Refresh Rate- Sets the rate at which the display is refreshed (similar to frame rate). 

• Faster - Smoother movements with simple environments, slower navigation with complicated environments. Note: Increasing Refresh Rate may 
not have any effect when working with complicated environments or slower computers. Refresh rate is affected directly by how fast the graphics 
data can be displayed on your monitor. 

• Slower - "Jerkier" movements with simple environments, faster navigation with complicated environments. 
• Select a particular Refresh Rate and/or use the Up and Down arrows to select a faster or slower Refresh Rate. 

Animation Speed - Sets the speed of navigation (or animation) as you move the cursor. 

• Faster - More sensitive to cursor movements (faster navigation). 

• Slower - Less sensitive to cursor movements (slower navigation). 
• Select a particular Animation Speed and/or use the Up and Down arrows to select a faster of slower Animation Speed. 

Note:  In the Render Toolkit, you can click the Interactive Display button (or F4 on your keyboard) to easily toggle back and forth between 
your Default and Alternate settings. You can also adjust the Refresh Rate and Animation Speed in the Render Toolkit. Just click the Up or 
Down arrows or enter a value for Refresh Rate and/or Animation Speed. 

   

View Properties 
The View Properties dialog contains information about the current Render view. All settings except for the View Name may be modified. Except for 
the background color, all of the settings are automatically updated from the Interactive View commands. This dialog provides access for you to 
manually change the view and camera parameters. For advanced users, this dialog allows you to enter explicit values directly for each setting. 

 From the View menu choose View Properties, or from the Common toolbar select . 

  

 Display Properties 

Display Properties - Concepts 

The Display Properties dialog sets the global display parameters for all views in Render Mode. This dialog allows you to control how the images are 
displayed and set them up for presentation or analysis purposes. 

Application Examples 

• Preview color choices and texture application before calculating by using the Shaded Display type (and toggling Textures on, if applicable). 

• Create three-dimensional Illuminance or Luminance Pseudocolor images with scale value information for presentations. As an option, the 
Radiosity Wireframe format may be selected, for an alternative,"see-through" way of displaying this information. 

• Compare similar environments with dissimilar lighting designs by applying same Maximum Luminance or Illuminance to both and compare RGB, 
Pseudocolor or Grayscale images. Note that for RGB displays, only luminance can be scaled, by applying a Maximum Luminance value, but the 
actual scale is meaningless with RGB and therefore is not displayed when applying a maximum luminance to an RGB display. 

• Set Exposure for Daylight surfaces (exterior only), Non-Daylight Surfaces (interior, receiving electric light and/or daylight through Daylight 
Transition Surfaces), or All Surfaces. 

• Toggle Model Mode Overlay on/off and select which entities are to be overlaid on top of rendered environment. 

Exposure Setting 

The Exposure Setting in the Analysis tab is used to compensate for the limited contrast ratio of computer displays and the assumed reflectances. 

All rendered environments are assumed to be 18% reflective, per Kodak photographic assumptions. This is clearly not the case for most architectural 
environments. Most interiors tend to be much more reflective, while many exterior surfaces (such as asphalt) will be less reflective. 

In order to compensate for this standard photographic assumption, light colored environments will likely need a higher Exposure setting, while very 
dark environments will likely need a lower Exposure. 

• The average reflectance of all pixels in the environment (regardless of current viewpoint) is calculated and re-calibrated to 18%. This is 
equivalent to an Exposure setting of 0.  

• Most interiors will look more realistic with an exposure of 0.75 - 1.5 (30 - 55% reflective). 
• Most exteriors will look more realistic with an exposure of -1.5 - 0 (7 - 18% reflective). 
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Exposure Correlated Average  

Reflectance (%) 

-8 0.0703125 

-7 0.140625 

-6 0.28125 

-5 0.5625 

-4 1.125 

-3 2.25 

-2 4.5 

-1.5 6.36 

-1 9 

-0.5 12.7 

0 18 

0.5 25.5 

1 36 

1.5 50.9 

2 72 

3 144 

4 288 

5 576 

6 1152 

7 2304 

8 4608 

The Exposure setting may also be adjusted in the Render Toolkit. You may enter a value in the field, or use the up and down arrows to adjust the 
exposure setting. For more on this, click on the Procedures tab at the top of this topic.  

Display Properties 

The Display Properties dialog sets the display parameters for all views in Render Mode. These parameters are divided into Analysis and Model Mode 
Overlay Settings tabs. 

 From the View menu select Display Properties, or from the Common toolbar select . 

Analysis Tab 

The Analysis tab provides display and scaling options. 

Setting Type Default 
Value 

Description 

Analysis 

Display Radiosity Wireframe - This format is the default selection when Render Mode is first initialized unless the calculations 
have been already performed. This format shows the environment wireframe and does not consider lighting 
effects. 

Hidden Wireframe - This format displays the environment wireframe using the surface visibility properties. If 
the surface is invisible in the current view (e.g., single sided) it will not show this wireframe display. This 
display type does not display lighting effects. 

Shaded - This format displays the environment using the selected surface colors. Lighting effects are not 
considered. 

  

Radiosity - This format displays the calculated Radiosity solution. It is only available after calculations have 
been performed. 

Radiosity Wireframe - This format displays the environment wireframe using the surface visibility properties 
like the hidden wireframe format. The results must first be calculated, and the wireframe is displayed using the 
current color format - RGB Color, Grayscale or Pseudocolor. 
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Color RGB Color RGB Color - This option is available for all display types. In the Radiosity and Shaded formats, the colors 
used are those that were originally assigned to each surface. In Wireframe format, all lines are shown using 
black. 

  

Grayscale - This option is only available when the Radiosity or Radiosity Wireframe formats are selected. All 
surface colors are replaced with a corresponding shade of gray thereby producing a grayscale effect. 

  

Pseudocolor - This option is only available when the Radiosity or Radiosity Wireframe formats are selected. 
Each luminance or illuminance value is assigned a unique color value ranging from blue (minimum value) 
through cyan, green and yellow to red (maximum value). This color type allows an alternative way to view the 
luminance or illuminance distribution in the environment easily. NOTE: Scales are only available when 
Exposure=0. 

Metric Luminance This setting determines whether the luminances or illuminances of the surfaces are shown when the Radiosity 
or Radiosity Wireframe display formats are selected. Luminance is shown by default and is available for all 
display color types. Illuminance may be applied when Grayscale and Pseudocolor colors are selected. 

  

Luminance – This option displays the density of luminous flux projected in a given direction off of the 
surfaces. In AGi32, all surfaces are considered to be perfectly diffuse, and the luminance on the surface is the 
same, regardless of viewing direction. 

  

Illuminance – This option displays the density of the luminous flux incident on the surfaces. Illuminance is 
calculated using the luminance and reflectance of the surface. 

Light 
Component 

Direct/Indirect This setting allows the user to select which light component is displayed. Direct/Indirect is displayed by default. 

Direct/Indirect - This option displays both the direct component and the interreflected component of 
illumination for the rendered environment. 

Direct Only - Selecting this option removes the interreflected component of illumination from the rendered 
environment, leaving only the direct component visible. This selection provides a good visual indicator of the 
efficiency of electric lighting and daylighting to effectively illuminate surfaces directly. 

Indirect Only - Selecting this option removes the direct component of illumination from the rendered 
environment, leaving only the interreflected component visible. This selection provides a good visual indicator 
of the efficiency of interreflected light and effectiveness of surface geometry and reflectance, especially for 
daylighting analysis. 

Options 

Textures Setting 
disabled by 
default 

Selecting this option toggles textures on in Shaded and Radiosity Views. Toggling Textures is also available 
from the Status Bar. 

Wireframe 
Overlay 

Setting 
disabled by 
default 

Selecting this option allows you to overlay the wireframe on top of RGB, Pseudocolor or Grayscale color 
displays, to see the underlying element mesh. Wireframe Overlay is also available from the Status Bar. 

RGB, Grayscale and Pseudo Color Scaling 

Scaling Off 

  

Apply linear or power law scaling for luminance or illuminance mapping in the rendered environment. (RGB 
scaling can only be applied to luminance display.) See below for more information. 

Exposure 

Set Exposure 
For 

All Surface 
Types 

Interior surfaces will typically be much less bright than exterior surfaces receiving daylight. AGi32 provides 
three exposure settings, to handle these three categories: All Surfaces Types (default), the interior (Non-
Daylight Surfaces) and exterior (Daylight Surfaces).  

  

All Surface Types - In this setting, the appearance of the exterior and interior environments are set 
separately, enabling both to look appropriate in the same image. (Your camera couldn't do this!). The All 
Surface Types setting works for most environments. 

If the average reflectance of the current environment differs greatly from the assumed 18% value (see 
Concept tab for this topic), the image may appear under- or overexposed. Exposure modification may need to 
be applied to properly display the image. 

Non-Daylight Surfaces - This setting causes the exposure to be appropriate for the less-bright interior 
surfaces, leaving the daylight surfaces to look over-exposed. This option may be useful in environments where 
both non-daylight and daylight surfaces are present and daylight is NOT enabled, or where daylight is enabled 
but the exterior overexposure is not important. 

  

Daylight Surfaces - This setting causes the exposure to be appropriate for the brighter, exterior surfaces, 
leaving the interior surfaces to look comparatively dim, or underexposed. This option may be useful in 
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environments where both non-daylight and daylight surfaces are present, daylight is enabled, and the 
appearance of the exterior is more important than that of the interior. 

Exposure 
Setting 

Note: Exposure 
Setting may 
also be 
adjusted from 
the Render 
Toolkit. 

0 This parameter allows you to override the automatic exposure setting set by AGi32 based on average scene 
luminance. You may increase the screen luminance by increasing the Exposure value and therefore make the 
image ‘brighter’ on the screen. However, changing the Exposure and increasing the visual brightness of the 
environment on the screen does not actually change the calculated luminance values. This allows you to add 
detail to shadows or decrease the overall scene brightness without affecting the actual luminance values or 
the integrity of the calculated point-by-points. The Exposure values may be set from –8 (minimal brightness) to 
8 (maximum brightness) in increments of 0.25. 

Note: When applying a maximum luminance or illuminance value (see Scaling above), the exposure setting 
must be set to 0. 

 

Scaling 

This section allows you to display a graphic luminance or illuminance scale for the rendered environment using the range of values between 
minimum and maximum. You may also specify a constant maximum luminance or illuminance value for Grayscale or Pseudocolor environments, or a 
maximum luminance value for RGB environments, allowing you to compare environments side by side. Once enabled, all surface luminances (or 
illuminances) will be scaled according to the specified value. The value specified should be appropriate for the type of environment considered (i.e., 
exterior vs. interior, commercial vs. industrial, etc.). The exposure setting must be set to zero to use Pseudocolor scaling. 

For example, in a site lighting environment, a maximum illuminance value of 300 footcandles is calculated. This unusually high level of illuminance 
may occur directly below the luminaire on the pole surface itself (it is an object in AGi32 and therefore can receive light), whereas the remainder of 
the site exhibits illuminance of 10 footcandles or less. The range of values is so large in this case, you may only see a hot spot directly on the poles, 
with the site itself appearing very dim. By scaling the maximum illuminance to 10 footcandles, which may be the maximum on the pavement, all 
illuminance values of 10 or higher are mapped to the red range. The remainder of the site will then exhibit a more legible gradient. 

The maximum luminance and illuminance calculated for each environment are displayed in the Render Display Properties dialog. Using these values 
as a guide, you can select an appropriate maximum luminance or illuminance value to use. When enabling this option, the exposure must be set to 
zero. 

NOTE: It is very common for the calculated minimum luminance and illuminance values to be zero. All surfaces (except for luminaire symbols), 
regardless of visibility or reflectance, are considered when calculating these values. Surfaces that receive no light or have zero reflectance will yield 
zero luminance and illuminance values. 

Luminance - The maximum and minimum reflected luminances for the environment as well as the maximum emitted luminance are displayed in 
Candelas/Square Meter, regardless of the current units, for Non-Daylight and Daylight surfaces. The Max Emitted refers to the luminance emitted 
from self-emitting surfaces (specified as having non-zero Luminance in the Surface Edit command). If no self luminous surfaces are present in the 
environment, the Max Emitted luminance value will be zero. 

By clicking the Apply Maximum (Luminance) selection box, you may display a luminance scale to the left of the image. An alternate maximum may 
be entered to scale the environmental luminances, if desired. 

Note :By default, the Apply Maximum setting will be set to the largest luminance value (reflected - non-daylight, reflected - daylight, emitted - non-
daylight, emitted - daylight)  

Illuminance - The maximum and minimum illuminances for the environment are displayed in Footcandles or Lux, based on the current unit type 
specified in System Settings. By clicking the Apply Maximum (Illuminance) selection box, you may display an illuminance scale to the left of the 
image. The Apply Maximum selection box is only available when 
Grayscale or Pseudocolor is chosen for the Radiosity display type. 
An alternate maximum may be entered to scale the environmental 
illuminances, if desired. 

Note :By default, the Apply Maximum setting will be set to the 
largest maximum illuminance value  non-daylight or  daylight)  

Scale Type - This option allows you to choose a linear or power law 
scale to apply to the rendered environment. A linear scale displays 
the values in the range in equal increments. For example, in a linear 
luminance scale with a minimum/maximum range of 0 to 20, one 
quarter up from the minimum would be 5, the midpoint would be 10, 
three quarters up would be 15, etc. 

A power law scale is useful when there is a wide range of values 
displayed in the rendered environment (luminance or illuminance) 
and the values within the lower end of the range need to be 
displayed in detail. Power law expands the lower range of the scale, 
yielding more detail (the smaller values are spread over a larger 
range on the scale). This type of scaling is especially powerful when 
there are a few surfaces in the environment with very high 
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luminances and the remainder contain much lower values (e.g., indirect lighting interiors and site lighting with poles). 

Note that for RGB displays, only luminance can be scaled, by applying a Maximum Luminance value, but the actual scale is meaningless with RGB 
and therefore is not displayed when applying a maximum luminance to an RGB display. 

Display Scale With Image - This option applies a graphical luminance or illuminance scale on the left side of the graphics window. A scale may only 
be displayed when the Apply Maximum selection box is checked. The scale may be applied whether the Maximum value is scaled or not. The scale 
becomes part of the image and is shown when printing or exporting, and is saved for use in Imageports in Page Builder. 

 

Model Mode Overlay Settings Tab 

The Status Bar provides the command Toggle Model Overlay. This command overlays all Model mode entities on top of the current rendered 
environment (e.g., drawing entities, calculation points, Isolines, photometric webs, luminaire templates, etc.). 

Model Mode Overlay is WYSIWYG. All entities are displayed. The Display Properties - Model Mode Overlay Settings tab provides visibility control for 
all related entities. By default, all entities are selected. To hide entities (e.g., to simplify image or speed up display interaction), de-select them in this 
tab. 

The Model Mode Overlay may also be toggled on and off entirely from this tab (Check or Uncheck Model Mode Overlay selection box at top of tab). 

Text Display 

Overlaid text can be displayed using two methodologies: Outlined (Fast) and Filled. The default method is Outlined (Fast), which is recommended for 
everyday use. 

• Outlined (Fast) – Text is displayed as an outline and is visible when viewed from behind (e.g., back side of wall).Outlined text is much less 
graphic intensive and has less effect on display speed and  interactive movement in Render mode. 

• Filled -- Filled Text behaves similarly to single-sided surfaces; it is not visible from the back side of the text. For example: If you have calculation 
points on a wall, the calculated values (text) will not be visible when view from the back side of the wall (in Model mode the text appears upside 
down when viewed from the back side). 

• Filled Text is more graphic intensive and may slow display speed and interactive movement in Render mode. Increasing Hardware 
Acceleration (set using Windows Control Panel - Display) may eliminate or alleviate this issue. Please be aware that Hardware 
Acceleration has been known to cause a multitude of display issues if the display driver is out of date or buggy. 

• Filled Text may be useful for presentation purposes (e.g., image capture, movies, etc.). 

Technical Details 

• Model Mode Overlay is currently not available for ray traced images (e.g., ray trace image, daylight study – ray trace images, movie – ray trace 
images) or VRML files. 

• In order to display text, AGi32  creates font styles for each unique combination of font (font name) and font properties (bold, italic, underline and 
strike-through). Creating font styles can have a significant effect on performance. Therefore, it is recommended to minimize the use of different 
fonts and font properties in Model mode when including text in the overlay. 

• The extents of the display in Render mode may change when the overlay is toggled on and off. To reestablish the view and center the display, 
simply select one of the Default Views. 

• The Model Overlay is recreated each time Render mode is displayed and/or whenever the View Properties in Render mode are changed (e.g., 
adding additional views with View Manager). If you experience significant delays when the overlay is enabled, you may want to consider 
removing some entities from the overlay list. 

• Model Mode Overlay entities do not interact with the environment and are not considered in the calculations. 

Toggle Wireframe Overlay 

The Toggle Wireframe Overlay command overlays the radiosity wireframe on top of the Radiosity or Shaded view. 

The wireframe displays the meshing of the environment surfaces. By analyzing the wireframe overlay, you can analyze how finitely the environment 
is discretized and whether the mesh needs to be further refined. The wireframe mesh can be modified by changing the Initial Meshing Variables in 
Advanced System Settings or by applying adaptive subdivision. 

 From the Status Bar select Toggle Wireframe Overlay . The Wireframe Overlay can also be toggled on or off from the 
Display Properties dialog.   

Toggle Texture Display 

Textures can be toggled On or Off in Render mode. Textures are only visible in Shaded or Radiosity views. If Textures are not applied to any 
surfaces in the environment, this command is not available. 
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 From the Status Bar select Toggle Textures . Textures can also be toggled on or off from the Display Properties dialog.  

Anti-Aliasing - Concepts 

Anti-aliasing improves images by removing the jagged edges observed in the final images. Jagged edges occur because of the inherently square 
shape of each pixel in your display. Lower-resolution images have a higher chance of displaying jagged edges because of their lower pixel count. In 
Render mode, Anti-aliasing is achieved by redrawing the rendered scene a specified number of times, each time jittering the camera by a small 
amount, so that in the final image hard edges are softened by displaying slightly lighter pixels adjacent to the dark ones. The eye is fooled into seeing 
straighter lines and smoother curves (instead of “jaggies”). 

Hint: Always apply Anti-aliasing before exporting images for the best looking results. 

 

No anti-aliasing applied to JPG image 

 

Anti-aliasing Sampling Level 8 applied to JPG image 

The amount that the camera is jittered is determined by the Anti-Aliasing Sampling Level specified on the Status Bar. The levels available are: None, 
 2, 4, 8 and 15. Increasing the Sampling Level will increase the time it takes AGi32 to apply the Anti-aliasing. Determining which level is appropriate 
will depend on your screen resolution and severity of jagged edges in the image. Lower screen resolutions and severe jaggies will demand the 
highest sampling levels. 

In Render mode (Full Radiosity Method), Anti-aliasing can be applied after the radiosity process is complete. Anti-aliasing may be previewed on the 
screen graphically, but this is only a temporary application. Each time you change the view, the original environment is displayed. 

To apply Anti-aliasing permanently to the current view, export the current view as a JPG or BMP format image file. In addition, if Anti-aliasing is 
active (Sample Level > None), Anti-aliasing is applied to all Render views when Render mode is closed (for use in Imageports with Page Builder) 

Hardware Acceleration 

Some graphics cards disable manual Anti-aliasing when Hardware Acceleration is equal to Full. If you are not seeing Anti-aliasing  applied, turn 
down the Hardware Acceleration on your Windows™-Display-Properties-Troubleshooting tab.  

Apply Anti-Aliasing 

This command applies the Anti-Aliasing Sampling Level specified in the Status Bar. If the Sampling Level is set to None (the default level), this 
command is unavailable. Each time the view is changed, Anti-aliasing will need to be reapplied. In addition, if Anti-aliasing is active (Sample Level > 
None), Anti-aliasing is applied to all Render views when Render mode is not shown (for use in Imageports with Page Builder), before exporting as a 
JPG or BMP and before printing the image. 

 From the Status Bar select . The Sampling Level is also changeable here. Each time the level is changed, Anti-
aliasing must be reapplied to see the effect. 
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Toggle Model Overlay 

The Toggle Model Overlay command overlays the Model mode entities to display on top of the Rendered environment. Click on the pull-down arrow 
to change the Settings or use the Display Properties command. Model Overlay uses a WYSIWYG approach (all entities in Model mode are visible by 
default). 

The Display Properties - Model Mode Overlay Settings tab provides visibility control for all related entities. By default, all entities are selected. To 
hide entities (e.g. to simplify image or speed up display interaction), deselect them in this tab. 

 From the Status Bar select Toggle Model Overlay . The Model Overlay can also be toggled on or off from the Display 
Properties dialog.  

 

Exterior rendering without Model Mode Overlay 

 

Exterior rendering with Model Mode Overlay (Luminaire Templates, drawing 
lines) 

  

 

 Viewpoints 

Viewpoints - Concepts 

As you move around the rendered environment, inevitably you come across specific views that are of particular interest or attractiveness. User 
defined Viewpoints may be saved for future recall using slide show or animated playback capabilities. In addition, viewpoint animations may be 
exported into industry standard movie file formats for playback on external players (such as Windows Media player or Apple's Quicktime player). 

Terminology 

• Scene – Continuous action in a single line of motion. 

• Viewpoint – Points of interest and/or direction changes with a scene. 

• Slide Show – The process of playing back the scene by displaying one viewpoint at a time at a set display interval. 

• Animation – The process of making the scene appear to move between viewpoints by the addition of slightly varying views between viewpoints. 

• Movie – The combination of one or scene animations exported into a standard format movie file suitable for playback on a variety of media 
players (e.g. Windows Media Player). 

Adding Viewpoints 

When the View window contains a point of view (the viewpoint) you would like to save, you are ready to create the Viewpoint. The easiest and fastest 
way to capture the current viewpoint is to use the Viewpoint Quick Add command, which is associated with the F2 on the keyboard in Render 
mode. Simply press F2 to capture the current Viewpoint, you can even do so while in an Interactive View command.  
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To capture a series of Viewpoints for a slide Show or animation, capture Viewpoints for every small change in movement or view direction change as 
you are navigating in the environment. 

In the diagram to the right, the blue arrows indicate the 
line of movement for the animation. 

A Viewpoint is captured at the 
beginning and end of each line of 
movement. 

  

  

This three direction arrow 
indicates a view direction 
change (in three parts): 

1. The first Viewpoint 
(the vertical arrow 
pointing down - 1) is 
added at the end of 
the line of motion, 
looking in the same 

direction as the line of motion. 
2. The second viewpoint (the diagonal arrow - 2) is 

added after invoking the Rotate command to look 
45 degrees in the next direction of travel. This is an 
intermediate viewpoint that orients the camera in 
the proper direction. 

3. The third viewpoint (the horizontal arrow - 3) orients 
the camera in the final direction of travel, so the 
camera can move in the desired line of motion. 

 

Tips for creating better animations: 

o Use the following interactive commands when recording viewpoints: Dolly, Pan, 
Rotate, Orbit and Walk. Clip and Zoom should not be used, as these 
commands produce settings that are ignored (Front Clip, Back Clip and Viewing 
Angle) 

o Set a viewpoint with each direction or motion change. Use keystrokes when 
recording viewpoints, whenever possible, for optimal direction control. 

o Stop motion before recording a viewpoint, so that the proper coordinates are 
recorded. 

o When turning completely around (180-degrees), set at least one intermediate 
viewpoint (e.g. set viewpoint at 0-degrees, 90-degrees and 180-degrees) to 
ensure animation proceeds smoothly in one continuous direction. 

o Change the camera's eye position by editing the Eye and Focus Z coordinates 
of the appropriate viewpoints. This allows you to gain a more human 
perspective in tall environments, or change eye position to account for children 
or wheelchair based observers. 

o Extraneous viewpoints may be deleted, or not displayed, to produce smoother, 
smaller (less frames) animations. 

Managing Viewpoints 

The Viewpoints dialog provides your control point for managing scenes, viewpoints, animation settings, slide show display interval and frame rate. 

Current View Properties (Background Color, View Angles and Clipping Planes) are applied during playback. The View Properties present during 
Viewpoint capture are not applied. 

Scenes 

It is not necessary to create a scene before adding Viewpoints. A default scene, named Scene_1, is automatically created and viewpoints are 
automatically added to the default scene. You may rename scenes, delete scenes and create multiple scenes. 

Note: When a scene is deleted, all the viewpoints within the scene are deleted as well. 

 

Viewpoints 
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Viewpoints may be reordered, added, deleted, copied, change in status, and edited in the Viewpoints dialog. 

Animation 

The Walk and Pause times indicate the transition period between specified viewpoints. 

Slide Show Display Interval 

The Slide Show Display Interval indicates how long (in seconds) a viewpoint is displayed when the viewpoints are played back sequentially. 

Frame Rate 

The Frame Rate indicates the number of frames per second (FPS) to use when generating a viewpoint animation. Higher frame rates will result in 
smoother playback. 

Scene Length 

The time (in seconds) it takes to playback the entire scene; a sum of all Walk and Pause intervals. 

Total Number of Frames 

Indicates the total number of frames within the current scene. 

Viewpoints and Ray Tracing 

User Defined Viewpoints may also be used for static Ray Trace image generation. This option, available in the Ray Trace Parameters dialog, allows 
you to Ray Trace all of the user defined Viewpoints at the same time. 

Viewpoints and VRML export 

User defined Viewpoints are automatically added to the VRML file when the VRML format is exported from Render mode. The VRML viewer will 
provide access to the Viewpoints and display them by your specified names. 

Existing Viewpoints (from older versions): 

Viewpoints creating in older version of AGi32 are automatically added to the default scene (‘Scene_1’) and can be modified and played back without 
any additional modification.  

Using Viewpoints 

In Render mode, any viewpoint of interest may be saved by you for future recall. The Viewpoints dialog provides your control point for creating and 
managing your viewpoints and their display order and Interval. Viewpoints may also be animated in Render mode using the Animate Viewpoints 
button on the Common Toolbar and the resulting animations exported as movies for playback using industry standard movie files. 

To create a viewpoint, manipulate the view to display the viewpoint you desire, then use the F2 key to quickly capture the viewpoint and add it to your 
Viewpoint display list. When Viewpoints are added this way, they are automatically assigned the sequential name Render_# (e.g. Render_1, 
Render_2, etc.). You may rename these views at any time in the Viewpoints dialog. 

Once created, you may display the viewpoints individually or sequentially with the Slide Show buttons on the Render Viewpoints Toolbar. 

Viewpoints are saved with the job file and will automatically be included with the VRML file if it is generated. 

Note: The following interactive commands may be used to obtain a View suitable for  Viewpoints within animations: Dolly, Pan, Rotate, Orbit and 
Walk. Clip and Zoom should not be used, and their settings will be ignored, as they do not change the Eye or Focus positions required. Clip and 
Zoom only change the clipping planes and viewing angles, respectively; these settings are not used in animations. 
 

What do you want to do? 

Manage Scenes 

Rename a scene 

Scenes may be renamed within the Viewpoints dialog. Scene names must be unique and contain only valid characters (no * . / \ ?). 

1. From the Viewpoints toolbar select . 
2. If more than one scene is defined, select the scene to be renamed from the Current Scene Name drop down list. 
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3. Click the Rename Scene button . 
4. In the Rename Scene textbox, enter the new scene name, up to 256 characters long. 
5. Click Ok. 

Create multiple scenes 

Multiple scenes creation allows you to playback various lines of motion separately (e.g. walk-through, fly over).  Scene names must be unique and 
contain only valid characters (not * . / \ ?). 

1. From the Viewpoints toolbar select . 

2. Click the Create New Scene button . 
3. In the New Scene textbox, enter the new scene name, up to 256 characters long. 
4. Click Ok. 
5. You may continue adding new scenes in this manner. 

Delete a scene 

Scenes may be deleted within the Viewpoints dialog. When a scene is deleted, all the viewpoints within the scene are deleted as well. 

1. From the Viewpoints toolbar select . 
2. If more than one scene is defined, select the scene to be deleted from the Current Scene Name drop down list. 

3. Click the Delete Scene button . 

Make a scene current 

To add viewpoints to an alternate scene, the scene must first be defined, then selected as current before the viewpoints are added. 

1. On the Viewpoints toolbar, click in the Current Viewpoints Scene drop down list . 
2. Select the Scene name you wish to make current. 

Manage Viewpoints 

Append a viewpoint to the current scene 

To add a viewpoint, the current view must display the viewpoint you wish to store. You may use any of the predefined views to create a viewpoint or 
use the Interactive View commands to create a custom viewpoint. 

Once the Render view displays the viewpoint you wish to save, proceed. 

1. Press the F2 key from the keyboard to apply the Viewpoint Quick Add command which automatically captures the current Viewpoint using an 
automatic naming system. 

2. Repeat as necessary. 

Inserting viewpoint(s) within the current scene 

To insert viewpoints within a scene at a specific location, you must begin within the Viewpoints dialog. You may insert a single additional viewpoint or 
multiple viewpoints in sequential order as desired. 

Viewpoints are dynamically specified after selecting the Insert Viewpoints Above or Below command. Once the views are set, right click to insert the 
viewpoint parameters to the current scene and return to the Viewpoints dialog. 

Note: You must return to the Viewpoints dialog by right clicking (to accept the view) or by pressing the Esc key repeatedly until the Viewpoints dialog 
reappears (to cancel the Insert process). Otherwise all other Render functionality is locked (besides Preset or Interactive View commands) until the 
command is completed. 

1. From the Viewpoints toolbar select . 
2. Select the Viewpoint you wish to use as the current marker (you are choosing to insert a new viewpoint above or below this viewpoint). 

• You can display any viewpoint on the screen by clicking in the Display checkbox within the Viewpoint row. 
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• To select a viewpoint, click on the viewpoint row marker. 

 

3. Select the Insert Viewpoints Above/Below command (  ) from the Viewpoints dialog or from the Viewpoints menu (right-click on the 
selected viewpoint row marker to display the secondary menu). 

4. Control will return to the environment allowing you to navigate to the desired view. Note: The following interactive commands may be used to 
change the View parameters: Dolly, Pan, Rotate, Orbit and Walk. Clip and Zoom should not be used, and their settings will be ignored, as they 
do not change the Eye or Focus positions required. Clip and Zoom only change the clipping planes and viewing angles, respectively; these 
settings are not used in animations. 

5. Once the view is obtained, right click to confirm your selection. You will return to the Viewpoints dialog with the current view inserted in the 
desired location. The inserted views are labeled Insert_1,etc. 

6. To cancel the insert process and return to the Viewpoints dialog without specifying viewpoints, press the ESC repeatedly until the Viewpoints 
dialog appears. 

Reorder the Viewpoint display order 

To reorder a viewpoint, highlight the Viewpoint row in the Viewpoints dialog then select Move Up or Move down from the secondary menu. 

1. From the Viewpoints toolbar select . 
2. Highlight the desired Viewpoint row by clicking on the row marker in the Viewpoints list. 

 

3. Right click to display the secondary menu or use the Move Up/Move Down buttons (  )in the Viewpoints dialog. Move Up moves the 
Viewpoint up in the list, Move Down moves the Viewpoint down in the list. 

 

Rename a Viewpoint 

To rename a viewpoint, highlight it in the Viewpoints dialog then click on it again. 

1. From the Viewpoints toolbar select . 
2. Highlight the desired Viewpoint name in the Viewpoints Label column. 
3. Left click on the Viewpoint name again to rename it directly in the highlighted area. 
4. Rename the Viewpoint, then press ENTER or move to another cell to complete the process. 

Copy viewpoints 

To copy a single viewpoint, highlight the viewpoint to be copied in the Viewpoints dialog and select the Copy Viewpoint Above or Below command. 
Only single Viewpoints may be copied, if multiple Viewpoints are selected, only the first is copied. 

1. From the Viewpoints toolbar select . 
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2. Highlight the desired Viewpoint by selecting the Viewpoint Row Marker 

 

3. Select the Copy Viewpoint Above/Below command (  ) from the Viewpoints dialog or from the Viewpoints menu (right-click on the 
selected viewpoint row marker to display the secondary menu). 

4. The selected Viewpoint will be copied to the specified location. 
5. Click Ok. 

Move viewpoints 

To move a single viewpoint, highlight the viewpoint to be moved in the Viewpoints dialog and select the Move Viewpoint Up or Down command. Only 
single Viewpoints may be moved, if multiple Viewpoints are selected, only the last is moved. 

1. From the Viewpoints toolbar select . 
2. Highlight the desired Viewpoint by selecting the Viewpoint Row Marker 

 

3. Select the Move Viewpoint Up/Down command (  ) from the Viewpoints dialog or from the Viewpoints menu (right-click on the selected 
viewpoint row marker to display the secondary menu). 

4. The selected Viewpoint will be copied to the specified location. 
5. Click Ok. 

Delete viewpoints 

To delete a viewpoint, highlight it in the Viewpoints dialog and click the Delete button. You may delete multiple viewpoints at the same time by using 
Windows selection methods (Shift+Click selects adjacent rows, Ctrl+Click selects individual rows). 

1. From the Viewpoints toolbar select . 
2. Highlight the desired Viewpoints by selecting the Viewpoint Row Markers 

 

3. There are three methods provided for deleting viewpoints: 
i. Press the Delete key on your keyboard. 

ii. Click the Delete button  in the Viewpoints dialog. 
iii. Right click on the Row Marker to display the secondary Viewpoints menu - select Delete. 

4. The selected Viewpoints will be deleted. 
5. Click Ok. 

Turn off a viewpoint within a scene 
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Turning off a viewpoint allows you to remove viewpoints from the animation or slide show playback without requiring the viewpoint to be deleted. 

1. From the Viewpoints toolbar select . 
2. Use the Viewpoint Status checkbox to turn a viewpoint on or off. 

Viewpoint Playback 

Animate your viewpoints 

Viewpoints may be animated from within the Viewpoints dialog or directly in Render mode from the Viewpoint toolbar. Animation playback always 
begins with the first viewpoint and loops through all the viewpoints in sequential order until the animation is stopped. 

Animations are created by creating additional varying views between the specified viewpoints. The additional views added in between viewpoints is a 
function of Frame Rate and Walk interval. 

For example, at a Frame Rate of 15fps, it would require 30 frames to move between 2 viewpoints with a 2 second Walk interval. 

Frame Rate is defined as the number of frames per second (fps) used to generate the animation. Higher frame rates will result in smoother playback 
but also much larger movie files (when the movie is exported). The Frame Rate specified in the Viewpoints dialog is not necessarily applied when the 
movie is exported, an alternate frame rate may be applied within the movie file. 

Large or complicated environments or slow processors may produce undesirable animations. Walk times may not be achieved if the time 
necessary to display the render view exceeds the specified walk time. In this case, if the animation playback does not correspond to the 
"real-time" playback specified in the Viewpoints dialog, which is a function of frame rate and walk and pause intervals, AGi32 will display a 
warning icon during playback  - a Stop icon with an exclamation mark. Reducing the frame rate may alleviate this playback problem. This 

problem does not occur in generated movie files. 

Note: A Frame Rate  = 0 has the same effect as Slide Show (in which case Pause intervals may be applied to "hold" the slides). 

1. From the View menu select Animate, or from the Viewpoints toolbar select . 
2. Click to stop the animation. 

Edit your viewpoints 

To fine tune a scene, it may be necessary to edit one or more of the viewpoint metrics. Typical modifications include: Label, Walk Time, Pause Time 
and Eye and Focus Z-coordinate. Viewpoint editing must be done within the Viewpoints dialog. 

1. From the Viewpoints toolbar select . 
2. To edit the contents of a single Viewpoint, click in the cell you wish to modify. The following modifications are available within each viewpoint: 

• Label – You may want to change the viewpoint label for easier identification 

• Walk Time – This is the time (in decimal seconds) it takes to ‘move’ from one viewpoint to the next. By default, Walk Time is set to 1 sec. It may 
be desirable to increase Walk Time to slow down the animation. 

• Pause Time – This is the time (in decimals seconds) one can pause at a particular viewpoint during animation before continuing on to the 
viewpoint. 

• Eye Z and Focus Z - Changing the Eye and Focus Z-coordinate may be useful if want to change your eye height. For example: You may want to 
change the Eye and Focus Z to the height of a standing (5 ft.) or sitting person (2.5ft.). Changing the Eye and Focus Z will result in a viewpoint 
that looks straight ahead, Changing the Focus Z to a height higher or lower than the Eye Z will result in the viewer looking up or down, 
respectively. 

• View X, Y, Z - These unit direction vectors indicate which way is "up" relative to the eye position. 

o (0, 0, 1) - X = 0, Y = 0, Z = 1 indicates that Z is up relative to the viewpoint and the camera is looking straight ahead. A negative one (-
1) Z value indicates an upside down view (camera is looking behind the eye position) 

o (0, 1, 0) - X = 0, Y = 1, Z = 0 indicates that Y is up relative to the viewpoint (Top View). A negative one (-1) value indicates a Y Bottom 
view. 

o (1, 0, 0) - X = 1, Y = 0, Z = 0 indicates that X is up relative to the viewpoint (bottom of scene is running straight up and down the view, Y 
is to the left). 
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3. To Bulk Edit multiple Viewpoints at once, highlight the desired Viewpoints by selecting the Viewpoint Row Markers 

 

4. Right click on the on the Row Marker to display the secondary Viewpoints menu - select Bulk Edit. The following modifications are available 
within Bulk Edit: 

• Walk Time 

• Pause Time 

• Eye X, Y, Z 

• Focus X, Y, Z 

• View X, Y, Z 

5. You can preview your Walk and Pause changes by clicking on the Animate button . 
6. You can preview your Eye, Focus and View vector changes by redisplaying the view (display another viewpoint, then redisplay changed 

viewpoint to update screen display). 

Change the Slide Show Display Interval 

The Slide Show Display Interval specifies how often the Viewpoints cycle in the Slide Show when viewpoints are displayed sequentially. To change 
the Slide Show Display Interval, specify the new time, in seconds, in the Viewpoints dialog. 

1. From the Viewpoints toolbar select . 
2. Change the value in the Slide Show Display Interval text box to the desired times in Seconds. 

3. To preview the Display Interval, click the Viewpoint Playback button . 
4. The user defined Viewpoints will cycle sequentially in Render mode until you click again. 
5. The Viewpoints dialog will reappear. 

Recall a viewpoint 

To recall a viewpoint, you may use the Viewpoints dialog or use the Slide Show buttons on the Common Toolbar. 

To recall a specific viewpoint, use the Viewpoints dialog. 

1. From the Viewpoints toolbar select . 
2. Checkmark the Display selection box to update the current Viewpoint displayed in Render mode. 

Display all viewpoints sequentially 

To display the viewpoints sequentially (as in a slideshow), you may use the Viewpoints dialog or use the Slide Show buttons on the Common 
Toolbar. 

To display the viewpoints sequentially using a consistent display interval, click the Start button on the Common Toolbar or use the Viewpoints dialog. 

1. From the Viewpoints toolbar select . 
2. Viewpoints whose Status is On will be displayed. You may change a viewport's status to off by unchecking it, in order to remove it from the 

sequential slide show display. 

3. Click the Viewpoint Playback button . The Viewpoint will be displayed for the number of seconds shown in the Display Interval text box, 
after which the Viewpoints dialog will return. 

Set a consistent walk speed 

To set a user defined walk speed, to be applied consistently across all viewpoints, click the Set Walk Speed button in the Viewpoints dialog. 

1. From the Viewpoints toolbar select . 
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2. Select the Set Walk Speed command ( ) from the Viewpoints dialog. 
3. The Walk Speed dialog will appear allowing you to set a factory defined walk speed or a custom speed. 

4. You can preview your Walk speed changes by clicking on the Animate button . 

Movie Creation 

Create Movies from Animations 

Viewpoints animations may be exported as AVI files for playback on industry standard media players from the Viewpoints dialog. 

Note: A Frame Rate  = 0 has the same effect as Slide Show (in which case Pause intervals may be applied to "hold" the slides). 

1. From the Viewpoints toolbar select  

2. Click the Create Movie File button  in the Viewpoints dialog. 
3. The Create Movie File dialog will appear prompting you to select your production, image and movie parameters.  

Viewpoints Bulk Edit 

The Viewpoints Bulk Edit dialog allows you to make global changes to the Viewpoints selected in the Viewpoints dialog. 

The following modifications are available within Bulk Edit: 

• Walk Time 

• Pause Time 

• Eye X, Y, Z, each independently 

• Focus X, Y, Z, each independently 
• View X, Y, Z, each independently 

 To change one or more parameters, select the checkbox adjacent to the value to be modified, then enter the modified vale in the text box.  

Viewpoints-Walk Speed 

AGi32 allows you to specify a specific walk speed to be applied to all current active Viewpoints (Viewpoints whose Status is On - selection box 
checked). By selecting a fixed Walk Speed, AGi32 calculates the actual Walk Time, in seconds, based on the physical difference between the initial 
eye position and final eye position for successive Viewpoint. 

AGi32 does not apply Walk Speed to Viewpoints involving just Focus Position changes (e.g. Rotate commands). 

To apply different walk speeds to different Viewpoints, use the Status option to select and deselect the current Viewpoints with multiple select 
selection methods. Apply the desired Walk Speed to the current active Viewpoints, then select a different set, and reapply the desired Walk Speed 
accordingly. 

1. From the View menu select Viewpoints, or from the Viewpoints toolbar select . 

2. Select the Set Walk Speed command ( ) from the Viewpoints dialog. 
3. The Set Walk Speed dialog will appear allowing you to set a factory defined walk speed or a custom speed. 

• Normal: 4.46 Ft/sec  = 3.04 MPH 

• Fast: 4.46 Ft/sec  = 4.00 MPH 
• Specify - user specified value 

Slide Show 

The Slide Show buttons on the Viewpoints toolbar allow you to advance through your user 
defined viewpoints for the current scene manually or display them automatically with the Start 
button. 

If no viewpoints have been created, the Viewpoints dialog will be displayed. 

If necessary, select the desired scene from the Current Viewpoint Scene drop down menu. 

First – This button advances to the first selected viewpoint in the Viewpoints list. 

Previous – This button advances to the previous selected viewpoint in the Viewpoints list. If there is no previous viewpoint (i.e., you are at the first 
viewpoint), the viewpoint will not change. 
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Start – This button sequentially displays the selected viewpoints in the Viewpoints list based on the current Display Interval. The slide show will begin 
at the current selected viewpoint and continuously loop through the selected Viewpoints list until the left mouse button is clicked (Stop). 

Next – This button advances to the next selected viewpoint in the Viewpoints list. If there is no next viewpoint (i.e., you are at the last viewpoint), the 
viewpoint will not change. 

Last – This button advances to the last selected viewpoint in the Viewpoints list. 

 

 Creating Movies 

Creating Movie Files - Concepts 

The Create Movie File command allows AGi32 users to export animations created in Render mode to industry standard movie file format (AVI), 
complete with textures, ray trace and radiosity capabilities.  

Tips for creating movies successfully 

• Start simple! Attempting to generate a Hollywood production the first time out is just about guaranteed to result in frustration. Start with a short 
animation (a few seconds) and experiment with various movie settings. Use the Radiosity image type to minimize processing time 

• Selecting a Codec – The best way to do this is by experimentation! Start by Generating Images Only (see Product Types). Then Generate 
Movie Only using different codecs. Check and compare the resultant movie files: File size, quality, playback (smooth or jerky). Can you share 
the file with your clients?  

• We have had successful results using the following codecs (these may or may not be present on your computer): 

• Cinepak Codec by Radius 

• Microsoft Windows Media Video 9 

• Indeo Video 5.10 
• Try different frame rates. Lower frame rates may produce acceptable movies while greatly reducing production time and file size. 

Terminology 

• AVI (Audio-Video Interleave) – Digital video file format designated specially for the Microsoft Windows environment 

• Codec (COmpress and DECompress) - All video on a computer uses a special algorithm or program to process video. This program is called a 
codec 

• DV (Digital Video) – Specific video format used by digital camcorders. 

• DVD (Digital Versatile Disc) – Popular in video production because of its quality. DVD’s make use of the MPEG-2 format and can be played 
back on stand-alone DVD players or on the DVD drive of your computer 

• Frame Rate – The number of frames per second in a video (fps). NTSC video is commonly 29.97 fps, smaller video files can be created and 
used on a computer by using lower frame rates, like 15 fps (however, 15 fps is not suitable for DVD) 

• Frame Size – Size of the displayed images in video sequences. If an image intended for the sequence is larger or smaller the current frame 
size, it must be resized or cropped 

• Movie – The combination of one or scene animations exported into a standard format movie file suitable for playback on a variety of media 
players (e.g. Windows Media Player) 

• MPEG-2 – Digital video format used primarily for DVD’s. Offers resolutions of 720x480 and 1280x720 pixels 

• NTSC (National Television System Committee) – Video standard used in North America, Japan, Taiwan and some other regions. DV and DVD 
frame rate in 29.97 fps, frame size is 720x480 pixels 

• PAL (Phase Alternating Line) - Video standard used primarily in Europe, China and some South American and African countries. DV and DVD 
frame rate is 25 fps, frame size is 720x576 pixels 

• Scene – Continuous action in a single line of motion 

Selecting Viewpoints to include in the movie 

By default, all the Viewpoints in the selected scene are included in movie. To only use a specific selection set (e.g. to append additional frames to an 
existing image set) select the viewpoints to be included in the Viewpoints dialog in Render mode, by changing the Status of all non desired Viewpoint 
to Off, before clicking the Create Movie File button. 

• If a range of frames is specified - All viewpoints up to starting frame will be skipped. 

• If a range of frames is specified and the starting frame falls within a pause sequence, the program will automatically backup to and generate 
images from the first frame in the pause sequence 

• If a range of frames is specified and the last frame falls within a pause sequence, images for the entire pause sequence will be generated 

Production Type Details 

Generate Images and Movie File 
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This is the default option which generates both the frames used in the movie file and the resulting movie file in one step. The current Render View is 
automatically resized to match the selected frame size and aspect ratio.  

Note: The default aspect ratio of AGi32 Render Views is 1.5:1. Choosing a frame size with a different aspect ratio (e.g. 1280 x 720: aspect ratio 
1.78:1) may cause more or less of the rendered environment to be visible in the generated movie. The 720 x 480 and 352 x 240 Frame Sizes 
maintain a similar 1.5:1 aspect ratio, which will result in minimal change in the generated movie. To use a Frame Size with a different aspect ration 
successfully, it may be helpful to resize your current AGi32 Render View to the same aspect ratio. 

For radiosity images, the Frame size must be equal to or smaller than the current resolution setting. You must increase your screen resolution to 
generate larger images or ray trace them instead. 

During the on screen image production, the leading and trailing images are not displayed on screen. In addition, Pause sequences requiring 
additional frame generation are also not displayed on screen. 

To work on other applications while generating the movie frames, minimize the Viewpoints dialog, which will in turn automatically minimize AGi32 
during this process. Clicking Cancel will terminate the image generation process. 

At the end of the image generation process, an Image information (Image.ini) file is created describing the image data. In addition, the resulting AVI 
file with leading/trailing images and any pause sequences is created as well. 

Note: If the image creation process is canceled, an Information file is not created and a movie cannot be generated at a later time from the remaining 
images. 

Generate Images Only 

This option generates images only for a user defined Frame Range. This option may be desirable if you want to: (1) Use the images in another 
application (e.g. video editing software, see Advanced Options below), (2) Break the task into multiple parts (see Advanced Options below) or (3) 
Generate movies using the same images with different codecs.  

The generated images are saved in an Image Folder specified in the Image Setup section whose location corresponds to your specified MovieFiles 
folder location (specified in System Settings-File System tab). By default, MovieFiles are saved in your My Documents\AGi32\ [JobFile_MovieFiles] 
folder. If the specified Image Folder already contains previously generated images, AGi32 will check the existing Image Information file to ensure that 
the Image Setup parameters match (e.g. same frame size, frame rate, etc.). We strongly urge you to use the same parameters across all generated 
images in the same folder, so that when a resulting movie is created, the images match up well and create a harmonious result. If AGi32 detects that 
the Image Information File parameters do not match the current parameters, an option is displayed allowing you to change the current parameters to 
match the existing ones. 

Note: The default aspect ratio of AGi32 Render Views is 1.5:1. Choosing a frame size with a different aspect ratio (e.g. 1280 x 720: aspect ratio 
1.78:1) may cause more or less of the rendered environment to be visible in the generated movie. The 720 x 480 and 352 x 240 Frame Sizes 
maintain a similar 1.5:1 aspect ratio, which will result in minimal change in the generated movie. To use a Frame Size with a different aspect ration 
successfully, it may be helpful to resize your current AGi32 Render View to the same aspect ratio. 

For radiosity images, the Frame size must be equal to or smaller than the current resolution setting. You must increase your screen resolution to 
generate larger images or ray trace them instead. 

During the on screen image production, the leading and trailing images are not displayed on screen. In addition, Pause sequences requiring 
additional frame generation are also not displayed on screen. 

To work on other applications while generating the movie frames, minimize the Viewpoints dialog, which will in turn automatically minimize AGi32 
during this process. Clicking Cancel will terminate the image generation process. 

Note: If the image creation process is canceled, an Information file is not created and a movie cannot be generated at a later time from the remaining 
images. 

At the end of the image generation process, an Image information (Image.ini) file is created describing the image data. 

Generate Movie Only (From Existing Images) 

This option generates a movie using existing images from a user defined folder. These images must have been generating using AGi32, as AGi32 
uses the Image Information File (Image.ini) to generate the subsequent AVI movie file. This option may be desirable if you want to: (1) Assemble 
images generated by multiple computers (see Advanced Options) or (2) Generate movies using the same images with different codecs. 

By default, the Image Folder listed corresponds to the previously specified Image Folder location and name, however, you may select any Image 
Folder that contains images generated by AGi32 and a corresponding Image Information File.  

The AGi32 file correlated to the selected Image Folder needs not be opened, only the generated images and Image.ini information are used. 

To work on other applications while compiling the frame images into the movie, minimize the Viewpoints dialog, which will in turn automatically 
minimize AGi32 during this process. Clicking Cancel will terminate the movie compilation process. 

At the end of the movie compilation process, the resulting AVI file with leading/trailing images and any pause sequences is created. 

Image Setup Details 
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Scene selection - Specify the scenes to include in the production. This functionality allows you to select which scenes to use and even reorder 
them. 

Frame Size - Production time is dependant on the Frame Size selected, especially for Raytraced images. AGi32 provides many standard frame 
sizes to choose from, in addition to a custom frame size. To use a Custom Frame size, choose Custom and enter the Frame Width and Height to 
generate. Note: Custom Frame Sizes must be between 120 and 1280 pixels (anything larger or smaller may not be supported by the codec and/or 
movie player). 

For radiosity images, the Frame size must be equal to or smaller than the current resolution setting. You must increase your screen resolution to 
generate larger images or ray trace them instead. 

Frame Rate - The Frame Rate (Frames per second - fps) indicates how many frames to generate in between Viewpoints or at Pause Intervals. For 
example, a 20 second movie with a Frame Rate of 15 (15 fps) would require 300 frames to be generated. Higher frame rates generally result in 
smoother playback but with a longer production time and larger AVI file sizes. Conversely, lower frame rates result in smaller AVI files and shorter 
production times, but may also playback with "choppy" animation. Experiment with simple movies to see which Frame Rate suits your production 
style best. 

Image Type - Specify whether to use Radiosity or Raytrace (hybrid radiosity and raytrace method) images.  

Radiosity images will generate more quickly, but will not include specular surfaces, raytraced clouds, crisp shadows or other raytrace image benefits. 
Any of the Display Properties parameters may be applied to Radiosity images, including pseudocolor, display scale, exposure settings and 
antialiasing, by clicking on the Display Properties button. Applying Antialiasing to Radiosity images will result in less jagged lines, but slightly longer 
production times. 

Raytrace images may produce the most visually stimulating movies (including effects such as raytraced clouds for daylighting productions, specular 
highlights, crisp shadow lines, etc.) but at a cost of high production times, especially for large Frame Sizes. Any of the Raytrace Parameters may be 
applied by clicking on the Set Parameters button.  

For long productions, you may consider breaking the production into multiple parts on multiple computers, a process known as render farming (see 
Advanced Options below). 

Playback - Specify either Movie or Slideshow playback. Movie playback generates the production frames using the animations between the 
Viewpoints as well as the Viewpoints themselves. Slideshow playback only includes the defined Viewpoints at the Specified Display Interval. 

Image Folder - The folder location of production image files is determined by the ‘MoviesFiles’ folder specified in Tools-System Settings-File System. 
By default, this is specified as < Same Folder As Job File >. Within the job file specific MovieFiles folder,there lies a subfolder containing the 
generated image files. This subfolder is the Image Folder defined in this text box. 

File Structure Within The Job Files Folder ([] – Denotes folder): 

[<Filename>_MovieFiles] 

[Images_<Image Folder>] 

Image.ini 

Frame_1.jpg > Frame_N.jpg 

Example (Job File = Job1.a32, Image Folder = Scene1): 

[Job1_MovieFiles] 

[Images_Scene1] 

Image.ini 

Frame_1.jpg > Frame_N.jpg 

The Image Folder name is initially specified to correspond to the selected scene names but can be changed as desired. For example: If you select 
scenes ‘Scene’ and ‘Orbit’, the Image Folder will default to ‘Walk1_Orbit’. 

Movie Setup Details 

Movie Name - Specify the name of the generated AVI movie file to be located in the job file specific MovieFiles folder. The Movie Name is initially 
specified to correspond to the selected scene names but can be changed as desired. For example: If you select scenes 'Walk' and ‘Orbit’, the Movie 
Name will default to ‘Walk_Orbit’. 

Codec - The selection of a proper codec is a paramount choice to ensure adequate movie playback results affecting quality, file size and usability. All 
video codecs found on your computer are listed and available for selection; however, this does not ensure that all of the codecs listed will work 
properly or even work at all. Some codecs are unreliable, some require special licenses to use while others work on some computers but not on 
others. For example, if you encode a movie with a codec requiring a special license or software purchase, sharing this same movie may result in your 
client not being able to view it unless they purchase said license or software for additional fees. In addition, some codecs may require certain 
versions of multimedia players or specific plugins/patches to your operating system to playback. In short, you will want to experiment with different 
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codecs to see which ones work best for you and your clients. In the Tips section, at the top of this document, you will see a short list of codecs we 
have had successful results with in our office. If these codecs exist on your computer, you may wish to try them first. 

Many codecs include a Properties dialog. If your selecting codec has a Properties dialog, the Properties button will be enabled. These dialogs may 
contain basic descriptive information or include additional settings (such as compression level).  

Note: Codec property dialogs are not generated by AGi32 and are not supported by Lighting Analysts, these are part of the codec itself. To gain 
more understanding of the settings available for a specific codec, contact the codec author or supplier directly. 

Movie Playback - Once the production process is complete, the AVI file is saved in the specified MovieFiles folder and may be played with any 
multimedia software program (such as Windows Media Player, Apple's Quicktime player, etc.) Navigate to the movie folder, double click on your AVI 
to start it with your default movie player, or open the desired movie player, then load the AVI file you just created. 

Additional Images 

The Additional Images tab allows you to specify a leading and/or trailing image to append to the beginning and/or end of your movie (e.g. introduction 
and credits). These images are added to the following production types: Generate Images and Movie File and Generate Images Only. 

To specify, select the Leading and/or Trailing selection box, choose the desired Image file (in BMP, JPG or WMF format) and image duration in 
seconds. 

To see the selected image in more detail, click on the thumbnail preview to enlarge it (click again to return to the Additional Images tab). 

For best results, Leading and Trailing images should be the same size as your current frame size or larger with the same aspect ratio (width:length). 
This will minimize ‘pixilation’ which occurs when an image is re-sampled to fit the specified frame size. For example: If your Frame Size is 720x480, 
your Leading and Trailing images should also be 720x480 or larger with the same aspect ratio, e.g. 960x640 pixels 

Leading and Trailing images are added to the Movie Length and Total Number Of Frames (see Statistics). For example: A Leading image defined as 
having a duration of 3 seconds would account for the first 45 frames of your movie (assuming a frame rate of 15 fps). 

Summary 

The Summary display on the right side of the Create Movie File dialog gives you a quick reference of your specified movie. As the Image Setup 
variables are changed, the Summary statistics will update automatically to reflect your current image selections. When generating a movie only 
production, the summary reflects the settings of the previously generated images, as obtained from the Image Information File (Image.ini) in the 
selected Image Folder. 

Advanced Options 

Using Generated Images And/Or Movie Files In 3rd Party Video Editing Software 

The generated images and/or movie files produced in AGi32 may be imported and used in conjunction with 3rd party video editing software. This 
allows you take advantages of additional features of those programs (add audio, annotate images, create DVD, etc.) 

When loading images files into 3rd party video editing software, each generated image from AGi32 represents a frame in the final movie. The Frame 
display interval (within video editing software) should be set to 1 / Frame Rate (check your video software to see if it supports small displays 
intervals, e.g. 1/30 = 0.033 seconds per frame). 

Render Farming 

When generating long or complex movies, it may be useful to break the task into multiple parts on multiple computers. This process is often referred 
to as ‘rendering farming’. To do this, you need multiple computers (with AGi32 installed) connected to a central source (network server). Here are the 
necessary steps: 

1. Copy the AGi32 Job file to a central location on the server 
2. MovieFiles folder should be specified as <Same as Job File> and Image Folder name should be consistently specified across all computers. 
3. Decide how the task is to be split (e.g. Computer #1 – Generate images 1-200, Computer #2 – Generate images 201-400, etc.) 
4. Open the AGi32 Job file on one of the computers (bypass the ‘File is already in use message’) 
5. Open the Movie dialog and select Generate Images Only. Specified the desired range per Step #3. Set Image parameters as desired. 
6. Start generating images on ONE computer (this will establish the existing image parameters for all other computers to use) 
7. Repeat Steps #4 and #5 for each computer. The program will check your current image parameters against the existing image parameters and 

give you the option to change your settings to match (e.g. frame size, frame rate, etc.). Generating images with different parameters in the same 
folder can cause undesirable results when creating a movie from those images 

8. Once the images are generated, select to Generate Movie Only on one of the computers (select the appropriate folder)  

Create Movie File - Procedures 

Movie Files are created from scene animations generated with Viewpoints in Render mode.  
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1. From the View menu select Viewpoints, or from the Viewpoints toolbar select  

2. Click the Create Movie File button  in the Viewpoints dialog. 
3. Select the Production Type: 

a. Generate Images and Movie File: This is the default option. 
b. Generate Images Only: Specify a Frame Range to include. 
c. Generate Movie Only (From Existing Images): Select the folder where existing images are stored to compile into specified movie. 

4. Specify the Image Setup: 
a. Select the Scenes (if multiple scenes are defined) to include in the movie. Scenes are generated in order, to reorder your scenes, use 

the Alt and Up/Down Arrow keys. 
b. Select the Frame Size from a selection of standard sizes or a custom frame size. 
c. Select a Frame Rate. 
d. Select Radiosity or Raytrace images for inclusion and the parameters to be applied. 
e. Select either an animated Movie or Slideshow playback. 
f. Specify the Image Folder name to contain the generated images. 

5. Specify the Movie Setup: 
a. Specify the Movie name desired. 
b. Choose a Codec (compression/decompression method) to apply. 
c. The Properties button displays the dialog for the currently selected codec and may provide additional specifiable parameters specific to 

the selected codec. Please see the Help for each codec for instructions for applying additional parameters. 
6. Specify leading and trailing images for the generated movie, if desired, using the Additional Images tab: 

a. To add a Leading Image, check the Leading selection box and choose an image to use at the beginning of the movie. The duration of 
the image will indicate how many frames are required (at the specified frame rate). 

b. To add a Trailing Image, check the Trailing selection box and choose an image to use at the end of the movie. The duration of the 
image will indicate how many frames are required (at the specified frame rate). 

Note: Images will be rescaled to match the frame size of the specified movie. For best quality presentations, create your Leading 
and/or Training images at the same Frame Size as your movie to avoid pixelation or aspect ratio distortions.  

7. Click OK to begin movie generation. 

  

 Outputting Render Views 

Copying Render Views - Concepts 

The current Render View may be copied to the Windows™ clipboard for use in other applications or graphic manipulation in other image software 
that accepts bitmap (BMP) or JPG format graphics. The selected view is temporarily enlarged to its maximum resolution so that the image is 
captured at this resolution. You may resize or resample the image in any graphics software without losing any of the original clarity. 

Hint: If you Apply Anti-Aliasing before you copy the selected view, the copied view will remain anti-aliased.  

Copying Render Views 

The Copy command copies the selected Render View to the Windows Clipboard. Once the image is there, you may paste it into any application that 
accepts graphic input. The image is temporarily resized to the maximum resolution before being copied to the clipboard for maximum clarity. 

 From the Edit menu select Copy, or from the Common toolbar select , or press Ctrl+C on the keyboard. 

Exporting Render Views - Concepts 

You may export the current render view as a bitmap (BMP) or jpeg (JPG) format image for use in other software applications or, as an interactive 
environment that can be examined by anyone with a VRML player. This export capability allows you to share your work with others either in the form 
of still images or in the form of an interactive world. 

The file type you export is decided at the dialog level after you choose the Export command.  

Bitmap file type 

A bitmap is a still image of the current Render view. Bitmaps can be printed or imported into other software programs for publication. Bitmaps are 
quite suitable for desktop publishing because they contain raw image data with no compression algorithms. The BMP file AGi32 exports is saved at 
the maximum available resolution to preserve the clarity and integrity of the image for later use. 

JPEG file type 
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A JPG is also a still image of the current view. The JPG file AGi32 exports is saved at the maximum available resolution to preserve the clarity and 
integrity of the image for later use. JPEG images use lossy compression to generate smaller file sizes with fairly high quality. Generally speaking, for 
screen presentations,you will have a hard time differentiating between Bitmap and JPEG images, and should use the JPG format for output. For 
desktop publishing, where large image sizes are typically desired, the Bitmap file format is preferred. 

VRML file type 

VRML stands for Virtual Reality Modeling Language. A VRML export creates a file that contains the entire radiosity solution. This file can be opened 
using a VRML player and viewed interactively much as you would navigate through an AGi32 file. VRML players are freely available on the Internet. 

VRML files are exported without he inclusion of textures because the VRML format does not support modulated textures. This means that you cannot 
differentiate between highlight and shadow on the texture. The average texture color (visible in AGi32 when the textures are toggled off) will be 
shown at the surfaces instead. 

VRML files are automatically compressed when exported and saved with a *.WRL extension. 

Related Topics 

Ray Trace image generation 

Exporting Render Views 

The current view may be exported for use with other graphics software and will be saved in either the bitmap (BMP) or JPEG (JPG) file formats. 

1. Left click in the desired Render View to make it active. 

2. From the File menu select Export, or from the Common toolbar select . 
3. Select BMP Files or JPG Files from the Save As Type pull-down menu. 
4. In the Save As dialog, locate the folder where you wish to save the graphic and enter the graphic name in the File Name text box. 
5. Click Ok. 

The image is redrawn momentarily at its maximum resolution and saved in this format. This process allows you to rescale or resample the bitmap at 
smaller resolutions without any loss of clarity.  

Exporting the Rendered Environment as a VRML File 

You may export the Rendered environment as a VRML file. The VRML file format (Virtual Reality Modeling Language) allows you to view the 3D 
rendered environment that you have created in AGi32 with any VRML plug-in (or browser) locally or over the Internet. This format provides you with a 
new means of presenting your lighting designs to clients and team members outside of AGi32. 

All of the predefined views (e.g., Left, Right, Top, Bottom, etc.) and viewpoints are included in the VRML file to assist with navigation. Any defined 
viewpoints are also included as well. 

Various universal VRML plug-ins and browsers are freely available for your use. Please visit our website www.agi32.com for a comprehensive list of 
VRML players we recommend. 

1. From the File menu select Export, or from the Common toolbar select . 
2. Select VRML Files from the Save As Type list box. 
3. In the Save As dialog, locate the folder you wish to save the file in and enter a name for the VRML file in the File Name text box. The file will be 

saved with a WRL extension. 
4. Click Ok. 

Once the VRML file is created and a plug-in or browser is installed on your system, you may view the VRML file by double-clicking on the file since 
an association is automatically created by the plug-in. Alternately, you may create a link to it from a web page to allow others to view it. They too 
must have the plug-in enabled. The VRML files created with AGi32 are automatically compressed (about 6:1 ratio) so zipping may not be necessary.  

Printing Render Views - Concepts 

The Print command sends the current Render view to the printer specified in Print Setup. When the image is printed, it is temporarily enlarged to the 
maximum available resolution for best possible clarity in the final output. 

Hint: If you Apply Anti-Aliasing before you print the selected view, the printed view will remain anti-aliased.  
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Printing Render Views 

The current view is printed as a bitmap at its maximum resolution. The Print Setup dialog appears listing the default printer and default paper size 
and orientation. You may select other available printers and media selections, as desired. 

 From the File menu select Print, or from the Common toolbar select .  
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 Ray Tracing 

Ray Tracing - Concepts 

Ray tracing is a rendering technique that creates realistic images by simulating the method that light wave rays travel. In AGi32, backwards ray 
tracing is applied, which means that the rays are traced from the observer position backwards into the scene. For every pixel in the generated Ray 
Trace image, four rays (or more, depending on the anti-aliasing level) are traced to the corner of each pixel to check for interactions with the objects 
in each scene.  Every time an object is encountered, the color of the surface at that pixel is calculated. If the surface is specular or transmissive, 
additional secondary rays are traced to determine the contribution of reflected and refracted light and shadows to the final surface color. 

In the real world, rays begin at the light sources and are recursively traced from surface to surface, illuminating all the objects in their path. The light 
reflects and refracts through transparent surfaces over and over again. Only a partial amount enters our eyes or a camera lens. The vast majority of 
rays never encounter the observer directly, at least in the initial few bounces. Following the rays through this forward ray tracing technique, past the 
first few bounces, is impractical because it would take an unreasonable amount of time to render the scene and trace the majority of rays back to the 
observer. 

AGi32 allows you to consider both forward ray tracing and backwards ray tracing at the same time by selecting the Ray Trace Direct Illumination 
option in the Ray Tracing Parameters dialog. When this option is chosen, the Number of Bounces selected determines how many recursive (or 
repeating) rays are traced both forwards and backwards from each object intersection. Be aware, each light source (both the Sun in daylighting and 
Electric sources) will require a complete set of ray traces through each pixel, so your processing time may increase dramatically. The calculation time 
is proportional to the number of sources in each environment, regardless of whether they are directly visible in the current scene. 

The Ray Trace images AGi32 generates are based on the Radiosity calculations AGi32 has previously performed. The Radiosity calculations provide 
the Interreflected flux transfer distribution to the final images. When Ray Tracing is applied to the specified Viewpoint, the Direct component 
previously calculated in the Radiosity process is removed, and added back to the environment through Ray Tracing. 

View Dependence 

The Ray Trace images generated are view dependant. This is unlike the Radiosity calculation procedure, where you may interactively move through 
the environment and view all of the surfaces without having to recalculate. In the Radiosity renderings, all surfaces are assumed to be perfectly 
diffuse (Lambertian), which allows us to view them from any direction as they appear to have the same luminance from any viewing direction. In Ray 
tracing, surfaces may be diffuse, specular or transparent, and no simplistic assumptions can be made. Ray Trace images have to be independently 
generated for each viewing location, regardless of the surface reflection or transmission characteristics. 

Anti-Aliasing 

Anti-Aliasing improves images by removing the jagged edges observed in the final images. Jagged edges occur because of the inherently square 
shape of each pixel in your display. Lower resolution images have a higher chance of displaying jagged edges because  of their lower pixel count. In 
ray tracing techniques, anti-aliasing is applied by shooting a higher number of rays through each pixel to determine the average color of each pixel. 

 
Circle 

 
Aliased Circle 

 
Aliased Circle at Higher Resolution 

Soft Shadows 

When Ray-tracing the Direct Illumination component, the option to ray-trace Soft shadows is available. Soft shadows are defined as shadows created 
by light from area sources, or multiple sources and/or directions, causing multiple overlapping shadows and a region of intermediate gray values with 
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'fuzzy' edges. Soft shadows are intended to produce more realistic ray traced images and are strictly for visual effect. They have absolutely no affect 
on calculated values. The effects of soft shadows can only be seen in ray traced images. Soft Shadows is a ray trace technique and does not require 
any changes to the environment. Soft Shadows can increase the number of rays and ray tracing time by an average factor of 10 to 15 times. 

Soft Shadows are traced back to the source of direct illumination, regardless of whether the incident surface is specular or diffuse. Soft shadows are 
created by subdividing the luminous area into 64 equal parts and ray-tracing from each sub-luminaire to the pixel at the point of direct illumination. 

For electric lighting, the luminous box representing the luminaire is used as the luminous source. If the luminous box is described as a point source 
or is small enough to approximate a point source, enabling soft shadows will have little or no effect.  

 

Ray Trace Direct Illumination - Soft Shadows not enabled (Luminous Area assumed to be a point source) 
Number of Rays - 2,228,256; Calculation Time - 0.5 minutes (Intel P4 3.2 GHz, 1 GB RAM, hyperthreading enabled) 

 

Ray Trace Direct Illumination - Soft Shadows enabled (Luminous Area 0.3 Ft Diameter) 
Number of Rays - 57,736,596; Calculation Time - 15.6 minutes (Intel P4 3.2 GHz, 1 GB RAM, hyperthreading enabled) 
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For daylighting, the solar corona, apparent in clear and partly cloudy sky models, is used as the luminous source. Soft shadows may be considered 
in any daylighting environment (daylight exterior surfaces and interior environments attenuated by transition surfaces).The size of the solar corona is 
assumed and based on empirical measurements. 

� If the sky condition is clear (IESNA Clear Sky or CIE Standard Sky 11-  15), AGi32 assumes a solar corona subtending 0.5 degrees. 
� If the sky condition is partly cloudy (IESNA Partly Cloudy or CIE Standard Sky 6 – 10), AGi32 assumes a solar corona subtending 2.5 degrees. 

 

Ray Trace Direct Illumination - Soft Shadows not enabled (Clear Sky conditions) 
Number of Rays - 5024187; Calculation Time - 0.7 minute (Intel P4 3.2 GHz, 1 GB RAM, hyperthreading enabled) 

 

Ray Trace Direct Illumination - Soft Shadows enabled (Clear Sky conditions) 
Number of Rays - 93354569; Calculation Time - 11.03 minutes (Intel P4 3.2 GHz, 1 GB RAM, hyperthreading enabled) 

The end results of soft shadows may be very subtle and the "bang for the buck" in ensuing calculation times may not be worthwhile for all 
environments. Soft shadows are most apparent when using larger area sources or when long shadows are present. 

Tone Mapping Compression 

The human visual system is presented with a vast range of colors and intensities from natural and artificial lighting sources. For example, a starlit 
night has an average luminance level of around 0.0001 candela/m

2
, and daylight scenes may be close to 1,000,000 cd/m

2
. The maximum display 

luminance is only around 100 cd/m
2
, which means that our renderings cannot simulate the high dynamic range of naturalistic scenes. The simulation 

of extreme light and shadow can be reproduced using only the tiny range of available display outputs by applying tone reproduction operators. There 
are many tone mapping techniques; AGi32 uses the Reinhard tone reproduction method. 

The tone mapping compression factor determines the amount of per-pixel highlight luminance compression. If it is set to 1.0, no tone mapping will 
occur. If it is greater than 1.0, highlights are compressed. If it is less than 1.0, contrast enhancement occurs. 

AGi32 uses the following tone mapping compression factors: 1 (no tone mapping or 1 x compression), 2 (2 x compression), 5 (5 x compression), 10 
(10 x compression), 0.5 (1/2 x compression), 0.2 (1/5 x compression), and 0.1 (1/10 x compression).  

When applying Tone Mapping to environments with daylighting and exterior surfaces, the exposure may need to be adjusted in several ways to make 
the exterior look correctly exposed. For example, through the Display Properties dialog, one setting may needed to be set to properly display the 
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daylight exterior surfaces, the Exposure increased to make the interior look brighter, and tone mapping applied to ‘tone down' the overexposed 
exterior. 

Cloud Images for Daylit Environments 

AGi32 allows the user to specify a fractal pattern of clouds superimposed on the sky dome by using a procedural texture technique called Perlin 
Noise. Perlin noise is a interpolation function that allows us to generate images which vary pseudo-randomly over space and/or time. This technique 
is often used in computer graphics to make computer-generated objects more natural-looking, by imitating the pseudo-randomness of nature. 

Please note the following points regarding cloud images: 

• Cloud images are strictly cosmetic and the inclusion of clouds in the sky dome has no effect on the calculated values or surface 
illuminances/luminances observed in the ray-traced images.  

• Cloud images are only available with ray-traced daylit environments and when the Sky Dome is on. Furthermore, cloud images are only visible 
when the sky dome is visible in the rendered environment. 

• Cloud images may be specified automatically or manually. 

Automatic Cloud Specification 

In the Automatic Cloud Specification images, the Definition parameter is fixed at 0.9 (very defined clouds), the Noise Slice is fixed at 0.6. The Sample 
Cloud images presented in this dialog may not be representative of the actual cloud imagery ray traced in your environment. The background image 
behind the cloud fractal is considered also and varies based on the chosen Sky Condition, sun position, solar corona around sun (also derived from 
Sky Condition algorithms) and surface exposures. 

The specified environment luminances and other settings (e.g. Exposure Setting - F/Stop) may have a dramatic effect on the appearance of the 
clouds. If the sky dome is overexposed, the clouds may not be visible because of their propensity to blend into the background. In general, it is best 
to select exposure based on daylight surfaces in the Display Properties dialog. If this is not possible, experiment with lowering the Exposure Setting 
to create more contrast in your images. 

Note: These image samples are cropped from a Sky dome looking South East on Sept 12th, 2005 at 10:45 AM with one single sided surface facing 
the sky dome. The daylight exterior surface exposure is based on one surface (Min and Max luminances are equal). As such, your background color 
(sky dome background) may not be as vivid as the ones shown in the sample images, because your range of exposure is likely to be much greater 
and your sky dome will be more overexposed. 
 

Sky Condition General 
Description 

Comments Sample Images 

General Sky - 
Type 1, IES 
Overcast 

Overcast maximum coverage - 
100%, varying 
whiteness (1-1.75) 

   

General Sky - 
Type 2 

Overcast varying high 
coverage - 92 - 
100%, varying 
whiteness (0.25-2) 

   

General Sky - 
Type 3 

Overcast varying high 
coverage - 80 - 92%, 
varying whiteness (1-
2) 

   

General Sky - 
Type 4 

Overcast varying high 
coverage - 80 - 92%, 
varying whiteness 
(0.25-0.5) 
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General Sky - 
Type 5 

Overcast high coverage - 80%, 
varying whiteness 
(0.0.5-1.75) 

   

General Sky - 
Type 6 

Partly Cloudy medium coverage - 
68%, varying 
whiteness (0.25-1) 

   

General Sky - 
Type 7, IES 
Partly Cloudy 

Partly Cloudy medium coverage - 
68%, varying 
whiteness (1.5-2) 

   

General Sky - 
Type 8 

Partly Cloudy medium coverage - 
56%, varying 
whiteness (0.25-
1.25) 

   

General Sky - 
Type 9 

Partly Cloudy medium coverage - 
44%, varying 
whiteness (0.25-1.5) 

   

General Sky - 
Type 10 

Partly Cloudy medium coverage - 
44%, varying 
whiteness (0.5-2) 

   

General Sky - 
Type 11 

Clear low coverage - 32%, 
varying whiteness 
(0.25-2) 

   

General Sky - 
Type 12 

Clear varying low coverage 
- 20 - 32%, varying 
whiteness (0.5-1.5) 

   

General Sky - 
Type 13 

Clear low coverage - 20%, 
varying whiteness 
(0.25-1) 

   

General Sky - 
Type 14 

Clear very low coverage - 
10%, varying 
whiteness (0.5-2) 
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General Sky - 
Type 15, IES 
Clear Sky 

Clear varying low coverage 
- 10 - 20%, varying 
whiteness (1.5-2) 

   

 

Manual Cloud Specification 

The Manual Cloud Specification section allows you to create your own cloud fractals by assigning the cloud generation parameters. Varying the 
automatic parameters as a starting point will provide more understandable results. The following suggestions give a general overview of the fractal 
effects. 

• To generate ‘stormy’ looking clouds, apply a lower Whiteness parameter 

Sample Whiteness (Other Parameters Fixed: Coverage - 0.5, Definition - 0.9, Noise Slice 0.1) 

Whiteness Value - 0.25 

 

Whiteness Value - 0.75 

 

Whiteness Value - 1.25 

 

Whiteness Value - 2 

 

• To generate wispier, less defined clouds, apply a lower Definition parameter 

Sample Definition (Other Parameters Fixed: Coverage - 0.5, Whiteness- 2, Noise Slice 0.3) 

Definition Value - 0.1 

 

Definition Value - 0.3 

 

Definition Value - 0.7 

 

Definition Value - 1 

 

• To generate a completely different pattern of clouds, modify the Noise Slice (random pattern generation) value. Each decimal value generates a 
different fractal pattern. 

Sample Noise Slice Cloud Patterns (Other Parameters Fixed: Coverage - 0.5, Definition - 0.9, Whiteness - 2) 

Noise Slice Value - 0.1 

 

Noise Slice Value - 0.3 

 

Noise Slice Value - 0.5 

 

Noise Slice Value - 0.7 

 

 

Ray Trace - Process - (Getting environment ready to Ray trace) 

1. Create space in normal fashion (luminaire placement, surface creation, etc.) 
2. Assign specularity/glossiness to required surfaces using Surface Edit command. 
3. If Daylighting or Adaptive Subdivision are required, enable these settings. 
4. Calculate. 
5. Specify the necessary Ray Trace Parameters. 
6. In Render mode, specify the desired Views or the desired Viewpoints in one View. 
7. Start the Ray Trace. Ray Tracing can only be enabled in Render mode. 
8. View the generated Ray Trace images in the Windows™ Picture and Fax Viewer or My Computer. 
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Horizon / Sky Dome size 

In Radiosity renderings, the horizon line visible in daylit environments is located in the distance based on the Sky Dome size. It also exhibits a curved 
appearance because of the finite Sky Dome size. In ray-traced renderings, the horizon line is infinitely far away and the Sky Dome is infinitely large. 
Therefore, the horizon line no longer appears curved; it is in fact perfectly horizontal and may shift slightly upwards or downwards depending on the 
eye and focus position (i.e., it appears to move because it is farther away). The Sky Dome is also infinitely large and its extents extend to the edges 
of the scene for all images. 

How long does it take to generate Ray Trace images? 

The time to calculate depends on your hardware makeup, as well as the number of rays shot into the scene. The Ray number is based on screen 
resolution, space complexity, number of luminaires and amount of specular surface. At the minimum screen resolution AGi32 supports (1024 x 768), 
one specular surface and no anti-aliasing or direct illumination, the number of rays equals 6,291,456 (over 6 million rays. Most modern computer 
setups would be able to produce this image in under a minute. 

Add anti-aliasing, more specular surfaces and Direct Illumination into the mix, and your calculation times will certainly increase. Consider this worst 
case scenario: A mirrored room with 100 light sources and anti-aliasing set to 5. There will be 39 rays traced from the camera to each pixel. Each 
pixel also receive 100 Direct Illumination rays. The rays are then reflected a maximum of 10 times, which produces 390 more ray-surface 
intersections and another 1,000 Direct Illumination rays. This is 1,529 rays for a single pixel. Multiply this by 1,920,000 pixels for a large bitmap 
image (1600 x 1200 screen resolution) and total ray count is 2,935,680,000 (that's almost three billion rays). Clearly, this image will require serious 
calculation time. 

  

Ray Trace Parameters 

The Ray Trace Parameters dialog is used to specify the parameters used to generate desired Ray Trace images in AGi32. 

  From the Control Bar select . To modify the Raytrace parameters, choose the following option from the Raytrace secondary 
menu: Set parameters.  

Number of Bounces 

This value indicates the maximum number of specular bounces for each ray. The default value is 3, which is adequate for most environments. 
Environments with many specular or transmissive surfaces may require an increase in the number of bounces to ensure consideration of all specular 
bounces. 

Note: Increasing the number of bounces will increase calculation time. 

Anti-Aliasing 

This value indicates the Anti-Aliasing level applied to the Ray Trace images. The Default value is 0; no Anti-Aliasing is applied. Anti-Aliasing 
minimizes the appearance of jagged edges in the Ray Trace images. Anti-Aliasing is achieved in the Ray Trace process by tracing additional rays to 
the corners of each pixel. This process can dramatically increase calculation time; however, the image quality may be greatly improved. 

With Anti-Aliasing level equal to zero, the Ray Trace process starts by tracing four rays to the corners of each pixel. With Anti-Aliasing applied, (N + 
1)

2
 additional rays are required (where N equals the Anti-Aliasing level). These additional initial rays may in turn spawn additional rays. 

Anti-Aliasing level  Initial rays to each pixel 

0 4 

1 8 

2 13 

3 20 

4 29 

5 39 

Ray Trace All Defined Viewpoints 

This parameter creates Ray Trace images for all defined Viewpoints within the current View. This parameter is enabled by default. When this option 
is disabled, all current views (if multiple views exist) are Ray Traced using their current View setting. 

Note: To create a series of Ray Trace images (e.g., for walk-throughs), it is very efficient to set up multiple Viewpoints using the Render-View-
Viewpoints command first. You may also ray trace an animation when creating a movie file (see Creating Movie Files) 
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Ray Trace Direct Illumination 

When enabled, the Direct Illumination from all specified light sources (Daylighting and Electric Lighting) is ray traced. Forward Ray tracing, as this 
method is labeled, displays distinctive or harsh shadow lines or scalloping on surfaces as a result of Direct Illumination. 

Be aware, that enabling Direct Illumination, specifically with Electric Lighting sources, can be very time consuming and may increase your calculation 
times significantly. The Ray Trace calculation time will increase in proportion to the number of light sources. As such, you may want to limit it to final 
image generation (e.g., presentation images). 

Ray Trace Direct Illumination may also illuminate the surfaces of your luminaire symbol as well. In Ray Trace calculations, all surfaces are double 
sided and seen by the rays. If you experience scalloping on the luminaire surfaces, you may need to decrease your Luminaire Subdivision Level 
(discretize it into smaller pieces) in Advanced System Settings and recalculate (both Radiosity and Ray trace). 

 
Ray trace without Direct Illumination: Calc Time 0.25 Minutes 

 
Ray trace with Direct Illumination: Calc Time 1.6 Minutes 

Glossy Surfaces - When enabled, this parameter ray-traces Glossy Surfaces as defined in the AGi32 job file. The Glossy Surface attribute is 
applied individually to surfaces using the Surface Edit command. Only surfaces with Specularity assigned will have Glossiness applied, if a 
Glossiness value greater than zero is defined. 

Note: Glossy Surfaces require more rays to be traced from each specular surface intersection. Calculation times will increase on average up to  3 - 5 
times longer than without Glossy Surfaces enabled. 

Soft Shadows - When enabled, this ray trace technique traces the soft shadows created by the boundary of the luminous areas described in AGi32.  

Note: Calculation times will increase on average up to 10 - 15 times longer with Soft Shadows enabled. 

Combining Soft Shadows and Glossy Surfaces into a ray-trace calculation may increase your calculation times by a factor up to 100. It is strongly 
recommended to limit the use of soft shadows and/or glossy surfaces for presentation grade images only. 

Tone Mapping: Compression 

This value indicates the level of Tone Mapping compression applied to ray traced images so that they may be displayed more naturally on a 
computer monitor, which has a low dynamic display range (255:1). Tone Mapping is typically used to convert the high tones of an image into lower 
tones (i.e., "dodge the highlights," in photographic terms). Tone mapping may also be used to convert the low tones to higher ones (i.e., "burn the 
shadows," in photographic terms). 

Tone Mapping Compression level  Effect 

0-1 Convert low tones to higher tones 

1-10 Convert high tones to lower tones 

• Tone mapping effects are most noticeable when one is creating an image looking out of an interior environment opening or window and viewing 
the exterior environment. 

Image Size (Pixels) 

This section specifies the size of the generated Ray Trace images in pixels. Two options are provided for selection: 

• Same As View Display Size - This option generates Ray Trace images that are the same size as the specified Render views. If the Ray Trace 
All Defined Viewpoints option is specified, the generated Ray Trace images will be the same size as the current view. Note: Image size is 
dependant on Actual View size, aspect ratio and screen resolution. 
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• Custom - This option allows you to generate Ray Trace images that are of any desired size, independent of the specified render view sizes or 
current screen resolution. This option allows you to generate large images for desktop publishing or choose small images for quick Ray Trace 
analysis.  

1. To generate custom image sizes, specify either the Width or Height of the desired images. The other dimension will be automatically 
sized to maintain the original View aspect ratio. 

2. Generating large image sizes requires more memory and will increase processing times. 

Output Format 

This section indicates whether the generated Ray Trace images are saved as Bitmap files or JPEG files. JPEG images use lossy compression to 
generate smaller file sizes with fairly high quality. Generally speaking, for screen presentations,you will have a hard time differentiating between 
Bitmap and JPEG images, and should use the JPG format for output. For desktop publishing, where large image sizes are typically desired, the 
Bitmap file format is preferred. The Bitmap files contain the raw pixel data, with no applied compression. 

• What is Lossy compression? It is a compression technique that eliminates redundant pixel information in order to generate smaller file sizes. 
AGi32 applies a high quality compression algorithm to maintain the best quality images while reducing file sizes. For example, bitmap files 
requiring 1.8 Mb of disk space are compressed to less than 200 Kb (10% of their original size). 

Location of Generated Images - • Location for Ray Trace Images is specified using the Tools-System Settings command (File System tab). The 
default location is: <JobFileFolder> \_RayTraceImages 

Apply Cloud Image to Sky Dome (Only applicable with Daylighting) 

This section provides for the selection of sky dome cloud images to be added to daylit environments for a more realistic ray-trace rendering 
presentation. In order to apply clouds: you must have applied daylighting and have the Sky Dome On in the Daylight Parameters dialog. 

Clouds are strictly cosmetic and have no effect on the luminance values or calculated values of the AGi32 scene. The Sky Condition and 
solar location specified in the Daylight Parameters dialog determine the algorithms used to calculate daylighting; clouds are simply for 
visualizations only. 

Automatic Cloud Specification - The Cloud Parameters are automatically selected based on your current daylight sky condition. Three options are 
provided; each one allows you to vary your clouds based on your own preferences and regional sky conditions. 

Manual Cloud Specification - This section provides for manual selection of the cloud parameters used to generate cloud images.  

Cloud Parameters Description 

Coverage Specifies the approximate fraction of the sky dome that is covered by clouds (range: 0 – 1.0). 

Definition Specifies the definition (or ‘softness’) of the cloud boundary (range: 0 – 0.99). The higher the value, the more defined 
the cloud boundaries. 

Noise Slice Random number uses to generate a random distribution of clouds (range: 0 – 1.0). 

Whiteness Specifies the average ‘whiteness’ of the clouds (range: 0.25 to 2.0). The higher the value, the ‘whiter’ the clouds. Lower 
values may be useful with overcast skies to produce contrast between the clouds and the background sky dome. 

   

Start Ray Tracing 

The Ray Trace Start command starts the Ray Trace process per the Ray trace Parameter specifications. Ray tracing can only be started in Render 
mode and requires you to have previously completed the Radiosity process by calculating. 

Ray Tracing will generate multiple images for either one of the following scenarios: Multiple Views are defined or Multiple Viewpoints are defined 
(Viewpoints will be displayed in current View). 

Once the Ray Trace calculations are complete, the generated image files are automatically displayed in the Windows™ Picture and Fax Viewer, 
which provides many sophisticated image control options. 

  From the Control Bar select  
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 Page Builder 

Page Builder Overview 

Page Builder is AGi32's equivalent to a page layout program. Page Builder allows you to create multiple page reports and place different views of 
your job file and images in any position across the pages. These can be wireframe views (Plan, Isometric, Elevation of your Model mode layout), 
rendered views or external images you import into AGi32. Include text as you like, whether it is descriptive directly from AGi32, external text files or 
text notes and titles. Complete your presentation with a border and title block with your logo. 

In Page Builder, you can create two types of windows to append to your pages, Viewports and Imageports. Viewports are dynamic and assigned to 
visible views created in Model Mode views. Multiple views are possible in Model Mode by using View Manager - than assigned appropriate Plan, 
Elevation, or Isometric views. Imageports contain visible rendering images or graphics images. The page layout is created by arranging various 
Viewports and Imageports on the selected pages and augmenting it with AGi32's drawing tools and text. 

The Page Builder process begins by selecting the number of report pages, paper size and orientation. After selecting the initial report layout, you will 
be presented with a blank rectangle that represents the page on which to arrange your drawing. Each blank page contains a dashed rectangle that 
represents the page margins. To avoid clipping, keep all drawing entities and windows within the margins and separate from each other. Within this 
space, you create dynamic Viewports and Imageports that contain different views and images associated with your job file. The ports are dynamic 
objects that may be moved and resized in order to create a suitable arrangement. In addition, all of the drawing entity commands are available for 
use to further enhance and customize your presentation. 

You cannot modify the model directly in Page Builder. To make changes to the views or the job file, you must exit Page Builder and return to AGi32's 
Model Mode. These changes include adding or modifying luminaire locations, increasing text size for calculation points, etc.. In Page Builder, the 
only view modifications the user can specify is whether to use the associated view's display parameters or extents in the selected Viewport, as well 
as panning and zooming within the Viewports. 

To change modes, just click on the Model mode tab (or Render mode tab). You can go back and forth between all three modes at will.  

Page Builder - New Report dialog 

The page layout process begins by selecting the Page Builder command. The first time Page Builder is accessed in each job file, the New Report 
dialog will appear, prompting you to select the report attributes. 

The Load Existing Report Tab provides existing reports that extract information from the current environment. For your convenience, AGi32 is 
shipped with factory sample reports you may use and customize. When creating a new report, the page setup defaults to the last selected page 
count, paper size and orientation. When an English paper size is selected (units in inches), the Page Builder drawing units are also specified in 
inches. When a Metric paper size is selected (units in mm), the Page Builder drawing units are specified in millimeters. 

If the desired page size is not listed in the Page Size pull-down menu, it may be created by selecting Custom Page Size and specifying its width and 
height. 

Page Builder page margins default to 0.5 inches (or 12.5 mm) and may be changed as required. However, if the margins are set smaller than the 
printers minimum margins (as typically occurs with large scale plotters) the entities on the page may be clipped when printed. To determine your 
printer's minimum margins, open the Printer Properties dialog (from Windows Control Panel) or refer to the printer reference manual. 

Page Builder Interface 

After selecting the report setup in the New Report dialog, you will be presented with the Page Builder interface. The Page Builder Toolkit provides 
access to the Page Builder and Drawing toolbars. The Page Builder toolbar provides Page Control commands as well as Viewports, Imageports and 
Report functionality. 

Additional Page Navigation tabs are provided at the bottom of the Page Builder desktop. To print the report, use the Print icon on the Common 
toolbar. 

Page Builder reports are automatically saved with the job file. There is no need to save the report unless you would like to use the report as a 
template for future work. 
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Moving around in Page Builder 

The Page Builder interface includes its own unit system. The units used in Page Builder are different than those used in Model Mode, as you are 
working within the confines of individual pages. Depending on the page sizes chosen in the New Report or Report Properties dialogs, the units will be 
in inches or millimeters. When English units are used (inches) , then Snap increment is automatically set to 0.1 inch. When Metric units are used 
(mm) , then Snap increment is automatically set to 10 millimeters. Coordinates respective to Pager Builder units are shown in the Coordinate Display 
section at the lower left corner of the desktop. 

When the cursor is moved over an Imageport or Viewport, the cursor changes to an eleven o'clock arrow, to indicate that the ports can be moved by 
dragging them with the mouse. When the cursor moves over an Imageport or Viewport border, it changes to a doubleheaded arrow to assist in 
resizing the port. Click and drag the doubleheaded arrow to resize the port. 

When an Imageport or Viewport is placed on a page, the cursor crosshairs disappear behind the port. Due to the nature of Imageports and 
Viewports, they will always appear in front of all other entities on the screen, however, drawing entities can be placed on top of Viewports (but not 
Imageports). To accomplish this, you must first hide the contents of the Viewport before you can place drawing entities in its place. To hide the 
contents of all Viewports, select the Hide Viewport command from the Page Builder menu or use the Ctrl+D key sequence to toggle Viewport 
contents on and off. 

To close Page Builder and return to AGi32's Model Mode, click on the Model tab. You can exit AGi32 through any mode, including Page Builder. You 
will be prompted to save your file first if changes have occurred since the last save. 

Z Order of Entities 

Imageports maintain z-order when printed. In other words, overlapping Imageports will print as displayed 

Viewports do not maintain z-order when printed. They are drawn on the page 'layer'. Overlapping Viewports will be 'merged' together and therefore 
we generally do not recommend overlapping these entities.  

Imageports always have a higher z-order than the page, therefore, Imageports always are printed on top of Viewports if they overlap, regardless of 
the current display. 

Saving a Defined Page or Report as a template 

Page Builder makes it easy to save any individual page or report you create as a template to be used with other job files. This feature can save the 
time required to add logos, title blocks, borders and more to your output as you need only create your "look" once for any given report layout and/or 
individual page and orientation. When a page or report has been saved, you can rearrange its contents as necessary each time you open it in a 
different job file. 
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Page Builder Report files are saved individually in the PageBuilderReports folder specified in the Tools-System Settings-File System Tab. By locating 
your PageBuilderReports folder in a central location, the reports can be shared. 

Individual Pages may also be saved for reuse outside the local job file. However, these pages are stored in your AGI32_GeneralDB database in the 
AGi32 installation folder. Saved pages cannot be shared with other users, only reports are stored independently. 

Dynamic entities in saved Page Builder pages 

The following entities will dynamically update themselves based on the associated content in the current job file. To achieve the most consistent 
presentations and least layout modifications necessary, we recommend that your standardize on View Names and entity labels whenever possible. 

• Viewports - content shown as long as View Name exists 

• Schedules 
• Smart Text 

   

Page Builder - Procedures 

Page Builder allows for multiple page report creation, presentation and reuse by AGi32 users. Page Builder reports can contain any combination of 
graphics, statistical data, drawing entities and CAD presentation as deemed appropriate by the user. 

Proceed from AGI32’s Model Mode to Page Builder mode. Click on the Page Builder tab on the Control Bar  to change modes. 

The following 8-step process creates a page in Page Builder: 

1. The first time you enter Page Builder, the New Report dialog will appear. Specify the new report properties or choose an existing report if 
applicable. 

2. Master pages may be specified to apply a design template to all similarly sized pages in a report. 
3. Create a Viewport by specifying its window size and location on desired pages. 
4. Similarly, Imageports are created by specifying their size and location on desired pages. 
5. If desired , change the report properties to create pages of differing sizes or to specify other report attributes. 
6. Add drawing entities (such as title blocks and text) to each page complete the presentation. 
7. If desired, print the page. 
8. To use this report as a template with other job files, save the report. 

Related Topics 

Schedules 

View Manager 

Text 

Drawing Entity Blocks 

   

Page Builder - Create New Report 

The New Report command allows a user to create a New Report or load an Existing Report into Page Builder. When a New Report is selected, the 
current report is deleted with all of its associated Viewports, Imageports and drawing entities and a new/existing report is loaded according to the 
properties specified in the New Report dialog. 

When Page Builder is initially accessed in any job file, the New Report dialog is automatically displayed. 

When a Page Builder Report is initially created, all pages are of the same size. Variable page size may be specified in the Report Properties 
command after entering Page Builder Mode. 

If an existing report is being replaced with a new report, AGi32 will reconfirm that you wish to delete the current report. This command is not 
undoable. 

 From the Page Builder menu choose New Report, or from the Page Builder toolbar select . 

Create New Report 
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1. ReportName - Optionally specify an alternate Report name - default name is Report. 
2. Description - Optionally specify Description. 
3. Number of Pages - Specify number of pages in Report. The number of pages may be incremented or deleted after the report is displayed in 

Page Builder as well. 

The Insert Page and Delete Page icons at the top of the New Report dialog may also be used to increment/decrement the Number of Pages. 

5. PaperSize - Specify the desired paper size from a common media list or specify a custom paper size - the default paper size is Letter (8.5 x 11 
inches). 

6. Units - Inches or Millimeters, depending on selected PaperSize. For Custom Paper Sizes, the user may specify which unit is applicable. 
7. Width, Height - Specify values for custom paper sizes, otherwise grayed out per selected PaperSize. 
8. Orientation - Portrait or Landscape may be selected. 
9. Margins- Top, Bottom, Left and Right may be specified independently - default margins are 0.5" for all (12.5 mm) 

10. Working Area - Indicates the useable area for user input (in inches or mm). 
11. Click Ok. 

Load Existing Report 

Load Existing Report tab is only available if Page Builder Report Files are found in the folder specified in the PageBuilderReportFiles folder (Tools-
System Settings-File System). Factory sample Reports are provided upon AGi32 installation. 

1. Choose the Existing Report that is desired. 
2. Click Ok. 

   

Page Builder - Open Existing Report 

To use an existing report (either one you have created yourself, or a factory sample report), use the Open Existing Report command.  

Factory sample Reports are provided upon AGi32 installation. 

The Load Existing Report tab is only available if Page Builder Report Files are found in the folder specified in the PageBuilderReportFiles folder 
(Tools-System Settings-File System). If you have specified an alternate location for the PageBuilderReportFiles folder in System Settings (e.g. to a 
network drive to make them available to all AGi32 users on a shared drive), you will need to manually copy the existing report files (*.PBR files) into 
this folder to make them available. 

If there is a report current, and you choose to replace it with an alternate report, AGi32 will reconfirm that you wish to delete the current report. This 
command is not undoable. 

 From the Page Builder menu choose Open Report, or from the Page Builder toolbar select . 

Load Existing Report 

1. Choose the Existing Report that is desired. 
2. Click Ok. 

   

Page Builder - Master Pages 

Master pages are used as a design templates for other pages in the Page Builder Report of the same size and orientation. Master Pages can 
incorporate any AGi32 design element that the user wishes to duplicate on every page such as Imageports, text, schedules and other drawing 
entities. Some examples of Master Page elements include title blocks, corporate branding and logos, page numbering elements, headers, footer, 
banners, etc. 
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SAMPLE MASTER PAGES 

 

 

Any Page Builder Report page may be used as a Master Page. Use Set Current Page as Master Page button to toggle any page as a Master Pages. 
All changes made to drawing entities and Imageports on a Master Page are automatically reflected on other Report pages. 

• Content placed on a page before the page is set as a Master page is not duplicated on other pages (not retroactive).Therefore, the best practice 
method to use is  to set a blank page as a Master page and then add content to it. 

• Only one Master Page can exist in any Report. To apply a Master Page to pages of a different size within the same Page Builder Report, simply 
toggle off the current Master Page, and set a blank page of another size as the Master Page. 

• Master pages can be used to changed locked pages in protected reports (Report Locking And Protection). 

• Schedules and Viewports placed on a Master Page are not duplicated on other pages. 

• Master Pages cannot be cleared of their contents with the Clear All Entities From Current Page command, use the Drawing Entity-Delete 
commands instead. 

• When a page is set as a Master Page, its label is automatically changed to Master. The Master Page is not considered in the total page count 
and other pages will be renumbered accordingly. Master Pages are identified in Smart Strings as Page M of <Total Pages>. For example: 4 
pages exist in a Page Builder Report and the 1st page is set as the Master Page. The pages will be renumbered as: Page M of 3, Page 1 of 3, 
Page 2 of 3 and Page 3 of 3.  

• When a Master Page is toggled  off, its label will be changed back  to ‘Page {X}’, it will be considered in the total page count and other pages 
will be renumbered accordingly  

• You can print the Master Page by either: (1) Select the Master Page and choose the Print Current Page Option, or (2) Toggle the Master page 
making a normal page, it will now be include in the total page count and can be printed using the All Pages or Page Range options  

   

Page Builder - Page Navigation 

The Page Navigation Tabs at the bottom of the Page Builder interface is designed to show 10 page tabs at one time. Users may display and work on 
pages within the report by selecting the tabs to change the current page. 
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Icon Comments 

 
The Master Page is displayed with a blue icon and the PageName 'Master'. 

• Pages behind the Master page are automatically renamed (renumbered) internally if the default PageName label (Page #) is 
used (e.g. Page 2 will become Page 1 if the original Page 1 is set as the Master). 

 

Report Pages use a PageName corresponding to a 'Page #' system by default. 

 
Locked Pages are displayed with a padlock icon to the left of the page name. 

 
Report pages may be renamed in the Report Properties dialog. The example to the left shows a page renamed 'Schedules'. 

• Pages downstream of the renamed page are automatically renamed (renumbered) internally if the default PageName label 
(Page #) is used (e.g. Page 2 will become Page 1 if the original Page 1 is renamed). 

Scrolling Page Range Controls 

The Page Display - Range controls allow users to scroll between ranges of pages in a Page Builder report.  If a report contains more than 10 pages, 
the scrolling controls become available and allow the user to move between the page ranges, either one page forward or back at a time, or in 10 
page increments. 

Icon Command Comments 

 
PageDisplay-Previous Range Of 
Pages 

This command shifts the displayed range of pages backwards 10 spots, when possible. 

• For example: Total Pages in Report equals 20; Pages displayed range from 11-20- 
Selecting Previous Range scroll will change the displayed range to 1-10. 

• Pages are not shifted back when the current range displayed encompasses the first 10 
pages. For example: Total Pages in Report equals 20; Pages displayed range from 1-
10- Selecting Previous Range scroll will continue displaying current range. If Pages 5-
14 were displayed, selecting the Previous Range scroll button would display pages 1-
10. 

 

PageDisplay-Shift Range Of Pages 
Back 

This command shifts the displayed range of pages one spot backwards. 

• For example: Total Pages in Report equals 20; Pages displayed range from 11-20- 
Selecting the Shift Range Back scroll button will change the displayed range to 10-19. 

 
PageDisplay-Shift Range Of Pages 
Forward 

This command shifts the displayed range of pages one spot forwards. 

• For example: Total Pages in Report equals 20; Pages displayed range from 4-13- 
Selecting the Shift Range Forward scroll button will change the displayed range to 5-
14. 

 
PageDisplay-Next Range Of Pages This command shifts the displayed range of pages forwards10 spots, when possible. 

• For example: Total Pages in Report equals 20; Pages displayed range from 1-10- 
Selecting the Next Range scroll button will change the displayed range to 11-20. 

• Pages are not shifted forward when the current range displayed encompasses the last 
10 pages.  

   

Page Builder - Report Properties 

The Report Properties command allows reports to be further customized in Page Builder. Options such as differing page sizes, custom page names 
and protection are available from this command. 

A preview of the current page size and orientation is shown at the right. 
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 From the Page Builder menu choose Report Properties, or from the Page Builder toolbar select . 

Report Properties 

ReportName - Indicates Report name - default name is Report, limited to 32 characters. 

Description - Indicates Report Description. 

Report Locked - Indicates True or False Status 

• Locking a Report locks all pages within a report, so no changes can be made to existing pages. 

• New Pages may still be inserted into locked report, as well as copies of existing and previously saved pages. 

Report Protected - Indicates True or False Status 

• Report Protection offers the an additional level of security for reports. Once a report is protected, no page additions may be made at all without 
entering a report password. 

• Password protection is required, password is prompted for each time report is protected/unprotected or whenever a page command is selected. 

• Password is not stored, user must recall password to change locking status. 

• Locking and protecting a report offers the highest level of security as no modifications may be made at all. 

Number of Pages - Specifies number of pages in Report. The number of pages may be only be viewed in this dialog not incremented or decreased. 

Lock/Protection Combinations 

Settings Action 

Lock Report and Protect 
• Locks all pages (no master page) 

• Can unlock using password 

• Highest level of security prevents any changes to report 
• Used for totally canned reports 

Lock Selected Pages and Protect 
• Locked pages can only be changed using a master page 

• End user cannot select a new master page 

• Unlocked pages may be modified normally 

• Suggested Use: Preformatted reports that can only be customized using a Master Page (e.g. 
modify banner, title blocks, etc.) 

Lock Report, No Protection - Or Lock 
Selected Pages, No Protection 

• Locks all pages (no master page) 

• Pages can be unlocked without using password 
• Low security, use for in-house reports to prevent inadvertent changes 

Page Properties 

Number - Indicates the current page number. Users may navigate through the Report pages vi this cell or via the Previous Page/next Page icons at 
the top of the dialog. 

PageName - Indicates the current page name. Any name, up to 24 characters in length may be specified. 

Master Page - Indicates True or False Status. Pages may be changed to Master Pages via this cell, however, only one Master Page may exist per 
Report. 

Page Locked - Indicates True or False Status. When a Report is Locked (see above) all pages are displayed as True. Individual pages may also be 
Locked via this cell. 

Page Size 

PaperSize - Specify the desired paper size from a common media list or specify a custom paper size - the default paper size is Letter (8.5 x 11 
inches). 

• When changing page size, entities already placed on the page will not be affected. They may need to be resized or moved to fit properly on the 
revised page size. 
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• To change all pages in the report to a consistent page size, select 'Apply Changes To All Unlocked Pages'. This is the default option. 
• To change individual pages, deselect 'Apply Changes To All Unlocked Pages'. Navigate to the desired page and make the appropriate changes. 

Units - Inches or Millimeters, depending on selected PaperSize. For Custom Paper Sizes, the user may specify which unit is applicable. 

Width, Height - Specify values for custom paper sizes, otherwise grayed out per selected PaperSize. 

Orientation - Portrait or Landscape may be selected. 

Margins- Top, Bottom, Left and Right may be specified independently - default margins are 0.5" for all (12.5 mm) 

Working Area - Indicates the useable area for user input (in inches or mm). 

  

Page Builder - Save Report 

The Save Report command allows you to save your report outside of the local AGi32 job file so that it may be accessed from other job files by other 
users. Page BuilderReport files are saved individually in the PageBuilderReports folder specified in the Tools-System Settings-File System Tab. By 
locating your PageBuilderReports folder in a central location, the reports can be shared. 

The Page Builder report File extension is .PBR. Page Builder reports may be shared electronically amongst users, however, in order to be "seen" by 
Page Builder, they must be copied to the PageBuilderReports folder. 

Reports that have been locked and/or protected may be saved affording the user more control options to create consistently formatted output from 
AGi32. 

1. From the Page Builder menu choose Save Report, or from the Page Builder toolbar select . 
2. Specify a unique report name. 
3. An optional report description may also be appended. 
4. The number of report pages will be shown for confirmation. 
5. Click ok. 

Saving Individual Pages 

Individual Pages may also be saved for reuse outside the local job file. However, these pages are stored in your AGI32_GeneralDB database in the 
AGi32 installation folder. Saved pages cannot be shared with other users, only reports can be shared as they are stored independently. 

   

Save Page builder Page 

The Save Page command allows you to save the current Page Builder page as a template so that it may be accessed by other job files. The Page 
Builder pages are automatically saved with the current job file as part of the Page Builder Report, so there is no need to save it independently, unless 
it is to be used as a template. You may also delete defined (previously saved) pages from within the Defined Pages Manager. 

What do you want to do? 

Save a Page Builder page as a template 

1. From the Page Builder menu select Page-Save Page, or from the Page Builder toolbar select . 
2. Enter a unique page description in the Page Description text box. Entering a page name that already exists will redefine the existing page. 
3. Click the Save button. The page description will appear below in the Defined Pages section. 
4. Click Ok. 

Delete a saved Page Builder page 

1. From the Page Builder menu select Page-Save Page, or from the Page Builder toolbar select . 
2. Select the page descriptions to be deleted in the Defined Pages section. 
3. Click the Delete button. The page description will be removed from the Defined Pages section. 
4. Click Ok. 
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Insert a Saved Page 

Pages previously saved from other reports can be inserted into any current report. The saved page will be inserted after the current page.  

Begin by choosing the page you wish to proceed the inserted page (although you can move any page at any time with the Move Current Page 
commands).  

1. From the Page Builder menu select Page-Insert-Saved Page, or from the Page Builder toolbar select . 
2. Select the page to insert by name from the Insert Saved Page dialog. 
3. Click Ok. 

Saving Page Builder Pages 

   

Print Report - Concepts 

The Print command sends the current Page Builder report to any Windows™ printer or Plotter (including MDI and/or PDF if installed). Each page is 
printed at a one to one scale (1" or 1 mm on the page = 1" or 1 mm on the printed output) regardless of the selected media size. 

The Page Builder format and output is unique to AGi32. There is no correlation between Page Builder entities and CAD entities, therefore, Page 
Builder cannot be exported to a suitable CAD format. However, you may export the data contained in Model Mode in DXF file format for compatibility 
with CAD software. 

Windows printers 

AGi32 will print or plot to any Windows printer or plotter, as well as to the Adobe™ Acrobat PDF Printer and Microsoft Document Imaging (MDI). 
There is generally little preparation needed to print. AGi32 references the default settings (including paper size, rotation, quality, etc.) for all Windows 
printers. The user may change the paper size and orientation, or configure the printer properties to write to a file. When selecting a plotter, you may 
need to configure additional properties, such as pen configuration, print quality, paper source, etc. 

Print Preview 

Based on the current print specifications, Print Preview will display the report pages one at a time as they will appear printed. When multiple pages 
exist, users can scroll through the pages using the slideshow controls in the dialog. 

Print Details 

The Print Details dialog appears after the Print button is selected. This dialog allows you to select the umber of copies to print and which pages will 
be printed when AGi32 is breaking the output into multiple pages. You can select a range of pages by entering the page numbers separated by a 
hyphen (e.g. 6-10) or random pages by separating the page numbers by commas (e.g. 5,7,11,12,15). 

   

Printing A Page Builder Report 

The Print command sends the current page report layout to the printer/plotter. In this dialog, the user selects options that determine how the image 
fits on the paper including paper sizes and rotation, and whether the pages will be printed in color or black and white (if available). 

1. From the File menu select Print, or from the Common toolbar select . 
2. Verify that the desired printer and media are displayed in the Where section of the Print Report dialog. To change the printer or media, click the 

Print Setup button. Printers that can print color will allow the selection of Color or Black and White for printing. 
3. Select Pages To Print - Three options are available for selection: 

• All Pages (Excluding Master Page) – This option prints all pages except for the master page (if existing), page numbering and number 
of pages are adjusted accordingly. This option is the default. 

• Current Page Only – This option prints the current page only. Master page will be printed as Page M of <Total Pages>, all other pages 
will be printed as Page # of <Total Pages> (i.e. pages retain their current page number). 

• Pages (Excluding Master Page) – This option allows the user to specify an individual page or ranges of pages. For example: 1,4-6 
would print pages 1,4,5,6. Pages will retain their current page number unless the Renumber selection box  is selected. For example: 
Report consists of 5 pages and you select to print pages 1,3,5. The pages will be printed as Page 1 of 5, Page 3 of 5, and Page 5 of 5. 
If you select to renumber, the pages will print as: Page 1 of 3, 2 of 3, and 3 of 3. 

• The Master Page (if existing) will NOT be printed and is not included in the total page count with the Print All Pages and Print Pages 
options. To print a Master Page you can either; click on the Master Page and select the print Current Page Only option, or toggle the 
Master Page off making it a normal page and then select any of the available print options. 
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4. Indicate the number of report copies desired. 
5. The number of pages that will be printed is based on the specified Page size and orientation and the selected Printer Paper Size and 

orientation. If the current Paper Size does not match the current page size, the output may be printed on across several additional pages. To 
change the number of pages that will be printed, select an alternate Paper Size. 

6. Preview the report by clicking the Print Preview button. Scroll through the individual pages with the slideshow controls on the ride side of the 
Print Preview dialog.  If you like the output, click the Print button. Otherwise, click the Cancel button to return to the Print dialog. 

7. Click Ok to print the page according to the current settings. You may also print from the Print Preview dialog box. 

  

 Viewports 

Page Builder Viewport-Concepts 

Using Viewports you can assemble data from Model Mode in any array of possibilities on the report pages. Any or all of the visible Model mode views 
can be placed to scale, or scaled to fit to the confines of any page. 

Viewports are dynamic windows, drawn on the current Page Builder page, that contain a link to any view in AGi32's Model Mode. Viewports are 
dynamic, meaning that when the view contents change when working in Model mode, so will the contents of the Viewport. The linked View attaches 
itself to the upper left corner of the Viewport by default. Once a Viewport has been created, it can be moved or resized without any loss of 
information. In addition, a Viewport's properties may be changed at any time by double clicking on the Viewport or right clicking on the Viewport, and 
selecting Properties from the secondary menu. 

Zooming and Panning in Viewports 

Zooming and Panning is possible in Viewports using the following keyboard commands: 

Command Keyboard Shortcut 

Pan-Left Ctrl+Left Arrow 

Pan-Right Ctrl+Right Arrow 

Pan-Up Ctrl+Up Arrow 

Pan-Down Ctrl+Down Arrow 

Zoom-In Ctrl+Home 

Zoom-Out Ctrl+End 

As with the View Pan commands – Viewport - Pan Left pans the focus position to the left (image shifts right), Viewport Pan Right pans the focus 
position to the left (image shifts left), etc. 

Viewport Pan uses a Pan Factor of 0.05 (5%). This means that the image is panned (moved) 5% of the total Viewport extents which each pan. Pan 
Factor can also be applied in the Viewport-Properties dialog. 

Viewport Zoom uses a Zoom Factor of 0.05 (5%). This means that the image is zoomed in or out 5% of the total Viewport extents which each zoom. 
Zoom Factor can also be applied in the Viewport-Properties dialog 

Capture to Imageport 

It is possible to capture an image displayed in a Viewport and convert it to a bitmap. The captured bitmap then becomes an Imageport. This 
procedure can be useful when you are interested in presenting your application in various stages of design. For example, luminaires only, luminaires 
and templates, luminaires and point by points. In this case, each stage of the design could be captured to an Imageport. 

Here is an example of the procedure that might be employed. Imagine that you have a job file with templates and you want to present the layout with 
and without templates. 

• Make all templates visible 
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• Enter Page Builder 

• Create a Viewport 

• Capture Viewport to Imageport 

• Exit Page Builder 

• Make all templates invisible 

• Re -enter Page Builder 

• Create a Viewport 
• You now have a Viewport showing the layout without templates and an Imageport showing the layout with templates. 

Capturing a Viewport to an Imageport effects the appearance of the image, because the original vector graphic must be presented as a raster 
graphic.  

Create Viewport 

1. From the Page Builder menu select Viewport - Create Viewport, or from the Page Builder toolbar select . 
2. Specify the opposing corners of the Viewport on the page. Specify the first corner of the Viewport by locating the cursor at the desired location 

and clicking the left mouse button. Drag the cursor to the opposing corner of the Viewport and click the left mouse button again. 
3. After the Viewport has been located and sized, the Viewport Properties  dialog will appear. Select the view that will be attached to this Viewport, 

what portion of the view will be visible, scale, border and labeling options. 
4. Click Ok to apply the Viewport Properties to the Viewport and return to the Page Builder screen.  

Viewport Properties 

The Viewport Properties dialog specifies or changes the current Viewport properties. 

Specifying the properties of a Viewport: 

1. Associated View - This section provides the active view selection from the View Name pull-down menu. 
2. View Type - Specify the portion of the view that will be displayed by selecting the appropriate radio button: Display, Extents or Limits. Changing 

the View Type will automatically reset Zoom and Pan Factors to 0 (no additional zoom or pan is applied). 
3. Zoom Factor - Indicates the level of zoom. Default Zoom = 0 (no additional Zoom applied).  

• A Zoom Factor > 0 indicates the factor (percentage) the image within the Viewport has been zoomed in, A Zoom Factor < 0 indicates 
the factor (percentage) the image within the Viewport has been zoomed out. 

4. Pan Factor - Indicates the level of panning, Left-Right and Top-Bottom. Default Pan Factors = 0 (no additional Pan applied).  

• Pan Factor Left-Right > 0 indicates the factor (percentage) the image within the Viewport has been panned right, Pan Factor Left-Right 
< 0 indicates the factor (percentage) the image within the Viewport has been panned left. 

• Pan Factor Top-Bottom > 0 indicates the factor (percentage) the image within the Viewport has been panned up, Pan Factor Top-
Bottom < 0 indicates the factor (percentage) the image within the Viewport has been panned down. 

5. Location and Size - This section allows you to override the location and size of the Viewport you specified graphically (e.g. to align and specify 
consistent sizes for multiple Viewports). 

6. Scale - This section allows you to assign a user defined scale for the Viewport contents or Scale to Fit. 

• Select the radio button adjacent to User Defined Scale and specify the scale using the current display units (ft. or m). 

Ex: 1 inch = 20 Ft. (1:500) 

• Or, select the radio button adjacent to Scale To Fit Viewport to fit the view within the selected Viewport. 
7. Border - This section offers three border styles: No Border, Border, Border with Shadow. 
8. Label - In this section you may label the Viewport by selecting various label options. To add a custom description, check the Description 

selection box and type in a custom description, up to 256 characters. Similarly, include the View Name and Scale in the labeling by clicking on 
the appropriate selection box. 

9. If desired, change the text font or text size of the selected Viewport labels. 
10. Click Ok.  

Changing Viewport Properties 

1. Move the mouse over the desired Viewport until the Arrow pointer appears. 
2. Click the right mouse button to invoke the Viewport menu. 
3. Select Properties with the left mouse button. 
4. Make the desired changes. 
5. Click Ok. 

Note: These changes can be reversed with the Undo command. 

  



AGi32 Help System  Page Builder 

479 

 

Resizing Viewports 

1. Move the mouse over the edges or corners of the desired Viewport until the Resize pointer appears: 

 

 

 

2. Click and hold the left mouse button down. 
3. Resize the Viewport as desired releasing the left mouse button when satisfied. 

Note: The view is attached to the Viewport at the upper left corner of the Viewport. Resizing from the left or right sides has the same effect on the 
view within the Viewport. The same is true when resizing from the top or bottom of the Viewport. 
This action may be undone by clicking on the Undo button on the Common Toolbar. 

Moving Viewports 

1. Move the mouse over the desired Viewport until the arrow pointer appears. 
2. Click and hold the left mouse button down until the move icon (hand icon) appears. A 1/2 second delay is to be expected. 
3. Drag the Viewport to the desired location and release the left mouse button. Viewports will snap to the nearest Snap increment specified on the 

Switches Toolbar. 

Note: You may undo this action by clicking the Undo button on the Common Toolbar. 

Deleting Viewports 

1. Move the mouse over the desired Viewport until the arrow pointer appears or click the right mouse button to invoke the Viewport menu. Select 
Delete from the menu. 

Note: You may undo this action by clicking the Undo button on the Common toolbar.  

Show/Hide Viewports 

When Viewports are shown, their contents are visible, and the cursor changes to an arrow so that the Viewport may be selected, moved, or scaled. 
When Viewports are hidden, only the Viewport border and associated text is visible, its contents are hidden. If the Viewport was created using the No 
Border option, its boundaries will not be visible on the page. 

 Toggle (Hide/Show) the Viewports by selecting this option from the Page Builder menu, by selecting it from the  or by pressing the Ctrl+D keys 
on the keyboard at the same time. 

Hide Viewports is also available from the Viewport secondary menu (right click on Viewport to show menu). 

Hiding Viewports allows the user to draw on top of the Viewport and use the Zoom-Window command within the Viewport. For example, the user can 
use call outs on top of the Viewport or add a custom frame, such as a circle. 

Page Builder does not allow the user to see the Viewport's contents or the supplementary drawing entities within the Viewport together. 
Supplementary entities will appear to be “behind” the Viewport while in Page Builder once the Viewport contents are shown again. However, both the 
Viewport's contents and any drawing entities will be visible when printed. In addition, the user may preview the combined information in the Print 
Preview dialog. 
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Show Viewports Hide Viewports 

  

Once you leave a page (e.g. switch between pages) the Viewport contents are shown again.  

Viewport-Capture to Imageport 

This command converts the image currently displayed in a Viewport to a bitmap, then converts the Viewport to a static Imageport. 

1. Move the mouse over the desired Viewport until the Arrow pointer appears. 
2. Click the right mouse button to invoke the Viewport secondary menu. 
3. Select Capture to Imageport with the left mouse button. 

  

   

  Imageports 

Page Builder Imageport - Concepts 

Imageports are static graphics windows that contain a graphic image, displayed on the current Page Builder page. The following image types are 
directly available to Imageports: 

• Rendered images 

• Defined luminaire images from the Instabase 

• Photometric Toolbox Professional images 

• Raytrace images 

• Daylight study images 

• Browse for any other graphic image in JPG, BMP or WMF format 

Once the Imageport is created, it can be moved or resized as required. Imageports always retain their original aspect ratio, so that the image within is 
not skewed or distorted. When the Imageport is resized, it will use the shortest side to determine the aspect ratio. In addition, an Imageport's 
properties may be changed at any time by double clicking on the Imageport or right clicking on the Imageport, and selecting Properties from the 
secondary menu. 
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Selecting Images 

Once an Imageport has been located, the Image contained within the Imageport may be changed at any time. The Imageport Properties dialog 
contains a Select Image button, which allows you to select an alternate image for the Imageport. 

For example, if you create a rendered image and include it in page Builder, the image does not update if the rendering changes. To change the 
rendering to the most current displayed image, use the Select Image button in the Imageport Properties dialog to load the Select Images dialog 
again. the current available rendered image (as well as current raytrace and daylight study images) will be shown and may be selected.  

Once an image is loaded into an Imageport, it is stored in an internally compressed format. Bitmap or JPEGs format files are preferred over WMF 
(metafiles) files as metafiles tend to lose resolution in the compression storage process. Metafiles are converted to bitmaps before applying 
compression. 

Pasting an image from the Windows Clipboard 

Any image copied to the Windows Clipboard may be inserted directly into an Imageport using the Edit-Paste Directly To Imageport (Ctrl+V) 
command. The Imageport is automatically sized to match the images dimensions and pasted at the upper left corner of the page. 

Pasting Photometric Toolbox Professional images 

Luminaires must be defined and Photometric Toolbox Professional (PTB) must be installed and registered in order to use this feature. 

To select a graphic image from a PTB Tool to use in an Imageport, simply copy the graphic to the clipboard (the copy button in located lower right 
hand corner of each graphic), close PTB, the image will be automatically selected. 

To select text from a PTB Tool, use the same procedure described above. Note: The Paste command only works for text pasted to the clipboard as 
Rich Text. In does NOT work for text pasted as tab delimited text (e.g. candela array). The selected text is transferred and converted to an image. 
The resultant image is resized to fit the selected text. By default, Imageports containing text are 'locked' (not resizable)  to prevent pixilation. 

Text will most likely appear distorted when viewed in Page Builder, this is normal behavior. This pixilation is due to fact that the displayed image (and 
text within) is being displayed at a much smaller size than the actual size. This affect can be overcome by zooming in to actual size. When printed, 
the text should appear with the same quality as the original text with little or no pixilation.  

Note: Page Builder pages can be outputted to a printer or electronic file (e.g. Microsoft Document Image format – MDI). 

Create Imageport 

1. From the Page Builder menu select Imageport -  Create Imageport, or from the Page Builder toolbar select . 
2. The Imageport - Select Image dialog will appear, prompting you to select from a wide variety of image types to attach to the Imageport. The 

selected image will appear as a thumbnail in the right section of the dialog box. 

• The Defined Luminaires Tab provides access to graphic images associated with Instabase photometric files. Users can also access the 
Candela distribution curve and LCS Graph from the ‘More’ photometric dialog. These images may be copied to the current Imageport 
by clicking on the small "Copy To Clipboard" icon in the lower left corner of each graph. 

• AGi32 users with Photometric Toolbox Professional can also directly access Toolbox Pro using any defined luminaire and access any 
graphic or text from any tool to include in an Imageport.  

• The Render Tab contains current Render images, Daylight Study images and Raytrace images. 

• The Browse button allows users to browse for other desirable images such as corporate logos, internet images or digital camera 
images. 

3. Click Ok to select the desired image and invoke the Imageport Properties dialog. 
4. In the Imageport Properties dialog, you will be prompted to choose a border style, location and size, image rotation and add a custom label, if 

desired. At this time, you may also reselect an alternate image with the Select New Image button. 
5. Click Ok to apply the Imageport Properties to the Imageport and return to the Page Builder screen. 

Page Builder - Paste Directly To Imageport 

This command pastes the current contents of the Windows Clipboard to an Imageport on the current Page Builder page. Any graphical image or text 
based content available on the Windows Clipboard is available to use in an Imageport.  

Select Image 

The Imageport - Select Image dialog prompts you to select one of many image types to attach to the current Imageport: 

• Rendered images 

• Defined luminaire images from the Instabase 

• Photometric Toolbox Professional images 

• Raytrace images 
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• Daylight study images 

• Browse for any other graphic image in JPG, BMP or WMF format 

How do I use the Select Image dialog? 

1. Choose the image to use in the current Imageport. The selected image will appear as a thumbnail in the right section of the dialog box. 

• The Defined Luminaires Tab provides access to graphic images associated with Instabase photometric files. Users can also access the 
Candela distribution curve from the ‘More’ photometric dialog. 

• AGi32 users with Photometric Toolbox Professional can also directly access Toolbox Pro using any defined luminaire and access any 
graphic or text from any tool to include in an Imageport.  

• The Render Tab contains current Render images, Daylight Study images and Raytrace images. 
2. If selecting an image file, click on the Browse button to select the file name. AGi32 will read bitmap, JPEG, or Windows™ metafile format (BMP, 

JPG, or WMF) files. Again, the associated thumbnail image will appear in the lower right hand corner of the dialog. 
3. Click Ok to select the desired image and invoke the Imageport Properties dialog. 

Imageport Properties 

The Imageport Properties dialog specifies or changes the current Imageport properties. 

Specifying the properties of an Imageport: 

1. In the Image section, note the image description, image filename and thumbnail graphic. These will correspond to your choice in the Imageport - 
Select Image dialog. 

2. The Image Location (Top, Left) automatically defaults to the upper left corner of the current page  - units are measured from the lower left corner 
(0, 0). 

3. The Image Size automatically defaults to the actual image size based on your current screen resolution. Imageports must maintain their aspect 
ratio relationship so that images are not distorted, therefore changing the Height will automatically change the related Width and vice versa. 

4. Locking an Imageport prevents it from being resized graphically (stretched) or through the Imageport Properties dialog. Width and Height cells 
are unavailable when an Imageport is locked.  

5. Specify the border style that will be applied to this Imageport: Border, No Border or Border With Shadow. 
6. If desired, you may add a custom label description by checking the Description selection box and typing the desired text, up to 256 characters. 
7. The Rotate button below the thumbnail image will rotate the image 90 degrees counter clockwise with each subsequent click. 
8. If desired, change the text font or text size of the Imageport label. 
9. Click Ok. 

Note: Imageport labels are attached to the lower left hand corner of the Imageport and move as the Imageport is moved or resized. The labels will 
appear in the same order on the page as in the dialog box. The Font section displays the labels, as they will appear on the page using the selected 
font and text size. 

Changing Imageport Properties 

1. Move the mouse over the desired Imageport until the Arrow pointer appears. 
2. Click the right mouse button to invoke the Imageport menu. 
3. Select Properties with the left mouse button. 
4. Make the desired changes. 
5. Click Ok. 

Note: These changes can be reversed with the Undo command. 

Resizing Imageports 

1. Move the mouse over the edges or corners of the desired Imageport until the Resize pointer appears: 

 

 

 

2. Click and hold the left mouse button down. 
3. Resize the Imageport as desired releasing the left mouse button when satisfied. 

Note: The images contained within the Imageports always maintain their original aspect ratio. Consequently, when resizing, the Imageport will 
automatically resize itself, if necessary, to maintain the aspect ratio. 
This action may be undone by clicking on the Undo button on the Common Toolbar. 



AGi32 Help System  Page Builder 

483 

 

Moving Imageports 

1. Move the mouse over the desired Imageport until the arrow pointer appears. 
2. Click and hold the left mouse button down until the move icon (hand icon) appears. A 1/2 second delay is to be expected. 
3. Drag the Imageport to the desired location and release the left mouse button. Imageports will snap to the nearest Snap increment specified on 

the Switches Toolbar. 

Note: You may undo this action by clicking the Undo button on the Common Toolbar.  

Deleting Imageports 

1. Move the mouse over the desired Imageport until the Arrow pointer appears or Click the right mouse button to invoke the Imageport menu and 
select Delete from the menu. 

Note: You may undo this action by clicking the Undo button on the Common toolbar. 
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 References 

AGi32 Files and Folders 

The AGi32 folder contains a number of files and other folders that are important to AGi32's successful function. These files and folders (please see 
complete listing below) should not be deleted or modified. AGi32 also provides the user with several folders to assist them in organizing job files, 
photometric files, and temporary job files. 

Note: AGi32 has installed several associated DLL, OCX and TLB files, in common system related areas, in addition to the above files and folders. 
Please contact LAI for assistance with these files. 

Folder File Comments 

C:\Program Files\Lighting Analysts\AGi32 

C:\Program Files\Lighting Analysts\Shared 

<Various Files> General AGi32 operational files DO NOT ALTER OR 
DELETE any files in these folders unless instructed to 
do so. 

...\AGI32\Cloud Images <Various Image Files> Cloud image files for ray tracing daylit simulations - 
DO NOT ALTER OR DELETE unless instructed to do 
so. 

...\AGI32\Color Bleed <Various Image Files> Color Bleed images - DO NOT ALTER OR DELETE 
unless instructed to do so. 

...\AGI32\FactoryPBRs <Various Page Builder Reports> Sample reports for inclusion in user's <Root 
folder>\PageBuilderReports - DO NOT ALTER OR 
DELETE unless instructed to do so. 

...\AGI32\FactorySampleFiles <Various AGi32 Job Files> Sample job files for inclusion in user's <Root folder> - 
DO NOT ALTER OR DELETE unless instructed to do 
so. 

...\AGI32\Arrangements <Various Files> Arrangement files- DO NOT ALTER OR DELETE 
unless instructed to do so. 

...\AGI32\Symbols <Various Files> Symbol files DO NOT ALTER OR DELETE unless 
instructed to do so. 

...\AGI32\Digitizer <Various Files> Digitizer drivers DO NOT ALTER OR DELETE unless 
instructed to do so. 

...\AGI32\Object Libraries <Various Files> Factory and/or custom Object Library files. Generally, 
you do not want to delete any of these files unless you 
want to remove a particular library 

...\AGI32\Roadopt <Various RTB Files> Roadway Optimizer R Tables DO NOT ALTER OR 
DELETE unless instructed to do so. 

...\AGI32\SpecLevels <Various Image Files> Specularity Level images - DO NOT ALTER OR 
DELETE unless instructed to do so. 

...\AGI32\SplashGallery <Various Image Files> Opening splash screen image files - add your won to 
customize your splash screen 

...\AGI32\Textures <Various Image Files> Texture database images - DO NOT DELETE unless 
instructed to do so. You may add images to this folder 
and update the Textures Database in AGi32 

...\AGI32\Textures\Factory Supplied <Various Image Files> Factory shipped sample textures for AGi32. Updates 
for incremental versions are found in this folder. 

File System Folders and Files 

<Root folder> <Various AGi32 Job Files> This folder contains ready to use sample job and 
tutorial files. 

<Root folder>\JobFiles *.AGI This is the default folder for AGi32 Job Files, however, 
you can store and retrieve Job Files on any device or 
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folder. 

<Root folder>\CADFiles_Export   This is the default folder for exported CAD files, 
however, you can store and retrieve DWG/DXF files 
on any device or folder. 

<Root folder>\CADFiles_Import   This is the default folder for imported CAD files, 
however, you can store and retrieve DWG/DXF files 
on any device or folder. 

<Root folder>\CADFiles_Import_Maps   Folder for storing automatically saved and user 
defined import maps generated from the Import CAD 
File dialog. 

<Root folder>\PhotometricData_Files <Various Files> This folder and sub-folders are created after setting up 
AGi32 Photometric Database(s). The folder contains 
photometric files and images. 

<Root 
folder>\PhotometricData_FilesFromJobFile 

  This folder contains photometric files from previously 
opened job files with no locally recognizable path. 

<Root 
folder>\PhotometricData_PDPPackageFiles 

  This folder contains photometric package files for use 
with the AGi32 Instabase. 

<Root folder>\PageBuilderReports   This is the folder containing AGi32 Page Builder 
reports. In order for existing reports to be visible in the 
Load Existing Reports tab in Page Builder, page 
builder reports must be located in this folder only. 

C:\Documents and Settings\<Username>\Local 
Settings\Application Data\AGI32\Temporary 

<Various Files> This folder is used for temporary working files. This 
folder should be empty unless you suffer a crash. You 
can delete any files in the folder as long as AGi32 is 
not active. 

C:\Documents and Settings\<Username>\Local 
Settings\Application 
Data\AGI32\Temporary\Working 

*WRK.AGI This folder contains temporary Job Files. If you suffer 
a crash during operation, you may be able to recover 
your work using a temporary Job File (please see 
“System Crash Job File Recovery Procedure”). 

C:\Documents and Settings\<Username>\Local 
Settings\Application 
Data\AGI32\Temporary\Render 

<Various Files and Folders> This folder and sub-folders are used to store 
temporary render files. This folder should be empty 
unless you suffer a crash or have selected not to 
delete these files (see [CMD] System Settings-
Advanced Settings). You may delete any files in this 
folder as long as AGi32 is not active. 

   

IESNA Standard File Format 

The majority of lighting fixture manufacturers are currently employing the IESNA standard recommended file format for luminaire photometry (IES 
document LM-63-2002). 

The ASCII file format is shown below. This is exactly how any IES format file should appear when listed directly from a text editor. The standard for 
this format is included in the lighting method documentation LM-63 available through IESNA (www.iesna.org). 

IES File Format 

Each line marked with an asterisk must begin a new line. Descriptions enclosed by the brackets"<" and ">" refer to the actual data stored on that line. 
Lines marked with an "at sign" @ appear only if TILT=INCLUDE. 

All data is in standard ASCII format. 

 *IESNA:LM-63-1995 

*<keyword [TEST]> 

*<keyword [MANUFAC]> 

*<keyword 3> 

 " 

*<keyword n> 
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*TILT=<filespec> or INCLUDE or NONE 

@ *<lamp to luminaire geometry> 

@ *<# of pairs of angles and multiplying factors> 

@ *<angles> 

@ *<multiplying factors> 

*<# lamps><lumens/lamp><multiplier> <# vertical angles> 

<# horizontal angles><photometric type><units type>  

<width><length><height>  

*<ballast factor><ballast lamp factor><input watts> 

*<vertical angles> 

*<horizontal angles> 

*<candela values for all vertical angles at first horizontal angle> 

*<candela values for all vertical angles at second horizontal angle> 

* " 

* " 

<candela values for all vertical angles at last horizontal angle> 

NOTE: At the time of release of this publication some luminaire manufacturers do not employ the IESNA:LM-63 keyword scheme. Lighting Analysts 
programs do not require the IESNA:LM-63 keywords, however, the AGi32 Instabase uses keywords if present. Without keywords, all information 
preceding the TILT= line is read as descriptive information.  

  

  

AGi32 Roadway Luminance Calculations With Reflective Surfaces 

This topic outlines the procedure and calculation methodology used to consider reflective surfaces in roadway luminance calculations. The primary 
application of this methodology is tunnel lighting, although many applications may be applied, such as overpasses, signage, etc. 

The calculation methodology/procedure uses techniques outlined in the IESNA Recommended Practice for Tunnel Lighting, RP-22. The calculations 
are limited to straight sections of roadway only and do not consider daylight at this time. 
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Calculation Method Application 

When Full Radiosity Method is enabled, reflective surfaces are considered as reflectors and obstructors. When Direct Only Method is enabled, 
reflective surfaces are considered as obstructions only, they do not reflect light (only the direct component is used). 

Environment Components: 

Roadway Pavement Surface (RPS): 

• Surface Type: (40)-Single-Sided Roadway Pavement (Direct Flux Only)  

• This surface type is considered in radiosity calculations; however, it receives and reflects direct flux only 

• Reflectance is derived from the Q0 value (R = Q0 * Π) for the road surface, as determined by the pavement's R classification. Reflectance value 
is assigned once the roadway grid is specified. 

• If roadway calculations are not being performed (no roadway grid), this surface is considered as type (10)-Single-Sided  and Direct Flux Only 
attribute is applied. 

• It is not necessary to apply a roadway grid to RPS’s; the calculation grid can be specified and located independently 

Roadway Contributing Surface (RCS): 

• Surface Type: (41)-Single-Sided Roadway Contributor 

• This surface type is considered in radiosity calculations and in indirect-component roadway calculations  
• If roadway calculations are not being performed (no roadway grid is placed), this surface is considered as type (10)-Single-Sided 

Environment Construction: 

•••• Automated: 

•••• Room-Rectangular-Vertical Extrusion – Make Room Into A Roadway Tunnel. When this option is selected, the following changes 
occur: 

•••• Label = ‘Tunnel’ (default) 
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•••• Room has open ends (default) 

•••• Ceiling and walls are specified as Roadway Contributing Surfaces 

•••• Floor is specified as a Roadway Pavement Surface; floor reflectance specified in dialog is ignored. Floor reflectance is based on 
assigned R-table  

•••• Calculation-Roadway Luminance: Create Roadway Luminance grid in normal fashion 

•••• Manual: 

• Construct environment using existing tools (for tunnels, it is recommended to use open ended ‘rooms’) 

• Using Surface Edit: Change surfaces to Roadway Pavement Surfaces or Roadway Contributing Surfaces as appropriate. Note: Make 
sure all surfaces are facing appropriate direction. 

• Calculation-Roadway Luminance: Create grid in normal fashion 

Calculation Process: 

Calculating direct component: 

• Use existing methodology 

• Obstructions from luminaires to Roadway Pavement Surface and to observer are considered (see graphic below). 

• Calculate Full Radiosity solution (Note: This is different than RP-22): 

• When a Roadway Luminance grid is specified, only Roadway Pavement Surface and Roadway Contributing Surface types are used in the 
radiosity solution; no other surfaces are considered, nor are they visible in Render Mode 

• Roadway Pavement Surfaces (RPS) only receive and reflect direct component; this prevents ‘double-dipping’ (receiving reflected component 
twice) 

• Obstruction from luminaires to Roadway Contributing Surfaces and between Roadway Contributing Surfaces are also considered (included in 
normal radiosity calculations) 

• Obstructions are considered for these conditions: 

 

Calculating indirect component: 

Obstructions from Roadway Contributing Surface to Roadway Pavement Surface are considered, as are obstructions from Roadway Pavement 
Surface to Observer. 

In final calculations, all surfaces are assumed to be double-sided; however in Render Mode Roadway Contributors and Pavement surfaces are 
single-sided. 

• Break all Roadway Contributing Surfaces into zones (Zone Size ≤ 1m
2
). Actual zone size is based on Minimum Surface Dimension (MSD): 

• If Minimum Surface Dimension is ≤ 1m, then Zone Size = MSD
2
 

• If Minimum Surface Dimension is >1m, then Zone Size = (MSD / (Int(MSD) + 1))
2
. For example: If Minimum Surface Dimension = 

25.5m, Zone Size = 25.5/(25+1)
2
 = 0.98m

2
 

• Calculate exitance (Point Spacing = Zone Size). Automatic Placement points are used 

• Using exitance value, calculate intensity Iδ (cd) reflected by zone to pavement observation point (calculation point). 

Formulas: 
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I’ = Lo * Ao 

Where: 

Lo = Zone luminance = Exitance / π (Lambertian reflection is assumed.) 

Ao = Zone size in m
2
 

Iδ€ = I’ * Cos(δ) 

€ 

Where: 

Cos(δ) = Cosine of the angle between the normal to the zone surface (direction of I’) and the line from the zone center to the roadway observation 
point (calculation point) (Lambertian reflection) 

Each zone is treated as a luminaire and calculations are completed using existing methodology . 

   

Terminology Definitions 

Throughout the HTML help you will find terminology that refers to specific parts of the AGi32 software or processes involved. These terms are not 
arbitrary or intended to confuse those not current in computer lingo! We have actually given careful thought to most terms and you will find their 
definitions in the text that follows. 

Controls 

The term Control is of technical origin and refers to a mini program that is used to control access, or interface with, certain types of information. 
Examples of typical controls include the following: Text box, Combo box, Pull-down menu, Pop-up menu, Option button, Check box, Scroll bar, Tab, 
Command button, Tree view, List box, Updown button, Picture box, Drivelist box, Dirlist box, Filelist box, Common dialog, Progress bar and Grid. 

Job File 

The job file is the computer file that you use to save the job(s) you work on. AGi32 Job files carry the extension AGI. Example: Downtown Pedestrian 
Mall.AGI 

Project 

A Project is a subset of your Job file that may contain computations for any portion of your application. For example, when running multiple interior 
spaces in a single job file you may want to separate them into multiple Projects. Projects can be locked such that they are not computed when 
working on other portions of your job file. Projects can be manipulated using the AGi32 Project Manager. A single Job file may contain multiple 
Projects. 

AGi32 Desktop 

Desktop refers to AGI32’s main interface screen. The Desktop contains all of the Pull-down menus, Toolbars, and Graphics Windows related to the 
program operation. Technically, the AGi32 Desktop is a MDI (Multiple Document Interface) form. 

Toolkits and Toolbars 

Toolbars contain collections of buttons designed to access most of AGi32's most commonly used commands eliminating the need to search for a 
command in the pull-down menu structure. 

Graphics Window 

The graphics window is another description for the active area in which you create your projects. The Graphics Window can contain a number of 
different Views as created in the AGi32 View Manager. 

Dialog 

A Dialog is an interactive window or form that appears when certain functions are activated (as in carrying on a dialog with AGi32!). An example of a 
Dialog is the Define Luminaire portion of AGi32. This command actually has multiple dialogs associated with it. Essentially, any time you execute a 
command and an interactive window appears requesting input, you are looking at a dialog. 
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MultiUse Dialog 

The MultiUse Dialog is covered by the previous definition as well, but can be accessed from different commands. An example of this is the Color 
Dialog box. Many MultiUse dialogs are Windows Common Dialogs meaning they are standardized among applications and available to any 
developer. 

Mouse Pointer 

The mouse pointer is the standard Windows mouse icon. (Set by 
system defaults).  

Cursor 

The cursor can either be crosshairs, or a pick box in the Graphics 
window depending on the status of the command being carried 
out.  

 

Command Line 

The AGi32 Command Line can be found across the bottom left corner of the AGi32 Desktop (screen). The Command Line always displays the status 
of the current command in progress and prompts for action by the user. Data entry can also be accommodated on the Command Line when the 
command in progress is waiting for coordinate entry.  

 

Tilt Correction factors 

Luminaires containing Metal Halide lamps often require a correction factor to be applied when the luminaire is tilted. The specific correction factors 
are contained in the IES format photometric file and are the responsibility of the luminaire manufacturer. Luminaires whose photometric files contain 
tilt information will have tilt correction factors applied whenever the luminaire is tilted. Specifically, when the luminaire is located, re-aimed or edited, 
the tilt information is extracted from the photometric file and the tilt correction is calculated. AGi32 looks at the luminaires tilt angle and compares it to 
tilt angles and respective tilt factors within the photometric file. If the file does not contain the tilt angle, AGi32 interpolates between the supplied 
angles to obtain the tilt correction factor. The tilt correction factor is then applied to the calculated illuminance from the tilted luminaire. This process is 
repeated for each luminaire in the job file employing a tilt. 

The following metal halide tilt correction factors have been provided courtesy of Venture Lighting International, Inc. 

Tilt Angle from Nadir (in degrees) Lamp = 1000/U Lamp = 1500/HBU 

0 1.00 1.00 

15 0.97 0.97 

30 0.94 0.94 

45 0.90 0.90 

60 0.88 0.88 

75 0.87 0.87 
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90 (horizontal) 0.98 0.98 

The tilt factors and relative angles are contained in the IES format file. For more specifics please refer to IES document LM-63 or additional data 
provided here. 

Per IESNA Standard file format, tilt correction is applied only to all tilted luminaires, and does not account for other aiming angles, such as Roll and 
Spin. In addition, the tilt correction factor is applied to tilted luminaires regardless of lamp to luminaire geometry. Refer to IESNA LM-63 for detailed 
technical information. 

The Luminaire Location Summary will contain tilt correction factors (TCF) for each luminaire placed on the drawing. Luminaires whose photometric 
report does not include tilt data will have a TCF equal to one. Luminaire arrangements and luminaire groups will have an average TCF calculated. In 
addition, an average TCF will be calculated for all luminaires.  

  

  

System Parameters 

The factory settings for all system parameters are defined below. 

System Settings 

Parameter Factory Setting Included in Job File 

Display Units Ft Yes 

Numeric Units Fc Yes 

Number Decimals 1 No 

Mark Points False (Off) No 

Numeric Ratios Avg/Min, Max/Min Yes 

Project Name Project_1 Yes 

Locked Color - Color used for locked entities. Lt. Gray (Windows Color Number = 12632256) No 

Selected Color - Color used for selected entities. Gray (Windows Color Number = 8421504) No 

Temporary On Color - Color used for entities that are 
temporarily on (i.e. replacing calculation points). 

Red (Windows Color Number = 255) No 

Calc. Areas Text Color - Default color for Calculation 
Points text in the Statistical Summary Window. 

Red (Windows Color Number = 255) No 

Stat Areas Text Color - Default color for Statistical 
Area text in the Statistical Summary Window. 

Blue (Windows Color Number = 16711680) No 

LPD/UWLR Areas Text Color - Default color for 
LPD/UWLR Area text in the Statistical Summary 

Window. 

Green (Windows Color Number = 65280) No 

Model Mode Background Color Windows background color Yes 

Isometric Rotation Angle - Rotation angle used for 
Default isometric view. 

-30 No 

Isometric Tilt Angle - Tilt angle used for Default 
isometric view. 

60 No 

Entity Dialog Defaults Reset With Each File (New or Open) No 

Reset To Factory Settings Now False (Unchecked) No 

Zoom Factor - Zoom in/out factors used for Default 
View Factors. 

1.25 No 

Pan Factor - Pan factor used for Default View Factors. 1.25 No 

Dimension Precision - Precision (number of decimal 
points) used for dimensions. 

3 No 

Virtual Axis Display Location - Controls display and Attached to virtual axis X, Y coordinates No 
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location of virtual axis. 

Virtual Axis X-location - X-location for virtual axis if 
axis location is attached to coordinates. 

0 No 

Virtual Axis Y-Location - Y-location for virtual axis if 
axis location is attached to coordinates. 

0 No 

Smart Text On - Controls display of smart text strings. 
If true (on) - smart text string is substituted, if false 

(off) - actual smart text string is displayed. 

True (On) No 

Undo/Redo On - Undo Status (True - On, False, Off) True (On) Yes 

Calculation Method Full Radiosity Yes 

Ortho Mode On - Status of Ortho Drawing mode False (Off) Yes 

Auxiliary Coordinate Display False (Off) No 

Model Mode Snap On True (On) Yes 

Model Mode Snap Value 0.5 Yes 

Model Mode Color Black (0) Yes 

Model Mode Line Type Solid Yes 

Model Mode Line Width 0 (Pixel) Yes 

Page Builder Mode Snap On True (On) Yes 

Page Builder Mode Snap Value 0.1 Inch, 10mm Yes 

Page Builder Line Color Black (0) Yes 

Page Builder Line Type Solid Yes 

Page Builder Line Width 0 (Pixel) Inch, 0 (Pixel) mm Yesy 

Smart Symbols - Full Radiosity Method - enables 
Smart Symbols in Full Calculation mode 

True (On) NO 

Smart Symbols - Direct Only Method - enables Smart 
Symbols in Direct Calculation mode 

True (On) No 

Default Model Symbol Box Down No 

Default Render Symbol Box Down No 

Font Name - default font used for illuminance values, 
etc. 

Courier New No 

Font Characteristics (1 - Bold, 2 - Italic, 4 - Underline, 
8 - Strikeout) 

Normal No 

View Name - Name for startup view. View_1 No 

View - X minimum - X minimum coordinate for startup 
view. 

0 No 

View - X maximum - X maximum coordinate for 
startup view. 

100 No 

View - Y minimum - Y minimum coordinate for startup 
view. 

0 No 

View - Y maximum - Y maximum coordinate for 
startup view. 

100 No 

Maximum Steps - Sets maximum allowed Radiosity 
calculation steps. 

1000 Yes 

Stopping Criterion (% Light Absorbed) - Stopping 
criteria for Radiosity calculations. 

99 Yes 

Render Image Refresh Interval (%) - Percent change 
in light absorbed between displaying updated render 

image. 

10 Yes 

Adaptive Subdivision On False (Off) Yes 

Maximum Subdivision Level - Number of subdivisions 
applied to elements when adaptive subdivision is 
enabled. Each level subdivides elements into two 

smaller elements. 

3, for both sections Yes 
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Minimum Element Area - Minimum element area size. 
Determines the smallest element that will be produced 

by adaptive subdivision. 

0.5, for both sections Yes 

Element Luminance Threshold - Determines the 
maximum allowable threshold difference between 

adjacent elements. 

1.5, for both sections Yes 

Save Rendered Environment True (On) Yes 

Anti-Aliasing Sampling Level None Yes 

Compress Job File When Saving True (On) Yes 

Automatically Create Job File Backup True (On) Yes 

Prompt For File Information Before Closing File True (On) Yes 

Enable Automatic File System Cleanup True (On) No 

Auto Save Reminder True (On) No 

Save Reminder Increment - time (in minutes)between 
reminders 

15 No 

Save Display Reminder - displays a reminder to save 
instead of saving automatically. 

True (On) No 

File Locations Root Folder Location No 

Advanced System Settings 

Parameter Factory Setting Included in Job File 

Ghost Image - Repaint Cutoff Increment - Sets cutoff 
distance (in twips) to repaint ghost image (i.e. - when 

moving entities). If distance > cutoff, image is not 
painted. Prevents program from repainted ghost 

image for every move of the cursor. 

250 No 

Ghost Image - Number of Entities Cutoff - Sets cutoff 
for displaying complete ghost image or cube covering 
extents of image. If number of entities > cutoff, "cube" 

is displayed instead of entities; 

1000 No 

Ghost 2D Image - Number of Entities Cutoff - Sets 
cutoff for displaying complete 2D ghost image or 

partial image (2D ghost image is used for luminaires 
to prevent "wash-out" of stacked segments). If number 
of entities exceeds cutoff; entities list is incremented 
by Ghost 2D Image - Segment Step, otherwise, list is 

incremented by 1. 

500 No 

Ghost 2D Image - Segment Step - Sets increment 
step for entity list if number of entities exceeds Ghost 

2D Image - Number of Entities Cutoff. 

3 No 

Initial Curve Increment (Degrees) - Sets initial 
increment for curves in degrees (i.e. - circle, arc). For 
example; with a setting of 15, a circle will be created 
with 24 segments (360/15). Changing this parameter 

does not effect existing entities. 

15 No 

Font - Line Segments Per Line - Sets the number of 
selection lines per line of text. The higher the number, 
the easier it is to select a line of text (for modification). 

Higher numbers increase redraw time and file size. 
Changing the parameters does not effect existing text 

entities. 

8 No 

Direct Calc Mode Limiting Value -This setting specifies 
the minimum testing footcandle value required to 

determine whether the contribution from a luminaire is 
considered in Direct Calculation Mode. 

0.0025 No 

Surface View Mode - Tolerance - indicates the 
distance (in feet or meters)within the Surface View 

0.2 No 
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command that entities located within the tolerance 
limit are displayed. 

Import Text - Size Factor - Factor applies to text when 
importing from DXF or AGI-DOS. Text in those files is 
based on actual size, text in AGi32 is based on font 

glyphs. 

2 No 

Import Text - Offset Factor - Factor applied to offset of 
text when importing from DXF or AGI-DOS. Text in 

those files is placed on the baseline coordinates of the 
text, text in AGi32 is placed below the baseline 

coordinates of the text. 

1.5 No 

Flip Color Tolerance - This setting will flip an entity 
color to the opposite color if the RGB components of 
the entity minus the Flip Color Tolerance is equal to or 
less than the RGB components of the background 
color. 

128 No 

Snap To – Initial Tolerance - This setting specifies the 
initial tolerance distance (in the current units - ft, 

meters, inches or mm) for drawing entity endpoints to 
be selected as potential Snap To points. 

2 No 

Snap To – Final Tolerance - This setting determines 
the final tolerance distance (in current units) to the 

drawing entity endpoint from the cursor for it to 
become the actual Snap To point. 

0.05 No 

Snap To – Mouse Detect (Pixels) - This setting 
determines the pixel amount the cursor needs to move 

in order for the Snap To command to search for 
potential Snap To points. 

3 No 

Max. Imported Surfaces Per Layer - This setting is 
used with imported #D CAD files. Layers with more 
than the indicated setting will be split into multiple 

layers. 

5000 No 

3D Entity Check Range - This setting indicates the 
percentage of entities within an object checked for 

duplicate surfaces and consistent surface orientation. 

0.25 No 

Initial Meshing - General Surface Types - Mesh 
Length Setting 1 in feet 

8 Yes 

Initial Meshing - General Surface Types - Mesh Patch 
Size Setting 1 in feet 

2 Yes 

Initial Meshing - General Surface Types - Mesh 
Length Setting 2 

32 Yes 

Initial Meshing - General Surface Types - Mesh Patch 
Size Setting 2 

4 Yes 

Initial Meshing - General Surface Types - Mesh 
Length Setting 3 

128 Yes 

Initial Meshing - General Surface Types - Mesh Patch 
Size Setting 3 

8 Yes 

Initial Meshing - General Surface Types - Mesh 
Length Setting 4 

384 Yes 

Initial Meshing - General Surface Types - Mesh Patch 
Size Setting 4 

12 Yes 

Initial Meshing - General Surface Types - Mesh Patch 
Size Setting 5 

16 Yes 

Initial Meshing - General Surface Types - Element 
Size Factor (x Patch Size) 

0.5 Yes 

Initial Meshing - Transition Surface Types - Mesh 
Length Setting 1 in feet 

8 Yes 

Initial Meshing - General Surface Types - Smart 
Meshing 

True (On) Yes 

Initial Meshing - Transition Surface Types - Mesh 2 Yes 
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Patch Size Setting 1 in feet 

Initial Meshing - Transition Surface Types - Mesh 
Length Setting 2 in feet 

16 Yes 

Initial Meshing - Transition Surface Types - Mesh 
Patch Size Setting 2 in feet 

2 Yes 

Initial Meshing - Transition Surface Types - Mesh 
Patch Size Setting 3 in feet 

4 Yes 

Initial Meshing - Pole/Pendant Patch Level 0 Yes 

Initial Meshing - Pole/Pendant Element Level 1 Yes 

Initial Meshing - Luminaire Symbol Patch Level 0 Yes 

Initial Meshing - Luminaire Symbol Element Level 1 Yes 

Minimum Luminaire Segment (in feet) 1 Yes 

Force Luminaire Subdivision False (Off) Yes 

Secondary Sources False (Off) Yes 

Secondary Sources Threshold Value 0.01 (1%) Yes 
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 AGi32 Setup 

Installation & License Manager 

Installation and License Manager - Concepts 

AGi32 and Photometric Toolbox Licenses 

There are a variety of licensing types to assist Lighting Analysts' customers with their software needs. The descriptions below will help you to learn 
more about the various types of installation and licensing options. 

Single User License 

A Single User license allows users to access the installed software (AGi32 or Photometric Toolbox) on one computer at a time. The license can be 
used on a work PC, home PC, or laptop, but not at the same time. This license can be converted to a Network License through the purchase of the 
Network Service, or shared using the License Sharing feature (see License Sharing below). 

License Sharing 

License Sharing can be activated for a Single User or Term License. There are two different and separate types of sharing: Simple Sharing and 
Advanced Sharing. Simple Sharing is a feature included in the Single User License. See Simple Sharing. Advanced Sharing is more robust and 
offered for a fee. Advanced Sharing allows users to share up to five licenses with up to ten distinct computers. Find all the details under Advanced 
Sharing. 

Single User Term License 

The Single User Term License is a full license with a specific term (time limited duration). The license term is determined at the time of purchase. At 
the conclusion of the purchased term, the license expires. License keys are auto-generated once an order is fully processed. 

Network License 

Network licensing for AGi32 and Photometric Toolbox products can be purchased for companies requiring access to the software among multiple 
users concurrently. The Network Service software is installed and registered (keyed) on your server, allowing the client machines to access AGi32 or 
Photometric Toolbox licenses over the network. The LAI Network Service does not depend on an Internet connection, so it is ideal for closed LAN 
and WAN systems. The Network Service can operate on any Windows based server with a static IP address within the appropriate class-B subnets. 
Clients must have a persistent connection to the server where the LAI Network service is installed and running. See Network License Installation. 

Trial License 

A Trial License provides a fully functional version of the software for a designated trial period. This period consists of a predetermined number of 
days and/or startups, as set by Lighting Analysts. A Trial License requires an installation key that is e-mailed to the address you enter when 
registering.  

Educational License 

Lighting Analysts is pleased to support university-level lighting education with our Educational License (EDU). The Educational License is available at 
no charge to university-level lighting educators to incorporate AGi32 and Photometric Toolbox into their curriculum. The Educational version is 
identical to the regular version, with the exception that the EDU license carries an established expiration date. If you don't know your account 
number, please contact the faculty member in charge of license administration. 

Installation and License Manager 

AGi32 and Photometric Toolbox Licenses 

There are a variety of licensing types to assist Lighting Analysts' customers with their software needs. The descriptions below will help you to learn 
more about installation and licensing procedures for the various licensing options. 

Single User License 

A Single User License allows users to access the installed software (AGi32 or Photometric Toolbox) on one computer at a time. The license can be 
used on a work PC, home PC, or laptop, but not at the same time. This license can be converted to a Network License through the purchase of the 
Network Service, or shared using the License Sharing feature (see License Sharing below). 
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Single User License Installation: 

1. From the start up dialog box, select Single User License. 
2. Click on the request key link and then enter the user information; LAI####, E-Store password and e-mail address are required. Your E-

Store password must match the password we have on file for you; if you have misplaced your password, click the link provided). 
3. When your order has been completely processed, your license key is auto-generated and the installation is automatically activated. 

This also applies to existing users who are upgrading. 
4. The license key will also be e-mailed to the address you entered; the license key can be cut and pasted from the e-mail if necessary. 

Convert Single User License to a Network License: 

1. Open the program. From the Tools menu, select Installation and License Manager. 
2. Select Convert to Network License. 
3. A prompt will ask you if you really want to convert; select Yes. 
4. Click on the Request Network Access Key link and enter the user information; LAI#### and e-mail address (optional) 
5. Your Network Access Key is auto-generated, and the installation is automatically activated for network use. 
6. Enter the server IP address where the LAI Network Service is installed. 
7. IMPORTANT: Your Single User License will no longer be valid. 

Single User Licenses can be transferred two ways. 

Not using license sharing:  

1. Uninstall the program from computer A from the computer's Control Panel.  
2. Install the program on Computer B, and follow the instructions above to activate a Single User License, or below to activate a 

Single User Term License, depending on the type of license you have. The License key will automatically be generated and the 
installation activated!  

Using license sharing: 

1. Set up Simple License Sharing on computer A by following these steps: 
2. From an active Single User License installation, on the Tools menu, select Installation and License Manager.  
3. Click Set up License Sharing.  
4. Set up License Sharing on computer A.  
5. Activate Shared License on Computer B.  
6. Check out Shared License permanently on Computer B. 
7. More information on License Sharing can be found via the links in the next section. 

License Sharing 

License Sharing can be activated for a Single User or Term License. There are two different and separate types of sharing: Simple Sharing and 
Advanced Sharing. Simple Sharing is a feature included in the Single User License. See Simple Sharing. Advanced Sharing is more robust and 
offered for a fee. Advanced Sharing allows users to share up to five licenses with up to ten distinct computers. Find all the details under Advanced 
Sharing. 

Single User Term License 

The Single User Term License is a full license with a specific term (time limited duration). The license term is determined at the time of purchase. At 
the conclusion of the purchased term, the license expires. License keys are auto-generated once an order is fully processed. 

Activating a Term License: 

1. From the startup dialog, select Term License. 
2. Click on the Request License Key link. 
3. Enter the user information: LAI####, E-store password, E-mail address and Term License Code. The Term License Code is a unique 

code given to you or your company when a Term License is ordered through our E-Store. Check the e-mail you received when you first 
placed the order; it will contain your Term License Code. If you don't have the Code, you may leave this field blank. However, receiving 
your License Key may then take up to 72 hours. 

4. If your order is still processing, you will be notified to check back later for your key. 
5. The program will open and operate under the available term. 

Details of the Term License: 

A Term License can utilize Simple License Sharing; please see License Sharing, above. 

Network License 

Network licensing for AGi32 and Photometric Toolbox products can be purchased for companies requiring access to the software among multiple 
users concurrently. The Network Service software is installed and registered (keyed) on your server, allowing the client machines to access AGi32 or 
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Photometric Toolbox licenses over the network. The LAI Network Service does not depend on an Internet connection, so it is ideal for closed LAN 
and WAN systems. The Network Service can operate on any Windows based server with a static IP address within the appropriate class-B subnets. 
Clients must have a persistent connection to the server where the LAI Network service is installed and running. See Network License Installation. 

Trial License 

A Trial License provides a fully functional version of the software for a designated trial period. This period consists of a predetermined number of 
days and/or startups, as set by Lighting Analysts. A Trial license requires an installation key that is e-mailed to the address you enter when 
registering. Please make sure you enter a valid e-mail address to receive the installation key for your Trial License. 

Important: If you do not enter a valid e-mail address, you will not be able to receive your key to use the Trial. 

Installing a Trial License: 

1. From the startup dialog box, select the Register Trial License button (Under Try or Purchase Products). 
2. Enter the descriptive information. A valid e-mail address is required. 
3. The License Key is sent to the e-mail address entered. 

Activating the Trial License: 

1. Once the e-mail containing your license key arrives, select Trial License from the startup dialog box (Under Activate Installation). 
2. Cut and paste the License Key from the e-mail into the License Key field. 
3. Click Activate. 
4. The program will now operate for the designated trial period. 

Details of the Trial License: 

• Trial Licenses are available in the current program version only. 
• Only one Trial License will be issued per computer and per major version of the software (2.1, 2.2, etc.) 

Educational License 

Lighting Analysts is pleased to support university-level lighting education with our Educational License (EDU). The Educational License is available at 
no charge to university-level lighting educators to incorporate AGi32 and Photometric Toolbox into their curriculum. The Educational version is 
identical to the regular version, with the exception that the EDU license carries an established expiration date. If you don't know your account 
number, please contact the faculty member in charge of license administration. 

Educational License Installation: 

1. From the Startup Dialog box, select Temporary License. 
2. Click the Request License Key button. 
3. Enter the account number, LAI####EDU. 
4. Enter your user information. A valid e-mail address is required. 
5. When the e-mail containing your license key arrives at the address you provided, select Temporary License from the startup dialog box. 
6. Cut and paste the License Key from the e-mail into the License Key textbox. 
7. Click Activate. 
8. Or, (in the startup dialog box), click the Request Temporary License Key link again and re-enter the license request. If the key has been 

processed, the key will automatically be activated. 
9. Once your license expires, the program will revert back to the startup dialog box.  

Network Licensing Details 

Network License Installation Details 

IMPORTANT! You must first install and start the license service on the server before the AGi32 clients may connect to it. 

This document is intended for IT personnel and system administrators. If you have any questions please contact Lighting 
Analysts, Inc. 

This document covers the installation of the server and client-side software as well as moving, updating and adding licenses 
to the service. 

The network license configuration for Lighting Analysts software products consists of a small Windows application (LAI 
Network Service Configuration) that is installed on the server, a “Service” that is started by that application (LAI Network 
Service), and the AGi32 and Photometric Toolbox client-side applications. The server-side software is used for all private 
network configurations serving prescribed IP address ranges. 

 WARNING! 
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IP Addressing: A.B.C.D 
The network service is able to serve all addresses with identical A and B 
components. 

Example: Server IP is: 192.168.1.1 Client IP’s can 
be: 192.168.x.x 

Exceptions for non-routable IP’s: the service can serve clients in non-
routable zones as shown at right. 

10.x.x.x 192.x.x.x 172.x.x.x 

 

1) System Requirements: 

Network License Server: 

Pentium IV or better 

Windows 2000 Professional, XP or Server 2003 or better 

Ethernet connection w/ IPv5 or 6 TCP/IP 

Static IP address 

Administrative Access on the system 

Client AGi32 machines: 

Pentium IV or better 

Windows XP or Vista 

Ethernet connection. 

Static or Dynamic (Bootp/DHCP) IP address within the same class C subnet as the server. 

Address Range: 

WAN Clients must be in the same Class A and B subnet as the server (i.e. within the first two octets of an IPv4 address). For instance, a 
server with an IP address of 69.56.10.1 could serve any clients within the range of 69.56.0.0 to 69.56.255.255. 

LAN Clients must be in the same Class A subnet as the server (for non-routable Class A subnet addresses: 10, 172 and 192). For instance, 
a server with an IP address of 192.168.55,1 could server clients within the range of 192.0.0.0 to 192.255.255.255.  

2) Installation & Licensing 

IMPORTANT: If you are replacing the Version 2.0x LAN or WAN service with the new Version 5.1 LAI Network Service, please follow the De-
authorization instructions in Step 4 below. 

The License "Server" does not require an extensive server with excessive memory. It can be any computer on the same local network as the 
workstations running AGi32. It could even be one of the workstations running AGi32. As long as the machine is on, the license service will be 
running.  

The LAI Network Service Software is licensed for use on both Local Area Networks (LAN) and Wide Area Networks (WAN). There is no license 
restriction on the client locations. 

Definitions 

Server: The machine that the license service is running on. This can be any Windows NT, Windows 2000, Windows XP, Windows 2003 
server, or Windows .NET server. 

Configuration software: The application that installs on your server that is used to install the service and register it with the system. This 
software contains your installation key and can stop and start the service as required. It also contains logging and laptop checkout features. 

Service: The licensing program running on the server that communicates with client copies of AGi32 & PTB. It is constantly running in the 
background of the server and automatically starts with each reboot. 

IP Address: Address of a machine, four numbers connected with decimals: (i.e. 10.0.0.32 or 192.168.1.4; each set between periods is 
between 0 and 255). Addresses read A.B.C.D, similar to a postal address; A is the “state,” B is the “city,” C is the “street,” and D is the “unit 
number,” although addresses do not refer to actual geographic locations. 

The following steps A through F are an abbreviated description of how to install the server-side configuration software, register the service, start it on 
the server and install the client software. Each step is discussed in detail following the condensed instructions. 

Condensed Instructions 

A. Set up the LAI Network Service Configuration Software on the server. 
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B. Step (1) - Register the license service with the operating system (Register button). 

C. Step (2) – Start the service (Start Service button). 

D. Step (3) – Request the license key from Lighting Analysts. 

a. Select the Request License Key button. 

b. Complete the form and click Submit. 

c. On the web-based registration screen, confirm your e-mail address and click the Register button at the bottom of the page. The 
license key is returned to you via email. Turn-around may be up to 72 hours. 

d. Paste the returned license key into the field provided. 

e. Select the Activate Key button. 

E. Close the LAI Network Service Configuration program; the service is now running continuously. 

F. Install AGi32 and/or Photometric Toolbox Pro on the client machines.  

A – Set up the LAI Network Service Configuration Software on the server 

1. Begin by locating the server-side software component you have either downloaded or been supplied on CD (it is not on the AGi32 product 
CD). The Setup file is titled LAI_Network_Service-Setup.exe 

2. Run the Setup by double clicking on the file. This will install the LAI Network Service Configuration software, which is used to administer 
the networking components. It must be installed on the server. 

3. Start the newly installed LAI Network Service program as follows: 

Start->Programs->Lighting Analysts->LAI Network Service-Configuration 

The LAI Network Service Configuration program will open as seen below: 

 

Figure 1 -- LAI Network Service Confuguration software as it first opens. 

B – Register the license service with the operating system 

Click the Register button to install the license service into the server’s service control manager. The LAI Network Service Configuration dialog will 
now appear as shown below. 
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Figure 2 -- LAI Network Service configuration software after service is registered. 

C - Have the operating system start the license service 

Click Start Service to begin running the service as shown in the dialog below. Once started, the service will always be running until stopped by the 
LAI Network Service Configuration software. 

 

Figure 3 -- LAI Network Service configuration software after service is started. 

D - License the service to provide AGi32 and/or PTB licenses 

Select the Request License Key button to submit the Service ID to Lighting 
Analysts. Be sure to complete the entire form (shown at right) so that we know 
who you are. When you click Submit, you will be connected to our web server to 
complete the process. Verify your e-mail address and click on the Register button. 
Your license key will be returned to you via e-mail. The turn-around may be up to 
72 hours. 

If you do not have Internet access, copy the Service ID from the dialog and paste 
it into a text file that you can reference from another computer. Paste the Service 
ID into an e-mail and send to info-register@agi32.com . Please DO NOT attempt 
to transpose the Service ID via telephone. 

  

  

  

          Figure 4 -- Request license key e-mail form, click Submit. 
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When you receive the license key from Lighting Analysts, paste it into the field labeled License Key. 

Select the Activate Key button. A small pop-up will be displayed labeled Key Loaded. This small dialog will also show the number of AGi32 and PTB 
licenses to be served. See Figure 5 below. 

Click OK in the small pop-up dialog and notice that the number of licenses to be served appears across the top of the LAI Network Service 
Configuration software under Current License Information. 

 

Figure 5 -- After Activate Key button has been selected, key loaded. 

E – Close the LAI Network Service Configuration program 

Note the IP address of the server in the lower-right corner of the dialog; you will need this for the client installations. Select the Close button to close 
the LAI Network Service Configuration program. Windows will now automatically run this service continuously when the computer is turned on and 
will automatically start it when the server is rebooted. 

F – Install AGi32 and/or Photometric Toolbox on the Client machines 

1. Install the AGi32 and/or Photometric Toolbox software on each client machine. The software can be installed from a downloaded setup file 
or from the standard product CD. 

2. On first start of the software, select the Network tab for product validation. Select the Network License button and enter the Server IP 
address. This client will now be registered with the network license. Client machines running AGi32 and/or PTB do not require a separate 
installation key; they validate their license with the server service. 

3. To convert machines using a single user license of AGi32 or Photometric Toolbox Professional to a network license: From the Tools 
menu, select the Installation and License Manager command. On the Single User License tab, select Convert To Network License. On the 
Network tab, enter the network server's IP address. This step is required for standalone licenses traded in for network licensing. 
IMPORTANT: Your Single User License will no longer be valid. 

3) Moving or Updating the Service (Version 2.0x LAN and WAN DE-AUTHORIZATION): 

The 2.0x version of the network service (LAN and WAN) is now obsolete and can be replaced by the free update to Version 5.1. VERY IMPORTANT! 
Follow the uninstall directions below to remove the Version 2.0x service from your server before installing the new update. IMPORTANT: YOU 
MUST DE-AUTHORIZE THE OLD SERVICE BEFORE KEYING THE NEW ONE! 

1. Open LAINConfig application on the server. 

2. Select the De-authorize tab. 

3. Click the De-authorize Now button. 

4. Submit your company information along with the De-authorization information by clicking the Submit button in the dialog that appears. 

5. Return to the Service Setup tab. 

6. Stop the service. 

7. Unregister the service. 
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8. Uninstall the LAI Network Service Configuration software from Windows Control Panel. 

9. Log into your account at www.agi32.com and check for product updates; download as necessary. 

10. Double click the Setup file to install the new software on the new or existing server, depending on whether you are moving the service or 
just updating it. 

11. Start the LAI Network Service Configuration software. 

12. Select the Register Service button. 

13. Select the Start Service button. 

14. Request the license key using the Request License Key button. 

15. Complete the form and click Submit. 

16. The License key will be returned via e-mail. Copy and paste it into the License Key field and click the Activate Key button. 

4) Moving the Service to a New Server (Version 5.1 only): 

If it becomes necessary to move the version 5.1 (and greater) network license service, all you need to do is Uninstall the software from Control 
Panel. As a new function in the 5.1 Version, this process automatically sends a de-authorization key to Lighting Analysts, then stops and un-registers 
the service. You are then free to install on the new server following the instructions below. 

1. Uninstall the LAI Network Service Configuration software from Windows Control Panel. 

2. Log into your account at www.agi32.com and check for product updates, download if necessary. 

3. Double click the Setup file to install the software on the new server. 

4. Start the LAI Network Service Configuration software. 

5. Select the Register Service button. 

6. Select the Start Service button. 

7. Request the license key using the Request License Key button. 

8. Complete the form and click Submit. 

9. The License key will be returned via e-mail. Copy and paste it into the License Key field and click the Activate Key button. 

5) Updating the Service (Version 5.1 only): 

Updating the Service or LAI Network Service Configuration software for version 5.1 and greater is straightforward and will require a new License key. 
Simply uninstall the existing application using Control Panel. This process automatically sends a de-authorization key to Lighting Analysts in Version 
5.1; it then stops and un-registers the service. 

1. Uninstall the LAI Network Service Configuration software from Windows Control Panel. 

2. Install the upgrade from the new setup file. 

3. Start the LAI Network Service Configuration software. 

4. Select the Register Service button. 

5. Select the Start Service button. 

6. Request the license key using the Request License Key button. 

7. Complete the form and click Submit. 

8. The License key will be returned via email. Copy and paste it into the License Key field and click the Activate Key button. 

6) Adding Licenses to the Network Service 

Adding licenses requires a new key. This can be done quickly with no downtime. Please order the licenses through Lighting Analysts prior to 
requesting the new key. 

1. Start the LAI Network Service Configuration software on the server. 
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2. Go to the Service Setup tab. 

3. Select the Request License Key button to submit the Service ID to Lighting Analysts. Be sure to complete the entire form so that we know who you 
are. 

4. Lighting Analysts will check your record for a recent license purchase and will return the new license key to you via e-mail. 

5. Highlight the field titled License Key. Copy and paste the new key in place of the old key. 

6. Select the Activate Key button. A small pop-up will be displayed labeled “Key Loaded.” The newly purchased licenses may not appear until the LAI 
Network Service Configuration software is closed and reopened. 

7) Error Codes 

Error #1 - No Server Found. Click Ok to enter a different Server IP Address. Please contact your System Administrator for assistance. 

Error #2 - Service not responding. Click Ok to enter a different Server IP Address. Please contact your System Administrator for assistance. 

Error #3 - Not LAI Network License Service. Click Ok to enter a different Server IP Address. Please contact your System Administrator for 
assistance. 

Error #4 - LAI Network License Service has not been initialized. Please contact your System Administrator for assistance. 

Error #5 – No licenses available. <<< List of connected users is displayed >>> 

Error #6 - Requested license has expired. Click Ok to try again. 

Error #7 - Address is beyond the class C subnet. Click Ok to enter a different Server IP Address. Please contact your System Administrator for 
assistance. 

Error #8 - No network available. The network version of this program requires a network connection. Contact your System Administrator and/or LAI 
for help. 

Error #9 - No network hardware found. The network version of the program requires a network connection. Contact your System Administrator for 
assistance. 

Error #10 - Invalid IP Address. Click Ok to enter a different Server IP Address. Please contact your System Administrator for assistance. 

Error #11 - Invalid Port Address. Please contact your System Administrator for assistance. 

 License Sharing 

Operating AGi32 on Multiple Computers 

AGi32 can be operated on multiple computers using a single license user by one of three methods. Each method allows you to share a license of 
AGi32 across multiple computers without purchasing a license for each computer. 

• In version 2.04 and older: By use of an Activate Disk . The Activate Disk deactivates the current installation while enabling another installation 
(new or deactivated) to become active. 

• In version 2.1 and later: By Simple Sharing or Advanced Sharing. 

Simple Sharing 

Simple Sharing is available for AGi32 version 2.1 and later. Earlier versions may use the Activate Disk procedure instead. 

The Simple License Sharing feature is available for Single User and Term Licenses ONLY. Users can share one license with up to two computers. 
This is a great option for those who want to use the software on their work pc and one other machine (home or laptop). The License Sharing feature 
requires a persistent Internet connection and all shared computers must be using the same program version. 

Important: License Sharing requires a persistent Internet connection from a computer while it is using or wishes to use the software! 

Installation: 

1. From an active Single User or Term License installation, select Installation and License Manager Setup from the Tools menu. 
2. Select Set up License Sharing. 
3. Enter Sharing Name (see below) and E-mail address. Click Submit. 
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Once license sharing is established, the program generates a Shared License Key that is used by the other computer you wish to share the license 
with. The key will be sent to the e-mail, provided allowing you to forward it to the shared computer. 

Note: The Sharing Name is used to identify which computer/user is currently using the license. It can be anything you want, but It is recommended 
that you NOT use the same name for everyone sharing the license. For Example if you would like to share your license between your office and 
home computer, a likely scheme would use the names: "Home" and "Office". 

To Activate the License on a Shared Computer: 

1. Install the software in the normal manner. 
2. From the Startup Dialog box, select Shared License. 
3. Enter the Shared License Key (cut and paste from e-mail, if possible) 
4. Click Activate. 
5. Enter the user information (name and e-mail) 
6. Click Activate. 
7. If successful, the program will connect to the shared license. 

To Disable License Sharing: 

1. Open the program, select Installation and License Manager Setup from the Tools menu. 
2. Select Convert to Single User License. 
3. A prompt will ask you if you really want to convert; select Yes. 
4. An pop-up message will let you know License Sharing has been terminated. 

Details: 

License Sharing only allows one concurrent use of the program. If the shared license is in use by another user when the program is started, you will 
be notified and the license allocation information will be displayed. 

If the original installation of the program (where sharing was originated) is uninstalled, license sharing will be terminated for all shared users unless 
the license is checked out by one of the shared users. 

The License Sharing option allows any shared computer to permanently check out the shared license. This will make the license unavailable to other 
shared installations. Be careful who you share with! 

When Updating a License: 

The installation of a product update will terminate any shared license accounts you have established. Follow the direcctions below to reestablish 
sharing. 

When using a Simple Shared License Key: 

If you have setup and are using Simple Sharing, there are only two computers using the shared key: the computer which originated the share (this is 
the computer which owns the Single User License – Computer #1); and the computer that is using the share (the computer which does not have a 
Single User License – Computer #2) 

On Computer #1: 

• Install the update (this automatically terminates license sharing) 

• Start the program, a new Single User License is automatically generated and installed 
• Open the Installation and License Manager (Tools Menu) and create a new Simple Shared License key 

On Computer #2: 

• Install the update 

• Start the program and wait for a message indicating that the Single User License could not be verified 

• Close the program and restart 
• Select Shared License and enter the new Shared License Key 

Advanced License Sharing 

Advanced Sharing is available for AGi32 version 2.1 and later. Earlier versions may use the Activate Disk procedure instead. 

The Advanced License Sharing option is available to Single User License owners for an additional fee. Each Advanced Sharing Package purchased 
allows you to share up to five licenses with up to ten distinct computers. The License Sharing feature requires a persistent Internet connection and all 
shared computers must be using the same program version. 

Important: License Sharing requires a persistent Internet connection from a computer while it is using or wishes to use the software! 

Installation: 
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1. From an active Single User License installation, select Installation and License Manager from the Tools menu. 
2. Select Set up License Sharing. 
3. Select Advanced Sharing 
4. Select New. 
5. Enter user information (name and email) and click Submit. 
6. Once License Sharing is successfully set up, the program generates a Shared License Key that is to be used by the other computers you wish 

to share the license with, or to add additional licenses to the shared account. The key will be e-mailed, allowing you to forward it to the shared 
computers as necessary. 

7. Follow steps one through three to add an additional license to an existing shared account. 

Note: Sharing Name is used to identify which computer/user is currently using the license. It can be anything you like; however, it is recommended 
that you NOT use the same name for everyone sharing the license. For example, if you would like to share a license between your office and home 
computer, a likely scheme would use the names "Home" and "Office". 

Add Additional License to Existing Shared Account : 

NOTE: You must own a valid Single User License in order to add it to an existing Shared Account. 

1. From an active Single User License installation, select Installation and License Manager from the Tools menu. 
2. Select Advanced Sharing 
3. Select Add. 
4. Enter user information (name and e-mail) and the Shared License Key 
5. (copy and paste from e-mail if possible); click Submit. 
6. If successful, the program will connect to the shared license and open! 

Activate License On a Shared Computer: 

1. This computer does not own a Single User License, but can utilize license sharing. 
2. From the Startup Dialog box, select Shared License. 
3. Enter the Shared License Key (copy and paste from e-mail if possible) and click Activate. 
4. Enter user information (name and e-mail); click Activate. 
5. If successful, the program will connect to the shared license and open! 

To Disable License Sharing : 

Two Methods: 

1. Uninstall the program from the computer which initiated the Shared License. The license will be removed from shared account. If this is the only 
or last license in the account, the shared license is terminated. (All sharing computers will no longer be able to connect to the shared license.) 

2. Uninstall from Shared computer. User is removed from shared users list. The shared license account remains active. May need/want to do this 
with another computer if all shares are currently being used. 

Advanced License Sharing allows for the number of licenses in the account to be shared concurrently. If all licenses are in use, you will be notified 
and the license allocation information will be displayed (who is currently using the licenses). 

Shared License Check Out : 

Available for Simple or Advanced Sharing, this may be useful when going on the road or if your Internet connection is erratic. 

1. From an active Single User License installation, select Installation and License Manager from the Tools menu. 
2. Select Check Out Shared License 
3. Select Check Out Period. 
4. Hours – May be useful when sharing a desktop and a home computer. 
5. Days – May be useful when taking a laptop on the road. 
6. Permanently-Converts license back to original state (Full or Term); Sharing is terminated. When using Advanced Sharing, the license is 

removed from the shared account. If this is the only or last license in the account, the shared account is terminated (all shared computers will no 
longer be able to connect to the shared license). 

7. After selecting Check Out Period, select Check Out. 
8. If successful, the program will operate as a standalone (no Internet connection necessary) for the designated check out period. 

Details: 

What happens if: 

You uninstall from the computer which initiated the Shared License – License is removed from Shared account. If this is the only or last license in the 
account, the Shared License is terminated (all shared computers will no longer be able to connect to the Shared License). 

You uninstall from a Shared Computer – The user is removed from the shared users list. The shared license account remains active. You may 
need/want to do this to share with another computer if all shares are currently being used. 
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When Updating a License: 

The installation of a product update will terminate any shared license accounts you have established. Follow the directions below to reestablish 
sharing. 

When using an Advanced Shared License Key: 

If you have setup and are using Advanced Sharing, there may be multiple computers using the shared key: the computer which originated the 
Advanced Shared Pool - Computer #1; other computers who have added their single user license key to the Shared Pool - Computer #2 and 
Computer #3; and any computer adding themselves as a shared user in the Shared Pool - Computer #4 and Computer #5. Since the Advanced 
Shared License Pool remains active until all single user licenses have been removed from the pool, it is necessary that all users who added their 
license to the Advanced Shared License Pool uninstall the older version first, before recreating the Advanced Shared License Pool with the newer 
release. 

On Computer #1: 

• Install the update (this automatically removes your license from the sharing pool - when all licenses have been removed the license 
share is terminated) 

• Start the program, a new Single User License is automatically generated and installed 

• Open the Installation and License Manager (Tools Menu) and create a new Advanced Shared License key (share this key with 
Computers #2 and #3) 

On Computers #2 and #3: 

• Install the update (this automatically removes your license from the sharing pool - when all licenses have been removed the license 
share is terminated) 

• Start the program, a new Single User License is automatically generated and installed 
• Add your license to the Shared Key provided by Computer #1 

On Computers #4 and #5: 

• Install the update 

• Start the program and wait for a message indicating that the Shared License could not be verified 

• Close the program and restart 
• Select Shared License and enter the new Shared License Key provided by Computer #1 

Moving AGi32 to a New Computer 

In versions 2.04 and earlier, AGi32 can be easily moved from one computer to another by creating an Activate Disk. This command allows the 
program to be deactivated on one computer without being deleted and then in turn, activated on another computer. Should the first installation be 
required again, the program may be deactivated on the second computer and reactivated on the original. You can effectively have as many 
deactivated installations as you require. However, only one installation may be active at any one time. 

The Activate Disk File may be created on a CD, which can be transported from one computer to another, or in any specified directory and drive for 
network usage or e-mail transport. 

Note: The Activate Disk method of sharing is not available for version 2.1 and later. 

AGi32 Version 2.1 and later may be moved to a new computer by one of the Sharing methods: Simple Sharing or Advanced Sharing. 

Using an Activate Disk 

Creating an Activate Disk-Procedure 

Activate Disks are used to transfer a Single User License of AGi32 from one computer to another. Both computers must have the same major 
version of AGi32 (e.g. 2.0x) installed; the Activate Disk process will not work across different versions of AGi32. 

To create and use an Activate Disk: 

1. From the Tools menu, select the Create Activate Disk command. 
2. Note the Serial Number from a newly installed copy of AGi32 or on a deactivated copy. You must open the AGi32 application on the target 

computer to see the serial number. The serial number will change each time the software is reinstalled or deactivated! 
3. Type the serial number that was previously noted, in the Target CPU Serial Number box. 
4. Insert a blank CDR or CDR/W . 

• If your computer does not have a CD Drive, or you do not wish to use a CD to transfer information, you can specify an alternate path 
(drive and folder) in which the Activate Disk File will be located. 
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• You may also specify an network drive for the Activate Disk File (called Activate.dat) so that the user can access the file from a 
common location. You may also email the file to another user when sharing a license across multiple office at different physical 
locations. 

4. Click Ok. 

Activating a new Installation: 

1. Take your Activate Disk to the new installation for which you recorded the serial number (or to the previously deactivated installation). 
2. Start AGi32 on the new CPU. 
3. At the Installation Registration dialog, click on the Have Activate Disk button. 
4. Select the location where the Activate Disk File  is located and click OK. You may select the Drive or Folder location instead of clicking on the 

Activate File if you wish (See sample). 
5. The new installation is now successfully activated. Your original installation is now deactivated. It can be reactivated by the same procedure as 

explained below. 

Reactivating a deactivated installation: 

1. Start the deactivated installation of AGi32. 
2. Record the serial number from the deactivation screen. 
3. Start the active installation of AGi32 that you will create the activate disk from. 
4. Select Create Activate Disk from the Tools menu. 
5. Specify the location where you want to create the Activate Disk File (you do not have to select your floppy drive). 
6. Enter the serial number from the deactivated installation and click Ok. 
7. Return the Activate Disk to the deactivated installation. 
8. Click on the Have Activate Disk button. 
9. Select the location containing the Activate Disk File from the drop down menu and click Ok.  

Creating an Activate Disk - Concept 

The Activate disk deactivates the current installation of AGi32 so that another installation at a different location may be used instead. At any one 
time, only one copy of AGi32 is active. This option is intended for users with single licenses to share a license of AGi32 at various places. 

Once a copy of AGi32 has been deactivated, it is no longer accessible. You must reactivate it with an Activate disk or reinstall the software and 
obtain an installation key to access it again. 

Both computers must have the same major version of AGi32 (e.g. 2.0x) installed; the Activate Disk process will not work across different versions of 
AGi32. 

Note: Activate Disk is not available when AGi32 is registered as a Network License. 

Related Topics 

Moving AGi32 to another computer 

Operating AGi32 on multiple computers 

Target CPU Serial Number 

The Target CPU's serial number will be displayed in one of two ways: 

1. From a new installation, the serial number appears on the Installation Registration screen. 
2. From a deactivated installation, the serial number may be obtained by double clicking on the AGi32 icon. The Deactivation screen will appear 

with the associated serial number. 

Note: Only the target installation can be activated with the disk. Other installations will not be affected.   

System Requirements 

AGi32 is a state of the art illumination engineering program. It will run satisfactorily on legacy hardware for relatively simple applications. Users 
planning on taking advantage of the full spectrum of power offered by AGi32 should consider the Recommended Minimum hardware requirements. 

Minimum (Legacy hardware) Recommended Minimum 

Pentium IV based PC   Multi-core or multi-processor system* 

500 Mb RAM 2 Gb RAM or greater 
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Windows XP Windows XP, Windows Vista, Windows 7 

OpenGL enabled video card Video card w/256 Mb or greater memory 

Minimum resolution 

1024 x 768 

16 bit color support 32 bit color support 

* AGi32's radiosity computations cannot utilize multi-core\processor configurations, however, due to improvements in I/O architecture they are much 
faster than comparable single core based systems. AGi32's ray tracing calculation does utilize multi-core\processor systems.   

User Information 

The User Information dialog displays the user information entered when AGi32 was initially registered. The User Information included here is 
available via the Replacement string option in the Text command. Please inform Lighting Analysts of any change in this information by faxing the 
User Information to 303.972.8851 or emailing the Register.rtf file to us at info@agi32.com. 

The User Information is used to check for AGi32 Updates as well. Please make sure the information is accurate and that Lighting Analysts is also 
aware of all current users to ensure access to all available updates. 
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 Troubleshooting 

Transporting Job Files 

Transporting files created by AGi32 between two computers is easy as the job files (*.AGI) maintain all relevant data, luminaire symbols, luminaire 
arrangements, photometric files, luminaire images and textures as part of the job file. To move a job file from one computer to another requires 
nothing more than copying the file. This can be done across a network, storage drive or via email. Generally, AGi32 job files can be quite large and 
will probably need to be zipped. 

When opening an AGi32 file for the first time on a different computer, the program will first check to see if luminaire symbols, luminaire 
arrangements, photometric files, luminaire images and textures are already on the system along the paths defined in the AGi32 file. If the files are 
found on the host’s Instabase, the file definitions will be updated automatically. 

If the photometric file is not found, AGi32 will automatically copy the photometric files to the PhotometricData_FilesFromJobFile folder specified in the 
System Settings-File System tab. The arrangement, symbol and image will be automatically copied to the appropriate locations. Textures will also be 
copied to the correct textures folder. 

If the job file contains multiple photometric files, each will be copied to the same directory.  

   

System Crash Job File Recovery 

AGi32 has a built-in recovery system to keep you working with a minimum of lost data if your computer system crashes while you are working on a 
project. 

When a file is saved, AGi32 automatically organizes and compresses the current working file. The newly cleaned up working file is then copied as 
the job file. If the job file has been previously saved, it is saved as a backup copy (with the extension .BAK) before being overwritten with the new 
data. 

By keeping a copy of your job file current to the last completed command, AGi32 needs only modify your actual job when you save it. Therefore, if 
your computer crashes while working on a job file, you have three levels of backup: 

• The saved job file which is current to the last save. This is your best option for recovery.  

• The backup file which is current to the previous save. Backup files (.BAK) are saved in the same location as the job file and can be opened 
using the File-Open command. Simply change the 'Files of type' to AGi32 Backup Files (*.BAK) and select the appropriate file. 

• The temporary working file which is current to the last command completed. The temporary working file is constantly accessed while in AGi32 
and, consequently, can easily become corrupt if the program crashes while writing data to the file. Using a temporary working file to recovery 
data should only be used as a last resort! 

Using Temporary Working Files: 

Temporary working files are stored in the Working folder (default location is C:\Documents and Settings\<Username>\Local Settings\Application 
Data\AGI32\Temporary\Working folder). The Local Settings folder and those below it in the folder tree may be hidden on your computer. If they are 
not visible, in Windows Explorer folder view, select Folder Options from the Tools menu, then select the View tab. Select the option to show Hidden 
Files and Folders.  

Working files can be opened just like any other job file. Look for the filename that you were working on as the beginning of a longer filename. Your 
filename will be followed by a series of numbers. These numbers are timer numbers used in the program when working with the Job file. An example 
of the format of this file is as follows. 
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Once you have located the file you can simply open it with AGi32 using the File-Open command or by double clicking on it, in Explorer™ or My 
Computer. You may want to use the File-Save As command to save the file in another location and continue working. 

During normal AGi32 sessions, the working files are automatically deleted upon exiting AGi32. However, should the system crash, those files will be 
left behind for recovery purposes.  

If the temporary working file is unstable, you may be able to recovery most or some of your data by importing the temporary working file using the 
File-Import command. 

  

  

  


